   Introducing WebFOCUS Business User Edition ................................. 25
   WebFOCUS Business User Edition Components. ................................. 25
   WebFOCUS Installation Overview. ................................................... 26
   WebFOCUS and Your Network. ........................................................... 26
   Installation ....................................................................................... 26
   Installing WebFOCUS Business User Edition on a Windows Environment. 26
   WebFOCUS Business User Edition System Requirements for Windows. 27
      Hardware Requirements. ................................................................. 27
      Software Requirements. ................................................................. 27
   Installing WebFOCUS Business User Edition. ..................................... 27
   Updating WebFOCUS Business User Edition. ...................................... 36
   Starting and Stopping WebFOCUS Business User Edition Services ....... 37
   Uninstalling WebFOCUS Business User Edition. ............................... 39
   Troubleshooting WebFOCUS Business User Edition. ......................... 41
      Port Assignment. ........................................................................... 41
      WebFOCUS Business User Edition Log Files. .................................. 41
      Troubleshooting the Uninstall Process. ............................................ 42
   Installing the WebFOCUS Business User Edition on a Linux Environment. 44
   WebFOCUS Business User Edition System Requirements on a Linux Environment. 45
      Installation Prerequisites. ................................................................. 45
      System Resource Limits. .................................................................. 46
   Installing WebFOCUS Business User Edition Using Console Mode ....... 46
   Configuring Java Memory Allocation for the Application Server. .......... 48
   Launching WebFOCUS Business User Edition. .................................... 49
   Running WebFOCUS Business User Edition Servers Manually. ............. 49
      Creating Shell Scripts to Start and Stop Servers. ........................... 50
   Updating WebFOCUS Business User Edition. ..................................... 51
   Uninstalling WebFOCUS Business User Edition. ............................... 53
      Configuring for Email Distribution. ................................................ 53
   Navigating the Environment ............................................................. 55
   Navigating the Business User Edition Portal. ..................................... 56
Contents

Home Page .................................................................................................................. 56
Menu Bar ...................................................................................................................... 57
Sidebar ......................................................................................................................... 58
Explorer ........................................................................................................................ 58
  Navigation Bar .......................................................................................................... 59
  Resources Tree ........................................................................................................ 62
  Actions Bar ............................................................................................................... 63

Types of Content You Can Create in the Business User Edition ....................... 64
  Content Area .......................................................................................................... 66
  Folder and Item Properties ...................................................................................... 68

Navigating the Administration Console ................................................................. 70
  Navigating the Configuration Tab ........................................................................ 71
  Navigating the Security Tab .................................................................................. 73
  Navigating the ReportCaster Tab .......................................................................... 73
  Navigating the Diagnostics Tab ............................................................................ 74

Reviewing Version Information .................................................................................. 74
  Reviewing Client Verification ................................................................................ 75
  HTTP Request Headers and JVM Property Information ....................................... 76

Navigating the InfoAssist Interface ........................................................................... 76
  InfoAssist Application Window ............................................................................. 77
  Application Main Menu ........................................................................................ 78
  Quick Access Toolbar ............................................................................................ 81
  Ribbon ...................................................................................................................... 84
    Working With the Ribbon ..................................................................................... 84
  Home Tab ................................................................................................................ 85
  Insert Tab ............................................................................................................... 86
  Format Tab ............................................................................................................. 86
  Data Tab .................................................................................................................. 87
  Slicers Tab ............................................................................................................... 88
  Layout Tab ............................................................................................................... 88
  View Tab .................................................................................................................. 89
  Field Tab .................................................................................................................. 90
  Series Tab ................................................................................................................. 90
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Understanding the Canvas.</td>
<td>91</td>
</tr>
<tr>
<td>Using the Query Pane and Filter Pane on the Canvas.</td>
<td>92</td>
</tr>
<tr>
<td>Understanding Output Options.</td>
<td>92</td>
</tr>
<tr>
<td>Using the Navigation Taskbar.</td>
<td>94</td>
</tr>
<tr>
<td>Using the Status Bar.</td>
<td>95</td>
</tr>
<tr>
<td>Understanding the Resources Panel.</td>
<td>95</td>
</tr>
<tr>
<td>Using the Data Pane.</td>
<td>97</td>
</tr>
<tr>
<td>Using the Data Pane to Add Fields to a Report.</td>
<td>99</td>
</tr>
<tr>
<td>Using the Query Pane and Filter Pane.</td>
<td>101</td>
</tr>
<tr>
<td>Using Field Containers.</td>
<td>103</td>
</tr>
<tr>
<td>Field Containers for Reports.</td>
<td>103</td>
</tr>
<tr>
<td>Field Containers for Charts and Visualizations.</td>
<td>103</td>
</tr>
<tr>
<td>Using Shortcut Menu Options in the Query Pane.</td>
<td>107</td>
</tr>
<tr>
<td>Dynamic Grouping</td>
<td>111</td>
</tr>
</tbody>
</table>

### 2. Setting Up Your Environment ................................................ 115

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using the Administration Console</td>
<td>115</td>
</tr>
<tr>
<td>Opening the Administration Console</td>
<td>115</td>
</tr>
<tr>
<td>Using the Administration Console Menu Bar.</td>
<td>117</td>
</tr>
<tr>
<td>Using the Licenses Menu.</td>
<td>117</td>
</tr>
<tr>
<td>Reviewing Client License Information.</td>
<td>117</td>
</tr>
<tr>
<td>Reviewing User Audit Information.</td>
<td>119</td>
</tr>
<tr>
<td>Reviewing Third Party Licenses.</td>
<td>121</td>
</tr>
<tr>
<td>Clearing the Cache.</td>
<td>122</td>
</tr>
<tr>
<td>Closing the Administration Console.</td>
<td>122</td>
</tr>
<tr>
<td>Opening Administration Console Help.</td>
<td>122</td>
</tr>
<tr>
<td>Configuring Security.</td>
<td>122</td>
</tr>
<tr>
<td>Using Internal Security.</td>
<td>123</td>
</tr>
<tr>
<td>Using External Security.</td>
<td>127</td>
</tr>
<tr>
<td>Understanding Custom Settings.</td>
<td>127</td>
</tr>
<tr>
<td>Understanding NLS Settings.</td>
<td>129</td>
</tr>
<tr>
<td>Customizing the Dynamic Language Switch.</td>
<td>131</td>
</tr>
<tr>
<td>Understanding Redirection Settings.</td>
<td>133</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Working With Domains</td>
<td>246</td>
</tr>
<tr>
<td>Managing Domain Users</td>
<td>247</td>
</tr>
<tr>
<td>Granting Access to a Domain</td>
<td>247</td>
</tr>
<tr>
<td>Managing Domain Private Resources</td>
<td>248</td>
</tr>
<tr>
<td>Deleting Domains</td>
<td>248</td>
</tr>
<tr>
<td>Managing Domain Users After Deleting a Domain</td>
<td>249</td>
</tr>
<tr>
<td>Working With Folders</td>
<td>249</td>
</tr>
<tr>
<td>Managing Users</td>
<td>254</td>
</tr>
<tr>
<td>Understanding Users</td>
<td>255</td>
</tr>
<tr>
<td>Understanding User Name Requirements</td>
<td>255</td>
</tr>
<tr>
<td>Importing Users</td>
<td>258</td>
</tr>
<tr>
<td>Understanding User Import File Layout and Format Requirements</td>
<td>258</td>
</tr>
<tr>
<td>Understanding User Record Field Format Requirements</td>
<td>259</td>
</tr>
<tr>
<td>Understanding the Group Membership Report</td>
<td>263</td>
</tr>
<tr>
<td>Managing Groups</td>
<td>265</td>
</tr>
<tr>
<td>Understanding Groups</td>
<td>266</td>
</tr>
<tr>
<td>Creating Groups From Domains</td>
<td>266</td>
</tr>
<tr>
<td>Managing Private Resources</td>
<td>268</td>
</tr>
<tr>
<td>Authenticating Users to Your Active Directory</td>
<td>268</td>
</tr>
<tr>
<td>Configuring Active Directory/LDAP Authentication</td>
<td>269</td>
</tr>
<tr>
<td>Creating User Accounts When WebFOCUS Business User Edition is Configured for Active Directory Authentication</td>
<td>272</td>
</tr>
<tr>
<td>Configuring WebFOCUS Business User Edition for SSL</td>
<td>273</td>
</tr>
<tr>
<td>Establishing the Self-Signed Certificate</td>
<td>275</td>
</tr>
<tr>
<td>Importing the Trusted Certificate into the Keystore</td>
<td>275</td>
</tr>
<tr>
<td>Updating the Connector Protocols in the Tomcat Server.xml File</td>
<td>276</td>
</tr>
<tr>
<td>Creating a Change Management Package</td>
<td>277</td>
</tr>
<tr>
<td>Working With CM Zip Files</td>
<td>277</td>
</tr>
<tr>
<td>Changing InfoAssist User Preferences</td>
<td>284</td>
</tr>
<tr>
<td>View</td>
<td>284</td>
</tr>
<tr>
<td>Layout</td>
<td>285</td>
</tr>
<tr>
<td>Format</td>
<td>285</td>
</tr>
<tr>
<td>Environment and Styling</td>
<td>285</td>
</tr>
</tbody>
</table>
3. Working With Data ....................................................... 319

Working With Data Overview ............................................. 319

Understanding Your Data Structures ................................... 320

Preparing Data for Upload ................................................ 320

Naming Conventions and Excel Sheet Names ......................... 321

Removing Introductory Information ..................................... 322

Placing Column Titles in the First Row ................................. 322

Removing Aggregated Information ....................................... 323

Using Excel Named Ranges ............................................... 323

Preparing Hierarchical Data Columns ................................. 323

Removing Date Formulas .................................................. 324

Uploading, Appending, and Merging Spreadsheets .................. 325

Uploading Files .............................................................. 328

Connecting to Data and Editing Data ................................... 331

Creating a Synonym With the Connect to Data Wizard .............. 331

Configuring Adapters ...................................................... 332

Creating Synonyms ......................................................... 334

Editing And Deleting Metadata .......................................... 341

Using Data Preparation Options ......................................... 342

Creating Clusters ........................................................... 342

Pivoting Repeating Columns Into Rows ............................... 343

Creating Folders and Assigning DV Roles ............................. 345

Assigning DV Roles ......................................................... 346

Joining and Blending Data ................................................ 347

Joins .............................................................................. 347
4. Creating Content ............................................................ 361

Generating Sample Content .................................................. 361
  Generating Sample Content Overview..................................... 362
  Analyzing Sample Content.................................................... 365

Creating Reports ................................................................. 371
  Choosing a Report Output..................................................... 372
  Downloading InfoAssist Report Data to Excel (CSV) Format.......... 373
  Using Procedure Settings..................................................... 374

Creating Charts ................................................................. 380
  Chart Outputs................................................................. 383
  Binning................................................................. 383
    Binning Values in a Histogram............................................ 388

Using Insight to Analyze Dynamic Charts ................................. 391
  Working With Charts in Insight............................................... 394
    Searching for Fields........................................................ 399
  Changing Summary Operators for the Field............................... 399

Filtering in Insight............................................................ 401
  Types of Filters............................................................ 402
  Adding a Filter........................................................... 405
  Removing a Filter.......................................................... 406

Using the Options Toolbar..................................................... 406

Using Insight in Phone Mode................................................ 411
  User Options in Phone Mode................................................ 412
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Renaming a Visual.</td>
<td>493</td>
</tr>
<tr>
<td>Using Paper-Clipping to Group Values in a Visual.</td>
<td>494</td>
</tr>
<tr>
<td>Using Multi Drill in Visualization Mode.</td>
<td>501</td>
</tr>
<tr>
<td>Creating Matrix Charts</td>
<td>502</td>
</tr>
<tr>
<td>Using Active Technologies</td>
<td>507</td>
</tr>
<tr>
<td>Active Technologies Report Overview.</td>
<td>507</td>
</tr>
<tr>
<td>Security Features.</td>
<td>510</td>
</tr>
<tr>
<td>Handling a Large Amount of Data.</td>
<td>511</td>
</tr>
<tr>
<td>Distribution and Viewing Considerations</td>
<td>511</td>
</tr>
<tr>
<td>Usage Notes for Active Technologies.</td>
<td>513</td>
</tr>
<tr>
<td>Creating an Active Technologies Report.</td>
<td>516</td>
</tr>
<tr>
<td>Active Technologies Report Menu Options.</td>
<td>516</td>
</tr>
<tr>
<td>Active Technologies Cell Menu Options.</td>
<td>520</td>
</tr>
<tr>
<td>Configuring Active Technologies Report Options.</td>
<td>521</td>
</tr>
<tr>
<td>General Tab.</td>
<td>522</td>
</tr>
<tr>
<td>Menu Options Tab.</td>
<td>522</td>
</tr>
<tr>
<td>Colors Tab.</td>
<td>524</td>
</tr>
<tr>
<td>Advanced Tab.</td>
<td>525</td>
</tr>
<tr>
<td>Creating an Active Technologies Chart.</td>
<td>526</td>
</tr>
<tr>
<td>Active Technologies Options for Charts.</td>
<td>526</td>
</tr>
<tr>
<td>Creating an Active Technologies Dashboard.</td>
<td>529</td>
</tr>
<tr>
<td>Active Technologies Dashboard Prompts.</td>
<td>529</td>
</tr>
<tr>
<td>Target Reports.</td>
<td>530</td>
</tr>
<tr>
<td>Using Multiple Reports as Targets and Sources.</td>
<td>531</td>
</tr>
<tr>
<td>Using Navigation Options for Reports</td>
<td>539</td>
</tr>
<tr>
<td>Creating Maps to Illustrate Trends.</td>
<td>540</td>
</tr>
<tr>
<td>InfoAssist and Esri Integration.</td>
<td>542</td>
</tr>
<tr>
<td>Configuring an Esri On Premise Environment.</td>
<td>545</td>
</tr>
<tr>
<td>Creating and Customizing Maps in InfoAssist.</td>
<td>547</td>
</tr>
<tr>
<td>Customizing the List of Geographic Roles.</td>
<td>565</td>
</tr>
<tr>
<td>Customizing the List of Basemap Definitions.</td>
<td>575</td>
</tr>
<tr>
<td>Adding a Custom Basemap.</td>
<td>575</td>
</tr>
<tr>
<td>Customizing the List of Geographic Roles.</td>
<td>579</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>--------</td>
</tr>
<tr>
<td>View Tab</td>
<td>687</td>
</tr>
<tr>
<td>Field Tab</td>
<td>689</td>
</tr>
<tr>
<td>Ribbon Commands for Charts</td>
<td>694</td>
</tr>
<tr>
<td>Home Tab</td>
<td>694</td>
</tr>
<tr>
<td>Format Tab</td>
<td>696</td>
</tr>
<tr>
<td>Data Tab</td>
<td>701</td>
</tr>
<tr>
<td>Slicers Tab</td>
<td>702</td>
</tr>
<tr>
<td>Layout Tab</td>
<td>703</td>
</tr>
<tr>
<td>View Tab</td>
<td>704</td>
</tr>
<tr>
<td>Field Tab</td>
<td>706</td>
</tr>
<tr>
<td>Series Tab</td>
<td>709</td>
</tr>
<tr>
<td>Ribbon Commands for Documents</td>
<td>711</td>
</tr>
<tr>
<td>Home Tab</td>
<td>711</td>
</tr>
<tr>
<td>Insert Tab</td>
<td>714</td>
</tr>
<tr>
<td>Format Tab</td>
<td>715</td>
</tr>
<tr>
<td>Data Tab</td>
<td>717</td>
</tr>
<tr>
<td>Slicers Tab</td>
<td>718</td>
</tr>
<tr>
<td>Layout Tab</td>
<td>719</td>
</tr>
<tr>
<td>View Tab</td>
<td>720</td>
</tr>
<tr>
<td>Field Tab</td>
<td>722</td>
</tr>
<tr>
<td>Series Tab</td>
<td>727</td>
</tr>
<tr>
<td>Ribbon Commands for Visualizations</td>
<td>728</td>
</tr>
<tr>
<td>Home Tab</td>
<td>728</td>
</tr>
<tr>
<td>Format Tab</td>
<td>730</td>
</tr>
<tr>
<td>View Tab</td>
<td>732</td>
</tr>
<tr>
<td>Field Tab</td>
<td>733</td>
</tr>
<tr>
<td>Series Tab</td>
<td>734</td>
</tr>
<tr>
<td>5. Customizing Content</td>
<td>737</td>
</tr>
<tr>
<td>Customizing Reports</td>
<td>737</td>
</tr>
<tr>
<td>Styling Reports</td>
<td>740</td>
</tr>
<tr>
<td>Report Style Dialog Box</td>
<td>750</td>
</tr>
<tr>
<td>Color Dialog Box</td>
<td>751</td>
</tr>
<tr>
<td>Section</td>
<td>Page</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Report Group</td>
<td>752</td>
</tr>
<tr>
<td>Report Features</td>
<td>754</td>
</tr>
<tr>
<td>Customizing Charts and Visualizations</td>
<td>755</td>
</tr>
<tr>
<td>Chart Features</td>
<td>755</td>
</tr>
<tr>
<td>Labeling Charts</td>
<td>756</td>
</tr>
<tr>
<td>Accessing Chart Formatting Tools</td>
<td>757</td>
</tr>
<tr>
<td>Using Live Preview</td>
<td>757</td>
</tr>
<tr>
<td>Formatting a Series</td>
<td>758</td>
</tr>
<tr>
<td>Associated Dialog Boxes</td>
<td>758</td>
</tr>
<tr>
<td>Format Series Dialog Box</td>
<td>758</td>
</tr>
<tr>
<td>Edit Title Dialog Box</td>
<td>760</td>
</tr>
<tr>
<td>Traffic Light Condition Dialog Box</td>
<td>760</td>
</tr>
<tr>
<td>Formatting and Display Tools for Data in a Visual</td>
<td>761</td>
</tr>
<tr>
<td>Series Elements Shortcut Menu</td>
<td>763</td>
</tr>
<tr>
<td>Using Series Properties</td>
<td>765</td>
</tr>
<tr>
<td>Enhancing Series Using the Series Tab</td>
<td>766</td>
</tr>
<tr>
<td>Formatting Charts Using the Series Tab</td>
<td>767</td>
</tr>
<tr>
<td>Formatting Data Labels</td>
<td>775</td>
</tr>
<tr>
<td>Associated Dialog Boxes</td>
<td>775</td>
</tr>
<tr>
<td>Format Labels Dialog Box</td>
<td>775</td>
</tr>
<tr>
<td>Style Dialog Box</td>
<td>779</td>
</tr>
<tr>
<td>Line Style Dialog Box</td>
<td>779</td>
</tr>
<tr>
<td>Data Labels Elements Shortcut Menu</td>
<td>780</td>
</tr>
<tr>
<td>Using Data Labels Properties</td>
<td>780</td>
</tr>
<tr>
<td>Formatting a Legend</td>
<td>781</td>
</tr>
<tr>
<td>Format Legend Dialog Box</td>
<td>781</td>
</tr>
<tr>
<td>Legend Elements Shortcut Menu</td>
<td>783</td>
</tr>
<tr>
<td>Using Legend Properties</td>
<td>784</td>
</tr>
<tr>
<td>Formatting Gridlines</td>
<td>786</td>
</tr>
<tr>
<td>Format Grid Lines Dialog Box</td>
<td>787</td>
</tr>
<tr>
<td>Gridline Elements Shortcut Menu</td>
<td>789</td>
</tr>
<tr>
<td>Using Gridline Properties</td>
<td>790</td>
</tr>
<tr>
<td>Formatting Axis Labels</td>
<td>796</td>
</tr>
<tr>
<td>Topic</td>
<td>Page</td>
</tr>
<tr>
<td>----------------------------------------------------------------------</td>
<td>------</td>
</tr>
<tr>
<td>Format Axis Dialog Box</td>
<td>796</td>
</tr>
<tr>
<td>Secondary Axes Options</td>
<td>801</td>
</tr>
<tr>
<td>Axis Elements Shortcut Menu</td>
<td>801</td>
</tr>
<tr>
<td>Using Axis Properties</td>
<td>803</td>
</tr>
<tr>
<td>Formatting a Frame and a Background</td>
<td>805</td>
</tr>
<tr>
<td>Frame &amp; Background Dialog Box</td>
<td>806</td>
</tr>
<tr>
<td>Frame and Background Shortcut Menu</td>
<td>812</td>
</tr>
<tr>
<td>Using Frame and Background Properties</td>
<td>813</td>
</tr>
<tr>
<td>Formatting a Gauge Chart</td>
<td>815</td>
</tr>
<tr>
<td>Format Gauge Dialog Box</td>
<td>815</td>
</tr>
<tr>
<td>Gauge Elements Shortcut Menu</td>
<td>818</td>
</tr>
<tr>
<td>Using Gauge Properties</td>
<td>818</td>
</tr>
<tr>
<td>Formatting Page Headings and Page Footings</td>
<td>823</td>
</tr>
<tr>
<td>Using Additional Formatting Features</td>
<td>825</td>
</tr>
<tr>
<td>Collation in Charts</td>
<td>830</td>
</tr>
<tr>
<td>Creating Thumbnails for Use With the Home Page</td>
<td>830</td>
</tr>
<tr>
<td>Using Storyboards</td>
<td>833</td>
</tr>
<tr>
<td>Animating Visualizations</td>
<td>835</td>
</tr>
<tr>
<td>Using Filters to Customize the Display of Data</td>
<td>836</td>
</tr>
<tr>
<td>Sorting the Values in an Autoprompt Parameter</td>
<td>838</td>
</tr>
<tr>
<td>Using Auto Drill</td>
<td>839</td>
</tr>
<tr>
<td>Using the Auto Linking Feature to Link Content</td>
<td>841</td>
</tr>
<tr>
<td>Using Optional Parameters with Auto Linking to Enhance Drilldown Results</td>
<td>843</td>
</tr>
<tr>
<td>Using Multi Drill</td>
<td>848</td>
</tr>
<tr>
<td>Adding Parameters for Data Selection at Run Time</td>
<td>859</td>
</tr>
<tr>
<td>Working With Slicers</td>
<td>862</td>
</tr>
<tr>
<td>Creating Slicers</td>
<td>862</td>
</tr>
<tr>
<td>Filtering With Slicers</td>
<td>864</td>
</tr>
<tr>
<td>How Slicers Cascade Together</td>
<td>864</td>
</tr>
<tr>
<td>Changing a Field Format</td>
<td>865</td>
</tr>
<tr>
<td>Dynamic Grouping</td>
<td>870</td>
</tr>
<tr>
<td>Customizing Domain Portal Pages</td>
<td>873</td>
</tr>
</tbody>
</table>
6. Using Content ............................................................... 885
   Creating Distribution Lists .................................................. 885
   Creating a Distribution List .................................................. 886
   Maintaining Distribution Lists .............................................. 890
   Editing and Deleting a Distribution List .................................. 890
   Accessing Distribution Lists ................................................. 891
   Bursting a Report ............................................................ 894
       Bursting Guidelines and Limitations .................................. 895
   Specifying Multiple Email Addresses .................................... 898
   Creating Schedules ............................................................ 900
       About the Basic Scheduling Tool ....................................... 900
       Basic Scheduling Tool Quick Access Toolbar ....................... 901
       Basic Scheduling Tool Ribbon ......................................... 902
   Creating a Schedule in the Basic Scheduling Tool ....................... 904
   About Tasks in the Basic Scheduling Tool ................................ 906
   Task Options in the Basic Scheduling Tool ................................. 906
   Specifying Parameter Values ................................................ 908
       Using Parameter Values to Burst Active Dashboards and Compound
       Reports ................................................................. 916
       Running Pre and Post-Processing Procedures for Each Parameter
       Value ................................................................. 919
       Bursting an Active Dashboard or Excel Compound Report That
       Contains Filtered and Unfiltered Reports ................................ 922
       Bursting an Active Dashboard or Excel Compound Report That
       Contains Only Filtered Reports ....................................... 924
   Deleting a Parameter .......................................................... 928
   Creating a New Parameter .................................................... 928
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reviewing Expanded URL Details</td>
<td>1006</td>
</tr>
<tr>
<td>Reviewing Reporting Server Request Details</td>
<td>1007</td>
</tr>
<tr>
<td>Reviewing Reporting Server Response Details</td>
<td>1008</td>
</tr>
<tr>
<td>Working With Log Files</td>
<td>1009</td>
</tr>
<tr>
<td>Working With Log Pages</td>
<td>1010</td>
</tr>
<tr>
<td>Tracking ReportCaster Configuration Events</td>
<td>1011</td>
</tr>
<tr>
<td>Downloading ReportCaster Job Trace Files</td>
<td>1011</td>
</tr>
<tr>
<td>Using the ReportCaster Performance Log to Track Schedule Performance</td>
<td>1012</td>
</tr>
<tr>
<td>Understanding Warning Messages in InfoAssist</td>
<td>1013</td>
</tr>
<tr>
<td>InfoAssist Warning Messages</td>
<td>1013</td>
</tr>
<tr>
<td>Unsupported Syntax and Objects</td>
<td>1014</td>
</tr>
</tbody>
</table>
WebFOCUS Business User Edition


**In this chapter:**
- Introducing WebFOCUS Business User Edition
- Installation
- Navigating the Environment

**Introducing WebFOCUS Business User Edition**

This topic provides an overview of WebFOCUS Business User Edition.

**WebFOCUS Business User Edition Components**

With WebFOCUS Business User Edition, you can quickly and easily perform the following functions, all in a single web-based environment:

**Business User Edition Portal**

The Business User Edition Portal provides access to the Home page, the default landing page that opens when you first sign in. It serves as a centralized place for creating, organizing, accessing, or sharing content, performing administrative tasks, scheduling reports and procedures, and working with your data. You can develop new content or interact with content that has been created by other users, as well as create pages and InfoApps with WebFOCUS Designer.

**Reporting and Analysis**

Create ad hoc queries, develop reports, charts, documents, and other analytic views for personal usage or sharing and distribution in static or interactive formats. You can also create more advanced information assets, such as multi-page analytic documents and multi-source dashboards.

**Data Discovery**
Explore your data to find trends, patterns, and gain new insight, by creating visualizations. Running against a high-speed data sandbox and other data sources, you can create interactive visualizations that can be saved, shared, published, and delivered as PowerPoint presentations to help you build business cases through storytelling.

**Scheduling and Distribution**

ReportCaster provides scheduling and distribution capabilities for reports and procedures, as well as independent files and URLs. Reports and files are automatically distributed on a monthly, weekly, daily, or specific basis.

**WebFOCUS Installation Overview**

This section briefly explains the different WebFOCUS installation components.

**WebFOCUS and Your Network**

WebFOCUS seamlessly integrates into your existing network by connecting web servers and application servers to your data. Users then access WebFOCUS through a web browser.

The main requirements for installing WebFOCUS are:

- **Web Browser.** To access WebFOCUS applications, you need a web browser and a TCP/IP connection to a web server or application server.

- **Web Server and Application Server.** WebFOCUS runs in part through a web server or application server. WebFOCUS BUE installs and configures a required application server.

- **Data.** WebFOCUS BUE accesses data through a High-Speed Analytics Sandbox (Hyperstage), a hybrid in-memory data store that stores, in a very compressed form, large amounts of data for retrieval, aggregation, and calculation.

**Installation**

This topic provides the step-by-step instructions that you need to install WebFOCUS Business User Edition.

**Installing WebFOCUS Business User Edition on a Windows Environment**

The following section describes how to install WebFOCUS Business User Edition on a Windows environment.

You can begin using WebFOCUS Business User Edition immediately after you install the product. No additional configuration steps are required.
WebFOCUS Business User Edition System Requirements for Windows

To install WebFOCUS Business User Edition, you must have administrator privileges. Additionally, your machine must meet the system requirements that are defined in Hardware Requirements on page 27 and Software Requirements on page 27.

**Hardware Requirements**

- Quad-core processor, 2.5 GHz minimum per core is recommended.
- 16 GB of RAM or higher is recommended for optimal performance. 8 GB of RAM minimum.
- 8 GB of free disk space.
- Ensure that the Windows page file is properly configured and that it is set to Automatically manage paging file size. For Windows 64-bit, the recommended paging file size is three times the size of the RAM.

**Software Requirements**

- 64-bit Version of Windows.
- Supported browsers: Internet Explorer® 11, Microsoft Edge®, Google Chrome™ (latest version), Mozilla Firefox® (latest version).

  **Note:** Accessibility Compliance is not supported at this time.

**Installing WebFOCUS Business User Edition**

This section describes how to install WebFOCUS Business User Edition.

**Procedure:** How to Install WebFOCUS Business User Edition

1. Download the installation files.
2. Double-click `installWebFOCUS_BUE8203.exe`.

  **Note:**

  - Java Version 8 Update 162 (8u162) and Tomcat 8.5.29 are included with the WebFOCUS Business User Edition product installation.
The installation program includes the following third-party components: Tomcat, Java, and Derby. Later versions or releases of these third-party components, which often contain fixes for security vulnerabilities, may exist at installation time. It is your responsibility to check the vendor sites listed below for updates to newer versions or releases of these third-party components if you intend to use them with WebFOCUS Business User Edition. Install the new updates or versions prior to proceeding with the WebFOCUS Business User Edition installation. If these components are installed through the WebFOCUS Business User Edition installation program, it is your responsibility to update these components after the installation is completed.

- The latest version of Tomcat is available at https://tomcat.apache.org.
- The latest version of Java is available at https://www.java.com.
- The latest version of Derby is available at https://db.apache.org/derby.

**Tomcat Memory Allocation**

- The Tomcat initial memory pool size (JvmMs) is configured to use 1/8 of the physical memory of the machine. For example, on a machine with 16 GB RAM, the pool size is set to 2130. The maximum memory pool size (JvmMx) is configured to use 1/4 of the physical memory of the machine. For example, on a machine with 16 GB RAM, the pool size is set to 4261.

- You can change the Java memory allocation by running the WfBUE82AppSrvw.exe Tomcat configuration utility, located in the drive:\ibi\WebFOCUS_BUE82\tomcat\bin folder, and selecting the Java tab.
3. Choose the appropriate language from the drop-down list and click OK.

The list of languages depends on the regional language settings of the Windows Operating System where WebFOCUS Business User Edition is being installed.

**Note:** The language selected will be the language used during the installation program. This language is also used to set the code page of the Reporting Server, which is responsible for data access.

If your data sources are in a different language, you will have to change the code page of the Reporting Server.
The Welcome window opens.

4. Click Next to continue.
The License Agreement window opens.

5. Click *I accept the terms of the License Agreement*, and then click Next.

**Note:**

- Only one installation per platform is supported.
If you have an earlier release of WebFOCUS Business User Edition installed on your machine, you will be prompted to update your installation and to provide Manager user ID credentials to load new roles and BI Portal page templates. In addition, you must manually stop all WebFOCUS Business User Edition services, except the WebFOCUS BUE Repository Server service, before beginning the installation program. For more information, see Starting and Stopping WebFOCUS Business User Edition Services on page 37. To perform a full or new installation, you must quit the installation program, uninstall the existing version, and perform a new installation. When you uninstall WebFOCUS Business User Edition, all components are removed from your directory structure, except the WebFOCUS Business User Edition Reporting Server applications. For more information, see Uninstalling WebFOCUS Business User Edition on page 39.

The License Code window opens, as shown in the following image.
6. Type the WebFOCUS Business User Edition license code and first four digits of the site code that were provided with your copy of WebFOCUS Business User Edition, and then click Next.

The Setup Preferences window opens, as shown in the following image.

7. In the Setup Preferences window, complete the following steps:
   a. The installation program preconfigures a user name, but requires that you type a password. You must complete the User Name credentials section to proceed with the installation. In the Password field, type a password, and then confirm your password.
Note: During the database creation, the password supports ASCII characters from 32 to 126 and cannot include the following characters: caret (^), ampersand (&), percent (%), or double quotation marks ("). Refer to the ASCII character table to determine the characters to use for the password. As a reference, see https://msdn.microsoft.com/en-us/library/60ecse8t(v=vs.71).aspx. The password for the user name must be between four (4) and 20 characters. Leading blanks and trailing blanks will be removed.

b. Optionally, select the Configure email distribution check box to select the type of Mail Server to be used for report distribution. Valid options are:

- Google. This requires a Google Account Name and Password.
  
  Note: Google may block sign-in attempts when delivering reports through WebFOCUS Business User Edition. To allow WebFOCUS Business User Edition to connect to the Google email account that was configured for email distribution, sign in to the Google account, navigate to My Account settings, select Sign-In & security, and turn the Allow less secure apps option On.

  For more information, see:

  https://www.google.com/settings/security/lesssecureapps

- Yahoo. This requires a Yahoo Account Name and Password.

- Other. Select this for all other mail servers. This option requires you to type the host name or IP address for your SMTP mail server.

c. The Configure WebFOCUS BUE services to start automatically check box is selected, by default. You can leave this check box selected to keep the services Startup Type as Automatic. This will ensure that the services required to run the product are always running, and will not require that you start the services manually, even if you restart the machine.

  Optionally, you can clear the Configure WebFOCUS BUE services to start automatically check box so you can manually start and stop the WebFOCUS Business User Edition services from the shortcut options found in the WebFOCUS Business User Edition 82 group, or through the Windows services program.

d. Select the Advanced Configuration check box if you want to customize the location of your Reporting Server applications directory. The default location is \WebFOCUS_BUE82\data\apps.

8. Click Next to continue.

The Pre-Installation summary window opens.
Note: If you selected the Advanced Configuration check box, the following window opens.

Server applications can be created in the default location or in a new location outside of the drive:`\ib\WebFOCUS_BUE82\` folder. Select the location of your applications and then click Next.

9. Confirm that the summary information is correct, and then click Install.

10. When the installation completes, click Done to close the installation program.
The Sign In page opens, as shown in the following image.

![Welcome to WebFOCUS Business User Edition](image)

11. Sign in using the manager user credentials that you configured during the installation program.

**Updating WebFOCUS Business User Edition**

The following needs to be performed after the upgrade completes:

- Ensure all WebFOCUS Business User Edition services are running.
- Run the following .bat file, if this step failed to run during the installation update process.

```
drive:\ibi\WebFOCUS_BUE82\WebFOCUS\utilities\WFReposUtil\update_repos.bat
```

This script will make updates to the WebFOCUS Business User Edition repository that are required to load new roles and BI Portal page templates.

- The `update_repos.bat` utility imports the following Change Management packages:
  - `bip_pages_templates_Vnn.zip`, where `nn` is the version of the package.
  - `roles.zip`
  - `pgx_page_templates_Vnn.zip`, where `nn` is the version of the package.
  - `themes_Vnn.zip`, where `nn` is the version of the package.
  - `wfbue_getting_started.zip`
Logs are created in the `drive:\ibi\WebFOCUS_BUE82\WebFOCUS\logs` folder under the following names:

- `cm_import_bip_page_templates_<date_time>.log`
- `cm_import_roles_<date_time>.log`
- `cm_import_pgx_page_templates_Vnn_<date_time>.log`
- `cm_import_themes_Vnn_<date_time>.log`
- `cm_import_wfbue_getting_started_<date_time>.log`
- `cm_import_wfbue_Collaborative_portal_<date_time>.log`

Currently, Tomcat does not provide an upgrade option in WebFOCUS Business User Edition. An installation utility will be available post-Release 8.2 Version 03 to enable you to upgrade existing Tomcat installations.

The solution for Release 8.2 Version 03 is as follows:

3. Restore the backed up data to the new installation.

By default, the data that needs to be backed up is located in the following folders:

- `drive:\ibi\WebFOCUS_BUE82\derby\WFBUE82\`
- `drive:\ibi\WebFOCUS_BUE82\data\apps\`
- `drive:\ibi\WebFOCUS_BUE82\srv\wfs\hs\`

### Starting and Stopping WebFOCUS Business User Edition Services

The installation program installs the following services:

- An application server
- A Distribution Server
- A repository server
A Reporting Server

Note: If you are updating an earlier release of WebFOCUS Business User Edition, you must manually stop all WebFOCUS Business User Edition services, except the WebFOCUS BUE Repository Server service, before beginning the installation program.

To view the status of these services, launch your Windows Services program. The following image highlights the WebFOCUS Business User Edition services as they appear in the Windows Services program. Select a service and use the toolbar to stop or start the service.

<table>
<thead>
<tr>
<th>Display name</th>
<th>Service Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>WebFOCUS BUE 82 Application Server</td>
<td>WfBUE82AppSrv</td>
</tr>
<tr>
<td>WebFOCUS BUE 82 Distribution Server</td>
<td>WfBUE82DistSrv</td>
</tr>
<tr>
<td>WebFOCUS BUE 82 Reporting Server</td>
<td>WebFOCUS BUE 82 Reporting Server</td>
</tr>
<tr>
<td>WebFOCUS BUE 82 Repository Server</td>
<td>WfBUE82DbSrv</td>
</tr>
</tbody>
</table>
Procedure: How to Start or Stop WebFOCUS Business User Edition Services

From the Start menu, navigate to the WebFOCUS Business User Edition shortcut, under the Information Builders program group.

- Click Start WebFOCUS_BUE Services to start the WebFOCUS Business User Edition services.
- Click Stop WebFOCUS_BUE Services to stop the WEBFOCUS Business User Edition services.

To stop or start an individual WebFOCUS BUE service, use the Windows Services program as described earlier in this section.

Uninstalling WebFOCUS Business User Edition

If you want to remove an existing WebFOCUS Business User Edition installation and want to perform a full installation of a newer release, you can run the uninstall program.

Note: Before you uninstall WebFOCUS Business User Edition, it is recommended that you save the cleanup utility to a different location on your machine in case the uninstall fails and you need to manually uninstall any components. For more information, see Troubleshooting WebFOCUS Business User Edition on page 41.

Procedure: How to Preserve Your Data

The following steps can be performed if you want to preserve your data and perform a new installation, if you need to move your data to another location, or if an upgrade installation fails and you need to perform a new full installation.

1. Back up the WebFOCUS Business User Edition repository server and Reporting Server application folders to a different location on your machine.

   By default, these are located in the following folders:

   - drive:\ibi\WebFOCUS_BUE82\derby\WFBUE82\n   - drive:\ibi\WebFOCUS_BUE82\data\apps\n   - drive:\ibi\WebFOCUS_BUE82\srv\wfs\hs\n

Procedure: How to Restore and Move Backed Up Data

2. After the installation program is complete, do the following:
   a. Manually stop the repository server service.
   b. Replace the new repository server and Reporting Server application folders, using the backup directories that you made in step 1 of *How to Preserve Your Data* on page 39.
   c. Restart the repository server service.

**Procedure: How to Uninstall WebFOCUS Business User Edition**

1. From the Start menu, navigate to the Uninstall shortcut, under the Information Builders Program group.
2. Click *Uninstall*.
   The InstallAnywhere installation program opens.
3. In the Uninstall WebFOCUS Business User Edition 82 window, click *Uninstall*, as shown in the following image.
The installation program begins and uninstalls the WebFOCUS Business User Edition components.

Troubleshooting WebFOCUS Business User Edition

If you are unable to launch WebFOCUS Business User Edition, ensure that all services are running. If they are not, do the following:

- Stop all services.
- Restart the services, and launch WebFOCUS Business User Edition.

If this does not work, stop the services again. Before you restart the services, ensure that the Hyperstage processes, `ibengine.exe` and `postgres.exe`, are also stopped. Restart your machine if you are still unable to restart the services.

Port Assignment

By default, ports in the range of 26000 to 26040 are checked for availability. If the installation program detects that no ports in that range are available, it then increases the range by 10 and checks again for availability. For example, if ports 26000 to 26040 are unavailable, ports 26010 to 26050 are then checked.

Default Port Assignment.

- Ports 26000 to 26003 are used by the application server.
- Port 26010 is used by the repository server.
- Ports 26020 to 26023 and port 26040 are used by the Reporting Server.
- Port 26030 is used by the Distribution Server.

WebFOCUS Business User Edition Log Files

WebFOCUS Business User Edition creates a log file in the following location for Windows:

```
drive:\Users\user_id\WebFOCUS_BUE82_Install_date_time.log
```

```
drive:\Users\user_id\WebFOCUS_BUE82_Debug_date_time.log
```

where:

`user_id`

Is your Windows user ID.
date_time

Is the date and time the log file was created.

These log files provide information about the WebFOCUS Business User Edition installation. If you contact Customer Support Services with an installation problem, have these files available.

Troubleshooting the Uninstall Process

If you choose to uninstall WebFOCUS Business User Edition, and the uninstall process fails, you can follow one of the procedures in this section to clean up your machine before reinstalling the product.

Before performing one of the following procedures, ensure that you have uninstalled WebFOCUS Business User Edition, as described in Uninstalling WebFOCUS Business User Edition on page 39.

**Procedure:** How to Manually Uninstall WebFOCUS Business User Edition Components Using the Cleanup Utility

If the WebFOCUS Business User Edition uninstall process fails, you can run the wf_cleanup.bat file to clean a damaged installation on your machine.

1. Navigate to the following location on your machine:
   
   \drive:\\ibi\\WebFOCUS_BUE82\\WebFOCUS\\utilities\\install\\

2. Copy the \wf_cleanup.bat file from the install directory to a different directory (for example, \drive:\\ibi\\).

3. Right-click \wf_cleanup.bat, and then click Run as administrator.

4. When prompted, type the location of the install directory to proceed.
   
   **Note:** By default, the utility will back up the Reporting Server applications, data, and the Derby database.

**Procedure:** How to Manually Uninstall WebFOCUS Business User Edition Components

If the WebFOCUS Business User Edition uninstall process fails, you can do the following to manually cleanup the remaining WebFOCUS Business User Edition components on your machine.

2. Remove any remaining services from your machine.
   a. Locate the existing WebFOCUS Business User Edition services. To get the service name, right-click the service in the Windows Services program and click Properties. The Properties dialog box opens, where you can right-click the service name and click Copy, as shown in the following image.

   ![WebFOCUS BUE 82 Application Server Properties](image)

   b. To remove a service, open the Command Prompt as an Administrator and issue the following command:

   ```
   sc delete "service name"
   ```

   where:

   **service name**

   Is the name of the service you are manually deleting. For example:
C:\sc delete "WfBUE82AppSrv"

Note: The service name must be enclosed in double quotation marks (".

Repeat this for the remaining services.

3. Open Task Manager and ensure that the process ibengine.exe is not running.

4. Remove files from disk, except for the Reporting Server application folders.
   For example, if WebFOCUS Business User Edition is installed on the C:\ drive, remove all folders under C:\ibi\WebFOCUS_BUE82\, except for the following folders:
   - C:\ibi\WebFOCUS_BUE82\data\
   - C:\ibi\WebFOCUS_BUE82\srv\wfs\hs\
   - C:\ibi\WebFOCUS_BUE82\Derby\WFBUE82\

5. Click Start, point to All Programs, and expand the Information Builders folder.


7. Launch the Windows Registry Editor, and remove the following registry keys.
   - HKEY_LOCAL_MACHINE\SOFTWARE\WebFOCUS_BUE82
   - HKEY_LOCAL_MACHINE\SOFTWARE\Information Builders\Derby\WfBUE82DbSrv
   - HKEY_LOCAL_MACHINE\SOFTWARE\Information Builders\WebFOCUS BUE 82 Reporting Server
   - HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Information Builders \ReportCaster\WfBUE82DistSrv
   - HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Apache Software Foundation \Procrun 2.0\WfBUE82AppSrv

Installing the WebFOCUS Business User Edition on a Linux Environment

The following section describes how to install WebFOCUS Business User Edition on a Linux environment. WebFOCUS Business User Edition is supported on:

- Intel Linux - Kernel-2.6.32-glibc-2.6 and higher x86_64 64-bit

  Note: Java Version 8 Update 162 (8u162) and Tomcat 8.5.29 are included with the WebFOCUS Business User Edition product installation.

- Intel Linux - Kernel-3.10.0-glibc-2.17 and higher x86_64 64-bit
Note: Java Version 8 Update 162 (8u162) and Tomcat 8.5.29 are included with the WebFOCUS Business User Edition product installation.

- Linux on IBM Power Systems - Kernel-3.16.0-libc6-2.19 and higher ppc64le 64-bit (Little Endian)

Note: Java Version 8 Update 161 (8u161) and Tomcat 8.5.29 are included with the WebFOCUS Business User Edition product installation.

The installation program includes the following third-party components: Tomcat, Java, and Derby. Later versions or releases of these third-party components, which often contain fixes for security vulnerabilities, may exist at installation time. It is your responsibility to check the vendor sites listed below for updates to newer versions or releases of these third-party components if you intend to use them with WebFOCUS Business User Edition. Install the new updates or versions prior to proceeding with the WebFOCUS Business User Edition installation. If these components are installed through the WebFOCUS Business User Edition installation program, it is your responsibility to update these components after the installation is completed.

The latest version of Tomcat is available at https://tomcat.apache.org.

The latest version of Java is available at https://www.java.com.

The latest version of Derby is available at https://db.apache.org/derby.

WebFOCUS Business User Edition System Requirements on a Linux Environment

The following section describes the system requirements for installing WebFOCUS Business User Edition on a Linux environment.

Note: Only one installation per platform is supported.

Installation Prerequisites

The following are installation prerequisites for installing WebFOCUS Business User Edition on Linux:

- WebFOCUS Business User Edition cannot be installed as user root, due to requirements of the PostgreSQL database used by Hyperstage. If user root is detected, the installation will exit and the following message displays:

  The installation cannot proceed under the root user account and will terminate. Restart the installation as a non-root user.

- When installing WebFOCUS Business User Edition on Linux machines, if the unzip application is not found, the following message displays:
Invalid unzip command found.

This is generated by the installation program and does not prevent the installation from proceeding and completing successfully.

- WebFOCUS Business User Edition requires a minimum of 5GB of available disk space to successfully install on the target system.

- An additional 8GB of required disk space is used during the installation of the product. This temporary use of disk space will be removed at the end of the installation.

If the temp directory on the host does not meet the minimum size requirements, the InstallAnywhere environment variable IATEMPDIR can be set to use an alternate directory. You may specify an alternate /tmp location by setting the following environment variable:

\[
\text{IATEMPDIR}=/\text{large}\_\text{tmp} \\
\text{export} \text{ IATEMPDIR}
\]

**System Resource Limits**

The operating system provides ways of limiting the amount of resources that can be used. These limits can affect the installation process.

Use the `ulimit` command to set process memory-related resource limits for your session.

The WebFOCUS Business User Edition installation program requires `ulimit` to be set to 8192. Limits can be **hard** or **soft**. Hard limits are set by the root user. Only the root user can increase hard limits, although other users can decrease them. Soft limits can be set and changed by other users, but they cannot exceed the hard limits. To view the current limits, enter the following command:

```
ulimit -a
```

Use the `/etc/security/limits.conf` file to store `ulimit` settings. Changes to this file should be made by a system administrator.

**Installing WebFOCUS Business User Edition Using Console Mode**

The following section describes how to install WebFOCUS Business User Edition using Console Mode.

**Procedure:** How to Install WebFOCUS Business User Edition Using Console Mode

1. Download the self extracting installation program, `installWebFOCUSBUE8203.bin`.  

2. Apply the permissions necessary for the owner of the file to execute the installation by using the following command:

   chmod u+x installWebFOCUSBUE8203.bin

3. Run the installation program using the following command:

   ./installWebFOCUSBUE8203.bin -i console

   The Welcome to WebFOCUS Business User Edition 82 prompt displays.

4. Press Enter to continue.

   The License Agreement prompt displays.

5. Read the License Agreement. Press Enter after each screen until you receive the License Agreement Acceptance prompt.

6. Type Y to accept the terms of the agreement and press Enter to continue.

   The Choose Install Type prompt displays.

7. Type 2 to perform a full installation of WebFOCUS Business User Edition.

8. Press Enter.

   The License Code prompt displays.

9. Type the license code (17 digits) for the WebFOCUS Business User Edition Installation.

   This code was sent to you as part of the email message that contained the download link for the software.

   You are prompted to enter the site code.

10. Type the site code (4 digits) for the WebFOCUS Business User Edition Installation.

    This code was sent to you as part of the email message that contained the download link for the software.

11. Press Enter.

    The Setup Preferences prompt displays.

12. Accept the default destination folder for the installation. If you want to install WebFOCUS Business User Edition in a different folder, type the path to the location where you want to install the software.

    **Note:** Spaces are not allowed in the destination path.

    You are prompted to enter the WebFOCUS Business User Edition Administration credentials.

13. Type a password to use with the Administration ID, manager.
Note:

- The manager Administration ID cannot be changed.
- During the database creation, the password supports ASCII characters from 32 to 126 and cannot include the following characters: caret (^), ampersand (&), percent (%), or double quotation marks ("), Refer to the ASCII character table to determine the characters to use for the password. As a reference, see https://msdn.microsoft.com/en-us/library/60ecse8t(v=vs.71).aspx. The password for the user name must be between four and 20 characters. Leading blanks and trailing blanks will be removed.

The Advanced Configuration prompt displays. Type Y and press Enter if you want to change the default directory location of the WebFOCUS Business User Edition Reporting Server application. Type N and press Enter if you want to use the default directory location of the WebFOCUS Business User Edition Reporting Server.

If you chose to use the default WebFOCUS Business User Edition Reporting Server directory, the Pre-Installation Summary prompt displays.

14. Verify that the information in the Pre-Installation Summary window is correct, and press Enter to continue.

The installation begins.

During installation, the activity window indicates which installation program tasks are being performed.

When installation is complete, a summary is provided displaying the servers that were installed and the ports that have been assigned.

Configuring Java Memory Allocation for the Application Server

For UNIX installations, the default Tomcat Java memory configuration is set to use an initial Java heap size of 256MB and a maximum Java heap size of 512MB.

These settings are in located in the /ibi/WebFOCUS_BUE82/tomcat/bin/catalina.sh file. For example:

```
JAVA_OPTS="-XX:MaxPermSize=256m -Xms256m -Xmx512m -Djava.awt.headless=true"
```

For better product performance, it is recommended to increase these values. The initial Java heap size should be at least 1024MB (1GB). The size is normally set in Megabytes. For example:

```
-Xms1024m
-Xmx2048m
```
These values need to be set based on the physical memory of the machine.
It is recommended to set the minimum/initial memory value to one eighth (1/8) of the physical memory. The maximum value needs to be one quarter (1/4) of the physical memory.

**Launching WebFOCUS Business User Edition**

To launch WebFOCUS Business User Edition, type the following:

```
http://host:port/ibi_apps/
```

**Note:** Enter the application server port number when using this command to start WebFOCUS Business User Edition. The application server port number is the lowest port number displayed in the summary at the end of the WebFOCUS Business User Edition installation.

The default port for the WebFOCUS Business User Edition application server is 26000. It is listed during the end of the installation and also available in the installation log file.

Installation log files are under the user home directory. An example of an installation log file is shown in the example below:

```
/$HOME/WebFOCUS_BUE82_Install_date_time.log
/$HOME/WebFOCUS_BUE82_Debug_date_time.log
```

where:

*date_time*

Is the date and time the log file was created.

These log files provide information about the WebFOCUS Business User Edition installation. If you contact Customer Support Services with an installation problem, have these files available.

**Running WebFOCUS Business User Edition Servers Manually**

The following commands are used to manually start and stop the required WebFOCUS Business User Edition servers.

**Note:** The /home/user/ path depends on your installation.

**Starting Servers**

You must start the servers in the following order:

- Repository Server
- Application Server
Distribution Server

To start the WebFOCUS Business User Edition Repository Server, run:
```
nohup /home/user/ibi/WebFOCUS_BUE82/derby/bin/start.sh &
```

To start the WebFOCUS Business User Edition Application Server, run:
```
/home/user/ibi/WebFOCUS_BUE82/tomcat/bin/startup.sh
```

To start the WebFOCUS Business User Edition Distribution Server, run:
```
nohup /home/user/ibi/WebFOCUS_BUE82/WebFOCUS/ReportCaster/bin/schbkr &
```

To start the WebFOCUS Business User Edition Reporting Server, run:
```
/home/user/ibi/WebFOCUS_BUE82/srv/wfs/bin/edastart -start
```

Stopping Servers

You must stop the servers in the following order:

- Application Server
- Distribution Server
- Repository Server
- Reporting Server

To stop the WebFOCUS Business User Edition Application Server, run:
```
/home/user/ibi/WebFOCUS_BUE82/tomcat/bin/shutdown.sh
```

To stop the WebFOCUS Business User Edition Distribution Server, run:
```
/home/user/ibi/WebFOCUS_BUE82/WebFOCUS/ReportCaster/bin/stopit
```

To stop the WebFOCUS Business User Edition Repository Server, run:
```
/home/user/ibi/WebFOCUS_BUE82/derby/bin/stop.sh
```

To stop the WebFOCUS Business User Edition Reporting Server, run:
```
/home/user/ibi/WebFOCUS_BUE82/srv/wfs/bin/edastart -stop
```

Creating Shell Scripts to Start and Stop Servers

You can create shell scripts that run the following commands to start and stop servers:
**Start Servers**

```
nohup /home/user/ibi/WebFOCUS_BUE82/derby/bin/start.sh &
sleep 5
/home/user/ibi/WebFOCUS_BUE82/tomcat/bin/startup.sh
nohup /home/user/ibi/WebFOCUS_BUE82/WebFOCUS/ReportCaster/bin/schbkr &
/home/user/ibi/WebFOCUS_BUE82/srv/wfs/bin/edastart -start
```

**Stop Servers**

```
/home/user/ibi/WebFOCUS_BUE82/tomcat/bin/shutdown.sh
/home/user/ibi/WebFOCUS_BUE82/WebFOCUS/ReportCaster/bin/stopit
/home/user/ibi/WebFOCUS_BUE82/derby/bin/stop.sh
/home/user/ibi/WebFOCUS_BUE82/srv/wfs/bin/edastart -stop
```

**Note:**

- Adjust the paths based on your installation directories.
- The sleep 5 command adds a wait period to ensure Derby has started.

**Updating WebFOCUS Business User Edition**

You can update an earlier release of WebFOCUS Business User Edition using the following steps.

**Procedure: How to Update WebFOCUS Business User Edition**

2. Ensure that all ports that are used by WebFOCUS Business User Edition processes are stopped. You can run a command, such as `netstat`, to check the ports.
   - **Note:** If the ports are busy, run a command, such as `lsof`, to identify what processes are still running, and stop those processes. Before you proceed, you must rerun the `netstat` command.
3. Download the self extracting installation program, `installWebFOCUSBUE8203.bin`.
4. Apply the permissions necessary for the owner of the file to execute the installation by using the following command:
   ```bash
   chmod u+x installWebFOCUSBUE8203.bin
   ```
5. Press Enter to continue.
   - The License Agreement prompt displays.
6. Run the installation program using the following command:
   ```bash
   ./installWebFOCUSBUE8203.bin -i console
   ```

7. Read the License Agreement. Press Enter after each screen until you receive the License Agreement Acceptance prompt.

8. Type **Y** to accept the terms of the agreement and press Enter to continue.

The Choose Install Type prompt displays.

9. Type **1** to update an existing WebFOCUS Business User Edition installation to a new Service Pack level.

10. Press Enter.

11. Verify that the information in the Pre-Installation Summary window is correct, and press Enter to continue.

The installation begins.

During installation, the activity window indicates which installation program tasks are being performed.

12. Clear the Tomcat cache, all folders under:

   `/home/user/ibi/WebFOCUS_BUE82/tomcat/work/Catalina/localhost/`


14. Start the WebFOCUS Business User Edition Repository Server by running:

   `nohup /home/user/ibi/WebFOCUS_BUE82/derby/bin/start.sh &`

15. Run the following script file, if this step failed to run during the installation update process.

   `/home/user/ibi/WebFOCUS_BUE82/WebFOCUS/utilities/WFReposUtil/update_repos.sh`

   This script will make updates to the WebFOCUS Business User Edition repository that are required to load new roles and BI Portal page templates.

   You are prompted for WebFOCUS Business User Edition Administrator credentials. The built-in user ID is manager.

16. Start the other servers:

   `/home/user/ibi/WebFOCUS_BUE82/tomcat/bin/startup.sh`
   `nohup /home/user/ibi/WebFOCUS_BUE82/WebFOCUS/ReportCaster/bin/schbkr &`
   `/home/user/ibi/WebFOCUS_BUE82/srv/wfs/bin/edastart -start`

The upgrade is now complete and you can use the software.
Uninstalling WebFOCUS Business User Edition

To uninstall WebFOCUS Business User Edition, delete the /home/user/ibi/WebFOCUS_BUE82/ folder or run the uninstall program using the following command:

/home/user/ibi/WebFOCUS_BUE82/Uninstall/Uninstall

Configuring for Email Distribution

An email server is required for email distribution and notifications. The following procedures provide the steps for configuring the supported mail servers.

Procedure: How to Configure the Mail Server

1. From the Business User Edition Portal Menu bar, click Administration, then click Administration Console. Click the ReportCaster tab.

   or

   From the Business User Edition Portal Menu bar, click Tools, then click ReportCaster Status.

2. Click the Configuration option on the ribbon.

3. Select the Email Distribution folder.

4. Type the name of your mail server in the Mail Server text box.

   In addition, if your mail server uses a secure connection or requires authentication, select the appropriate options and type the required credentials. You need to save your configuration changes and restart ReportCaster to make the changes effective.

   If you use Google as your email server, see How to Configure Google as the Email Server on page 54.

   If you use Yahoo as your email server, see How to Configure Yahoo as the Email Server on page 55.
**Procedure:** How to Configure Google as the Email Server

1. Type the name of the Google SMTP Server in the Mail Server text box, as shown in the following image.

![Image showing configuration settings with Google SMTP Server details](image.png)

2. Select the *This Server Requires a Secure SSL Connection* check box.
3. Do not select the *This Server Requires a Secure TLS Connection* check box.
4. Select the *This Server Requires Authentication* check box.
5. Click the button to open the SMTP User ID/Password dialog box.
6. Type your Google account name.
7. Type the password for this account.
8. Confirm the password for this account.
9. Click *OK* to close the dialog box.
10. Click *Save* in the Manage Configuration group on the ribbon.
11. Click *Restart* in the Manage Configuration group on the ribbon.
Procedure: How to Configure Yahoo as the Email Server

1. Type the name of the Yahoo SMTP Server in the Mail Server text box, as shown in the following image.

2. Select the This Server Requires a Secure SSL Connection check box.

3. Select the This Server Requires a Secure TLS Connection check box.

4. Select the This Server Requires Authentication check box.

5. Click the button to open the SMTP User ID/Password dialog box.

6. Type your Yahoo account name.

7. Type the password for this account.

8. Confirm the password for this account.

9. Click OK to close the dialog box.

10. Click Save in the Manage Configuration group on the ribbon.

11. Click Restart in the Manage Configuration group on the ribbon.

Navigating the Environment

This topic introduces the Business User Edition environment. It describes how to navigate the Business User Edition portal, the Administration Console, and InfoAssist.
It is also important to understand that Manager users, Developers, Advanced users, and Basic users have different access to environment options. That access is determined by the group of users to which you are assigned.

Navigating the Business User Edition Portal

When you access the Business User Edition, using the Sign-in page or browser URL, you are presented with the Business User Edition portal. From the portal, depending on your user role, you can create and edit content, view content that other users published or shared, create and edit personal pages, manage users, configure the system, upload files to the repository, connect to data and edit data, and access interactive help and instructional materials.

The main components of the Business User Edition portal include a Home page, Resources tree, and Menu bar.

Home Page

The Home page, which is shown in the following image, is the first page that you see when you sign in.

The Home page has three sections with which you can interact:

- Menu bar
- Sidebar
- Explorer

The content in these sections varies, depending on your user type.
Menu Bar

The Menu bar is located in the upper-right section of the screen, inside the top banner. The following image shows the Menu bar that appears when you are signed in as a Manager.

The Menu bar gives you access to the following options:

- **Change your password (click your username).**
- **Tools:**
  - View the status of deferred reports, and manage them.
  - Stop your outstanding interactive requests that are running.
  - Access Session Viewer, where you can visualize the exploratory analysis of the current web session.
  - Access the ReportCaster Status, where you view the status of your scheduled jobs and log reports.
- **Administration:**
  - Access the Security Center, where you define users and groups and grant access permissions.
  - Access the Administration Console, where you configure, administer, and monitor the components of the application.
  - Access the Reporting Server Console, where you can view and manage the server environment.
  - View and administer the private resources for groups and users.
  - Switch between Normal mode (seeing your own content) and Manager mode (managing other user content).
- Open the WebFOCUS Resources panel on the right side of the window, so you can manage content on personal portal pages.
- Access the online Help, additional Technical Content resources, Information Builders Home page, as well as information about the Business User Edition application, version, and available licenses.
Sidebar

You can use the sidebar to switch between two views of your repository content. These include:

- **Content.** Displays your repository content and provides options so you can create, share, and modify domains and content. Here, you can also upload files and spreadsheets, connect to data, create portals and pages, and generate sample content.

- **Favorites.** Displays the items that you designate as favorites. To designate an item as a Favorite, right-click the item, and click Favorites.

Explorer

The Explorer is the main component of the Home page. Here, you can create and interact with content, work with data, create sample content, organize your repository structure and perform other essential tasks. The Explorer is shown in the following image.

The Explorer consists of the following elements:

- Navigation bar

- Resources tree
Actions bar

Content area

**Navigation Bar**

The navigation bar is located beneath the banner and above the explorer area. You can use the navigation bar to move between folders in your repository, search the contents of a domain or folder, change the view of items in the content area, and refresh content in a domain or folder you select.

A domain node is the highest level of folder organization in the Resources tree. All of the domains that a user is authorized to access are displayed in the tree. Domains contain all of the components and content that you can create.

When you drill down into folders in your repository, the navigation bar generates a breadcrumb trail that you can use to move between folders. You can move back one folder or multiple folders in a single click. You can click a folder name to view the contents of that folder. You can also click arrows between the folders, to see the file structure that is currently displayed, as shown in the following image. The selected folder appears in bold text.
From the navigation bar, you can also search for items in your repository. To search for an item, type a keyword in the Search field and press Enter. The results of your search display in the content area. If the items in your results contain tags, these tags display with your search results. An example of user-defined tags in a search is shown in the following image.

Note: Until you enter text, the Search field contains the name of the domain or folder as placeholder text. When you enter text into the Search field, an X appears. Click the X to clear the Search field. The X does not appear if you use a Firefox browser.

You also can toggle the view of your content between Grid View and List View, and refresh all content in a domain or folder. By default, content displays in Grid View. Click the Grid view icon or List view icon to change your view.
Grid View allows you to see the thumbnails of your items, which you can customize to add transparency to your display. The List View is useful when you need to see a large number of items at a glance. You can sort your items by various criteria. An example of a List View is shown in the following image.

You can sort the list by clicking any column title. Each column features a three-step toggle sorting: ascending, descending, and back to default. You can also specify which columns display in the content area by clicking the Settings button, and selecting the desired columns from the list. An example of an expanded settings menu is shown in the following image.
To refresh all content in a selected domain or folder, click Refresh.

Resources Tree

The Resources tree provides a way to view your repository structure and navigate between domains and folders that are available to you. The following image shows an example of a Resources tree.

You can expand or collapse folders by clicking the plus (+) or minus (-) sign. When you click a folder, its contents display in the content area. You can also right-click a folder to access a shortcut menu of available options. From the shortcut menu, you can perform the following actions:

- Expand or collapse a folder
- Duplicate a folder
- Cut or copy a folder
- Paste content or another folder inside a folder
- Delete a folder
- Allow or suppress access to a folder
- Show or hide a folder
- Configure security rules for a folder
- View and edit properties for a folder
You can customize the width of the Resources tree. To do so, put your cursor on top of the left edge of the Resources tree area, as shown in the following image, and drag the edge to achieve the desired width. Your new width is remembered, and displays the next time you sign in.

You can also collapse the Resources tree to allow more room for the content area. To collapse the Resources tree, click the arrow on the left side of the tree. Click the arrow again to expand the Resources tree.

**Actions Bar**

You can use the actions bar to create analytical content, upload files and spreadsheets, connect to data, build portals and pages, schedule procedures, and generate sample content using the options available to you for a domain or folder. The following image shows an example of the actions bar an advanced or basic user has access to for a domain or folder.

The default view of the actions bar displays the most common options available to you. You can access additional options by clicking *More*.

The actions bar only displays the items that you can create for the domain or folder that is currently selected. If you click the Domains node, the actions bar only displays the Domain and Folder options. The items that display on the actions bar are also subject to permissions. You can only see the items that are available to you based on your role.
Similar to the Resources tree, you can collapse the actions bar to make more room for the content area. To collapse the actions bar, click the arrow in the upper-right corner of the actions bar, as shown in the following image.

![Actions Bar Collapse](image)

**Types of Content You Can Create in the Business User Edition**

There are many types of content that you can create in the Business User Edition, using the action bar on the Home page. The most common content items include: charts, visualizations, reports, and pages. To access more options, click *More*.

**Note:** Access to all options on the actions bar is determined by your role in a domain. Contact your administrator to obtain access to additional options.

The following table lists and describes all of the content items that you can create from the Home page.

<table>
<thead>
<tr>
<th>Action Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Chart" /></td>
<td><strong>Chart.</strong> Creates a graphical representation of your data.</td>
</tr>
<tr>
<td><img src="image" alt="Visualization" /></td>
<td><strong>Visualization.</strong> Creates a graphical representation of your data, comprised of one or more visuals. Visuals can be charts, maps, or grids.</td>
</tr>
<tr>
<td><img src="image" alt="Report" /></td>
<td><strong>Report.</strong> Creates a tabular representation of your data.</td>
</tr>
<tr>
<td><img src="image" alt="Document" /></td>
<td><strong>Document.</strong> Creates a customized document.</td>
</tr>
<tr>
<td><img src="image" alt="Sample Content" /></td>
<td><strong>Sample Content.</strong> A set of sample charts, reports, and dashboard that is generated automatically based on uploaded Excel workbooks, CSV files, or existing single-segment Master Files in your repository.</td>
</tr>
<tr>
<td>Action Button</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>-------------</td>
</tr>
<tr>
<td>![Page icon]</td>
<td><strong>Page</strong>. Launches WebFOCUS Designer, where you can create a flexible interactive application for various BI content, including charts, visualization, reports, maps, URLs, and other resources.</td>
</tr>
<tr>
<td>![Portal Page icon]</td>
<td><strong>Portal Page</strong>. Creates a domain portal page from which you can organize dynamic content. Domain portal pages can be added to the portal.</td>
</tr>
<tr>
<td>![Blog icon]</td>
<td><strong>Blog</strong>. Creates an interactive item that operates as commonly seen blogs on the internet, and allows users to post and view comments.</td>
</tr>
<tr>
<td>![Distribution List icon]</td>
<td><strong>Distribution List</strong>. Specifies the email addresses, directory locations, or printers that you can configure to distribute a schedule. This includes Email, FTP, or Printer.</td>
</tr>
<tr>
<td>![URL icon]</td>
<td><strong>URL</strong>. Creates a link to a webpage that can be displayed inside a portal or page or within the Repository.</td>
</tr>
<tr>
<td>![Shortcut icon]</td>
<td><strong>Shortcut</strong>. Creates a shortcut to a repository file or a Master file.</td>
</tr>
<tr>
<td>![Upload File icon]</td>
<td><strong>Upload File</strong>. Uploads files such as images and office documents to the repository.</td>
</tr>
</tbody>
</table>
Content Area

The content area displays the items contained within a domain or folder that is currently selected. An example of a content area is shown in the following image.

![Content Area Example]

If a resource contains folders and items, the folders are always displayed first, followed by the items. Items shown in the content area include reports, charts, pages, portals, and more.

You can sort your content by using the two sorting menus in the upper-left corner of the Content Area. One allows you to sort by various criteria, such as title, summary, size, last modified and published dates. The other menu toggles between the descending and an ascending orders. You can also create a customized sorting order, by configuring the Sort Order property for the item. If the sort order is configured, the Default Sort option is added to the menu.

You can right-click any folder or item to access a shortcut menu of options. The following options are available when you right-click a folder or item in the content area.

**Expand/Collapse**
- Expands or collapses a folder. This option is only available for folders.

**Run**
- Runs the report procedure or schedule.

**Run in new window**
- Runs the item in a new window.

**Run deferred**
- Submits a report procedure or a schedule for deferred execution.
**Schedule**
Launches the scheduling tool, where you can schedule a report procedure to be run. Scheduling options include Email, Printer, and Repository.

**View log**
Launches the Schedule Log Options dialog box, where you can select whether to view the most recent log report for the schedule, or specify a time range for which to obtain log reports. This option is only available for schedules.

**View**
Enables you to launch the URL or download a copy of the file to your browser. This option is available for URLs, Excel Workbooks, PDF, HTML, and Image Files.

**Edit**
Edits an item with the tool that was used to create it.

**Duplicate**
Makes a copy of the folder or item with an underscore and number appended to the title, for example, duplicating Sales_Report creates Sales_Report_1 in the same location. The number is incremented each time a duplicate is created.

**Cut, Copy, and Paste**
Cuts, copies, or pastes the folder and its contents or item.

**Create shortcut**
Creates a shortcut to this item.

**Delete**
Deletes the folder and its contents or item.

**Publish/Unpublish**
Allows or suppresses public access to the content.

**Show/Hide**
Shows or hides the folder or item.

**Share/Unshare**
Shares content with all users that are permitted to access this content. Unshare stops sharing content with all users.

**Comments**
Provides access to the following options:

**View comments**
Opens the blog item and expands all comments.

**Remove all comments**
Clears all comments from the blog.

**Note:** These options are only available for blogs.
Add to favorites
Adds the item to the Favorites folder.

Remove favorite
Removes the Favorite from the list. This option is only available for Favorites.

Security
Provide access to the Owner option, which allows you to set the resource owner, either Published (no specific owner), or a specific group or user.

Properties
Shows the properties of the folder or item.

Folder and Item Properties
Authorized users can select the Properties option to review information about a folder or item, including when it was created, the date it was last modified, title, name, and settings that control the functionality available to users when they access the folder, run, or schedule an item.

The General Properties tab includes the following settings:

- **Title.** Displays the value that you can use to identify the content in the Resources tree.

- **Name.** Refers to the unique name of the item or folder. Click the Edit button to change the name.

- **Summary.** Detailed explanation that provides additional information about the item.

- **Path.** Full path of the folder or item in the Repository.

- **Created.** Shows the date the folder or item was created.

- **Modified.** Shows the date the folder or item properties were last modified, and identifies the user that modified them.

- **Accessed** Shows the date the folder or item was last opened, and identifies the user that opened it.

- **Tool.** Specifies the type of an item.

- **Owner.** Identifies the user who created the folder or item.

- **Size.** Displays N/A bytes for folders. For items, displays the size in bytes.

- **Publish.** Provides an option to publish or unpublish the folder or item.
Show. Provides an option to show or hide the folder or item.

The Advanced tab allows you to customize the functionality and behavior of the folder or item.

The Advanced Properties tab includes the following properties.

Explorer/Portal Properties:

- **Thumbnail.** Allows you to preview and change the thumbnail for an item.
- **Sort order.** Specifies the order to list the folder in the tree or item within other items in a folder.
- **Language.** Indicates the current language of your environment.
- **View All.** Opens the Language Properties dialog box, where you can select a language.
- **Load in iFrame.** Grants or suppresses a permission to load an item in an iFrame container.
- **Default width.** Sets a default width value for the item, when it is displayed inside the portal at run time.
- **Default height.** Sets a default height value for the item, when it is displayed inside the portal at run time.

Search Properties:

- **Tags.** Adds tag values to the item that display in the search results.

Interactive Reporting Properties:

- **Prompt for parameters.** Indicates whether to display the Autoprompt HTML page to allow the user to view and select parameter values. When this check box is clear, users will still be prompted if there are any parameters that do not have a value supplied.
- **Enable AutoLinking.** Establishes drill-down links from column data to the target reports that you link together.
- **AutoLink target.** Identifies a report as the target report that is run when the drill-down link is triggered.

Note: The AutoLinking between reports only works if the target report contains a parameterized field that corresponds to one of the fields in the primary AutoLink report.

- **Enable AutoDrill.** Creates drill-down links in reports and charts that contain hierarchical data.
Use title for deferred report description. Indicates whether or not to prompt for a custom deferred report description. If selected, this option gives you an alternative to being prompted for a custom deferred report description.

Only run as deferred report. Runs the report in deferred mode.

Scheduling and Library Content Properties:

Restrict schedule to Library only. Prevents emails distribution for security-sensitive scheduled reports, and restricts them to the library distribution only.

Note: This property does not apply to the Business User Edition.

The Query Detail Properties tab, is only available for reports, charts, and visualizations. It shows which data elements, parameters, and conditions were used in an item.

Navigating the Administration Console

The Administration Console contains four tabs and a menu bar that help you navigate to its settings and other features.

These tabs organize administration activities into the following categories:

- **Configuration.** Configures Reporting Server Connections, Application Settings, Custom Settings, NLS Settings, Dynamic Language Switch, Redirection Settings, and InfoAssist Properties.

- **Security.** Configures general security settings for Internal and External Authentication.

- **ReportCaster.** Opens the ReportCaster Console, where you can configure ReportCaster, restart the Distribution Server, configure environment parameters, and turn traces on and off. The Administration Console authenticates to ReportCaster with the value of the user ID, IBIMR_RC_SVCUSER. If this authentication fails, users are prompted for their credentials.

- **Diagnostics.** Displays component installation and configuration details, turns session logging on or off, and enables Managers to view or delete log files.

  You can view traces with the Session Viewer, which is accessible from the Tools option on the Menu bar in the Portal.

Options on the menu bar connect you to basic tasks, such as reviewing Business User Edition and third-party licensing information, clearing the cache, closing the Administration Console, or opening the online Help.
To update or review an Administration Console setting, click a tab, and then click the folder or page icon from the main menu on your selected tab. The main window refreshes and the individual settings assigned to your selected page become available.

**Navigating the Configuration Tab**

The Configuration tab contains settings and features that describe Reporting Server connections and other application settings, which are listed and described in the following table.

<table>
<thead>
<tr>
<th>Folder [Page]</th>
<th>Available Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Reporting Servers</strong></td>
<td>The Reporting Servers subfolders contain the tools that manage all connections from the client to remote servers. Using the following sub-folders, you can:</td>
</tr>
<tr>
<td></td>
<td>✅ <strong>Server Connections.</strong> Add and change Remote Services settings. In WebFOCUS Business User Edition, this feature is limited to the main reporting server, EDASERVE.</td>
</tr>
<tr>
<td></td>
<td>✅ <strong>Alternate Server Mappings.</strong> Configure alternate mappings to individual Remote Servers. This feature is not available in WebFOCUS Business User Edition.</td>
</tr>
<tr>
<td><strong>Configuration</strong></td>
<td>Pages in the Application Settings folder of the Configuration tab manage settings for the WebFOCUS Business User Edition application. Pages in this folder include settings for the following functional areas:</td>
</tr>
<tr>
<td>[Application Settings]</td>
<td>✅ Change Management</td>
</tr>
<tr>
<td></td>
<td>✅ Deferred Reporting</td>
</tr>
<tr>
<td></td>
<td>✅ ESRI</td>
</tr>
<tr>
<td></td>
<td>✅ Parameter Prompting</td>
</tr>
<tr>
<td></td>
<td>✅ Text Generation Server</td>
</tr>
</tbody>
</table>


<table>
<thead>
<tr>
<th>Folder [Page]</th>
<th>Available Functionality</th>
</tr>
</thead>
</table>
| Configuration [Custom Settings]      | The Custom Settings page of the Configuration tab contains a text-based input field where you can define advanced customization settings for the Client. Using this page, you can:  
|                                      | - Customize Client settings.                                                                                                                                                                                             |
|                                      | - Create a Client site profile.                                                                                                                                                                                         |
|                                      | - Create a Client universal profile.                                                                                                                                                                                   |
| Configuration [Dynamic Language Switch] | The Dynamic Language Switch page of the Configuration tab contains a list of languages that can be included in this feature.                                                                                          |
| Configuration [Redirection Settings] | The Redirection Settings page of the Configuration tab contains settings that manage the redirection of report output.                                                                                                 |
Navigating the Security Tab

The Security tab contains internal and external security settings, which are listed and described in the following table.

<table>
<thead>
<tr>
<th>Folder [Page]</th>
<th>Available Functionality</th>
</tr>
</thead>
</table>

Navigating the ReportCaster Tab

When you click the ReportCaster tab, the ReportCaster Server Status page opens, by default. Features on that page identify the current status of ReportCaster Server operations. For more information, see Using the ReportCaster Console on page 162.
Navigating the Diagnostics Tab

The Diagnostics tab contains settings and features that describe system performance and activities, which are listed and described in the following table.

<table>
<thead>
<tr>
<th>Folder [Page]</th>
<th>Available Functionality</th>
</tr>
</thead>
<tbody>
<tr>
<td>Diagnostics</td>
<td>The Diagnostics section of the Administration Console contains the following functional areas:</td>
</tr>
<tr>
<td></td>
<td>- <strong>About WebFOCUS.</strong> Displays version and release information about your installation of WebFOCUS Business User Edition.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Client Verification.</strong> Displays your directory permissions and the status of your ability to perform common operations.</td>
</tr>
<tr>
<td></td>
<td>- <strong>HTTP Request Info.</strong> Displays information about HTTP request headers.</td>
</tr>
<tr>
<td></td>
<td>- <strong>JVM Property Info.</strong> Displays information about your Java VM environment.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Session Monitor.</strong> Displays session monitor events and links to detailed traces.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Log Files.</strong> Displays links to WebFOCUS Business User Edition log files.</td>
</tr>
</tbody>
</table>

Reviewing Version Information

The About WebFOCUS page displays information about the release you are using and the optional components installed with it.

You can use the information on this page to identify your current product release and service pack when corresponding with the Information Builders Customer Support team.

When you click **About WebFOCUS**, the following information appears in the main window:

- **Edition.** Name of the edition of WebFOCUS, for example, WebFOCUS Business User Edition.
- **Product Release.** Release number, for example, 8.2.
- **Service Pack.** Service pack number, for example, 0.2.
- **Package Name.** Installation file package name, for example, wb102417b.
**Release ID.** Product release number, for example, 8202.

**Build/GEN Number.** Specific product build number, for example, 88.

**Build/GEN Date.** Date and time the build number was generated, for example, October 24, 2017 9:09:01 PM EDT.

**Application Server.** Application Server, for example, Apache Tomcat/8.5.20.

This version of the About WebFOCUS page, that opens from the Diagnostics tab, is only available to those users whose privileges allow them to open and review the Administration Console.

However, the information on this page is also available to those users whose privileges allow them to view the About WebFOCUS Business Intelligence window. To open this other window, in the Business User Edition Portal, on the Menu bar, click *Help*, and then click *About*.

**Reviewing Client Verification**

The Client Verification page displays the current status of client configuration and application settings. When you open this page, the client automatically conducts the test required to verify that configuration and application settings are open and available.

Settings marked pass are available for use. Settings marked fail are not available for use.

The automated verification process includes checking web server aliases and directory permissions for each type of client communication mode (CGI, WFServlet, or ISAPI).

The Client verification tools, by default, place the verification logs in the \logs directory. These tools test read, write, and remove permissions for the \logs directory. They also test read and write permissions for the \config directory.

To test a Reporting Server connection and the current status of the Graph or Table functionality it can deliver, you must open the Configuration tab, and right-click the icon for the Reporting Server you wish to test. All three tests are available on the shortcut menu assigned to each server icon.

**Procedure:** How to Verify WebFOCUS Business User Edition

From the Administration Console, click *Diagnostics*, and then click *Client Verification*.

The Client Verification page displays your directory permissions, such as creating and deleting applications, signing in as the administrator, reading and writing from the standard directories, creating and deleting domains, and creating and deleting reports.
Note: If you run this test immediately after performing the installation procedure, there might be a delay resulting from a slow or delayed first time initialization of the Tomcat Web Application that supports client operations.

HTTP Request Headers and JVM Property Information

The Diagnostics tab also contains information about HTTP request headers and your Java VM environment.

- Settings on the HTTP Request Info page display information about the HTTP or HTTPS headers returned to your browser. This information is useful for troubleshooting and configuring HTTP headers, especially if you integrate web or application server security with WebFOCUS Business User Edition or if your web or application server uses virtual hosts (HTTP headers).

- Settings on the JVM Property Info page display information about your Java VM environment. This information is useful for troubleshooting and configuring the Java environment for web applications and for resolving memory or resource issues.

Navigating the InfoAssist Interface

InfoAssist provides an intelligent, flexible layout for creating reports, charts, visualizations, and documents.

The application window provides intuitive menus and toolbars, a versatile ribbon that provides access to specialized groups for different functional areas of report design, a taskbar for selecting output, and a status bar for directing output.

The application window also provides a resources area for selecting and sorting data, and a multi-faceted results area that can display report design, a preview of report output, or actual report output.
InfoAssist Application Window

The components of the InfoAssist Application window are shown in the following image.

1. **Application button.** Provides access to the Application menu of procedure-related commands.

2. **Quick Access Toolbar.** Displays frequently-used commands, such as New, Open, Save, Undo, Redo, View code, Run, and Preview, in a toolbar that remains visible. For more information, see Quick Access Toolbar on page 81.

3. **Ribbon.** Displays the commands you need to create reports, charts, visualizations, and documents. It also displays the Help menu. For details, see Ribbon on page 84.

4. **Help.** Provides access to the online technical content for InfoAssist in a new browser window.

5. **Resources panel.** Displays the Data pane, Query pane, and Filter pane.

6. **Canvas.** Displays the results of your report. In Live Preview mode, the canvas displays a preview of the file as it is developed.

The main interface components are explained as follows:

1. **Application button.** Provides access to the Application menu of procedure-related commands.

2. **Quick Access Toolbar.** Displays frequently-used commands, such as New, Open, Save, Undo, Redo, View code, Run, and Preview, in a toolbar that remains visible. For more information, see Quick Access Toolbar on page 81.

3. **Ribbon.** Displays the commands you need to create reports, charts, visualizations, and documents. It also displays the Help menu. For details, see Ribbon on page 84.

4. **Help.** Provides access to the online technical content for InfoAssist in a new browser window.

5. **Resources panel.** Displays the Data pane, Query pane, and Filter pane.

6. **Canvas.** Displays the results of your report. In Live Preview mode, the canvas displays a preview of the file as it is developed.
Depending on the type of file that you are developing, the canvas may display differently. For example, when creating a document, the canvas includes rulers around the development area. This is to assist you in placing the components on to the document.

7. **Navigation taskbar.** Displays groups and icons that provide different views and quick access to all active reports and report output. For details, see *Using the Navigation Taskbar* on page 94.

8. **Status bar.** Provides an output format button that you click to see the selected format and an output target button that you click to view the selected option for displaying new output windows or tabs. For more information, see *Using the Status Bar* on page 95.

**Application Main Menu**

In the upper-left corner of the InfoAssist interface, click the IA button 📊 to open the Application main menu.

You can run the following commands from the Application main menu:

- **New.** Opens the InfoAssist splash screen, where you can create a new report, chart, visualization, or document. The exact functionality of the New command depends on your current InfoAssist session.

  When you open a new session of InfoAssist and then click *New*, a new report is created. You are prompted to choose a data source.

- **Open.** Opens an existing report, chart, visualization, or document.

- **Save.** Saves a report, chart, visualization, or document.

- **Save As.** Saves a report, chart, visualization, or document with a new name.

- **Run.** Runs a report, chart, visualization, or document.

- **Run Deferred.** Submits a report, chart, or document for processing in the background while you continue to work on other tasks.

- **Close.** Closes the currently active report, chart, visualization, or document.
Recent Items. Displays recent reports, charts, visualizations, and documents and those items that have been pinned to the menu. The Recent Items area of the InfoAssist Application main menu is shown in the following image.

![Recent Items](image)

Pinned reports, charts, visualizations, and documents are represented by a blue pin icon. Pinned items appear at the top of the list in alphabetical order.

Recent reports, charts, visualizations, and documents are represented by a sideways blue pin icon. Recent items appear below the separator bar in the order in which they were created, with the most recently created item at the top.

You can pin important reports, charts, visualizations, and documents to the top of the Recent Reports section of the Application main menu for quick and easy access. To promote a recent report to pinned report, click the sideways blue pin icon. The icon turns upright and the report is moved to the pinned report area of the Recent Items window, where it stays until it is unpinned.

To demote a pinned report, click the blue pin icon. The icon turns sideways and the report is moved below the separator bar.
A shortcut menu is available when right-clicking a recent item, as shown in the following image.

The options in the menu are:

- **Open.** Opens the selected report, chart, visualization, or document.

- **Pin to list.** Pins or unpins a recent report, chart, visualization, or document to the pinned reports list above the separator bar.

- **Remove from list.** Unpins a pinned report, chart, visualization, or document from the pinned reports list.

- **Clear unpinned list.** Clears all unpinned reports, charts, visualization, or documents from the Recent Items list.

- **Options.** Opens the Options window to customize your user preferences.

- **Exit.** Exits the application.
Reference: Open Dialog Box

The Open dialog box displays when you launch InfoAssist. It also displays when you join and blend data. You can use this dialog box to do the following:

- Select data sources for creating reports, charts, visualizations, and documents.
- Select data sources for joining and blending data.
- Configure data adapters for connecting to an existing database and creating synonyms.
- Upload user data.

The Open dialog box contains the following options:

Connect to Data

Opens the Connect to Data wizard, where you can configure a Data Adapter to connect to an existing database and create synonyms.

Upload Data

Opens the Upload wizard, where you can upload user data from a machine to which you have access. This data can be used with WebFOCUS reporting.

Open

Opens the selected Master File.

Quick Access Toolbar

The Quick Access Toolbar provides access to the most commonly used functions. It is located to the right of the Application main menu button and is always visible no matter which options are selected.

- Create a new report, chart, document, or visualization. Opens the InfoAssist splash screen, where you can create a new report, chart, document, or visualization.
- Open existing item. Opens the Open dialog box, where you can select an existing item.
- Save. Saves a report, chart, document, or visualization.
- Undo and Redo. The Undo icon undoes your last action. The Redo icon repeats your last action.

The Undo icon is enabled (blue) when there is an action to undo. Otherwise, the icon is unavailable (gray). The Redo icon is enabled (blue) when there is an action to redo. Otherwise, the icon is unavailable (gray).
For example, if you add a database field to a report, the Undo icon turns blue. You can now click the Undo icon to remove the database field from the report. The Undo icon turns gray, and the Redo icon turns blue. To restore the field to the report, click the blue Redo icon.

You can also press Ctrl+Z to undo an action, or Ctrl+Y to redo an action.

You can undo and redo up to 25 actions per session. InfoAssist maintains the undo and redo list of actions even when you switch between reports.

When a dialog box is open in the application window, you cannot use the Undo and Redo icons. However, when you click OK and close the dialog box, the icons become available for use. With a single click of Undo, you can undo all the actions that you performed in the dialog box, and you can reinstate them with a single click of Redo.

- **View code.** View the underlying code for the report.

- **Procedure Settings.** Click the Procedure Settings button to specify and control items for inclusion in a procedure. The Procedure Settings dialog box presents various SET commands which are useful when you need to tailor your report, chart, or document presentation or content to meet your individual needs. For more information, see *Using Procedure Settings* on page 374.

- **Create Thumbnail.** In InfoAssist, you can create and store thumbnail images for use in the Business Intelligence Portal. Thumbnail images allow you to see a snapshot of a report or chart without opening the file. In InfoAssist, you can create a thumbnail image by clicking on the Create Thumbnail icon, which is located on the Quick Access toolbar.
You can create thumbnail images when working in Report and Chart mode in InfoAssist. These images are smaller renditions (220x160px) of your actual report or chart as it displays in Live Preview. Once you create the thumbnail and save the report or chart, you can access the thumbnail image from the file list on the Home page, as shown in the following image.

**Note:** Thumbnail images are stored as part of the procedure when it is saved in the repository. For more information, see *How to Create a Thumbnail Image of a Report or Chart* on page 831.

- **Run.** Click the *Run* button to run a report, chart, visualization, or document immediately. Click the down arrow to open the Run menu, which contains the following additional options:
  - **Preview.** Runs the report, chart, or document in the selected format with the limited number of records as set in the Design group on the Home tab.
  - **Run with Default Parameter Values.** Runs a report or chart using the default parameter values. If you have parameters defined, the default value is the first data field defined for the parameter. If you do not have parameters defined, the report or chart will run, regardless.
SQL Trace. Returns the SQL commands for the request.

SQL Preview Trace. Returns the SQL commands for the Live Preview run.

Ribbon

The ribbon is a rectangular area of distinct groups of buttons that spans the top of the InfoAssist application window.

The ribbon is contextual and changes depending on the type of file that you are developing. For example, in Chart mode, the ribbon is made up of nine tabs, whereas when working in Visualization mode, the ribbon consists of five tabs. Each tab contains a subset of InfoAssist functionality organized in logically-related groups of controls and commands graphically represented by distinctive icons.

Working With the Ribbon

The ribbon contains two types of arrow-based buttons. The first type of button opens a menu when you click it. The Orientation button is an example of this type of button. Clicking the Orientation button opens a menu of options, as shown in the following image.

The second type of button is a split button. Clicking the left side of the split button performs a default action. Clicking the down arrow, on the right side of the button, opens a menu of options. The Header & Footer button is an example of a split button. It is shown in the following image.
Clicking the Header & Footer button on the left opens the Header & Footer dialog box. Clicking the down arrow on the right opens a menu of options.

Some options open dialog boxes of additional commands and option lists.

The ribbon displays all controls and commands using different sized icons and groups, depending on the size of the monitor and application window.

When you reduce the size of the application window, some groups are collapsed into single icons as determined by the amount of available space.

When a group is collapsed into a single icon, the individual icons are removed from view, but are still available. Clicking a collapsed group icon restores the group to its normal full size and displays all of the individual icons.

When expanding a collapsed group, the ribbon collapses a neighboring group to make enough room to expand the selected group.

When an icon, button, or option in a menu or dialog box appears dimmed, that functionality is not available for that report as it currently exists. Some functionality is available for reports only, charts only, visualizations only, or documents only.

In some situations, selecting one or more options makes other options incompatible with the previously selected ones. As a result, the incompatible options are dimmed and unavailable for selection. InfoAssist automatically makes incompatible options unavailable as you create and modify a report.

**Note:** If you do not have access to a particular option, contact your administrator.

**Home Tab**

The Home tab contains the most commonly used commands and options, which you can use when developing reports, charts, documents, or visualizations. The following list highlights the features on the Home tab for each mode.

- For reports, the Format, Design, Filter, and Report groups offer options for changing the output format of your report, as well as styling it.

- For charts, the Format, Design, Filter, and Report groups enable you to change the theme or your chart or add a header and footer.

- For documents, options are enabled in the Format and Design groups only. Available options for documents include changing the data source for the document and changing the output format.
For visualizations, the Clipboard, Data, Visual, and Storyboard groups enable you to perform some of the more basic functions, such as copy and paste. You also use the Home tab to change your visual type.

**Related Information for Reports, Charts, and Documents:**

- Using Filters to Customize the Display of Data on page 836

**Related Information for Visualizations:**

- Building Visualizations on page 463
- Using Storyboards on page 833
- Joins on page 347

**Insert Tab**

The Insert tab contains options to add reports, charts, existing reports, text, images, and active form controls (for active reports only) to a canvas in Document mode.

**Note:** The Insert tab is only available in Document mode.

**Related Information for Documents:**

- Building a Document on page 448

**Format Tab**

The Format tab provides options for formatting your report, chart, document, or visualization. Depending on the mode you are using, you can perform tasks such as selecting a chart type, enabling Auto Linking, or adding navigational aspects to a report.

The following list highlights the features on the Format tab for each mode.

- For reports, the Format tab provides access to the Destination, Navigation, Features, Run with, and Auto Linking groups. These options enable you to perform many functions related to reports, including Auto Drill or any other report navigation feature.

- For charts, the Format tab provides access to the Destination, Chart Types, Features, Labels, Interactive, Run with, and Auto Linking groups. These options enable you to perform a variety of charting tasks, including changing the chart type and adding interactive options.

- For documents, the Format tab enables you to change to Report or Chart mode. You can also access InfoMini.
For visualizations, the Format tab provides access to the Report, Features, Labels, and Interactive groups. These options enable you to format your visualization. Also included are grid commands, as well as various features and label commands.

Related Information for Reports, Charts, and Documents:

- Customizing Reports on page 737
- Formatting a Series on page 758
- Formatting Data Labels on page 775
- Formatting a Legend on page 781
- How to Style and Customize a Report on page 457
- How to Style and Customize a Chart on page 458
- Using Auto Drill on page 839
- Using the Auto Linking Feature to Link Content on page 841

Related Information for Visualizations:

- Building Visualizations on page 463
- Customizing Charts and Visualizations on page 755

Data Tab

The Data tab contains data manipulation and data display options. For example, you can access Join functionality and work with Defines and Computes. The Data tab is available in the Report, Chart, and Document mode. It is not available in Visualization mode.

The following list highlights the features on the Data tab for each available mode.

- For reports, the Data tab provides access to the Calculation, Join, Filter, Display, and Data Source groups. When working with reports, you can join data sources or create Defines and Computes. You can also filter data.

- For charts, the Data tab provides access to the Calculation, Join, Filter, Display, and Data Source groups. When working with charts, these options enable you to join data sources, create a Define or Compute, and filter data.

- For documents, the Data tab provides access to the Calculation, Join, Filter, Display, and Data Source groups. When working with a document, you can create a define or join data sources. You can also add or switch data sources.
Slicers Tab

The Slicers tab provides the ability to create and edit slicers. Slicers are dynamic filters that you can use with reports, charts, and documents.

**Note:** The Slicers tab is unavailable in Visualization mode.

The features on the Slicers tab are the same for reports, charts, and documents. You can perform the following functions with the slicer functionality:

- Add slicers to your report, chart, or document to create dynamic filters.
- Set a record limit for the display of your data.
- Create groups of slicers to filter your data.
- Add fields to existing slicers.
- Clear slicers to clear all selected values from existing slicers.

**Related Information for Reports, Charts, and Documents:**

- [Working With Slicers](#) on page 862

**Note:** The slicer capabilities are only available in the full version of InfoAssist.

Layout Tab

The Layout tab provides access to page display and layout options. These include page orientation and AutoFit, which is a feature that limits the width of columns in a report to be no wider than the largest value in each column.

The Layout tab is available in Report, Chart, and Document mode.

**Note:** The Layout tab is unavailable in Visualization mode.

The following list highlights the features on the Layout tab for each available mode.

- For reports, the Layout tab provides access to the Page Setup and Report groups. These options allow you to change the size or orientation of your report. You can also add page numbers.
For charts, the Layout tab provides access to the Page Setup and Size & Arrange groups. These options allow you to change the orientation or size of your chart. You can also set a height and width for your chart, and enable the AutoFit functionality.

For documents, Layout tab provides access to the Page Setup and Size & Arrange groups. You can change the size of your document and adjust its orientation. For Active Documents, you can turn on the Adaptive Dashboard feature to enhance the layout for mobile devices. You can also lock the height and width aspect ratio of your document.

Related Information for Reports, Charts, and Documents:

- Customizing Reports on page 737

View Tab

The View tab provides access to reporting options, including design and display options. Some of the options on the View tab control how information is displayed, whether it be in structured view or list view. The View tab is available in all modes of InfoAssist.

The following list highlights the features on the View tab for each mode.

- For reports, the View tab provides access to the Design, Show/Hide, Data Panel, Query Panel, Output Window and Report groups. When creating your report, you can change the way your data displays or switch to another mode, such as document.

- For charts, the View tab provides access to the Design, Show/Hide, Data Panel, Query Panel, Output Window and Report groups. When creating your chart, you can change the output location for the chart or switch to another report or chart.

- For documents, the View tab provides access to the Design, Show/Hide, Data Panel, Query Panel, Output Window and Report groups. When working with your document, you may want to change the display of data in the Data pane or Query pane.

- For visualizations, the View tab provides access to the Show/Hide, Data Panel, and Report groups. When creating your visualization, you can use these options to show or hide the resources panel. You can also change the display of your data to either logical, list or structured.

Related Information for Reports, Charts, and Documents:

- Using the Query Pane and Filter Pane on the Canvas on page 92
Field Tab

The Field tab is enabled in the ribbon when you select a data source field. The options available in the Field tab are specific to the data type that is selected. The options available for numeric fields are different from the options available for non-numeric and date fields. The Field tab provides access to the Filter, Sort, Break, Style, Format, Display, and Links groups.

The following list highlights the features on the Field tab for each mode.

- For reports, the Field tab provides options for filtering and styling your report. It also provides you with access to the Traffic Lights and Within functionality, making your reports more robust and customized.

- For charts, the Field tab enables you to hide a particular field or group values in your chart. You can also use the filter options to limit the display of information in your chart.

- For documents, the Field tab provides options for filtering, as well as Traffic Light functionality. You can also hide fields and add aggregations.

- For visualizations, the Field tab provides options for filtering and sorting, as well as access to the Multi Drill feature. You can also hide fields and add aggregations.

Related Information for Reports, Charts, and Documents:

- How to Apply Traffic Light Conditional Styling to a Report (By Constant) on page 746
- How to Apply Traffic Light Conditional Styling to a Report (By Field) on page 748
- Changing a Field Format on page 865

Series Tab

The Series tab provides access to chart options through the Select, Style, Properties, Line, and Pie groups. The Series tab is available in Document, Chart, and Visualization mode. It is not available in Report mode.

The following list highlights the features on the Series tab for each available mode.

- For charts, the Series tab enables you to add such features as a trendline or data labels to your chart. If multiple series are specified, you can select a series and specify options specific to that series.

- For documents, the Series tab displays once you have specified fields within your document or embedded chart. You can use the options on the Series tab to add markers, smoothlines, or trendlines to your data.
For visualizations, the Series tab enables you to switch between series, style the selected series, or add any other property or line features, as required.

**Related Information for Reports, Charts, and Documents:**

- **Formatting a Series** on page 758
- **Formatting Data Labels** on page 775

**Related Information for Visualizations:**

- **Formatting Axis Labels** on page 796

**Understanding the Canvas**

The canvas displays a preview of the report being created or modified on the canvas when you are in the default Live Preview. To select Live Preview, go to Home tab, and in the Design group, click Live Preview, or on the View tab, in the Design group, click Live Preview. The canvas is always fully maximized and cannot be minimized, cascaded, or tiled. However, a blank canvas opens when there is no report.

The canvas displays either live data or sample data.

- To display live data, on the Home tab, in the Design group, click Data from Source (default).

  When you select Data from Source, a live preview of the report being built is refreshed on the canvas as you add, remove, and style data source fields in the report.

- To display sample data, on the Home tab, in the Design group, click Use Sample Data.

  When you select Use Sample Data, the canvas displays sample data based on the field type, with the same formatting and styling used to display live data.

When you execute a report, the canvas displays the Output window. If the Output is minimized, or if there is no report to preview, the canvas is blank. To change the canvas view, you can select Query Design view or Live Preview from the Design group of the View tab or Home tab.

When working with a report in Live Preview, you can rearrange the columns of the report by dragging them to the left or right, depending on your display preference. If the column is numeric, you are presented with the option to Drop as Sum or Drop as Sort.

**Note:** If you select Drop as Sort, the values are listed individually and they are sorted. If you select Drop as Sum, the values are summed for that particular row. The default is Drop as Sum.
When placing the column in a new location, a red indicator bar displays, indicating the location of placement for the moved column. This allows you to see where the column will be placed before you actually perform the operation.

**Note:** Column sort order can also be rearranged by dragging the fields in the Query field containers of the Query pane to reorder them.

If you create a filter, then the filter appears in the Filter pane.

**Using the Query Pane and Filter Pane on the Canvas**

If you click **Query** on the **Home** tab, in the **Design** group, the Query and Filter panes expand into the canvas.

This provides a larger area for displaying the Query and Filter panes. This feature is useful when you are designing a report with multiple filters or numerous fields.

Depending on whether you are creating a report or a chart, the Query pane displays selected data source fields using different types of Query field containers.

**Related Information:**
- [Using Filters to Customize the Display of Data](#) on page 836
- [Using Field Containers](#) on page 103

**Understanding Output Options**

When you run a report, the output appears, either in a tab on the canvas, or in a new browser window. You can create and display output in several different ways, depending on the following options. You can select these options on the **View** tab, in the **Output Window** group:

- Cascade
- Tile Horizontally
- Tile Vertically
- Single Tab
- New Tab
- Single Window
- New Window
- Switch Output
Output window and tab options are also available in the status bar, and output window display options are also available in the Navigation taskbar.

**Note:** When you run a report, tab focus is not on the output window and pressing the Tab key does not move the selection. To move the Tab focus out of the output window, press F6.

**Reference:** Output Target Options

The following are output target options that you can select.

- **Single Tab.** When you click *Single Tab* and run a report, a new output window is created on the canvas, a report instance is created, and an output tab is placed on the Navigation taskbar. As you modify a report, the same output window is refreshed each time the report is run. This option, which is the default, is ideal when you are working with just one report.

- **New Tab.** When you click *New Tab*, each time you run a report, a new output window is created on the canvas. A new report instance is also created and preserved by the addition of a new output tab on the Navigation taskbar. Each output tab maintains the output of the report that generated the corresponding output window. Selecting an output tab on the Navigation taskbar loads the associated output instance into the output window.

- **Single Window.** When you click *Single Window* and run a report, a new browser window is opened and populated with the report output. As you modify the report, the same browser window is refreshed each time the report is run. If the browser window is closed and the report is run, a new browser window is opened again and is refreshed for each subsequent run. The output is not displayed on the canvas, and an output tab is not added to the Navigation taskbar.

- **New Window.** When you click *New Window*, each time you run a report, a new browser window is opened and populated with the report output. The output is not displayed on the canvas, and an output tab is not added to the Navigation Taskbar.

**Reference:** Output View Options

The following are output view options (Arrange) that you can select.

- **Cascade.** When you click *Cascade*, if multiple output windows exist, they are cascaded diagonally across the canvas. This option does not affect open browser windows when you select New Window or Single Window.

- **Tile Horizontally.** When you click *Tile Horizontally*, if multiple output windows exist, they are tiled horizontally, one above another, across the canvas. This option does not affect open browser windows when you select New Window or Single Window.
- **Tile Vertically.** When you click *Tile Vertically*, if multiple output windows exist, they are tiled vertically, side by side, across the canvas. This option does not affect open browser windows when you select New Window or Single Window.

- **Switch Output.** When you click *Switch Output*, a drop-down menu opens, where you can select any active report to view the output. The selected report is loaded into the output window or browser window, depending on the selected output window or tab option.

**Reference:**  
*Output Format Options*

The Output window can display report output in the following formats: HTML, HTML5, active report, and PDF.

**Note:** Excel and PowerPoint formats open in their native programs in a window external to InfoAssist.

**Using the Navigation Taskbar**

The Navigation taskbar provides quick access to all active output windows and to the report design that generated the output. You can return to the last report that you edited in the Query pane by clicking *Display Design View* on the taskbar. The Navigation taskbar is always visible. It is located near the bottom of the application window, just above the status bar.

Each of the active output windows displays a tab on the Navigation taskbar. Selecting the tab displays that output window on the canvas. If you save a report with a unique name each time you modify it, when the report is executed and a new output window is generated, the unique name appears as a tab on the taskbar. If you continue to modify and execute a report without saving it with a unique name, a number in parentheses is appended to the original, saved report name to differentiate it among the multiple output windows.

The ability to select report output from the Navigation taskbar depends on the output window option selected from the status bar or from the Output Window group of the View tab. For more information, see *Using the Status Bar* on page 95, or *Understanding Output Options* on page 92.

Each report tab on the Navigation taskbar has a shortcut menu with the following options:

- Restore
- Minimize
- Maximize
- Close
Auto Resize

Restore, Minimize, Maximize, and Close are standard options available in any browser window or software application. Minimize, Maximize (if the window is not maximized), or Restore (if the window is maximized), and Close can also be found in the top-right corner of the output window.

The Auto Resize option enables automatic resizing of an output window as needed when you add or remove fields.

The Window Options menu at the far left of the Navigation taskbar provides options for displaying all active output windows on the canvas. The display options that you can select are Cascade, Tile Horizontally, Tile Vertically, Restore All, Minimize All, Maximize All, or Close All. The name of each active output window appears at the bottom of the menu.

The Window Options menu options are directly linked to the options available in the Output Window group of the View tab.

Using the Status Bar

The status bar displays the status of the last selected action, a reports button that shows the number of open reports, an output format button that shows the selected format, as well as a list of the available formats, and an output target button that shows the selected option for displaying new output windows or tabs.

When you click the reports button, a menu opens, with options for selecting any of the open reports. Each report is listed by name and an icon which represents the report type (report, chart, visualization, document). The report you select becomes active.

When you click the output format button, a menu opens, with options for selecting a different output format. For a complete list of options, see Understanding Output Options on page 92.

When you click the output target button, a menu opens, with options for Single Tab (default), New Tab, Single Window, and New Window. For more information, see Understanding Output Options on page 92.

Understanding the Resources Panel

The Resources panel is comprised of the Data pane, the Filter pane, and the Query pane. It is located on the left side of the InfoAssist interface and is visible by default. You can customize how the Resources panel displays by using the options on the Home tab and View tab. For example, on the View tab, in the Design group, click Query to display only the Query and Filter panes.
The Data pane, which contains all the fields from the selected data sources, is always displayed.

You can manually adjust the size of the Resources panel. To do so, move the mouse pointer over the border. When the pointer changes to a two-way arrow, drag the border.

Reference: Field Image List

In the Resources panel, each field has an image associated with it. The following table displays each image and describes what it represents.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image.png" alt="Blob" /></td>
<td>Blob</td>
</tr>
<tr>
<td><img src="image.png" alt="Calculated Date Field" /></td>
<td>Calculated Date Field</td>
</tr>
<tr>
<td><img src="image.png" alt="Calculated Numeric Field" /></td>
<td>Calculated Numeric Field</td>
</tr>
<tr>
<td><img src="image.png" alt="Calculated Other Field" /></td>
<td>Calculated Other Field</td>
</tr>
<tr>
<td><img src="image.png" alt="Calculated Text Field" /></td>
<td>Calculated Text Field</td>
</tr>
<tr>
<td><img src="image.png" alt="Cube Property" /></td>
<td>Cube Property</td>
</tr>
<tr>
<td><img src="image.png" alt="Date or Date and Time Field" /></td>
<td>Date or Date and Time Field</td>
</tr>
<tr>
<td><img src="image.png" alt="Dimension Field" /></td>
<td>Dimension Field (Standalone or Drillable)</td>
</tr>
<tr>
<td><img src="image.png" alt="Dimension Field" /></td>
<td>Dimension Field (Drillable, Second-level)</td>
</tr>
<tr>
<td><img src="image.png" alt="Dimension Field" /></td>
<td>Dimension Field (Drillable, Third-level)</td>
</tr>
<tr>
<td><img src="image.png" alt="Geographic Role Dimension Field" /></td>
<td>Geographic Role Dimension Field (Standalone or Drillable)</td>
</tr>
<tr>
<td><img src="image.png" alt="Geographic Role Dimension Field" /></td>
<td>Geographic Role Dimension Field (Drillable, Second-level)</td>
</tr>
</tbody>
</table>

Note: There are 17 dimension field levels. Level 0 is specific to certain databases.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="Image" alt="Icon" /></td>
<td>Geographic Role Dimension Field (Drillable, Third-level)</td>
</tr>
<tr>
<td><img src="Image" alt="Icon" /></td>
<td>Funnel (filter)</td>
</tr>
<tr>
<td><img src="Image" alt="Icon" /></td>
<td>Geolocation</td>
</tr>
<tr>
<td><img src="Image" alt="Icon" /></td>
<td>Index Field</td>
</tr>
<tr>
<td><img src="Image" alt="Icon" /></td>
<td>Key Field</td>
</tr>
<tr>
<td><img src="Image" alt="Icon" /></td>
<td>Measure</td>
</tr>
<tr>
<td><img src="Image" alt="Icon" /></td>
<td>Numeric Field</td>
</tr>
<tr>
<td><img src="Image" alt="Icon" /></td>
<td>Text or Alpha Field</td>
</tr>
</tbody>
</table>

**Note:** This list of icons changes based on the type of database that is in use.

**Reference:** Filter Pane

The Filter pane displays all filters that have been created for the selected report.

For more information on filtering, see *Field Tab* on page 90 and *Data Tab* on page 87.

**Note:** The Filter pane displays all created filters, both active (included) and inactive (excluded).

**Using the Data Pane**

The Data pane contains the data fields that are used to construct reports, charts, or visualizations. The default structure of data in the Data pane displays your data by field type, for example, measure field or dimension field. You can explore this structure using the sample retail database that is included with InfoAssist. The structure of this sample database, which is a cube database, includes measure groups, measure fields, dimension hierarchies, dimension fields, and attributes.
The data fields that display in the Data pane may vary. Depending on the underlying structure of your metadata, these fields may be organized and presented differently. For example, you may have just measures and dimensions, or you may have fields that represent multiple drill levels. You can also have any combination of these field types.

The structure of your metadata dictates the order of the fields, as well as the hierarchy that they employ. InfoAssist displays this hierarchy based on the structure defined for the master file that you choose. For more information on the specific field types, see Field Image List on page 96.

If you are using a Business View Plus (BV+) data source, which is built based on a pre-determined targeted hierarchy or structure, the view of your Data pane will be set to Structured, by default. When using a BV+ data source, Logical view is disabled. These options are available on the View tab, in the Data Panel group.

**Note:** When you open a BV+ data source, you will have access to common components, such as measures, dimensions, and filters, but values are not supported.

The fields in the database structure are displayed in Logical view, by default. You can use the commands in the View tab to change how your data fields are organized in the Data pane. These commands display the data fields in a Logical, List, or Structured view. All three views provide options for displaying each data source field as a Title, Description, Field, or Alias. The List view also includes options to show the Alias, Format, and Reference of each field.

Field list search functionality is also available in the Data pane, which you can use to search for specific fields within a tree or list. When conducting a search in the Tree view, the search functionality searches only the attribute that is displayed.

When searching in List view, all attributes are searched at once.

**Note:** There are additional options on which you can search, including Name, Title, Alias, Format, Segment, Filename, Description, and Reference.

As you enter search criteria, InfoAssist begins the search process. When you enter just a few letters, the list of records that is returned is typically long. As your search criteria gets more specific, the list of returned fields narrows.

If you are conducting a search that you wish to cancel, click the X icon in the field list search tool to abort the search.

**Note:** The X icon displays only when you have search criteria specified in the Search fields box.
The following is an example of the default Logical view, displaying the Title of each field.

Using the Data Pane to Add Fields to a Report

There are several ways that you can add data source fields to a report. You can drag, double-click, or right-click data source fields in the Data pane to add them to a Query field container or the Filter pane.

After you add data source fields to a Query field container, you can change the order of the fields by dragging and dropping one field above or below another field.

**Drag.** This method provides the most control. You can drag data source fields from the Data pane to the appropriate Query field container or Filter pane.

For a larger work area in which to drop data source fields in the appropriate Query field container, make sure that Query Design view is selected, and then, on the View tab, in the Query Panel group, click Areas 2x2 or Areas 1x4.
You can select Query Design view on the Home tab, in the Design group, by clicking Query or on the View tab, in the Design group by clicking Query. That selection expands the Query and Filter panes.

**Multi-Select.** You can multi-select data source fields that you want to add to a report in Live Preview, Query Design view, and Document mode. To select multiple data source fields to add to a report, click the appropriate fields while holding the Ctrl key on the keyboard. You can drag fields onto the canvas, or add them to the Query field container.

**Double-Click.** To automatically add a field to the appropriate Query field container in the Query pane, you can double-click a data source field in the Data pane.

- When you double-click a measure field in the Data pane, it is automatically added to the Sum Query field container.

- When you double-click a dimension field in the Data pane, it is added to the By (Row Label) Query field container for a report, or to the X-axis Query field container for a chart.

You cannot automatically add a field to the Across (Column Label) Query field container for a report, or to the Legend (Series) and Multi-graph Query field containers for a chart.

**Right-Click.** You can right-click a field in the Data pane to add it to the Filter area or a Query field container in the Query pane. For reports, the available shortcut menu options are as follows:

- **Across.** For dimension fields.

- **Add to Query.** Opens a menu of available Query field containers, to which you can add your data.

- **Create Group.** Allows you to create a group of elements based on the field data type that you select.

- **Include as Category Axis.** For dimension fields.

- **Include as Coordinated.** Only available in Document mode.

- **Include as Legends Series.** For dimension fields.

- **Filter.** For all types of fields.

- **Slicers.** For all types of fields.

- **Sort.** Adds the field to the Sort field container. This is for all types of fields.

- **Sum.** For measure fields.
Create Bins. Allows you to create a bin for the selected measure. Bins are used with the Binning functionality. For more information, see Binning on page 383.

A measure is a numeric value, such as Gross Profit or Cost of Goods Sold, that you may want to aggregate. All numeric values that can be summed are measures. Numeric fields that cannot be summed, such as product number and miles per gallon, are not treated as measures. Instead, they may be used in the same way as dimension fields to analyze measures. It is up to you to understand your data and determine whether each numeric field can be summed. Related measures can be organized into measure groups. For example, Gross Profit and Cost of Goods Sold can be part of a Sales measure group.

A dimension is a way to categorize data. You can use a dimension to analyze and compare measures. Generally, any field that is not a measure, usually an alphanumeric field such as product, is a dimension. Dimensions can be organized into hierarchies to define the relationships between the fields in the hierarchies. For example, a Geography hierarchy can contain the Continent, Country, State, and City dimensions. You can also define dimension fields that are not part of a dimension hierarchy.

Using the Query Pane and Filter Pane

The Query and Filter panes appear to the right of the Data pane, except when you select Query Design view, which expands the size of the Query and Filter panes. There are different Query field containers for reports and charts.

Note: If you have more than one item in either Sum, By, or Across Query field containers (for reports) or Measure (Sum) or X-axis Query field containers (for charts), you can drag them up or down in the Query pane to rearrange the order in which they display in your report or chart. When you drag fields to rearrange them, an indicator line displays, providing guidance as to where the field will be placed. The color of this line is determined by the theme. Once you have performed the rearrangement, the Live Preview refreshes based on the newly indicated order.

Reports. For all reports, the Query field containers in the Query pane include Sum, By, and Across.

Use the Sum field container to aggregate or display numeric measure fields. Its context menu provides options to Sum (default), Print, Count, or List the fields in the report.

Use the By Query field container to vertically sort dimension fields to produce row labels in the report output. Dimension fields are normally non-numeric or date fields.

Use the Across Query field container to horizontally sort dimension fields to produce column labels in the report output.
For most charts, the Query field containers in the Query pane include Measure (Sum), X Axis, Legend (Series), Multi-graph and Coordinated. More complex charts that require additional dimension fields have alternative Query field containers.

- **Measure (Sum).** Use this Query field container to aggregate or display numeric measure field values.

- **Location.** Use this Query field container to display a location field. This Query field container displays for maps only.

- **X Axis.** Use this Query field container to sort dimension fields in the chart output.

- **Legend (Series).** Use this Query field container to display dimension fields as color-coded values (lines, bars, areas, scatter plots) that match the color-coded dimension values displayed in the legend below the chart. Legend (Series) provides functionality that is similar to an Across field in a report.

- **Multi-graph.** Use this Query field container to create outermost sort fields and to serve as a page break for working with multiple charts. The sort field added to this Multi-graph Query field container is not plotted on the chart, but each unique sort field value is listed for every chart.

- **Coordinated.** Use this Query field container to collectively sort and collate by a common sort group (for documents only).

For pie charts, the Query field containers in the Query pane include Measure (Sum), Slices, Category, Multi-graph, and Coordinated.

- **Measure (Sum).** Use this Query field container to aggregate or display numeric measure field values in the pie.

- **Pie slices.** Use this Query field container to display dimension fields as color-coded pie slices that match the color-coded dimension values displayed in the legend below the chart. The Pie slices Query field container is equivalent to the Legend (Series) Query field container used for other chart types.

- **Multi-graph.** Use this Query field container to create outermost sort fields and to serve as a page break for working with multiple charts. The sort field added to this Multi-graph Query field container is not plotted on the chart, but each unique sort field value is listed for every chart.

- **Category.** Use this Query field container to sort dimension fields in the chart output. Category is equivalent to the X-axis Query field container used for other chart types.
Coordinated. Use this Query field container to collectively sort and collate by a common sort group (for documents only).

Using Field Containers

Field containers are used to hold fields that you select based on the function that you want it to perform. For example, in Chart and Visualization mode, you can add a field to the Color field container, which will color your data based on the selected field.

For reports, the available field containers are different than those presented for charts and visualizations. This section reviews all of the field containers, providing you with a reference point when working with field containers.

Field Containers for Reports

The following field containers display when creating reports.

Across

Enables you to display column headings across the top of the report for the measure or dimension that is placed in this field container.

By

Enables you to specify sort fields for your report.

Note: You can rearrange the display order of your By sorts by dragging them into the desired order in the Query pane.

Sum

Displays numeric totals for numeric (measure) fields that are added to this field container.

Field Containers for Charts and Visualizations

The following field containers display when creating charts and visualizations.

Animate

Enables you to animate time progression using a slider control. As you move the control along the slider bar, an animation effect results. The slider control has a Play button that allows you to play and pause the animation. When you click Play, the Pause option is activated, enabling you to pause the progression and analyze your data. Slider controls are limited to one sort field and should be time or sequence related, such as month or year. This field container displays for many different chart types.
By

Use this field container to differentiate data types in a field that contains multiple categorical values. For example, when creating a gauge chart, the field that you specify in this field container becomes a By field, by which all values are displayed as a separate chart.

Category

Enables you to display data categorically in a chart. This field container displays for Tag Cloud charts, which are available in the Other charts category.

Category Axis

Use this field container to specify a field that contains categorical data. These categories display on the categorical portion of a 3D bar chart. The other axis, Series Axis, is plotted against the categorical data.

Close

Enables you to specify a numeric field to indicate the closing value of a stock. Other required values include: Open, High, and Low. This field container displays for Stock charts, which are available in the Other charts category.

Color

Enables the application of different colors based on the underlying data set for the field in this field container. When you place a numeric field in the Color field container, the legend displays as a heat scale. When you place an alphanumeric or a date field (non-measure) in the Color field container, the legend displays as colored markers. To change how the legend displays, right-click the Color field container and click Color BY.

Columns

Enables you to specify a field to display column data in a matrix chart in a visual. The use of measure fields is supported. Column data is displayed at the top of the visual, along the X axis. This field container is available for charts and visualizations.

Detail

Use this field container to add detail to your visual by adding a data field to it. For example, if you add Sale,Quarter to the Detail field container in your Scatter plot, the points on the plot are quadrupled, one for each quarter. In addition, the field that you specify in the Detail field container also displays on the hover menu for each point in the plot.

Grouping

Enables you to specify a field by which to present your data in categories or groups. For example, this data field controls how a treemap is grouped.
High

Enables you to specify a numeric field to indicate the high value of a stock. Other required values include: Open, Low, and Close. This field container displays for Stock charts, which are available in the Other charts category.

Horizontal Axis

Displays the data for the selected along the X axis. This field container is available for charts and visualizations.

Note: You can specify up to three fields on the horizontal axis.

Layer

Enables you to specify a Geolocation field for use in a map.

Note: Geolocation fields are listed in the Data pane with a Geolocation icon.

Legend (Series)

Enables you to add a field to specify for the legend of the chart. This field container displays for a number of charts that are available in the Other chart category.

Low

Enables you to specify a numeric field to indicate the low value of a stock. Other required values include: Open, High, and Close. This field container displays for Stock charts, which are available in the Other charts category.

Lower Limit

Enables you to specify a numeric (measure) field by which to establish a lower limit. This field container displays for Vertical Box Plot charts, which are available in the Other chart category.

Lower quartile

Enables you to specify a numeric (measure) field by which to establish a lower quartile. This field container displays for Vertical Box Plot charts, which are available in the Other chart category.

Measure

Use this field container to specify a measure that will serve as the basis for a pie chart. The Measure metric is used with the Color field container for pie charts to create sections based on your field selections. It is also used with Gauge charts.
**Measure (Sum)**

Enables you to specify a numeric (measure field) by which to sum data. This field container displays for a number of charts that are available in the Other chart category.

**Median**

Enables you to specify a numeric (measure) field by which to establish an median. This field container displays for Vertical Box Plot charts, which are available in the Other chart category.

**Multi-graph**

Enables the creation of multiple graphs based on the field that you place in this field container. This field container displays for many different chart types, including Spectral Heatmaps, which are available from the Other dialog box.

**Open**

Enables you to specify a numeric field to indicate the opening value of a stock. Other required values include: High, Low, and Close. This field container displays for Stock charts, which are available in the Other charts category.

**Rows**

Enables you to specify a field to display row data in a matrix chart in a visual. The use of measure fields is supported. Row data is displayed on the left side of the visual, along the Y axis. This field container is available for charts and visualizations.

**Series Axis**

Use this field container to specify a series to plot against the data presented on the Categorical Axis. This field container displays for 3D bar charts.

**Size**

Controls the size of markers or other data points.

**Size (Sum)**

Enables you to specify a numeric (measure) field, which will control the size of the data presented in a chart. This field container displays for Tag Cloud charts, which are available in the Other charts category.

**Slices**

Enables you to specify a field whose data values will dictate the size of the slices in a chart. This field container is available for Funnel charts, which are available in the Other chart category.
**Tooltip**

When you place a field in this field container, InfoAssist enables you to view additional information in the tooltip for a chart or visual.

**Upper limit**

Enables you to specify a numeric (measure) field by which to establish an upper limit. This field container displays for Vertical Box Plot charts, which are available in the Other chart category.

**Upper quartile**

Enables you to specify a numeric (measure) field by which to establish an upper quartile. This field container displays for Vertical Box Plot charts, which are available in the Other chart category.

**Vertical Axis**

Displays the data for the selected field along the Y axis. This field container is available for charts and visualizations.

**X Axis**

Enables the specification of a field on the X Axis of certain chart types. For example, XY Polar. This field container displays for a number of charts that are available in the Other chart category.

**Y1 Measure (Sum)**

Enables you to specify a measure (numeric) field for the Y Axis in a Pareto and certain line charts, which can be accessed from the Other chart category.

**Y2 Measure**

Use this field container to indicate a measure to serve as the basis for second Y axis. This field is used in various line charts, which can be accessed from the Other chart category.

**Using Shortcut Menu Options in the Query Pane**

In the Query pane, you can right-click any field and select from a list of available options that are displayed in the menu that appears. The options that you can select vary, depending on the type of Query field container in which the field is located and the type of report that you are creating.

You can also rename the content type in the Query pane. You can right-click the component and click *Rename* to change the title.
This allows you to customize the title in the Query pane. In addition, when working in Excel format, the name that you provide is used as the worksheet name in the workbook that is generated at run-time.

**Note:** If you are working with a report or chart in HTML format, you can also access Sum, Print, List, and Count aggregations from the shortcut menu on the report or chart component.

**Related Information:**
- [Using Field Containers](#) on page 103
- [Right-Click Field Options in the Query and Filter Panes](#) on page 108

**Reference:** Right-Click Field Options in the Query and Filter Panes

The following table lists and describes all the right-click field options available in the Query and Filter panes for a selected field.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td># of Columns</td>
<td>Opens the Number of Columns dialog box, where you can indicate the number of columns in which you wish to display multiple graphs.</td>
</tr>
<tr>
<td>Aggregation Functions</td>
<td>Provides a menu for selecting options to assign an aggregation type value to a selected numeric field in a report.</td>
</tr>
<tr>
<td>Break</td>
<td>Provides a menu of options to enable page breaks and subtotals, and resetting page numbers.</td>
</tr>
<tr>
<td>Create Group</td>
<td>Allows you to create a group of elements based on the field data type that you select. Once you define a new group, a higher-level field is created that contains the selected elements. For more information, see <a href="#">How to Create a Dynamic Group</a> on page 112.</td>
</tr>
<tr>
<td>Change Title</td>
<td>Opens the Edit Title dialog box, where you can change the title of the selected field by typing the new title in the Enter Title field.</td>
</tr>
</tbody>
</table>

**Note:** When changing the title of a column heading, you can place a comma between words in the Enter Title field to create a multi-line header.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color BY</td>
<td>Changes the Color field container to Color BY. The field container also changes to Color BY when you place a field into the Color field container. You can disable Color BY, which changes a dimension field into a measure field. This option is only available for charts and visualizations.</td>
</tr>
<tr>
<td>Data Bars</td>
<td>Provides a menu for enabling the data bar representation functionality. Selecting On adds a data visualization column to the right of a selected numeric field. The column displays values in each row using horizontal bars that extend from left to right in varying lengths, depending on the corresponding data values.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected field.</td>
</tr>
<tr>
<td>Note: In the Query and Filter panes, you can select and delete multiple data fields at one time. Using the CTRL key, select two or more data fields, right-mouse click, and then click Delete.</td>
<td></td>
</tr>
<tr>
<td>Drill Down</td>
<td>Opens the Drill Down dialog box, where you can create multiple drilldown links on a data field to external procedures or websites.</td>
</tr>
<tr>
<td>Edit Format</td>
<td>Opens the Field Format Options dialog box, where you can edit the field type and display options. This option is available for fields within the Sum field container in a report, as well as measure fields in a chart or visualization.</td>
</tr>
<tr>
<td>Note: Any changes to the format of a field will be reflected in the tooltip for charts at run time, as well as for visualizations at design and run time.</td>
<td></td>
</tr>
<tr>
<td>Filter Values</td>
<td>Opens the Filter dialog box for creating WHERE statements, which enable you to select only the data that you want and to exclude all unwanted data.</td>
</tr>
<tr>
<td>Missing</td>
<td>Allows you to show or hide fields with no value.</td>
</tr>
<tr>
<td>Multi-Y Split</td>
<td>Allows you to display individual charts for each measure field where multiple measures are specified. Located on the Vertical Axis, this option is available for charts and visualizations.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| New Parameter      | Allows you to add new parameters to your report or chart, which creates parameter options for selection at run time. You can create a new parameter in a report or chart in any field container.  
**Note:** When working with charts, a new parameter can only be added for charts that use the new attribute syntax. |
<p>| Sort               | Provides access to the Sort, Rank, and Limit menus. The Sort menu allows you to sort your data either in ascending or descending order. The Limit menu allows you to specify the number of unique values displayed for a sort group that has been added. The Rank menu allows you to insert a rank column immediately to the left if a Sort By field is selected and adds a rank column to the left of the Sort By field if a Measure field is selected. Ranking a Measure field results in two copies of the field, the original Measure field and the Sort By field that is created during ranking. |
| Sub Footer         | Opens the Sub Header &amp; Sub Footer dialog box where you can edit and style your footers.                                                                                                                                 |
| Sub Header         | Opens the Sub Header &amp; Sub Footer dialog box where you can edit and style your headers.                                                                                                                                 |
| Suppress Empty Group | Suppresses any part of your chart that is empty. You can deselect this option, which is enabled by default. This option is available on the Horizontal axis in both Chart and Visualization mode. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort by Total Value</td>
<td>Enables you to sort the output in a chart or visualization using the values from the y-axis (Horizontal axis) of a stacked bar chart. While this feature was implemented specifically for Stacked Bar charts, it also applies to regular bar charts, as well as line and area charts. This enables you to view your data as ranked, or sorted, from highest value to lowest value. Accordingly, this option sorts the output by the bar (or other) with the highest total. This option is set to Off by default, but you can select Ascending or Descending to sort your data. This option is available on the Horizontal axis in both Chart and Visualization mode. <strong>Note:</strong> If you rotate your chart horizontally, the Sort By Total Value menu option displays on the Vertical Axis. For more information, see <em>How to Sort a Chart by Total Value</em> on page 826.</td>
</tr>
<tr>
<td>Traffic Light Conditions</td>
<td>Opens the Traffic Light Condition dialog box, where you can add new conditional styling or modify existing conditional styling by applying traffic light (and other) colors to a selected field in the report output when the field meets specified criteria.</td>
</tr>
<tr>
<td>Visibility</td>
<td>Provides a menu for controlling the visibility of the selected field. Clicking Hide removes the selected field from the report output. Clicking Show (default) displays the selected field in the report output.</td>
</tr>
</tbody>
</table>

All of the shortcut menu options that are available in the Query and Filter panes are also available in the Field tab. For more information, see *Field Tab* on page 90.

**Dynamic Grouping**

Dynamic grouping allows you to create groups of elements based on the field data type that you select. For example, in the wf_retail_lite database, there are a number of brands of televisions. Using the dynamic grouping functionality, you can create groups based on the popularity of a particular brand. The first group might include top sellers such as LG and Sony. The second group might contain the remaining brands (Panasonic, GPX, Supersonic, Tivax, and Audiovox). This would allow you to group top sellers into one group, and the remaining brands into another group.
**Note:** The Create Group option is only available for dimension fields of non-numeric format or attribute.

You can also specify multiple, unique groupings in the same session. For example, you might want to group the data to indicate groups or products, or specific regions.

**Note:** If you want to exclude a specific data element from your analysis, you can use the filter functionality.

The grouping that you specify is applied and this new group then replaces the original field that you selected in the Query pane. The name that you specify when creating the group is reflected in the Query pane.

**Note:** You can edit the group once it has been created by right-clicking on the higher-level field and clicking *Edit Group*.

**Procedure:** How to Create a Dynamic Group

1. From the Data pane, add one or more data fields to your report or chart.
   
   **Note:** You can use the dynamic grouping functionality on non-numeric dimension fields only.

2. In the Query pane, right-click the data field for which you want to apply dynamic grouping.
   
   **Note:** The Create Group option is also available in the Data pane shortcut menu.

3. Click *Create Group*.
   
   The Create a Group dialog box displays.

4. In the Field text box, optionally type a name for the new group.
   
   **Note:** The fully qualified field name is displayed in the Field Origin text field. This field is enabled and has a read-only attribute. The display of the fully qualified field name is particularly useful when renaming or editing a group, as it identifies the data source followed by the hierarchical location of the field within a data set. For example, WF_RETAIL_LITE.WF_RETAIL_PRODUCT.BRAND.
5. Select the data values that you want to group. Use CTRL + click to select more than one value, as shown in the following image.

6. Click Group.

**Note:** To ungroup values, click a group and then click Ungroup.
7. Optionally, create additional groups, as shown in the following image.

![Create a Group](image1.png)

8. Click OK.

Your grouped data will display in the Data pane when your report, chart, or visualization refreshes, as shown in the following image.

![Data pane](image2.png)
Setting Up Your Environment

Configure and customize your environment, create users and groups, and manage your resources using the available functionalities.

In this chapter:

- Using the Administration Console
- Working With HTML5 Chart Extensions
- Changing Application Settings
- Changing Client Settings
- Using the ReportCaster Console
- Working With Domains
- Working With Folders
- Managing Users
- Managing Groups
- Managing Private Resources
- Authenticating Users to Your Active Directory
- Configuring WebFOCUS Business User Edition for SSL
- Creating a Change Management Package
- Changing InfoAssist User Preferences
- Configuring Hyperstage
- Distributing the Quick Data Add-In File
- Managing the Server or Global Profile

Using the Administration Console

The Administration Console contains the settings that configure WebFOCUS Business User Edition, customize internal or external authentication settings, connect you to ReportCaster, and support diagnostic research.

Opening the Administration Console

Because the Administration Console contains settings that can alter the operation of your entire installation, it is available only to those users with the privileges to update or reconfigure system settings. In WebFOCUS Business User Edition, the Administration Console is available only to the Manager User.
Before you can open the Administration Console, you must sign in with a User ID that has the privilege to do so. Once you have signed in with the appropriate privileges, the Administration Console is visible and available for review and updates. You can then open the Administration Console from the Menu bar.

You can also open the Administration Console directly from the address bar of your browser window by entering the URL of the Administration Console and then signing in with a User ID that has the appropriate privileges.

**Procedure:** How to Sign In to the Administration Console From the Start Menu

1. If WebFOCUS Business User Edition has been installed on a Windows machine, click the Start button, and then click the Information Builders folder.
3. On the Sign in page, type the ID and password of a user that has privileges to open the Administration Console, and then click Sign in.
4. To open the Administration Console, on the Menu bar, click Administration, and then click Administration Console.

**Procedure:** How to Sign in to the Administration Console From a Browser Window

1. Go to the URL:

   http(s)://machine:port/context/admin

   where:

   **machine**

   Is the network ID of your computer.

   **port**

   Is the number of the port that connects your computer to the server hosting WebFOCUS Business User Edition.

   **context**

   Is the local address for WebFOCUS Business User Edition. For example, *ibi_apps*.

2. On the Sign in page, type the ID and password of a user that has privileges to open the Administration Console, and click Sign in.

   The Administration Console opens automatically.
**Note:** To display the Administration Console using a different language, on the Sign in page, click *Choose language*, and then click the language you want to use in the language list.

**Using the Administration Console Menu Bar**

The Administration Console menu bar appears above the Administration Console tab display. The commands and features it contains are available to all of the Administration Console tabs.

**Using the Licenses Menu**

The Licenses Menu links you to information about your current product license, an audit of User and Group licenses and roles, and to information about licenses for all third-party software products included in the installation. Using Licenses menu commands you can:

- View the current license number, product edition, license key expiration date, and the number of licensed users. You can also add new license numbers.

**Reviewing Client License Information**

The WebFOCUS Client command opens the License Information dialog box. This dialog box identifies the current license key and the individual product components made available by that key. You can also use it to replace the current license key with a new license key when your current license expires or changes.

The License Information dialog box provides the following information:

- **Product Edition.** The name of the current product edition.
- **License Key.** The license key currently in use.
- **License Key Expiration Date.** The date the license key will expire. By default, a warning message for the client license key expiration date begins to appear fourteen (14) days before the actual expiration date. This message displays the expiration date and the number of days remaining until that date. The License Expiration Warning message appears only to Administrators during sign on, and it is written to the event.log file located in the logs directory of the WebFOCUS Business User Edition installation.
- **User Licenses.** The total number of available user licenses and the number of licenses used for each user category. For example:
Portal Users

InfoAssist Users

Product Components. The product components your license entitles you to use. If the check box to the right of an entry is visible and selected, you are entitled to use that product component.

New License Key. Opens the Update License dialog box, where you can add a new license key and site code.

Reference: Managing Client Licenses

Access to WebFOCUS Business User Edition features and the number of licensed users is based on your license key and site code.

When the number of users exceeds the number of licensed users, the User Licenses Used count displays, in red, a message that the user license count has been exceeded, which is written to the event.log trace file. Users that are authorized to access the Administration Console will receive a message upon signing in.

User licenses are maintained or enforced when the following product components are licensed:

- Total Users. The total number of named users in the Repository.
- Portal Users (PR). The number of users with portal privileges.
- InfoAssist Users. The number of users with portal privileges and InfoAssist privileges.

Procedure: How to Configure License Codes

Access to the product features and the number of Managed Reporting users is based on your license key and site code. You can change these values from the License Management page.

1. In the Administration Console menu bar, click Licenses, and then click WebFOCUS Client.
   The License Information window opens, displaying features available under the current license.

2. Click New License Key.

3. Type your new license key and site code.

4. Click Validate.
   The License Management page displays the current license key, the new license key, and the features that the new license key provides.
5. Click Save to implement the new license.

You must reload your web application in order for your changes to take effect. In addition, users must sign out and sign back in to obtain access to any new features.

**Reviewing User Audit Information**

The User Audit command evaluates the repository license usage for Total Users, Portal Users, and InfoAssist Users. The command produces a License Analysis report that identifies the total number of licenses by license type, the number of licenses in use by license type, and analyzes license assignments by Group and by User.

You can run the User Audit utility (license_audit.bat) from your local WebFOCUS installation directory, which is available in the following location:

\`\`drive:\ibi\WebFOCUS_BUE82\WebFOCUS\utilities\mr\`\`

When you run this program, it generates the License Analysis report and transfers it to the auditUserCounts.htm file, in the same directory.

The License Analysis report contains the following information:

<table>
<thead>
<tr>
<th>License Analysis</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Product Edition</strong></td>
</tr>
<tr>
<td>The name of the current product edition.</td>
</tr>
<tr>
<td><strong>License Key</strong></td>
</tr>
<tr>
<td>Displays your current license key.</td>
</tr>
<tr>
<td><strong>User License</strong></td>
</tr>
<tr>
<td>Displays the user license types that are authorized under your current license key. This can include the following:</td>
</tr>
<tr>
<td>- Total Named Users</td>
</tr>
<tr>
<td>- Portal Users</td>
</tr>
<tr>
<td>- InfoAssist Users</td>
</tr>
<tr>
<td><strong>Code</strong></td>
</tr>
<tr>
<td>Displays the code for each user license, such as TU for Total Users.</td>
</tr>
<tr>
<td><strong>Maximum</strong></td>
</tr>
<tr>
<td>Displays the maximum number of user licenses that are available with your license key.</td>
</tr>
<tr>
<td><strong>In Use</strong></td>
</tr>
<tr>
<td>Displays the number of user licenses that are currently in use.</td>
</tr>
<tr>
<td><strong>License Analysis</strong></td>
</tr>
<tr>
<td>------------------------------</td>
</tr>
<tr>
<td>Available</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Analysis of Groups</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Group Path</td>
<td>Displays the Groups stored in the repository. The following groups are created by the WebFOCUS Repository Creation utility, by default:</td>
</tr>
<tr>
<td></td>
<td>☐ /EVERYONE</td>
</tr>
<tr>
<td></td>
<td>☐ /Getting_Started</td>
</tr>
<tr>
<td></td>
<td>☐ /Managers</td>
</tr>
<tr>
<td></td>
<td>☐ /Retail Samples</td>
</tr>
<tr>
<td>License Type(s)</td>
<td>Displays the license types for each Group, such as TU.</td>
</tr>
<tr>
<td>Role</td>
<td>Displays the role of each Group, such as SystemFullControl.</td>
</tr>
<tr>
<td>On Resource</td>
<td>Displays the resource to which the Role is applied for the Group.</td>
</tr>
<tr>
<td>Former Type(s)</td>
<td>Displays the former types of licenses for each Group.</td>
</tr>
<tr>
<td>Groups Summary</td>
<td>Displays counts for the following:</td>
</tr>
<tr>
<td></td>
<td>☐ Number of groups</td>
</tr>
<tr>
<td></td>
<td>☐ Number of groups with license types</td>
</tr>
<tr>
<td></td>
<td>☐ Number of groups with no license types</td>
</tr>
<tr>
<td></td>
<td>☐ Number of groups with changed user types</td>
</tr>
<tr>
<td></td>
<td>☐ Number of groups with cleared user types</td>
</tr>
<tr>
<td></td>
<td>☐ Number of groups with unchanged types</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>Analysis of Users</strong></th>
<th></th>
</tr>
</thead>
</table>
License Analysis

<table>
<thead>
<tr>
<th>Description</th>
<th>Details</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Name</td>
<td>Displays the users stored in the repository. The following users are created by the WebFOCUS Repository Creation utility, by default:</td>
</tr>
<tr>
<td></td>
<td>manager</td>
</tr>
<tr>
<td>License Type(s)</td>
<td>Displays the license types assigned to each user.</td>
</tr>
<tr>
<td># Group w/Licenses</td>
<td>Displays the number of groups with licenses of which the user is a member.</td>
</tr>
<tr>
<td>Former Type(s)</td>
<td>Displays the license types that have been changed or cleared for each user.</td>
</tr>
<tr>
<td>User Summary</td>
<td>Displays counts for the following:</td>
</tr>
<tr>
<td></td>
<td>Number of users</td>
</tr>
<tr>
<td></td>
<td>Number of users with license types</td>
</tr>
<tr>
<td></td>
<td>Number of users with no license types</td>
</tr>
<tr>
<td></td>
<td>Number of users with changed user types</td>
</tr>
<tr>
<td></td>
<td>Number of users with cleared user types</td>
</tr>
<tr>
<td></td>
<td>Number of users with unchanged types</td>
</tr>
</tbody>
</table>

Procedure: How to Run the User Audit from the Administration Console

From the Administration Console menu bar, click Licenses, and then click User Audit.

The License Analysis report opens in a separate browser window.

Reviewing Third Party Licenses

The Third Party command opens the 3rd Party Information page that displays the following information for each third-party software application used to support different features:

- **Description.** The name or brief description of the third-party application.
- **Version.** The version number of the third-party application.
The WebFOCUS Business User Edition product uses various third-party software applications that support a variety of features.

Clearing the Cache

The Clear Cache command refreshes the state of the application by applying saved changes that are not applied dynamically. Even though some changes are dynamic or only require the administrative user to clear the cache to take effect, others require an administrative user to recycle the web application.

Closing the Administration Console

The Close command closes the Administration Console. After the console closes, you remain signed in to your work session.

Opening Administration Console Help

When you click the Help icon, the online Help file opens to a topic that describes the tab, setting, or feature currently on display.

Configuring Security

In the Administration Console Security Tab, you can adapt the default security settings to your local environment.
Security can either be configured internally in the WebFOCUS Business User Edition repository, or externally in a Microsoft Active Directory or an LDAP directory that is not part of the application. You can use either the Internal page or the External page on the Security tab in the Administration Console. To configure settings for internal security, use the settings in the Internal page. To configure a connection to an external Microsoft Active Directory or LDAP Directory, use the External page.

Internal authentication and authorization is enabled by default.

**Using Internal Security**

Internal authentication and authorization are enabled, by default. Optionally, you can use the settings in the Internal page to configure sign in and password policies.

**Sign In Settings (Enable Sign In Settings)**

Determines the default values assigned to the Sign In Settings on the Internal Security Page.

This check box is cleared (False), by default. Sign In Settings are inactive and unavailable, and display a value of 0.

When this check box is selected (True), Sign In Settings are activated, automatically assigned a set of pre-configured values, and made available for updates. To deactivate an individual setting while this check box is selected, type or select zero (0). When this check box is later cleared, all values assigned to the Sign In Settings return to 0, and the settings are deactivated.

This setting does not affect the value or availability of the Password Expiration Result options.

**Maximum Sign-in Attempts (IBI_Max_Bad_Attempts)**

Specifies the number of unsuccessful sign-in attempts allowed before the account status is changed to locked. When the Sign In Settings check box is cleared, the default value is 0, which allows unlimited attempts. When the Sign In Settings check box is selected, the default value is 5, and managers can type or select an alternative value. To deactivate this setting when the Sign In Settings check box is selected, type or select 0.

**Lockout Duration (Minutes) (IBI_Account_Lockout_Duration)**

Specifies the number of minutes before the status of an account changes from locked to active. When the Sign-in Settings check box is cleared, the default value is 0 (off). When the Sign In Settings check box is selected, the default value is 3 minutes, and managers can type or select an alternative value. To deactivate this setting when the Sign In Settings check box is selected, type or select 0.
**Lockout Duration Reset (Minutes) (IBI_Account_Lockout_Duration_Reset)**

Specifies the number of minutes that must elapse after the number of failed sign-in attempts specified by the Maximum Sign-in Attempts setting before the allowed sign-in attempt counter is reset to 0. The available range is from 1 to 99,999 minutes. When the Sign-in Settings check box is cleared, the default value is 0 (off). When the Sign In Settings check box is selected, the default value is 3 minutes, and managers can type or select an alternative value. To deactivate this setting when the Sign In Settings check box is selected, type or select 0.

**Days Until Password Expires (IBI_Password_Expire)**

Specifies the number of days that a password will remain active. When Sign-in Settings is cleared, the default value is 0, which prevents passwords from expiring. When Sign In Settings is selected, the default value is 90 days. Once the password has expired, the user must take the action specified by the Password Expiration Result (IBI_Password_Expire_Action) setting, and managers can type or select an alternative value. To deactivate this setting when the Sign In Settings check box is selected, type or select 0.

**Days Until Password Expiration Warning (IBI_Password_Expire_Warning)**

Specifies the number of days prior to expiration that a warning will be displayed to the user. When Sign-in Settings is cleared, the default value is 0, which provides no warning. When Sign In Settings is selected, the default value is 75 days. This value should be less than or equal to the value assigned to the Days Until Password Expires (IBI_Password_Expire) setting, and managers can type or select an alternative value. To deactivate this setting when the Sign In Settings check box is selected, type or select 0.

**Password Expiration Result (IBI_Password_Expire_Action)**

Specifies the action required when a password expires. You can choose one of the following options:

- **To force Users with Expired passwords to change their passwords before signing in** (MUSTCHANGE). This is the default value.

- **Change the status of users with expired passwords to inactive. Such users cannot sign in until an administrator resets the password** (DISABLE-USER).

**Enable Password Complexity (IBI_Password_Complexity)**

Determines the default values assigned to the Password Settings on the Internal Security Page.

This check box is cleared (False), by default. All of the Password Settings are inactive and unavailable, and display a value of 0.
When this check box is selected (True), all of the Password Settings are activated and available for updates. WebFOCUS Business User Edition automatically assigns a pre-configured set of values to them.

When this check box is later cleared, all values assigned to the Password Settings return to 0, and the settings are deactivated.

If this check box is selected (True), passwords also must:

- Not contain the user account name or parts of the full name of the user that exceed five consecutive characters.
- Be at least six characters long or at least the number of characters specified in Minimum Password Length, whichever is greater.
- Contain characters from three of the following four categories:
  - Uppercase English characters (A through Z).
  - Lowercase English characters (a through z).
  - Base 10 digits (0 through 9).
  - Non-alphabetic al characters (for example, !, $, #, %).
- Complexity requirements are enforced when passwords are changed or created.

**Minimum Password Length (IBI_Password_Minimum_Length)**

Defines the required minimum length of a password. When Enable Password Complexity is cleared, the default value is 0 characters. When the Enable Password Complexity check box is selected, the default value is 6 characters. To deactivate this setting when the Enable Password Complexity check box is selected, type or select 0.

**Password Reuse (IBI_Password_Reuse)**

Specifies the number of recent passwords that cannot be reused. If Password Reuse is set to 6, for example, WebFOCUS Business User Edition will track the 6 most recent password changes and prevent you from reusing them when creating a new password. When the Enable Password Complexity check box is cleared, the default value is 0 changes, and users can re-use any previously-assigned password. When the Enable Password Complexity check box is selected, the default value is 2 changes. To deactivate this setting when the Enable Password Complexity check box is selected, type or select 0.

**Procedure:** How to Configure Sign In Settings

1. Sign in as a Manager.
2. In the Administration Console, click the Security tab, and on the Security page, under the Security Configuration folder, click Internal.

3. Select the Sign In Settings check box.

The Internal page displays the following default values:

- Maximum Sign-in Attempts – 5
- Lockout Duration (Minutes) – 3
- Lockout Duration Reset (Minutes) – 3
- Days Until Password Expires – 90
- Days Until Password Expiration Warning – 75

4. To change the default value assigned to any of these settings, type or select an alternate value in any of these boxes.

5. To clear all settings, clear the Sign In Settings check box. All values automatically return to 0.

6. In the Password Expiration Result section, accept the default option To force users with expired passwords to change their passwords before signing in, or click the alternative option Change the status of users with expired passwords to inactive. Such users cannot sign in until an administrator resets the password.

7. Continue with any other Internal Security page updates or save your changes.

Procedure: How to Configure Password Settings

1. Sign in as a Manager.

2. In the Administration Console, click the Security tab.


4. Select the Enable Password Complexity check box.

The Internal page displays the following default values:

- Minimum Password Length – 6
- Password Reuse – 2

5. To change the default value assigned to any of these settings, type or select an alternate value in either of these boxes.

6. To clear all settings, clear the Enable Password Complexity check box. All values automatically return to 0.

7. Continue with any other Internal Security page updates or save your changes.
**Procedure:** How to Save Internal Security Page Configuration Updates

1. When all of your Internal Security Page Configuration updates are complete, click **Save**.
2. When you receive a confirmation message, click **OK**.
3. When you receive a message to clear the cache, click **OK**.
4. In the Administration Console menu bar, click **Clear Cache** and, when you receive a confirmation message, click **OK**.

**Using External Security**

Use the External page if you have elected to configure security in a Microsoft Active Directory (AD) or Lightweight Directory Access Protocol (LDAP) directory that is not part of WebFOCUS Business User Edition.

**Enable External Security**

When you select this check box, internal security settings are overridden. WebFOCUS Business User Edition directs all authentication activities and approvals to the external system you identify on this page.

**External Security Type (IBI_Authentication_Type)**

The drop-down list box for this field contains the following values:

- **Reporting Server.** Authenticates users against an AD or LDAP directory.
- **Legacy LDAP.** This value is not used with WebFOCUS Business User Edition.
- **Custom Java Plug-In.** This value is not used with WebFOCUS Business User Edition.

**Understanding Custom Settings**

The Custom Settings page allows you to customize WebFOCUS Business User Edition by typing customized values for standard settings.

When you save updates to settings that you type into the Customized Setting text box, they are transferred to the site.wfs file, in the following location:

```
drive:\ibi\WebFOCUS_BUE82\WebFOCUS\client\wfc\etc\
```

When you use this page to assign new values to settings, they override the default values assigned to them. These overrides are carried over as you upgrade to new versions.

After you save a custom setting, the text continues to display on this page. You can use comments to identify specific updates and additional information about them.
Procedure: How to Configure Custom Settings

Only a manager can configure settings on the Custom Settings page.

1. In the Administration Console, on the Configuration tab, click Custom Settings.
2. Under the final comment statement at the top of the Custom Settings text box, or the most recent custom setting entry, type the variables, settings, commands, or comments that comprise the custom settings.

   Use the format required by the application or operating system that will execute the command.

   To help track changes to custom settings, use comments to identify and separate individual changes.

3. To store your custom settings in an encrypted format, select the Encrypt check box.
   
   Note: Even when you select this check box, settings continue to appear in an unencrypted format in the Custom Settings text box.

4. When your configuration is complete, click Save.
5. When you receive a confirmation message, click OK.
6. When the Custom Setting page clears, click Custom Settings under the Application Settings folder to see your updated comments, settings, or commands in the Custom Settings text box.

Procedure: How to Configure Collation Sequence Settings

Only a manager can configure settings on the Custom Settings page.

1. In the Administration Console, on the Configuration tab, click Custom Settings.
2. Under the final comment statement at the top of the Custom Settings text box, type the comment line:

   # Collation Sequence Settings

3. Under the comment line, type the command:

   _site_profile=&_site_profile
   SET COLLATION={BINARY|SRV_CI|SRV_CS|CODEPAGE}

   where:

   BINARY
     Bases the collation sequence on binary values.

   SRV_CI
     Bases the collation sequence on the LANGUAGE setting, and is case-insensitive.
SRV_CS
Bases the collation sequence on the LANGUAGE setting, and is case-sensitive.

CODEPAGE
Bases the collation sequence on the code page in effect, and is case-sensitive.
CODEPAGE is the default value. In most cases, CODEPAGE is the same as BINARY.
The only differences are for Danish, Finnish, German, Norwegian, and Swedish in an
EBCDIC environment.

4. To store your custom settings in an encrypted format, select the Encrypt check box.

   **Note:** Your settings will continue to appear in the Custom Settings text box in an
unencrypted format.

5. When your configuration is complete, click Save.

6. When you receive a confirmation message, click OK.

7. When the Custom Setting page clears, click Custom Settings under the Application
Settings folder to see your updated comments, settings, or commands in the Custom
Settings text box.

**Understanding NLS Settings**

You can use the Administration Console to configure National Language Support and enable
the Dynamic Language Switch.

Separate message files exist for every national language that WebFOCUS Business User
Edition supports. If you want to customize the set of characters used in your report output, you
must select the code page for every language you use.

These settings do not carry over during updates. You must repeat this customization step for
each new release that you install.

**Procedure:** How to Configure National Language Support

1. In the Administration Console, on the Configuration tab, click NLS Settings.

2. On the NLS settings page, click the option for the operating system on which WebFOCUS

   The list adjusts to display the code pages that are available to the selected operating
system.

3. From the list, click a code page that configures the client for the correct display of report
output in the browser.

   **Tip:** The language selected for the Client usually corresponds to the language selected for
the Server from the Reporting Server Console.
If the language chosen from the Reporting Server Console does not appear in the list, click *User Defined Code Page* and type the number of the user-defined code page.

Use this option, for example, when the server adds support for a new code page that is not yet reflected in the client software.

In the following sample configuration window, the administrator specified code page 437.

![Select the operating system where the WebFOCUS Client resides](image)

Unicode (UTF-8) is available for the Windows, UNIX, or AS/400 operating systems.

4. Click *Save* to store your NLS settings.

The Administration Console generates and updates the client configuration file (nlscfg.err), found in `drive:\ibi\WebFOCUS_BUE82\WebFOCUS\client\home\etc`, with the CODE_PAGE setting. Note that if you click NLS Settings again, your new setting is highlighted as the active code page.

**Reference:** *Client Code Page Settings*

The following code page settings are available:

- 137 - U.S. English/Western European
- 874 - Thai
- 942 - Japanese
- 946 - Simplified Chinese
- 949 - Korean
- 1250 - Eastern European
- 1251 - Russian
* 1252 - Western European
* 1253 - Greek
* 1254 - Turkish
* 1255 - Hebrew
* 1256 - Arabic
* 1257 - Baltic
* 10942 - Japanese EUC
* 10948 - Traditional Chinese
* 65001 - Unicode (UTF-8)

Note: Only those code page settings marked with an asterisk are fully supported in the current release.

Customizing the Dynamic Language Switch

You can customize the languages that are made available on the Sign in pages by activating the Dynamic Language Switch.

Procedure: How to Customize the Dynamic Language Switch

1. In the Administration Console, on the Configuration tab, under the Application Settings folder, click Dynamic Language Switch.

The Dynamic Language Switch page opens with a list of the languages made available by the code page selected in the NLS Settings page. By default, the Enable Dynamic Language check box is unselected, and all of the language check boxes are deactivated.

The Dynamic Language Switch page also shows the Client Code Page setting specified in How to Configure National Language Support on page 129.
2. Select the *Enable Dynamic Language* check box to activate the check boxes for all of the available languages displayed in the panel, as shown in the following image:

![Enable Dynamic Language](image)

Selecting the Enable Dynamic Language check box and one or more languages activates the display of the Select Languages button on all of the Sign in pages. It also activates the Language menu on the portal Menu bar.

3. Select the check box next to the Locale heading if you want all of the languages to appear in the Select Languages list on the Sign in pages and in the Language menu.

   OR

   Clear the check box next to the Locale heading and select the individual check boxes next to the individual languages that you want to appear on the Sign in pages and in the Language menu.

4. Click Save.

   **Note:** To remove individual languages from the Select Languages drop-down list on the Sign in pages, clear the check boxes next to the languages you want to remove.
Understanding Redirection Settings

Redirection settings specify the way in which output files using a specific file extension are handled. You can review these settings through the Redirection Settings page of the Administration Console Configuration tab. Each entry in the page identifies an output file format by its WebFOCUS Extension, Content Type, File Format, Server Extension, Client Extension, and IBFS File Format, as shown in the following image.

<table>
<thead>
<tr>
<th>WFOCUS Extension</th>
<th>Content Type</th>
<th>Format</th>
<th>Redirect</th>
<th>Server Extension</th>
<th>Save Report</th>
<th>Client Extension</th>
<th>IBFS Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>.wp</td>
<td>text/plain</td>
<td>ascii</td>
<td>no</td>
<td>N/A</td>
<td>no</td>
<td>wp</td>
<td>ascii</td>
</tr>
<tr>
<td>.xls</td>
<td>application/vnd.ms-excel</td>
<td>ascii</td>
<td>no</td>
<td>XLSH</td>
<td>yes</td>
<td>xls</td>
<td>ascii</td>
</tr>
<tr>
<td>.xls</td>
<td>application/vnd.ms-excel</td>
<td>binary</td>
<td>yes</td>
<td>EXCEL</td>
<td>no</td>
<td>xls</td>
<td>binary</td>
</tr>
<tr>
<td>.xlsx</td>
<td>application/vnd.openxmlformats-officedocument.spreadsheetml.sheet</td>
<td>binary</td>
<td>no</td>
<td>XLSH</td>
<td>yes</td>
<td>xlsx</td>
<td>binary</td>
</tr>
<tr>
<td>.html</td>
<td>application/vnd.openxmlformats-officedocument.spreadsheetml.template</td>
<td>binary</td>
<td>no</td>
<td>XLSH</td>
<td>yes</td>
<td>html</td>
<td>binary</td>
</tr>
<tr>
<td>.wml</td>
<td>application/vnd.ms-excel</td>
<td>ascii</td>
<td>no</td>
<td>XWP</td>
<td>yes</td>
<td>wml</td>
<td>ascii</td>
</tr>
<tr>
<td>.xml</td>
<td>text/xml</td>
<td>ascii</td>
<td>no</td>
<td>XML</td>
<td>yes</td>
<td>xml</td>
<td>ascii</td>
</tr>
<tr>
<td>.zip</td>
<td>application/zip</td>
<td>binary</td>
<td>no</td>
<td>ZIP</td>
<td>yes</td>
<td>zip</td>
<td>binary</td>
</tr>
</tbody>
</table>

**Note:** This image displays the lower half of the page to show file extensions with varying values in the Redirect and Save Report fields.

The mime.wfs file, located in the directory `drive:\ibi\WebFOCUS_BUE82\WebFOCUS\client\wfc\etc` or `drive:\ibi\WebFOCUS_BUE82\WebFOCUS\client\home\etc` contains information about format types available with WebFOCUS. When you open the Redirection Settings page, WebFOCUS retrieves redirection settings from the mime.wfs file and displays them on the Redirection Settings page. When you save changes to these settings, WebFOCUS transfers them from the Redirection Settings page to the mime.wfs file.

Before making any changes to the Redirection Settings, you must assess the impact they will have on the applications and user experience within your organization. If you require further assistance, consult Customer Support Services.

Redirecting and Saving File Output

On the Redirection Settings page, values in the Redirect and Save Report settings determine whether the output from a request is stored in a temp folder file during processing, and whether a name is to be assigned to that file automatically. The combination of values assigned to these two settings determines the way in which output from requests is to be displayed and saved.
The Redirect setting allows you to specify if the output from a request should be saved to a file in the temp folder located under the WebFOCUS BUE client directory.

- If the value in the Redirect setting is yes, the output is saved to a file in the temp folder, where a name can be assigned to it, as directed by the value assigned to the Save Report setting.

- If the value in the Redirect setting is len, the output is saved to a file in the temp folder only if it exceeds the value assigned to the IBIWF_sendbufsize setting, which, by default, is 16384 bytes. Any output that must be saved to a file in the temp folder is then sent to the browser without an additional HTTP call.

- If the value in the Redirect setting is no, output is processed as directed by the value assigned to the Save Report setting.

The Save Report setting allows you to specify if report files should be assigned names automatically when they are created.

- If the value in the Save Report setting is no, the report, chart, or other output opens directly in the Browser or application without prompting users to open or save it. Users still have the option to save the report after it is opened. A randomly-generated name is assigned to the report output file regardless of whether the request originated from the Resources tree, from InfoAssist, or from some other application tool.

- If the value in the Save Report setting is yes, the report, chart, or other output is saved to a file in the temp folder, as follows:

  - If the report request specifies an output file name, it is assigned to the output file. Then the browser makes an HTTP call to retrieve the temporary stored output file, and prompts the user to open, save, or cancel it. The output file name appends the date and time at which the file was created only if the request also includes a PCHOLD AS statement that captures this information.

  - If the report request does not specify a file name:

    - If you run the request from an item in the Resources tree, the name value of that item is assigned to the request output file, and the date and time that the file was created is automatically added to the file name.

      **Note:** The name value of an item appears on the Properties panel in the Name field.
If you run the request from a tool such as InfoAssist, a randomly-generated name is assigned to the output file, and the date and time that the file was created is automatically added to the file name.

**Procedure: How to Change Redirection Settings**

Before changing Redirection Settings, consult with a system or network administrator to assess the impact of your proposed changes on the applications involved and on the user experience within your organization. If you require further assistance, consult with Customer Support Services.

1. In the Administration Console, on the Configuration tab, click *Redirection Settings*.

2. In the Redirect list:
   a. Click *yes* to redirect the output to a temporary directory for files using the specified extension.
   b. Click *no* to allow the output to be processed as directed by the value assigned to the Save Report setting.
   c. Click *len* to redirect report content to a temporary directory only when it exceeds the buffer size defined in the IBIWF_sendbufsize setting.

3. In the Save Report list:
   a. Click *yes* to prompt users in the browser to open or save the output for files using the specified extension.
   b. Click *no* to open output directly in the Browser or application without prompting users to open or save it.

4. If you want to encrypt the redirection settings, select the *Encrypt* check box at the bottom of the screen.

5. Click Save to save your changes in the Redirection Settings panel.

**Saving GRAPH (PNG, SVG, GIF, JPEG, or JPG) Requests**

In order to use the Save Report functionality for GRAPH requests that specify a PNG, SVG, GIF, JPEG, or JPG format in the procedure, you must take the following steps:

1. Set Save Report to *yes* for the .htm extension.

   Running a server-side GRAPH request creates an HTM file that contains a link to the actual graph output, which is stored as a temporary image file with a .jpeg, .jpg, .gif, .svg, or .png extension.
2. When you execute a GRAPH request, if you select the Save option when prompted to open or save the output, the output is saved to an HTM file using only a reference to the graph image, which will eventually expire and be deleted from the server, as determined by the temporary file expiration settings in the Client Configuration.

3. To preserve the output of the GRAPH request, open the saved HTM file, right-click the graph image, and select Save Picture As to save it to disk permanently. You can then substitute an absolute reference to the saved image file in the HTM output file.

Working With HTML5 Chart Extensions

The HTML5 Chart Extensions page contains all HTML5 chart extensions currently installed in your local installation of WebFOCUS Business User Edition, as shown in the following image.

HTML5 chart extensions expand the standard set of InfoAssist charts to include customized charts tailored to very specific reporting and data visualization requirements. Features on this page allow you to upload HTML5 chart extensions, enable or disable their use in InfoAssist, and uninstall them from WebFOCUS Business User Edition when no longer needed.
Understanding HTML5 Chart Extension Entries

Each HTML5 Chart Extension entry contains details that identify a chart extension and its origin, and help you determine if a chart extension is appropriate for your installation of WebFOCUS Business User Edition.

<table>
<thead>
<tr>
<th>Name:</th>
<th>Chord Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version:</td>
<td>1.0</td>
</tr>
<tr>
<td>API Version:</td>
<td>1.0</td>
</tr>
<tr>
<td>Author:</td>
<td>Three D Graphics</td>
</tr>
<tr>
<td>Copyright:</td>
<td>Three D Graphics Inc.</td>
</tr>
<tr>
<td>URL:</td>
<td><a href="https://github.com/biz/wf-extensions-chart/tree/master/com.ibm.chord">https://github.com/biz/wf-extensions-chart/tree/master/com.ibm.chord</a></td>
</tr>
<tr>
<td>License:</td>
<td>BSD 3-clause</td>
</tr>
</tbody>
</table>

Each entry identifies an HTML5 chart extension with a Name, Description, Version, and API Version. These details help you identify the chart extension you want to use, and the specific version of it that best matches your requirements. The Author and Copyright identify the origin of the chart extension, and the URL links you to the location where you can retrieve additional copies. License information identifies the type of license, if any, under which the chart extension is made available to you, and helps you understand any limits on the use of the chart extension and the rights and obligations licensed users have to the developer.

Understanding the HTML5 Chart Extensions Enable/Enabled Check Box

Every HTML5 Chart Extension entry includes the Enable/Enabled check box that indicates whether or not the chart extension is available for use. The use of this check box provides a second level of availability that enables managers to restrict the full availability of HTML5 Chart Extensions to those that are in active use, while retaining all other installed HTML5 Chart Extensions in readiness for when they are needed.

When this check box is cleared, it displays the Enable label to indicate that selecting the check box will make the chart extension available for use, as shown in the following image.

<table>
<thead>
<tr>
<th>Name:</th>
<th>Chord Diagram</th>
</tr>
</thead>
<tbody>
<tr>
<td>Version:</td>
<td>1.0</td>
</tr>
<tr>
<td>API Version:</td>
<td>1.0</td>
</tr>
<tr>
<td>Author:</td>
<td>Three D Graphics</td>
</tr>
<tr>
<td>Copyright:</td>
<td>Three D Graphics Inc.</td>
</tr>
<tr>
<td>URL:</td>
<td><a href="https://github.com/biz/wf-extensions-chart/tree/master/com.ibm.chord">https://github.com/biz/wf-extensions-chart/tree/master/com.ibm.chord</a></td>
</tr>
<tr>
<td>License:</td>
<td>BSD 3-clause</td>
</tr>
</tbody>
</table>

HTML5 Chart Extensions that have the Enable check box selected are installed, but they are not available for use.
When this check box is selected, it displays the Enabled label to indicate that the chart is already available for use, as shown in the following image.

HTML5 Chart Extensions that have the Enabled check box selected are installed and are available for chart creation in InfoAssist. WebFOCUS Business User Edition identifies the files and directories included in that Chart Extension as eligible for calls from InfoAssist, and displays an icon for that Chart Extension in the Select a Chart menu that opens from the Other command in the Chart Type group, on the InfoAssist Format tab ribbon.

**Note:** The HTML5 Chart Extensions page does not manage copyright or license restrictions. You are ultimately responsible for the use of any HTML5 Chart Extension you upload. Therefore, you must ensure that you have a license or permission to use any HTML5 Chart Extension before uploading it to this page.

**Uploading Additional HTML5 Chart Extensions Using the Upload and Install Extensions Page**

Use the Upload and Install Extensions page to install additional HTML5 Chart Extensions. To open the Upload and Install Extensions page from the main HTML5 Chart Extensions page, click *Get more Extensions*, as shown in the following image.
The Upload and Install Extensions page opens, as shown in the following image.

The Upload and Install Extensions page provides two ways to install additional HTML5 Chart Extensions:

- By clicking the **Install Extension** button in entries for chart extensions that are found on the Information Builders public extension GitHub page, [https://github.com/ibi/wf-extensions-chart](https://github.com/ibi/wf-extensions-chart), but are not currently installed in WebFOCUS Business User Edition.

- By clicking the **Choose File** button to navigate to a folder on your local file system that contains a locally-developed HTML5 Chart Extension package in .zip file format.

To move back to the main HTML5 Chart Extensions page from the Upload an Install Extensions page, click **HTML Chart Extensions** under the Application Settings Folder, or click the **Back** button in your browser.

**Procedure:** How to Upload HTML5 Chart Extensions from the Local File System

Use this procedure to upload zip files containing HTML5 Chart Extensions from your local system.

You must ensure that you have a license or permission to use any HTML5 Chart Extension before uploading it to this page.

1. Sign in as a Manager and open the Administration Console.

2. On the Configuration tab, under the Application Settings folder, click **HTML5 Chart Extensions**.

3. On the HTML5 Chart Extensions page, click **Get more Extensions**.
4. On the Upload and Install Extension page, click *Choose File*, as shown in the following image.

The Open dialog box opens and points to the extensions folder for your local installation of WebFOCUS Business User Edition. Typically, this is the following folder:

```
drive:\ibi\install_dir\config\web_resource\extensions
```

where:

```
install_dir
```


**Note:** If you downloaded your HTML5 Chart extension zip file to a different directory, navigate to that directory and file.

5. Click the file containing the zipped version of the HTML5 Chart extension you want to upload, and then click *Open*.

6. When the HTML5 Chart Extensions page refreshes and returns you to the top, scroll down to the entry for the new HTML5 Chart Extension.

**Procedure:** How to Install HTML5 Chart Extensions From the IBI GitHub Page

Use this procedure to upload HTML5 Chart Extensions from the public IBI GitHub extension page, [https://github.com/ibi/wf-extensions-chart](https://github.com/ibi/wf-extensions-chart).

1. Sign in as a Manager and open the Administration Console.

2. On the Configuration tab, under the Application Settings folder, click *HTML5 Chart Extensions*. 
3. On the HTML5 Chart Extensions page, click *Get more Extensions*.

4. On the Upload and Install Extension page, review the list of extensions from GitHub that are not installed, as shown in the following image.

![HTML5 Chart Extensions](image)

5. If the chart extension you want to install appears in the list, click *Install Extension*.

6. When the HTML5 Chart Extensions page refreshes and returns you to the top, scroll back to your entry to confirm that the chart extension is now installed.

**Procedure:** How to Enable an Installed HTML5 Chart Extension

When you select the Enable check box in an HTML5 Chart Extension entry, you make it available for use in InfoAssist and in your local installation of WebFOCUS Business User Edition. You must ensure that you have a license or permission to use any HTML5 Chart Extension before making it available for use.

1. Sign in as a Manager and open the Administration Console.

2. On the Configuration tab, under the Application Settings folder, click *HTML5 Chart Extensions*.

3. On the HTML5 Chart Extensions page, scroll to the entry for the HTML5 Chart Extension that you want to enable.

   **Note:** You can also search for the chart extension by name, using the Find or Find on this page command that is supported by the browser.

4. Select the *Enable* check box, as shown in the following image.
5. When the HTML5 Chart Extensions page refreshes and returns you to the top, scroll back to your entry to confirm that the check box is now selected.

An icon for the HTML5 Chart Extension appears in the InfoAssist Select a Chart menu, which opens when you click the Other command in the Chart Types group on the Format tab.

Procedure: How to Disable an HTML5 Chart Extension

When you clear the Enabled check box in an HTML5 Chart Extension entry, you make it unavailable for use in InfoAssist and in your local installation of WebFOCUS Business User Edition. However, the chart extension remains installed on the HTML5 Chart Extension page and can be enabled again when needed.

1. Sign in as a Manager and open the Administration Console.
2. On the Configuration tab, under the Application Settings folder, click HTML5 Chart Extensions.
3. On the HTML5 Chart Extensions page, scroll to the entry for the HTML5 Chart Extension that you want to make unavailable.
   
   Note: You can also search for the chart extension by name, using the Find or Find on this page command that is supported by the browser.
4. Clear the Enabled check box, as shown in the following image.

5. When the HTML5 Chart Extensions page refreshes and returns you to the top, scroll back to your entry to confirm that the check box is now cleared.

The icon for the HTML5 Chart Extension no longer appears in the Select a Chart Menu that opens from the InfoAssist ribbon.

Procedure: How to Uninstall an HTML5 Chart Extension

1. Sign in as a manager and open the Administration Console.
2. On the Configuration tab, under the Application Settings folder, click HTML5 Chart Extensions.
3. On the HTML5 Chart Extensions page, scroll to the entry for the HTML5 Chart Extension that you want to uninstall.
Note: You can also search for the chart extension by name, using the Find or Find on this page command that is supported by the browser.

4. Click `Delete_CHARTNAME_ Chart` as shown in the following image.

5. When you receive a message asking if you want to permanently delete the extension, click Yes.

6. When the HTML5 Chart Extensions page refreshes and returns you to the top, scroll back to your entry to confirm that the entry is now deleted.

   The entry for the HTML5 Chart Extension no longer appears on the page.

Changing Application Settings

The Application Settings pages enable Managers to update configuration settings that are required by various components of the WebFOCUS Business User Edition web application. You can view or edit the application settings through the Administration Console.


Reference: Understanding Change Management Settings

Change Management settings determine which file types can be exported during the change management process, the format of the exported file, and whether some legacy functionality is preserved.

File Types Included in Export Package (IBI_CM_EXPORT_WFRS_FILE_EXTENSIONS)

Determines, by file extension, which files from the Reporting Server or the web will be included in exports created by the change management feature. The values included by default are acx, bmp, css, fex, gif, htm, html, ico, jpe, jpeg, jpg, js, mas, mnt, png, sty, and svg.

Retain Handles (IBI_CM_RETAIN_HANDLES)

This option is not relevant to WebFOCUS Business User Edition.

Zip Change Management Package (IBI_CM_ZIP)

When selected (True), the export package is compressed and delivered in a zip file.
Name format of Zip export files (IBI_CM_ZIP_FILE_FORMAT)

Select an option from the drop-down menu to specify the name format of the zip file.

Verify Signature on Import (IBI_CM_ZIP_VERIFY_SIGNATURE)

When selected (True), the export package is flagged for signature verification, which ensures that the code has not been tampered with and that the signature was produced with the expected key.

Reference: Understanding Deferred Reporting Settings

Deferred Reporting settings determine how deferred reports are processed.

Prompt for Custom Deferred Report Description (IBI_DEFERRED_CUSTOM_DESCRIPTION)

When this check box is selected, the default setting, users are prompted to optionally customize the description for the deferred report, which defaults to the title of the report being run deferred. This occurs whenever the description defined in the parameter (IBIMR_defer_description) has not been submitted with the run deferred report request.

When this check box is cleared, the title of the report being submitted to run deferred is assigned to the deferred report description automatically, and no prompt appears.

Display Deferred Request Submitted Notification (IBI_DEFERRED_NOTIFY_SUBMITTED)

When this check box is selected, the default setting, the Deferred Request Submitted window displays to confirm a successful deferred request. The user clicks OK to close the window.

When this check box is cleared, the Deferred Request Submitted window does not display.

Display Deferred Ticket Delete Confirmation (IBI_DEFERRED_TICKET_DELETE_CONFIRM)

Activates an automated message that prompts the user to confirm the deletion of a deferred report. When this check box is selected, which is the default, a message prompts the user to confirm the deletion, so a deletion requires two clicks. When this check box is cleared, the user is not prompted to confirm the deletion, so a deletion requires only one click. Making a large number of deletions is faster when suppressing the confirmation message.
**Reference: Understanding ESRI Settings**

ESRI settings defines the connection to the local application that supports Esri-based maps.

**ESRI On Premise (IBI_ESRI_ON_PREMISE)**

Identifies the path to the internal ArcGIS JavaScript API Source used to develop Esri-based maps for WebFOCUS Business User Edition. This setting is blank, by default, meaning that the use of an internal source is not activated. To activate the use of an internal ArcGIS JavaScript API to develop Esri maps, type the path to it in this setting, typically, `/web_resource/arcgis_api`.

The default API that should be referenced by this setting is the ArcGIS API for JavaScript, version 3.15, which can be found at [https://js.arcgis.com/3.15/](https://js.arcgis.com/3.15/). The ArcGIS JavaScript API zip file is available for download from [https://developers.arcgis.com/downloads/](https://developers.arcgis.com/downloads/).

For more information about the Esri ArcGIS JavaScript API, see [https://developers.arcgis.com](https://developers.arcgis.com).

For more information about how to configure Esri On Premise for InfoAssist, see [Configuring an Esri On Premise Environment](#) on page 545.

**Reference: Understanding Parameter Prompting Settings**


**Managed Reporting (IBIMR_PROMPTING)**

Enables or disables parameter prompting for all Managed Reporting requests. Possible values are:

- **Off.** Turns off parameter prompting at the site level.

- **Run with Default Values. (XMLRUN)** Prompts for amper variables that were created with the –DEFAULT command and any other amper variable that does not have a value. This is the default value.

- **Always Prompt. (XMLPROMPT)** Prompts for amper variables that were created with the –DEFAULT command when there is another amper variable that does not have a value assigned.
Managed Reporting when Prompt Parameters Property Unset (IBIMR_PROMPTINGUNSET)

Enables or disables parameter prompting for Managed Reporting procedures (FEXes) when IBIMR_prompting is set to XMLPROMPT or XMLRUN, and the Prompt for Parameters setting is unchecked in the FEX Properties dialog box. Possible values are:

- **OFF.** Turns off parameter prompting.
- **Run with Default Values. (XMLRUN)** Prompts for amper variables that were created with the –DEFAULT command and any other amper variable that does not have a value. This is the default value.
- **Always Prompt. (XMLPROMPT)** Prompts for amper variables that were created with the –DEFAULT command when there is another amper variable that does not have a value assigned.

Self Service (IBI_WFDESCRIBE_DEFAULT)

Enables or disables amper auto prompting for self-service reporting. Possible values are:

- **OFF.** Turns off auto prompting. This is the default value.
- **Run with Default Values. (XMLRUN)** Prompts for amper variables created with the -DEFAULT command and for any other amper variable that does not have a value.
- **Always Prompt. (XMLPROMPT)** Only prompts for amper variables created with the -DEFAULT command when there is another amper variable that does not have a value assigned and, therefore, will be prompted for.
- **Display XML (Debug with syntax error checking). (XML)** The XML document describing the amper variables is displayed in the browser. This setting is used internally, and is recommended for debugging and syntax error checking purposes only.
- **Display XML (Debug). (XMLCHECK)** The XML document describing the amper variables is displayed in the browser. This setting is used internally, and is recommended for debugging purposes only.

**Note:** Managed Reporting uses a separate variable setting, which is IBIMR_prompting.

Default Autoprompt Template (IBI_DESCRIBETEMPLATES)

The HTML template that defines the auto prompt layout.
Null Behavior (IBIF_DESCRIBE_NULL)

Specifies the value (_FOC_NULL or FOC_NONE) that the client assigns (in a -SET command) to the amper variable when the dynamic multi-select list No Selection value is selected. The default value is _FOC_NULL.

Reference: Text Generation Server Settings

Text Generation Server settings define the connections to an independent server that provides narrative descriptions for chart headers, footers, and tooltips.

Text Generation Server URL (IBI_TEXT_GENERATION_SERVER_URL)

Identifies the URL of the external natural language generation (NLG) server that provides narrative descriptions for chart headers, footers and tooltips. If your product installation supports natural language generation for charts, type the URL of the text generation server in this setting. This setting is blank, by default.

When you activate the use of an external natural language generation (NLG) server, this setting contains a value, typically:

http://machine_name:20000/yseop-manager/direct/savvy-kb/dialog.do

Where:

machine_name

is the name of the server that hosts the external natural language generator.

Changing Client Settings

InfoAssist Properties

Settings in the InfoAssist Properties page of the Administration Console determine the display and use of the InfoAssist tool that opens when Advanced Users, Developers, or Managers create or update content.

To enable or disable reporting options for the v tool, click Utilities, scroll down to the bottom of the Configuration tab menu, and then click InfoAssist Properties.
Reference: Understanding InfoAssist Home Tab Properties

The InfoAssist Home tab enables you to control the most commonly used properties and options from the Format, Design, Filter, and Report groups. These properties are:

Use Live Preview Mode

Determines whether InfoAssist opens in the Live Preview mode or the Query Design View by default. When Yes is selected, InfoAssist opens in the Live Preview mode as the default. When Yes is not selected, InfoAssist starts with the Query Design View. If Allow User Override is selected for this option, users can change the setting specified by the Manager.

Record Limit

Enables the Record Limit menu of the Home tab. If Show is not selected, the Record Limit menu is removed from the InfoAssist interface.

Themes

Provides InfoAssist users with various color-coded StyleSheet themes that can be used to style reports and charts. Users can select standard InfoAssist themes, or select customized cascading style sheet themes created by your organization. If Show is not selected, the Themes menu is removed from the InfoAssist interface.

Page Heading

Enables the Head/Foot menu of the Home tab. InfoAssist users can use the Head/Foot menu to add a heading or footing to each page of the report output. If Show is not selected, the Page Heading menu is removed from the InfoAssist interface.

Report Heading

Enables the Head/Foot menu of the Home tab. InfoAssist users can use the Head/Foot menu to add a heading or footing to the first page of the report output. If Show is not selected, the Report Heading menu is removed from the InfoAssist interface.

Reference: Understanding InfoAssist Format Tab Properties

For reports or charts, InfoAssist displays a list of output file format options, such as, HTML, PDF, or Excel, in the Format Group of the Home tab. Other options that make additional layouts and display features available when creating a report or chart appear only on the Format tab itself. You can control the display of both types of options through the settings contained in this section. The settings that affect the Format tab display are InfoMini Run Immediate, Other Chart Types, Pages on Demand, Stack Measures, and User Selection.
Note: Settings in this section do not affect the display of Format tab features for visualizations.

Active Report Format

Enables the use of the HTML active report format. An HTML active report is a self-contained report that is designed for offline analysis. It contains all of the data and JavaScript within the HTML output file and it includes analysis options, such as filtering, sorting, and charting.

Select the check box to ensure that this option appears in the drop-down lists for the Report Output Format, Chart Output Format, and Document Output Format properties under the Tool Options Dialog Defaults section of the InfoAssist Properties page.

Additional HTML Formats for Chart

Enables the use of the PNG, JPEG, GIF, and SVG output formats. The default value is PNG. PNG is not available as a format for chart output.

Additional PDF Formats for Chart

Enables the use of the PDF/SVG and PDF/GIF output formats. The default value is PDF/SVG.

Excel 2000 Format

Enables the use of the Excel 2000 spreadsheet output format. The Excel 2000 format supports most StyleSheet attributes, allowing for full report formatting. The computer on which the report displays must have Microsoft Excel 2000 installed.

When this check box is selected, this output format option, Excel, is available for selection in the Output Format drop-down menus in the Tool Options Dialog Defaults section.

The Show check box for this setting is selected, by default.

Excel 2000 Formula

Enables the use of the Excel 2000 formulas when the Excel 2000 Format option is selected.

This check box is selected, by default.

Excel 2007 Format

Enables the use of the Excel 2007 spreadsheet output format. The computer on which the report displays must have Microsoft Excel 2007 installed.

When this check box is selected, this output format option, Excel (xlsx), is available for selection in the Output Format drop-down menus in the Tool Options Dialog Defaults section.
This check box is selected, by default.

**Excel 2007 Formula**

Enables the use of the Excel 2007 formulas when the Excel 2007 Format option is selected.

This check box is selected, by default.

**Excel Pivot**

Enables the use of the Excel 2000 PivotTable output format. PivotTable is an Excel tool for analyzing complex data, much like OLAP.

This check box is clear, by default.

**Excel CSV**

Enables the use of the comma separated values (CSV) file format.

When this check box is selected, the Excel CSV format option is available for use in InfoAssist, and it appears on the Home tab in the Format group options list under the Excel format option. When it is cleared, this option is not available, and it does not appear in the Format group options list.

This check box is selected, by default.

**HTML Format**

Enables the use of the HTML page report format.

Select the check box to ensure that this option appears in the drop-down lists for the Report Output Format, Chart Output Format, and Document Output Format properties under the Tool Options Dialog Defaults section.

**InfoMini Run Immediate**

If Enable is selected, reports run immediately when InfoMini first launches. This setting is enabled by default.

**Other Chart Types**

Allows the creation of more complex graph output types, such as Spectral Maps, Gauge Charts, and Pareto Charts.

**Pages on Demand**

Enables the display of report output one page at a time. InfoAssist users can use the navigation menu at the bottom of the output screen to view each page. This option is activated only when HTML or active report output format is selected.
PDF Format

Enables the use of the PDF report format.

Select the check box to ensure that this option appears in the drop-down lists for the Report Output Format, Chart Output Format, and Document Output Format properties under the Tool Options Dialog Defaults section.

PowerPoint 2000 Format

Enables the use of the PowerPoint® 2000 document output format. The computer on which the report appears must have Microsoft PowerPoint 2000 or higher installed.

Select the check box to ensure that this option appears in the drop-down lists for the Report Output Format, Chart Output Format, and Document Output Format properties under the Tool Options Dialog Defaults section.

PowerPoint 2007 Format

Enables the use of the PowerPoint® 2007 document output format. The computer on which the report appears must have Microsoft PowerPoint 2007 or higher installed.

Select the check box to ensure that this option appears in the drop-down lists for the Report Output Format, Chart Output Format, and Document Output Format properties under the Tool Options Dialog Defaults section of the InfoAssist Properties page.

Stack Measures

Displays all numeric measure field names in the first column of the report output, with the corresponding numeric data values displayed across time in a column for each selected time period. The Stack Measures feature is activated only when HTML, Excel, or PowerPoint output format is selected.

User Selection

Allows users to change the output type of their reports at run time.

Reference: Understanding InfoAssist View Tab Properties

Enables InfoAssist users to customize the view of different report components in the InfoAssist tool, such as the design mode, output location, and data view. You can configure the following properties in the InfoAssist View tab:

Display View Tab

Enables the View tab and all of its menu options. If the Show check box is not selected, the View tab is removed from the InfoAssist interface.
Data Panel

Allows the user to customize Data Panel settings. Values are Logical (default), List, and Structured.

Query Panel

Allows the user to customize the view of the query components, such as Filters, Column and Row labels, and Measures when building a report. Values are Tree (default), Area 2x2 (2 columns by 2 rows), Area 1x4 (1 column by 4 rows). If Allow User Override is checked for this option, users can change the setting specified by the Manager.

Reference: Understanding InfoAssist Tool Options Dialog Defaults Properties

Settings in the Tools Options Dialog Defaults section enables Managers to specify default tool settings. If the Allow User Override check box is selected for an option, users can change the setting specified by the Manager. However, the Manager cannot specify a default value that has already been disabled in one of the other groups. For example, if you have disabled the active report format in the Format Tab section, you will see an error message if you attempt to set that format as a default Compose Output Format in the Dialog Defaults section.

Report Output Format

Sets the default format for reports. Valid values are HTML, Active Report, PDF, EXL07, EXL2K, PowerPoint 2000, and PowerPoint 2007. To ensure that these options are available, a Manager must select the check box for each under the Format Tab section of the InfoAssist Properties page. The default value is HTML.

Chart Output Format

Sets the default format for charts. Valid values are HTML, HTML5, Active Report, PDF, EXL07, EXL2K, PowerPoint 2000, and PowerPoint 2007. To ensure that these options are available, a Manager must select the check box for each under the Format Tab section of the InfoAssist Properties page. The default value is HTML5.

Document Output Format

Sets the default format for documents that are generated in InfoAssist. Valid values are HTML, Active Report, PDF, EXL07, EXL2K, PowerPoint 2000, and PowerPoint 2007. The format options in this list are available only when their corresponding check box is selected in the Format Tab section of the InfoAssist Properties page. If that check box is cleared, you will receive a message warning you that the format option is not enabled when you select it from this list. The default value is Active Report.

Page Orientation

Sets the default page orientation for reports and charts. Valid values are Portrait and Landscape. The default value is Portrait.
Page Size

Sets the default page size for reports and charts. Valid values are A3, A4, A5, Letter, Tabloid, Legal, PPT-SLIDE, and Large Size. The default value is Letter.

Data Preview Method

Sets the default action for whether reports are previewed using sample data or actual data from the data source. Valid values are Sample and Live. The default value is Live.

Record Limit

Sets the default maximum number of rows retrieved from the data source when Interactive Design view is selected. This feature is useful in reducing response time if users are working with a large amount of data. It is applicable only when developing the report. The record limit setting will not affect the report output at run time. Valid values are All, 1, 10, 50, 100, 500, 1000, 2000, 5000, and 10000 rows. The default value is 500 rows.

Output Target

Sets the default location for reports and charts. Valid values are Single tab, New tab, Single window, and New window. The default value is Single tab.

InfoAssist/Portal StyleSheet

Sets the style sheet to be used for InfoAssist and the Portal. Click Change Stylesheet to open the Browse predefined template files window.

Visualization StyleSheet

Sets the style sheet to be used when creating visualizations. Click Change Stylesheet to open the Browse predefined template files window.

Encode HTML

Encodes script tags within data, so that the tags are replaced and not executable in a browser. The default value is Yes. This includes the ON TABLE SET HTMLENCODE ON command in the procedure.

Enable Pages On Demand

Allows InfoAssist users to view report output one page at a time. The user can use the navigation menu at the bottom of the output screen to view each page. This option is activated only when HTML or active report output format is selected.

Rows retrieved from cache

Establishes how many rows of cached data stored in a binary file are returned to the output window at one time. The default value is 100 rows.
**HTML Freeze Height**

Determines how the Freeze option, located on the Format tab in the Navigation group of the InfoAssist ribbon, automatically freezes the height of a report area.

If the AutoFit value is assigned to this setting, reports produced when the Freeze option is selected automatically fit the height of the window or pane in which they appear. This is the default value.

If the Fixed value is assigned to this setting, reports produced when the Freeze option is selected are set automatically to a fixed height of four inches, regardless of the size of the window or pane in which they appear.

**HTML Accordion**

Determines whether the Accordion option, located on the Format tab in the Navigation group of the InfoAssist ribbon, displays accordion reports that automatically resize data to fit the container in which they appear.

If the AutoFit value is assigned to this setting, reports produced when the Accordion option is selected automatically resize the display of data to fit the size of the container in which they appear, and automatically adjust column widths based on the size of the largest data value or column title. This is the default value.

If the legacy value is assigned to this setting, reports produced when the Accordion option is selected do not automatically resize the display of data to fit the size of the container in which they appear, and do not automatically adjust column widths.

**Reference:** *Understanding InfoAssist File Options*

Determines which of the following file types can be selected by InfoAssist users when creating and saving HOLD files:

**Binary**

Stores report or chart data as binary numbers in numeric fields. Binary files use the extension (*.ftm).

**FOCUS**

Stores report or chart data as text in a segment structure that conforms to FOCUS database requirements. FOCUS files use the extension (*.foc).

**Comma Delimited with Titles**

Stores report or chart data as text in sequence by field. Alphanumeric fields are enclosed in quotation marks. Fields are separated by commas and are preceded by Field Names. Comma Delimited with Titles files use the extension (* .csv) (Comma Separated Values).
Plain Text
Stores report or chart data as text in sequence by field without delimiters or field names. Plain Text files use the extension (*.ftm).

Tab Delimited
Stores report or chart data as text in sequence by field. Fields are separated by tab characters. Tab Delimited files use the extension (*.tab).

Tab Delimited with Titles
Stores report or chart data as text in sequence by field. Fields are separated by tab characters, and are preceded with field names. Tab Delimited with Titles files use the extension (*.tab).

Database Table
Stores report or chart data as text in a field structure that conforms to a Structured Query Language (SQL) Database format. Database Table files use the extension (*.sql).

Database Table output is only available when working against an SQL database.

Hyperstage
Stores report or chart data as text in a field structure that conforms to the Hyperstage database table format. Hyperstage files use the extension (*.bht).

Hyperstage output is only available when the reporting server has a Hyperstage adapter configuration.

SQL Script
Stores report or chart data as text in a sequential field structure that can be imported into a database table that conforms to the Structured Query Language (SQL) Database format. SQL Script files use the extension (*.sql).

SQL Script output is only available when working against an SQL database.

XML
Stores report or chart data as text in a field structure that conforms to the rules of the Extensible Markup Language. Fields are separated by tags that identify content. XML files use the extension (*.xml).

JSON
Information is not yet available.
Understanding InfoAssist Auto Drill Properties

Settings in this section enable the use of drill-down navigation options, which are part of the Auto Drill functionality.

**Single Click Navigate**
Enables the use of single click navigation, which is an automatic drill down to the next level of a dimension within the body of a report or chart made in response to a single click on a top-level entry or feature.

By default, this check box is not selected, meaning that single click navigation is disabled, and top-level Auto Drill entries or features display the Drilldown menu in response to a single click. If this check box is selected, single click navigation is enabled, and instead of displaying the Drilldown menu, top-level Auto Drill entries or features automatically refresh the report or chart with results based on the next lower level of your selected dimension in response to a single click.

**Breadcrumbs**
Enables the display of a breadcrumb trail at the top of an Auto Drill report or chart.

By default, this check box is selected, and Auto Drill reports and charts display a breadcrumb trail. If this check box is cleared, Auto Drill reports and charts do not display a breadcrumb trail.

In an Auto Drill report or chart, a breadcrumb trail displays a series of links to previous versions that were generated as you drilled through each level of your selected dimension to reach the version currently on display.

**Restore Original**
Enables the display of the Restore Original option in the Drilldown menu.

By default, this check box is selected, and the Restore Original option appears in the Drilldown menu. If this check box is cleared, the Restore Original option does not appear in the Drilldown menu. In an Auto Drill report or chart, the Restore Original option returns you directly to the original version.

**Drill Up**
Enables the display of the Drill up option in the Drilldown menu.

By default, this check box is selected, and the Drill up option appears in the Drilldown menu. If this check box is cleared, the Drill up option does not appear in the Drilldown menu. In an Auto Drill report or chart, the selection of the Drill up option refreshes the display with results based on the next level above the current level of your selected dimension.

**Drill Down**
Enables the display of the Drill down option in the Drilldown menu.
By default, this check box is selected, and the Drill down option appears in the Drilldown menu. If this check box is cleared, the Drill down option does not appear in the Drilldown menu. In an Auto Drill report or chart, the selection of the Drill down option refreshes the display with results based on the next level below the current level of your selected dimension.

**Note:** In addition to disabling the Drill down option, clearing this setting also removes hyperlinks from top level report entries and the breadcrumb trail display from reports and charts. If the Single Click Navigate setting is also cleared, clearing the Drill Down setting effectively disables Auto Drill navigation tools in reports and charts that contain only the top level of a dimension value in their design. If the Single Click Navigate setting is selected, and the report or chart contains entries below the top level, clearing the Drill Down setting shifts the Single Click Navigation feature to those lower-level entries. However, because this setting also suppresses the display of the Drilldown menu, users will neither be able to restore the original version of the report or chart, nor will they be able to drill back up to a higher level.

**Reference:**  
Understanding InfoAssist Miscellaneous Options

**Use two-part file name**

If selected, this option requires the use of two-part file names, which specify the path to the Master File location. If not selected, a one-part file name must be used instead. The default value is selected.

**Expand Data Source Tree**

Determines whether the initial view of the data source tree is expanded or collapsed. If selected, the tree is expanded. If not selected, the tree is collapsed. The default value is selected.

**Join Tool**

Displays the Join menu option on the InfoAssist Data tab. If not selected, the Join menu option is removed from the Data tab. The default value is selected.

**Layout Tab**

Enables the Layout tab in the InfoAssist control panel. If not selected, the Layout tab is removed from the InfoAssist control panel. The default value is selected.

**Series Tab**

Enables the Series tab in the InfoAssist control panel. The Series tab displays only when working with chart queries. It provides access to charting properties and options in the Properties, Line, and Pie menus. If not selected, the Series tab is removed from the InfoAssist control panel. The default value is selected.
Reporting Server Configuration Settings

Reporting Server configuration settings are available on the Configuration tab of the Administration Console. To view them, you must expand the Reporting Server folder and the Server Connections folder, and click the Reporting Server icon.

Reference: Reporting Server Node Properties

The Reporting Server Node properties from the Basic pane are explained below.

Basic

Node Name

The logical name of the node. The name cannot be the same as any other node name. It must begin with a letter and cannot be more than eight characters. The Client will use this name when it accesses this server.

Node Description

Optional. The description of the node that appears in the Configuration pane. If this is omitted, the node name will be used.

Host

The Host name or IP address of the Server.

TCP/IP Port

The Port number for the TCP listener. The default port is 8120.

HTTP(S) Port

The Port number for the HTTP listener. This is typically one port after the TCP/IP port.

The default HTTP port is 8121.

Security

The security options for the reporting server connection.

- **Prompt for Credentials.** This option is not relevant to WebFOCUS Business User Edition.

- **HTTP Basic.** This option is not relevant to WebFOCUS Business User Edition.

- **Kerberos.** This option is not relevant to WebFOCUS Business User Edition.

- **SAP Ticket.** This option is not relevant to WebFOCUS Business User Edition.

- **Service Account.** This option is not relevant to WebFOCUS Business User Edition.
trusted. Allows you to connect to the Reporting Server with only a user ID. This option is useful when no password is available for the user. Controls should be placed on the Server to ensure that connections from unauthorized clients are rejected. For example, you can employ the Reporting Server RESTRICT_TO_IP setting or configure a network firewall so that only a particular client can connect to the Server.

**Note:** When configuring the Client to make trusted connections to the Reporting Server, you must also enable the Reporting Server to accept trusted connections.

**Advanced**

The Reporting Server Node properties from the Advanced pane are explained below.

**Service Name**

Description for the Reporting Server node. This description displays to end users.

**Use HTTPS**

Enables encrypted communication between the Client and the Reporting Server HTTP listener. The default value is off.

This option must be selected if the Reporting Server HTTP listener is configured to use SSL. If you are using a self-signed certificate to enable HTTPS communication with a Reporting Server, the certificate must be configured in the Java environment where the Client is installed. This enables HTTPS communication between the Reporting Server and the Administration Console.

**Compression**

Enables data compression. By default, data compression is disabled.

**Encryption**

Sets data encryption ability and the cryptography symmetric method used.

Select one of the following options from the drop-down list:

- **0. Off.** This is the default value.
- **AES.** Advanced Encryption Standard. The AES selections are in the format

  \[CIPHER (x) (-MODE)\]
where:

**CIPHER**

Is AES128, AES192, AES256.

**x**

Is optional and defines an RSA key length of 1024 bits. When this is not specified, the RSA key is 512 bits.

**CBC**

Is optional and defines the use of Cipher Block Chaining (CBC) mode. When the mode is not specified, Electronic Code Book (ECB) is used.

For example, AES256x-CBC is the AES256 cipher with a 1024-bit RSA key in CBC mode. AES128 is the AES128 cipher with a 512-bit RSA key in ECB mode.

**Connect Limit**

Specifies the number of seconds that the Client will hold the pending connection. Other possible values are 0 (no wait) and -1 (infinite wait). The default value is -1.

**Maximum Wait**

Specifies the time, in seconds, that the Client will wait before timeout. You can optionally specify different return times for the first row and other rows. A single number indicates the return time is valid for any row. If two numbers are separated by a comma, the first number specifies the return time for the first row and the second number specifies the return time for the subsequent rows. The default value is -1, which indicates an infinite wait time.

**Security Object**

For any security option, a Manager can specify one or more HTTP header names and/or cookie names as follows:

- **Cookie.** Specify each HTTP cookie name separated by a comma (,). For example:
  
  `cookie_name1, cookie_name2`

- **Header.** Specify each HTTP header name separated by a comma (,). For example:
  
  `header_name1, header_name2`

**Note:**

- HTTP cookie and header names must not contain commas (,) or colons (:). These are reserved delimiters.
REMOTE_USER is a special type of HTTP header variable whose contents will not be sent to the Reporting Server. Therefore, it is not a valid HTTP header value. Instead, specify the WF_REMOTE_USER variable.

**Reference:** Reporting Server Node Security Options

The security options from the Client Configuration pane are explained below.

**Prompt for Credentials**

WebFOCUS Business User Edition makes an explicit connection to the Reporting Server with the user ID and password specified in the Web Security tab. This is the default value.

**HTTP Basic**

WebFOCUS Business User Edition extracts the user ID and password from the authorization header. These credentials are then used to make an explicit connection to the Reporting Server. You should only select this option when your web tier is performing Basic Authentication.

**Note:** You can verify that the authorization header is available in by selecting HTTP Request Info in the Diagnostics tab.

**Kerberos**

WebFOCUS Business User Edition passes a Kerberos ticket for the user to the Reporting Server. This option enables an end-to-end single sign on solution from the desktop to WebFOCUS Business User Edition, from WebFOCUS Business User Edition to the Reporting Server, and from the Reporting Server to supported relational DBMS systems. To use Kerberos authentication, the Reporting Server must run in security OPSYS mode.

**SAP Ticket**

WebFOCUS Business User Edition passes the user MYSAPSSO cookie, which is created on SAP Enterprise Portal, to the Reporting Server. The Reporting Server then validates the cookie using the SAP security API. This option enables single sign on from WebFOCUS Business User Edition to a Reporting Server configured with the Data Adapter for SAP for environments using Open Portal Services in SAP Enterprise Portal.
**Service Account**

Allows you to specify a user ID and password to be used for all connections to the Reporting Server.

The service account credentials are encrypted and stored in the SECURITY keyword of the odin.cfg file. When defined, the service account overrides any other credentials that may be presented to WebFOCUS Business User Edition for this Reporting Server node, and all users connect to the Reporting Server using the same credentials. This approach does not make it possible to identify which user is running a given request on the Reporting Server in Managed Reporting deployments, and therefore is not recommended for them.

**Trusted**

Allows you to connect to the Reporting Server with only a user ID. This option is useful when no password is available for the user. Controls should be placed on the Server to ensure that connections from unauthorized clients are rejected. For example, you can employ the Reporting Server RESTRICT_TO_IP setting or configure a network firewall so that only a particular client can connect to the Server.

**Note:** When configuring WebFOCUS Business User Edition to make trusted connections to the Reporting Server, you must also enable the Reporting Server to accept trusted connections.

**Using the ReportCaster Console**

The ReportCaster Console is the interface that provides access to the tools that administer the Distribution Server and manage schedule job logs, blackout dates, and execution IDs.

**Note:** Throughout this section, the ReportCaster Console will be referred to as the Console.

**Using the ReportCaster Console**

The following tools are accessible from the Console.

- Server Status
- Job Status
- Job Log
- Configuration
- Blackout Periods
- Global Updates
Purge Logs

In WebFOCUS Business User Edition configurations licensed for ReportCaster, authorized users can access the ReportCaster Console through the Administration Console, from the Administration option on the menu bar, as shown in the following image.

Depending upon your privileges, these options are also available from the ReportCaster Status option on the Tools menu, as shown in the following image.
The Console intuitive ribbon displays in a new browser window, as shown in the following image. The ribbon displays a tab for each tool the user is authorized to access.

Server Status

The Server Status tool allows Managers to select a Distribution Server to restart, suspend, or stop. The tool also enables Managers to view traces or refresh data, as shown in the following image.
Viewing the Distribution Server Status

The Server Status tool, accessed by selecting the Server Status tab in the Console, enables you to view the status of the Distribution Server. The Server Status tool also provides details about the Distribution Server, such as the host name and port number, the status, and the number of jobs that are running and in the queue. The Distribution Server information includes:

- **Distribution Server.** The name used to identify the server in the Console. Primary is the name given to the server listed in the ReportCaster Configuration tool setting (Primary Distribution Server).

  **Note:** When the Distribution Server attempts to make an SMTP connection to an Email server, the connection will timeout after five minutes.

- **Host** and **Port.** The host name and port number where the Distribution Server is installed.

- **Mode.** The state and function of the Distribution Server. Options include:

  - **Full Function.** Indicates that the Distribution Server is up and functioning. When you configure ReportCaster with a secondary Distribution Server, this indicates that the server is acting as the primary Distribution Server.

  - **Down.** Indicates that the Distribution Server is stopped.

- **Running.** The number of scheduled and on demand jobs that are currently running.

- **Queued.** The number of scheduled and on demand jobs that are in the Distribution Server queue.

- **Services.** The services currently running on the Distribution Server. Options include:

  - **Cache Cleaner.** The Distribution Server uses this service to refresh the IBFS Cache. The frequency at which the cache is refreshed is controlled by the setting IBI_Repository_Sync_Interval in the Administration Console.

  - **Console.** The Distribution Server uses this service to listen for communication from the ReportCaster application or API.

  - **Dispatcher.** The Distribution Server uses this service to execute scheduled jobs.

    **Note:** Depending on your server configuration, you may have one or more additional Dispatchers listed in the Server Status Dialog box.

  - **Reader.** The Distribution Server uses this service to poll the Repository.
Status. The status of each service currently running on the Distribution Server. Options include:

- **Active.** The service is active.
- **Ready.** The service is available.
- **Standing By.** The service is standing by.
- **Suspend.** The service is suspended.
- **Listening.** The Console service is actively listening.
- **Polling.** The Reader service is active.
- **Monitoring.** The Repository Monitor is active.
- **Waiting.** Displayed when a job in the running queue is waiting for a connection to the reporting server. Occurs when a multi-task schedule is started because a connection is available to the reporting server in the first task but then waits because a connection is not available to the reporting server in the second task.

From the Server Status interface, you can perform the following tasks:

- **Refresh.** Retrieves the most current information and refreshes the Distribution Server status with this information.
- **Restart.** Recycles the Distribution Server and the Application Server.
- **Suspend.** This option is always available. Suspends the Distribution Server services, but the server remains running. When you suspend a server, the Suspend button label will change to Resume.
- **Stop.** Brings the Distribution Server completely down.

  **Note:** When you stop the Distribution Server using this option, you must restart it from the machine where it resides. You cannot restart the Distribution Server remotely.

- **View Trace.** Allows you to view trace information for the scheduler.log, main.trc, reader.trc, console.trc, and dispatcher.trc files. You can also turn the Distribution Server traces on or off. For more information, see How to Turn Distribution Server Traces On or Off on page 167.

  **Note:** Distribution Server traces are tracked separately from Job traces using this functionality. You do not need to turn on job traces to see distribution server traces.

- **Help.** Opens the Console Server Status online documentation.
Procedure: How to Turn Distribution Server Traces On or Off

1. From the ReportCaster Console, select Server Status.
2. From the Distribution Server list, select a server.
3. On the toolbar, click the down arrow on the Server Log button.
4. Click Turn On Server Traces to turn the Distribution Server traces on, as shown in the following image.

To disable the Distribution Server traces, follow steps 1 and 2, and then hover over Turn On Server Traces and click Turn Off Server Traces.
**Separate Job Queues for Each Data Server**

The Distribution Server has separate job queues for each Reporting Server, as well as an additional queue for tasks that do not require a Reporting Server, as shown in the following image. Therefore, there will always be at least one job thread available for each Reporting Server, in addition to at least one thread for non-server based jobs. No one Reporting Server can have all of the available job threads consumed by jobs associated with that server.

![Server Status](image)

**Viewing, Stopping, Suspending, and Restarting the Distribution Server**

The Server Status interface enables you to stop and restart the Distribution Server, as follows:

- To stop the Distribution Server, click the **Stop** button. A window opens, asking you to confirm that you want to stop the server. Click Yes.

  **Note:** When you stop the Distribution Server using this option, the Server Status Restart option cannot be used to restart the Distribution Server. To start the Distribution Server, log on to the machine on which the Distribution Server is installed.

- To suspend the Distribution Server, click the **Suspend** button. A window opens, asking you to confirm that you want to suspend the server. Click Yes.

- To restart the Distribution Server, click the **Restart** button. A window opens, asking you to confirm that you want to restart the server. Click Yes.

  When you restart the server, the Distribution Server and the ReportCaster Application are restarted.

- To obtain the most current information about the Distribution Server, click **Refresh**.
Procedure: How to Restart a Server
1. Select a server that is running.
2. From the toolbar, click Restart to restart the server.
   A window opens, asking you to confirm that you want to restart the server.
3. Click Yes.

Procedure: How to Suspend and Resume a Server
1. Select the server in Full Function mode.
2. On the toolbar, click Suspend.
   A window opens, asking you to confirm that you want to suspend the server.
3. Click Yes.
   The reader service is suspended and the toolbar button changes to Resume.
   To resume polling the repository for schedules, click Resume. Click Yes to confirm.

Procedure: How to Stop a Server
1. Select a running server and click Stop.
   A window opens, asking you to confirm that you want to stop the server.
2. Click Yes.

Job Status
Another resource for tracking schedules is the schedule job status. The schedule status provides a list of scheduled jobs that are in the Distribution Server queue. Status information includes the Schedule ID, the time it started running, and the status of the job.

The schedule information includes:

- Job Id. The ID assigned to the job.
- Schedule ID. A unique ReportCaster generated key assigned to the job when it was scheduled.
Description. The description provided when the schedule was created.

Priority. The priority level of the schedule. 1 is the highest and 4 is the lowest priority.

Start Time. The time that the schedule run began.

Owner. The name of the user who owns the schedule.

Status. The status of the scheduled job. It contains one of the following values:

- Running. The scheduled job is currently running.
- Queue. The scheduled job is waiting for a thread to become available to run the request.

Server Name. The Reporting Server to which the job has been submitted.

Job Log

The Job Log tab enables you to view the logs of executed jobs belonging to you or to users whose job logs you are authorized to see. You can view log and trace information, open job logs, delete job logs, refresh job logs, or access related help for job logs on the Job Log tab. You can also view log and trace information for the daily and on-demand Log Purge jobs. The Log Purge log can be accessed from the system folder. The logs for other jobs can be accessed under the folder of the user to whom the job belongs.

Note: The Job Log tab supports the functionality of a multiple selection, whereby you can open or delete multiple files simultaneously.

The job logs information includes:

- Job Id. The ID assigned to the job.
- Start Time. The time that the schedule was run.
- Job Duration(seconds). The amount of time needed to complete a job.
- Job Status. The status of the job when it completed processing.
  - Success. No errors occurred during the scheduled job processing.
  - Error. One or more errors occurred during the scheduled job processing. No report was generated or distributed.
  - Warning. One or more warnings occurred during the scheduled job processing. A report was generated and distributed.
ReportCaster Configuration

The Configuration tool enables Managers to view and manage the configuration of the Distribution Server, Servlet (deployed in WebFOCUS Business User Edition web application) interfaces and tools. Options that Managers can modify include Distribution Servers, Repository Settings, General Preferences, Email Distribution, Notification, and other options, as shown in the following image.

Configuration Icons

In the Configuration tab on the ReportCaster Console ribbon, a series of icons enable you to perform the following tasks.

**Note:** When you select *Configuration* in the ReportCaster Console ribbon, the Manage Configuration group displays on the left-hand side. Clicking *Server Status*, *Job Status*, *Job Log*, or *Blackout Periods* will change the name and functionality of this group, depending where you are in the interface. These options all appear in the Show group of the ribbon.

- **Manage Configuration group**
  - **Save.** Saves any changes made to the configuration. You will receive a message asking you to confirm the save. You must save the changes to the configuration settings as part of the process to implement the change. For details, see *Changing Configuration Settings* on page 174.
New. Creates a new Reporting Server. This option is only active when working in the Data Servers folder.

Remove. Deletes a Reporting Server from the ReportCaster configuration. You will receive a message asking you to confirm the deletion. This option is only active when working in the Data Servers folder.

Test. Tests the connection to the selected server or repository. This option is only active when working in the Data Servers, Repository Settings, and LDAP Settings folders. You may be prompted for a user ID and password to connect to a specified server. You will receive a message describing whether the test succeeded or failed.

Restart. Restarts the Distribution Server and ReportCaster to implement changes to the server configuration. You can also select Restart from the Action menu. For more information, see Changing Configuration Settings on page 174.

Configuration Files. Provides options to view and download the ReportCaster configuration files. Click the arrow to access the following individual files.

- dserver.xml. Contains a record of current ReportCaster configuration settings.
- sendmodes.xml. Contains information about MIME output file formats.
- rc_preference.xml. Contains information about the display of options in the UI.

Clicking one of these file options displays the file information in a browser window. Download Configuration Files to download all files as a single zip file.

Tools group

Global Updates.

Authorized users can make global updates for the values stored in schedules and distribution lists. Using the Global Updates interface, the following settings can be updated:

- Mail Server
- FTP Server
- Printer
- Email Address
- Email From
- Data Server
Purge Job Logs. Provides on-demand capability for purging logs. You can also specify a number of days (past) for which to purge logs. For example, if you want to purge logs for the past month, you would use the default number of days, which is 30. You can also specify an option for traces: Default Traces, No Traces, or Trace On. For more information, see How to Purge Job Logs on Demand on page 245.

Actions group

Refresh. Refreshes the settings to reflect the last saved configuration settings.

Help. Opens the online Help file. This option is only available when accessing the configuration tool through the ReportCaster web application. It is not available when accessing the tool from the Windows Programs menu or by running editit.bat or the UNIX editit script file from the /utilities directory within the ReportCaster Distribution Server installation.

Configuration Tab Folders

The Configuration tab provides access to configuration settings through the following folders:

Distribution Servers. Defines and configures the Distribution Server.

General Preferences. Specifies which distribution formats and methods will be available to a user creating a schedule. In this folder, you can also specify if ReportCaster scheduling options will include the ability to distribute a PDF file directly to a printer. For details on these settings, see General Preferences on page 181.

Email Distribution. Configures email settings, such as the default email host, number of attempts to distribute to an email host, and security information. For details on these settings, see Email Distribution on page 187.

Notification. Configures notification settings, such as the notification email host and default notification type. For details on these settings, see Notification on page 198.

Zip Settings. Provides settings to configure how Zip files will be created and named. For details on these settings, see Zip Settings on page 201.
Other Schedule Defaults. Defines the default end date and time of a ReportCaster schedule. For details on these settings, see Other Schedule Defaults on page 203.

Log Purge. Allows you to specify the time and period that log files will be automatically purged. For details on these settings, see Log Purge on page 204.

LDAP Setting. Allows you to configure ReportCaster self-service users to be authenticated and authorized against an LDAP data source rather than the Repository. You can also configure ReportCaster to retrieve email address information from an LDAP data source. For details on these settings, see LDAP Setting on page 205.

Data Servers. Allows you to configure multiple Reporting Servers, including cluster servers. For details on these settings, see Data Servers Settings on page 208.

Changing Configuration Settings

To implement changes to the ReportCaster server configuration settings, you must save the changes, and then restart the Distribution Server and the ReportCaster web application. Use the following steps to save any configuration changes.

1. After you make changes to any of the configuration settings within a Configuration folder, click the Save icon in the Manage Configuration group toolbar.

   A window opens, asking you to confirm the save.

2. Click OK.

   A window opens, explaining that you must restart the Distribution Server and the ReportCaster Web Application in order for the changes that you saved to take effect.

3. Click OK.

4. Click the Restart icon in the Manage Configuration toolbar.

   A window opens, asking you to confirm that you want to stop all running jobs and restart.

5. Click Yes.

6. Notify all users that are currently logged that they must restart their sessions to obtain the new configuration information. This is required because user sessions have information cached pertaining to the ReportCaster configuration. The user interfaces must be restarted to obtain any updated configuration information.
Changing Default User IDs

Several of the Configuration tab folders provide the option to change the default user ID and/or password. To change a default user ID settings, click the icon that appears to the right of the setting field. This opens the User dialog box, where you can type a new user ID and password. When your changes are complete, click OK to exit the User dialog box. Remember to save your changes and restart the Distribution Server to implement any changes.

Distribution Server Settings

The Distribution Servers folder contains the settings that define and configure the Distribution Server. The Server Status option, located on the ribbon, provides the ability to restart the Distribution Server, suspend distribution, stop distribution, switch servers, and refresh data. For more information, see Server Status on page 164.

The Distribution Servers folder contains the following configuration settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Primary Distribution Server section</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Host</td>
<td>Required.</td>
<td>Host name of the primary Distribution Server.</td>
</tr>
<tr>
<td>Port</td>
<td>Required.</td>
<td>Port number of the primary Distribution Server.</td>
</tr>
<tr>
<td>Restrict to IP Address</td>
<td>Optional.</td>
<td>Restricts Distribution Server console access to one or more IP Addresses.</td>
</tr>
<tr>
<td>Reader Interval</td>
<td>Required.</td>
<td>Polling interval (in minutes) for the ReportCaster Distribution Server to check for scheduled jobs. An acceptable value is any positive integer from 1 to 999999. Negative numbers and zero are not allowed.</td>
</tr>
<tr>
<td>Setting</td>
<td>Optional or Required/Default Value</td>
<td>Descriptions and Possible Values</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Recovery</td>
<td>Default value is OFF.</td>
<td><strong>On.</strong> During startup, the ReportCaster Distribution Server recovers scheduled jobs that were processed but not completed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Off (Default).</strong> During startup, the ReportCaster Distribution Server does not recover any scheduled jobs.</td>
</tr>
<tr>
<td>Processing for No Report to Distribute</td>
<td>Required. Default value is Error.</td>
<td>Specifies whether the <em>No Report to Distribute</em> message from the WebFOCUS Reporting Server is categorized as an error or a warning. This is a global setting, relevant to all schedules. Possible values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Error.</strong> The <em>No Report to Distribute</em> message is categorized as an error and the message is written to the ReportCaster log report in red. When the schedule has the Notification option set to Error, the Notification is sent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Warning.</strong> The <em>No Report to Distribute</em> message is categorized as a warning and the message is written to the log report (in orange) as an informational message. When the schedule has the Notification option set to Warning, no error notification is sent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>These settings also apply to burst reports when there is a <em>No Report to Distribute</em> message for an individual burst value.</td>
</tr>
<tr>
<td>Setting</td>
<td>Optional or Required/Default Value</td>
<td>Descriptions and Possible Values</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>------------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Processing for Blackout Period Job Termination</td>
<td>Required. Default value is Error.</td>
<td>If a scheduled report distribution is terminated due to a previously set blackout period, this option specifies whether or not an error notification will be sent via email.</td>
</tr>
<tr>
<td>Max Messages per Task from Data Server</td>
<td>Required. Default value is 1000.</td>
<td>Controls the number of messages for each task from the Data Server written to the ReportCaster log file.</td>
</tr>
</tbody>
</table>

**Scan-back section**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scan-back Type</td>
<td>Required. Default value is On.</td>
<td>Possible values are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- On</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Off</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Reset Next Run Time</td>
</tr>
<tr>
<td>Setting</td>
<td>Optional or Required/ Default Value</td>
<td>Descriptions and Possible Values</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Scan-back Interval</td>
<td>Default value is 15, 24 hour periods.</td>
<td>If the Distribution Server is unavailable for a period of time, this is the number of 24 hour periods (beginning with the Distribution Server restart time) that you want the Distribution Server to scan for jobs not yet run and run them.</td>
</tr>
</tbody>
</table>

### Additional Settings folder

#### SSL Certificate section

<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/ Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Console Requires Secure SSL Connection</td>
<td>Optional</td>
<td>Select this check box to encrypt the communication between the ReportCaster application and the ReportCaster Distribution Server. After enabling secure communication and saving the changes, you must manually restart the ReportCaster application and the ReportCaster Distribution Server.</td>
</tr>
<tr>
<td>SSL Certificate</td>
<td>Required if The Console Requires Secure SSL Connection check box is selected.</td>
<td>A default SSL Certificate is supplied by the installation procedure. You can optionally replace the default certificate with your own certificate to activate secure communication.</td>
</tr>
</tbody>
</table>
### Setting Up Your Environment

<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/ Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule Job Traces</td>
<td>Options. The default value is Off.</td>
<td>Enables Distribution Server Traces.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Off.</strong> Trace is disabled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Schedule.</strong> Schedule job processing information.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- <strong>Schedule and Report.</strong> Scheduled job processing information and report output is returned to the Distribution Server to be distributed.</td>
</tr>
<tr>
<td>Hold Repository Connection</td>
<td>By default, this option is selected.</td>
<td><strong>Selected.</strong> The database connection is kept open throughout the execution of the schedule, including obtaining Address Book information and writing information to the log files.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Not selected.</strong> The database connection is dropped before executing the schedule. A new connection is made after the schedule is executed to obtain Address Book information and write information to the log files.</td>
</tr>
</tbody>
</table>

### Restricting Distribution Server Console Access to an IP Address List

Limiting Distribution Server access to a preselected IP address helps prevent denial of service (DoS) attacks against your server. A DoS attack is a malicious cyber-attack that overloads a server with requests from multiple IP addresses, which blocks legitimate IP addresses from accessing the server. You can use the Restrict to IP Addresses option in the ReportCaster Console to enhance the security of your network. If you populate the Restrict to IP Addresses field with one or more IP addresses, the Distribution Server only accepts TCP/IP requests from the addresses listed. This setting is blank by default.
**Procedure:** How to Configure IP Address Restrictions

1. Open the ReportCaster Console.
2. On the ribbon, in the Show group, click Configuration.
3. In the Configuration pane, click Distribution Servers.
   The Primary Distribution Server options display.
4. Click the Restrict to IP Addresses open folder button.
   The Allowed IP Addresses dialog box opens.
5. Click Add.
   The Add IP Address dialog box opens, as shown in the following image.

![Add IP Address dialog box](image)

6. Type an IP address and click OK. This adds the IP address to the Allowed IP Address list.
7. Repeat steps 5-6 to add any additional IP addresses.
8. Click OK to save the Allowed IP Address list and return to the ReportCaster Console.
9. On the ribbon, in the Manage Configuration group, click Save to keep your allowed IP address changes.
10. On the ribbon, in the Manage Configuration group, click Restart to apply your changes.

**Procedure:** How to Edit an IP Address

1. Click the Restrict to IP Addresses open folder button.
   The Allowed IP Addresses dialog box opens.
2. Click the IP address that you want to modify, and then click *Edit*.
   The Edit IP Addresses dialog box opens.
3. Modify the IP address, and then click *OK*.
4. On the ribbon, in the *Manage Configuration* group, click *Save* to keep your allowed IP address changes.
5. On the ribbon, in the *Manage Configuration* group, click *Restart* to apply your changes.

**Procedure: How to Delete an IP Address**

1. Click the *Restrict to IP Addresses* open folder button.
   The Allowed IP Addresses dialog box opens.
2. Click the IP address that you want to delete, and then click *Remove*.
   The selected IP address is deleted.
3. Click *OK*.
4. On the ribbon, in the *Manage Configuration* group, click *Save* to keep your allowed IP address changes.
5. On the ribbon, in the *Manage Configuration* group, click *Restart* to apply your changes.

**General Preferences**

The General Preferences folder in the Configuration tab, as shown in the following image, contains settings that determine which distribution formats and methods will be available to a user.
The General Preferences folder contains the following configuration settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow PDF Distribution Directly to a Printer</td>
<td>Required. By default, this option is selected.</td>
<td>When selected, PDF is a selectable format for the Printer distribution method. This enables a PDF file to be distributed directly to a printer. The printer must have the appropriate driver to print PDF files.</td>
</tr>
<tr>
<td>Distribution Formats</td>
<td>Optional. All formats are enabled, by default.</td>
<td>Specifies what report and graph formats are available to users.</td>
</tr>
<tr>
<td>Distribution Methods</td>
<td>Optional. All distribution methods are enabled, by default.</td>
<td>Specifies what distribution methods are available to users.</td>
</tr>
</tbody>
</table>

**Specifying Schedule Format Settings**

The Distribution Formats setting in the General Preferences folder enables users to specify what report and graph formats are available to users and groups.

This setting only applies to WebFOCUS (Repository) procedures. By default, all report and graph formats are enabled (selected). A minimum of one report or graph format must be selected.

**Note:** If a Format is cleared after a schedule using that Format has been created, the schedule will fail when it is run. A message in the log will indicate how to fix the problem.

**Procedure:** How to Specify Schedule Format Settings

1. In the General Preferences folder, click the icon to the right of the Distribution Formats field.
The ReportCaster - Report/Graph Formats dialog box opens, as shown in the following image.

2. Using the Styled Formats drop-down list, you can select Specialized Formats, Non-styled Formats, or Graph Images. Optionally, you can keep the default, Styled Formats.

By default, Styled Formats are displayed with each format type selected.

3. To enable or disable styled formats, select or clear the check box for one of the listed formats.
4. To enable or disable Non-styled Formats, which do not support styling using WebFOCUS StyleSheet commands, select Non-styled Formats from the drop-down list. By default, the Non-styled Formats are displayed with each format type enabled, as shown in the following image.

5. To enable or disable graph images, which are created by a WebFOCUS graph request, select Graph Images from the drop-down list. By default, the graph image formats are displayed with each format type enabled, as shown in the following image.
6. When your selections are complete in the Report/Graph Formats dialog box, click $\text{OK}$. The changes are saved and the Report/Graph Formats dialog box closes.

7. To implement the configuration changes, restart the Distribution Server and the WebFOCUS Business User Edition web application.

**Specifying Schedule Distribution Method Settings**

The Distribution Methods setting, in the General Preferences folder, enables authorized users to specify the distribution methods that are available to users and groups. If a method is cleared after a schedule using that method has been created, and *Only run schedules for selected Distribution Method* is selected, the schedule processing will not run the scheduled tasks. A message in the log will indicate that the distribution method is not configured for use. In addition, a schedule that has multiple distributions will not run if one of the distribution methods is cleared in the Distribution Methods drop-down menu, in the General Preferences folder, of the Configuration tab.

By default, all distribution methods are enabled (selected).

**Note:** A minimum of one distribution method must be selected.

The Repository option only appears if these products are enabled. Repository is an optional product component that is installed with WebFOCUS Business User Edition.

**Procedure:** How to Specify Schedule Distribution Method Settings

1. In the General Preferences folder, click the icon to the right of the *Distribution Methods* field.
The ReportCaster - Schedule Distribution Methods dialog box opens, as shown in the following image.

2. To enable or disable specific distribution methods, select or clear the check box for one of the listed options.

   **Note:** At least one schedule distribution method must be selected.

3. Optionally, select the *Only run schedules for selected Distribution Methods* check box to limit the schedules running to those that have at least one of the Distribution Methods selected.

4. When your selections are complete in the Schedule Distribution Methods dialog box, click **OK**.

   The changes are saved and the Schedule Distribution Methods dialog box closes.

5. To implement the configuration changes, restart the Distribution Server and WebFOCUS Business User Edition web application.
Email Distribution

The Email Distribution folder in the Configuration tab contains default email settings, email retry options, and email security. The Email Distribution window is shown in the following image.

![Email Distribution Window](image)

The Email Distribution folder contains the following configuration settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inline Report Distribution</td>
<td>Required. The default value is Allowed.</td>
<td>Specifies whether the Schedule tool will enable the email distribution option to send a report in the body of the email (inline). <strong>Note:</strong> If this option is cleared after a schedule using this option has been created, the schedule will fail when it is run. A message in the log will indicate how to fix the problem.</td>
</tr>
<tr>
<td>Setting</td>
<td>Optional or Required/Default Value</td>
<td>Descriptions and Possible Values</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Packet Email                 | Required. The default value is Yes. | Controls how task output and burst content are distributed through email. Valid values are:   

- **No.** Each burst value or task output is distributed in a separate email.  
- **Yes.** People receiving burst values or output from tasks will receive a single email with multiple attachments.  
- **Burst.** Each burst value in a distribution list will generate a separate email for a given email address. There may be one or more attachments in the email, depending on the number of tasks in the schedule.  |
| Allowed Email Domains and Addresses | The default value is Off. | Contains the email domains and addresses that are authorized in a distribution. Select the *Restrict user input with this list* check box to restrict user input of email addresses and domains to the allowed addresses saved in your list.

**Note:**  
- Files containing email addresses intended for distribution are also verified for valid domains at schedule execution time. If it contains a restricted address, then no delivery is made to that address and an error message is written to the log file. |
<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Customize Attachment Message</td>
<td>Optional</td>
<td>Provides the ability to specify a custom message.</td>
</tr>
<tr>
<td>Default Attachment Message</td>
<td>Required</td>
<td>Defines the default message used in your Email Distribution. The message that you define here displays in the Basic Scheduling Tool.</td>
</tr>
</tbody>
</table>

### Mail Server Defaults section

<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mail Server</td>
<td>Required</td>
<td>Name of the default mail server used to distribute an email schedule. You can also specify a port for Mail Host using <code>hostname:port</code>. If you do not specify a port or the port you specify is not present, the default port is used.</td>
</tr>
<tr>
<td>This Server Requires a Secure SSL Connection</td>
<td>Optional</td>
<td>Select this check box if the specified mail server uses SSL.</td>
</tr>
<tr>
<td>This Server Requires a Secure TLS Connection</td>
<td>Optional</td>
<td>Select this check box if the specified mail server uses TLS.</td>
</tr>
<tr>
<td>This Server Requires Authentication</td>
<td>Optional</td>
<td>Select this check box if the specified mail server requires authentication with a user ID and password.</td>
</tr>
<tr>
<td>SMTP User Id/Password</td>
<td>Required if the mailhost is using SMTP Authorization. No default value.</td>
<td>User ID and password used to connect to the mailhost.</td>
</tr>
</tbody>
</table>

### Email Reply Defaults section
<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mail From</td>
<td>Optional.</td>
<td>Default value for the email From field. This can be any value.</td>
</tr>
<tr>
<td>Mail Reply Address</td>
<td>Optional.</td>
<td>Default email reply address when creating an email schedule.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> If you do not provide a Mail Reply Address, the default Reply Address used in the Basic Scheduling tool will be the email address of the user that is signed to WebFOCUS. ReportCaster obtains the email address of the user from the WebFOCUS security system.</td>
</tr>
</tbody>
</table>

**Email Retries section**

<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email Retries</td>
<td>The default value is 1.</td>
<td>Number of times the Distribution server will try to connect to the email server to deliver report output.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the Distribution server is unable to connect to the email server on the first try, it will attempt to connect again after the specified Email Retry Interval has passed. A message for each attempt is written to the log file.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Valid values are 0 through 9.</td>
</tr>
<tr>
<td>Email Retry Interval(seconds)</td>
<td>The default value is 60 seconds.</td>
<td>Amount of time that the Distribution server will wait between retries.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Valid values are 1 through 999.</td>
</tr>
</tbody>
</table>

**Procedure:** How to Configure Email Distribution

1. From the Tools menu, click *ReportCaster Status*. 
2. Click the Configuration button, as shown in the following image.

   **Note:** Authorized users can also access the ReportCaster Configuration tool from the Administration Console.

3. In the left pane, select the *Email Distribution* folder.

4. Populate the email distribution fields. You can:
   - Make changes to the current email settings. For more information, refer to the preceding table.
   - Supply any default values that you would like to be available at schedule creation time.

5. If your mail server(s) require authentication or SSL or TLS, check the appropriate boxes and enter the required credentials.

6. Click Save.

**Validating Allowed Email Domains and Addresses**

When sending reports by email, you can restrict user selection of email domains and addresses from a pre-defined list.
The following image shows the Allowed Email Domains and Addresses dialog box in the ReportCaster Console, where this option is available.

Select the Enabled check box to restrict email distribution to a list of valid email domains and addresses. When the list is enabled, and a user enters an email address that is not on this list, the ReportCaster job cannot be saved.

If you select the Restrict user input with this list check box, users will only be able to use email domains and addresses selected from this list, applying another layer of email distribution restriction for other users.

**Note:** You must select the Enabled check box in order to select the Restrict user input with this list check box.

**Examples of Invalid Email Addresses and Domains**

In this example, an Administrator added the following email addresses and email domains to the Allowed Email Domains and Addresses list:

- john@ibi.com
- roger@ibi.com
- @gmail.com
- @yahoo.com
These additions to the list define what is valid and what is invalid for user input.

**Invalid Email Addresses**

For example, since john@ibi.com was added to the list, if a user types in John@ibi.com, with an upper case J, the email address is valid. This is because the Allowed Email Domains and Addresses feature is not case sensitive.

However, if a user types johnroger@ibi.com, which is a combination of two email addresses that were added to the list, the email address would be invalid, because this specific email address was not added to the list.

**Invalid Email Domains**

When entering domain addresses, if a user types in any email address with the email domain @gmail.com, it is valid, because @gmail.com is one of the domains added to the list.

However, if a user types in any email address with the email domain @outlook.com, it is not valid, because @outlook.com is not one of the domains added to the list.

**Email Domain and Address Restrictions**

Restrictions apply during the following situations:

- Editing Email Distribution options in the Basic Scheduling tool.

  The following image shows the Email Distribution options in the Basic Scheduling tool. If you select the **Restrict user input with this list** check box, you can click the **To**, **From**, and **Reply Address** fields to select or create email addresses.

  ![Distribution Information](image)

- Editing Notification Email options in the Basic Scheduling tool.
The following image shows the Notification Email options in the Basic Scheduling tool. If you select the *Restrict user input with this list* check box, you can click the *Reply Address*, *Brief Message To*, and *Full Message To* fields to select or create email addresses.

![Notification Email](image)

- Adding new members to a Distribution List

The following image shows the Distribution List Add New Member dialog box. If you select the *Restrict user input with this list* check box, you can click the *ellipsis* button next to the E-mail address field to select or create email addresses.

![Add New Member](image)

*The Email Selection Dialog Box*

When the *Restrict user input with this list* check box has been selected, you can click a *To*, *From*, *Cc*, *Bcc*, *Reply*, *Reply Address*, *Brief Message To*, *Full Message To*, or *ellipsis* button to display one of three dialog boxes. The dialog box that displays is based on the type of email domain and address information contained in the Allowed Email Domains and Addresses list.

**Note:**

- You can enter multiple email addresses into the *To*, *From*, *Cc*, *Bcc*, *Reply*, *Reply Address*, *Brief Message To*, and *Full Message To* fields.
To cancel the selection of an email address in the Select Email Addresses dialog box, hold the Ctrl key and select the email address.

A List of Only Email Addresses

If the Allowed Email Domains and Addresses list contains only email addresses, the Select Email Addresses dialog box allows you to select an email address for the To, Cc, Bcc, or Reply fields, as shown in the following image.

After you select an email address, click the To, Cc, Bcc, or Reply button to assign the email address to the respective field.
A List of Email Domains and Addresses

If the Allowed Email Domains and Addresses list contains both email domains and addresses, the Select or Enter Email Addresses dialog box lets you select from a list of email address. The dialog box also lets you create an email address for specific domains, as shown in the following image.

After you select an email address, or enter an email address and choose a domain, click the *To*, *Cc*, *Bcc*, or *Reply* button to assign the email address to the respective field.
A List of Only Email Domains

If the Allowed Email Domains and Addresses list contains only email domains, the input dialog box lets you select an email domain and enter the name of an email address, as shown in the following image.

After you enter an email address and choose a domain, click the To, Cc, Bcc, or Reply button to assign the email address to the respective field.
**Notification**

The Notification folder in the Configuration tab contains default notification settings. The Notification window is shown in the following image.

The Notification folder contains the following configuration settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Notification Defaults section</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Optional or Required/Default Value</td>
<td>Descriptions and Possible Values</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Notify Mail Server</td>
<td>Optional.</td>
<td>Name of the mail server that distributes the notification email. If blank, ReportCaster uses the Mailhost setting as the notification mail server. <strong>Tip:</strong> Information Builders recommends using different mail servers for notification and email distribution. This way, if there is a problem with your Mailhost, notification will still be sent. Having separate mail servers ensures that you will be informed when the default mail server falters. You can also specify a port for the Notify Mailhost using <code>hostname:port</code>. If you do not specify a port or the port you specify is not present, the default port is used.</td>
</tr>
</tbody>
</table>
| Default Notify Type     | The default value is Never.       | Specifies whether to send notification of the schedule status to a specified email address. Possible values are:  

- **Never.** This is the default value. ReportCaster does not send notification of the schedule status under any circumstance.  

- **On Error.** The specified users are notified when errors are encountered while running the schedule. Information Builders recommends using the On Error notification option.  

- **Always.** The specified user is always notified when the schedule runs. |
### Setting | Optional or Required/Default Value | Descriptions and Possible Values
---|---|---
Enable Brief Notification Only | Optional. | Controls whether Full Notification is available as a scheduling option. When this check box is selected, you can only select the Brief Notification option when you schedule a report. Full Notification is not available.

**Note:** Messages are displayed in the log when Full Notification is disabled. If a schedule is created before Full Notification is disabled, when the schedule executes, a Brief Notification will be sent, and a warning will be displayed in the schedule log.

**Procedure:** How to Configure Notification

1. From the Tools menu, click *ReportCaster Status*.
2. Click the *Configuration* button, as shown in the following image.

   **Note:** Authorized users can also access the ReportCaster Configuration tool from the Administration Console.

3. In the left pane, select the *Notification* folder.
4. Populate the notification fields. You can:
   - Make changes to the current notification settings. For more information, refer to the preceding table.
   - Supply any default values that you would like to be available at schedule creation time.

5. Click Save.

**Zip Settings**

The Zip Settings folder in the Configuration tab, as shown in the following image, contains settings for adding an extension to a distributed Zip file, the Zip encryption to use for distribution.
The Zip Settings folder contains the following configuration settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Zip Extension to Filename if not Specified</td>
<td>Required. By default, this option is selected.</td>
<td>Controls whether or not the .zip file extension will be automatically appended to the Zip file name entered by the user in a schedule distributed by email or FTP. Select this option if you want to automatically append .zip to the entered file name. Do not select this option if you want to use the file name as entered by the user and not have .zip automatically appended to the file name.</td>
</tr>
<tr>
<td>Zip Minimum with Email Distribution</td>
<td>Required. The default size is in KB and set to 0.</td>
<td>Select either MB or KB and customize the size of your file using the up and down arrows.</td>
</tr>
<tr>
<td>Zip Encoding</td>
<td>Optional.</td>
<td>Specifies an encoding other than the default encoding of the ReportCaster Distribution Server platform. The encoding specified must match the encoding used by WinZip or any other Zip utility installed on the Distribution Server.</td>
</tr>
<tr>
<td>Maximum Concurrent Compressions</td>
<td>Optional The default value is zero (0).</td>
<td>The total number of compression operations that the Distribution Server will perform simultaneously. If many running jobs include a compression operation (for example, zipping the output before sending), the compression operations could consume all of the available resources on the Distribution Server. You can lower this number to prevent this from occurring.</td>
</tr>
</tbody>
</table>
Procedure: How to Configure Zip Settings

1. From the ReportCaster Tools menu, click ReportCaster Status.
2. Click the Configuration button.
   
   Note: Authorized users can also access the ReportCaster Configuration tool from the Administration Console.
3. In the left pane, select the Zip Settings folder.
4. Populate the Zip Settings fields using the information provided in the preceding tables.
5. If you want to produce zipped output that is encrypted and password protected, you can use the Zip Encryption Password Plug-in. To use your own program to supply the password, select Custom from the drop-down list and enter the name of the program in the Zip Encryption Password Plug-in Name field. To use the default, select Default.
6. Click Save.

Other Schedule Defaults

The Other Schedule Defaults folder in the Configuration tab, as shown in the following image, contains settings for Schedule End Date and Schedule End Time.

Note: Depending on your time zone, the default Schedule End Date may be set to Jan 1, 2100.
The following table lists and describes the configuration settings available in the Other Schedule Defaults folder.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Schedule End Date</td>
<td>Required</td>
<td>Clicking the drop-down menu displays a calendar where you can select the schedule end date.</td>
</tr>
<tr>
<td>Schedule End Time</td>
<td>Required</td>
<td>Manually, you can enter an end time for the schedule. Alternatively, use the arrows to assign a schedule end time.</td>
</tr>
</tbody>
</table>

**Log Purge**

The Log Purge folder in the Configuration tab, as shown in the following image, contains settings for purging log files, log purge periods, and log purge times.
The Log Purge folder contains the following configuration settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Purge Log at Distribution Server Start</td>
<td>Optional. By default, the check box is unchecked.</td>
<td>When selected, log reports are automatically purged each time the Distribution Server starts. This is in addition to the scheduled log purging that is set using the Log Purge Period and Log Purge Time options.</td>
</tr>
</tbody>
</table>

### Daily Scheduled Log Purge section

<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional.</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Log Purge Period (Days)</td>
<td></td>
<td>Automatically purges individual log reports when they are older than a set number of days.</td>
</tr>
<tr>
<td>Log Purge Time</td>
<td></td>
<td>Time at which log purging occurs.</td>
</tr>
</tbody>
</table>

### LDAP Setting

ReportCaster can be configured to retrieve email address information from an LDAP data source. The leading mail server software vendors use LDAP for storage of email information. This includes Active Directory on Windows platforms.
The LDAP Setting folder in the Configuration tab, as shown in the following image, contains settings to define LDAP server connection and security, as well as LDAP email settings.

The LDAP Setting folder contains the following configuration settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General Setting section</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Active Directory</td>
<td>By default, this option is not selected.</td>
<td>Select if you are using the Active Directory technology for LDAP. Do not select if you are using any other technology for LDAP.</td>
</tr>
<tr>
<td>Secure Connection (SSL)</td>
<td>By default, this option is not selected.</td>
<td>Indicates whether or not SSL (Secure Sockets Layer) is used to communicate with the LDAP server.</td>
</tr>
<tr>
<td>LDAP Host</td>
<td>There is no default value.</td>
<td>Host name or IP address of your LDAP directory server.</td>
</tr>
<tr>
<td>Setting</td>
<td>Optional or Required/Default Value</td>
<td>Descriptions and Possible Values</td>
</tr>
<tr>
<td>------------------</td>
<td>------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>LDAP Port</td>
<td>Default value is 389.</td>
<td>Port on which the directory server listens.</td>
</tr>
<tr>
<td>LDAP Search Base</td>
<td>There is no default value.</td>
<td>Filter for LDAP searches. Only the subtree below the search base is available for LDAP queries. For example, dc=ibi, dc=com.</td>
</tr>
<tr>
<td>Search Time Out</td>
<td>Default value is 120.</td>
<td>Time, in seconds, that ReportCaster can search an LDAP data source before timing out.</td>
</tr>
<tr>
<td>Security Principal</td>
<td>No default value.</td>
<td>Service account of the user performing authentication. The user must have sufficient access rights to locate user entries in the directory. Select the icon to the right of this option to open the User dialog box, where you can type a user name and password.</td>
</tr>
</tbody>
</table>

### LDAP Email Setting section

<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Email LDAP Enabled</td>
<td>By default, this option is not selected.</td>
<td>Indicates whether ReportCaster is enabled to retrieve email address information from an LDAP data source.</td>
</tr>
<tr>
<td>Email Map</td>
<td>Default value is mail.</td>
<td>Attribute type for email entries.</td>
</tr>
<tr>
<td>Setting</td>
<td>Optional or Required/Default Value</td>
<td>Descriptions and Possible Values</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-----------------------------------</td>
<td>----------------------------------</td>
</tr>
<tr>
<td>Email User Filter</td>
<td>Default value provided is dependent on the LDAP Type selected.</td>
<td>Filter for email entries to be retrieved. For example: `(&amp; (mailnickname=*)) (</td>
</tr>
<tr>
<td>First Name Map</td>
<td>Default value is givenName.</td>
<td>Attribute for first name entries.</td>
</tr>
<tr>
<td>Last Name Map</td>
<td>Default value is sn.</td>
<td>Attribute for last name entries.</td>
</tr>
</tbody>
</table>

**Data Servers Settings**

The Data Servers folder in the Configuration tab contains settings to configure the Reporting Servers associated with ReportCaster. Using the configuration settings in this folder, you can also configure multiple Reporting Servers with ReportCaster.

**Note:** Data Server connection information is stored in WebFOCUS Business User Edition, and not in ReportCaster. ReportCaster runs scheduled procedures through WebFOCUS Business User Edition which is installed with the Distribution Server. When a ReportCaster job is executed by Business User Edition, the alternate deferred server is used if an alternate deferred server is defined.
The following image shows the display in the right panel when the Data Servers folder is selected. Initially, the default data server appears in this panel with information, such as the data server name, URL (used to connect to the Reporting Server), the type of server, whether or not it is the default server, and what security type it is using. When you add a data server that ReportCaster can access, it will appear in this list.

The following image shows the configuration settings when you select a specific data server under the Data Servers folder (in this example, EDASERVE).
The Data Servers folder contains the following configuration settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/ Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Settings for the Data Servers folder:</td>
<td></td>
<td>Optimizes the processing of graphs. Due to performance considerations, Information Builders generally recommends configuring this setting to 1 Graph Agent for each concurrent graph report. However, your own internal testing should determine the Graph Agent value that best suits the business needs of your organization.</td>
</tr>
<tr>
<td>Graph Agents</td>
<td>The default value is 1.</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Optional or Required/ Default Value</td>
<td>Descriptions and Possible Values</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Graph Servlet URL</td>
<td>Optional. There is no default.</td>
<td>Overrides the default graph server setting and configures graph image files to be created on the Application Server.</td>
</tr>
</tbody>
</table>
|                      |                                                                                                     | Type the following value http://hostname/context_root/IBIGraphServlet where: hostname: Is the host name of the Application Server where WebFOCUS Business User Edition is installed.
|                      |                                                                                                     | context_root: Is the site-customized context root for the WebFOCUS Business User Edition web application deployed on your Application Server. ibi_apps is the default value.
<p>|                      |                                                                                                     | This setting should not be used when web server security is enabled. This includes Basic authentication, IWA, SSL, and third-party security products (such as SiteMinder). In these cases, the web server security settings can prevent WebFOCUS Business User Edition from creating the graph. |</p>
<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/ Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
</table>
| Excel Servlet URL | Default value is http://localhost:8080/ibi_apps | Specifies the application server to be used to zip the file components that comprise an EXCEL® 2007 file (.xlsx) as follows: 
&URL_PROTOCOL://servername/alias/IBIEXCELSERVURL

where:

- **URL Protocol** is HTTP.
- **servername** is the name of the application server where WebFOCUS Business User Edition is installed.
- **alias** is the context root of the WebFOCUS Business User Edition application. The default is ibi_apps.

This setting is available for WebFOCUS Business User Edition Server and WebFOCUS Business User Edition procedures. This setting should not be used when web server security is enabled. This includes Basic authentication, IWA, SSL, and third-party security products (such as SiteMinder). In these cases, the web server security settings can prevent WebFOCUS Business User Edition from creating the Excel 2007/2010 file.

| FOCEXURL/ FOCHTMLURL | Default value is http://localhost:8080 | Specifies the host name and port of the FOCEXURL/FOCHTMLURL. |

Settings for an individual Data Server:
<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/ Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Required.</td>
<td>Name of the selected Data Server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Data Server names are case-sensitive. Data Servers are defined in WebFOCUS Business User Edition as uppercase so you should also define Data Servers as uppercase in ReportCaster.</td>
</tr>
<tr>
<td>Default</td>
<td>Required.</td>
<td>This option is selected by default.</td>
</tr>
<tr>
<td>Set FOCEXURL/ FOCHTMLURL in the Scheduled Procedure</td>
<td>Required.</td>
<td>This setting is selected, by default. If this setting is not selected, the Distribution Server will not set the value of FOCEXURL or FOCHTMLURL for a scheduled procedure. Therefore, when cleared, if FOCEXURL or FOCHTMLURL is already set in the edasprof.prf file, this setting remains in effect, unless it is overridden in the scheduled procedure.</td>
</tr>
</tbody>
</table>

### Security section

<table>
<thead>
<tr>
<th>Security Type</th>
<th>By default, this option is set to User.</th>
<th><strong>Static.</strong> A valid Execution Id and password is supplied in the User setting. When creating a schedule, you cannot specify an Execution Id and password.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td><strong>User.</strong> A valid Execution Id and password must be specified when creating a schedule.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Shared.</strong> When creating a schedule, the user ID and password is internally assigned as the Execution Id and password.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> Since the actual password is not stored in the WebFOCUS Business User Edition repository, the Shared configuration can only be used when a password is not required to connect to the Reporting Server.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Trusted.</strong> The Execution Id is the schedule owner and no password is sent to the WebFOCUS Business User Edition Reporting Server when schedules run.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note:</strong> The Reporting Server must be configured to accept a Trusted connection when the Trusted option is selected.</td>
</tr>
</tbody>
</table>
### Configuring Reporting Servers With ReportCaster

You can configure multiple Reporting Servers with ReportCaster through the Data Server folder in the ReportCaster Configuration tab. Although the installation program automatically populates values for the default EDASERVE server, all additional Reporting Servers must be added to the configuration manually.

**Note:** If the default Reporting Server is changed on the Client, then the change will not be effective until the period specified by the IBFS Cache Cleaner service or until the Distribution Server is restarted. If the Distribution Server is installed on another machine with a separate copy of the Client, then a change to the default Reporting Server will not be effective until the same change is made on the Client installed on the same machine as the Distribution Server.
**Procedure: How to Add a Reporting Server**

1. In the left panel of the Configuration tab, select the *Data Servers* folder, then select *New* in the toolbar, as shown in the following image.

   ![Image of Configuration tab](image)

   **Note:** The default Data Server names are SERVER, SERVER 2, SERVER 3, and so on.

2. From the Available Data Servers dialog box, select one or more Data Servers, and click *OK*. You can optionally select the Select All check box.

3. Double-click the new server node in either the Data Servers folder in the left panel or the server list in the right panel.

   The right panel displays the default properties for the selected server, as shown in the following image.

   ![Image of default properties](image)

4. Provide values for the appropriate settings.
In the Name field, verify the name of the server you want to add to the ReportCaster configuration is the same as the NODE setting for that server specified in the WebFOCUS Business User Edition Server Connections configuration. You can review the WebFOCUS Business User Edition Server Connections by accessing the Administration Console and selecting Reporting Servers within the Configuration tab.

Optionally, provide values for the Security Type and Maximum Connections settings or leave the default values in place.

You can also optionally set the Data Server being added to be the default Data Server when new schedules are created, specify not to have the FOCEXURL and FOCHTMLURL settings automatically added when scheduled jobs run, and specify that the Data Server does not have a graphics card, is Headless.

5. To implement the changes in ReportCaster, in the Configuration tab toolbar, select Save, then Restart.

**Caution:** Information Builders recommends that you avoid changing the name of a Reporting Server, since all existing jobs on that server will no longer run.

### Using Blackout Periods

Blackout Periods are those dates and times on which schedules will not run and cannot be set to run. A user authorized to access the Blackout Periods tool can view, define, update, import, export, and delete blackout periods.

To view schedule blackout periods, select *Blackout Periods* from the Show group in the Console. The Blackout Periods interface, which is shown in the following image, provides a calendar in the left panel and the right panel lists the blackout dates you are authorized to manage.

Users authorized to manage blackout periods can add new blackout periods, delete blackout periods, replace the description of existing blackout periods, and extract existing blackout period information to a file for future use. In the ReportCaster Blackout Periods interface, these tasks can be completed using the following features:

- The Blackout Date and Time dialog box, accessed from the New and Edit buttons in the Manage Blackout Periods group.
- The Import Dates dialog box, accessed from the Manage Blackout Periods group.
- The Extract Blackout Dates dialog box, accessed from the Manage Blackout Periods group.
You can change the month or year using the arrows at the top of the calendar. Dates only appear as available or unavailable. You can show or hide the left panel by clicking the arrow in the top-right corner of the left panel. The following image shows the display with the left panel hidden.

Reference: Blackout Period Configurations

Every type of Blackout Period profile shares the same basic settings: Group Assignment, Name, Description, Details, and Blackout Time. Within that basic configuration, there are four types of Blackout Periods that accommodate differing scheduling requirements. These include:

- **Weekly Blackout Periods.** Recur on a specified day or days of the week.
- **Monthly Blackout Periods.** Recur on a specified monthly date or dates.
- **Single Day Blackout Periods.** Occur only once on a specified date.
- **Every Day Blackout Periods.** Recur at a specified time every day.

This variety of profiles enables you to build blackout periods into your reporting schedule that accommodate those regularly recurring and special one-day events that would cause you to suspend reporting.

Reference: Basic Blackout Period Settings

The Blackout Date and Time dialog box contains settings that define the timing and frequency of a scheduled Blackout Period. There are four variations of this dialog box to accommodate the Weekly, Monthly, Single Day, and Every Day frequency options.
The following table describes settings in the Global Blackout Date and Times profile.

<table>
<thead>
<tr>
<th><strong>Setting</strong></th>
<th><strong>Optional or Required/Default Value</strong></th>
<th><strong>Descriptions and Possible Values</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Group</td>
<td>Displays the name (Global).</td>
<td>Displays the name (Global).</td>
</tr>
<tr>
<td>Name</td>
<td>Optional.</td>
<td>A descriptive name for the Blackout Date and Time profile. You can modify the default name by clicking within the Name field.</td>
</tr>
<tr>
<td></td>
<td>By default displays the name: Blackout-[Current Date] [Current Time]</td>
<td></td>
</tr>
<tr>
<td></td>
<td>For example: Blackout-Jun 26 2015 10:27 AM</td>
<td></td>
</tr>
<tr>
<td>Description</td>
<td>Optional.</td>
<td>A detailed description of the Blackout Date and Time profile.</td>
</tr>
<tr>
<td>Details Label</td>
<td>Assigned to the profile after creation.</td>
<td>A summary of the detailed times and frequency of the Blackout Period. This is a narrative description of the selections you make in the Weeks, Days, Months, and Blackout Time fields. ReportCaster creates this description automatically when you save the profile, and updates it when you save changes to it. You cannot create, edit, or delete it directly.</td>
</tr>
<tr>
<td>Setting</td>
<td>Optional or Required/Default Value</td>
<td>Descriptions and Possible Values</td>
</tr>
<tr>
<td>-----------------------</td>
<td>------------------------------------</td>
<td>----------------------------------</td>
</tr>
</tbody>
</table>
| Blackout Time check box | By default this check box is cleared. | **Selected.** The Blackout Period covers the hours specified in the Start (Time) and End (Time) fields.  
**Not Selected.** The Blackout Period covers the entire day.  
**Note:** If you change a profile from Single Date to any other frequency setting, you must clear this check box if the blackout period is to cover the entire day. |
| Start (Time)          | Optional. By default, displays the current hour and minute. | The Hour and Minute in which a Blackout Period is to begin.  
This value is relevant only if the Blackout Time check box is selected. |
| End (Time)            | Optional. By default, displays the time two hours after the current hour and minute. | The Hour and Minute in which a Blackout Period is to end.  
This value is relevant only if the Blackout Time check box is selected. |
| Frequency             | Required. By default, the Weekly option is selected. | **Weekly.** Blackout periods that recur on a specified day of the week.  
**Monthly.** Blackout periods that recur on a specified monthly date.  
**Single Day.** Blackout periods that occur once on a specified date.  
**Every Day.** Blackout periods that recur at a specified time every day. |
**Procedure:** How to Configure a Blackout Period

To configure a blackout period:

1. From the Manage Blackout Periods group on the ribbon, click New.

   The Blackout Date and Time dialog box opens, as shown in the following image.

   ![Blackout Date and Time dialog box](image)

2. Accept the default Name assigned to the Blackout Period profile or enter a new value for Name.

3. Type a description for the Blackout Period profile in the Description field.

4. If this blackout period must cover the entire day, leave the Blackout Time check box cleared and skip to step 7.

5. If this blackout period must be limited to a range of hours within a day, select the Blackout Time check box and configure the start and end time for the Blackout Period.

   For more information, see *How to Configure a Start Time and End Time for a Blackout Period* on page 229.
6. Click the appropriate frequency option:

- **Weekly.** Establish the frequency for the blackout period. For configuration information, see Configuring Weekly Blackout Periods on page 221.

- **Monthly.** Establish the frequency for the blackout period. For configuration information, see Configuring Monthly Blackout Periods on page 224.

- **Single Day.** Select the date for the blackout period. For configuration information, see Configuring Single Day Blackout Periods on page 227.

- **Every Day.** Establish the hours for the daily blackout period. For configuration information, see Configuring Every Day Blackout Periods on page 228.

7. Review your configuration.

- If your configuration of dates and hours is unacceptable, the OK button will not respond when you attempt to click OK. Adjust your configuration and refresh the profile by clearing and reselecting the recurring check boxes.

- If your configuration is acceptable, the OK button will be available, and the Details label will include a description summarizing your selections.

8. When your configuration is complete, click **OK**.

   An entry for the Blackout Profile appears in the right pane of the Blackout Dates window and the Blackout Date Calendar in the left pane highlights the new blackout dates.

**Configuring Weekly Blackout Periods**

The Weekly Blackout Period configuration bases its recurrence on a specified day of the week. It suits events that recur as part of a weekly schedule, regardless of the date on which that day falls.

Even though the name implies that this Blackout Period occurs only once a week, Blackout Periods using the weekly configuration can occur more or less frequently.

The tools in this configuration enable you to specify:

- The day, or days, of the week on which the blackout period will occur.

- The week, or weeks, of the month in which the blackout period will occur.

- The month, or months, of the year in which the blackout period will occur.
Instead of requiring you to enforce blackout periods on the same day each and every week, this flexible configuration enables you to schedule Blackout Periods that occur more than once a week. It also enables you to configure Blackout Periods that skip one or more weeks in a month or skip one or more months in a year.

**Weekly Blackout Period Settings**

If you select the Weekly option, the Blackout Date and Time dialog box displays a unique set of options that enables you to schedule Blackout Periods for specified days of the week.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>On</td>
<td>Required (At least one selection from this column.)</td>
<td>The week of the month check boxes list ordinal weeks of the month. When you select one, you define the week of the month in which this blackout period is to occur. That is, the first week of the month, the second week, and so on. You can select one or more individual weeks. The Select All check box automatically selects every week of the month, establishing a blackout period that takes place every week in a month.</td>
</tr>
<tr>
<td>Week of the Month Check Boxes (Left Column)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Optional or Required/ Default Value</td>
<td>Descriptions and Possible Values</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| On Days of the Week check boxes (Right Column) | Required (At least one selection from this column). | The day of the week check boxes list the days of the week. When you select one, you define the day of the week in which this blackout period will occur. That is, on Monday, Tuesday, and so on.
You can select one or more individual days.
The Select All check box automatically selects every day of the week, establishing a blackout period that takes place every day of your selected weeks in the month. |
| Months                                       | Required (At least one selection from this group). | The Month check boxes list the months of the year. When you select one, you define the month of the year in which this weekly black out period will occur. That is, in January, February, and so on.
You can select one or more individual months.
The Select All check box automatically selects every month of the year, establishing a blackout period that takes place during every month on your selected week and day. |

**Procedure:**  
**How to Configure Weekly Blackout Period Settings**

To configure weekly blackout period settings:

1. From the Blackout Date and Time dialog box, click *Weekly*.  

The dialog box displays check boxes that support the Weekly frequency schedule, as shown in the following image.

![Weekly Frequency Schedule](image)

**Note:** In order to enable the OK button and save the profile, you must select at least one week, day, and month check box.

2. Select the check boxes for the week or weeks of the month in which the Blackout Period is to occur, or click Select All to select every week automatically.

3. Select the check boxes for the day or days of the week on which the Blackout Period is to occur, or click Select All to select every day of the week automatically.

4. Select the check boxes for the month or months in which the Blackout Period is to occur, or click Select All to select every month automatically.

**Configuring Monthly Blackout Periods**

The Monthly Blackout Period configuration bases its recurrence on a specified monthly date. It suits events that recur on the same date, regardless of the day of the week on which that date falls.

Even though the name implies that this Blackout Period occurs only once a month, Blackout Periods using this configuration can occur more or less frequently. They can occupy the entire day, or they can be limited to a range of hours within a single day.

The tools in this configuration enable you to specify:

- The day, or days, of the month on which the blackout period will occur.
- The month, or months, of the year in which the blackout period will occur.
Instead of requiring you to enforce blackout periods on the same day of the month, each and every month, this flexible configuration enables you to schedule Blackout Periods that occur more than once a month. It also enables you to configure Blackout Periods that skip one or more months.

**Monthly Blackout Period Settings**

If you select the *Monthly* option, the Blackout Date and Time dialog box displays a unique set of options that enables you to schedule Blackout Periods for specified dates of the month.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Optional or Required/Default Value</th>
<th>Descriptions and Possible Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>Days</td>
<td>Required.</td>
<td>The Days check boxes list the dates within a month. When you select one, you define the day of the month on which this blackout period will occur. That is, on the first day of the month, the second, the third, and so on. You can select one or more individual dates. The Select All option automatically selects every day of the month, establishing a blackout period that takes place every day during your selected months.</td>
</tr>
<tr>
<td>Months</td>
<td>Required.</td>
<td>The Months check boxes list the months of the year. When you select one, you define the month in which this blackout period will occur. That is, in January, February, and so on. You can select one or more individual months. The Select All option automatically selects every month of the year, establishing a blackout period that takes place during every month on your selected day or days.</td>
</tr>
</tbody>
</table>
**Procedure:** How to Configure Monthly Blackout Period Settings

To configure monthly blackout period settings:

1. From the Blackout Date and Time dialog box, click *Monthly*.

   The Blackout Date and Time dialog box displays the check boxes that support the Monthly frequency, as shown in the following image.

   ![Blackout Date and Time Dialog Box](image)

   **Note:** At a minimum, you must select a check box for one day and a check box for one month. Until you do, the OK button will be unavailable, and you will be unable to save the profile.

2. Select the check boxes for the day or days of the month on which the Blackout Period is to occur, or click *Select All* to select every date in the month automatically.

3. Select the check boxes for the month or months in which the Blackout Period is to occur, or click *Select All* to select every month automatically.
Configuring Single Day Blackout Periods

Single Day Blackout Periods occur once, on a single, specified date. They can occupy the entire day, or they can be limited to a range of hours within a single day. The settings for Single Day Blackout Periods are shown in the following image.

![Single Day Blackout Period Settings](image)

**Single Day Blackout Period Settings**

If you select the *Single Day* option, the Blackout Date and Time dialog box displays a copy of the Blackout Dates calendar, which enables you to select a single date for a scheduled Blackout Period.

**Procedure:** How to Configure Single Day Blackout Period Settings

1. From the Blackout Date and Time dialog box, click *Single Day*.

   The dialog box appears, displaying the calendar automatically set to the current date.
2. Click the single arrows to change the month and click the double arrows to change the year.

3. When you have found the month and year for the scheduled single day blackout period, click on the date on which you want the Blackout Period to occur.

   The calendar highlights the new date.

**Configuring Every Day Blackout Periods**

Every Day Blackout Periods recur every day. To prevent Every Day Blackout Periods from blocking the release of any reports, you must limit them to a range of hours within the day. The settings for Every Day Blackout Periods are shown in the following image.
Every Day Blackout Period Settings

If you select the *Every Day* option, the Blackout Date and Time dialog box limits its display to the Beginning and End time for the Blackout Period. No other options are relevant.

**Procedure:** How to Configure Every Day Blackout Period Settings

1. From the Blackout Date and Time dialog box, click *Every Day*.
   
   The Blackout Time check box is selected automatically, and the dialog box displays a note reminding you to select the start and end time.
   
   The Start time is automatically set to the current time, and the End time is automatically set to a value two hours later.

2. To change the Start or End Time values, see *How to Configure a Start Time and End Time for a Blackout Period* on page 229.

**Procedure:** How to Configure a Start Time and End Time for a Blackout Period

From the Blackout Date and Time dialog box:

1. To change the hour of the start time, click in the *Hour* section of the Start field.
   
   a. Click the up or down arrow to move the value ahead one hour or back one hour, respectively.

   b. You can also type the hour in this section, but be careful to stay within the twelve hour range. If you enter a value outside of this range, the dialog box will automatically recalculate your value in terms of a twelve hour clock. For example, 44 hours would become 8. (44-(12X3))=(44-36)=8

   c. Ensure that the start time is earlier than the end time.

2. To change the minutes of the start time, click in the *Minutes* section of the Start field.
   
   a. Click the up or down arrow to move the value ahead one minute or back one minute, respectively.

   b. You can also type the minutes in this section, but be careful to stay within the sixty minute range. If you enter a value outside of this range, the dialog box will automatically recalculate your value in terms of the number of minutes within an hour. For example, 88 minutes would become 28. (88-60) = 28).

   c. Ensure that the start time is earlier than the end time.

3. To change the start time from AM to PM, click in the AM/PM section of the Start field.
   
   a. Click the up arrow to move from AM to PM.

   b. Click the down arrow to move from PM to AM.
c. You can also type AM or PM directly into this section.

4. To change the hour of the end time, click in the Hour section of the End field.
   a. Click the up or down arrow to move the value ahead one hour or back one hour, respectively.
   b. You can also type the hour in this section, but be careful to stay within the twelve hour range. If you enter a value outside of this range, the dialog box will automatically recalculate your value in terms of a twelve hour clock. For example, 44 hours would become 8. \((44-12\times3)=44-36=8\).
   c. Ensure that the end time is later than the start time.

5. To change the minute of the end time, click in the Minutes section of the End field.
   a. Click the up or down arrow to move the value ahead one minute or back one minute, respectively.
   b. You can also type the minute in this section, but be careful to stay within the sixty minute range. If you enter a value outside of this range, the dialog box will automatically recalculate your value in terms of the number of minutes within an hour. For example, 88 minutes would become 28. \((88-60=28\)).
   c. Ensure that the end time is later than the start time.

6. To change the end time from AM to PM, click in the AM/PM section of the End field.
   a. Click the up arrow to move from AM to PM.
   b. Click the down arrow to move from PM to AM.
   c. You can also type AM or PM directly into this section.

   **Important:** You must use the right or left arrow keys to move between the Hour, Minutes, and AM/PM sections of the Start and End fields.

   If you try to use the Tab key to move between sections, you will move down to the next option instead of across to the next section of the Start or End field.

   For example, if you use the Tab key to move from the Hours section of the Start field, you will move down to the Hours section of the End field, not over to the Minutes section of the Start field. To move right, you must use the right direction key instead.

   Similarly, the Shift+Tab key combination will move you to the previous option, not back to a previous section within the Start or End field. To move left, you must use the left direction key instead.

**Procedure:** How to Delete a Blackout Period Profile

1. In the left pane of the Blackout Dates dialog box, click the folder for the Group to which the Blackout Period profile you want to delete is assigned.
2. In the right pane, click the entry for Blackout Period profile you want to delete, as shown in the following image.

![Image of Manage Blackout Periods screen](image)

3. On the ribbon, in the Manage Blackout Periods group, click Delete.

4. When you receive a confirmation message, click Yes, as shown in the following image.

![Confirmation message image](image)

Your newly deleted entry disappears from the right pane and the dates assigned to that entry are no longer highlighted on the Blackout Dates calendar in the left pane.

### Importing Blackout Periods

You can use the Blackout Period Import operation to automate Blackout Period management tasks. Using a properly formatted import file with this tool, you can:

- Create new Blackout Period profiles.
- Remove Blackout Period profiles.
- Enrich Blackout Period information.
**Note:** All imported files must contain UTF-8 (National Language Support) character encoding to upload correctly.

The source file for the import contains the following information about a Blackout Period Profile:

- **Date.** The date on which the Blackout Period profile becomes effective. This date can be omitted for Every Day Blackout Period profiles.

- **Start Hour.** The time (HH:MM:SS) at which the Blackout Period becomes effective. This value is optional for all but Every Day Blackout Period profiles.

- **End Hour.** The time (HH:MM:SS) at which the Blackout Period ceases to be effective. This value is optional for all but Every Day Blackout Period profiles.

- **Description.** A detailed description of the Blackout Period profile.

- **Name.** The unique name assigned to a Blackout Period profile.

**Note:** Additional Codes precede entries for Weekly or Monthly Blackout Period profiles. For more information, see *Weekly Blackout Period Import File Entry Layout* on page 233 and *Monthly Blackout Period Import File Entry Layout* on page 234.

The task you select when you run an import operation determines the way in which ReportCaster uses the information in the source file for the Import.

If you select:

- **Add,** the import creates new Blackout Period profiles from the records in the import source file.

- **Remove,** the import compares date and additional information in import file records to that of existing Blackout Period profiles and removes those profiles that match the file records.

- **Replace,** the import compares date information in import file records to that of existing Blackout Period profiles and adds Name and Description information to them.

- **Use the actions specified in the file,** the import runs the add, remove, and replace operations as required by commands included in the Import file along with entries for the Blackout Period profiles affected by them.

The automation of these tasks frees you from manually creating, updating, or deleting Blackout Period profiles when operational changes, such as monthly, quarterly, or annual operation schedule updates, require a sweeping review and revision of your reporting schedule.
For example, at the start of the year, you have a file containing the dates and names of all scheduled holidays that must be incorporated into your reporting schedule. The Blackout Period Import enables you to import that file and establish the holiday blackout schedule for an entire year in a single operation. Without the import you would have to create a Single Date Blackout Date and Time profile for each holiday in the coming year.

**Viewing Blackout Period Import File Format**

Even though entries in the Import File format for Blackout Period records use the same basic structure, each profile type contains minor variations that identify the type of Blackout Period profile ReportCaster must create from the entry details.

**Single Date Blackout Period Import File Entry Layout**

You can import Single Date Blackout Date and Time profiles from a flat file that lists the information for each profile on a separate line. Each line must follow the following layout:

```
[Date]/[Start Hour]| [End Hour] [Description]| [Name]
```

For example:

```
20150629/08:59:00|10:59:00 Report Blackout for June 29th Only|Special One Day Blackout - June 29th
```

- Dates use the format YYYYMMDD
- Hours use the format HH:MM:SS
- You can omit the hours to schedule an all day blackout.

The Weekly, Monthly, and Every Day Blackout Date and Time profiles use a variation of this format.

**Weekly Blackout Period Import File Entry Layout**

You can import Weekly Blackout Date and Time profiles from a flat file that lists the information for each profile on a separate line. Each line must follow the following layout:

```
[Blackout Pattern] [Description]| [Name]
```

For example:

```
[11111111111/10000:0000010]/17:00:00|23:59:00 Report Blackout First Friday of Every Month 5:00 PM to 11:59 PM|First Friday Afternoons
```
This information identifies the entry as a Weekly Blackout Period, and includes its Description and Name. The Blackout Pattern indicates the selected Month(s) and Selected Day(s) of the Week. A '1' means that a month or day is selected. A '0' means that a month or day is not selected.

**Monthly Blackout Period Import File Entry Layout**

You can import Monthly Blackout Date and Time profiles from a flat file that lists the information for each profile on a separate line. Each line must follow the following layout:

```
[Blackout Pattern]/[Start Hour][End Hour] [Description][Name]
```

For example:

```
[11111111111/10000:0000010]/17:00:00|23:59:00 Report Blackout First Friday of Every Month 5:00 PM to 11:59 PM|First Friday Afternoons
```

This information identifies the entry as a Monthly Blackout Period, and includes its Description and Name. The Blackout Pattern indicates the selected Month(s) and Selected Day(s) of the Month. A '1' means that a month or day is selected. A '0' means that a month or day is not selected.

**Every Day Blackout Period Import File Entry Layout**

You can import Every Day Blackout Date and Time profiles from a flat file that lists the information for each profile on a separate line. Each line must follow the following layout:

```
/[Start Hour][End Hour] [Description][Name]
```

For example:

```
/21:04:00|23:04:00 Every Day Blackout between 3:00 PM and Midnight|Daily Afternoon Blackout
```

This information identifies the entry as an Every Day Blackout Period and includes its Description and Name.

**Procedure: How to Add Blackout Period Profiles Using an Import File**

To add a Blackout Period profile through the import is to create a new Blackout Period profile from information in the import file. Your Import file must therefore contain records for all Blackout Period profiles you want to add to ReportCaster through this import operation.

1. In the Blackout Dates pane, click the folder of the group for which you are importing Blackout Period profiles.
2. On the ribbon, in the Manage Blackout Periods group, click Import.

![Import Blackout Data dialog box](image)

3. In the File Name field, type the full path to the file, or click Browse and navigate to the file you want to import.

4. Click Add, and click OK.

The Import Blackout Data dialog box opens, listing details of the new Blackout Profiles based on each entry in the Import file as shown in the following image.

![Import Blackout Data](image)

5. Click Add to add the new Blackout Period profiles listed in the Import Blackout Data dialog box to the Blackout Dates Calendar and Group entries.
A message displays, informing you that the blackout dates have been successfully imported, as shown in the following image.

![Message from webpage]

6. Click OK.

The Blackout Dates calendar highlights the newly imported Blackout Period Dates in the left pane of the Blackout Dates window and entries for the new Blackout Period profiles appear in the right pane, as shown in the following image.

![Blackout Dates Calendar]

**Procedure:** How to Replace Blackout Periods Using an Import File

To replace a Blackout Period profile through the import is to add updated information to its Name and Description fields. To ensure that the import-based update affects the proper profiles, your Import file must contain records whose dates match those of the existing Blackout Period profiles that must be enriched by this Import operation.
**Note:** You *must* use this procedure to update or enrich information assigned to a Blackout Period profile created from an Import.

1. In the right pane of the Blackout Dates dialog box, select the group for which you are importing Blackout Period profiles.

2. On the ribbon, in the Manage Blackout Periods group, click *Import*.

   The Import Dates dialog box opens, as shown in the following image.

3. In the File Name field, type the full path to the file, or click *Browse* and navigate to the file you want to import.

4. Click *Replace*, and then click *OK*.

   The Import Blackout Data dialog box opens, listing the details from each entry in the Import file that will be added to their corresponding Blackout Period profiles.

5. Click *Replace* to add new the information listed in the Import Blackout Data dialog box to the designated Blackout Period profiles.

   A message displays, informing you that the blackout dates have been successfully imported, as shown in the following image.
6. Click OK.

Enriched entries for the updated Blackout Period profiles appear in the right pane.

Procedure: How to Remove Blackout Periods Using an Import File

Removing a Blackout Period profile through the import deletes it. To ensure that the import-based deletion affects the proper profiles, your Import file must contain records whose dates match those of the existing Blackout Period profiles that are to be deleted by this Import operation.

1. In the Blackout Dates tab pane, select the group containing blackout period profiles that must be removed.

2. On the ribbon, in the Manage Blackout Periods group, click Import.

   The Import Dates dialog box opens, as shown in the following image

   ![Import Dates dialog box](image)

3. In the File Name field, type the full path to the file, or click Browse and navigate to the file you wish to import.

4. Click Remove, and then click OK.

   The Import Blackout Data dialog box opens, listing details from each entry in the Import file that successfully matched an existing Blackout Period profile.

5. Click Remove to delete those Blackout Period profiles listed in the Import Blackout Data dialog box.

   A window opens, informing you that the blackout dates have been successfully imported.

6. Click OK.
Procedure:  How to Manage Multiple Blackout Period Updates Using an Import File

The Use the actions specified in the file option allows the import process to add, remove, and replace multiple Blackout Period profiles in a single operation. Your Import file must therefore contain the all necessary commands followed by entries representing Blackout Period profiles that must be added, removed, or enriched by the import operation.

1. In the right pane of the Blackout Dates dialog box, select the group for which you are managing Blackout Period profiles.
2. On the ribbon, in the Manage Blackout Periods group, click Import. The Import Dates dialog box opens.
3. In the File Name field, type the full path to the file, or click Browse and navigate to the file you want to import.
4. Click Use the actions specified in the file, and then click OK. The Import Blackout Data dialog box opens, listing details from each entry in the Import file and a note about its proposed update.
5. Click OK.
6. When you receive the Blackout Dates have been successfully imported message, click OK.
The Blackout Dates calendar highlights the dates of the newly imported Blackout Periods in the left pane of the Blackout Dates window. Entries for the new and enriched Blackout Period profiles appear in the right pane. Calendar highlights and entries for profiles removed by the Import no longer appear.

**Note:** You will be unable to use the Edit command to update Blackout Period profiles created from a direct file import. You will be required to update these profiles using the Replace option in the Import operation.

**Extracting Blackout Period Profiles**

You can extract existing blackout period profile information from the ReportCaster Development Interface to a .txt file.

A direct file extract minimizes the time it would take to transfer information about multiple Blackout Periods to a text file that can serve as a backup of your Blackout Calendar configuration or as the source of an import to an external system for reporting or auditing purposes.

For example, if your group is required to maintain a backup copy of blackout dates for the coming six months, the extract operation enables you to transfer the Description, Date, and Name of all scheduled blackout periods during that time. You can recreate basic information about these profiles from the backup file in an emergency, shortening the time required to reconstruct your reporting schedule.

**Extracting File Formats**

The Import and Extract file operations use the same layout and format conventions. The Extract file contains additional comments that document the range of dates selected for the extract and templates for the format of the entries it contains, as shown in the following image.

For more information about each entry type layout, see Viewing Blackout Period Import File Format on page 233.
Procedure: How to Extract Schedule Blackout Period Profiles to a File

To extract schedule blackout period profiles:

1. In the Blackout Dates pane, select the group from which you are extracting blackout period profiles.

2. In the Manage Blackout Periods Toolbar group, click Extract.

   The Extract Blackout Dates dialog box opens. The Group Name from which you are extracting the blackout dates appears at the top of the dialog box, as shown in the following image.

3. Select one of the following from the Date Range Options:
   - All to extract all currently saved blackout period profiles.
   - Date Range to specify the range of dates containing scheduled blackout period profiles that you want to extract.

   If you select Date Range, type or select the Start Date and End Date. To select a date, click the down arrow next to the field. A calendar opens, from which you can choose a date.

4. Click OK.

5. To open the file, click the Open button when your browser presents it.
A window opens, displaying the contents of the extracted content profiles, as shown in the following image.

You can save and close the file using the commands in the File menu.

6. To accept an automatic download of the extract file, click the **Save** button (users of Google Chrome need only close the page displaying the new file name).

   You can later retrieve the file from the Downloads folder of your computer, rename it if necessary, and save a copy of it in another folder for archival or other purposes.

7. To rename and save the file in a different location, click the **Open** or **Open With** button, and select the **Save As** command from the program that opens the file.

8. From the Save As window, navigate to the folder in which you want to save the file, rename the file if necessary, and click **Save**.

   You can close any additional web pages that may remain open after you save the file.

   **Note:** The default extract file name is `rcbdextract_GroupName_YYMMDD_HHmmSS.txt`, where *GroupName* is the name of the group from which the blackout dates are extracted, *YYMMDD* and *HHmmSS* are the date (year, month, day) and time (hour, minute, second) that the file was created.

**Global Updates**

Authorized users can make global updates for the values stored in schedules and distribution lists. Using the Global Updates interface, the following settings can be updated:

- Mail Server
- FTP Server
- Printer
- Email Address
- Email From
- Data Server
Procedure:  How to Make a Global Update for a Mail Server
   1. In the Global Updates interface, click the Setting drop-down list and select Mail Server (the default).
   2. Type the existing Mail Server in the Old Value box.
   3. Type the new Mail Server in the New Value box.
   4. Click Update to update the new Mail Server value in schedules and distribution lists.

Procedure:  How to Make a Global Update for a Printer
   1. In the Global Update interface, click the Setting drop-down list and select Printer.
   2. Type the existing Printer in the Old Value box.
   3. Type the new Printer in the New Value box.
   4. Click Update to update the new Printer value in schedules and distribution lists.

Procedure:  How to Make a Global Update for an Email Address
   1. In the Global Update interface, click the Setting drop-down list and select Email Address.
   2. Type the existing Email address in the Old Value box.
   3. Type the new Email address in the New Value box.
   4. Click Update to update the new Email address value in schedules and distribution lists.

Procedure:  How to Make a Global Update for an Email From
   1. In the Global Update interface, click the Setting drop-down list and select Email from.
   2. Type the existing Email from in the Old Value box.
   3. Type the new Email from in the New Value box.
   4. Click Update to update the new Email from value in schedules and distribution lists.
Procedure: How to Make a Global Update for a Data Server
1. In the Global Update interface, click the Setting drop-down list and select Data Server.
2. Type the existing Data Server in the Old Value box.
3. Type the new Data Server in the New Value box.
4. Click Update to update the new Data Server value in schedules and distribution lists.

Procedure: How to Make a Global Update for a Notification Type
1. In the Global Updates interface, click the Setting drop-down list and select Notification Type.
   The notification options are:
   - Never. ReportCaster will not send a notification of the schedule status under any circumstances. This is the default value.
   - Always. Send a notification each time the schedule runs.
   - On Error. Only send a notification when there is an error running the schedule.
   For more information, see Notification Options in the Basic Scheduling Tool on page 942.
2. Select the existing value in the Old Value box.
3. Select the new value in the New Value box.
   If the Old Value is Never, then the Reply Address, Subject, Brief Message To, and Full Message To fields will display. Provide each field with the necessary information.
4. Click Update to update the new Notification Type value in schedules and distribution lists.

Procedure: How to Make a Global Update for a Notification Reply Address
1. In the Global Updates interface, click the Setting drop-down list and select Notification Reply Address.
2. Type the existing Notification Reply Address in the Old Value box.
3. Type the new Notification Reply Address in the New Value box.
4. Click Update to update the new Notification Reply Address value in schedules and distribution lists.

Procedure: How to Make a Global Update for a Notification Subject
1. In the Global Updates interface, click the Setting drop-down list and select Notification Subject.
2. Type the existing Notification Subject in the Old Value box.
3. Type the new Notification Subject in the *New Value* box.
4. Click *Update* to update the new Notification Subject value in schedules and distribution lists.

**Procedure: How to Make a Global Update for a Notification Brief Message To**

1. In the Global Updates interface, click the *Setting* drop-down list and select *Notification Brief Message To*.
2. Type the existing Notification Brief Message To in the *Old Value* box.
3. Type the new Notification Brief Message To in the *New Value* box.
4. Click *Update* to update the new Notification Brief Message To value in schedules and distribution lists.

**Procedure: How to Make a Global Update for a Notification Full Message To**

1. In the Global Updates interface, click the *Setting* drop-down list and select *Notification Full Message To*.
2. Type the existing Notification Full Message To in the *Old Value* box.
3. Type the new Notification Full Message To in the *New Value* box.
4. Click *Update* to update the new Notification Full Message To value in schedules and distribution lists.

**Purge Logs**

The Purge Logs functionality provides on-demand options for purging logs, including the ability to specify a number of days (past) for which to purge logs. For example, if you want to purge logs for the past month, you would use the default number of days, which is 30. You can also specify an option for traces: Default Traces, No Traces, or Trace On.

**Procedure: How to Purge Job Logs on Demand**

1. From the Tools group in the ReportCaster Console, click *Purge Job Logs*.
2. In the *Purge Job Logs Older Than (Days)* field, accept the default number of days or specify another value. The default number of days is 30.
3. Under Trace Options, you can accept the default of *Default Traces*, or select *No Traces* or *Trace On*.
4. Click *OK*. 

---

Online Help PDF 245
Working With Domains

WebFOCUS Business User Edition uses Domains, and the groups of users they define, to support workgroups. Domains enable users to maintain private content, to share that content if their user role permits, and to access governed content published by others. Domains are available to multiple users, who, based on their role, have access to their own view of the domain. This built-in workgroup security makes your data analysis and reporting activities easier to configure and manage.

In the Resources tree, domains appear as root-level folders under the Domains node.

Domains comprise a collection of groups, an Application folder on the Reporting Server, and a set of rules that makes them all work together in a single workgroup. Domains partition content and metadata, and enable Managers to organize and store your content in the portal. They are the place where Developers and Advanced Users create and manage content.

Procedure: How to Create a Domain

1. Sign in as a Manager.
2. On the Home page, in the Resources tree, click Domains if it is not highlighted already.
   or
   In the breadcrumb trail, click Domains.
3. On the actions bar, click Domain, as shown in the following image.
4. In the Title field, type a description of the domain, as shown in the following image.
As you type, the description you type in the Title field is automatically assigned to the Name field and adjusted to conform to format rules for file names.

Domain Titles appear in the Resources tree and in the content area. Domain Names are internal identifiers and are not shown to users.

5. Click OK.

**Note:** Within the new domain, a Hidden Content folder and a My Content folder are created for each user. The Hidden Content folder can be used to store items that are related to the domain but that should not be visible to other users, such as schedules that distribute output back to the domain, image files or style sheets used by charts. The My Content folder stores personal content for each user. Some users can share personal content with other domain users. Domain Developers and Managers can create folders and content within the domain and publish their content to enable domain users to access and interact with it.

**Managing Domain Users**

When a Manager creates a new domain, WebFOCUS Business User Edition automatically creates a new group for the domain itself, along with subgroups for each of the four user types within it. A domain accommodates multiple users, maintaining independent views and levels of availability for each one. By assigning users to different groups within a domain, a Manager or Group Administrator can set security options for each user at the domain level.

To review these groups, open the Security Center. From there, a Manager can create new users for these domain groups or add existing users to them. For more information about Groups, see *Managing Groups* on page 265.

**Granting Access to a Domain**

When a Manager first creates a domain, it is available only to the Manager that created it.

To update this setting, a Manager must right-click a domain, point to General Access, and then select one of the following settings.

- **Domain groups.** Protects the domain by limiting its availability to those users who are assigned to it and work within it. This is the default setting for all new domains.

- **All users.** Gives everyone Basic User access to the domain. Using this setting, the Manager that created the domain can make content and resources available to all users in a single action instead of individually assigning each user to the domain.
The four domain groups represent the four user types: Basic User, Advanced User, Developer, and Group Administrator. When the Manager or a Group Administrator assigns users to one of these groups, those users automatically obtain the privileges assigned to the user role represented by that group when working with content in that domain.

**Managing Domain Private Resources**

The Manage Private Resources feature allows Managers and Group Administrators to identify and manage private resources owned by users or groups. Managers can manage private resources by user, group, or domain.

**Deleting Domains**

A domain can only be deleted by a Manager who has rights to delete all of the resources within it.

The process that deletes a domain first removes all users from groups in the domain, and then cascade deletes the groups and rules that were created with it.

**Note:** The cascade delete process only removes users from groups within a domain. It does not delete the users themselves.

**Procedure: How to Delete a Domain**

1. Sign in as a Manager.
2. On the Home page, in the Resources tree, or in the content area, right-click a domain folder, and then click *Delete*.
3. When you receive a message advising you that this process will delete all resources created by this domain folder, click *OK* to delete the domain and associated resources, as shown in the following image.

   ![Delete Domain - Sales](image)

   Deleting this domain folder will also delete the following resources:

   /SYS/GROUPS/Sales

   ![OK Cancel]

   **Note:** In this message, the list of resources that will be deleted depends upon the resources that were originally included in the domain. Therefore, the details in this message will vary with each deleted domain.
4. If you receive a message warning that the folder contains private content, as shown in the following image, click OK to delete the domain and its private content, or click Cancel to end the process without deleting the domain.

Managing Domain Users After Deleting a Domain

Even though deleting a domain automatically deletes the groups associated with it, this action does not delete the users assigned to those groups. Users from the deleted groups remain in the Users pane in the Security Center, but, unless they are assigned to another group, they are limited to view only privileges. To completely remove users from deleted groups, a Manager must delete them from the Security Center.

Working With Folders

Folders contain all repository content. Whenever a user creates a folder, it will always be created as a private folder. If the creator is permitted the necessary privileges, folders and their contents can be shared with other users or published for general use.

Folders have both titles and file names. The title is typically displayed to users. The file name is used as an internal reference to provide an unambiguous context. Titles can be duplicated within a container, but file names cannot.

The folder path may have up to 1,040 characters for the path information (not including the object name), and up to 64 characters for the object name. For example, a folder may be named: /WFC/Repository/AmericaBank/Finance. In this example, /WFC/Repository/AmericaBank/ is 28 characters and Finance is 7 characters.

Procedure: How to View Folder Properties

In order to view the properties of a folder, right-click a folder in the Resources tree or content area of the Home page, and then click Properties. The Properties panel opens, displaying the information in the following table.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Tab</td>
<td></td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Language</td>
<td>Displays the language in which the folder and its content were created. The list attached to this field contains all languages made available by your code page selection.</td>
</tr>
<tr>
<td>View All</td>
<td>Opens the Language Properties dialog box that identifies the list of available languages and the default language selected for the folder. The default language specified in this dialog box is the language in which the folder and its contents were created and are displayed, by default. The folder name and description appear next to the selected default language option.</td>
</tr>
<tr>
<td>Title</td>
<td>Displays the title that appears on the folder when it is displayed in the Resources tree or content area. This is the title by which end users identify the folder, and is typically based on the contents in it.</td>
</tr>
<tr>
<td>Name</td>
<td>Displays a unique internal reference to the folder. This is the name used to identify the folder for internal operations. This field is dimmed and unavailable by default. Click the Change Name icon next to it to make this field available for name changes.</td>
</tr>
<tr>
<td>Summary</td>
<td>Displays a detailed explanation that provides additional information about the folder.</td>
</tr>
<tr>
<td>Path</td>
<td>Displays the full repository path of the parent folder.</td>
</tr>
<tr>
<td>Created</td>
<td>Displays the date and time the folder was created.</td>
</tr>
<tr>
<td>Modified</td>
<td>Displays the date and time the folder was last modified, and the ID of the user who last modified the folder.</td>
</tr>
<tr>
<td>Accessed</td>
<td>Displays the date and time the folder was last accessed by the Properties, Run, or Run Deferred commands, or by any of the edit tools used to update the folder. It also displays the ID of the user or tool that last accessed the folder.</td>
</tr>
<tr>
<td>Owner</td>
<td>Displays the ID of the User to whom the folder is currently assigned.</td>
</tr>
<tr>
<td>Publish</td>
<td>Specifies whether the folder and its contents are published or not.</td>
</tr>
<tr>
<td>Item</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show</td>
<td>Specifies whether to display the folder to users who are not permitted to create content in it. This option is primarily used when the folder needs to be made temporarily unavailable to end users who would otherwise be permitted to view or work with the content in the folder.</td>
</tr>
<tr>
<td><strong>Advanced Tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Folder Properties</strong></td>
<td></td>
</tr>
<tr>
<td>Automatically create My Content folders</td>
<td>When this check box is selected, a My Content folder is created for users with the My Content Folder privilege, giving the user a place to save the personal reports, charts, or documents that they may create using InfoAssist or other report and distribution features, such as Save Parameter reports.</td>
</tr>
<tr>
<td>Automatically open</td>
<td>If this check box is selected, when you open the Home page, this domain folder is automatically expanded in the Resources tree to display the My Content folder and the other folders that this folder contains. In addition, the content area automatically displays the folders and items assigned to this folder.</td>
</tr>
<tr>
<td><strong>Explorer/Portal Properties Group</strong></td>
<td></td>
</tr>
<tr>
<td>Sort order</td>
<td>Specifies the order in which the folder is listed in the Resources tree and in the content area.</td>
</tr>
</tbody>
</table>

**Procedure:** How to Create a Folder

1. On the Home page, in the Resources tree, click the parent folder that will contain the new folder.
   
   Or
   
   In the breadcrumb trail, click the link to the parent folder that will contain the new folder.
2. In the New Folder dialog box, type the title for the new folder, as shown in the following image.

As you type, the description you type in the Title field is automatically assigned to the Name field and adjusted to conform to format rules for file names. The Name field automatically converts any spaces or special characters you type in the Title field into underscore characters. If you type an unbroken string of multiple special characters, such as $&$, in the Title field, the Name field automatically converts them into a single underscore character. If you prefer, you can modify the Name, later.

3. Click OK.

The new folder appears in your selected location in the Resources tree and in the content area of the Home page.

4. In order to add an optional summary description of the folder:
   a. Right-click the new folder, and then click Properties.
   b. On the Properties panel, type the description in the Summary field.
   c. Click Save to save the description, and then click Cancel to close the Properties panel.

*Procedure: How to Publish a Folder*

In the Resources tree or content area of the Home page, right-click a folder, and then click Publish.

The Resources tree refreshes and no longer displays the folder name in italics. The content area refreshes, removes the border from the folder, and displays the folder icon in full color.

*Procedure: How to Unpublish a Folder*

In the Resources tree or content area of the Home page, right-click a folder, and then click Unpublish.
The Resources tree refreshes and displays the folder name in italics. The content area refreshes, displays a border around the folder, and displays the folder icon in gray.

**Procedure: How to Duplicate a Folder**

In the Resources tree or content area of the Home page, right-click a folder and then click *Duplicate*.

In the Resources Tree, a duplicate folder appears beneath the original folder. In the content area, the duplicate folder appears immediately to the right of the original or below it. The name and title of the duplicate folder are the same as those of the original, appended with an underscore and an integer that increases each time the folder is duplicated.

**Note:** The Duplicate command creates a copy of the folder in the same location as the original. Use the Copy and Paste commands if you need to move a copy of a folder to a different location.

**Procedure: How to Cut or Copy and Paste a Folder**

1. In the Resources tree or content area of the Home page, right-click a folder, and then click *Cut* if you want to move the folder, or click *Copy* if you want to create a copy of the folder and leave the original folder in place.

2. In the Resources tree, click the folder that represents the new location. Expand the tree to display the new location if necessary.

   or

   If the new location appears on the Breadcrumbs trail, click the folder that represents the new location.

3. In the Resources tree, right-click the folder that represents the new location, and then click *Paste*.

   or

   Right-click anywhere in the content area of the new location, and then click *Paste*.

The Resources tree and the content area refresh and display the folder.

Folder names must be unique within a specific location. If you paste the folder to a different parent folder, its name remains the same, as long as no folder of that name already exists in the new parent. If a folder of that name already exists, or if you pasted the copy of the folder into the same folder as the original, the name of the copy is the same as the original, appended with an underscore and an integer that increases each time you paste the folder. Folder titles are updated in the same way as folder names.
Procedure: How to Change a Folder Title

1. In the Resources tree or content area of the Home page, right-click a folder, and then click Properties.

2. On the Properties panel, type the new Title in the Title field, and then click Save.

   The folder name is updated. If the new name changes the position of the folder in alphabetical order, the folder is also relocated on the Resources tree and within the content area.

3. When your updates are complete, click Cancel to close the Properties panel.

Procedure: How to Delete a Folder

1. In the Resources tree or content area, right-click a folder, and then click Delete.

2. When you receive a message asking you to confirm the decision to delete the folder, click OK.

   The Resources tree and the content area refresh and remove the deleted folder.

Managing Users

The Users pane of the Security Center lists all users. The Search field in this tab allows you to search the name and description fields for users. Simple wildcard searches are supported. The full range of features that manage users is available only to Managers. Group Administrators can see the Security Center, but can only assign existing users to groups. Basic Users, Advanced Users, and Developers cannot see the Security Center, nor can they create, update, or delete users or assign users to groups.

The toolbar above the User pane allows Managers to perform the following actions:

- Create, edit, or delete users.
- Import users.
- View when users last signed in.
Understanding Users

Users are those individuals who have access to WebFOCUS Business User Edition. Managers and Group Administrators can assign users with similar responsibilities to one of the user type groups that are created automatically within a domain. This assignment allows users to take advantage of those features and content that supports their daily activities, but prevents them from using features or content that are beyond the range of their responsibilities and authority. The four user types are:

- **Basic Users.** Can view reports and content in the domains accessible to them. They can save deferred reports to their My Content folders, or copy parameters from a previously created report. They cannot share, publish, copy, or paste any folder or content.

- **Advanced Users.** Can do everything that Basic Users can do, and can also create original reports, charts and other content for their My Content folders. They can share folders and the content they contain with everyone or with selected users or groups.

- **Developers.** Can do everything that Advanced Users can do, and can view and publish content in their Hidden Folder. They can also copy and paste folders and content from their domain to another domain, but they must be sure that the domain they target for this operation maintains the same metadata as that used to create the content they are copying.

- **Group Administrators.** Can assign users to groups. They can also switch to Manager Mode and manage private resources.

Each user in the repository is defined by a unique name and may also be assigned a description, an email address, and a password. The user must be placed in a group at account creation and assigned a status. By default, the user is placed in the EVERYONE group, which is the group of all users in the system, and assigned the Active status.

Any of these characteristics, except the unique user name, may be edited later by a Manager.

Understanding User Name Requirements

Because user names are defined within the repository, they need to conform to the format rules and character limitations it imposes. If your installation supports external authentication, such as that provided by Microsoft Active Directory, user names also exist in an external repository, and must conform to the format rules defined in it.

The set of characters you can use to create user names is defined by the current character encoding setting established in the application server and the Client Code pages assigned to your NLS setting. For example, if the application server is configured to support UTF-8 encoding, and the NLS Setting is also configured to support the US Unicode (UTF) code page, you can use characters in the double-byte character set (DBCS) to create user names.
To support those installations that rely on external LDAP or Active Directory authentication, user names in WebFOCUS Business User Edition support all of the characters supported by the sAMAccountName standard. Note that the range of allowable characters for User Names in WebFOCUS Business User Edition is broader than the range for the sAMAccountName standard, and administrators must be careful to avoid including characters allowed by WebFOCUS Business User Edition but prohibited by the sAMAccountName standard in user names.

Given these considerations, when creating user names, take the following rules into account:

- User names may contain alphanumeric characters, spaces, and underscores.
- Depending upon the Client Code Page assigned to your NLS setting, user names can also include single-byte or double-byte NLS characters.

**Note:** To prevent sign-in issues, and to conform to sAMAccountName best practices, replace characters that contain accents or other diacritical marks in user names with characters that exclude them. For example, convert Müller into Muller.

- The following characters are not supported in user names: “|;/*,?"

**Note:** if your user names must conform to sAMAccountName standards, you must independently ensure that user names also exclude the following characters: [ ] : = + < > \n
- It is recommended that you limit user names to 64 characters. Longer user names may cause problems during migration.

- Do not end user names with a period (.) .

If you support external authentication, avoid including characters in user names that your external authentication repository does not support. For more information about which characters to avoid, contact Customer Support Services.

**Procedure:** How to Create a User

**Note:** Only a Manager can create a user.

1. In the Security Center, on the Users & Groups tab, click the New User button.

   The New User dialog box opens, as shown in the following image.
2. Type the user name, and optionally, type the description, email address, password, and password confirmation, and if desired, select a group and a status for the user.

3. When your input is complete:
   a. Click OK to create the user and close the New User dialog box.
   b. Click Create to create the user without closing the New User dialog box.
      Use this button when you need to create additional users without delay. When you click this button, the New User dialog box clears, a new entry for the user appears in the Users pane of the Security Center, and you can return to the previous step to add the next user.

If you do not enter a description, the description defaults to the name. If you do not select a group and status for the user, the user will be created in the EVERYONE group and assigned the Active status, by default.

If you are creating a user that will be authenticated externally using AD or LDAP, and you want to synchronize user information with the authentication provider, leave the email and description fields blank.
Importing Users

The Import User command automatically creates new user accounts by importing user information from a comma-separated values (.csv) text file and transferring those records to the user accounts database in the repository. This operation streamlines the creation of multiple user accounts by eliminating the necessity to open the New User dialog box, type, and save the details for each new user account, individually.

The import does not overwrite records of existing users, nor can you use it to delete existing user records. If a record in the user import file matches an existing user account, the import generates a message identifying the record that could not be imported, as shown in the following image.

Understanding User Import File Layout and Format Requirements

You can create a new user import file by typing user information into any text editor and saving it as a comma-separated values (.csv) file. If you are exporting user information from an external source, you can create a user import file by reorganizing and reformatting the exported information, as necessary, and then saving the exported user information in a .csv file. Regardless of the method you use, you must ensure that all user import files you create conform to the format and layout requirements described in this topic and that the information within those user records conforms to the requirements described in Understanding User Record Field Format Requirements on page 259.
The user import file must not contain a header or column heading line. The first line in the file must contain the first user record. From that point on, each line within the user import file contains the record for a single new user. Multiple user records must not be placed on the same line. Because the import will end when it encounters the first blank line, do not include any blank lines between user records.

User import files that contain only those NLS characters used in the U.S. English or Western Europe code page 137 require no special encoding. However, user import files containing NLS characters from other code pages require UTF-8 encoding, without a byte order mark (BOM). To encode a user import file for UTF-8, open it in a third-party editor, change the appropriate setting to specify that the file uses UTF-8 encoding, and save it with that value.

Each user record contains the following fields: user name, password, description, email address, user status, and groups, as shown in the following image.

Within a user record, each field is separated by a comma. If the value assigned to a field includes a comma, the value in that field must be enclosed within quotation marks ("."). For example the following new user record contains a comma in the third field, the description field, and is enclosed in quotation marks ("):

```
testadv,password,"Getting Started, Advanced User",testadv@domain.com,ACTIVE,Getting_Started/AdvancedUsers
```

If a field in a user record contains no information, the record must still define a placeholder for the blank field by leaving two commas with no characters between them in the appropriate place in the record. For example, the following new user record omits the password typically found in the second field of a user entry:

```
testbas,,Getting Started Basic User,testbas@domain.com,ACTIVE,Getting_Started/BasicUsers
```

Understanding User Record Field Format Requirements

When creating a user record, ensure that the values you assign to individual fields conform to the following requirements:

- **User Name.** Names assigned to imported users are subject to the same restrictions on valid characters as those entered directly in the new user dialog box. For a detailed description of user names and the range of characters that you can include in them, see *Understanding User Name Requirements* on page 255.
- **Password.** You can assign a generic one-time password, such as password, to the password field, or you can assign one of the hashed passwords from the UOA_USERS table.

- **Description.** Leave this field blank if you have activated the Synchronize User Information setting, which is located on the External page of the Security tab of the Administration Console. Otherwise, type the full name of the user or a brief description in this field. The activation of the Synchronize User Information setting allows for automatic updates to the value in this field from an external authentication or authorization provider.

- **Email Address.** Leave this field blank if you have activated the Synchronize User Information setting, which is located on the External page of the Security tab of the Administration Console. Otherwise, type the email address for the new user. The activation of the Synchronize User Information setting allows for automatic updates to the value in this field from an external authentication or authorization provider.

- **User Status.** Type ACTIVE, INACTIVE, or MUSTCHANGE in this field to identify the initial status of the user when the new user account is created. Each of these values must be typed in uppercase characters. If you type ACTIVE, the user represented by the account can sign in and work within WebFOCUS Business User Edition as soon as the account is created. If you type INACTIVE, the user represented by the account can sign in and work with WebFOCUS Business User Edition only after a Manager has changed the status of that user account to Active. If you type MUSTCHANGE, the user represented by the account is prompted to change his or her one-time password the first time he or she signs in to WebFOCUS Business User Edition.

- **Groups.** Type the name of the group or groups to which the user is assigned. If you do not include a value in the group name field, the user will be assigned to the EVERYONE group automatically. If you do include a group name, make sure that it matches the spelling and capitalization of its corresponding existing group name exactly.

  The format for a group name is the domain name, followed by a slash mark (/), and the group name. For example, the following new user record adds a user to the AdvancedUsers group of the Getting_Started domain, as shown in the last field in the record.

  ```
testadv,password,Getting Started Advanced User,testadv@domain.com,ACTIVE,Getting_Started/AdvancedUsers
```

  You can include more than one group name in this field. If you choose to do so, separate each group name with a semi-colon. For example, the following new user record adds a user to the Developers group and to the GroupAdmin group within the Getting_Started domain, as shown in the last field in the record.

  ```
testadv,password,Getting Started Advanced User,testadv@domain.com,ACTIVE,Getting_Started/AdvancedUsers
```

  ```
testadv,password,Getting Started Advanced User,testadv@domain.com,ACTIVE,Getting_Started/AdvancedUsers
```

  ```
testadv,password,Getting Started Advanced User,testadv@domain.com,ACTIVE,Getting_Started/AdvancedUsers
```
To prevent a user record from failing to load, any group that you identify in it must already be defined within WebFOCUS Business User Edition. You cannot use the import user operation to load new groups as well as users simultaneously.

**Procedure: How to Import Users**

Before you begin, ensure that all groups that are identified in the user import file already appear in the Groups pane of the Security Center, and create any groups or domains that do not appear.

1. In the portal, on the Menu bar, click **Administration**, and then click **Security Center**.
2. On the Users & Groups tab, click **Import Users**.
3. In the Import Users dialog box, click **Browse**.
4. In the Choose File to Upload dialog box, navigate to the .csv file that contains the users to import and double-click the entry, or click it, and then click **Open**.
5. In the Import Users dialog box, ensure that the name of the file that contains user records for import appears in the File to Import field, and if so, click **Import**.

The import operation creates new user accounts for the users specified in the file records, and assigns the new users to the groups specified in each record.

a. If you receive a message stating that there were issues processing the file, click **Hide/Show details**, review the issues listed in Warning Details dialog box, and update the import user file text or layout to address them.

b. When your updates are complete, save the revised user import file, close the Warning Details dialog box, and return to step 2 to run the import again.

6. When the import is complete, click **Close** in the Import Users dialog box.

7. Review the Users pane and the Users in Group pane to ensure that the full set of new users was imported, and that they were appropriately assigned to all groups.
**Procedure: How to Edit User Details**

Only a Manager can edit user details.

1. In the portal, on the Menu bar, click *Administration*, and then click *Security Center*.
2. On the Users & Groups tab, double-click a user, or right-click the user and select *Edit*, or click the user and then click the *Edit User* button. The Edit User dialog box opens, as shown in the following image.

3. If desired, type new information in the User Name, Description, or EMail Address field.
4. To change the status of a user, select *Active*, *Inactive*, or *Must Change Password* from the Status drop-down list.

   **Note:** If you select *Must Change Password*, users will be prompted to change their password when they attempt to sign in.

**Procedure: How to Delete a User**

Only a Manager can delete a user. The action of deleting a user also deletes that user's private content. Be sure to publish or share any private content assigned to that user if it supports ongoing activities.

1. In the portal, on the Menu bar, click *Administration*, and then click *Security Center*.
2. On the Users & Groups tab, right-click a user and select *Delete*, or select the user and click the *Delete User* button.

A confirmation dialog box opens. Click Yes to delete the user.

**Understanding the Group Membership Report**

The Group Membership report lists all groups to which an individual user or selected group of users is currently assigned. The list entry for each group assignment identifies a Group Name, Group Description, User Name, and User Description, as shown in the following image.

![Group Membership Report Image]

By default, the report lists entries in ascending order by Group Name. You can reorganize this default display by clicking column headings to sort the report entries in ascending or descending order based on the values in that column.
From this dialog box, you can also create an HTML version of the report, as shown in the following image.

Using commands in your browser, you can save this version of the report or send it by email to an external reviewer.

The Date and Time that appear on the HTML version of the Group Membership report use the default, locale-sensitive time format (24 hours or 12 hours AM/PM) assigned to the machine on which WebFOCUS Business User Edition is installed. Therefore, if you select a different language when you sign in to WebFOCUS Business User Edition, dates and times continue to appear in the format used by the default locale of your machine instead of the format required by the language you selected.

For example, if you install WebFOCUS Business User Edition on a machine that runs on the Windows operating system, uses English as the default language, and uses a locale-sensitive time format of 12 hours AM/PM instead of 24 hours, WebFOCUS Business User Edition displays all times in the 12 hour AM/PM format. Even if you configure WebFOCUS Business User Edition to use the UNICODE code page and include the Japanese Locale in the Dynamic Language Switch settings, times on this report and throughout the user interface continue to use the 12 hour AM/PM format. You cannot change the time display to a 24-hour time format unless you also add Japanese to the Windows Language configuration and change to a 24-hour time format within the Windows Date and Time settings on the machine that runs WebFOCUS Business User Edition.
**Procedure:** How to Create a Group Membership Report

1. In the Security Center, do one of the following:
   - To base the report on an individual user, in the Users pane, right-click the entry of your selected user.
   - To base the report on a group of adjacent users, in the Users pane, click the first user entry, hold down the Ctrl key, click on the final user entry, and then right-click your selection.
   - To base the report on a group of non-adjacent users, in the Users pane, hold down the Ctrl key, click on all of the individual entries you want to include in the report, and then right-click any selected entry.

2. When your selections are complete, in the shortcut menu, point to **Groups**, and then click **Group membership report**.
   - The Group Membership report dialog box opens, displaying all group assignments for your selected users.

3. To rearrange the report entries, click any column heading to list report entries in ascending or descending order based on the values in that column.

4. To produce an HTML version of the report, click **Create Report**.
   - Use the commands in your browser menu to print, save, or send the report.

5. To close the dialog box, click **OK**.

**Managing Groups**

In WebFOCUS Business User Edition, only Managers and Group Administrators can open the Security Center and review groups. The Groups field in the Users & Groups tab of the Security Center lists all the groups in the repository in alphabetical order. Subgroups appear indented below their parent groups. The Users in Group field lists the members of the selected group. If no group is selected, the field is blank. The Search field in this tab allows Managers and Group Administrators to search the name and description fields for groups. Simple wildcard searches are supported. A toolbar allows Managers and Group Administrators to perform the following actions:

- View the groups to which a user belongs.
- Add users to groups or remove them from groups.
- View the members of a group.
Understanding Groups

Groups are formed of users or subgroups that require similar capabilities or access to the same resources. All users are members of the EVERYONE group, which is the set of all named users in the system.

A group is a collection of similar users. Typically, users are permitted actions based on rules that apply to groups, although rules may also apply to individual user roles. Users may belong to more than one group.

Creating Groups From Domains

Groups are created automatically whenever a Manager creates a new Domain and deleted whenever a Manager deletes a Domain. This feature simplifies group management by limiting it to the assignment of users to previously created groups. Managers and Group Administrators are not obligated to create or delete groups independently.

Each Domain creates one master group that uses its name. This group does not contain any users.

The Domain also creates four groups within that master group that correspond to the four basic user types.

Members of the Basic User group can view content within their Domain and can save copies of reports they run deferred to their My Content folder for their own use.

Members of the Advanced User group have all the privileges of basic users, and they can create, share, and distribute their own content.

Members of the Developers group have all the privileges of basic and advanced users, and they can upload and connect to data, edit metadata, and create and organize Domain content. They can also manage the content other users see.

Group Administrators determine the role each user can have within a Domain by adding users to or removing users from groups and can change the General Access setting assigned to the Domain.

Users can be members of more than one of these groups and can have different privileges in different Domains. This capability is especially relevant to Group Administrators. In almost all cases, this group assignment, and the privileges it grants, is combined with membership in another group.
Procedure: How to Add a User to a Group

Only Managers and Group Administrators can add users to groups.

1. In the portal, on the Menu bar, click Administration, and then click Security Center.
2. On the Users & Groups tab, under Groups, select a group.
   
   **Note:** When you select a group, the members of the group appear in the Users in Group field.

3. Drag a user from the Users field into the Users in Group field, or select the user and click the Add selected users to group button.

   The user you added now appears in the Users in Group field, as shown in the following image.

4. Click OK.

Procedure: How to Remove a User From a Group

Only Managers and Group Administrators can remove users from groups.

1. In the portal, on the Menu bar, click Administration, and then click Security Center.
2. On the Users & Groups tab, under Groups, select a group.

3. Select a user and click the Remove selected users from group button, or drag the user into the Users field.
Managing Private Resources

Sometimes it is necessary for a manager to view or modify the private resources owned by another user. For example, when employees leave the company and their status is set to inactive, their private resources may need to be deleted or transferred to another user. It can also be useful for managers to have access to the private resources of the groups they manage in order to share resources or troubleshoot procedures. Managers and Domain Group Administrators have access to this feature. Managers can access the private resources of all users. Group Administrators can access the private resources of the users in their Domain groups.

You can perform most actions on non-output resources owned by other users, such as FOCEXECs, and schedules. For output resources, such as PDFs or Libraries, your abilities are limited to deleting the resources or changing their titles.

You can view and manage private resources by domain or by user or group.

Authenticating Users to Your Active Directory


The benefits of authenticating users to the Active Directory include:

- **Improved usability.** Users only need to remember a single user ID and password.


- **Improved maintenance.** Each time a user signs in, their user description and email is updated using the information found in the Active Directory, simplifying WebFOCUS Business User Edition administration.
Configuring Active Directory/LDAP Authentication

To convert to external Active Directory or LDAP authentication, you must override the default setting of internal authentication in both the WebFOCUS Business User Edition Client and the Reporting Server, and establish a connection between the Reporting Server and LDAP provider that will support authentication activities.

Here is an overview of the configuration steps:


   Since the default Manager account manager generally does not exist in the external source, it cannot be authenticated once external authentication has been successfully configured. The new Manager account that you create will exist both in WebFOCUS Business User Edition and in Active Directory so that you can use it for access to WebFOCUS Business User Edition once you have restarted it in its new authentication configuration.

2. Configure the LDAP provider to authenticate users to Active Directory.


   In the steps that follow, you will be required to provide credentials for two service accounts. The first is a WebFOCUS Business User Edition Reporting Server account, PTH\srvadmin, that is used by WebFOCUS Business User Edition to delegate authentication to the Reporting Server. The password for this account is pre-configured during installation to be the same as the password you supplied for the Manager account.

   The second is an Active Directory account of your choice that is used by the Reporting Server to authenticate users and retrieve their full description and email information, which in turn is passed back to WebFOCUS Business User Edition to update the user account. This service account simply needs read access to Active Directory. Generally, any Active Directory account can be used for this purpose, but you must make sure its password is set to never expire.

Procedure: **How to Create the Externally Authenticated Manager Account**

1. Sign in as a Manager.

2. In the portal, on the Menu bar, click Administration, and then click Security Center.

3. In the Security Center, under Users, click New User.

4. Type the Active Directory ID of the person who will be the new Manager after Active Directory authentication is established, in the User Name field.

   You do not need to enter a description or email address because this information will be automatically updated during sign in based on information retrieved from Active Directory.
5. Click Managers in the Create in Groups list.

6. Click OK.

An icon for the new user appears under Users and under Users in Group, when you click the Managers group.

Procedure: How to Establish LDAP as the Primary Security Provider on the Reporting Server

1. Sign in as a Manager.

2. In the portal, on the Menu bar, click Administration, and then click Reporting Server Console.

3. In the Reporting Server Console, click the Access Control tab.

   The Navigation pane displays an expandable LDAP folder.

4. Right-click the LDAP folder, and then click New.

5. In the LDAP Security Provider Configuration page, accept the default name, LDAP01, or type a new descriptive name for the LDAP security provider in the LDAP_PROVIDER field.

6. In the Connection Section, type the host name of your Active Directory server in the ldap_host field.

   In some cases, you can also enter the domain name of your organization, for example: ibi.com.

7. Change the value in the LDAP port field only if your installation uses a different port number.

   Most installations use the default port number, 389.

8. Click Explicit in the security list.

   The section expands and displays the fields, ldap_principal, and ldap_credentials.

9. Type the name of a Service Account that has read access to the Active Directory, in the ldap_principal field.

   It is important that this account has a non-expiring password to avoid future disruptions.

10. Type the password of the Service Account in the ldap_credentials field.

11. Click Next.

   If you receive a message that the Discover LDAP server attributes failed, click OK, and then review and update the settings you entered up to this point.

   If all settings are correct, the page refreshes and displays additional headings. Fields in the User Search section contain values populated directly from the Reporting Server.
12. Click the **Trusted Connection** section heading.
13. In the Trusted Connection section, click y in the trust_ext list.
14. Click **Test User Authentication**.
15. Type the Active Directory User ID and Password of the person that you previously identified as the new Manager, and then click **Continue**.

   If you receive a message that the connection or password failed, review and update your settings if necessary, and try again.

   If the password succeeded, continue with the next step.
16. Click **Save**.
17. In the Activate Providers page, in the LDAP entry that is identified by LDAP01, or by the descriptive name you typed in the LDAP_PROVIDER field, click **Primary** in the Status list.

   The Status of the LDAP entry changes to Primary, and the Status of the PTH<internal> Security provider entry changes to Secondary automatically.
18. Click **Save Provider’s Status**.

   The screen refreshes and displays the Change Effective Security Provider page.
19. Click **Apply and Restart Server**.

   When the confirmation dialog box opens, click **OK**.

   The Reporting Server Console refreshes and displays the Applications tab.
20. Click the **Access Control** tab.
22. Close the Reporting Server Console.

**Procedure:**  **How to Enable External Security in the WebFOCUS Client**

1. Sign in as a Manager.
2. In the portal, on the Menu bar, click **Administration**, and then click **Administration Console**.
3. In the Administration Console, click the Security tab.
4. Under the Security Configuration folder, click **External**.
5. On the External page, select the **Enable External Security** check box.

   The External page displays the settings currently assigned to the Reporting Server.
6. Type `PTH\srvadmin` in the **Server Administrator ID** field.

   This is a Reporting Server administrator account that was installed automatically during the installation.
7. Type the password for this account in the Password field.
   The password was assigned during installation, and is initially set to the same value that
   you entered for the Manager account during installation.

   **Note:** The placement of this ID and its associated Password in the Server Administrator ID
   field enables the Client to present them to the Reporting Server when sending User
   authentication requests.

8. Click Connect to verify the credentials you provided.

9. Leave User Authorization set to Internal and ignore the Account Creation on Sign In
   settings. WebFOCUS Business User Edition does not support changes to these options.

10. Select the Synchronize User Information with Authentication Provider check box.

11. Click Save.
    When the confirmation dialog box opens, click OK.

12. In the Administration Console menu, click Close.


14. Stop and restart the web application to make these changes take effect. To do so:
    If this installation is based on the Windows operating system, stop and restart the
    If this installation is based on the Linux operating system, navigate to the tomcat/bin
    directory and run the shutdown.sh and startup.sh utilities.

15. When the Web Application restarts, sign in again using the Active Directory User ID and
    Password of the new Manager that you identified at the beginning of the configuration.
    The user description on the Menu bar in the portal, and the Email Address of this account
    now reflect the values retrieved from the Active Directory.

---

**Creating User Accounts When WebFOCUS Business User Edition is Configured for
Active Directory Authentication**

Now that you have configured WebFOCUS Business User Edition to authenticate users to
Active Directory, you can create user accounts and assign them to the appropriate groups. This
can be done in two ways:
**Security Center.** To use the Security Center to create and assign accounts to groups, create accounts the normal way and assign them to the desired groups. However, since you are configured for Active Directory authentication you do not need to assign passwords for these users, and you do not need to populate the Description and Email fields for them. As you have seen, this information will be automatically retrieved from Active Directory as each user signs in.

**Import Users.** To use the Import Users feature, simply define a CSV file containing one row for each user account. You can use the `getting_started_sample_users.csv` file located in the installation directory as a template. You can leave the password, user description and email values blank, but you need to preserve the same number of commas in the file to properly delimit all the required fields. You can adjust the group membership data in the CSV for each user account to suit your requirements, or you can leave it blank and assign users in the Security Center. The file should contain only data rows with the required number of commas on each row and contain no blank lines. For example:

```
user1, , , ,ACTIVE,
user2, , , ,ACTIVE,Getting_Started/Developers;Retail_Samples/AdvancedUsers
```

**Configuring WebFOCUS Business User Edition for SSL**

The Hypertext Transfer Protocol over Secure Socket Layer (https) establishes an encrypted Secure Socket Layer (SSL) connection, and should be used to secure communications between WebFOCUS Business User Edition and browsers assigned to end users. There are many configuration options that enable the use of this protocol, one of which is the Apache Tomcat configuration, as described in this section. WebFOCUS Business User Edition uses this configuration by default.

To activate Secure Socket Layer-based communications, create a self-signed certificate for Java. You can optionally submit it to a Certificate Authority to establish it as a trusted certificate. The keytool utility that creates the certificate also modifies the connection type from open to SSL. Therefore, you must comment out the default Connector Protocol setting in the Tomcat server.xml file, and ensure that a setting for the new SSL Connector Protocol appears there instead.

**Procedure: How to Create a Self-Signed Certificate**

To create a Self-Signed Certificate with Java:

1. Open the command prompt window and redirect the command prompt to the following directory:

   ```
   drive:\ibi\WebFOCUS_BUE82\re\bin
   ```
2. Type the keytool command and values as shown in the following example.

```bash
keytool -genkeypair -alias mykey -ext san=dns:dnsName1,dns:dnsName2... -keyalg RSA -validity 720 -keystore /path_to_keystore/keystore -keysize 2048 -storepass MyPassword
```

where:

- **dnsName**
  Is the name, or alias, of the entity (the subject) that will present this certificate for authentication. You can include multiple names to ensure that all versions of the subject names are recognized. For multiple alternative names use the syntax, `dns:first_dnsName,dns:second_dnsName and so on`.

  For example, `dns:bue,dns:bue.ibi.com`.

- **MyPassword**
  Is the password for this keystore. You can accept MyPassword, the default value, or you can replace it with a unique password by typing it in this field.

- **/path_to_keystore/keystore**
  Is the location information that specifies where the key file will be placed. This value is optional. If you do not specify a location for the key file, the Keytool utility places it in the default location.

  **Note:** The name mykey is important if you need to issue a -certreq (certificate request) for a certificate signed by a Certificate Authority.

3. Press Enter.

4. Respond to each question as follows:
   - “What is your first and last name?” Type the first and last name of the certificate holder.
   - “What is the name of your organizational unit?” Type the name of the organizational unit of the certificate holder.
   - “What is the name of your organization?” Type the name of the organization of the certificate holder.
   - “What is the name of your City or Locality?” Type the name of the city or locality of the certificate holder.
   - “What is the name of your State or Province?” Type the two-letter abbreviation for the state in which the certificate holder is located.
“What is the two-letter country code for this unit?” Type the two-letter abbreviation for the country in which the certificate holder is located.

5. When the command prompt displays the question, “Is CN=__, OU=__, O=__, L=__, ST=__, C=__ correct?”, review the values and type y if they are correct.

If they are not correct, Type n and retype the keytool command from step 2.

If they are correct, the new Self-Signed Certificate is ready for use.

Establishing the Self-Signed Certificate as a Trusted Certificate

Until you identify the new self-signed certificate to the browser as a Trusted Certificate, the browser will display errors when you use it. During the initial testing period, you can add the new self-signed certificate directly to the Trusted Certificate Authority of those browsers included in the test. However, to fully establish the new certificate as a trusted certificate, you typically request certification for it from a Certificate Authority using the following request:

```
keytool -certreq -alias mykey -storepass MyPassword -file ./mykey.csr -keystore /path_to_keystore/keystore
```

where:

- **MyPassword**
  
  Is the password for this keystore. You can accept MyPassword, the default value, or you can replace it with a unique password by typing it in this field.

- **/path_to_keystore/keystore**
  
  Is the location information that specifies where the key file will be placed. This value is optional. If you do not specify a location for the key file, the Keytool utility places it in the default location.

You can then send the certificate request file (mykey.csr) to a Certificate Authority to sign, and when the authority returns the signed certificate, import it into the keystore.

Importing the Trusted Certificate into the Keystore

To import your certificate from the CA, type the following command:

```
keytool -import -alias mykey -file ./mykey.crt -keystore /path_to_keystore/keystore
```

where:

- **/path_to_keystore/keystore**
  
  Is the location information that specifies where the key file will be placed. This value is optional. If you do not specify a location for the key file, the Keytool utility places it in the default location.
If your CA is an internal CA, then type the following command to import the certificate from your Certificate Authority.

```
keytool -import -alias CA -trustcacerts -file ./ca.crt -keystore /path_to_keystore/keystore
```

where:

`/path_to_keystore/keystore`

Is the location information that specifies where the key file will be placed. This value is optional. If you do not specify a location for the key file, the Keytool utility places it in the default location.

### Updating the Connector Protocols in the Tomcat Server.xml File

The Tomcat server.xml file is located in the following directory:

```
drive:\ibi\WebFOCUS_BUE82\tomcat\conf
```

The keytool utility disables the http connection assigned to port 26000. Therefore you must comment out the Connector tag in the server.xml file that defines this http-based connection by typing an exclamation point (!) after the open tag symbol (`<`).

```
<Connector connectionTimeout="20000" maxPostSize="-1" port="26000" protocol="HTTP/1.1" redirectPort="26001" useBodyEncodingForURI="true"/>
```

The keytool utility also establishes an SSL connector on port 443. This connection replaces the old http based connection. Therefore, if it does not appear in the file, you must type this updated version of the connector tag, with its attributes and values, as shown in the following example.

```
```

where:

`/path_to_keystore/keystore`

Is the location information that specifies where the key file will be placed. This value is optional. If you do not specify a location for the key file, the Keytool utility places it in the default location.

`MyPassword`

Is the password for this keystore. You can accept MyPassword, the default value, or you can replace it with a unique password by typing it in this field.
Creating a Change Management Package

Many organizations do not grant developers write access to the user acceptance test and production environments. Access to these environments is strictly controlled and granted only to administrators, production control personnel, or automated change management processes.

Only developers know which changes are ready to be moved into the test environment. The Change Management Export facility presents developers with a graphical view of the resources they manage and allows them to build a change management package. This package is then loaded into another environment by production control personnel or automated processes.

**Note:** Execution IDs and passwords cannot be imported or exported through the Change Management utility. A new Execution ID and password must be created on the selected system.

Working With CM Zip Files

The zip file format compresses the resources that make up a change management package into a single file, delivering the advantages of speed and security to change management packages. They are especially useful when you must transfer change management packages from one physical location to another. Their compressed and consolidated format captures all files included in a change management package into a single file that can be emailed, copied, or cut and pasted from a source folder on one network component to a target folder on another.

WebFOCUS creates change management zip files, called CM zip files, by default. To disable this feature, clear the Zip Change Management Package (IBI_CM_ZIP) check box, which is found on the Change Management page of the Configuration tab in the Administration Console. When this feature is disabled, change management packages use the uncompressed CM file format.

The default CM zip file name format is NAME_DATE_TIME_USERID, which combines the name of the change management package, with the date and time on which it was created, and the ID of the user who created it. For example, retail_samples_20160504_161133_administrator.zip. To specify an alternative format for CM zip file names, select a template from the Name format of Zip export files (IBI_CM_ZIP_FILE_FORMAT) setting, which is found on the Change Management page of the Configuration tab in the Administration Console.
**Procedure: How to Create a Change Management Extract Package**

Only members of the Managers group have access to the Change Management feature, which is available as a node that contains two subfolders: Import and Export on the WebFOCUS Resources panel. To open the WebFOCUS Resources panel, in the portal Menu bar, click Resources.

The steps required to create a Change Management Package are:

1. **Create a Scenario.** Utilizing the Change Management Export facility, an authorized user creates a scenario by selecting the resources to be exported. A scenario is a description of all the resources that will be exported into a Change Management Export Package.

2. **Export a Scenario.** After a scenario is created, a user can export this scenario into a Change Management Export Package. This Change Management Export Package is placed in the drive:`\ibi\WebFOCUS_BUE82\WebFOCUS\cm\export` directory in two formats: a zip file and a folder, which contains the expanded contents of the zip file.

   The zip file or the exported folder is then copied to the target environment and placed in the drive:`\ibi\WebFOCUS_BUE82\WebFOCUS\cm\import` directory. For convenience the CM zip file can be downloaded from Business User Edition using a web browser and similarly uploaded to the target Business User Edition where its content can then be imported and accessed.

**Procedure: How to Create a Scenario From the Change Management Export Facility**

1. In the portal, on the Menu bar, click Resources.

2. In the WebFOCUS Resources panel, expand the Change Management node.

3. Right-click Export, and click New Scenario.

4. In the New Scenario dialog box, type the scenario name, and then click OK.

The Change Management Scenario dialog box opens, as shown in the following image.

5. Right-click the domain, folder, or other resource you want to include, and:
   a. Click Select with Sub-Tree to include that folder and all subfolders in your selection.
   b. Click Select Folder Only to include the specific folder, with no content. Typically, this is done to move rules on the folder.
c. You can also select resources by dragging them from the Resources tree and dropping them in the right pane. When you do so, the With Subtree check box is selected, by default, and you must clear it if you wish to exclude subfolders and content from your selection.

When your selection is complete, an entry for it appears in the right pane, and a strikethrough line appears on the entry under the Resources tree, as shown in the following image.

- If you select a private resource, the With Private Content check box is automatically selected and cannot be cleared.

- If you select private content, it will only be imported if the owner of that private content already exists in the target environment.

- If you select a published folder, you can include private content within it by selecting the With Private Content check box for that resource. This will export all of the private content in that folder and its subfolders, including those My Content folders that are assigned to individual users, even if you do not have the privileges necessary to view that private content.

- If you select a subfolder without a parent folder, the Import process will recreate the parent folder in the target environment. A connection to the same metadata must exist within the target environment as well as the source environment.
If the rules on the source and target environments are different, users may have access to private content in the source environment, but be denied access in the target environment. This occurs if users have access to the published folder that contains the private content in the source environment, but do not have it in the target environment.

6. Repeat the previous step for any additional resources you want to include in the change management scenario.

7. If you need to clear your unsaved selections, click Reset Scenario.

8. When you have selected all resources, click Save.
   An entry for the new scenario appears beneath the Export node.

9. If the new scenario does not appear, right-click the Export node, and then click Refresh.

**Procedure:** How to Open a New Change Management Scenario from the Change Management Scenario Dialog Box

1. In the Change Management Scenario dialog box, on the toolbar, click Create a new Scenario.

2. If you receive a message that asks if you want to save the changes you made, click Yes.

3. Type the name of the new scenario, and click OK.
   A new Change Management Scenario dialog box opens. The current Change Management Scenario dialog box also remains open.

4. Create the new scenario as described in the procedure, How to Create a Scenario From the Change Management Export Facility on page 278, starting with step 4.

**Procedure:** How to Open an Existing Change Management Scenario from the Change Management Scenario Dialog Box

1. In the Change Management Scenario dialog box, on the toolbar, click Open existing Scenario.

2. If you receive a message that asks if you want to save the changes you made, click Yes.

3. In the Open Scenario dialog box, navigate to the existing scenario you want to open and double-click it, or click it and then click Open.
   Your selected Change Management scenario dialog box opens and replaces the Change Management scenario dialog box that was on display.
Procedure: How to Export a Saved Change Management Scenario Using the Change Management Facility

Before you can export a change management scenario, you must make sure that you have saved it. You cannot export an unsaved change management scenario.

1. In the Scenario dialog box Quick Access Toolbar, click Export.
2. When the confirmation message opens, click OK.
   The new scenario appears in the WebFOCUS Resources panel, under the Change Management, Export node.
3. If the new scenario does not appear, right-click the Export node, and then click Refresh.

Procedure: How to Download a Change Management Package Zip File

The export process saves a CM zip file to the following location:

```
drive:\ibi\WebFOCUS_BUE82\WebFOCUS\cm\export
```

The download process takes that CM zip file, and downloads it to your local machine. You can then transfer the copy of that CM zip file to another environment for use as a change management package.

1. In the portal, on the Menu bar, click Resources.
2. In the WebFOCUS Resources panel, expand the Change Management node.
3. Expand the Export node.
4. Right-click the CM zip file you want to download, and then click Download, as shown in the following image.

5. Save the CM zip file to an external location as directed by your browser.
**Procedure: How to Upload a Change Management Package Zip File**

The zip file upload process saves a copy of a CM zip file stored on your local machine to the change management import directory on the server at the following location:

```
drive:\ibi\WebFOCUS_BUE82\WebFOCUS\cm\import
```

You can then import the copy of that CM zip file to WebFOCUS Business User Edition.

1. In the portal, on the Menu bar, click **Resources**.
2. Expand the Change Management node, right-click Import, and then click **Upload a Zip File**.
3. In the Upload a Zip File dialog box, click **Browse**, navigate to the location where you have saved the change management package, click the CM zip file you want to upload, and then click **Open**.
4. Ensure that the correct CM zip file appears in the File to Upload field, and decide whether or not to import files from the package as published or unpublished files.
   - To establish the contents taken from the CM zip file as published after the upload is complete, select the **Publish Documents** check box. This is the default setting.
   - To establish the contents taken from the CM zip file as private after the upload is complete, clear the **Publish Documents** check box.
5. Click **Upload**.
   - When you receive a confirmation message, click **OK** to complete the upload.
6. In the Upload a Zip File dialog box, click **Close**.
   - If an entry for the new CM zip file does not appear below the Import node, right-click it, and then click **Refresh**.

**Procedure: How to Import a Change Management Package**

Only members of the Managers group can import Change Management Packages.

This procedure assumes that a change management zip package has been previously created on another system, the Manager is signed in to the target environment, and the CM zip file is available to the Manager.

1. In the WebFOCUS Resources panel, expand the **Change Management** node, and then expand the **Import** node.
   - If the CM zip file is not visible, right-click the node, and then click **Refresh**.
2. Right-click the uploaded change management package, and click **Import**.
   - The Import Package dialog box appears, as shown in the following image.
3. Select one of the following options:

**Add New Resource Only (do not replace).** This option only adds new resources to the target environment. For newly created items, the Created On and Last Modified On fields are updated with the time at which they were imported. To view the Created On and Last Modified On fields, right-click an item and click *Properties*.

If an item already exists in the target environment but is also part of the change management export package, the target resource are left alone and the Last Modified On field will not be updated.

**Add New and Update Existing Resources.** This option adds new resources to the target environment, and updates existing resources. For newly created items, this option assigns the time of the import to the Created On and Last Modified On fields. For updated items, this option retains the original value in the Created On field, but updates the value in the Last Modified On field with the time of the most recent import.

The other options on this panel are not used in WebFOCUS Business User Edition and can be ignored.

4. Click *OK*. 
Changing InfoAssist User Preferences

You can change the default user preferences to customize the way that InfoAssist behaves when you create reports and generate output. The application theme, which is inherited from the portal, customizes the InfoAssist interface, including all menus and dialog boxes.

You can style your reports by selecting a document theme independent from the interface. On the InfoAssist application main menu, click Options.

The Options window, as shown in the following image, opens to provide you with a user-friendly interface for customizing the InfoAssist application.

Note: If you make changes to the default selections in the Options dialog box, changes will take effect the next time InfoAssist launches.

If any of the options are unavailable, contact your administrator for assistance.

View

The View area provides settings for establishing the design view in which you will work, the type of data you will use when you preview your output, the limit you need to set on your record input, how your data and query panels will look, and the output target that you will use.

- **Design View.** Values are Live Preview and Query. Select Live Preview to activate the Preview Method drop-down menu. The default value is Live Preview.

- **Preview Method.** Values are Preview with Source Data and Preview with Sample Data. This menu becomes active when you select Live Preview from the Design View drop-down menu. The default value is Preview with Source Data.

- **Record Limit.** Values are All records, 1, 10, 50, 500, or you can type a numeric value directly in the menu. The default value is 500.
Data Panel. Values are Logical, List, and Structured. The default value is Logical.

Query Panel. Values are 2x2 (2 columns by 2 rows), 1x4 (1 column by 4 rows), and Tree. The default value is Tree.

Output Target. Values are Single Tab, New Tab, Single Window, and New Window. The default value is Single Tab.

Layout

The Layout area provides settings for printing reports and charts.

Page Size. Values are A4, A3, A5, Letter, Tabloid, and Legal. The default value is Letter.

Orientation. Values are Portrait and Landscape. The default value is Portrait.

Format

The Format area provides settings for the output types for reports, charts, and documents.

Report output type. Values are HTML, PDF, PowerPoint (pptx), Excel (xlsx), Excel (xlsx Formula), Excel, Excel (Formula), Excel (csv), and active report. The default value is HTML.

Chart output type. Values are HTML, HTML5, PDF, PowerPoint (pptx), Excel (xlsx), Excel, and active report. The default value is HTML5.

Document output type. Values are HTML, PDF, PowerPoint (pptx), Excel (xlsx), Excel (xlsx Formula), Excel, Excel (Formula), and active report. The default value is active report.

Environment and Styling

The Environment and Styling area provides settings for styling reports and charts through the specification of a Document Theme. Click the Browse button to open the Templates - Browse predefined template files dialog box, in which you can search for an existing WebFOCUS StyleSheet. The default StyleSheet is Warm.sty, but you can select from the other themes that are available (Dark.sty or Flat.sty).

Note: StyleSheets are stored in the following directory of your Business User Edition installation:

drive:\ibi\WebFOCUSBUE82\IBI_HTML\ibi_themes
In addition, you can access a repository of additional themes by accessing the Legacy Templates, under Libraries, as shown in the following image.

The theme that you select determines the coloring and hues that display within InfoAssist. The default templates in the Templates section apply to all languages, whereas some of those in the Legacy Templates sections are specific to just one language (for example, EN=English).

- **Accordion.** Values for this option are: Autofit and Legacy. The enhanced Accordion report format is built to autofit and be adaptive within windows and portal page containers. The legacy Accordion report opens in a tree structure independent of the window or container. The default value is Autofit.

- **Freeze.** The Freeze option allows you to define a scroll area within the data of your report. It locks the headings and footings in place, enabling you to scroll through the data within the container. Values for this option are: Autofit and Fixed. Autofit sizes the scroll bar to fit the container. Fixed sets the scroll height to the default 4" size. The default value is Autofit.
Changing Global Preferences

You can change global preferences for InfoAssist through the Administration Console found on the portal. To do so, in the Administration Console, on the Configuration tab, click *InfoAssist Properties*.

Configuring Hyperstage

Hyperstage is a column-oriented, high performance analytic engine designed for analytic applications and data marts that need fast query response across large data volumes. Hyperstage was designed specifically for large volume data analytics applications with up to 50 Terabytes of data.

Hyperstage Overview

Hyperstage uses a unique and patent-pending approach to compressing, storing, and processing data that allows it to be installed and run on commodity hardware with little or no DBA intervention. Hyperstage requires little tuning to support ad hoc or complex business analytic queries.

Hyperstage is a database engine utilizing the PostgreSQL database environment. As such, Hyperstage is fully compatible with all PostgreSQL-compliant Business Intelligence tools and utilizes the PostgreSQL administrative interface to reduce the learning curve for system administrators.

Hyperstage provides a versatile, highly-compressed database system optimized for analytic-type queries. The ratio of possible compression and the speed of data import and retrieval are optimized at the expense of some transactional features of the engine performance, like the frequent data updating.

Hyperstage executes complex or ad hoc queries across vast amounts of data with a low cost of ownership.

Hyperstage and PostgreSQL

Hyperstage combines the Hyperstage storage engine with PostgreSQL server implementation. Hyperstage consists of several layers. The upper layers are provided by the PostgreSQL server implementation, and the lower layers are provided by Hyperstage.

Hyperstage includes both its own optimizer and executor along with the storage engine. The PostgreSQL query engine can be used with Hyperstage. However, since the PostgreSQL storage engine interface is row oriented, it cannot take full advantage of the column orientation or the Knowledge Grid and hence query execution through this path is reduced. Queries will be directed to the Hyperstage optimizer whenever possible.
Hyperstage ships with the full PostgreSQL binaries required. PostgreSQL is used to store catalog information (as with other storage engines). You can use the PostgreSQL instance for other purposes, but joining PostgreSQL and Hyperstage tables may result in reduced performance as the PostgreSQL query engine will be used.

PostgreSQL provides:

- Mature connectors, tools and resources.
- Interconnectivity and certification with BI tools.
- Management services and utilities.

Hyperstage provides:

- Load function that compresses data.
- Column-oriented storage engine.
- Knowledge Grid metadata layer that contains information about the compressed data.
- Optimizer/executor that uses the Knowledge Grid.

Installing and Configuring the Hyperstage Database

The following section describes the installation and configuration steps for Hyperstage.

Configuring Hyperstage

The Hyperstage configuration file is called infobright.cnf and is located in the ib_data subdirectory within the Hyperstage Data installation directory for example, C:\ibi\HyperstagePG\ib_data.(for example, C:\ibi\WebFOCUS_BUE82\srv\wfs\hs\ib_data). The configuration file is a text file containing the Hyperstage configuration parameters.

Each parameter is shown on a separate line.

If a parameter is not present in the configuration file or if the configuration file does not exist, the default values are used. Blank lines and comments (lines starting with #) are ignored.

Be sure to customize the following parameters to optimize performance. These tuning parameters are case sensitive and must be typed as shown in the following table.

**Note:** The values are commented out (preceded by #) in the infobright.cnf file, which causes them to default to the application minimum allowed values of 600 and 320 for ServerMainHeapSize and LoaderMainHeapSize, respectively.
Hyperstage Configuration Parameters

<table>
<thead>
<tr>
<th>Parameter Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>LicenseFile</td>
<td>Specifies the path or name of the newly required License file.</td>
</tr>
<tr>
<td>LogLevel</td>
<td>Controls how much information is written to logs. This is similar to the obsolete ControlMessages parameter.</td>
</tr>
<tr>
<td>LogRotateSize</td>
<td>Specifies how large the log file can be before it is rotated and archived.</td>
</tr>
<tr>
<td>LogRotateFiles</td>
<td>Specifies how many log archive files are kept.</td>
</tr>
<tr>
<td>KNFolder</td>
<td>Specifies the folder where Knowledge Grid is stored.</td>
</tr>
<tr>
<td>CacheFolder</td>
<td>Specifies the folder where temporary objects are stored.</td>
</tr>
<tr>
<td>ServerMainHeapSize</td>
<td>Specifies the size (in MB) of the main memory heap.</td>
</tr>
<tr>
<td>ThrottleLimit</td>
<td>Controls how many SELECT queries can run concurrently.</td>
</tr>
</tbody>
</table>

Configuration Tips and Examples

**Important:** You must properly configure your memory settings to ensure optimal performance.

The following table shows sample, recommended memory configurations for different systems.

<table>
<thead>
<tr>
<th>System Memory</th>
<th>Server Main Heap Size</th>
<th>Loader Main Heap Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>64GB</td>
<td>48000</td>
<td>800</td>
</tr>
<tr>
<td>48GB</td>
<td>32000</td>
<td>800</td>
</tr>
<tr>
<td>32GB</td>
<td>24000</td>
<td>800</td>
</tr>
<tr>
<td>16GB</td>
<td>10000</td>
<td>800</td>
</tr>
<tr>
<td>8GB</td>
<td>4000</td>
<td>800</td>
</tr>
</tbody>
</table>
In most cases, the loader does not benefit from larger memory settings. However, increasing the LoaderMainHeapSize can help when:

- A table to be loaded has very long text values.
- or
- The table has many columns (for example, 1000 columns).

You can use more memory at import if you are planning to execute several concurrent load tasks to different data tables. However, disk access may become a bottleneck.

ServerMainHeapSize should be as large as possible, but safely smaller than the amount of physical memory on the machine. If performance decreases because of memory swapping by the operating system, try to set lower heap sizes. We also recommend decreasing the heap size if many users are running queries in parallel.

**Note:** Hyperstage may use additional memory for heavy loads or queries. Also, other applications on your server will use memory for their processes. It is important that the total of ServerMainHeapSize is less than the total available physical memory. If the system needs to swap memory, performance will be severely impacted.

**Using the Hyperstage Database Beyond WebFOCUS**

The following section describes how to work with the Hyperstage server.

**Starting and Stopping the Hyperstage Server Under Windows**

The Hyperstage Server starts and stops automatically when starting and stopping the Hyperstage version of the Reporting Server. The Manager user ID is required to start and stop any component of the Business User Edition.
To manually stop the Hyperstage Server, from the Workspace tab, expand the Select Special Services and Listeners section of the Reporting Server Web Console, right-click the HYPER service and click Stop, as shown in the following image.
To manually start the Hyperstage server, from the Workspace tab, expand the Select Special Services and Listeners section of the Reporting Server Web Console, right-click the HYPER service and select Start, as shown in the following image.

![Hyperstage Server Configuration](image)

**Quick Copy For Hyperstage Using Extended Bulk Load Utility**

**Note:** Hyperstage only supports DataMigrator, Quick Copy, and Custom Copy as ETL tools.

The Quick Copy tool allows for the copying of all data from a Source table into Hyperstage. The Bulk Load option should be selected in order for data to be loaded quickly. If the Bulk Load option is cleared, the data will take much longer to load.

The Custom Copy tool allows for the copying of selected columns, presorting data within selected columns, and filtering of columns from a Source table into Hyperstage.

The DataMigrator tool is a comprehensive ETL tool. ETL flows can be created to copy data from various sources, transform the data, and load the data into targets.

To access the Quick Copy tool, right-click the name of the synonym corresponding to the table or data you wish to copy into Hyperstage, and select Quick Copy.

The following configuration setting options are available:

**Load Option**

- **New/Replace.** Recreate the target table before loading the data.
Append to Existing. Data is loaded to an existing table.

Adapter
The list of adapters currently configured on the Reporting Server. The Hyperstage adapter must be configured with at least one connection in order to appear in the drop-down menu.

Connection
The Hyperstage connection used for the load operation.

Synonym Application
The target application on the Reporting Server where the target synonym will be stored.

Synonym
The name of the target synonym defining the Target Table Name.

Table Name
The name of the Hyperstage table where the data will be loaded.

Bulk Load
When selected, data will be loaded using the Hyperstage Bulk Load functionality. Bulk Load is the recommended approach for loading data into Hyperstage.

When cleared, data will be loaded using Insert/Update. Insert/Update is not recommended and will perform extremely slow.

Managing Hyperstage Tables
The following section describes how to work with the Hyperstage tables and lists the data types supported.

About the Hyperstage Database Files
Hyperstage tables are located in the ib_data subdirectory in your Hyperstage installation directory. Within the ib_data subdirectory, Hyperstage databases are stored in separate subdirectories.

Important: Do not manually copy a data table from one database to another by copying the database files. Internal table numbering errors and Knowledge Grid inconsistencies may occur. To copy a table, use import and export commands (see Importing and Exporting Data in Hyperstage) or backup the entire database directory (see Hyperstage Backup and Recovery on page 298).
The following path and image shows the content of the ib_data directory, containing the Hyperstage databases webfocus and utf8test, as well as the BH_RSI_Repository directory, which holds the Knowledge Notes:

```
D:\dbms\Hyperstage\ib_data>dir
08/15/2014 05:11 PM <DIR> BH_RSI_Repository
08/18/2014 12:56 PM <DIR> utf8test
06/10/2014 03:16 PM <DIR> webfocus
```

C:\ibi\WebFOCUS_BUE82\srv\wfs\hs\ib_data

### About Supported Data Types

The following data types are supported in Hyperstage. Note that numeric data types ranges are 1 less than the PostgreSQL minimums and maximums.

<table>
<thead>
<tr>
<th>Numeric Types</th>
<th>Values</th>
<th>Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>BOOLEAN</td>
<td>Values are either 0 or 1.</td>
<td></td>
</tr>
<tr>
<td>SMALLINT</td>
<td>-32767</td>
<td>32767</td>
</tr>
<tr>
<td>INT (INTEGER)</td>
<td>-2147483647</td>
<td>2147483647</td>
</tr>
<tr>
<td>BIGINT</td>
<td>-9223372036854775807</td>
<td>-9223372036854775807</td>
</tr>
<tr>
<td>REAL</td>
<td>-3.402823466E+38</td>
<td>3.402823466E+38</td>
</tr>
<tr>
<td>DOUBLE PRECISION</td>
<td>-1.7976931348623157E+308</td>
<td>1.7976931348623157E+308</td>
</tr>
</tbody>
</table>
**Numeric Types**

<table>
<thead>
<tr>
<th>Numeric(M, D)</th>
<th>-((1E+M - 1) / (1E+D))</th>
<th>((1E+M - 1) / (1E+D))</th>
</tr>
</thead>
<tbody>
<tr>
<td>where: 0 &lt; M &lt;= 18 and 0 &lt;= D &lt;= M</td>
<td>(-(1E+M - 1) / (1E+D))</td>
<td>((1E+M - 1) / (1E+D))</td>
</tr>
</tbody>
</table>

**Date and Time Types**

<table>
<thead>
<tr>
<th>DATE</th>
<th>100-01-01</th>
<th>9999-12-31</th>
<th>YYYY-mm-dd</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time (without timezone)</td>
<td>00:00:00</td>
<td>24:00:00</td>
<td>HH:MM:SS</td>
</tr>
<tr>
<td>TIMESTAMP (without timezone)</td>
<td>100-01-01 00:00:00</td>
<td>9999-12-31 23:59:59</td>
<td>YYYY-mm-dd HH:MM:SS</td>
</tr>
<tr>
<td>TIMESTAMP (with timezone)</td>
<td>1970-01-01 00:00:00 in UTC</td>
<td>2038-01-01 00:59:59 in UTC</td>
<td></td>
</tr>
<tr>
<td>Interval</td>
<td>-1780000000 years</td>
<td>1780000000 years</td>
<td></td>
</tr>
</tbody>
</table>

**String Type**

<table>
<thead>
<tr>
<th>BYTEA (binary string)</th>
<th>0 &lt; N &lt;= 65536</th>
</tr>
</thead>
<tbody>
<tr>
<td>CHAR(N)</td>
<td>Fixed-length. Maximum length depends on character set (encoding). 0 &lt; N * B &lt;= 65536 where B is the maximum number of bytes for a single character.</td>
</tr>
</tbody>
</table>
### String Type

| VARCHAR(N) | Maximum length depends on character set (encoding). $0 < N \times B \leq 65536$, where $B$ is the maximum number of bytes for a single character. For example, for UTF-8 it is 4 bytes, so the maximum number of characters that can be stored in a (VAR)CHAR column is $65536 / 4 = 16384$ |
|

### Creating and Dropping Tables

Use the standard PostgreSQL commands to create and drop tables in Hyperstage, the same as you would with a PostgreSQL table. For detailed syntax information, see the PostgreSQL 9.2 Documentation.

**Important:** Do not manually copy a data table from one database to another by copying the database files. Internal table numbering errors and Knowledge Grid inconsistencies may occur. To copy a table from one database to another, export from the source database and then import into the target database (see Importing and Exporting Data in Hyperstage) or back up the entire database directory (see Hyperstage Backup and Recovery on page 298). You can rename the entire database by renaming the folder. However, you should not copy a database folder from one active instance to another, or within the same active instance.

To create a table, enter the following command:

```sql
psql> create table <table_name> (<column(s)>) with (ENGINE=INFOBRIGHT);
```

**Note:**

- 'with (ENGINE=INFOBRIGHT)' syntax is necessary when creating tables manually, to specify that the table will be stored as part of the Hyperstage-specific Infobright engine. Without this syntax, the table will be created and stored as a regular PostgreSQL table.

- When creating a table, as a matter of practice, you should always use the ENGINE= option to ensure that the correct database engine is used. Hyperstage is shipped with DEFAULT ENGINE=INFOBRIGHT, but this can be changed. The name of the engine can be specified explicitly at the end of the create table statement.

To drop a table, enter the following command:

```sql
psql> drop table table_name;
```
For information on supported and unsupported options when creating columns, see About Column Options.

Character Set Support

The following section describes the character sets supported by Hyperstage.

Supported Character Sets

Hyperstage storage supports all ANSI and UTF-8 character sets. This means that Hyperstage can store and retrieve data encoded in 8-bit and multi-byte character sets.

Important: Queries that evaluate against UTF-8 character data columns will execute with less performance than an equivalent query against ASCII character data, due to ASCII support of Character Maps in the Knowledge Grid (see Running Queries in Hyperstage). UTF-8 specific Knowledge Grid extensions will be available in an upcoming release.

Collations and Comparisons

Hyperstage supports all custom UTF-8 collations supported by PostgreSQL:

<table>
<thead>
<tr>
<th>utf8_bin</th>
<th>utf8_polish_ci</th>
</tr>
</thead>
<tbody>
<tr>
<td>utf8_czech_ci</td>
<td>utf8_roman_ci</td>
</tr>
<tr>
<td>utf8_danish_ci</td>
<td>utf8_romanian_ci</td>
</tr>
<tr>
<td>utf8_esperanto_ci</td>
<td>utf8_slovak_ci</td>
</tr>
<tr>
<td>utf8_estonian_ci</td>
<td>utf8_slovenian_ci</td>
</tr>
<tr>
<td>utf8_general_ci (default)</td>
<td>utf8_spanish2_ci</td>
</tr>
<tr>
<td>utf8_hungarian_ci</td>
<td>utf8_spanish_ci</td>
</tr>
<tr>
<td>utf8_icelandic_ci</td>
<td>utf8_swedish_ci</td>
</tr>
<tr>
<td>utf8_latvian_ci</td>
<td>utf8_turkish_ci</td>
</tr>
<tr>
<td>utf8_lithuanian_ci</td>
<td>utf8_unicode_ci*</td>
</tr>
<tr>
<td>utf8_persian_ci</td>
<td></td>
</tr>
</tbody>
</table>

*utf8_unicode_ci properly handles both French and German collation, so specific collation types for these languages are not necessary.

For more information, see the PostgreSQL 9.2 Documentation.
The SQL standard does not define a default collation. Therefore, many DBMS engines have different default collations and produce different results. As a result, there are several differences between Hyperstage and other DBMS engines.

- For Hyperstage, character data types are case-sensitive. For example, the condition ‘toronto’='Toronto' is not true in Hyperstage. Similarly, the condition, LIKE ‘Abc%’ is not true for 'abcde'.

- The Hyperstage sorting order is A...Z a...z (for example 'Zeta' < 'alfa'), which is the same sorting order as used by Oracle. The Hyperstage sorting order is different than the default PostgreSQL sorting order, which mixes lowercase and uppercase. The SQL Server order, which is aAbB...zZ; and the DB2 order, which is AaBb...Zz.

- The Hyperstage sorting order affects ORDER BY results, GROUP BY results (which is the order of groups and their definitions (for example, 'aaa' and 'AAA' define different groups) and DISTINCT results. WHERE conditions may also be affected if you are expecting a different sorting order than the one used by Hyperstage.

- To simulate Hyperstage collation in the PostgreSQL engine, set latin1_bin collation while creating a table (for more information, see the PostgreSQL 9.2 Documentation). Enter the following command:

  ```
  psql> create table ... collate ascii_bin;
  ```

### Padding

Hyperstage treats padding differently than other DBMS engines. Hyperstage assumes literal comparisons of text fields, including all whitespace characters. Therefore, a string containing two spaces is different than a string containing one space or an empty (0 length) string, which is also different than the NULL value.

The Hyperstage padding definition is compatible with the SQL standard. However, most DBMS systems have defined less restricted, customizable rules regarding text comparison. For example, 'abc ' = 'abc' may be true in some databases, but is not true in Hyperstage.

**Note:** In CHAR columns, trailing spaces are trimmed on LOAD, INSERT, and UPDATE, whereas in VARCHAR columns values are loaded with all spaces.

### Hyperstage Backup and Recovery

The following section provides instructions on how to backup and restore the Hyperstage databases.
Backup Procedure

Use the following procedures to back up Hyperstage.

- To back up the Hyperstage databases, copy the ib_data and pg_data directories.
- You can take advantage of incremental backups, since only some of the database files are updated when new data is imported. Be sure to do a full backup occasionally.

**Important:** Some files in the KNFolder are updated when queries (using JOIN) are run, so be sure to back up the KNFolder on a regular basis.

Restore Procedure

To restore the Hyperstage databases from a backup copy, do the following:

1. Replace the ib_data and pg_data directories with the backup copy.
2. Replace the KNFolder with the backup copy (if the KNFolder is not inside the data directory).

**Important:** Do not manually modify database files or move them from one database to another. This may lead to data corruption and unpredictable results.

Functions and Operators

The following section lists the functions and operators supported by Hyperstage.

### Hyperstage Optimizer Supported Functions and Operators

#### Comparison Functions and Operators

<table>
<thead>
<tr>
<th>Function</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>COALESCE</td>
<td>YES</td>
</tr>
</tbody>
</table>

#### Control Flow Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>CASE</td>
<td>YES</td>
</tr>
<tr>
<td>COALESCE</td>
<td>TBD</td>
</tr>
<tr>
<td>NULLIF</td>
<td>YES</td>
</tr>
</tbody>
</table>
### String Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>BIT_LENGTH</td>
<td>YES</td>
</tr>
<tr>
<td>CONCAT</td>
<td>YES</td>
</tr>
<tr>
<td>LEFT</td>
<td>YES</td>
</tr>
<tr>
<td>LENGTH</td>
<td>YES</td>
</tr>
<tr>
<td>LOCATE</td>
<td>YES</td>
</tr>
<tr>
<td>LOWER</td>
<td>YES</td>
</tr>
<tr>
<td>LPAD</td>
<td>YES</td>
</tr>
<tr>
<td>LTRIM</td>
<td>YES</td>
</tr>
<tr>
<td>OCTET_LENGTH</td>
<td>YES</td>
</tr>
<tr>
<td>POSITION</td>
<td>YES</td>
</tr>
<tr>
<td>RIGHT</td>
<td>YES</td>
</tr>
<tr>
<td>RPAD</td>
<td>YES</td>
</tr>
<tr>
<td>RTRIM</td>
<td>YES</td>
</tr>
<tr>
<td>SUBSTR</td>
<td>YES</td>
</tr>
<tr>
<td>TRIM</td>
<td>YES</td>
</tr>
<tr>
<td>TRUNC</td>
<td>TBD</td>
</tr>
<tr>
<td>UPPER</td>
<td>YES</td>
</tr>
</tbody>
</table>

### Numeric Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>Modulo (%)</td>
<td>YES</td>
</tr>
<tr>
<td>ABS</td>
<td>YES</td>
</tr>
<tr>
<td>Function</td>
<td>Status</td>
</tr>
<tr>
<td>------------</td>
<td>--------</td>
</tr>
<tr>
<td>ACOS</td>
<td>YES</td>
</tr>
<tr>
<td>ASIN</td>
<td>YES</td>
</tr>
<tr>
<td>ATAN2, ATAN</td>
<td>YES</td>
</tr>
<tr>
<td>ATAN</td>
<td>YES</td>
</tr>
<tr>
<td>CEIL</td>
<td>YES</td>
</tr>
<tr>
<td>COS</td>
<td>YES</td>
</tr>
<tr>
<td>COT</td>
<td>YES</td>
</tr>
<tr>
<td>DEGREES</td>
<td>YES</td>
</tr>
<tr>
<td>EXP</td>
<td>YES</td>
</tr>
<tr>
<td>FLOOR</td>
<td>YES</td>
</tr>
<tr>
<td>LN</td>
<td>YES</td>
</tr>
<tr>
<td>LOG</td>
<td>YES</td>
</tr>
<tr>
<td>MOD</td>
<td>YES</td>
</tr>
<tr>
<td>PI</td>
<td>YES</td>
</tr>
<tr>
<td>POWER</td>
<td>YES</td>
</tr>
<tr>
<td>RADIANS</td>
<td>YES</td>
</tr>
<tr>
<td>RANDOM</td>
<td>TBD</td>
</tr>
<tr>
<td>SIGN</td>
<td>YES</td>
</tr>
<tr>
<td>SIN</td>
<td>YES</td>
</tr>
<tr>
<td>SQRT</td>
<td>YES</td>
</tr>
<tr>
<td>TAN</td>
<td>YES</td>
</tr>
</tbody>
</table>
### Date and Time Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>CURRENT_DATE</td>
<td>YES</td>
</tr>
<tr>
<td>CURRENT_TIME</td>
<td>YES</td>
</tr>
<tr>
<td>DATE</td>
<td>YES</td>
</tr>
<tr>
<td>DAY</td>
<td>YES</td>
</tr>
<tr>
<td>DAYOFYEAR</td>
<td>YES</td>
</tr>
<tr>
<td>FROM_UNIXTIME</td>
<td>YES</td>
</tr>
<tr>
<td>HOUR</td>
<td>YES</td>
</tr>
<tr>
<td>MINUTE</td>
<td>YES</td>
</tr>
<tr>
<td>MONTH</td>
<td>YES</td>
</tr>
<tr>
<td>NOW</td>
<td>YES</td>
</tr>
<tr>
<td>QUARTER</td>
<td>YES</td>
</tr>
<tr>
<td>SECOND</td>
<td>YES</td>
</tr>
<tr>
<td>TIME</td>
<td>YES</td>
</tr>
<tr>
<td>YEAR</td>
<td>No</td>
</tr>
</tbody>
</table>

### Text Search and Other Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>CAST</td>
<td>YES</td>
</tr>
<tr>
<td>MD5</td>
<td>TBD</td>
</tr>
</tbody>
</table>

### Group By Aggregate Functions

<table>
<thead>
<tr>
<th>Function</th>
<th>Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>AVG</td>
<td>YES</td>
</tr>
<tr>
<td>Function</td>
<td>Status</td>
</tr>
<tr>
<td>---------------</td>
<td>--------</td>
</tr>
<tr>
<td>BIT_OR</td>
<td>No</td>
</tr>
<tr>
<td>BIT_AND</td>
<td>No</td>
</tr>
<tr>
<td>COUNT(DISTINCT)</td>
<td>TBD</td>
</tr>
<tr>
<td>COUNT</td>
<td>YES</td>
</tr>
<tr>
<td>MIN</td>
<td>YES</td>
</tr>
<tr>
<td>MAX</td>
<td>YES</td>
</tr>
<tr>
<td>STD, STDDEV</td>
<td>YES</td>
</tr>
<tr>
<td>STDDEV_POP</td>
<td>YES</td>
</tr>
<tr>
<td>STDDEV_SAMP</td>
<td>YES</td>
</tr>
<tr>
<td>SUM</td>
<td>YES</td>
</tr>
<tr>
<td>VAR_POP</td>
<td>YES</td>
</tr>
<tr>
<td>VAR_SAMP</td>
<td>YES</td>
</tr>
<tr>
<td>VARIANCE</td>
<td>YES</td>
</tr>
</tbody>
</table>

**Hyperstage Data Tools**

The following section describes the data tools used by Hyperstage.

**Hyperstage Consistency Manager**

Hyperstage provides a tool to validate Hyperstage-specific metadata structures. The Hyperstage Consistency Manager is an external stand-alone application that can be run against a Hyperstage instance to verify and repair most Hyperstage data structures, including the Knowledge Grid and Data Packs.

If you are seeing unexpected behavior with Hyperstage, such as server crashes, it can help to run the Hyperstage Consistency Manager for information for support and to perform repairs.

**Note:** Currently, the Hyperstage database must be offline in order to run the Hyperstage Consistency Manager.
### Hyperstage Consistency Manager Tests

The Hyperstage Consistency Manager runs tests, as described in the following table.

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete mask consistency check</td>
<td>Checks that the delete mask headers contain the proper sum for the delete mask body. If any inconsistency is found between the header and body, the Hyperstage Consistency Manager returns the list of blocks of delete mask where inconsistencies were found.</td>
</tr>
<tr>
<td>Number of objects in columns equality</td>
<td>Compares the stored number of objects in each column file related to the table. If any inconsistency is found in the number of objects, the Hyperstage Consistency Manager returns the first two columns with different object numbers.</td>
</tr>
<tr>
<td>Comparison of maximal value in DIMENSION dictionary versus DPN</td>
<td>Executes only for DIMENSION columns. Compares the maximal key value stored in the DIMENSION column dictionary and in DPNs. If the values differ, the Hyperstage Consistency Manager writes them to the log.</td>
</tr>
<tr>
<td>Comparison of number of objects in first-column DPN versus delete mask</td>
<td>Compares the metadata stored in the headers of the delete mask and DPN file related to the number of objects. If any inconsistencies are found, the Hyperstage Consistency Manager returns both numbers. The Hyperstage Consistency Manager compares only the first column because there is an independent test comparing this value between columns. If the test does not find the proper delete mask file or the proper DPN file, the Hyperstage Consistency Manager reports corruption.</td>
</tr>
<tr>
<td>Knowledge Grid consistency for column</td>
<td>Checks if the histograms report the proper value of the fixed parameter. A basic test of the Knowledge Node, ensuring the file has a proper format and the type of Knowledge Node corresponds to the column.</td>
</tr>
<tr>
<td>Knowledge Grid format for column</td>
<td>Each Knowledge Node is stored in a separate file. This test validates that the header data of each file is in the proper format.</td>
</tr>
</tbody>
</table>
### Test Description

<table>
<thead>
<tr>
<th>Test</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Test for overlapping Data Packs in data files</td>
<td>Checks if there are Data Packs in files that overlap each other. If this situation occurs, the Hyperstage Consistency Manager returns a list of pairs of Data Packs numbers that are overlapping.</td>
</tr>
<tr>
<td>Tests of table metadata consistency</td>
<td>Verifies if the table metadata is valid. Includes verification of files used to store items, such as table name, number of columns and their names, types, and constrains like NOT NULL. These are the files created on CREATE TABLE and modified only on ALTER TABLE.</td>
</tr>
<tr>
<td>Test of DPNs for non-binary collation</td>
<td>Verifies Data Packs specifically for non-binary collation types (for example: Latin1_swedish.ci). If errors exist, they can be repaired using the Hyperstage Consistency Manager - -repair option.</td>
</tr>
</tbody>
</table>

#### Syntax: How to Run the Hyperstage Consistency Manager

To view the run options, run Hyperstage Consistency Manager with the - -help flag:

```plaintext
Icm-pure --help
```

To run Hyperstage Consistency Manager, use the following command:

```plaintext
Icm-pure --datadir=/data_directory_path [parameters]
```

For example:

```plaintext
c:\ibi\srv77\home06Hyperstage\hs\bin>icm-pure.exe
   --datadir=C:\HyperstagePG\ib_data --log-file=C:\temp\icm-pure.log
```

**Note:** Hyperstage Consistency Manager should be run by the 'postgres' user. It should not be executed by 'root' or any rebuilt knowledge nodes will be owned by root (and cannot be edited), which will result in issues when loading any subsequent data into the 'corrected' tables.

The following table describes the Hyperstage Consistency Manager parameters.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>- -help</td>
<td>Displays help message and exit.</td>
</tr>
<tr>
<td>-V [ - -version ]</td>
<td>Displays version information and exit.</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>- basedir</td>
<td>Absolute path to Hyperstage installation directory.</td>
</tr>
<tr>
<td>arg</td>
<td></td>
</tr>
<tr>
<td>- datadir arg</td>
<td>Absolute path to directory. Mandatory.</td>
</tr>
<tr>
<td>- database arg</td>
<td>Name of database chosen for data integrity testing. Optional. If specified, no other databases will be tested.</td>
</tr>
<tr>
<td>- table arg</td>
<td>Name of table chosen for data integrity testing. Optional. If specified, no other tables will be tested.</td>
</tr>
<tr>
<td>- log-file arg</td>
<td>Prints output to log file. Optional. If not specified, the logs will be printed to the console.</td>
</tr>
<tr>
<td>-F [ -full-check ]</td>
<td>Runs full set of tests (may be time-intensive). Running Hyperstage Consistency Manager without the full-check option will result in a quicker test. However, the &quot;Knowledge Grid consistency for column&quot; test will not be run.</td>
</tr>
<tr>
<td>-repair</td>
<td>Repairs found problems.</td>
</tr>
<tr>
<td>-rebuild-kns</td>
<td>Rebuilds the Knowledge Grid. For more information, see About Rebuilding or Repairing Knowledge Nodes on page 307.</td>
</tr>
<tr>
<td>-stop-on-error</td>
<td>Stops tests on first error and report.</td>
</tr>
<tr>
<td>-cleanup</td>
<td>In case of an error in the Hyperstage Consistency Manager repair procedure, this option enables Hyperstage Consistency Manager to manually revert the datadir to its previous state. Running Hyperstage Consistency Manager with the -cleanup option removes the old DPN files (containing incorrect DPNs) from the datadir and also makes the changes performed by Hyperstage Consistency Manager impossible to undo. If the -cleanup option is not used, the old DPN files remain in the datadir.</td>
</tr>
</tbody>
</table>
About Rebuilding or Repairing Knowledge Nodes

Executing a rebuild of the Knowledge Nodes (using the -rebuild-kns option) will run the following tests:

- Test of table metadata consistency
- Test of Knowledge Grid format for column
- Test of Knowledge Grid consistency for column

The -rebuild-kns option will fix any issues found for the first two tests ("Test of table metadata consistency" and "Test of Knowledge Grid format for column").

You can also use the -repair option along with the --full-check option to achieve the same results as -rebuild-kns. Using either of these methods will rebuild any Knowledge Nodes that have been deleted.

About Cleanup Procedures

The Hyperstage Consistency Manager creates backup files when repairing problems related to "Test of DPNs for non-binary collation" (backup files are not created for any other tests). These backup files can be used to revert back to the original data if the Hyperstage Consistency Manager encounters an error during the repair procedure. To revert to the original data, copy or rename the TAXXXXXDPN.icm_bck files to the TAXXXXXDPN.ctb files (found in the ib_data directory).

Distributing the Quick Data Add-In File

WebFOCUS Quick Data add-in allows you to bring a large amount of enterprise information to the familiar Excel environment, and interact with this information without learning any additional software. You can install the WebFOCUS Quick Data Add-in on your desktop, and you can create and edit queries by accessing predefined data sources. You can save a query in an Excel document, and you can refresh it at any time.

Because all WebFOCUS connection and report information can be saved in an Excel workbook, users with the proper security and access rights can share spreadsheets throughout an organization. As a result, you spend less time recreating reports and more time analyzing information for effective decision-making.

Note: Quick Data is an option for Business User Edition, which requires a separate license and installation. For more information about licensing Quick Data, contact your Information Builders representative.
To distribute and enable the Quick Data Add-in in your environment, follow the procedures below.

**Procedure: How to Distribute the Quick Data Add-in File**

1. Copy the wfquickdata.xla add-in file and the wfquickdata.cfg configuration file, located in one of the following directories:
   - For Windows, `drive:\ibi\WebFOCUS_BUE82\WebFOCUS\utilities\quickdata`
   - For Unix, `/ibi/WebFOCUS_BUE82/utilities/quickdata`

2. Add the files to the following directory on the machines that use Quick Data.
   
   C:\Users\userid\AppData\Roaming\Microsoft\AddIns\
   
   where:
   
   `userid`
   
   Is the name of the user logged on to the PC.

   After the WebFOCUS Quick Data Add-in file is in the proper directory, you must open Excel and select the WebFOCUS Quick Data option in the Add-Ins dialog box, as described in the following procedure.

   **Note:** If you already have Quick Data installed in your environment, be sure to backup your existing wfquickdata.cfg file to preserve all your customizations. You can then copy your edits from the existing wfquickdata.cfg file to the new file.

**Procedure: How to Enable the Quick Data Add-In in Excel 2016**

Use the following steps to enable the Quick Data Add-in in Excel 2016:

2. Click the File tab, click *Options*, and then click the Add-Ins category.
3. From the Manage dialog box, select *Excel Add-ins*, and then click *Go.*
The Add-Ins dialog box opens, as shown in the following image.

![Add-Ins dialog box](image)

**Note:** If WebFOCUS Quick Data is not listed in the Add-Ins dialog box, make sure that the add-in is installed and placed in the correct directory.

4. Select the WebFOCUS Quick Data check box and click OK.

**Procedure:** How to Enable the Quick Data Add-In in Excel 2013

Use the following steps to enable the Quick Data Add-In in Excel 2013:

1. Launch Microsoft Excel 2013.
2. Click the File tab, click Options, and then click the Add-Ins category.
3. In the Manage dialog box, select Excel Add-ins, and then click Go.
The Add-Ins dialog box opens, as shown in the following image.

![Add-Ins Dialog Box](image)

**Note:** If WebFOCUS Quick Data is not listed in the Add-Ins dialog box, make sure that the add-in is installed and placed in the correct directory.

If the Quick Data Add-in was installed in a different directory, use the Browse button in the Add-Ins dialog box to locate it.

4. Select the WebFOCUS Quick Data check box and click OK.

**Procedure:** How to Enable the Quick Data Add-In in Excel 2010

Use the following steps to enable the Quick Data Add-In in Excel 2010:

2. Click the File tab, click Options, and then click the Add-Ins category.
3. In the Manage dialog box, click Excel Add-ins, and then click Go.
The Add-Ins dialog box opens, as shown in the following image.

![Add-Ins dialog box](image)

**Note:** If WebFOCUS Quick Data is not listed in the Add-Ins dialog box, make sure that the add-in is installed and placed in the correct directory.

If the Quick Data Add-in was installed in a different directory, use the Browse button in the Add-Ins dialog box to locate it.

4. Select the WebFOCUS Quick Data check box and click **OK**.

**Procedure:** How to Enable the Quick Data Add-In in Excel 2007

Use the following steps to enable the Quick Data Add-In in Excel 2007:


2. Click the Microsoft Office Button in the top-left corner.

3. Click *Excel Options* and then click *Add-Ins* in the Excel Options dialog box.

4. From the Manage drop-down list, select *Add-ins*, and click *Go*.
The Add-Ins dialog box opens, with WebFOCUS Quick Data listed as an add-in option, as shown in the following image.

![Add-Ins dialog box](image)

**Note:**

- If WebFOCUS Quick Data is not listed in the Add-Ins dialog box, make sure that the add-in is installed and placed in the correct directory.

- If the Quick Data Add-in was installed in a different directory, use the Browse button in the Add-Ins dialog box to locate it.

5. Select *WebFOCUS Quick Data*, and click *OK*.
A WebFOCUS menu opens in the Add-Ins tab. The following image shows an example of the WebFOCUS menu in Excel 2016.

![WebFOCUS menu in Excel 2016](image)

**WebFOCUS Quick Data Options**

Once you have distributed the Quick Data Add-in, you can access the WebFOCUS Quick Data Options, which are described in this topic. Except for Settings and Web Servers List, these options are also available from Excel right-click context menus.

- **Create Query.** Available for new queries only, this option opens the Web Server Connection dialog box, so that you can connect to Business User Edition. It continues by opening the Data Source Selection dialog box, so that you can select a Master File, and then create a query.

- **Edit Query.** Available for existing queries only, where you can edit a query.

  Edit Query is not enabled for password-protected cells.

- **Edit Connection.** Available for existing queries only, this option opens the Web Server Connection dialog box, where you can edit the connection settings including the Web Server URL, the HTML Alias, and the Client Path. The ability to edit connection information saves time when you are reusing reports and helps facilitate the sharing of workbooks across an organization.

- **Data Range Properties.** Available for existing queries only, this option opens the External Data Range Properties dialog box, where you can set Excel query properties.

- **Refresh Data.** Available for existing queries only, this option refreshes the data in the existing report query.

  Refresh is not enabled for password-protected cells.
Settings. This option opens the WebFOCUS Quick Data Settings dialog box, as shown in the following image.

The WebFOCUS Quick Data Settings dialog box provides the following settings:

- **On-Demand Reporting Server Logon.** This setting determines if the user will be prompted to log on to the Reporting Server the first time that a connection to the server is made during an Excel session (check this setting), or each time that a request is made to the Reporting Server during an Excel session (do not check this setting).

- **Show Properties dialog when the query is created.** When this setting is selected, a dialog box with options on how to insert data into Excel opens each time that a new query is executed.

- **Enable Tracing.** This option allows you to capture WebFOCUS Quick Data information in a trace file to troubleshoot communication problems and issues that may occur when you attempt to create and run report requests.

The captured information includes tasks performed by the tool when it attempts to connect to the web server and Reporting Server, when requests are made for data, and when data is retrieved. The default name of the trace file is wfquickdata.txt. It is created in the same directory as the WebFOCUS Quick Data Add-in file, for example:

```
C:\Users\user_id\AppData\Roaming\Microsoft\Addins
```
Traces are captured for the duration of a single active Excel session. Tracing is automatically turned off when you close an Excel session. The trace file content is cumulative. Added to the file is trace information from each session in which tracing is enabled.

When you select Enable Tracing, the Trace File field is automatically populated with the full path to the trace file. The path includes the trace file name. You can change the location and name of the trace file by either typing the changes in this field, or by clicking the ellipsis and browsing to a new trace file location.

To view the current trace file, click Open Trace.

To delete the contents of the current trace file, click Clear Trace.

You can forward your trace file to Information Builders Customer Support Services (CSS) for analysis by the technical support team.

- **Web Servers List.** This option opens a dialog box that displays a list of the configured web servers, as shown in the following image. You can move the servers up or down in the list to change the order of appearance, and delete servers from the list.

![Web Servers List](image)

**Configuring a Default Business User Edition Environment**

A configuration file is provided with the Quick Data add-in for the Administrator to use as a template when designing a default environment. The configuration file defines items, such as the web server port number, alias, and client path.
Providing users with a default environment allows them to bypass the additional step of manually defining web server connection parameters.

The configuration file is named wfquickdata.cfg. It is originally located in the following directory: ..\ibi\WebFOCUS_BUE82\WebFOCUS\utilities\quickdata. After you have distributed the Quick Data Add-in in your environment, the configuration file is placed in the directory, such as: C:\Users\userid\AppData\Roaming\Microsoft\AddIns.

The configuration file can contain multiple WebFOCUS configurations. Keep in mind that if the configuration file contains more than one configuration, the last one appearing in the file is the configuration that is used when Quick Data is opened.

The configuration file provided as a template with the Quick Data add-in contains examples of configurations and instructions to help you create your own configuration. The following example displays a typical configuration:

```plaintext
SERVER_START
  PROTOCOL=“http”
  HOST=“localhost”
  PORT=“26000”
  HTML_ALIAS=“/ibi_apps/ibi_html”
  CLIENT_PATH=“/ibi_apps/WFServlet.ibfs”
SERVER_END
```

**Note:**

- The use of double quotation marks around a parameter value, as shown in the example, is optional.
- Begin a comment line in the file with a number sign (#).

Use the following guidelines to create the configuration file:

- The configuration file must have the same name as the Quick Data Add-in file, and must have the extension .cfg, such as wfquickdata.cfg
- The configuration file must reside on the machine running the Quick Data Add-in, in the same directory as the .xla file.
- Each configuration must begin with the delimiter, SERVER_START, and end with the delimiter, SERVER_END.
- Each configuration must contain the following parameters in order to connect to Business User Edition:
  - **PROTOCOL.** The protocol used in the environment running Business User Edition. If Business User Edition is running in a Secure Sockets Layer (SSL) environment, you must specify https as the protocol value. The default value is http.
- **HOST.** The name of the server on which the web application is installed.

- **PORT.** The port number of the application server on which Business User Edition is installed.

- **HTML_ALIAS.** The alias of the web server or application server on which the static pages are located. The default value is /ibi_apps/ibi_html.
  
  **Note:** The leading slash is required.

- **CLIENT_PATH.** The path to the Servlet, as defined in the web application file, web.xml. The default value is \\
  
  /ibi_apps/WFServlet.ibfs

  where:

  /ibi_apps

  Is the default context root of the web application. The leading slash is required. You can configure this value.

  WFServlet.ibfs

  Is the name of the Servlet.

### Managing the Server or Global Profile

A server or global profile, edasprof.prf, is created during installation of WebFOCUS Business User Edition. You can customize this profile, which is applied to all users.

The server profile can include almost any command that a client application can send to the server. However, the server profile is used most frequently for application setup commands, such as SET commands.

The server profile remains in effect throughout a user session. You can modify the server profile default settings. You can also add any commands or code that all connected users require before application processing begins.

**Procedure:** How to Manage the Server or Global Profile

1. Sign in as a Manager.
2. In the portal, on the Menu bar, click Administration, and then click Reporting Server Console.
3. Click the Workspace tab.
4. On the Workspace tree panel, expand Configuration Files.
5. Right-click Server Profile and click Edit.
   The server profile, edasprof.prf, opens.

6. Type the desired command, such as an application setup command, at the end of the file.
   An example of an application setup command is SET ACRSVRBTITL = ON. For an Active Technologies report, this command displays the title specified in the Master File, instead of the name, to identify a column in an ACROSS group.

7. Click Save.
   All commands typed in the profile in step 6 are in effect for any user who submits a request for a report.
Chapter 3

Working With Data

Upload your own data sources and connect, join, and blend data, or learn about the sample data sources that are packaged with the Business User Edition software.

In this chapter:

- Working With Data Overview
- Preparing Data for Upload
- Uploading, Appending, and Merging Spreadsheets
- Uploading Files
- Connecting to Data and Editing Data
- Using Data Preparation Options
- Joining and Blending Data
- Creating Virtual Fields

Working With Data Overview

There are two ways that you can connect to data in Business User Edition. You can upload a Microsoft Excel spreadsheet or CSV file using the Upload wizard, or you can connect to an existing table in a data source of your choice, using the Connect to Data wizard. Both processes begin with identifying and preparing the data that you want to use. After your file or table selection is complete, the wizard shows you the default breakdown of your data as measures, dimensions, and hierarchies.

At similar points during the upload and connect processes, you can access options to transform your data beyond the default settings. This includes joining multiple tables into a cluster to create more fields and expand the scope of a synonym, editing geo roles and geo encoding to prepare the synonym for use in mapping and location analysis, data profiling and statistical analysis, changing columns or groups of columns into rows, and creating new or editing existing field roles.
Once a synonym is complete, you can upload it to a target environment or append it or merge it with an existing synonym. You can also save it as a template to allow repeated transformations if the same file is uploaded again in the future.

Understanding Your Data Structures

When you upload or connect to data in Business User Edition, you create a synonym that can be used to build analytical content. Synonyms define unique names (or aliases) for each object that is accessible from the Reporting Server. Synonyms are useful because they hide the underlying data source location and identity from client applications. They also provide support for extended metadata features of the Reporting Server, such as virtual fields and additional security mechanisms.

Depending on the structure of the synonym that you are creating, the data inside a synonym is typically broken down into categorized roles, such as measures (facts), dimensions, hierarchy levels, and attributes.

A measure or fact is a numeric value, such as Gross Profit or Cost of Goods Sold, that you can aggregate. Numeric fields that cannot be summed, such as product number or order ID, are not categorized as measures. Instead, they may be used in the same way as dimension fields to analyze measures.

A dimension is a way to categorize data or sort output. You can use a dimension to analyze and compare measures. Usually, dimension fields are alphanumeric fields such as Product. Certain dimension fields can be organized into hierarchies to define the relationship between the fields. For example, a Geography hierarchy can contain the Region, Country, State, and City fields.

An attribute is a field or collection of fields that provide additional information about a dimension.

Using the Business View Plus (BV+), you can create a view of your data that represents its business use by creating virtual segments called folders and adding fields to these folders. You have the flexibility to create folders anywhere in the structure, as well as reusing fields in multiple folders. You can then categorize those folders and fields as measures, dimensions, hierarchy levels, or attributes.

Preparing Data for Upload

Uploading data to Business User Edition can be made easier if you familiarize yourself with the data file first and ensure that it is properly formatted for upload, so geographic data, dimensional hierarchies, and other important aspects of your data are recognized. This is important so that the synonym created for your uploaded data provides the basis for quality analytical content.
You can use the following techniques to prepare your data for the uploading process.

**Naming Conventions and Excel Sheet Names**

For Excel spreadsheets, the name of the file is not important but the name of the worksheet that contains your data is used to generate the synonym name. For the best results, follow the guidelines below:

- Ensure that the worksheet name is meaningful. For example, Store Sales is better than Sheet1.
- Remove special characters from the worksheet name. Spaces will be converted to underscores but all non-alphanumeric characters should be removed from the name, such as:
  `/\~!@#$%^()-+=[]\;`,
- Remove or replace NLS characters with standard alphanumeric characters.

The image below shows a worksheet with a meaningful name, Retail Sales.

While you have an opportunity to edit the worksheet name within the Upload wizard, doing it in Excel may be preferable. Note that your spreadsheet data and column titles may contain National Language Support data and special characters.

For CSV files, there is no worksheet name, so the CSV file name is used to generate the synonym name. For this reason, all of the limitations identified for Excel worksheet names apply to the CSV file name. Be sure to check and adjust the file name prior to the upload.
Removing Introductory Information

Sometimes, an Excel spreadsheet contains formatted headings in the first few rows. This information cannot be imported into Business User Edition and should be removed. Delete the introductory rows and save the file before uploading. Alternatively, you can define a data range within your worksheet and leave the introductory information in place. The following image shows an example spreadsheet with a heading and subheadings highlighted.

Placing Column Titles in the First Row

For data to be useful in Business User Edition, your data columns must be identified and properly described in the synonym that is generated during the upload process. You can make this easier by ensuring that the first few rows of your Excel spreadsheet contain column titles that are meaningful to you and to other users who will be using it. An example of meaningful column titles is shown in the following image.

If your spreadsheet has more than one row of column titles, Business User Edition can merge the information when creating the synonym. You will be given an option to specify how many first rows of the Excel file contain title information in the Upload wizard.
Removing Aggregated Information

Excel spreadsheets may contain subtotals, grand totals, and other non-data row information. Data aggregation is performed by Business User Edition, so you should remove these kinds of rows from your spreadsheet and save the file before uploading it.

Using Excel Named Ranges

Data ranges defined within your Excel worksheet can be helpful for the following reasons:

- Your worksheet may have introductory information, such as formatted headings or non-data information, in the first few columns.
- You may not want to import all of the data columns found on your worksheet.

You can define a data range in your worksheet to remove the data that you want Business User Edition to process during upload, and leave your spreadsheet in its original format. An example of this is shown in the following image.

Preparing Hierarchical Data Columns

Business User Edition recognizes columns of data that have hierarchical relationships. This is useful because the field names are arranged more logically in InfoAssist and because it facilitates Auto Drill capabilities in the content. Auto Drill lets you drill up and down a field hierarchy automatically, making the content engaging and useful.
To help Business User Edition recognize hierarchical columns correctly, ensure that the column titles begin with a common word or words and are arranged left-to-right in the correct top-to-bottom direction, as shown in the image below. In the Upload wizard, you can define and edit dimension hierarchies prior to creating the synonym. You can also do this prior to the upload in Excel.

![Image of a spreadsheet showing column titles and data]

Removing Date Formulas

Spreadsheets may contain a date column where the values are computed by Excel using a formula. You need to convert these computed values into simple values before uploading a spreadsheet. To remove date formulas, select a column, right-click, and then click Copy. Then right-click the selected column again, and click Values. This can be found under the Paste Options menu, which is highlighted in the following image. Menu options may vary by Excel release. Now you can see that each cell contains a date value, and Business User Edition can decompose your dates into useful components for use in InfoAssist.

![Image showing the process of removing date formulas and the Paste Options menu]
Uploading, Appending, and Merging Spreadsheets

You can upload, append, or merge Excel spreadsheets or CSV files using the Upload wizard. Before uploading a new file, you should review Preparing Data for Upload on page 320, to ensure that your upload runs successfully.

After you upload a new file, you can append a file by adding new data to an existing synonym, without changing the structure. This option is useful when you are working with a complex or heavily edited synonym, by allowing you to retain all previous edits and data transformations. You can also merge a file with your data and enhance the existing structure.

The procedures in this section provide step-by-step instructions for uploading, appending, and merging files using the default settings in the Upload wizard.

Procedure: How to Upload Excel Spreadsheets

1. Launch the Upload wizard in one of the following ways:

   - On the Home Page, on the actions bar, click Upload Data.
   - In the Open dialog box, in InfoAssist, click Upload Data.

2. Drag the file that you want to upload into the Upload pane or click Select File, and navigate to the location of the file on your machine.

3. On the ribbon, click Load and Next.

   The Target Load Options dialog box opens.

   A dialog box opens.

   Note: By default, the Bulk Load check box is selected. Clear this check box if you do not have a bulk load program that supports your target environment. For example, if you are using Microsoft SQL Server, you may use a Bulk Copy Program (BCP). If you are unsure about whether you have a bulk load program installed, contact your system Administrator.

4. Click Proceed to Load.
If the load is successful, a window opens, and provides options to automatically generate content from your data, create content using the new Master File, or close the Upload wizard, as shown in the following image.

![Window options](image)

**Note:** If there are informational messages or if your upload is unsuccessful, the Status screen opens.

5. Select what you want to do next.

**Related Information:**

**Procedure:** How to Append New Data to an Existing Synonym

1. Launch the Upload wizard.

2. Drag the file containing the data that you want to append into the Upload pane or click *Select File*, and navigate to the location of the file on your machine.

   The next screen in the Upload wizard opens.

3. On the ribbon, click *Load Options*.

   The Target Load Options dialog box opens.

   **Note:** By default, the Bulk Load check box is selected. Clear this check box if you do not have a bulk load program that supports your target environment. For example, if you are using Microsoft SQL Server, you may use a Bulk Copy Program (BCP). If you are unsure about whether you have a bulk load program installed, contact your system Administrator.

4. From the Load Option drop-down list, click *Append to Existing*.

   In the Select Target Synonym dialog box, select the synonym to which you want to append data.
5. Click OK. 
   The Target Load Options dialog box opens.
6. Click OK. 
   The Merge Editor dialog box opens.
7. Click OK. 
8. On the ribbon, click Load and Next.
   If the load is successful, a window opens, and provides options to automatically generate content from your data, create content using the new Master File, or close the Upload wizard.
   **Note:** If there are informational messages or if your upload is unsuccessful, the Status screen opens.
9. Select what you want to do next.

**Procedure:** How to Merge New Data With an Existing Synonym

1. Launch the Upload wizard.
2. Drag the file containing the data that you want to merge into the Upload pane or click Select File, and navigate to the location of the file on your machine.
   The next screen in the Upload wizard opens.
3. On the ribbon, click Load Options.
   The Target Load Options dialog box opens.
4. From the Load Option drop-down list, click Merge into Existing.
   In the Select Target Synonym dialog box, select the synonym to which you want to merge your data.
5. From the If the record exists drop-down list, click the action you want to occur when a record in the new spreadsheet matches a record in the existing data. You can choose to reject the matching record, update the existing record, or delete the existing record. By default, Update the existing record is selected.
6. From the If the record does not exist drop-down list, click the action you want to occur when a record in the new spreadsheet does not match the record in the existing data. You can choose to include or reject the record that does not match the existing record.
Note: By default, the Use Bulk Load to populate and Stage Table + Merge into Target check box is selected. Clear this check box if you do not have a bulk load program that supports your target environment. For example, if you are using Microsoft SQL Server, you may use a Bulk Copy Program (BCP). If you are unsure about whether you have a bulk load program installed, contact your system Administrator.

7. Click OK.

8. In the Merge Editor dialog box, you can make additional changes to how your data is merged, for each column in the spreadsheet.

   You must create at least one matching expression before you load your data.

9. Click OK.

10. On the ribbon, click Load and Next.

   If the load is successful, a window opens, and provides options to automatically generate content from your data, create content using the new Master File, or close the Upload wizard.

   Note: If there are informational messages or if your upload is unsuccessful, the Status screen opens.

11. Select what you want to do next.

### Uploading Files

In addition to creating content using WebFOCUS, you can upload other files, such as images and documents. These files can be used to enhance visualizations and shared with other users and groups.

**Procedure: How to Upload Files From The Actions Bar**

1. Select the domain or folder where you want your uploaded file or files to reside.

2. On the actions bar, click Upload File.

   The Open dialog box opens.

3. Select one or multiples files from your machine and click Open.
The file uploads to your selected directory, and the *Upload completed* message appears, as shown in the following image.

![Upload completed message](image)

4. Close the *Upload completed* message and proceed with using the uploaded file.

**Note:** When you upload an image, such as a .bmp, .jpg, .jpeg, .gif, or .png file, to the repository, an embedded thumbnail of the image automatically generates in the WebFOCUS Explorer. To change the thumbnail that appears in the WebFOCUS Explorer, right-click the thumbnail, and open the Properties panel. Click the *Advanced tab*, and modify the thumbnail.

**Procedure:** How to Upload Files by Dragging to the Explorer

1. Select the domain or folder where you want your uploaded file or files to reside.

---

Online Help PDF 329
2. Drag one or multiple files from your machine directly to the WebFOCUS Explorer, as shown in the following image.

The file uploads to your selected directory and the *Upload completed* message shows the status of each uploaded file. If an upload fails, the error appears in red in the *Upload completed* message, as shown in the following image.

3. Close the *Upload completed* message and proceed with using the uploaded files.
Note: When you upload an image, such as a .bmp, .jpg, .jpeg, .gif, or .png file, to the repository, an embedded thumbnail of the image automatically generates in the WebFOCUS Explorer. To change the thumbnail that appears in the WebFOCUS Explorer, right-click the thumbnail, and open the Properties panel. Click the Advanced tab, and modify the thumbnail.

Connecting to Data and Editing Data

Aside from uploading data, you can create synonyms by connecting to various data sources. The Connect to Data wizard leads you through this process and allows you to establish a connection to many native data sources. The data source being used determines the type of metadata that is required. For example:

- When the server accesses a relational data source, it needs to know how to interpret the data stored there. You must create a synonym that describes the structure of the data source and the server mapping of the data types.

- When the server invokes a transaction or procedure, it needs to know how to build the request, what parameters to pass, and how to format an answer set from the response. You must create a synonym that describes the layout of the request or response area.

Whatever your data source, the adapter you are using manages the synonym creation process for you, creating a synonym that meets your specific requirements.

Note: Although all synonym creation panes have the same look and feel, the parameters are specific to each adapter. To obtain detailed information for an adapter, click the question mark (?) next to a parameter.

Creating a Synonym With the Connect to Data Wizard

The Connect to Data wizard lets you configure adapters that connect to data sources that you can use to build reports, charts, and visualizations. InfoAssist

Using the Connect to Data wizard, you can perform the following in a single environment:

1. Configure Adapters. Configure an adapter, create a new connection, or change connection parameters.

2. Create Base Synonyms. Create a synonym for one or more data objects.

3. Create Cluster Synonyms with BV. Create a cluster synonym for select objects assigned as facts or dimensions.

You can launch the Connect to Data wizard in one of the following ways:

- On the Home Page, on the actions bar, click Connect.
In the portal on the Menu bar, click Resources, right-click a folder or domain on the Resources panel, point to Metadata and then click Edit.

In the Open dialog box, in InfoAssist, click Connect to Data.

Configuring Adapters

The Connect to Data wizard creates a connection to your data, which will allow you to modify your data. You can configure a new adapter or connection, add a connection to an existing adapter, or change adapter connections.

When the Connect to Data wizard opens, it displays a panel for configured adapters and a panel for available adapters, as shown in the following image.

![Configured Adapters](image)

Configured Adapters
Displays all adapters and connections that have been configured. You can create synonyms and cluster business views from this panel, add new or duplicate connections, remove connections, and view and edit properties.

**Available**

Displays all available adapters. If a connection has already been configured for an adapter, a check mark is displayed next to the adapter name. If the adapter has multiple versions, you can select which version to configure when you right-click the adapter name or click its drop-down arrow. You can select a category of adapter to display from a categorical drop-down list. A search option is also available.

**Procedure: How to Configure a New Adapter/Connection**

1. From the Available panel, right-click an adapter name or click the arrow, and click *Configure*.

   **Note:** If the adapter has multiple versions, right-click the adapter name or click the arrow, and select which version to configure.

The Configure Adapter screen opens, as shown in the following image.

2. Enter the parameters for the specific adapter.
3. Click *Test* to test your configuration.
4. Click *Configure*.

   **Note:** Once configured, the adapter displays in the Configured Adapters panel.

**Procedure: How to Add a Connection**

1. From the Configured Adapters panel, right-click an adapter name or click the arrow on an adapter line.
A shortcut menu opens, as shown in the following image.

Note: These menu options are for a SQL adapter. Options may differ for different categories of adapters.

2. Click Add Connection.
3. Enter the parameters for the specific adapter.
4. Click Test to test your configuration.
5. Click Configure.

Procedure: How to Change a Connection
1. From the Configured Adapters panel, right-click an adapter name or click the arrow on an adapter line.
2. Click Change Settings.
3. Change the parameters for the specific connection and click Configure.

Creating Synonyms
You can enter all the parameters needed to create base synonyms or create a cluster synonym on a single page.

Procedure: How to Create a Synonym
1. From the Configured Adapters panel, right-click a connection name or click the arrow on a connection line.
A shortcut menu opens, as shown in the following image.

![Configured Adapters](image)

**Note:** These menu options are for a SQL adapter. Options may differ for different categories of adapters.

2. Click *Show DBMS objects* from the shortcut menu.

The Available Objects page opens, as shown in the following image.

![Available Objects](image)

3. Select from the Available Objects parameters.
4. From the Action dropdown, select *Create Cluster Synonym with BV* (default) or *Create Base Synonyms* as shown in the following image.

![Available Objects for MS SQL Server OLE DB (9999_me2014_retail)](image)

**Procedure:** How to Create a Cluster Synonym with BV

1. Click *Create Cluster Synonym with BV* from the Action dropdown.

2. Manually select objects as Facts and Dimensions for which you want to create a cluster synonym. To automatically select Facts and Dimensions, proceed to step 3. Otherwise proceed to step 5.

3. Right-click a fact or dimension table name or click the arrow next to a fact or dimension table name and select *Show Related Dimensions*.

   **Note:** Option only for Relational data sources if Foreign Key to Primary key information is available in the RDBMS.
A report of related dimensions displays, as shown in the following image.

4. Right-click a fact or dimension table name or click the down arrow next to a fact or dimension table name and select Add Related Dimensions.

Note: Option only for Relational data sources if Foreign Key to Primary key information is available in the RDBMS.
All related dimensions are selected automatically, as shown in the following image.

5. Click Next to Cluster Business View on the ribbon.
Your cluster selection displays, as shown in the following image.

6. Enhance your cluster synonym from the panels or ribbon as needed.
7. Click Save and Next on the ribbon.
8. Change the cluster name in the File Name field of the Save As dialog box if needed.
9. Click OK.

**Procedure:** How to Create a Base Synonym

1. Select Create Base Synonyms from the Action dropdown.
2. Select check boxes of the objects for which you want to create synonyms, as shown in the following image.

Available Objects for MS SQL Server OLE DB (9999_ms2014_retail)

- **Object Type**: Tables
- **Database**: Default Database
- **Owner/Schema**: dbo
- **Object Name**: Sample abc
- **Search**

<table>
<thead>
<tr>
<th>Database: bigcsm06b (Default)</th>
<th>Row Limit</th>
<th>50</th>
</tr>
</thead>
<tbody>
<tr>
<td>wrd_wf_retail_age</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_currency</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_customer</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_discount</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_education</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_employees</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_geography</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_income</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_industry</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_labor</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_labor_rate</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_marital_status</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_occupation</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_product</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_sales</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_shipments</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_shipping_options</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_store</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_time</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_time_life</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
<tr>
<td>wrd_wf_retail_vendor</td>
<td>dbo</td>
<td>TABLE</td>
</tr>
</tbody>
</table>

3. Select **Next to Base Synonyms** on the ribbon. Your synonym selection displays, as shown in the following image.
4. Enhance your base synonym from the panels or ribbon as needed.
5. Click *Save and Next* on the ribbon.
6. Change the base synonym name in the *File Name* field of the *Save As* dialog if needed.
7. Click *OK*.

**Editing And Deleting Metadata**

You can edit or delete previously created synonyms in one of the following ways:

- On the Home Page, on the actions bar, click *Metadata*.
- In the portal on the Menu bar, click Resources, right-click a folder or domain on the Resources panel, point to *Metadata* and then click *Edit*.

The Applications page opens, from which you can edit or delete your synonym.

**Procedure:** How to Edit a Synonym

1. From the Applications page, in the Application Directories tree, left-click a folder to expand it, then right-click a procedure or metadata file in the file panel and select *Open*, as shown in the following image.

![Image](image-url)

The Data Assist opens, where you can modify your synonym.
**Note:** When you open an existing synonym in this way, the Master File opens in 
BV_NAMESPACE=OFF or BV_NAMESPACE=ON mode, depending on the existing BV or DV 
structure.

2. Make edits to the synonym, as required.
3. To save your synonym, click *File*, and then click *Save*.

**Procedure:** **How to Delete Metadata**

1. Right-click the synonym that you want to delete, point to *Data Management*, and then click *Delete All Data*.
   
   A confirmation window opens, alerting you that you are deleting every row of data.
2. Click *OK* to proceed.
3. To remove the synonym file from the view, right-click this synonym again and then click *Delete*.

**Using Data Preparation Options**

The Upload wizard and Connect to Data wizard offer a suite of data preparation options, which 
are designed to help you prepare your data for future analytics. With these data preparation 
tools, you can assess your data for validity and consistency, troubleshoot errors, and enhance 
accuracy and uniformity of your data. The following sections describe these options and 
explain how to use them.

**Creating Clusters**

When you need to add more tables to your synonym, you can use the Join feature to create a 
cluster. This allows you to enhance the structure of your synonym by introducing more data.

**Procedure:** **How to Create a Cluster**

1. When uploading data or connecting to data on the main metadata screen, on the ribbon, 
   click *Join Editor*.
   
   The Join Editor view opens.
2. Click *Insert Child*.
   
   The Insert Child dialog box opens.
3. Click a Master File from the list, select a synonym, and then click *OK*. You can select 
   several synonyms at once.
An example of a completed cluster is shown in the following image.

4. Close the Join Editor dialog box.
   The new columns are added to the Table/Column pane.
5. Drag columns to the Business View pane to modify the synonym.

Pivoting Repeating Columns Into Rows

Some Excel spreadsheets may contain repeating columns, such as sales figures for a series of years. There may even be repeating column groups, such as both budget and actual figures for a series of years. You can use the pivot option to transform these columns or groups of columns into rows.

**Procedure: How to Pivot Columns Into Rows**

1. When uploading data or connecting to data on the main metadata screen, on the ribbon, click Pivot.
   The Pivot Columns to Rows dialog box opens.
2. Set the Pivot Type option to Repeating column.
3. In the First column drop-down box, select the first column in the range of repeating columns.
4. In the Last column drop-down box, select the last column in the range of repeating columns.

5. In the Column Title for Pivoted Data, type the new column title that reflects the numeric cell that you are describing.

6. In the Title for Pivoted Key field, type the new column title that represents the repeating columns that you are pivoting into rows.

7. Leave the Formula for Pivoted Key field value unedited. This value is automatically generated by the wizard, it should not be changed.

An example of the completed configuration for pivoting columns is shown in the following image.

![Pivot Column(s) to Rows in synonym years](image)

8. Click OK.

The repeating columns now display as rows. The Pivot button turned into the Remove Pivot button, allowing you to quickly revert your pivoting changes.

**Procedure: How to Pivot Column Groups into Rows**

1. When uploading data or connecting to data on the main metadata screen, on the ribbon, click *Pivot*.

   The Pivot Columns to Rows dialog box opens.

2. Set the Pivot Type option to *Repeating group of columns*.

3. In the Number of groups field, specify the number of groups of columns that you are pivoting.

4. In the Column Title for Pivoted Data, type the new column title that will be used for all the columns across the repeating groups.

5. In the Title for Pivoted Key field, type the new column title that represents the repeating columns that you are pivoting into rows.
6. Edit the automatically generated formula in the Formula for Pivoted Key field by clicking the ellipsis button. Make sure there are no repetitive alphanumeric values in the Pivoted Column field.

An example of the completed configuration for pivoting groups of columns is shown in the following image.

![Pivot Column(s) to Rows in synonym groups](image)

7. Click OK.

The repeating groups of columns now display as rows. The Pivot button turned into the Remove Pivot button, allowing you to quickly revert your pivoting changes.

**Creating Folders and Assigning DV Roles**

When using BV+, specifically when you are working in a Business View, you can create folders to organize your data. Folders function as segments to provide a view of the synonym and define the accessible fields and their relationships. Folder relationships are the same as segment relationships, with parent folders, child folders, and sibling folders. Once you create a new folder, you can add data fields and assign roles.
You can create a new folder by right-clicking a folder or field, clicking Manage Folders, and then clicking New Folder, as shown in the following image.

Assigning DV Roles

While you have total flexibility defining a structure using any fields from your data source, when you issue a report request against the synonym, the retrieval path for the data must conform to any constraints imposed by your DBMS entity diagrams and by the rules of retrieval.

By default, a Dimension View structure is defined within folders in the Business View pane. You can add either additional Dimension View nodes or folders to this structure.

You can assign a DV role to a folder or field by right-clicking the folder or field and assigning a DV role. The following image shows the context menu and options for a folder.

You can explicitly assign a DV role to a folder or field, or have it automatically inherit its role from its parent. If you explicitly assign a DV role, that role moves with the object if you drag it to another location within the BV+ structure. If you do not explicitly assign a DV role, the role changes as you move the object under a new parent, except if you drop it onto a field with the Drill Level role. If dropped onto a Drill Level field, the moved field inherits the Drill Level role.
You can assign the following DV roles.

**Dimension.** A dimension field, when double-clicked or dragged onto the report or chart canvas, is automatically added to the request as a vertical (BY) sort field.

A folder can be assigned the role Dimension.

A field can be assigned the role Dimension (Standalone) or Dimension (Drill Level). When it is assigned the role Dimension (Drill Level), it becomes part of a hierarchy, where the levels depend on the order of the fields in the folder. Then, when AUTODRILL is turned on, automatic drill-downs are created in the report or chart output.

A folder can contain only one drill level hierarchy. However, you can use the same fields in multiple hierarchies by placing each hierarchy in a separate folder. A folder with a drill level hierarchy is not limited to just the hierarchy. It can contain other fields with different DV_ROLEs.

**Measure.** A measure field, when double-clicked or dragged onto the report or chart canvas, will automatically be added to the request as an aggregated value (SUM), if it is numeric. If it is alphanumeric, it will be added as a vertical (BY) sort field. A folder or field can be assigned the role Measure.

**Attribute.** An attribute field, when double-clicked or dragged onto the report or chart canvas, will automatically be added to the request as an aggregated value (SUM), if it is numeric, or as a vertical sort field (BY), if it is alphanumeric.

**Folder.** A folder is a virtual segment in a BV+. It can be assigned the roles Dimension, Measure, or Attribute.

**Note:** When a folder is inserted as a child of a field, the attribute PARENT_FIELD describes this relationship. By default, such a folder and its fields will be assumed to have the Attribute role.

## Joining and Blending Data

You can join two or more related data sources to create a larger integrated data structure from which you can report in a single request. The joined structure is virtual. It is a way of accessing multiple data sources as if they were a single data source. This can greatly increase the number of fields available for use in your content, giving you an expanded selection for your reporting and charting purposes.
Using conditional joins, you can establish joins based on conditions other than equality between fields. In addition, the host and cross-referenced join fields do not have to contain matching formats, and the cross-referenced field does not have to be indexed.

**Note:** You can edit the description of a join by clicking *Edit* in the Join dialog box and typing in the Description section. You can only use letters, numbers, and underscores in your description. No special characters are allowed.

The conditional join is supported for FOCUS and all relational data adapters. Because each data source differs in its ability to handle complex conditional criteria, the optimization of the WHERE syntax differs depending on the specific data sources involved in the join and the complexity of the conditional criteria.

For FOCUS data sources, if the host and cross-referenced join fields do not have common matching formats, the following message appears.

![Where-Based Join](image)

**Note:** If you click Yes, the Filter dialog box opens, where you can create a Where-Based Join.

If the cross-referenced join field does not have an index, the following message appears.

![Where-Based Join](image)

**Note:** If you click Yes, the Filter dialog box opens, where you can create a where-based join.
Blending Data

The blend option allows you to explicitly select the data fields that you want to include. More specifically, you can join multi-fact data structures and combine pertinent external data into your current data source, creating a blended data resource. This can be from local or other system resources.

Blending is used to create customized data sources. For example, you may have some of the basic fields available in the current data source, but you can use the blend option to add relevant data fields from a different data source to the current data source in order to create a unique data set.

The blend option allows a new fact table to be added to a cluster master as a parent segment to an existing child segment. This option is available from the Join dialog box. You may want to blend data if you are reporting from two different fact tables that share a common dimension, such as a product dimension. For an example of this, you can view the sample retail database, wf_retail_lite. The wf_retail_lite Master File contains the WF.RETAIL_STORE_SALES segment and the WF.RETAIL_SALES segment. The WF.RETAIL_SALES segment is defined as the parent of the WF.RETAIL_STORE_SALES segment. You may want to add a second fact table to the report. The second fact table in this example will be an Excel spreadsheet that you upload to InfoAssist for use with a report or chart. The data in the spreadsheet file that you upload will be joined to the WF.RETAIL_LITE database using a common field.

Note: You can find supported, common fields in your selected database (for example, WF.RETAIL_LITE) using the search feature in the Data pane. If necessary, you may need to add a field in your spreadsheet to map your data to the structure of the database. For example, ID_CUSTOMER. In addition, the name of the primary sheet in Microsoft Excel becomes the name of your data source, so be sure to name the file accordingly.

The following list provides some general rules that apply to the Blend option:

1. The result of blending is that a single dimension is shared between two fact tables. The table must be based on a cluster with at least two segments. One segment is for Fact table 1, the second segment is for the dimension.
2. Two uploaded files cannot be blended because they result in single segment Master Files.
3. Do not use the fields from the blended table as a sort field, since these fields will not have common field when used with fields from other fact tables.

Procedure: How to Blend Data

This procedure describes how to blend data from an external data source into an existing data source. This example uses a Microsoft Excel spreadsheet file.

1. On the Data tab, in the Join group, click Join.
The Join dialog box displays.

2. Click Add New.

The Open dialog box displays.

**Note:** The options that display on the Open dialog box depend on your user privileges.

3. At the top of the Open dialog box, click Upload Data.

The Upload wizard opens.

4. Drag your Microsoft Excel spreadsheet file on to the Upload pane, or click Select Upload File to locate the file on your local drive.

The next screen of the Upload wizard opens. You can use the options on this screen to preview and change spreadsheets and delimited data files before you upload them to the target environment. This screen shows you the default breakdown of your data as measures, dimensions, and hierarchies.

5. On the ribbon, click Load and Next.

The Target Load Options dialog box opens.

**Note:** In Business User Edition, the default target for the Upload Wizard is Hyperstage, which is configured with a bulk load feature. If you change your target environment from the default, and do not have a bulk load program that supports this environment, you may need to clear the Bulk Load check box. For example, if you are using Microsoft SQL Server, you may use a Bulk Copy Program (BCP). If you are unsure about whether you have a bulk load program installed, contact your system administrator.

6. Click Proceed to Load.

The Upload wizard closes, and you return to the Open dialog box.

**Note:** If there are informational messages or if your upload is unsuccessful, the Status screen opens.

7. In the Open dialog box, click the name of your uploaded data source and then click Open.

8. In the Join dialog box, create a connection between the common fields by dragging your mouse pointer from the field in the Master File to the common field in the newly uploaded file.

9. Click Blend, and then click OK.

The blended data source fields are now available in the Data pane.
Creating Virtual Fields

A temporary field is a field whose value is not stored in the data source, but can be calculated from the data that is there, or assigned an absolute value. A temporary field takes up no storage space in the data source, and is created only when needed. DEFINE fields and COMPUTE fields are two different types of temporary fields.

When you create a temporary field, you determine its value by writing an expression. You can combine fields, constants, and operators in an expression to produce a single value. For example, if your data contains salary and deduction amounts, you can calculate the ratio of deductions to salaries using the following expression: deduction / salary.

You can specify the expression yourself, or you can use one of the many supplied functions that perform specific calculations or manipulations. In addition, you can use expressions and functions as building blocks for more complex expressions, as well as use one temporary field to evaluate another.

Note: When creating a DEFINE or a COMPUTE field, the following characters are suppressed and cannot be entered in the Format text box.

```
space ! " # $ & ' ( ) * + , / : ; < = > ? @ \ ] ^ _ ` { | } ~
```

Selecting a Temporary Field

The following information is provided to help you choose the kind of temporary field that you need.

- **Choose a virtual field** when you want to:
  - Use the temporary field to select data for your report. You cannot use a calculated value, since it is evaluated after data selection takes place.
  - Use the temporary field to sort on data values. A calculated value is evaluated after the data is sorted. With the BY TOTAL phrase, you can sort on this type of field.

- **Choose a calculated value** when you want to:
  - Evaluate the temporary field using total values or prefix operators (which operate on total values). You cannot use a virtual field, since it is evaluated before any totaling takes place.
  - Evaluate the temporary field using fields from different paths in the data structure. You cannot use a virtual field, since it is evaluated before the relationship between data in the different paths is established.
A virtual field (DEFINE) is evaluated as each record that meets the selection criteria is retrieved from the data source. The result of the expression is treated as though it were a real field stored in the data source.

The calculation that determines the value of a virtual field is performed on each retrieved record that passes any screening conditions on real fields.

You can define a virtual field in the following ways:

- **In a Master File.** These virtual fields are available whenever the data source is used for reporting. These fields cannot be cleared by JOIN or DEFINE FILE commands.

- **In a procedure.** A virtual field created in a procedure lasts only for that procedure.

A DEFINE field is an optional attribute used to create a virtual field for reporting. You can derive the virtual field value from information already in the data source (that is, from permanent fields).

You may define fields simultaneously (in addition to fields defined in the Master File) for as many data sources as desired. The total length of all virtual fields and real fields cannot exceed 32,000 characters.

The Detail Field (DEFINE) dialog box allows you to create a defined field, type a name for the field, and enter a format.

The Detail (DEFINE) dialog box is shown in the following image.
Note: If the order or dependencies within your DEFINE fields changes, InfoAssist will now automatically reorder these fields to ensure they can be correctly processed. Any revisions in the order of the fields will not change how they are presented in the field tree, but can be verified using the View Code option on the Quick Access toolbar or by editing the procedure on the WebFOCUS Home Page.

Summary (COMPUTE)

A calculated value (COMPUTE) is evaluated after all of the data that meets the selection criteria is retrieved, sorted, and summed. Therefore, the calculation is performed using the aggregated values of the fields. Calculated values are available only for the specified report request. You specify the COMPUTE command in the body of the report request, following the display command and optionally, introduced by AND. You can compute more than one field with a single COMPUTE command.

The Summary Field (COMPUTE) dialog box allows you to create a computed field, type a name for the field, and enter a format.

The Field List provides similar functionality, including options to display data source fields in a Logical, List, or Structured view. You can also view a complete set of functions, instead of data source fields, by clicking the Functions button.

Using Field Titles in a DEFINE or COMPUTE

When working with Defines and Computes, field titles automatically display as you build your criteria in the Define (or Compute) text area.

Field titles are an attribute of a field. They are defined in the metadata and display only when specified for the field that you select. If a field title has not been defined in the metadata, the title that displays will be the physical field name.
The Use field titles feature enables you to see the field title (for example, Cost of Goods) rather than the fully qualified name of the field (for example, WF_RETAL_LITE.WF_RETAL_SALES.COGS_US). This facilitates easy identification of field names while building your Define or Compute. You can switch between the display of field titles and fully qualified field names by unchecking the Use field titles option, which you can access by clicking Additional Options, as shown in the following image.
If your Define or Compute uses more than one field with the same title (for example, Sale,Year), then only the first field will be added using field titles. Any other reference to this identical field will use the fully qualified field name. For example, in a sample InfoAssist data source, Sale,Year displays as the field title for two unique fields: WF_RETAIL_LITE.WF_RETAIL_TIME_SALES.TIME_YEAR and WF_RETAIL_LITE.WF_RETAIL_TIME_SALES.TIME_DATE_YEAR_COMPONENT. In this case, only WF_RETAIL_LITE.WF_RETAIL_TIME_SALES.TIME_YEAR would display (using field titles) as Sale,Year. The other field would display using the fully qualified field name, as shown in the following image.

**Procedure:** How to Use Field Titles in a Define or Compute

1. In Report or Chart mode, create a Define or a Compute.
2. Add fields by double-clicking them in the metadata tree.

   **Note:** The fields that you select display with field titles, as this is the default option. If you specify a field with a duplicate field title, the fully qualified field name is used for the second (and any subsequent) instance.

3. Click *Additional Options* and then click *Use field titles* to disable the use of field titles, which results in the display of fields using the fully qualified field name.
Resizing the Text Area of a Define or Compute

When working with Defines and Computes, you can adjust the width of the text area to accommodate the size of the fields in your query. This is particularly useful if you are using fully qualified names or long formulas, which can span more than the standard width of the text area.

In its original state, the text area is aligned with the calculator, as shown in the following image.
Procedure:  How to Resize the Text Area of a Define or Compute

1. Open InfoAssist in Report or Chart mode.
2. Select a Master File.
3. On the Data tab, click Detail (Define) or Summary (Compute).
   The Define or Compute dialog box displays, respectively.
4. Hover over the right border of the text area until double arrows display.
5. Click and drag the field to the right.

The text area is resized.

Note:

- If you expand the text area in a current session, InfoAssist will retain that expanded state for use in other areas of the application. For example, if you expand the text area when creating a Define, the expanded state will be present when you create a Compute.

- When working with the text area in an expanded state, you can reinstate the metadata tree and toolbar by hovering over the right border of the text area until double arrows displays. Click and drag the arrows to the left and right, as needed.
Creating Temporary Fields Independent of a Master File

The temporary fields that you create with the DEFINE and COMPUTE commands are tied to a specific Master File, and in the case of values calculated with the COMPUTE command, to a specific request. However, you can create temporary fields that are independent of either a Master File or a request using the DEFINE FUNCTION command.

A DEFINE function is a named group of calculations that use any number of input values and produce a return value. When calling a DEFINE function, you must first define the function.

A DEFINE function can be called in most of the same situations that are valid for Information Builders-supplied functions. Data types are defined with each argument. When substituting values for these arguments, the format must match the defined format. Alphanumeric arguments shorter than the specified format are padded with blanks, while longer alphanumeric arguments are truncated.

All calculations within the function are done in double precision. Format conversions occur only across equal signs (=) in the assignments that define temporary fields.

Enabling the Display of Missing Values for a DEFINE or COMPUTE

When working with DEFINEs and COMPUTEs, you can use the Missing Values option to enable or disable the display of missing values for a DEFINE or COMPUTE field. This allows you to accurately display missing values in reports, charts, and visualizations. The Missing Values option, which is accessible through the Additional Options button, is shown in the following image.
The following descriptions explain each option on the Missing Values drop-down list:

- **Off.** When selected, MISSING syntax is removed from the DEFINE or COMPUTE field definition. This is the default selection. MISSING treats missing values for numeric fields as zeros and missing values for alphanumeric fields as blanks.

- **On.** When selected, MISSING ON is added after the format in the DEFINE or COMPUTE field definition. MISSING ON interprets the temporary field as missing.

- **On All.** When selected, MISSING ON ALL is added after the format in the DEFINE or COMPUTE field definition. MISSING ON ALL indicates that if all fields in the expression have values, then the temporary field has a value. If at least one field in the expression has a missing value, the temporary field also has a missing value.
Creating Content

Create reports, documents, charts, and interactive visualizations using the available features and functionality.

In this chapter:

- Generating Sample Content
- Using Navigation Options for Reports
- Creating Reports
- Creating Maps to Illustrate Trends
- Creating Charts
- Building InfoMini Applications
- Using Insight to Analyze Dynamic Charts
- Viewing Data Behind Visuals
- Selecting a Chart Type
- Creating HOLD Files
- Creating Your Own Chart Types
- Creating Shortcuts and URLs
- Building a Document
- Creating Blogs
- Creating Multi-Page Documents
- Working With Portal Pages
- Building Visualizations
- Working With the Business User Edition Portal
- Creating Matrix Charts
- Using WebFOCUS Designer
- Using Active Technologies
- Creating Report Queries With InfoAssist
- Ribbon Command Reference

Generating Sample Content

This topic describes how to generate sample content from uploaded or existing data using the Samples Generator. It also provides information about how to interpret and analyze the sample content.
Generating Sample Content Overview

The Samples Generator automatically generates a suite of analytic content based on uploaded Excel workbooks, CSV files, or existing single-segment Master Files in your repository. The Samples Generator populates your directory with sample charts, reports, and dashboards. Additionally, the suite contains charts and reports that provide quick and easy navigation through the levels of each available hierarchy. You can view, edit, or delete this content, or use it as a starting point to create new dashboards.

The Samples Generator feature is useful to the novice user, because it introduces all major analytic content types in the InfoAssist toolset. Depending on the structure of your source worksheet or synonym, the Samples Generator automatically creates the following items:

- **Active dashboards:**
  - Initial Dashboard
  - Initial Dashboard by Year
  
  **Note:** This item is only generated if your source dataset includes an eligible date, which contains data for minimum three unique months.

- **Reports:**
  - Auto-drill report starting at the top of each identified hierarchy
  - Overview accordion report
  - Overview active report

- **Charts:**
  - Pie chart
  - Bar chart
  - Line chart
  
  **Note:** Line charts are only created if your source dataset includes an eligible date, which contains data for minimum three unique months.

The dashboards, auto-drill reports, overview accordion report, and overview active report are stored in the Analytics folder. All other items are placed in the folders that are named after the measures for which they are created. The content may vary depending on the structure and size of your synonym.
To see the most complete suite of analytical content, it is recommended that you use a data source that contains at least four measures, six dimensions, and data for a minimum of three unique months. Additionally, a record count called Trans appears in the sample content, if there are not sufficient measures available for analysis.

**Note:** Virtual fields, such as COMPUTE and DEFINE, are not eligible for selection as dimensions or measures in the generated content.

The following image shows an example the suite of sample content generated from a synonym on the Home page.

![WebFOCUS Home Page](image)

**Note:** If you generate sample content more than once from the same source worksheet or synonym in the same location, the Samples Generator creates a new folder with an underscore and number appended to the title. For example, if a retail_sample folder already exists in a domain or folder, a new folder with the new set of content is created and titled retail_sample_1. The number is incremented each time you repeat this action.

You can generate sample content from one of the following ways:

- By navigating to the Sample Content option on the Home page, for access to existing data.
- By uploading an Excel spreadsheet or CSV file and selecting the Gain Insight option at the end of the upload procedure.

**Procedure:** How to Generate Sample Content From the Home Page

1. On the Home page, select a domain or folder, and then click Sample Content. The Open dialog box opens.
**Note:** Only single-segment Master Files are displayed for selection.

2. Locate a single-segment Master File that you want to use for generating sample content and click **Open**.

   The new folder with the same name as your Master File appears in your chosen directory. It contains sample charts, reports, and dashboards.

**Procedure: How to Generate Sample Content From the Upload Wizard**

1. Upload a spreadsheet, as described in *Uploading, Appending, and Merging Spreadsheets* on page 325.

   After the Upload procedure is complete, a selection screen opens, as shown in the following image.

   ![Selection Screen](Image)

   **Note:** Generating sample content on Master Files uploaded to a temporary folder, such as FOCCACHE, may produce unexpected results.

2. Click **Automatically generate content from your data**.

   The sample content is generated in the same folder that you selected for your upload.
Analyzing Sample Content

The following section provides a closer look at each content type, and explains how this content is generated. These examples have been generated using the retail_data_extract.xlsx spreadsheet that is provided with your installation.

Initial Dashboard by Year

The Initial Dashboard gives you a quick overview of your data. It is comprised of three charts and one report, as shown in the following image. Additionally, it displays a drop-down menu, which allows you to narrow down your results to a specific year. The Initial Dashboard by Year is only generated if your source worksheet or synonym includes an eligible date, which contains data for a minimum of three unique months.

The bar chart is generated from the first measure and first dimension in the source spreadsheet or synonym. It shows the Top 10 values.

The first pie chart is generated from the second measure and second dimension. It shows the Top 5 values.
The second pie chart is generated from the third measure and third dimension. It shows the Top 5 values.

The active report shows an overview of all measures and dimensions in the source worksheet or synonym.

**Initial Dashboard**

The Initial Dashboard is identical to the Initial Dashboard by Year, with the exception that the year drop-down menu is not displayed.

**Auto-drill reports**

The auto-drill reports are generated for each of the identified hierarchies in the synonym. For example, if your data set contains three hierarchies, the Samples Generator automatically creates three auto-drill reports and one overview auto-drill report. In each auto-drill report, the first four measures in the data set will be summed up by the dimension values in the hierarchy. The report also features data bars and grand totals for each dimension in the hierarchy. The name of the hierarchy is reflected in the title of the report. For example: Dimension_Auto_Drill_Report.fex where Dimension is the top level of the hierarchy. The following image shows an example of an Overview Auto-Drill Report.
Click one of the links to drill-down to the lower level, as shown in the following image. You can use the breadcrumbs to navigate back to the original report.

**Overview Accordion Report**

The Overview Accordion Report provides a way to control the amount of sorted data that appears on a page with the expandable views of data for each vertical sort field. It contains up to three dimensions and the first four measures that are found in your source synonym. The report displays the total values for each measure. The following image shows an example of an Overview Accordion Report.
Overview Active Report

The Overview Active Report contains one BY field for each dimension. The report displays a maximum of six dimensions and four measures. The total values are displayed for each measure. Each field features a drop-down menu, where you can access active report options. The Overview Active Report is always generated and resides in the Analytics folder. The following image shows an example of an Overview Active Report.

<table>
<thead>
<tr>
<th>Country</th>
<th>Product Category</th>
<th>State</th>
<th>City</th>
<th>Quarter</th>
<th>Revenue</th>
<th>Cost of Goods</th>
<th>Gross Profit</th>
<th>Quantity Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Australia</td>
<td>'stools'</td>
<td>New South Wales</td>
<td>Sydney</td>
<td>4</td>
<td>3,907</td>
<td>2,053</td>
<td>1,314</td>
<td>15</td>
</tr>
<tr>
<td></td>
<td>'oletter'</td>
<td>New South Wales</td>
<td>Sydney</td>
<td>4</td>
<td>4,057</td>
<td>2,503</td>
<td>1,564</td>
<td>10</td>
</tr>
<tr>
<td></td>
<td>'aplayer'</td>
<td>New South Wales</td>
<td>Sydney</td>
<td>4</td>
<td>4,315</td>
<td>2,917</td>
<td>1,398</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>'g Systems'</td>
<td>New South Wales</td>
<td>Sydney</td>
<td>4</td>
<td>11,006</td>
<td>9,053</td>
<td>2,003</td>
<td>35</td>
</tr>
<tr>
<td></td>
<td>'r Production'</td>
<td>New South Wales</td>
<td>Sydney</td>
<td>4</td>
<td>12,152</td>
<td>9,431</td>
<td>2,721</td>
<td>51</td>
</tr>
<tr>
<td></td>
<td>'r Sales'</td>
<td>New South Wales</td>
<td>Sydney</td>
<td>4</td>
<td>1,698</td>
<td>1,265</td>
<td>493</td>
<td>7</td>
</tr>
<tr>
<td></td>
<td>'r Email'</td>
<td>New South Wales</td>
<td>Sydney</td>
<td>4</td>
<td>47,881</td>
<td>32,973</td>
<td>14,908</td>
<td>171</td>
</tr>
<tr>
<td></td>
<td>'r Print'</td>
<td>New South Wales</td>
<td>Sydney</td>
<td>2</td>
<td>39,560</td>
<td>21,101</td>
<td>9,459</td>
<td>113</td>
</tr>
<tr>
<td></td>
<td>'r Export'</td>
<td>New South Wales</td>
<td>Sydney</td>
<td>3</td>
<td>29,204</td>
<td>19,379</td>
<td>9,905</td>
<td>183</td>
</tr>
<tr>
<td></td>
<td>'r Export'</td>
<td>New South Wales</td>
<td>Sydney</td>
<td>4</td>
<td>41,082</td>
<td>28,926</td>
<td>12,756</td>
<td>158</td>
</tr>
<tr>
<td></td>
<td>'r Print'</td>
<td>New South Wales</td>
<td>Sydney</td>
<td>1</td>
<td>30,320</td>
<td>22,709</td>
<td>14,521</td>
<td>145</td>
</tr>
<tr>
<td></td>
<td>'r Print'</td>
<td>New South Wales</td>
<td>Sydney</td>
<td>2</td>
<td>34,841</td>
<td>22,811</td>
<td>12,230</td>
<td>186</td>
</tr>
<tr>
<td></td>
<td>'r Print'</td>
<td>New South Wales</td>
<td>Sydney</td>
<td>3</td>
<td>33,290</td>
<td>20,795</td>
<td>12,465</td>
<td>129</td>
</tr>
<tr>
<td></td>
<td>'r Print'</td>
<td>New South Wales</td>
<td>Sydney</td>
<td>4</td>
<td>44,744</td>
<td>29,176</td>
<td>15,568</td>
<td>148</td>
</tr>
<tr>
<td></td>
<td>'r Print'</td>
<td>New South Wales</td>
<td>Sydney</td>
<td>1</td>
<td>35,542</td>
<td>25,216</td>
<td>10,332</td>
<td>104</td>
</tr>
</tbody>
</table>
Pie Charts

The Samples Generator uses the first four measures to create Pie charts, by pairing these measures with up to three different dimensions found in the source synonym. Each pie chart shows the Top 10 values. The number of pie charts may vary depending on your synonym structure. The following image shows an example of a pie chart created by the Samples Generator.
**Bar Charts**

The Sample Generator creates bar charts for each measure paired with up to three different dimensions. Each bar chart shows all values in the dataset for that dimension. If there are more values than can be displayed on the screen, a scrollbar appears. The number of bar charts may vary depending on the structure of your synonym. The following image shows an example of an automatically generated bar chart.

![Revenue by Product Category Chart](chart.png)
Line Charts

Line charts are only generated if your source dataset includes an eligible date, which contains data for a minimum of three unique months. If this data is present in the dataset, a line chart is created for each measure. The following image shows an example of a line chart.

Creating Reports

You can use the following procedures to create a basic report.

Procedure: How to Create a Report From the Portal

After you have signed in to WebFOCUS Business User Edition, you can work with an existing Domain folder, or create a new Domain folder on the Home page to store your reports.

1. On the Home page, select a folder or domain where you want to create your content.
2. On the actions bar, click Report.
   InfoAssist opens.
3. From the Open dialog box, select the data source that you want to use, and click OK.
   The data source that you selected appears in the Data pane.
4. Drag fields onto the canvas or into the Query pane to begin building your report.
**Procedure:** How to Create a Report From the Application Main Menu

1. In the upper-left corner of the InfoAssist interface, click the IA button to open the Application Main Menu.
2. From the Application Main Menu, click New.
   The InfoAssist splash screen opens.
   The Open dialog box opens.
4. From the Open dialog box, select the data source that you want to use, and click Open.
   The data source that you selected appears in the Data pane of the Resources panel.
5. Drag fields onto the canvas or into the Query pane to begin building your report.

**Procedure:** How to Create a Report From the Quick Access Toolbar

1. On the Quick Access Toolbar, click the New icon.
   The InfoAssist splash screen opens.
   The Open dialog box opens.
3. From the Open dialog box, select the data source that you want to use, and click Open.
   The data source that you selected appears in the Data pane of the Resources panel.
4. Drag fields onto the canvas or into the Query pane to begin building your report.

**Procedure:** How to Create a Report From an Existing Chart

1. Open the chart that contains the data that you want to present in a report.
   The data is presented as a report.

**Choosing a Report Output**

The following output types are available for reports:

- HTML
- active report
- PDF
Note: When you create a report in Document view, you have access to Excel only.

When you create a report in Live Preview or Query Design view, you have access to the following Excel output types:

- **Excel (xlsx)**. Outputs the report in Excel 2007 (and higher) format.
- **Excel**. Outputs the report in Excel format.
- **Excel Formula (xlsx)**. Outputs the report, using Excel formulas that calculate and display the results of any type of summed information, such as column totals, row totals, and subtotals. This format is for Excel 2007 (and higher).
- **Excel Formula**. Outputs the report, using native Excel formulas for totals and computed values.
- **Excel (csv)**. Outputs the report to .csv format. This enables you to capture your data and work with it in an external program, such as Microsoft Excel.

### Downloading InfoAssist Report Data to Excel (CSV) Format

When working with data in a report, you can download it into Excel (CSV) format. This enables you to capture your data and work with it in an external program, such as Excel.

When you use the File option to create a HOLD file from your report the output file is placed on the WebFOCUS reporting server. For users who do not have access to their reporting server this approach allows the data to be delivered directly to their desktops.

**Note:** You can select the Excel (CSV) output format in User Preferences, if you want to make this output format the default for each time you enter InfoAssist.

### Procedure: How to Download InfoAssist Report Data to Excel (CSV) Format

1. Open InfoAssist in Report mode.
2. Create a report.
3. On the ribbon, in the Output File Format list, click the right arrow next to Excel (xlsx) and then select Excel (csv), as shown in the following image.

4. On the Quick Access toolbar, click Run to run the report. The CSV will be presented for download using the standard interface of your specific browser interface.

Using Procedure Settings

Procedure Settings, also known as SET commands, enable you to specify and control items for inclusion in a procedure. If you want to include a Procedure Setting in a procedure (.fex), select the relevant check box to include that setting in the procedure (.fex). Procedure Settings are available in Report, Chart, and Document mode.
You can access Procedure Settings from the Quick Access toolbar. When you click Procedure Settings, the Procedure Settings dialog box displays, allowing you to select the options to apply to your procedure, as shown in the following image.

Options include:

- **Collation Sequence (COLLATION).** Establishes a binary or case-insensitive collation sequence. Options include Code Page (default), Binary, Case-Sensitive, and Case-Insensitive. This value will not be written into the procedure (.fex), by default. Therefore, you must select the check box to prompt this action.

- **Summary Lines (SUMMARY LINES).** Allows you to combine fields with and without prefix operators on summary lines in one request. Options include New (default value), Old, and Explicit. This value will not be written into the procedure (.fex), by default. Therefore, you must select the check box to prompt this action.

- **Missing Value (NODATA).** Specifies the missing data characters to be printed in a report. This is a text box with a default value of period ( . ). Common entries include N/A or NONE. In addition, this field has a limit of six characters. This value will not be written into the procedure (.fex), by default. Therefore, you must select the check box to prompt this action.
**Note:** You can use amper (&) variables in the Missing Data field to allow the entry of values at run-time. In general, valid values include any string or amper (&) variable, which will print automatically. You can use &xx to activate autoprompt. For example, you can use &NONE to specify a value at run-time. In Live Preview, this value is set to _FOC_NULL or as many characters that will fit in the width as defined by the existing values in a column. Global variables (&&x) should not be entered as they do not activate autoprompt. Mixing strings with amper (&) variable can result in Focus error messages. For example, &&&&N& or &nn&n&).

- **Decimal Notation (CDN).** Ensures the correct display of currency for the target language. Radio buttons include On and Off (default value).

- **HTML Encode (HTMLENCODE).** Controls whether HTML tags are encoded when these tags are stored within the actual data or when they are created using a DEFINE or COMPUTE command. Radio buttons include On (default value) and Off. This option is selected for inclusion in the procedure (.fex), by default (the check box is selected), as it is not a default setting of the Reporting Server.

- **Empty Report (EMPTY REPORT).** Controls the output generated when a TABLE request retrieves zero records. Radio buttons include On (default value) and Off. When set to On, an empty report (column headings with no content) is generated. When set to Off, no report is generated. This option is selected for inclusion in the procedure (.fex), by default (the check box is selected), as it is not a default setting of the Reporting Server.

**Note:** In Report mode, all settings apply. In Chart mode, only Collation Sequence (COLLATION), Decimal Notation (CDN), and Empty Report (EMPTYREPORT) settings are applicable. In Document mode, Procedure Settings apply to the whole document. These settings are currently unavailable in Visualization mode.
Procedure: How to Create a Procedure Using the Missing Value Option

1. Create a report with a dimension, a measure, and an across sort field that shows missing values, as shown in the following image.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Product Subcategory</th>
<th>Month</th>
<th>3 Revenue Per Sq. Ft.</th>
<th>4 Revenue Per Sq. Ft.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>Charger</td>
<td>1,073</td>
<td>$63.63</td>
<td>1,747</td>
</tr>
<tr>
<td></td>
<td>Headphones</td>
<td>4,246</td>
<td>$1,190.61</td>
<td>3,843</td>
</tr>
<tr>
<td></td>
<td>Universal Remote Controls</td>
<td>3,340</td>
<td>$750.19</td>
<td>2,585</td>
</tr>
<tr>
<td>Camcorder</td>
<td>Handheld</td>
<td>4,575</td>
<td>$548.54</td>
<td>4,205</td>
</tr>
<tr>
<td></td>
<td>Professional</td>
<td>242</td>
<td>$602.19</td>
<td>219</td>
</tr>
<tr>
<td></td>
<td>Standard</td>
<td>3,510</td>
<td>$1,049.03</td>
<td>3,291</td>
</tr>
<tr>
<td>Computers</td>
<td>Smartphone</td>
<td>3,822</td>
<td>$734.88</td>
<td>3,173</td>
</tr>
<tr>
<td></td>
<td>Tablet</td>
<td>3,102</td>
<td>$619.59</td>
<td>3,368</td>
</tr>
<tr>
<td>Media Player</td>
<td>Blu Ray</td>
<td>12,623</td>
<td>$3,762.71</td>
<td>11,421</td>
</tr>
<tr>
<td></td>
<td>DVD Players</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>Streaming</td>
<td>1,304</td>
<td>$111.49</td>
<td>1,134</td>
</tr>
<tr>
<td></td>
<td>Home Theater Systems</td>
<td>7,695</td>
<td>$1,300.07</td>
<td>6,599</td>
</tr>
<tr>
<td></td>
<td>Receivers</td>
<td>2,767</td>
<td>$857.80</td>
<td>2,477</td>
</tr>
<tr>
<td></td>
<td>Speaker Kit</td>
<td>4,542</td>
<td>$1,691.64</td>
<td>4,020</td>
</tr>
<tr>
<td></td>
<td>iPod Docking Station</td>
<td>5,803</td>
<td>$859.48</td>
<td>5,147</td>
</tr>
<tr>
<td>Televisions</td>
<td>Flat Panel TV</td>
<td>1,709</td>
<td>$1,166.99</td>
<td>1,561</td>
</tr>
<tr>
<td>Video Production</td>
<td>Video Editing</td>
<td>3,744</td>
<td>$920.19</td>
<td>3,317</td>
</tr>
</tbody>
</table>

Note: The highlighted area indicates the default ( . ) for missing values.

2. On the Quick Access toolbar, click Procedure Settings.

3. Select the Missing Value check box.

4. In the Missing Value text box, enter the characters to be used to represent missing values in your report. For example, NONE.

Note: By default, this is set to ( . ). However, common examples include N/A or NONE.

5. Click OK.
Fields with missing values are indicated by the word NONE, in this case, as that is what was specified. This value is shown in the following image.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Subcategory</th>
<th>Month</th>
<th>3</th>
<th>Revenue Per Sq. Ft.</th>
<th>4</th>
<th>Revenue Per Sq. Ft.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>Charger</td>
<td>1,973</td>
<td>6,204</td>
<td>$63.63</td>
<td>1,747</td>
<td>5,650</td>
</tr>
<tr>
<td></td>
<td>Headphones</td>
<td>4,245</td>
<td>13,463</td>
<td>$1,189.01</td>
<td>3,843</td>
<td>12,178</td>
</tr>
<tr>
<td></td>
<td>Universal Remote Controls</td>
<td>3,340</td>
<td>10,578</td>
<td>$740.19</td>
<td>2,995</td>
<td>9,581</td>
</tr>
<tr>
<td>Camcorder</td>
<td>Handheld</td>
<td>4,575</td>
<td>14,636</td>
<td>$848.54</td>
<td>4,256</td>
<td>13,490</td>
</tr>
<tr>
<td></td>
<td>Professional</td>
<td>242</td>
<td>756</td>
<td>$882.19</td>
<td>216</td>
<td>748</td>
</tr>
<tr>
<td></td>
<td>Standard</td>
<td>3,610</td>
<td>11,263</td>
<td>$1,049.08</td>
<td>3,291</td>
<td>10,409</td>
</tr>
<tr>
<td>Computers</td>
<td>Smartphone</td>
<td>3,622</td>
<td>11,413</td>
<td>$734.85</td>
<td>3,178</td>
<td>10,281</td>
</tr>
<tr>
<td></td>
<td>Tablet</td>
<td>3,102</td>
<td>8,134</td>
<td>$819.59</td>
<td>3,368</td>
<td>8,858</td>
</tr>
<tr>
<td>Media Player</td>
<td>Blu Ray</td>
<td>12,623</td>
<td>48,707</td>
<td>$2,767.71</td>
<td>11,421</td>
<td>36,130</td>
</tr>
<tr>
<td></td>
<td>DVD Players</td>
<td>NONE</td>
<td>NONE</td>
<td>NONE</td>
<td>NONE</td>
<td>NONE</td>
</tr>
<tr>
<td></td>
<td>Streaming</td>
<td>1,364</td>
<td>4,167</td>
<td>$111.40</td>
<td>1,314</td>
<td>3,966</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>Home Theater Systems</td>
<td>7,405</td>
<td>23,315</td>
<td>$1,360.07</td>
<td>6,599</td>
<td>21,120</td>
</tr>
<tr>
<td></td>
<td>Receivers</td>
<td>2,767</td>
<td>8,736</td>
<td>$857.80</td>
<td>2,477</td>
<td>8,080</td>
</tr>
<tr>
<td></td>
<td>Speaker Kits</td>
<td>4,542</td>
<td>14,332</td>
<td>$1,661.64</td>
<td>4,629</td>
<td>13,117</td>
</tr>
<tr>
<td></td>
<td>iPod Docking Station</td>
<td>5,883</td>
<td>18,348</td>
<td>$969.46</td>
<td>5,147</td>
<td>16,636</td>
</tr>
<tr>
<td>Televisions</td>
<td>Flat Panel TV</td>
<td>1,709</td>
<td>5,427</td>
<td>$1,165.90</td>
<td>1,551</td>
<td>4,992</td>
</tr>
<tr>
<td>Video Production</td>
<td>Video Editing</td>
<td>3,744</td>
<td>11,881</td>
<td>$920.18</td>
<td>3,317</td>
<td>10,774</td>
</tr>
</tbody>
</table>

6. Save the procedure.

**Procedure:** How to Create a Procedure Using the Empty Report Option

1. Create a report with one or more measures and two dimensions.

2. Add a filter to create an empty report by filtering on a value that does not exist in the dimension that you select.

**Note:** The addition of a filter condition causes your report to have no records, and the default behavior (EMPTYREPORT=ON) displays the heading and column titles.
The following image shows an empty report.

3. On the Quick Access toolbar, click Procedure Settings.


   **Note:** This option is selected, by default. Notice that Empty Report can be set to On or Off. When enabled and set to On, the shell of the report (headings and titles) will be displayed. If the setting is turned off, the environment default will be used.

5. Click OK.
   When the Empty Report check box is cleared, no report is generated, as shown in the following image.
6. Save the procedure.

Creating Charts

On the Format tab, the Chart Types group provides buttons for each of the five most commonly-used chart types. These include Bar (default), Pie, Line, Area, and Scatter. You also have access to Esri Choropleth and Proportional Symbol maps. A button labeled Other gives you access to the complete chart library of advanced charts.

The Chart Types group is shown in the following image.

When switching between chart formats that use a different syntax, you are prompted with a message that allows you to proceed with the change, or cancel your request. This message is shown in the following image.

On the Chart Attributes Modified dialog box, you can click Yes to accept the changes or click No to save the changes to a different file and preserve the originating procedure (.fex).

Procedure: How to Create a Basic Chart

You can run this procedure in Query Design view or Live Preview.

1. On the Format tab, in the Chart Types group, click the button of the chart that you want to create. Bar chart is the default.

   The chart appears on the canvas.

2. Populate the chart with your data in one of the following ways:

   - Drag the dimension fields and measure fields onto the chart.
Drag the dimension fields and measure fields into the appropriate Query field containers in the Query pane.

**Procedure: How to Create an Advanced Chart**

You can run this procedure in Query Design view or Live Preview.

1. On the Format tab, in the Chart Types group, click Other.
   
   The Select a chart dialog box opens. The chart types, depicted by icons, display on the left side of the dialog box.

2. To display the name of a chart type, hover over the chart type with the mouse.
   
   From top to bottom, the chart type categories are Bar, Line, Area, Pie, XY Plots, 3D, Stock, Special, HTML5, Map, and HTML5 Extension.

   **Note:** For streamgraphs, which are in the HTML5 category, the tooltip has been enhanced to display specific information, by data point, depending on the underlying data source.

3. Click a chart type.
   
   All supported variations of the chart type appear as thumbnail images in the dialog box.

4. Click an image to display a detailed description of that chart type.
   
   If you are not familiar with a chart type, be sure to read the description carefully before finalizing your selection. Some chart types require a certain number of data values, or a certain type of data values. If your data does not satisfy the requirements, the chart will not accurately represent the data.

   You can also hover over an image with your mouse to display the chart type name.

5. In the Select a chart dialog box, click OK to finalize your selection and close the dialog box.

6. Populate the chart with your data in one of the following ways:

   - Drag the dimension fields and measure fields onto the chart.
   - Drag the dimension fields and measure fields into the appropriate Query field containers in the Query pane.

**Procedure: How to Create a Combination Chart**

You can run this procedure in Query Design view or Live Preview.

1. On the Format tab, in the Chart Types group, click the button of the chart that you want to create. Bar chart is the default.
The chart appears on the canvas.

2. Populate the chart with your data in one of the following ways:
   - Drag the dimension fields and measure fields onto the chart.
   - Drag the dimension fields and measure fields into the appropriate Query field containers in the Query pane.

3. Change a series type in one of the following ways:
   - **Ribbon:** On the Series tab, in the Select group, select the series that you want to display in a different chart type. Then, in the Properties group, from the Type drop-down menu, select the chart type.
   - **Shortcut Menu:** Right-click the series that you want to display in a different chart type, point to Series Type, and click the chart type.

   The series appears in the new chart type.

**Procedure: How to Create a Dual-Axis Chart**

When you create a dual-axis chart, you assign one data series to the Y1 axis and another data series to the Y2 axis.

**Note:** This applies to charts in HTML format. If you are creating a dual-axis chart in HTML5 format, the field containers are labeled Vertical Axis 1 and Vertical Axis 2. If your chart is horizontal, the field containers are labeled Horizontal 1 and Horizontal 2.

1. Create a chart.
2. On the Format tab, in the Chart Types group, click Other.
   
   The Select a chart dialog box opens.
3. Select a dual-axis chart, such as dual-axis bar, and then click OK.
4. Drag one field onto the Y1 field, and then drag another field onto the Y2 field.

**Procedure: How to Create a Multi-Axis Chart**

When you create a multi-axis chart, you assign one data series to the Y1 axis and another data series to the Y2, Y3, Y4, and Y5 axes (as needed).

**Note:** This procedure is specific to HTML format.

1. Create a chart.
2. On the Format tab, in the Chart Types group, click Other.
   
   The Select a chart dialog box opens.
3. Select a multi-axis chart, and then click **OK**.
4. Drag fields onto the Y1, Y2, Y3, Y4, and Y5 fields, as needed.

**Chart Outputs**

You can create charts using one of the following output formats:

- HTML
- HTML5 (default)
- active report
- PDF
- Excel
- PowerPoint

The HTML5 output format allows you to render a chart in the browser using a built-in JavaScript engine. Charts with this output format utilize the very latest capabilities of the HTML5 Web standard, including animation, high-quality vector output, and attractive alpha-channel and gradient effects.

**Note:** Not every chart type can be output in every format listed here. To make sure that the chart that you are creating can be output in the format that you want, please see the topic for that particular chart type.

**Binning**

Binning is a powerful tool for analyzing your data using ranges that you define.

Binning enables you to determine the frequency of values across the entire range of values. It is used for analyzing a frequency distribution. With binning, you can create discrete buckets of continuous data that control how groups of your data display. In addition, binning gives you the ability to review trends and spot outliers.
For example, you can review the range of expenses incurred by households. In the following example, these ranges are represented by bins that are grouped by $1000. In this case, you can see that the largest number of households had the smallest expense (16) while the trend declines as the bin size gets larger. With binning, you can see the frequency of how often values in a range appear across the different groupings, as shown in the following image.

In InfoAssist, bins are automatically created for Histograms. You can change the size of your bins to meet the requirements of your data. For example, if your data has very large values (for example, in billions) you might want to create larger bins. You can also create bins manually in Vertical bar charts and reports.

**Note:** When creating a bin, the format of the bin and the value set for the Width of Bins must be compatible. If the Width of Bins is a large decimal value, define the field format to match the format of the field being converted so that the bins can be successfully generated with the appropriate numeric precision.

Binning is available for the different output types, including reports, charts, and visualizations, depending on how you choose to display and analyze your data.

**Procedure:** How to Use Binning in a Vertical Bar Chart

1. Open InfoAssist in Chart mode.
2. In the Query pane, right-click the chart component and change Sum to Count, as shown in the following image.
3. Add a measure, such as Households, to the Vertical Axis field container.

4. From the Data Pane, right-click the same measure and click Create Bins.

5. In the Create Bins dialog box, accept the default bin value and click OK.

6. From the Data pane, drag the bin into the Horizontal Axis field container. The chart displays showing the bins along the x-axis, as shown in the following image.

7. Save the chart.
   You can edit the bin size to meet your requirements for grouping and display.

**Procedure: How to Edit an Existing Bin**

1. Open a report, chart, or visualization that contains a bin.

2. From the Dimensions group, in the Data pane, right-click the existing bin and click Edit Bins.

   The Edit Bins dialog box opens, as shown in the following image.

   ![Edit Bins dialog box](image)

   **Note:** If you are working with a report, chart, or visualization where the bin is specified and therefore displays in the Query pane, the position of the Edit Bins field in the shortcut menu appears in a different location.

3. Optionally, change the name of the field for the bin, and click Format to edit the formatting that you want to change (for example, currency).

4. In the Width of Bins field, specify a value that meets your display requirements.
5. Click OK.

Procedure: How to Create Bins for Reporting

You can create bins in reports, which lets you view the detail behind a chart or histogram. You can optionally switch between report and chart as you perform your analysis. This allows you to review the actual values that fall into each bin.

1. Create a report.

2. In the Query pane, on the Report component, change Sum to Print, as shown in the following image.

3. Right-click the measure on which to bin, and click Create Bins.

4. In the Create Bins dialog box, set the width of the bins and change any formatting options (for example, currency).

5. Click OK.

6. In the Data pane, double-click the bin to add it to your report.
The report displays showing the bin assignments per value, as shown in the following image.
7. Optionally, you can change the Print and By field assignments to view the Households values by bin, as shown in the following image.

Binning Values in a Histogram

Histograms graphically represent the distribution of numeric data. They facilitate the identification and discovery of the underlying frequency distribution within a set of continuous data. You can use histograms to identify trends and illustrate categorizations, or groupings, also known as bins. For more information, see Binning on page 383.

Histograms use bins to group data. Bins allow you to establish a range of values for your data. For example, you can review how the bins are designated when you consider the age of everyone in your company. In the first table, you can review the bins (using the default value of 10) and counts for each bin.

<table>
<thead>
<tr>
<th>AGE</th>
<th>COUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-9</td>
<td>0</td>
</tr>
<tr>
<td>10-19</td>
<td>5</td>
</tr>
<tr>
<td>AGE</td>
<td>COUNT</td>
</tr>
<tr>
<td>-------</td>
<td>-------</td>
</tr>
<tr>
<td>20-29</td>
<td>26</td>
</tr>
<tr>
<td>30-39</td>
<td>351</td>
</tr>
<tr>
<td>40-49</td>
<td>460</td>
</tr>
<tr>
<td>50-59</td>
<td>310</td>
</tr>
<tr>
<td>60-69</td>
<td>285</td>
</tr>
<tr>
<td>70-79</td>
<td>22</td>
</tr>
<tr>
<td>80-89</td>
<td>3</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>1462</strong></td>
</tr>
</tbody>
</table>

In the second table, you can review the same data for the bins (with a bin width of 15) and counts for each bin. Notice that as the bin size gets larger, more employees fall into these different ranges.

<table>
<thead>
<tr>
<th>AGE</th>
<th>COUNT</th>
</tr>
</thead>
<tbody>
<tr>
<td>0-14</td>
<td>0</td>
</tr>
<tr>
<td>15-29</td>
<td>31</td>
</tr>
<tr>
<td>30-44</td>
<td>611</td>
</tr>
<tr>
<td>45-59</td>
<td>510</td>
</tr>
<tr>
<td>60-74</td>
<td>296</td>
</tr>
<tr>
<td>75-89</td>
<td>14</td>
</tr>
<tr>
<td><strong>Total</strong></td>
<td><strong>1462</strong></td>
</tr>
</tbody>
</table>

When you create a histogram in either Chart or Visualization mode, a bin is created automatically for the measure you select. When working with bins, you can change the width of the bin by editing it. In the Query or Data pane, right-click a bin field and click *Edit Bins* to change the value that dictates the width or format of the contents of the bin.
The bin value is designated as a dimension field, since it is a limited field with a discrete set of possible values that was created from a field with an unlimited, continuous range of values. The measure displays as a count (.CNT) field and the related bin is created in the Query pane. It is also placed in the Data Pane for future use.

**Procedure:** How to Create a Histogram with Automatic Binning in Chart Mode

1. Open InfoAssist in Chart mode.
2. On the Format tab in the Chart Types group, click Other.
3. In the Bar group of charts, click Vertical Histogram.
4. Click OK.
5. From the Data pane, drag a measure into the Measure field container in the Query pane. A histogram is automatically created using the measure you selected along with a generated bin, as shown in the following image.

![Histogram](image)

**Note:** This process produces the same results as if you had created the histogram manually, however it automatically converts the measure to a count (.CNT) field. It also creates the bin for you, placing it on the x-axis, accordingly.

**Procedure:** How to Create a Histogram with Automatic Binning in Visualization Mode

1. Open InfoAssist in Visualization mode.
3. In the Select a Visual dialog box, click Histogram.
4. From the Data pane, drag a measure into the Measure field container in the Query pane.
A histogram is automatically created using the measure you selected along with a generated bin, as shown in the following image.

You can optionally edit the bin to change its width or format. For information on building a histogram manually, in Chart mode, see *Binning* on page 383.

**Using Insight to Analyze Dynamic Charts**

In InfoAssist, you now have access to a number of visualization tools: Chart mode, Visualization mode, and Insight. Each tool offers different options for you as you visualize your data.

Insight is a new visualization tool that allows for the interactive selection of measures and dimensions, so you can create dynamic charts that refresh as you make changes. This feature is available in HTML5 Chart mode only.

With Insight, you can build a chart that shows the data fields that you choose in real-time. It even rebuilds as you select additional fields or specify filters.

Similar to Visualization mode in InfoAssist, you can make quick decisions regarding your data with Insight. Using logical menus and simple filtering, you can build charts interactively to suit your needs. As you select additional fields and create filters, your chart refreshes instantly, letting you see the results of your data choices as you use the tool.

In Visualization mode, you can create and work with multiple charts in a single visualization. All charts in the visual are linked to the same data source. You can use the filter prompts to narrow the data that displays.
Insight lets you build filters, as needed, to customize the data that displays. You can add and remove fields, at any time and in any pattern, to enhance your chart. You can take advantage of the customization options that are available to you right from the toolbar.

With Insight, the chart type determines the field containers that display. For example, if you are working with a pie chart, you can specify values for the following field containers: Measure, Rows, Columns, Color, and Size. In many cases, these field containers mirror the field containers that display when working with InfoAssist.

Available fields are organized into applicable Dimension and Measure categories. You can use the plus sign \( + \) to add additional fields to your chart. For example, if you want to create a bar chart that plots Gross Profit, Revenue, and MSRP for each Product Category, click the plus sign to add fields using the drop-down field selector. Once you choose the fields that you want to include, you can rearrange them by dragging and dropping them into the order that you prefer.

The resulting bar chart displays, as shown in the following image.

![Bar Chart Example](image)

You can use the navigational arrows in the interactive header to move between the available field containers in your chart. The following image highlights these arrows, which shift the focus of these field containers to the right or left.
All charts support a field container for Color, which adds contrast to your chart. Some charts also support the Size field container, which binds a measure to the size of the markers rendered on the chart.

Once you have added fields to the relevant field containers, you can use the Sort arrows adjacent to each field to sort the data in ascending or descending order. This helps identify trends and priorities within your data. You can only sort one field at a time. Ascending order sorts your data from the smallest value to the greatest value, while descending order sorts your data from the greatest value to the smallest value, as shown in the following image.

When you select a sort order for a field, the field arrow changes color, appearing bolder than the unsorted fields. In the image below, a sort order was selected for MSRP, so the field arrow appears black.
You can specify measures and dimensions for your chart in InfoAssist before using Insight. This pre-loads the Insight user interface (UI) with those selections. Optionally, you can use Insight without selecting any fields. In this case, the field selection options are broad, meaning that all fields will be presented. An example of an empty canvas is shown in the following image.

<table>
<thead>
<tr>
<th>Vertical Axis</th>
<th>Group</th>
<th>Color</th>
<th>Options</th>
</tr>
</thead>
<tbody>
<tr>
<td>+</td>
<td>+</td>
<td>+</td>
<td>▶️</td>
</tr>
</tbody>
</table>

Procedure: How to Enable Insight From InfoAssist

1. Open InfoAssist in Chart mode.

2. On the Format tab, in the Run with group, click the Insight icon.

3. On the Quick Access toolbar, click Run.

   The Insight interface opens, and you can begin building your chart.

Working With Charts in Insight

With Insight, you can choose individual fields for the field containers that you add. Whether you added fields into the Query pane before running Insight or you added fields to the existing field containers (or field containers that you add), creating a chart in Insight is streamlined to allow you to easily create a dynamic chart in real time. It also provides you with the flexibility of interactive comparison as you change your data selections rapidly and adjust the options for display.
You can use the default vertical bar chart or you can specify a different chart type using the Chart Picker in the Options toolbar.

In addition, you can re-order the display of field containers in your chart. This allows you to change the placement of a particular field, giving you control over where the data for this component displays in your chart.

**Procedure: How to Create a Basic Bar Chart Using Insight**

1. Click the plus icon under the Vertical Axis field container.
2. Choose a measure field from the drop-down list.
3. Click the plus icon under the Group field container.
4. Choose a dimension field from the drop-down list.

Your bar chart displays, as shown in the following image.

---

**Procedure: How to Change the Chart Type in Insight**

1. On the Options toolbar, click *Chart Picker*. 
The table of chart selections opens, as shown in the following image.

2. Select a chart type.

   Your chart refreshes with the new chart type, and the Insight interface refreshes to display all of the field containers that are relevant to the current chart type.

Procedure: How to Delete a Field From a Field Container

1. Add one or more fields to your chart.
2. Hover over the field that you want to delete and click X, as shown in the following image.

The chart refreshes to reflect your selections.

Procedure: How to Reorder the Display of Field Containers

1. Add multiple fields to your chart, as shown in the following image.
2. In the Vertical Axis grouping, drag the second field container into the first position. The placement of the field is shown by a dark blue vertical bar, as shown in the following image.

The following image shows the newly ordered fields.
Searching for Fields

You can locate fields for your field containers using the search option. On the toolbar, click the plus sign. In the search field, start typing the field that you want to locate. You can type in whole words or partial words. The search identifies all fields that contain any instance of the characters that you specify, as shown in the following image.

![Search for Fields](image)

Changing Summary Operators for the Field

When working with measure fields, you can change the summary operators for the field from Summary (default) to Average, Maximum, or Minimum. You can also change a Count field to Count Distinct, using a similar menu selection.
When you make a selection, the axis of the relevant measure updates in the chart, as shown in the following image.

Options for changing the Summary field are shown in the following image.
Filtering in Insight

To enable filtering, click the Show Filter icon , which is located in the Options section of the toolbar. This opens the filter shelf that renders above the field container shelf, as shown in the following image.

Use the filter shelf to build your filter. The filter shelf must be visible in order to add or modify a filter. In addition, filters that were created in a procedure (.fex) or InfoAssist session prior to launching Insight are applied, but do not show in Insight.
Note: As of Release 8.2 Version 03, query variables in Insight are available and functional on the Filter shelf. Typically, query variables display in the Data pane, above the measure fields. The filter values display as True or False, rather than one and zero. In addition, you can only select one value, as shown in the following image.

### Accessories

<table>
<thead>
<tr>
<th>All</th>
</tr>
</thead>
</table>

Select all Clear

True False

---

**Types of Filters**

There are different types of filters in Insight. For example, if you are filtering with a date field, you can use a built-in calendar to select a date range, as shown in the following image.
If you are filtering on a numeric value, such as a measure value, you can filter on values that are specific to a field. In this scenario, when you define the filter, a slider control opens. You can adjust the range of values that you want to include, using the slider control options, as shown in the following image.

You can also filter on dimension values. You can select one or more values by simply clicking on multiple values. A check mark appears, indicating the values selected, as shown in the following image.
You can select all values for the dimension, select one or more, or clear all selected values, as shown in the following image.
Adding a Filter

You add a filter when you want to limit the display of your data, or drill down to focus on specific data values. For example, you may want to just display data for Camcorder and Televisions, rather than all Product Categories. You can do this by adding a filter for the Camcorder and Televisions, as shown in the following image.

![Image of a chart with filters applied]

**Procedure:** How to Add a Filter in Insight

1. In the Options toolbar, click *Show Filter*.
   - The filter shelf opens.
2. Click the Show Filter icon.
3. From the drop-down list that opens, select the field on which to filter.
4. Click the identified field in the filter shelf to specify a value for the filter.
   - A list displays, showing the values that you can select.
5. Click on the filter shelf to save your filtered items.
   - Your chart refreshes.
Removing a Filter

To remove a filter, hover over it and click on the X, as shown in the following image.

![Diagram of removing a filter](image)

The chart refreshes and displays your data without any filter.

Using the Options Toolbar

The Options toolbar is located in the upper-right corner of the Insight interface. These options control your interactions with your data, including options such as pivoting and filtering. You can also change your chart type using the Chart Picker option.

Reference: Options Toolbar Icons

The following section describes the icons that display on the Options toolbar.

- **Reset**
  
  Returns the chart to its original state. Any filters, measures, dimensions that are added in the current Insight session are reverted. The chart type is reverted, as well.

- **Swap Axis**
  
  Swaps the x and y axis, placing the contents of the x axis on the y axis. You can click Swap Axis again to change the chart back to its original orientation.
Save
Saves the current Insight chart as a unique entry in the repository. When you click Save, you are presented with a list of folders. Navigation is limited to where you can save content. The default folder is your My Content folder. You can save the same Insight chart multiple times. Insight uses the same title and file name. You will then be prompted to overwrite the file.

Chart Picker
Provides options for selecting different chart types, including:

- **Horizontal Bar.** Offers the capability of ranking data in descending order. This chart type can also be used when x-axis labels are too long to fit legibly side-by-side. The following field containers are available for this chart type: Horizontal Axis, Group, and Color.

- **Vertical Bar.** Shows different measures per dimension component using different identifying colors. The following field containers are available for this chart type: Vertical Axis, Group, and Color.

- **Vertical Stacked Bar.** Stacks values per dimension component using differentiating colors. The following field containers are available for this chart type: Vertical Axis, Group, and Color.

- **Pie.** Presents values as part of a whole using colors to separate the segments. Pie charts emphasize where your data fits in relation to the larger whole. The following field containers are available for this chart type: Rows, Columns, Measure, Color, and Size.

- **Vertical Line.** Creates a line chart which is representative of the data. Line charts are useful for showing trends in numerical data. The following field containers are available for this chart type: Vertical Axis, Group, and Color.
Area. Creates an area chart which is similar to a line chart except the area between the data line and the zero line (or axis) is usually filled with color. The following field containers are available for this chart type: Vertical Axis, Group, and Color.

Scatter. Plots data using variable scales on both axes. The following field containers are available for this chart type: Rows, Columns, Vertical Axis, Horizontal Axis, Size, Detail, and Color.

Note: When working with Insight Scatter or Bubble Charts, the "Show Datalabels" ability is tied to the Size bucket. Therefore, you will only see datalabels if there is a measure in the Size field container.

Circle. Plots differing values in rows, enabling you to draw inferences as to how the values overlap. The following field containers are available for this chart type: Rows, Columns, Vertical Axis, Horizontal Axis, Size, Detail, and Color.

Treemap. Displays large amounts of hierarchically structured data. This chart type uses sections to represent an aspect of the selected measure. The following field containers are available for this chart type: Grouping, Size, and Color.

Histogram. Analyzes the distribution of a measure while assigning it to field containers based on the values you specify for the bins that are created. The default bin count is 10. The following field containers are available for this chart type: Rows, Columns, and Measure.

Table. Presents data in tabular form, allowing you to compare various intersections in your data. The following field containers are available for this chart type: Rows, Columns, and Measure.

Matrix. Analyzes one or two measures against a crosstab of two categorical dimensions. The following field containers are available for this chart type: Rows, Columns, Size, and Color.
Point Map. Uses symbols of different sizes to represent data associated with different areas or locations within the map. The following field containers are available for this chart type: Layer, Size, and Color.

Choropleth Map. Visualizes location-based data, trends, and distributions across a geographic area. These maps are geographically-based heat maps. The following field containers are available for this chart type: Layer and Color.

Note: The orientation of this chart icon changes if you swap an axis. In addition, the image that displays for the chart type changes, based on your selection.

Show Filter
Defines filters for your data. Select this icon, and using the filter shelf that opens above the field container shelf, click the Show Filter icon to define a filter. For more information, see Filtering on page 412.

Note: To select one or more non-consecutive values, select each field. The selected values will display with a check mark to indicate that they have been selected.

More Options
Opens the following additional options:

Export Data. Exports the underlying data of the current chart to an Excel file in LOCAL file storage. You will be alerted when the file appears in the bottom left corner, similar to any other file that you download.

Export Image. Generates an image of the current chart, which is saved in PNG format to LOCAL file storage using the current width and height of the browser window.

Series Layout. The bar, line, and area charts in Insight support several different sub-graph types (aka Layout). The supported graph types include: horizontal bar, vertical bar, vertical stacked bar, line, and area charts. For bar, line, and area charts, the Series Layout Options are as follows:

- Horizontal Bar: Stacked, Absolute, Percent, Side-by-Side
- Vertical Bar: Stacked, Absolute, Percent, Side-by-Side
- Vertical Stacked Bar: Stacked, Absolute, Percent, Side-by-Side
- Line: Stacked, Absolute, Percent
Vertical Stacked Area: Stacked, Absolute, Percent

Y-Axis Log Scale. Adjusts the log scale on the y axis. This option is always unchecked, by default. The following chart types are supported:

- Horizontal Bar
- Vertical Bar
- Vertical Stacked Bar
- Line
- Area charts
- Scatter charts
- Bubble
- Circle
- Histogram

X-Axis Log Scale. Adjusts the log scale on the x axis. This option is always not selected, by default. The following chart types are supported:

- Scatter
- Bubble

Change Bin Size. Changes the size of the bin (numeric value only). This option is only available for histograms. Clearing the text box switches it back to automatic bin size generation.

Show Data Label. Turns numeric Data labels on/off on all charts, except Grids. The default for this setting is always Off except for Treemaps.

Show Totals. Turns the Summary Row Total on Data Grid on or off. The default for this setting is always False.

Marker Shape. Changes the marker shape used in the matrix marker chart. Options include: Circle, Square, or Fill.
Using Insight in Phone Mode

Phone mode, which is available in Insight, allows you to take advantage of the features of Insight on your phone. The interactive heading that is available in Insight on a tablet or desktop is replaced by a static heading that displays the field names in the chart, in blue text. These become summary fields that allow you to see what fields are included in the chart.

Insight is mobile aware and mobile friendly. Full functionality is available on tablet devices and other high-resolution touch displays. On smaller devices, such as an iPhone, Insight enters a special phone mode which has a useful, but more limited, set of options and features that are tuned for the small screen real-estate of the device. In this mode, you can add or modify filters to narrow your data as needed. You can also hover over data points to see the underlying data.

Measures are shown first. The first measure displays with a summation attribute (for example, Sum or Avg) and then displays of and then the name of the measure, as shown in the following image.

In the above image, area one is the static heading. Area two marks the filtering side option button. Lastly, area three shows the conbody of the chart.
Numeric measures are displayed after the measures in the order of Y-Axis and then X-axis. If you define fields in your Grouping field container, they display after the collective measures and are preceded by the word by. If you have created a matrix marker chart, the relevant field containers for these display next. They also use the word by, as do any Detail field containers that are populated in the chart. If your chart specifies a field for color, Phone mode precedes the display of this item with color by. Lastly, if you have populated the Size field container, this displays last and is introduced by size by.

**User Options in Phone Mode**

You have a number of options in Phone mode, including robust filtering and hover capabilities.

**Filtering**

In Phone mode, you can filter just like in regular desktop mode. The primary difference is that the filter shelf stacks the available filters in a vertical row, as shown in the following image.

You click the filter icon to bring up the filter shelf and then you click the X to close it. If you have defined filters, closing the filter shelf merely collapses it. The filters that you defined remain intact. To remove a filter, hover over it and click the X in the upper-right corner.
General Usability

Phone mode allows you to view your chart and filter it to refine it based on your own unique scenario.

You can hover over a data bar a segment of a chart to obtain additional, detailed information from the underlying data. The tooltips that display are based on your data selections.

You can also show and hide the legend using the right arrow above the legend. When you collapse the legend, you can see more of your chart.

The opportunities for dynamic charting are vast with Insight. Using dynamic menus, filtering options, and search features, you can quickly and effectively create charts that communicate your data.

Selecting a Chart Type

InfoAssist provides a complete chart library of both basic and advanced charts. You can choose from a wide variety of charts to best represent the data that you want to display.

It is important that you choose a chart that is appropriate for your data. When working with chart types in the Other category, which is available in the Chart Types group on the Format tab in Chart mode, you can quickly access a description for each chart, simply by hovering over the chart type with your mouse in the Select a chart dialog box. This facilitates quick identification of the relevant chart type, making it easy to create the right type of chart based on your data.

Note:

- To change the chart type of a migrated chart procedure that contains bar, line, or area charts, click the Type button on the Series tab, instead of the Format tab.

- As of Release 8.2 Version 02, the new chart attribute syntax has been applied to the following chart types: Dual Bar and Line, Tag Cloud, Streamgraph, Mekko, Funnel, and Pyramid. In InfoAssist, specific field containers display for each chart type. For information on the field containers for charts, see Field Containers for Charts and Visualizations on page 103.

Bar Charts

Bar charts plot numerical data by displaying rectangular blocks against a scale (numbers or variable measure fields that appear along the axis). The length of a bar corresponds to a value or amount. You can clearly compare data series (fields) by the relative heights of the bars. Use a bar chart to display the distribution of numerical data. You can create horizontal and vertical bar charts.
Note:

- If you are working with a large dataset, you can enable the display of a scroll bar under your chart, allowing you to easily scroll through your data from left to right. If you want to enable, disable or re-enable scroll bars, click the Format tab and then click Interactive Options. In the Interactive Options dialog box, select the Auto Enable X-Axis Scrolling check box.

- When working with stacked bar charts in either Chart or Visualization mode, borders can be enabled to show each series or measure in the chart. When enabled, the borders outline each measure in a stacked bar chart. This allows you to differentiate between the measures when they are displayed using the same color on a riser.

You can specify a border for all series in the Style dialog box, which is accessible from the Series tab.

When to use: Use a bar chart when individual values are important. For example, a basic vertical bar chart can compare the individual products sold to the total amount in sales for each product. A retailer would find it important to know which pieces of inventory are selling and how much revenue each item is generating for the company.

The following image is an example of a bar chart showing gross profit and quantity sold by product category.
A horizontal bar chart becomes useful when you want to emphasize a ranking relationship in descending order, or the X-axis labels are too long to fit legibly side-by-side. For example, a basic horizontal bar chart can rank in descending order which products are generating the most revenue for the retailer.

**Bar Chart Types**

The following table lists the available bar chart types.

<table>
<thead>
<tr>
<th>Available Bar Chart Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical Clustered Bar</td>
</tr>
<tr>
<td>Vertical Stacked Bar</td>
</tr>
<tr>
<td>Vertical Dual-Axis Clustered Bar</td>
</tr>
<tr>
<td>Vertical Dual-Axis Stacked Bar</td>
</tr>
<tr>
<td>Vertical Bi-Polar Clustered Bar (Not in HTML5)</td>
</tr>
<tr>
<td>Vertical Bi-Polar Stacked Bar (Not in HTML5)</td>
</tr>
<tr>
<td>Vertical Percent Bar</td>
</tr>
<tr>
<td>Vertical Histogram</td>
</tr>
<tr>
<td>Vertical Waterfall</td>
</tr>
<tr>
<td>Vertical Multi-3Y Bar (Not in HTML5)</td>
</tr>
<tr>
<td>Vertical Multi-4Y Bar (Not in HTML5)</td>
</tr>
<tr>
<td>Vertical Multi-5Y Bar (Not in HTML5)</td>
</tr>
<tr>
<td>Error Bar</td>
</tr>
<tr>
<td>Horizontal Clustered Bar</td>
</tr>
<tr>
<td>Horizontal Stacked Bar</td>
</tr>
<tr>
<td>Horizontal Dual-Axis Clustered Bar</td>
</tr>
<tr>
<td>Horizontal Dual-Axis Stacked Bar</td>
</tr>
<tr>
<td>Horizontal Bi-Polar Clustered Bar (Not in HTML5)</td>
</tr>
<tr>
<td>Horizontal Bi-Polar Stacked Bar (Not in HTML5)</td>
</tr>
<tr>
<td>Horizontal Percent Bar</td>
</tr>
<tr>
<td>Horizontal Histogram</td>
</tr>
<tr>
<td>Horizontal Waterfall</td>
</tr>
<tr>
<td>Vertical Multi-5Y Bar (Not in HTML5)</td>
</tr>
</tbody>
</table>

**Pie Charts**

A pie chart is a circular chart that represents parts of a whole. A pie chart emphasizes where your data fits, in relation to a larger whole. Pie charts work best when the data consists of several large segments. As a best practice, limit your pie chart to five measure fields. Too many measure fields can divide a pie into many thin components that could become difficult to see. Use color on individual segments to create visual contrast.
In addition, you can add one or more measures to the Measure field container. Each measure will be used to create a separate, unique pie chart, to which you can add a measure or dimension to the Color field container to add color to your chart.

**Note:**

- When working with pie charts, you can add one measure field to the Color field container. This adds the measure as a By field, and determines how the pie chart is colored. Depending on your measure data, this may result in a large number of pie segments.

- You cannot plot negative data on a pie chart.

**When to use:** Use a pie chart when you have several large segments of data that you want to display as a whole.

For example, the following image is a pie chart showing the product revenue by sale quarter.

---

**Pie Chart Types**

The following table lists the available pie chart types.
Available Pie Chart Types

<table>
<thead>
<tr>
<th>Multi Pie</th>
<th>Multi Ring Pie</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multi Proportional Pie (Not in HTML5)</td>
<td>Multi Proportional Ring Pie (Not in HTML5)</td>
</tr>
<tr>
<td>Single Pie</td>
<td>Single Ring Pie</td>
</tr>
<tr>
<td>Pie-Bar (Not in HTML5)</td>
<td>Ring Pie-Bar (Not in HTML5)</td>
</tr>
</tbody>
</table>

Line Charts

Line charts are useful for emphasizing the movement or trend of numerical data over time. They allow you to trace the evolution of a data point by working backwards or interpolating. Highs and lows, rapid or slow movement, or a tendency towards stability are all types of trends well suited to a line chart.

You can also plot line charts with two or more scales to present a comparison of the same value, or set of values, in different time periods.

**Note:** If you are working with a large dataset, you can enable the display of a scroll bar under your chart, allowing you to easily scroll through your data from left to right. If you want to enable, disable or re-enable scroll bars, click the Format tab and then click **Interactive Options**. In the Interactive Options dialog box, select the **Auto Enable X-Axis Scrolling** check box.

**When to use:** Use a line chart when you want to trend data over time. For example, monthly changes in employment figures, or yearly sales of an item in your inventory.
For example, the following image is a line chart that traces product revenue over a four-year period.

![Line Chart Example]

Radar charts are essentially analogous to line charts, except that the scale wraps around. Radar charts compare two or more data sets. They work well with data that is cyclical, such as the months of a year. A radar line chart is available in the line chart category, and a radar area chart is available in the area chart category. You can use axes or polygons to represent values in a star or spider configuration.

**Line Chart Types**

The following table lists the available line chart types.

<table>
<thead>
<tr>
<th>Available Line Chart Types</th>
<th>Horizontal Absolute Line</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical Absolute Line</td>
<td></td>
</tr>
<tr>
<td>Vertical Stacked Line</td>
<td></td>
</tr>
<tr>
<td>Vertical Dual-Axis Absolute Line</td>
<td></td>
</tr>
<tr>
<td>Horizontal Stacked Line</td>
<td></td>
</tr>
<tr>
<td>Horizontal Dual-Axis Absolute Line</td>
<td></td>
</tr>
</tbody>
</table>
### Available Line Chart Types

<table>
<thead>
<tr>
<th>Vertical Dual-Axis Stacked Line</th>
<th>Horizontal Dual-Axis Stacked Line</th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical Bi-Polar Absolute Line (Not in HTML5)</td>
<td>Horizontal Bi-Polar Absolute Line (Not in HTML5)</td>
</tr>
<tr>
<td>Vertical Bi-Polar Stacked Line (Not in HTML5)</td>
<td>Horizontal Bi-Polar Stacked Line (Not in HTML5)</td>
</tr>
<tr>
<td>Vertical Percent Line</td>
<td>Horizontal Percent Line</td>
</tr>
<tr>
<td>Radar Line</td>
<td></td>
</tr>
</tbody>
</table>

### Area Charts

Area charts are similar to line charts except that the area between the data line and zero line (or axis) is usually filled with color. Area charts allow you to stack data on top of each other. Stacking allows you to highlight the relationship between data series, showing how some data series approach a second series.

**Note:** If you are working with a large dataset, you can enable the display of a scroll bar under your chart, allowing you to easily scroll through your data from left to right. If you want to enable, disable or re-enable scroll bars, click the Format tab and then click *Interactive Options*. In the Interactive Options dialog box, select the *Auto Enable X-Axis Scrolling* check box.
**When to Use:** Use an area chart when you want to distinguish the data more dramatically by highlighting volume with color. For example, the following image is a stacked area chart depicting the gross profit, revenue, and quantities sold for products over a three-year time period.

![Stacked Area Chart](image)

**Area Chart Types**

The following table lists the available area chart types.

<table>
<thead>
<tr>
<th>Available Area Chart Types</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Vertical Absolute Area</td>
<td>Horizontal Absolute Area</td>
</tr>
<tr>
<td>Vertical Stacked Area</td>
<td>Horizontal Stacked Area</td>
</tr>
<tr>
<td>Vertical Bi-Polar Absolute Area (Not in HTML5)</td>
<td>Horizontal Bi-Polar Absolute Area (Not in HTML5)</td>
</tr>
<tr>
<td>Vertical Bi-Polar Stacked Area (Not in HTML5)</td>
<td>Horizontal Bi-Polar Stacked Area (Not in HTML5)</td>
</tr>
<tr>
<td>Vertical Percent Area</td>
<td>Horizontal Percent Area</td>
</tr>
</tbody>
</table>
Available Area Chart Types

| Radar Area |

Scatter Charts

Scatter charts enable you to plot data using variable scales on both axes. When you use a scatter chart, the data is plotted with a hollow marker, so that you can visualize the density of individual data values around particular points, or discern patterns in the data. A numeric X axis, or sort field, always yields a scatter chart, by default, however you can optionally specify a non-measure (dimension) field on either the vertical or horizontal axis. You can also specify a non-measure field on both axes, which results in a vertical display of your dimension data.

If your chart reveals clouds of points, there is a strong relationship between X and Y values. If data points are scattered, there is a weak relationship, or no relationship.

**When to use:** Use a scatter chart when you want to determine patterns in your data.

The following image is a scatter chart that shows gross profit and MSRP data for product categories.
Multi-Axis Charts

Bar, line, and area chart types have multi-axis options, such as dual-axis charts and multi-Y charts, where you can compare one X-axis value to several Y-axis measure fields.

InfoAssist allows you to assign each individual series to the Y1 through Y5 axis.

**When to use:** Use a multi-axis chart when you want to plot values on an additional axis, or multiple axes, to compare multiple sets of data that are on different scales.

For example, the following image is a dual-axis bar chart that shows the revenue and MSRP by store type over a four-year time period.

![Dual-axis bar chart example](image)

XY Plot Charts

An XY plot chart depicts the relationships among the numeric values in several data series. It plots two groups of numbers, where for every X value, there is a corresponding Y value. This results in a single point of XY coordinate.

**When to use:** Use XY plot charts when you have two sets of numbers to compare and want to perform trend analysis.

- **Scatter.** Scatter charts show a relationship between X and Y values. They compare two sets of numbers at once, possibly revealing patterns and trends.
You can plot data using variable scales on both axes. When you use a scatter chart, the data is plotted with a basic line pattern so that you can visualize the density of individual data values around particular points, or discern patterns in the data. A numeric X axis, or sort field, always yields a scatter chart by default.

If your chart reveals clouds of points, there is a strong relationship between X and Y values. If data points are scattered, there is a weak or no relationship.

Scatter charts share many of the characteristics of basic line charts. Scatter charts and line charts are distinguishable from one another only by virtue of their X-axis format. Line charts can appear without connecting lines, making them look like scatter charts, and scatter charts can appear with connecting lines, making them look like line charts.

- **Polar.** A polar chart is a circular chart. Data is displayed on a polar chart in terms of values and angles. Polar charts share characteristics with scatter charts. Only one column field is allowed, in the following order: X (degree) for the column field, and Y (distance from the center) for the Across or By field.

- **Bubble.** A bubble chart is a chart in which the data points are represented by bubbles. Bubble charts can have two column fields representing X and Y data values, or have three column fields representing X, Y, and Z data values, in that order. The third variable (Z) represents size. The size of each bubble is used to show the relative importance of the data.

**Note:** You can specify a non-measure (dimension) data field on the horizontal or vertical axis, or both.

### XY Plot Chart Types

The following table lists the available XY plot chart types.

<table>
<thead>
<tr>
<th>Available XY Plot Chart Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>XY Scatter</td>
</tr>
<tr>
<td>Bubble</td>
</tr>
</tbody>
</table>

### 3D Charts

A 3D chart uses three axes, X, Y, and Z to display data from two or more data sets so that trends are most apparent.
When to use: Use a 3D bar chart when you want to look at the general shape of the data, but add visual depth to a chart presentation. A 3D chart would not be a good choice for presenting exact values, since it is difficult to determine values in a 3D chart.

Note: When working with charts in HTML5 format, the 3D Effect option is not supported.

The following image is a 3D chart that shows the revenue for products categories over a four-year time period.

3D Chart Types

The following table lists the available 3D chart types.

<table>
<thead>
<tr>
<th>Available 3D Chart Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D Bar</td>
</tr>
<tr>
<td>3D Octagon (Not in HTML5)</td>
</tr>
<tr>
<td>3D Floating Cubes (Not in HTML5)</td>
</tr>
<tr>
<td>3D Connected Series Area</td>
</tr>
<tr>
<td>3D Pyramid (Not in HTML5)</td>
</tr>
<tr>
<td>3D Cylinder (Not in HTML5)</td>
</tr>
<tr>
<td>3D Floating Pyramids (Not in HTML5)</td>
</tr>
<tr>
<td>3D Connected Series Ribbon (Not in HTML5)</td>
</tr>
</tbody>
</table>
### Available 3D Chart Types

<table>
<thead>
<tr>
<th>Available</th>
<th>Available</th>
</tr>
</thead>
<tbody>
<tr>
<td>3D Connected Group Area (Not in HTML5)</td>
<td>3D Connected Group Ribbon (Not in HTML5)</td>
</tr>
<tr>
<td>3D Cone (Not in HTML5)</td>
<td>3D Sphere (Not in HTML5)</td>
</tr>
<tr>
<td>3D Surface</td>
<td>3D Surface with Sides (Not in HTML5)</td>
</tr>
<tr>
<td>3D Smooth Surface (Not in HTML5)</td>
<td>3D Smooth Surface with Sides (Not in HTML5)</td>
</tr>
<tr>
<td>3D Honeycomb Surface (Not in HTML5)</td>
<td></td>
</tr>
</tbody>
</table>

### Stock Charts

Stock charts track the trend of a particular stock. They show the trading volume of the stock, its opening and closing values, and its high and low values over a specific time period. The data is represented by sets of bars or lines.
Stock Chart Types
The following table lists the available stock chart types.

<table>
<thead>
<tr>
<th>Available Stock Chart Types</th>
</tr>
</thead>
<tbody>
<tr>
<td>Stock Hi-Lo (Not in HTML5)</td>
</tr>
<tr>
<td>Stock Hi-Lo with Volume (Not in HTML5)</td>
</tr>
<tr>
<td>Stock Hi-Lo Open-Close (Not in HTML5)</td>
</tr>
<tr>
<td>Stock Hi-Lo Open-Close with Volume (Not in HTML5)</td>
</tr>
<tr>
<td>Open-Hi-Lo-Close Candle Stock</td>
</tr>
<tr>
<td>Open-Hi-Lo-Close Candle Stock with Volume (Not in HTML5)</td>
</tr>
</tbody>
</table>

Special Charts
Special charts include a variety of additional chart types.

- **Gauge.** A gauge chart indicates the current position of a single data value within a given spectrum. This chart has a circular shape.

- **Gauge Thermometer.** A gauge thermometer chart indicates the current position of a single data value within a given scale. This chart has the shape of a thermometer. It is not available in HTML5.

- **Pareto.** A Pareto chart uses the X axis to show group members, and the Y axis to show the percent of the total of all groups that each group represents. This chart highlights the differences between groups of data.

- **Vertical Box Plot.** A vertical box plot is oriented vertically, and shows the distribution of data through five-number summaries: Upper limit, Upper Quartile, Median, Lower Quartile, and Lower Limit. This chart can be represented with or without outliers, also known as whiskers.

- **Horizontal Box Plot.** A horizontal box plot is oriented horizontally, and shows the distribution of data through five-number summaries: Upper limit, Upper Quartile, Median, Lower Quartile, and Lower Limit. This chart can be represented with or without outliers, also known as whiskers.

- **Funnel.** A funnel chart is essentially a pie chart, displaying only one group of data at a time, from the first series to the last series at the bottom of the funnel.

- **Pyramid.** A pyramid chart is essentially a pie chart, displaying only one group of data at a time, from the first series to the last series at the top of the pyramid.
- **Spectral Map.** A spectral map contains a row or column matrix of markers that are displayed in different colors, according to the data values.

**HTML5 Charts**

The following HTML5 charts are available:

- **Parabox.** Parabox charts are used to visualize and analyze multivariate data. In a typical scenario, hundreds of possible outcomes can be compared by filtering along any dimension.

- **Mekko Chart.** Mekko charts compare two related variables by percent of total and magnitude. They are popular in business and marketing.

- **Streamgraph.** Streamgraph charts are typically used to illustrate how data has changed over time. They resemble a stacked area chart. However, the x-axis is not fixed. Streamgraphs are commonly used to illustrate trends in the Social Media arena.

- **Tag Cloud.** Tag Cloud charts display the most prominent terms in a visual representation for text data. They are noted for their quick display of relevant information, allowing you to make quick decisions and narrow your search for terminology. Tag Cloud charts are typically used to depict keywords on websites or to visualize free form text.

- **Treemap.** Treemap charts are used to display large amounts of hierarchically structured data. In a sectioned format, each rectangle represents an aspect of the selected measure. When a second measure is indicated, color coding is applied, emphasizing the unique sections of the treemap.

- **Grid.** Grids present data in tabular form. For example, in Chart mode, you can use the Grid chart type to create a table that summarizes your data. This option is also available in Visualization mode.

**Creating Your Own Chart Types**

Business User Edition supports the ability to add new, custom chart types to its list of built-in charts. These custom chart types are called extensions or plug-ins. An extension is a block of code that accesses resources external to Business User Edition. This topic describes the structure of an extension and the steps necessary to create your own and add it to the chart library.
Introducing Chart Extensions

Chart extensions are written in JavaScript. The visual part of a visualization can be drawn with HTML, Canvas, or SVG. Extensions can include external CSS and JS libraries (such as d3), which can be used to build almost any visualization. The WebFOCUS Extension API is limited to new, complete chart types only. It is not possible to add features to existing chart types, and it is not possible to modify or extend parts of Business User Edition outside of the chart area allocated to your extension.

This topic summarizes the process of writing, configuring, and installing a chart extension. Detailed instructions can be found on the Information Builders GitHub site:

https://github.com/ibi/wf-extensions-chart

Business User Edition extensions must be placed in the extensions folder under the web_resource folder of your Business User Edition installation. By default, this is the following location:

c:\ibi\install_dir\config\web_resource\extensions

where:

install_dir


Several sample chart extensions have already been installed in the extensions folder so that you can see their code, their structure, and how they are accessed in Business User Edition.

**Note:** The user installing the extension must know how to write JavaScript code for what the chart extension needs to generate. The GitHub site documents how to make the extension conform to the WebFOCUS API and how to install the extension in the Business User Edition chart library. It does not describe how to write JavaScript code.

Creating a Chart Extension

This section summarizes the build cycle for creating an extension and the structure and components of an extension.

**Reference:** Build Cycle for Writing an Extension

Creating an extension often involves cycles of writing, running, and then debugging code.

When you make changes to the properties.js file for your extension, you need to clear the Business User Edition cache in order for those changes to be recognized. Clear the cache using the *Clear cache* link in the Administration Console.
If you change the .js code for your extension (for example, com.ibi.simple_bar.js), you do not need to make any changes to Business User Edition. You only need to clear your own browser cache, to ensure that the new JavaScript file is downloaded. The same is true if you change any additional .js files included by your extension.

**Reference:** Extension Structure

The Simple Bar extension example demonstrates the required and optional files in an extension, and how those files are typically laid out.

You can open com.ibi.simple_bar and com.ibi.simple_bar.js in a text editor to see exactly how an extension is written.

The extension ID (ext_id) is a string in the form com.your_company.extension_name. The ext_id must be all lowercase, and can include only letters, numbers, underscores and dots. The entire extension lives in a folder named ext_id. The core of the extension lives in a file named ext_id.js. This file includes code to render the extension as a new chart type within Business User Edition.

The properties.json file configures your extension to run in Business User Edition. This file includes all the metadata needed to include your extension in Business User Edition, as well as a list of all properties you wish to expose to end users, so they can customize the behavior of your extension.

The extension folder can also include optional additional folders for external css and lib resources. If your extension uses any additional CSS or JavaScript library files, you can keep those resources organized in dedicated folders, such as css and lib, as you choose. External resources are configured and loaded inside the base ext_id.js file of your extension.

**Using the Chart Extension API**

To see examples of everything that the chart extension API provides, look at com.ibi.simple_bar.js. It is divided into two main parts, chart rendering and extension configuration.

**Rendering Charts**

The extension API provides three entry points that you can use as needed by defining your own JavaScript callback functions. They are passed a set of properties in a config object. Some properties are available during the entire rendering process, and some are only available during render callback.
**Reference:** Chart Rendering Callback Functions

You can define the following three JavaScript callback functions. Only the renderCallback function is always required.

- **initCallback(successCallback, config)** This optional function is invoked by the engine exactly once during library load time, providing a way to implement document.onload initialization code. This function is passed a successCallback, which you must invoke with `true` if your initialization code succeeded or `false` if it was not successful. If you call successCallback(false), no further interaction with your extension will occur, and your extension will render as an empty page.

- **preRenderCallback(config)** This optional function is invoked each time your extension is to be rendered, as the very first step in the overall rendering process. This is a good place to examine and tweak or override any internal chart properties that will affect the subsequent rendering.

- **renderCallback(config)** This required function must contain all of the code that will actually draw your chart. The `config` object will contain the properties described in the following sections.

Each of the three entry point callbacks is passed a config object, which contains a set of useful properties.
**Example: Sample renderCallback Function**

The following sample renderCallback code renders the Simple Bar extension.

```javascript
function renderCallback(renderConfig) {
    var chart = renderConfig.moonbeamInstance;
    var props = renderConfig.properties;
    var container = d3.select(renderConfig.container)
        .attr('class', 'com_ibi_chart');
    var data = renderConfig.data;
    if (renderConfig.dataBuckets.depth === 1) {
        data = [data];
    }

    var seriesCount = data[0].length;
    var seriesLabels = data[0].map(function(el){return el.labels;});
    data = d3.transpose(data).map(function(el, idx) {
        el = el[0];
        var v = Array.isArray(el.value) ? el.value : [el.value];
        var y0 = 0;
        return v.map(function(d, s) {
            return chart.mergeObjects(d, {y0: y0, y1: y0 += d, seriesID: s, value: d, labels: seriesLabels[idx]});
        });
    });

    var w = renderConfig.width;
    var h = renderConfig.height;
    var x = d3.scale.ordinal().domain(pv.range(seriesCount)).rangeRoundBands([0, w], 0.2);
    var ymax = d3.max([], function(d){return d.y1;});
    var y = d3.scale.linear().domain([0, ymax]).range([25, h]);
    var svg = container.selectAll("g")
        .data(data)
        .enter().append("g")
        .attr('transform', function(d, i){return 'translate(' + x(i) + ', 0)';});

    svg.selectAll("rect")
        .data(function(d){return d;})
        .enter().append('rect')
        .attr("width", x.rangeBand())
        .attr("y", function(d) {return h - y(d.y1);})
        .attr("height", function(d){return y(d.y1) - y(d.y0);})
        .attr('tdgtitle', function(d, s, g) {
```
```
To support tooltips, each chart object that should draw a tooltip must set its 'tdgtitle' attribute to the tooltip's content string.

// Retrieve the chart engine's user-defined tooltip content with getToolTipContent():
// 's' and 'g' are the series and group IDs for the riser in question.
// 'd' is this riser's individual datum, and seriesData is the array of data for this riser's series.
var seriesData = chart.data[s];
var tooltip = renderConfig.modules.tooltip.getToolTipContent(s, g, d, seriesData);
// getToolTipContent() return values:
// - undefined: do not add any content to this riser's tooltip
// - the string 'auto': you must define some 'nice' automatic tooltip content for this riser
// - anything else: use this directly as the tooltip content
if (tooltip === 'auto') {
  if (d.hasOwnProperty('color')) {
    return 'Bar Size: ' + d.value + '<br>Bar Color: ' + d.color;
  }
  return 'Bar Size: ' + d.value;
}
return tooltip;

[attr('class', function(d, s, g) {
  // To support data selection and tooltips, each riser must include a class name with the appropriate seriesID and groupID
  // Use chart.buildClassName to create an appropriate class name.
  // 1st argument must be 'riser', 2nd is seriesID, 3rd is groupID, 4th is an optional extra string which can be used to identify the risers in your extension.
  return chart.buildClassName('riser', s, g, 'bar');
})]
[attr('fill', function(d) {
  // getSeriesAndGroupProperty(seriesID, groupID, property) is a handy function
  // to easily look up any series dependent property. 'property' can be in dot notation (eg: 'marker.border.width').
  return chart.getSeriesAndGroupProperty(d.seriesID, null, 'color');
});]

.renderConfig.modules.tooltip.updateToolTips();  // Tell the chart engine your chart is ready for tooltips to be added
.renderConfig.modules.dataSelection.activateSelection();  // Tell the chart engine your chart is ready for data selection to be enabled
### Reference: Properties That Are Always Available

The following properties are always available.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>moonbeamInstance</td>
<td>The chart instance currently being rendered.</td>
</tr>
<tr>
<td>data</td>
<td>The data set being rendered.</td>
</tr>
<tr>
<td>properties</td>
<td>The block of properties for your extension, as set by the user.</td>
</tr>
<tr>
<td>dataBuckets</td>
<td>Optional custom data buckets. For information, see <em>Defining and Using Buckets in an Extension</em> on page 438.</td>
</tr>
</tbody>
</table>

### Reference: Properties Available Only During Render Callback

The following properties are available only during render callback, and are used by your chart rendering code (renderCallback).

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>width</td>
<td>Width of the container your extension renders into, in pixels.</td>
</tr>
<tr>
<td>height</td>
<td>Height of the container your extension renders into, in pixels.</td>
</tr>
<tr>
<td>containerIDPrefix</td>
<td>The ID of the DOM container your extension renders into. Prepend this to all IDs your extension generates, to ensure multiple copies of your extension work on one page.</td>
</tr>
<tr>
<td>container</td>
<td>DOM node for your extension to render into, either an HTML DIV element or an SVG G element, depending on your chosen containerType extension configuration</td>
</tr>
<tr>
<td>rootContainer</td>
<td>DOM node containing the specific chart engine instance being rendered.</td>
</tr>
</tbody>
</table>
Configuring Your Chart Extension

Extension configuration consists of two parts.

- Chart Engine Configuration configures the extension to interact with the chart engine and in Business User Edition Chart mode. This part of the extension configuration is defined in the config object that is passed to the chart renderer functions.

- Chart Interface Configuration interacts with the chart type picker in the user interface and the chart attribute categories. This part of the extension configuration is defined in the properties.json file.

Creating a config Object for Chart Engine Configuration

To configure your extension, create a config object with all the information unique to your extension, then register your extension with the extension API.

**Reference:** Creating a config Object for Your Extension

Required and optional properties in your config object are described in the following table.

<table>
<thead>
<tr>
<th>Property Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>id</td>
<td>Is the extension ID described in Extension Structure on page 429.</td>
</tr>
<tr>
<td>name</td>
<td>Is the name for the chart type to be displayed in the user interface.</td>
</tr>
<tr>
<td>description</td>
<td>Is a description for the chart type to be displayed in the user interface.</td>
</tr>
<tr>
<td>containerType</td>
<td>Is either 'html' or 'svg' (the default).</td>
</tr>
<tr>
<td>initCallback</td>
<td>Optional. References your initCallback function, described in Rendering Charts on page 429.</td>
</tr>
<tr>
<td>preRenderCallback</td>
<td>Optional. References your preRenderCallback function, described in Rendering Charts on page 429.</td>
</tr>
<tr>
<td>renderCallback</td>
<td>Required. References your renderCallback function, described in Rendering Charts on page 429.</td>
</tr>
<tr>
<td>Property Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-------------</td>
</tr>
<tr>
<td>resources</td>
<td>Optional. Are additional external resources (CSS and JS) required by this extension.</td>
</tr>
</tbody>
</table>

**Example:** Sample config Object

The following code is a sample of the config object used with the Simple Bar extension.

```javascript
var config = {
  id: 'com.ibi.simple_bar', // string that uniquely identifies this extension
  containerType: 'svg', // either 'html' or 'svg' (default)
  initCallback: initCallback, // Refers to your init callback fn (optional)
  preRenderCallback: preRenderCallback, // Refers to your preRender callback fn (optional)
  renderCallback: renderCallback, // Refers to your render fn (required)
  resources: { // Additional external resources (CSS & JS) required by this extension (optional)
    script: ['lib/d3.min.js'],
    css: ['css/extension.css']
  },
}
```

**Reference:** Registering Your Extension

To register your extension with the WebFOCUS extension API, call:

```javascript
tdgchart.extensionManager.register(config);
```

**Reference:** Tips for Building Your Extension

The easiest way to build your own extension is to clone the Simple Bar example, then tweak it. Assume the ID of the new extension is com.foo.bar:

2. In com.foo.bar.js, delete the inner content of the three callback functions.
3. In com.foo.bar.js, change the entries for each property in config to match the requirements of your extension.
4. Add any external resources you need to lib and css, and load them by setting config.resources in com.foo.bar.js.
5. Implement renderCallback in com.foo.bar.js to draw your extension.
Configuring the Chart Interface

Each extension must include a properties.json file, which defines the information needed by Business User Edition when drawing its user interface.

The properties.json file consists of the following blocks.

- **info.** This block defines several general purpose configuration options.

- **properties.** This block defines any properties of your extension that the end user may want to change. The user can change these properties in the GRAPH_JS blocks in a Business User Edition chart procedure.

- **propertyAnnotations.** This block validates the content of the properties block. Everything in properties must appear in propertyAnnotations. The possible types of any non-object (leaf) property in properties must be notated as one of "str", "bool", or "number".

- **dataBuckets.** This block defines the set of chart attribute categories that appear in the Query pane in Business User Edition when creating a chart. Each member in the dataBuckets collection is a bucket.

  There are two types of buckets, built-in and custom. Built-in buckets provide an easy way to reuse the existing Business User Edition data bucket logic. There are currently two built-in buckets, tooltip, and series_break. Use any of these buckets by setting the associated dataBuckets property to true.

- **bucket.** Each bucket block defines one custom chart attribute category. Each custom bucket requires the following properties:

  - **id.** This property corresponds exactly to the dataArrayMap and data properties that will be received by the render function for your chart.

  - **type.** This property defines the type of data field this bucket accepts, "measure", "dimension", or "both".

  - **count.** Consists of count.min and count.max, which define the minimum and maximum number of fields this bucket can accept. A minimum of 0 means this bucket is optional.

  - **translations.** Defines translations in different languages for every label to be drawn in Business User Edition. The translation object has one property for each language the extension supports, keyed by ISO-639 two letter locale strings.
Example: Sample properties.json File

The following properties.json file is from the Simple Bar extension.

```json
{
  // Define some general extension configuration options
  "info": {
    "version": "1.0",  // version number of your extension.
    "implements_api_version": "1.0",  // version number of the WebFocus
    "author": "Information Builders",
    "copyright": "Information Builders Inc.",
    "url": "https://github.com/ibi/wf-extensions-chart/tree/master/
    simple_bar%20example",
    "icons": {  // Reference to an image in the extension, used in the WF chart picker
      "medium": "icons/medium.png"
    }
  },
  // Define any properties of your extension that end user may want to change.
  "properties": {
    "exampleProperty": 50
  },
  // Define the possible values for each property in 'properties'.
  "propertyAnnotations": {  // number
    "exampleProperty": "number"
  },
  // Define the available data buckets drawn in WF's 'Query' data bucket tree.
  "dataBuckets": {
    // Choose whether or not to reuse existing WF data buckets. All optional.
    "tooltip": false,
    "series_break": false,
  }
}
```
// Define your own custom data buckets. Optional
"buckets": [ 
  
  
  "id": "value",
  "type": "measure",
  "count": {"min": 1, "max": 5}
  
  
  
},
  
  "id": "labels",
  "type": "dimension",
  "count": {"min": 1, "max": 5}
  
  
  ]
  
  
  },
  
  
  // Define the set of labels used in the WF interface for buckets and
  
  chart type picker.
  "translations": { 
  "en": { 
  "name": "My Simple Bar Chart",
  "description": "This chart is just a simple bar chart, nothing
to see here.",
  "icon_tooltip": "This extension does ...",
  "value_name": "Value Bucket",
  "value_tooltip": "Drop a measure here",
  "labels_name": "Label Bucket",
  "labels_tooltip": "Drop a dimension here"
  
  
  },
  "fr": { 
  "name": "Un Bar Chart tres simple",
  "description": "C'est un Bar Chart vraiment simple",
  "icon_tooltip": "This extension does ...",
  "value_name": "Value Bucket",
  "value_tooltip": "Drop a measure here",
  "labels_name": "Label Bucket",
  "labels_tooltip": "Drop a dimension here"
  
  
  }
  
  
  }
  
  
  

Accessing Data for Your Extension

Each time an extension is rendered, the render callback for the extension is passed the
current data set using the renderConfig.data argument. The overall structure of the data set is
defined by the set of buckets listed in the properties.json file, while the specific content of the
data is defined by the data fields the user has added to each bucket.

Defining and Using Buckets in an Extension

The data set is passed into an extension using the data property of the first argument of the
render callback, typically named renderConfig. Additional information about the current set of
fields in each bucket is in renderConfig.dataBuckets.
A data set is represented in JavaScript as arrays of objects. If an extension defines only custom buckets, the data set will be a flat array of objects. If an extension uses some built-in buckets, the data set may contain deeply nested arrays of arrays. The `renderConfig.dataBuckets.depth` property will be set to the number of array dimensions in the current data set.

**Custom Buckets**

Each innermost object within the arrays of data (called a *datum*) will have one property for each data bucket that contains a field. Each property will be the id of a custom bucket, as defined in the `dataBuckets.buckets` section of `properties.json`. The type of values of these properties depend on the bucket type. Dimension buckets have string values, while measure buckets have numeric values. If a bucket contains more than one field, the associated property for each innermost object will be an array of string or number values.

If you implement the extension API version 2, you can retrieve the field name and number format associated with a data bucket entry. To use API 2 and get a bucket entry field name or number format, an extension must declare that it implements extension API version 2 using the 'implements_api_version' entry in the info block of `properties.json`:

```json
{
   "info": {
      "implements_api_version": "2.0"
   }
}
```

**Built-in Buckets**

An extension can use buckets that are built-in and predefined by Business User Edition. These buckets will affect more than just the data set. Each bucket will also set specific chart engine properties, to pass in additional information related to that bucket.

Each built-in bucket is either a *standard* bucket or a *break* bucket.

- **Standard buckets** behave exactly like custom buckets. The data set remains a single array, and each datum object will include an additional property named after the bucket.

- **Break buckets** divide the data set into additional arrays of data. For each break bucket used, each datum object will be transformed into a full array of datum objects. The number of datum objects in each array will remain unchanged, but the number of arrays or datum arrays will correspond to the number of entries in the break field.
Types of Break Buckets

Break buckets can be of two types:

- A series-break bucket breaks the data set into one array for each entry in the series break field chosen by the user. A series-break bucket uses series-dependent properties defined in the chart engine, and the data names are now listed in those series-dependent properties. Each entry in the series-break field will generate a corresponding series property object in the chart engine, retrievable with renderConfig.moonbeamInstance.getSeries(x), where x is an integer for the series to be retrieved. getSeries returns an object with properties such as color and label, which are unique to the chosen series.

- A matrix-break bucket is used for the sort fields that define the columns and rows in a matrix chart. A matrix-break bucket also adds more array dimensions to the data set. A matrix-break bucket is broken into column and row sub-buckets. If either the row or column bucket contains any fields, the data set will contain two additional dimensions of data, even if one of the matrix buckets is empty. That is, the data set will either contain neither row nor column data, or both row and column data, never just one or the other. bucket.depth will always be at least three.

The Tooltip Bucket

The tooltip bucket is not a break bucket, and does not add any additional array dimensions to the data set. Instead, tooltip behaves like a custom bucket. Each inner datum object will contain a property named tooltip, with a value of type string for dimensions, number for measures, and an array of values for multiple fields in the bucket.

The usefulness of this bucket is that in addition to including tooltip-specific data in the data set, Business User Edition also generates meaningful tooltip content for each series. This tooltip content is the same content used for all of the built-in Business User Edition chart types. Using the tooltip bucket means the extension does not have to figure out what ought to go into each tooltip.

Example: Sample Series-Break Bucket Definition

This example uses the following sample data.

<table>
<thead>
<tr>
<th>Car</th>
<th>Country</th>
<th>Seats</th>
</tr>
</thead>
<tbody>
<tr>
<td>BMW</td>
<td>Germany</td>
<td>5</td>
</tr>
<tr>
<td>Audi</td>
<td>Germany</td>
<td>4</td>
</tr>
<tr>
<td>Car</td>
<td>Country</td>
<td>Seats</td>
</tr>
<tr>
<td>-----------</td>
<td>---------</td>
<td>-------</td>
</tr>
<tr>
<td>Peugeot</td>
<td>France</td>
<td>5</td>
</tr>
<tr>
<td>Alfa Romeo</td>
<td>Italy</td>
<td>4</td>
</tr>
<tr>
<td>Maserati</td>
<td>Italy</td>
<td>2</td>
</tr>
<tr>
<td>Toyota</td>
<td>Japan</td>
<td>4</td>
</tr>
</tbody>
</table>

The following code defines a series-break bucket for API version 1.0.

```javascript
dataBuckets:
    series_break: true,
    buckets: [
        {id: "label", type: "dimension"},
        {id: "value", type: "measure"}
    ]
```

Consider the following fields assigned to each of the buckets:

- "Country" assigned to the "series_break" bucket.
- "Car" assigned to the "label" bucket.
- "Seats" assigned to the "value" bucket.

In the renderConfig function, the renderConfig.data object will be similar to the following, in which the Country values are no longer part of the data array. However, a new array starts for each change in the Country value:

```javascript
[{{labels: "PEUGEOT", value: 5}},
 {{labels: "ALFA ROMEO", value: 4}, {{labels: "MASERATI", value: 2}},
 {{labels: "TOYOTA", value: 4}}],
 {{labels: "AUDI", value: 4}, {{labels: "BMW", value: 5}}]
```

The renderConfig.dataBuckets object will be defined as follows:

```javascript
renderConfig.dataBuckets = {
    depth: 2,
    series_break: {title: "Country"},
    buckets: {
        label: {title: "Car"},
        value: {title: "Seats"}
    }
```

If you are using API version 2.0, dataBuckets.buckets is an array instead of an object. Each entry in this array represents the content of one data bucket. The id property identifies which bucket this is, and the fields array specifies how many entries are in this bucket and the unique information for each (titles, field names, number formats).
The dataBuckets object includes a method named getBucket(). Pass it the name of a bucket and it returns the content of that bucket.

There are two types of buckets, built-in and custom. Built-in buckets provide an easy way to reuse the existing WebFOCUS data bucket logic. There are currently two built-in buckets, tooltip, and series_break. Use any of these buckets by setting the associated dataBuckets property to true.

The dataBuckets block includes the following objects for API Version 2.0.

- **depth.** Specifies the number of buckets in the buckets array.
- **buckets.** Specifies the properties of all fields for all buckets.
  - **id.** This property corresponds exactly to the dataArrayMap and data properties that will be received by the render function for your chart.
  - **fields.** Is an array of fields for each bucket. For each field, defines the field title, name, and number format:

```
{"title": "fieldtitle", "fieldName": "fieldname", "numberFormat": "format"}
```
With API Version 2.0, the content of renderConfig.dataBuckets that is passed to each render callback in an extension provides field title and format information. In the following example, the there are two buckets. The labels bucket has one field, CAR.ORIGIN.COUNTRY, whose title is COUNTRY. The value bucket has two fields, CAR.SALES, title SALES, and CAR.BODY.DEALER_COST, title DEALER_COST.

```
"dataBuckets": {
  "getBucket (bucketName)",
  "depth": 2,
  "buckets": [
  {
    "id": "labels",
    "fields": [
    {"title": "COUNTRY", "fieldName": "CAR.ORIGIN.COUNTRY"
    ]
  }
  }
  {
    "id": "value",
    "fields": [
    {"title": "SALES", "fieldName": "CAR.SALES",
      "numberFormat": ",,###.00"},
    {"title": "DEALER_COST",
      "fieldName": "CAR.BODY.DEALER_COST",
      "numberFormat": "#,####"
    ]
  }
  ]
}
```

**Handling Partial and Null Data in an Extension**

In many cases, the end user working with an extension cannot populate all of the extension buckets immediately. An extension must correctly handle these partial data cases, and cannot crash if one or more buckets are empty. It is important to check renderConfig.dataBuckets to see which buckets have been populated, and act accordingly.

In addition, data sets are often incomplete, missing some values for a given combination of dimensions and measures. These missing values may show up in the data set as null entries within an array (instead of datum objects), or they may show up as entirely empty arrays. It is important to detect and handle these missing data cases, and render a visualization appropriate for such missing data.
Most extensions require some minimum number of populated buckets before anything can be rendered. Use the count.min properties of each dataBuckets.bucket entry in properties.json to define these minimum requirements. If the fields in all buckets do not meet the minimum counts, then the renderCallback for the extension will not be called. Instead, the noDataPreRenderCallback for the extension is called. This allows the extension to render in a special no data mode. In this mode, the extension should render in grey scale, using renderCallback.baseColor as the main color. This should be a very simplified, sample rendering of the extension.

**Example:** Sample noDataPreRenderCallback Function

The following noDataPreRenderCallback function is from the Simple Bar sample extension.

```javascript
function noDataRenderCallback(renderConfig) {
  var grey = renderConfig.baseColor;
  renderConfig.data = [{value: [3, 3]}, {value: [4, 4]}, {value: [5, 5]}, {value: [6, 6]}, {value: [7, 7]}];
  renderConfig.moonbeamInstance.getSeries(0).color = grey;
  renderConfig.moonbeamInstance.getSeries(1).color = pv.color(grey).lighter(0.18).color;
  renderCallback(renderConfig);
}
```

**Installing a Chart Extension**

1. Find the extensions folder for your local Business User Edition installation. This is typically the following folder.

   C:\ibi\install_dir\config\web_resource\extensions

   where:

   **install_dir**


   **Note:** The WebFOCUS Extension section of the Information Builders GitHub page maintains a list of publicly available and supported extensions. To install one of those, click the extension you want to install, then right click the zip file for that extension, for example *com.ibi.xyz.zip*, and choose Save link as...

2. Unzip the downloaded zip file into the Business User Edition extensions folder. For example, for the *com.ibi.xyz.zip* zip file, this should create the following folder.

   C:\ibi\install_dir\config\web_resource\extensions\com.ibi.xyz

   If you are installing your own extension from your own environment, copy or download it to the Business User Edition extensions folder, using the same naming conventions for the folder and the extension ID as described for the sample extensions.
3. Edit C:\ibi\install_dir\config\web_resource\extensions\html5chart_extensions.json. Create a new line for the new extension in the form:

"com.ibi.abc": {"enabled": true},

where:

abc

Is the name of the extension.

4. In the Administration Console, click Clear cache. This will force WebFOCUS to reload all extensions.

Following is a sample html5chart_extensions.json.

{
    "com.ibi.simple_bar": {enabled: true},
    "com.ibi.liquid_gauge": {enabled: false},
    "com.ibi.sankey": {enabled: true}
}

Note: The Administration Console provides a user interface for installing chart extensions. For information, see How to Install HTML5 Chart Extensions From the IBI GitHub Page on page 140.

Reference: Preserving Custom Chart Types When Reinstalling Business User Edition

If you reinstall the Business User Edition, your extensions folder will be overwritten. Therefore, if you have installed any custom chart extensions, you should preserve them by copying them to another location prior to reinstalling the Business User Edition and copying them back to the extensions folder after reinstalling the Business User Edition.

You will also have to copy the entries for your custom extensions into the new html5chart_extensions.json file installed with the new version of Business User Edition.

Note: The extensions that are delivered as part of Business User Edition will be reinstalled automatically, so you should not preserve those extensions. In that way, if any enhancements have been made to those extensions, you will automatically have access to the enhanced versions when you reinstall Business User Edition.
Using Your Extension in a WebFOCUS Request

If you have installed and configured your extension as described, your extension will be available for use in Business User Edition as a chart type in the Other format category under HTML5 Extension, as shown in the following image.

The attribute categories you defined in the dataBuckets object of your extension are available in the query pane.

In the FOCEXEC:

- The LOOKGRAPH value is EXTENSION.

- The actual extension to use is identified in the chartType property of the *GRAPH_JS block in the StyleSheet. For example:

  ```
  *GRAPH_JS
  chartType: "com.ibi.simple_bar",
  }
  ```

- Each custom attribute category name is prepended with a greater-than character (>). For example:
The following is a sample request using the Simple Bar extension.

```sql
GRAPH FILE WF_RETAIL_LITE
SUM COGS_US
GROSS_PROFIT_US
REVENUE_US
DISCOUNT_US
BY PRODUCT_CATEGORY
ON GRAPH PCHOLD FORMAT JSCHART
ON GRAPH SET LOOKGRAPH EXTENSION
ON GRAPH SET AUTOFIT ON
ON GRAPH SET STYLE *
INCLUDE=IBFS:/FILE/IBI_HTML_DIR/javaassist/intl/EN/combine_templates/ENWarm.sty,$
TYPE=DATA, COLUMN=PRODUCT_CATEGORY, BUCKET= >labels, $
TYPE=DATA, COLUMN=COGS_US, BUCKET= >value, $
TYPE=DATA, COLUMN=GROSS_PROFIT_US, BUCKET= >value, $
TYPE=DATA, COLUMN=REVENUE_US, BUCKET= >value, $
TYPE=DATA, COLUMN=DISCOUNT_US, BUCKET= >value, $
*GRAPH_JS
chartType: "com.ibi.simple_bar",
*END
ENDSTYLE
END
```
Run the chart. The output is shown in the following image.

### Building a Document

Document view allows you to build multiple reports and charts on the same canvas. The styling, design, and report building functionality of Live Preview and Query Design view is available in Document view.

In addition, there are many other features that simplify building documents. You can build and insert multiple reports in the form of reports and charts into documents. You can also insert images and text for presentation and organizational purposes.

### Inserting Reports From Multiple Data Sources

With InfoAssist opened in Document view, you can insert multiple charts and reports onto the canvas. These reports can be from different data sources. With documents, you have the option to add additional data sources to the document.

In order to insert reports from different data sources, the document must have multiple data sources loaded. For more information on adding and switching between data sources, see Data Tab on page 87.

**Procedure:** How to Insert Two Reports From Two Different Data Sources

A document can display multiple reports from multiple data sources in the same document.

1. With InfoAssist open in Document view, click the Insert tab and select chart or report.
2. If your document has only one data source, insert additional data sources.
   For more detailed instructions on inserting multiple data sources, see Data Tab on page 87.

3. Switch to a data source different than the one used in step 1.
   For more detailed instructions on switching to a different data source, see Data Tab on page 87.

4. Insert a chart or report using this new data source, following the instructions given in Inserting a New Report on page 449.
   Your document is now populated with reports that have data from different data sources. You can add as many data sources as you need.

Inserting a New Report

With InfoAssist opened in Document view, you can insert multiple charts and reports onto the canvas. The procedures in the following sections detail how to insert reports into documents.

In Document view, you can insert a report in the following ways:

- Use the Insert tab.
- Double-click a data source field.
- Right-click a data source field.
- Drag a data source field onto the canvas.

Note:

- When you use the Insert tab, double-click a data source field, or right-click a data source field, a report placeholder is added to the canvas.

- When you insert an existing report, which has already been created and is referenced via INCLUDE syntax, and then select it on the Document canvas, the data fields do not display in the Query pane.

Dragging a data source field onto the canvas inserts the placeholder at the location you dropped it.

The following procedures describe how to insert new reports. For more information on how to edit existing reports, see How to Style and Customize a Report on page 457.
Procedure: How to Insert a Report

Do one of the following, while in Document mode:

- On the Insert tab, in the Reports group, click Report. Add fields to the placeholder report.
- On the Home tab, in the Format group, click Report. Double-click a data source to automatically create a report with that data.
- On the Home tab, in the Format group, click Report. Drag a field to the canvas to create a report.

Inserting a New Chart

With InfoAssist opened in Document view, you can bring multiple charts and reports onto the canvas. The procedures in the following sections describe how to insert charts into documents.

In Document view, you can insert a chart in the following ways:

- Use the Insert tab.
- Double-click a data source field.
- Right-click a data source field.
- Drag a data source field from the Resources panel onto the canvas.

Note: When you use the Insert tab, double-click a data source field, or right-click a data source field, a chart placeholder is added to the canvas.

Dragging a data source field onto the canvas inserts the place holder at the location you dropped it.

The following procedures describe how to insert new charts. For more information on how to edit existing charts, see How to Style and Customize a Chart on page 458.

Procedure: How to Insert a Chart

1. Do one of the following, while in Document mode:

- On the Insert tab, in the Reports group, click Chart. Add fields to the placeholder chart.
- On the Home tab, in the Format group, click Chart. Double-click a data source to automatically create a chart with that data.
- On the Home tab, in the Format group, click Chart. Drag a field to the canvas to create a chart.
2. Optionally, change the chart format using the options on the Format tab, in the Chart Types group.

**Inserting an Existing Report**

With InfoAssist opened in Document view, you can insert existing charts and reports onto the canvas from the Insert tab. The following procedure describes how you can insert reports into new documents and documents that are already populated with reports, text, and images.

**Note:** When working in Document view, you cannot insert an existing report that has a HOLD.

**Procedure:** How to Insert an Existing Report With the Insert Tab

You can create a document in the Custom Reports section of the domain and use Standard Reports items as Existing Report components. You cannot use other Custom Report items as components.

1. With InfoAssist open in Document view, click the Insert tab.
2. In the Reports group, click Existing Report.
   
   An Open dialog box appears.
3. Browse to the report that you want to insert and click Open.
   
   The report placeholder is added to the canvas.

**Note:** You cannot edit an existing report that is inserted into a document.

**Creating a Document From a Single Report**

You can take a single report created in Live Preview or Query Design view and convert it into a document, displaying it in Document view.

When you convert a single report into a document, the original report is preserved and a copy of that report is opened as a document in Document view. You can then add additional reports, charts, images, and text.

**Inserting Text and Images**

With InfoAssist opened in Document view, you can bring text and images onto the canvas. The following procedures describe how you can insert text and images into new documents and documents that are already populated with reports, text, and images.

**Note:** You can only do this in Document view.

The following procedures detail how to insert text and images. For more information on how to edit existing text and images, see *Editing Components in a Document* on page 453.
Procedure: How to Insert Text

1. With InfoAssist open in Document view, click the Insert tab.
2. In the Objects group, click Text Box.
   A text component is added to the canvas, containing default text.
3. Double-click, or right-click, the text component to edit the text.
   For more information on editing and styling the text, see How to Edit Text on page 458.

Procedure: How to Insert an Image

1. With InfoAssist open in Document view, click the Insert tab.
2. In the Objects group, click Image.
   An Open dialog box appears.
   Note: By default, the Open dialog box displays image files in the current WebFOCUS Content folder.
3. Browse to the desired image and click OK.
   The selected image is added to the canvas.

Procedure: How to Create an Adaptive Dashboard

In Document mode, you can create an Adaptive Dashboard. This is a feature that provides a mobile view with a fixed layout that will make dashboards easier to use while navigating on mobile devices.

1. With InfoAssist open in Document mode, click the Layout tab.
2. In the Page Layout group, click Adaptive Dashboard.
3. Add components as needed.
4. Access the dashboard from a mobile device, making adjustments, as needed.
   Note: You must run an Adaptive Dashboard using the Run in new window option to take advantage of this feature on a mobile device or tablet. When using an Adaptive Dashboard inside an iframe on a mobile device (for example, when running it from the Home Page without using the New Window option), the output is displayed with the components layout and menu options displayed when run from a desktop.
Editing Components in a Document

The reports, controls, and text in a document can be edited, moved, resized, and deleted. Each of these components has a context menu, which can be accessed by right-clicking the component.

Images can be moved, resized, and deleted, but they have no context menu and cannot be edited. Right-clicking an image brings up the option to delete it.

Procedure: How to Resize a Component

You can resize a component in the following ways:

- Using the component sizing handles.
- Changing the height and width on the Layout tab, in the Size & Arrange group.
- Accessing the options on the Size tab in the Size and Position dialog box.

The resize feature is available for all components that can be added to a document.

1. Open or create a document with at least one report, text component, control, or image.
2. Resize the component in one of the following ways:
   - **Sizing Handles:** Select the component and drag the sizing handles that appear around it. As you manually increase the height and width of the component, the new values appear in the corresponding text boxes in the Size & Arrange group of the Layout tab.
   - **Ribbon:** You can use the ribbon in one of the following ways:
     - Select the component in the document. On the Layout tab, in the Size & Arrange group, enter values in the Height and Width fields.
     - On the Layout tab, in the Size & Arrange group, click the dialog box launcher to open the Size and Position dialog box, as shown in the following image.
   - **Shortcut Menu:** Right-click the component and select Size and Position. The Size and Position dialog box opens.

   **Note:** You must right-click the corner of the component. For charts, if you click on any other point in the chart, the Size and Position option will not display.
From the Size and Position dialog box, open the Size tab.

Use the Height and Width options to change the position of the selected component. You can adjust the pixel size of the object with the Size options or the scale percentage of the object with the Scale options.

You can lock the aspect ratio using the Aspect Ratio button, which is available when working with charts, images, and text boxes while working in Document view. With the aspect ratio locked, changing the width automatically changes the height to keep the component to scale, and changing the height automatically changes the width.

**Note:** The Auto Overflow option is only available while working with reports in Document view through the Size & Arrange group. With Auto Overflow set, you cannot manually set the height and width of a report. The area of the report expands automatically to show all data.

When two objects are selected, the *Relative Position* button sets the bottom-left corner of the component that is higher on the page to the upper-left corner of the one that is lower. Once a relationship is created, arrows appear to show that relationship while both items are still selected.

**Procedure:** How to Move a Component

You can move a component by clicking it, or by accessing the Position section of the Size and Position dialog box. This feature is available for all components that can be added to a document.

You can also align components with each other so that their horizontal or vertical position matches. For more information, see *How to Align Components* on page 455.

1. Open or create a document with at least one report, text component, control, or image.
2. Select the component and move it by using one of the following methods:
   - Drag the component anywhere on the canvas.
   - or
   - Right-click the component and click *Size and Position*.
     - On the Size and Position dialog box, click the *Position* tab.
     - Use the Horizontal and Vertical options to change the position of the selected component.
Procedure: **How to Align Components**

You can align components with each other so that their horizontal or vertical positions match. You must have multiple components selected to use the align options.

The alignment is anchored by the component that is in the farthest position of the selected alignment. For example, if you select two components and click *Align Left*, the components align horizontally with the component farthest to the left.

1. Open or create a document with at least two components.
2. Select a component.
3. Select a second component by holding the Ctrl key and clicking a component.

   **Note:** You can select multiple components simultaneously by holding the Ctrl key and with the left mouse dragging a selection box around the components. When you release the mouse, sizing handles appear around each component that you selected. If the components display with light-grey coloring, this indicates that the components are selected.
Sizing handles appear around the components, as shown in the following image.

4. Align the components using one of the following methods:

☐ Right-click one of the selected components and select an alignment option from the Align drop-down menu, as shown in the following image.

☐ Access the alignment options from the Align drop-down menu. The menu is available on the Layout tab, in the Size & Arrange group.
The selected components align, as shown in the following image.

5. Click anywhere in the canvas to deselect the components.

Procedure: How to Style and Customize a Report

When you select a component, you can perform various functions on the component, such as moving and resizing it, as explained in How to Move a Component on page 454 and How to Resize a Component on page 453. After clicking a component, you can use the ribbon to affect all settings of the selected component, except for fields. You can right-click a component to select individual fields to edit through the context menu.

In addition to reports, you can style and customize charts and text. For more information on charts, see How to Style and Customize a Chart on page 458. For more information on text, see How to Edit Text on page 458.

Note: Images cannot be edited.

1. Open or create a document with at least one report.
2. Click the report.
   
The Query pane becomes active and you can now select fields within the report. Select a field by clicking it in the canvas or in the Query pane.
Procedure: How to Style and Customize a Chart

When you select a component, you can perform various functions on the component, such as moving and resizing it, as explained in How to Move a Component on page 454 and How to Resize a Component on page 453. After clicking a component, you can use the ribbon to affect all settings of the selected component, except for fields. You can double-click or right-click a component to select individual fields to edit through the context menu or Field tab.

In addition to charts, you can style and customize reports and text. For more information on reports, see How to Style and Customize a Report on page 457. For more information on text, see How to Edit Text on page 458.

Note: Images cannot be edited.

1. Open or create a document with at least one chart.
2. Click the chart.
   The Query pane becomes active and you can now select fields within the chart. Select a field by clicking it in the canvas or in the Query pane.
   You can now edit the selected chart using commands available through the context menu or the ribbon.

Procedure: How to Edit Text

When you select a component, you can perform various functions on the component, such as moving and resizing it, as explained in How to Move a Component on page 454 and How to Resize a Component on page 453. After clicking a component, you can use the ribbon to affect all settings of the selected component, except for fields. You can right-click a component to select individual fields to edit through the context menu.

In addition to editing text, you can style and customize reports and charts. For more information on reports, see How to Style and Customize a Report on page 457. For more information on charts, see How to Style and Customize a Chart on page 458.

Note: Images cannot be edited.

1. Open or create a document with at least one text component.
2. Click the text box.
   Sizing handles appear around the border and the text box toolbar becomes active.
3. Click anywhere in the text box and begin entering text.
4. Highlight the text you would like to edit, and right-click it. A menu of options appears, as shown in the following image.

5. Using the menu options, you can style the text and insert quick text.

The text component menu options are as follows:

- **Font.** Opens a list of available fonts for the selected text.
- **Size.** Opens a list of available text sizes for the selected text.
- **Bold.** Formats the selected text in bold.
- **Italic.** Formats the selected text in italics.
- **Underline.** Underlines the selected text.
- **Text color.** Opens the Color dialog box where you can select a color for the selected text.
- **Cut.** Cuts the selected text.
- **Copy.** Copies the selected text to the clipboard.
- **Paste.** Pastes the selected text from the clipboard.
- **Date.** Opens a list of date quick text in various formats.
- **Time.** Opens a list of time quick text in various formats.
Procedure: How to Delete a Component

The following procedure applies to all components in Document view.

1. Open or create a document with at least one component.
2. Right-click the component and click Delete.

The component is deleted from the canvas.

Note: You can also delete a component by clicking it and pressing the Delete key.

Creating Multi-Page Documents

In Document mode, content can be created on multiple pages. The available output formats are: HTML, active report, PDF, Excel (xlsx), and PowerPoint (pptx). Additional Excel formats are available, as well.

Note: When working in Document mode using the active report format, you can create a rich, multi-object document that integrates various reports and charts, closely resembling a dashboard.

Microsoft Excel 2007 and Microsoft PowerPoint 2007 are enabled by default in the Administration Console. To enable or disable formats, you must do so in the Administration Console.

- The active report output format combines multiple reports and charts into one document, resulting in a tabbed active dashboard.

- Excel combines multiple reports as different sheets in a workbook.

- PowerPoint combines multiple reports and charts in a single slide.

Creating Multi-page Documents

You can create multi-page documents, allowing you to display an array of information across different pages.

Procedure: How to Create a Multi-page Document

1. Create a new document.
   Page 1 appears on the canvas title bar.
2. Add content, such as a new or existing report, chart, text, and images to Page 1.
3. To add another page, do one of the following:

- On the Insert tab, in the Pages group, click Page.

- On the canvas title bar, click the page icon. From the Page menu that opens, select New Page.

A new page, for example, Page 2, is inserted after the current page, and appears on the canvas.

Each new page that you add is named Page n, where n is a unique number increasing by an increment of 1.

4. Add content to Page 2.

5. Repeat steps 3 - 4 until your document is complete.

To navigate between pages, open the Page menu by clicking the Page icon at the top of the canvas.

Creating a Multi-page Active Technologies Dashboard

You can create a multi-page active technologies dashboard using InfoAssist.

Procedure: How to Create a Multi-page Active Technologies Dashboard

1. Create a new active dashboard by setting the output format to active report.
   Page 1 appears on the canvas title bar.

2. Add content, such as a new or existing report, chart, text, images, and active dashboard prompts to Page 1.

3. To add another page, do one of the following:

- On the Insert tab, in the Pages group, click Page.

- On the canvas title bar, click the page icon. From the Page menu that opens, select New Page.

A new page, for example, Page 2, is inserted after the current page, and appears on the canvas.

Each new page that you add is named Page n, where n is a unique number increasing by an increment of 1.

4. Add content to Page 2.

5. Repeat steps 3 - 4 until your dashboard is complete.
To navigate between pages, open the Page menu by clicking the Page icon at the top of the canvas.

6. Run the active dashboard.

The tabs appear at the top of the canvas.

Navigating the Page Menu

You can access the Page menu by clicking the Page icon in Design mode.

The Page menu lists the pages in the order in which you created them. You can rearrange the pages using drag-and-drop functionality. You can also select multiple pages and delete them.

In addition, the Page menu contains the New Page option to add a new page to the document. The Duplicate option creates a duplicate page.

The Page menu also contains Page Options which you can click to launch a dialog box of the following options:

- Rename Page
- Move Page Up
- Move Page Down
- Delete

When you select a page, the Rename, Move Up, Move Down, and Delete options become active in the menu bar at the top of the dialog box. Also, when you right-click a page, a context menu of these same options opens.

The position of the page that you have selected determines which directional options are available. For example, Move Up would not be an option for Page 1. Move Down would not be an option for the last page.

To close the dialog box, click OK.

Using the Active Cache Option

Because all post-retrieval processing is performed in the memory of the web browser, an active report has a processing limit of approximately 5,000 records or 100 pages of output. The active cache option enables you to send only the first page of active report output to the browser and retrieve subsequent pages from a temporary cache on the Reporting Server.
Tip: It is recommended that you set the number of rows retrieved five times greater than the number of lines retrieved per page (as indicated in SET LINES). The minimum number of rows retrieved is 100.

Enabling Active Cache Through InfoAssist

Active cache is enabled when you select active report as the output type and the Pages on Demand button (Format tab, Navigation group) is enabled.

The Advanced tab on the active report options dialog box contains the Rows Retrieved drop-down list. Use this setting to establish the increments in which the cached data stored in a binary file is returned to the output window. The default is 100.

Note: In a multi-page document, active cache must be enabled per component. It is not globally set. Therefore, when creating a document in AHTML format, you must select each component separately to enable active cache. When you do so, the Pages on Demand button is activated.

Building Visualizations

Visualizations centralize information by providing different views of data that are pertinent to a particular objective. For example, reviewing trends or fluctuations in data over a period of time or within a region. A visualization provides you with a quick glance of information on a single screen.

Visualizations support the use of different types of charts, maps, and grids. For example, you may want to use a bar, pie, and line chart to show different views of the same data. Alternatively, you may want to offset a particular visual by showing other types of related data that employ a different type of visual. You can also add a text cell to your visualization to provide explanatory text or information that other users can reference.

Visualizations allow you to monitor changes in data. They also serve to provide information in real-time, based on changes in underlying data or other components. A visualization can be updated, changed, or revised at any time to account for shifts in data needs.

Creating a Visual

You can create charts, maps, and grids to visually represent your data. You can add multiple visuals to the canvas to create a complete visualization.

The default visual is a bar stacked chart. You can use the Change option in the Visual group on the Home tab to change the visual type.
The following visual is a matrix marker chart that shows sales data for a range of electronic products.

![Matrix Marker Chart]

**Procedure: How to Create a Visualization From InfoAssist**

You can have multiple file types opened at once. To create a visualization:

1. On the Quick Access toolbar, click New.
   
   or
   
   Click the Application Main Menu button, and click New.
   
   The InfoAssist splash screen displays.

2. Click *Build a Visualization*.

3. In the Open dialog box, select a data source and click *Open*.
   
   InfoAssist switches to visualization mode.

**Changing the Visual Type**

You can create a visual using the default chart type, which is a stacked bar chart. You can add your data to this chart and then change the chart type, or you can change the chart type prior to making your data selections.
Once you have started exploring your data, you can switch between the different types to obtain the graphical image that you wish to display.

You change the visual type from the Home tab.

**Procedure: How to Change the Visual Type**

1. On the Home tab, in the Visual group, click Change, as shown in the following image.

![Visual icons](image)

**Note:** The Change icon updates depending on the chart, map, or grid that you select from the Select a Visual menu. By default, the Change icon displays a stacked bar chart.

The Select a Visual menu displays.

2. On the Select a Visual menu, click the type of visual that you want to use.

Your canvas refreshes and displays the visual that you selected.

**Note:** Depending on the type of visual that you select, you may need to select additional or different data fields.

**Selecting a Visual**

It is important that you select a chart, grid, or map that appropriately displays a meaningful view of your data. InfoAssist provides a library of visuals.

You can select a visual type from the Select a Visual menu, on the Home tab, in the Visual group. The following table describes the types of charts available.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Visual Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Grid icon" /></td>
<td>Grid</td>
<td>Grids provide a tabular view of data. They allow you to review data in a row and column format, similar to a printed report.</td>
</tr>
<tr>
<td>Icon</td>
<td>Visual Type</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>---------------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Bar chart" /></td>
<td>Bar chart</td>
<td>Bar charts plot numerical data by displaying rectangular blocks against a scale (numbers or variable measure fields that appear along the axis).</td>
</tr>
<tr>
<td><img src="image" alt="Stacked bar chart" /></td>
<td>Stacked bar chart</td>
<td>A stacked bar chart is the default visual.</td>
</tr>
<tr>
<td><img src="image" alt="Histogram" /></td>
<td>Histogram</td>
<td>Histograms graphically represent the distribution of numeric data. They facilitate the identification and discovery of the underlying frequency distribution within a set of continuous data. You can use histograms to identify trends and illustrate categorizations, or groupings, also known as bins. For more information, see Binning on page 383.</td>
</tr>
<tr>
<td><img src="image" alt="Absolute line chart" /></td>
<td>Absolute line chart</td>
<td>Line charts allow you to trace the evolution of a data point by working backwards or interpolating. Highs and lows, rapid or slow movement, or a tendency towards stability are all types of trends well suited for a line chart.</td>
</tr>
<tr>
<td><img src="image" alt="Area chart" /></td>
<td>Area chart</td>
<td>Area charts analyze trends over time and look for differences in values.</td>
</tr>
<tr>
<td><img src="image" alt="Stacked area chart" /></td>
<td>Stacked area chart</td>
<td>Stacked area charts allow you to stack data on top of each other.</td>
</tr>
<tr>
<td><img src="image" alt="Pie chart" /></td>
<td>Pie chart</td>
<td>Pie charts are circular charts that represent parts of a whole. A pie chart emphasizes where your data fits, in relation to the other components in the pie.</td>
</tr>
<tr>
<td>Icon</td>
<td>Visual Type</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>🎁</td>
<td>Ring pie chart</td>
<td>Ring pie charts are useful when you want to review the value of each segment, which represents the measure value for the selected dimension, as it relates to the total for the selected measure.</td>
</tr>
<tr>
<td>🗣</td>
<td>Scatter Plot</td>
<td>Scatter charts enable you to plot data using variable scales on both axes. When you use a scatter chart, the data is plotted with a hollow marker, so that you can visualize the density of individual data values around particular points, or discern patterns in the data.</td>
</tr>
<tr>
<td>🏔️</td>
<td>Bubble chart</td>
<td>Bubble charts can have two column fields representing X and Y data values, or have three column fields representing X, Y, and Z data values. The third variable (Z) represents size. The size of each bubble is used to show the relative importance of the data.</td>
</tr>
<tr>
<td>📊</td>
<td>Matrix Marker chart</td>
<td>Matrix marker charts are useful for analyzing one or two measures against a crosstab of two categorical dimensions. The result is a color-scaled matrix chart that shows categorized trends.</td>
</tr>
<tr>
<td>🌄</td>
<td>Treemap</td>
<td>Treemaps are used to display large amounts of hierarchically structured data. Using a set of nested rectangles to illustrate data relationships, sections of a treemap represent branches of a tree.</td>
</tr>
<tr>
<td>Icon</td>
<td>Visual Type</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><img src="image" alt="Gauge Icon" /></td>
<td>Gauge</td>
<td>Gauges are used to display the value of a measure. In particular, circular gauges are used to represent a single data value within a given spectrum. You can create a single circular gauge for a measure or a matrix circular gauge, which shows the value of the selected measure across different dimensions, such as product category or yearly sales.</td>
</tr>
<tr>
<td><img src="image" alt="Choropleth Map Icon" /></td>
<td>Choropleth map</td>
<td>A geographically-based heat map. It is useful for visualizing location-based data, trends, and distributions across a geographic area.</td>
</tr>
<tr>
<td><img src="image" alt="Proportional Symbol Map Icon" /></td>
<td>Proportional symbol map</td>
<td>A technique that uses symbols of different sizes to represent data associated with different areas or locations within the map.</td>
</tr>
<tr>
<td><img src="image" alt="Heatmap Icon" /></td>
<td>Heatmap</td>
<td>A heatmap is a graphical representation of data where the individual values that comprise a matrix are represented as colors. Using radiant hues, you can track the intensity of a data relationship using the colors defined in the legend.</td>
</tr>
</tbody>
</table>

**Note:** When new data is added to a bar, line, area, pie, scatter, bubble, gauge, or treemap chart, the chart will morph and rebuild, revealing the new values in a smooth transition.

Use the topics in this section to select and create your visuals.

**Grids**

Grids provide a tabular view of data. They allow you to review data in a row and column format, similar to a printed report.

In the following example, we review the Sale Year and Product Category data for the following measure fields:

- Revenue
Procedure: How to Create a Grid

1. Change the visual to a grid, or insert a new grid.

2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:

   - Rows or Columns - one or more data fields
   - Measure - one or more data fields

As you add, edit, or rearrange the fields in your Query field containers, your canvas refreshes.
Bar Charts

Bar charts plot numerical data by displaying rectangular blocks against a scale (numbers or variable measure fields that appear along the axis). The length of a bar corresponds to a value or amount. You can clearly compare data series (fields) by the relative heights of the bars. Use a bar chart to display the distribution of numerical data. You can create horizontal and vertical bar charts.

**Note:** If you are working with a large dataset, a scroll bar displays under your chart, enabling you to easily scroll through your data from left to right. In visualization mode, scroll bars are automatically enabled, but if you want to disable or re-enable scroll bars, click the Format tab and then click *Interactive Options*. In the Interactive Options dialog box, select the *Auto Enable X-Axis Scrolling* check box. If you are working in any other mode, you must enable this functionality.

Use a bar chart when individual values are important. For example, the following image is a basic vertical bar chart that compares the individual products sold to the total amount in sales for each product. A retailer would find it important to know which pieces of inventory are selling and how much revenue each item is generating for the company.
A horizontal bar chart becomes useful when you want to emphasize a ranking relationship in descending order, or the X-axis labels are too long to fit legibly side-by-side. For example, the following image is a basic horizontal bar chart that ranks which products are generating the most revenue for the retailer.

![Horizontal Bar Chart Example](image)

**Note:** You can swap the orientation of your data in a bar chart. To do so, on the Home tab, in the Visual group, click Swap.

**Procedure:** **How to Insert a New Bar Chart**

1. Change the visual to a bar chart or insert a new bar chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one data field

**Note:** You can also double-click a data field to add it to your Query field containers.

The bar chart displays on the canvas. You can add additional data fields for comparative purposes. You can also view underlying data by hovering over any particular point on the bar chart.
Procedure: How to Create a Stacked Bar Chart

The bar stacked visual is the default visual.

1. Change the visual to a stacked bar chart or insert a new stacked bar chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual.
   The following Query field containers must be populated for this visual:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one or more data fields
   - Color - one data field

   **Note:** You can also double-click a data field to add it to your Query field containers.

   The stacked bar chart displays on the canvas. You can add additional data fields for comparative purposes. You can also view underlying data by hovering over any particular point on the stacked bar chart.

Line Charts

Line charts allow you to trace the evolution of a data point by working backwards or interpolating. Highs and lows, rapid or slow movement, or a tendency towards stability are all types of trends well suited for a line chart.

You can also plot line charts with two or more scales to present a comparison of the same value, or set of values, in different time periods.

**Note:** If you are working with a large dataset, a scroll bar displays under your chart, enabling you to easily scroll through your data from left to right. In visualization mode, scroll bars are automatically enabled, but if you want to disable or re-enable scroll bars, click the Format tab and then click *Interactive Options*. In the Interactive Options dialog box, select the *Auto Enable X-Axis Scrolling* check box. If you are working in any other mode, you must enable this functionality.
Use a line chart when you want to trend data over time, for example, monthly changes in employment figures, or yearly sales of an item in your inventory. The following image is a line visual that shows the gross profit in monthly sales for products.

![Line Chart Illustration]

**Procedure:** How to Create a Line Chart

1. Change the visual type to a line chart or insert a new line chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one data field
   - Color - one data field (optional)

**Note:** You can also double-click a data field to add it to your Query field containers.

To add insight, you can drag a data field to the color Query field container. This displays the values for this field using color.
The line chart displays on the canvas. You can add additional data fields for comparative purposes. You can also view underlying data by hovering over any particular point on the line chart.

**Area Charts**

Area charts analyze trends over time and look for differences in values by using the see-thru nature of the area fills. Stacked area charts allow you to stack data on top of each other. Stacking allows you to highlight the relationship between data series, showing how some data series approach a second series.

**Note:** If you are working with a large dataset, a scroll bar displays under your chart, enabling you to easily scroll through your data from left to right. In visualization mode, scroll bars are automatically enabled, but if you want to disable or re-enable scroll bars, click the Format tab and then click *Interactive Options*. In the Interactive Options dialog box, select the *Auto Enable X-Axis Scrolling* check box. If you are working in any other mode, you must enable this functionality.

Use an area chart when you want to distinguish the data more dramatically by highlighting volume with color. For example, the following image is a basic area chart that depicts the yearly gross profit for various electronic products.
Procedure: How to Create an Area Chart

1. Change the visual type to an area chart or insert a new area chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one data field
   - Color - one data field (optional)

   Note: You can also double-click a data field to add it to your Query field containers.

   The area chart displays on the canvas. You can add additional data fields for comparative purposes. You can also view underlying data by hovering over any particular point on the area chart.

Procedure: How to Create a Stacked Area Chart

1. Change the visual type to a stacked area chart or insert a new stacked area chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one data field
   - Color - one data field (optional)

   Note: You can also double-click a data field to add it to your Query field containers.

   The stacked area chart displays on the canvas. You can add additional data fields for comparative purposes. You can also view underlying data by hovering over any particular point on the stacked area chart.

Pie Charts

Pie charts are circular charts that represent parts of a whole. A pie chart emphasizes where your data fits, in relation to the other components in the pie. Pie charts work best when there are a limited number of slices (for example, less than 10) and the slices are all of a sufficient value as to reveal their fill color inside their wedge.
Use a pie chart when you have segments of data that you want to display as a whole. For example, the following image is a pie chart that shows the proportions of various electronic products based on the quarterly revenue.

![Pie Chart Example]

You can add one or more measures to the Measure field container. Each measure will be used to create a separate, unique pie chart, to which you can add a measure or dimension to the Color field container to add color to your chart.

**Note:** When working with pie charts, you can add one measure field to the Color field container. This adds the measure as a By field, and determines how the pie chart is colored. Depending on your measure data, this may result in a large number of pie segments.

**Procedure:** How to Create a Pie Chart

1. Change the visual type to a pie chart or insert a new pie chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - **Measure** - one data field. Data in this category is used to indicate the size of the pie slice for the relevant category.
   - **Color** - one data field. Data in this category indicates the colors in your pie chart.
**Note:** You can also double-click a data field to add it to your Query field containers.

The pie chart displays on the canvas. You can add additional data fields for comparative purposes, or to create another pie chart on the same canvas. You can also view underlying data by hovering over any particular point on the pie chart.

**Ring Pie Charts**

Ring pie charts are circular charts that display the total for the selected measure, as well as the individual segments that comprise the ring pie chart. You can hover over each segment to review the underlying data values. This is useful when comparing the measure value for an individual segment against the total for the measure, which displays in the center of the ring pie.

You can add one or more measures to the Measure field container. Each measure will be used to create a separate, unique ring pie chart, to which you can add a measure or dimension to the Color field container to add color to your chart.

**Note:** The font size of the value label in the middle of the ring is automatically set by the chart engine.
Use a ring pie chart when you want to review the value of each segment, which represents the measure value for the selected dimension, as it relates to the total for the selected measure. The following image is an example of a ring pie chart.

**Procedure: How to Create a Ring Pie Chart**

1. Change the visual type to a ring pie chart or insert a new ring pie chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - **Measure** - one data field. Data in this category is used to indicate the size of the ring pie segment for the relevant category.
   - **Color** - one data field. Data in this category indicates the colors in your ring pie chart.

**Note:** You can also double-click a data field to add it to your Query field containers.

The ring pie chart displays on the canvas. The total for the selected measure displays in the center of the ring pie chart. You can view underlying data by hovering over any of the ring pie chart segments.
Scatter Charts

Scatter charts enable you to plot data using variable scales on both axes. When you use a scatter chart, the data is plotted with a hollow marker, so that you can visualize the density of individual data values around particular points, or discern patterns in the data. A numeric X axis, or sort field, always yields a scatter chart, by default.

**Note:** You can specify a non-measure (dimension) data field on the horizontal or vertical axis, or both.

If your chart reveals clouds of points, there is a strong relationship between X and Y values. If data points are scattered, there is a weak relationship, or no relationship.

Adding data fields to the Detail Query field container creates additional BY fields on the scatter chart. For example, the following image shows the results when adding the Product, SubCategory and Model dimension fields to Detail Query field container in a scatter chart which showed gross profit and MSRP data.

---

**Procedure:** How to Create a Scatter Chart

1. Change the visual type to a scatter chart or insert a new scatter chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:

- Vertical Axis - one data field
- Horizontal Axis - one data field
- Detail - one or more data fields
- Color - one data field

**Note:** You can also double-click a data field to add it to your Query field containers.

The scatter chart displays on the canvas. You can also view underlying data by hovering over any particular point on the scatter chart.

**Bubble Charts**

A bubble chart is a chart in which the data points are represented by bubbles. Bubble charts can have two column fields representing X and Y data values, or have three column fields representing X, Y, and Z data values, in that order. The Z variable represents size. The size of each bubble is used to show the relative importance of the data.

When you add a data field to the Size field container, this value is represented as the Z Axis Title in the legend. It displays as an empty Z Axis Title when a size data field is not specified. If you choose to indicate a Z, or size, data value, the data label displays in the legend. A Size Legend also displays, showing the estimated data value for a range of circle sizes. This allows you to estimate the value of the data based on the size of the circle.

**Note:**

- You can hover over the circles in the visual to obtain exact data values for any given point.
- You can specify a non-measure (dimension) data field on the horizontal or vertical axis, or both.
- In Visualization mode and for HTML5 charts, if you select the No fill option for your Series style when creating a bubble chart, the series displays in shades of black. For active charts, you must enable the Show Border Color option in order to view the bubbles in your chart at run time, otherwise the bubbles are invisible.
In the following image, a bubble chart is used to show the Manufacturers Suggested Retail Price (MSRP) plotted against Revenue for a variety of electronics products. It also shows the values for Gross Profit, which was specified in the Size field container in the Query pane.

**Procedure: How to Create a Bubble Chart**

1. Change the visual to a bubble chart or insert a new bubble chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Vertical Axis - one data field
   - Horizontal Axis - one data field
   - Detail - one or more data fields
   - Size - one data field
   - Color - one data field (optional). Labels for the values in this data field will comprise the legend.

**Note:** You can also double-click a data field to add it to your Query field containers.

The bubble chart displays on the canvas. You can also view underlying data by hovering over any particular point on the bar chart.
**Matrix Marker**

Matrix marker charts are useful for analyzing one or two measures against a crosstab of two categorical dimensions. You can use the Size Query field container for one measure and the Color Query field container for a second measure. The result is a color-scaled matrix chart that shows categorized trends, as shown in the following image.

**Procedure: How to Create a Matrix Marker Chart**

1. Change the visual to a matrix marker chart or insert a new matrix marker chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Matrix Rows - one data field
   - Matrix Column - one data field
   - Size - one data field. The data for this field determines the size of the marker.
   - Color - one data field. The data in this field determines the color of the marker.

The matrix marker chart displays.
Treemaps

Treemaps are used to display large amounts of hierarchically structured data. Using a set of nested rectangles to illustrate data relationships, sections of a treemap represent branches of a tree. Each branch is given a rectangle, to which any number of smaller sub-branches can be assigned. The size of each branch is proportional to the summed values of the elements inside the branch.

The following treemap shows the categories of the selected dimension fields, using two data fields to determine the size and color of the treemap segments.

Procedure: How to Create a Treemap

1. Change the visual to a treemap or insert a new treemap.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:
   - Grouping - one or more data fields, which establishes the hierarchy of the Treemap grouping.
   - Size - one data field. This data controls the size of the branches that display.
   - Color - one data field. This data controls the colors that display based on the accompanying gradient.
The treemap displays.

**Gauges**

Gauges are used to display the value of a measure. In particular, circular gauges are used to represent a single data value within a given spectrum. These gauges have a circular shape. You can create a single circular gauge for a measure or a matrix circular gauge, which shows the value of the selected measure across different dimensions, such as product category or yearly sales. The value of the measure that displays in a circular gauge is determined by the underlying data stored for that measure in the database.

The circular gauge functionality uses only one measure in its presentation. The legend reflects the color of the measure within the circular gauge.

In the following example, we review revenue data for each product category by quarterly sales in a matrix circular gauge chart.

<table>
<thead>
<tr>
<th>Sale Quarter</th>
<th>Accessories</th>
<th>Computers</th>
<th>Product Category</th>
<th>Televisions</th>
<th>Video Production</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>25.7M</td>
<td>19.7M</td>
<td>Media Player</td>
<td>47.8M</td>
<td>14.9M</td>
</tr>
<tr>
<td>2</td>
<td>24.1M</td>
<td>22.0M</td>
<td></td>
<td>44.5M</td>
<td>13.6M</td>
</tr>
<tr>
<td>3</td>
<td>24.5M</td>
<td>24.6M</td>
<td></td>
<td>45.4M</td>
<td>14.4M</td>
</tr>
<tr>
<td>4</td>
<td>30.7M</td>
<td>29.0M</td>
<td></td>
<td>56.8M</td>
<td>17.4M</td>
</tr>
</tbody>
</table>

**Procedure:**  How to Create a Circular Gauge

1. Change the visual type to a gauge or insert a new gauge.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following query field containers must be populated for this visual:

- **Measure** - one data field. Data in this category is used to indicate the value of the selected measure, which displays within the gauge.

- **Tooltip** - one or more data fields. The fields that you add provide you with the ability to review additional related, underlying data for different measures. Tooltips are optional.

  **Note:** You can also double-click a data field to add it to your Query field containers.

  The circular gauge displays on the canvas. You can select additional measure fields for which to include in the tooltip.

### Heatmaps

A heatmap is a graphical representation of data where the individual values that comprise a matrix are represented as colors. Using radiant hues, you can track the intensity of a data relationship using the colors defined in the legend.

Heatmaps are useful when you are looking for hot spots in your data, or areas of focus or interest, as shown in the following image.
**Procedure: How to Create a Heatmap**

1. Change the visual to a heatmap or insert a new heatmap.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual.
   The following Query field containers must be populated for this visual:

   - **Color** - one data field. This data controls the colors that display based on the accompanying gradient.
   - **Horizontal field container** - one data field.
   - **Vertical field container** - one data field

   **Note:** You can optionally populate the Matrix Row and Column fields to increase the segmentation of your heatmap.

   The heatmap displays.

**Interacting With Visualizations**

A visualization is comprised of one or more visuals, such as charts, maps, or grids and text. You can create different views of your data in a single visualization, and share that visualization with others in your enterprise.

The following image shows a sample visualization. This visualization includes a map, a matrix grid, and a stacked area chart.
This section summarizes the tasks that are available to you when working with visuals. It provides centralized instructional information on performing each task and offers links to the most common topics when working with visuals.

<table>
<thead>
<tr>
<th>Task</th>
<th>How To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change visual</td>
<td>On the Home tab, in the Visual group, click Change. <strong>Note:</strong> The Change icon updates depending on the chart, map, or grid that you select from the Select a Visual menu. By default, the Change icon displays a stacked bar chart. Select a chart, map, or grid from the Select a Visual menu.</td>
</tr>
<tr>
<td>Insert new visual</td>
<td>On the Home tab, in the Visual group, click Insert. Use the default stacked bar chart or click Change to select a different chart, map, or grid from the Select a Visual menu. <strong>Note:</strong> You can also add additional charts, maps, or grids to a visualization by dragging a data field onto the canvas and placing it using the handles that are available.</td>
</tr>
<tr>
<td>Rearrange visuals</td>
<td>Drag a visual on top of another visual to activate a shaded area that contains handles, which can be used to indicate placement.</td>
</tr>
<tr>
<td>Copying a visual</td>
<td>On the canvas, select a visual. On the Home tab, in the Clipboard group, click Copy. <strong>Note:</strong> You can also press CTRL+C to copy a selected visual.</td>
</tr>
<tr>
<td>Pasting a visual</td>
<td>Copy a visual. On the Home tab, in the Clipboard group, click Paste. <strong>Note:</strong> You can also press CTRL+V to paste a copied visual on the canvas.</td>
</tr>
<tr>
<td>Task</td>
<td>How To</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Duplicating a visual</td>
<td>On the canvas, select a visual. On the Home tab in the Clipboard group, click Duplicate. A duplicate visual is created and a sequential number is assigned based on the type of visual.</td>
</tr>
<tr>
<td>Delete visual</td>
<td>Select a visual. On the Home tab, in the Clipboard group, click Cut. You can click the Close button in the upper-right corner of the current visual. From the Query pane, right-click a visual and click Delete. You can also press the Delete key when a visual is selected.</td>
</tr>
<tr>
<td>Apply Filter</td>
<td>Drag a dimension field or measure field into the Filter pane to access the filter options that are available. To add filter options for a field that is already in the Query pane, select the field and on the Field tab, in the Filter group, click Filter.</td>
</tr>
<tr>
<td>Add visuals to the storyboard</td>
<td>Create a visual. On the Home tab, in the Storyboard group, click Add.</td>
</tr>
</tbody>
</table>

**Procedure:** How to Insert a New Visual

1. On the Home tab, in the Visual group, click the down arrow next to Insert.
2. On the menu, click one of the following options:
   - Chart. Inserts a stacked bar chart visual.
   - Grid. Inserts a grid visual.
   - Text. Inserts a blank text cell.
3. Populate your visual with data or add text to the text cell.

**Note:**

- By default, when you click Insert, a stacked bar chart visual is inserted.
You can also drag a data field from the Data pane to the canvas to insert a new visual. This inserts the default visual, a stacked bar chart. You can use the placement handles to position your new visual on the canvas, for example, above an existing visual or to the side of an existing visual.

**Procedure: How to Add Text to Your Visualization**

1. On the Home Tab, in the Visual group, click the down arrow on next to Insert.
2. On the menu, click Text.
   A text cell opens on the canvas.
3. Add text to your visualization.

**Note:** You can resize the text cell and use the text formatting options to customize the display of any text that you add, as shown in the following image.

You can also position the text cell in your visualization by dragging the text cell on top of a visual. Use the placement handles to indicate placement of the text cell.

**Procedure: How to Create a Visualization**

1. Begin with the default canvas, which consists of a stacked bar chart template.
2. Insert a new visual in one of the following ways:

   a. Drag a data field from the Data pane onto the canvas. Handles display, which allow you to select the location for the new visual, for example, top (above) or left of the current visual, as shown in the following image.

   b. On the **Home** tab, in the **Visual** group, click **Insert**.

      **Note:** You can optionally click the down arrow on the Insert button to specify the addition of a chart, grid, or text.

3. Add another visual.

   Now, three visual cells display side-by-side.

4. Click a visual to select it.

   **Note:** You can click a visual to activate it, or double-click on the visual number or name in the Query pane.

5. Reorganize your visuals using the handles.
6. Once you have organized the placement of your visuals, select one and specify the visual type.
   
   
   Note: The Change icon updates depending on the chart, map, or grid that you select from the Select a Visual menu. By default, the Change icon displays a stacked bar chart.
   
b. In the Select a Visual menu, click the type of visual you want to use. For example, Line, Area, or Map.
   
c. Repeat these steps for all three visuals on your canvas.
   
7. Populate each visual with your data.
   
You can change the type of visual that you previously selected at any time. You can also resize or reorganize the position of each visual as you add data.

For example, move the lower-left visual to the top of the visualization.
8. Click Save to save your visualization.

**Minimizing or Maximizing a Visual**

When working on a visualization with more than one chart, map, or grid, you can maximize and minimize individual visuals. This allows you to focus on one visual at a time, and then minimize it to view it alongside the other visuals.

The maximize and minimize icons are located in the top-right corner of each visual, next to the Close button. When you click the *Maximize* icon, the current visual moves to the foreground and is the only visual that displays on the canvas. You can work on this visual, and then minimize it to view the other visuals.

**Note:** You can view other visuals in the maximized mode by selecting a different visual in the Query pane.

**Procedure:** How to Minimize or Maximize a Visual

1. Create a visualization with two or more visuals.
2. Perform the following actions to minimize or maximize your visual:

- Click the maximize icon or double-click on the Title bar to maximize your visual.
- Click the minimize icon or double-click on the Title bar to minimize your visual.

You can maximize one visual at a time, and you can switch between visuals in this mode by double-clicking a different visual in the Query pane.

Procedure: How to Delete a Visual
1. In your visualization, select the chart, map, or grid that you want to delete.
2. Perform one of the following tasks to delete the visual:
   - Press the Delete key.
   - On the Home tab, in the Clipboard group, click Cut.
   - Click the Close button in the upper-right corner of the current visual.
   - From the Query pane, right-click on a visual, and click Delete.

   Note: You can use the Undo and Redo options on the Quick Access Toolbar to reverse or redo any prior actions.

Renaming a Visual
You can rename a visual on the canvas or within your visualization. You may want to do this for presentation and organizational purposes, as each visual has a default label (for example, Bar 1, Bar 2, and Bar 3). You can change these labels by renaming the visual in the Query pane.

Once new labels are in place, it is easier to recognize which visual you want to select at any given time.

Using the shortcut menu for a visual in the Query pane, you can also rename your visual.

Procedure: How to Rename a Visual
1. Create a visualization with one or more chart, map, or grid.
2. In the Query pane, right-click the visual number for which you want to modify the title.
3. Click Rename.
4. In the Edit Title dialog box, enter a new name for the visual.
5. Click OK.
   The visual is renamed in the Query pane and the new title is reflected at the top of the selected visual.
Using Paper-Clipping to Group Values in a Visual

Paper-clipping gives you the advantage of lassoing values in a visual to create logical groups within your selected dimension. Paper-clipping uses the core functionality of dynamic grouping, giving you access to grouping capabilities that meet your business needs. You can also add additional groupings or fields to an existing group, and rename the groups and values, giving you control over how the information displays.

When you paper-clip values together, a new group is created using the naming convention of dimensiongroup_1. You can add values to this group by lassoing this grouped component, along with any additional components you want to add. These new values become part of that existing group.

**Note:** If you group two values and then add another value to that grouping, you must manually rename the group in order to update its display.

If you lasso other values in your visualization, and you do not capture or include a previously defined grouping, a new grouping is created for the selected fields in the current dimension. It is labeled using the original dimension label (dimensiongroup_1), but a new, unique grouping is created for these values. You can see the groupings by right-clicking the group in the Query pane and selecting *Edit Group*. If you want to add new values to an existing group, you must lasso the existing group, in addition to the fields that you want to add to it, in order to combine the additional fields into the existing grouping.
To enable paper-clipping, lasso the values that you want to group, release the mouse, and from the menu that displays, select *Group n Selection*, where \( n \) is the dimension associated with the values you select. This menu is shown in the following image.

**Note:** Paper-clipping allows you to group on the first BY field only. In the example above, the first BY field is Product Category. If you are working with a matrix chart and you apply this rule, you are only able to group on the first BY field. In addition, you cannot group on a numeric field (for example, Sales_Year). In this case, if the numeric field was the first BY field, grouping is not available.
Once you group the values, they display in a unique group on the relevant axis. The group label is based on the original values stored for those components. For example, in the previous image, we grouped Camcorder and Computers in the PRODUCT_CATEGORY_1 group, as shown in the following image.

![Graph showing grouped data]

Once you create a group, you can easily perform the following functions:

- **Edit group.** Opens the Edit Group dialog box, where you can edit the values in the current group. For example, you can add additional values into the current group or delete them. For more information on editing an existing group, see *Dynamic Grouping* on page 111.

- **Rename group.** Enables you to rename the group using the Rename Group dialog box. The revised name displays along the relevant axis and replaces the existing field name in the Query pane.

- **Rename x.** Enables you to rename the group name (x) that is assigned based on your grouping. This is particularly useful in cases where space is an issue in your visualization. This revised value also replaces the original group name in the Edit Group dialog box.

- **Ungroup x.** Ungroups the values of the group (x) that were previously grouped.

- **Ungroup All.** Ungroups all existing groups, returning the visualization to its original state.

**Note:** Upon ungrouping all groups, the original dimension displays as a group in the Query pane, by default. However, no grouping is applied.
These options are shown in the following image.

**Note:** You can also edit an existing group by right-clicking the group in the Query pane and selecting *Edit Group*. 
If you want to add another value to an existing group, lasso the existing group and the new value. From the menu, click Merge with x, where x is the value of the existing group, as shown in the following image.
The new value is added to the existing group. You can then rename the group so that its label contains all values in the group. You can optionally label it with a new, unique name. This option is shown in the following image.

Note: You can also use the Edit Group dialog box to rename groups or groupings. For more information, see Dynamic Grouping on page 111.

You can use the following procedures to create and manage your paper-clipped values.

Procedure: How to Paper-Clip Two or More Values Together

1. In visualization mode, create a bar chart with one measure and one dimension. The bar chart displays.
2. Lasso two or more columns in the visualization.
3. From the menu that displays, click Group n Selection, where n is the name of the dimension in your bar chart. The two values are paper-clipped together, or grouped, as indicated on the x-axis.

Note: If you have swapped the orientation of your visualization, the paper-clipped values display on the y-axis.

Procedure: How to Merge an Additional Value into an Existing Group

1. In visualization mode, create a bar chart with one measure and one dimension. The bar chart displays.
2. Lasso two or more columns in the visualization.

3. From the menu that displays, click \textit{Group n Selection}, where \( n \) is the name of the dimension in your bar chart.
   The two values are paper-clipped together, or grouped, as indicated on the x-axis.

   \textbf{Note:} If you have swapped the orientation of your visualization, the paper-clipped values will display on the y-axis.

4. Lasso this existing group, as well another column, to merge this additional value into the group.

5. From the menu that displays, click \textit{Merge with x}, where \( x \) is the name of the group you originally created.
   This value is merged into the existing group.

   \textbf{Note:} The name of the group is not dynamically updated. In order to reflect the contents of the revised group, you must edit the group using the right-click menu option or the Edit Group option that is available in the Query pane.

\textbf{Procedure:} \textbf{How to Rename an Existing Group}

1. In visualization mode, create a bar chart with one measure and one dimension. The bar chart displays.

2. Lasso two or more columns in the visualization.

3. From the menu that displays, click \textit{Group n Selection}, where \( n \) is the name of the dimension in your bar chart.
   The two values are paper-clipped together, or grouped, as indicated on the relevant axis.

4. Lasso the grouped column and from the menu that displays, click \textit{Rename x}, where \( x \) is the existing label of the group.

5. In the Rename Value dialog box, enter the new name for the group.

6. Click \textit{OK}.
   The group is renamed, as shown on the relevant axis.

   \textbf{Note:} Optionally, you can rename a group using the Edit Group dialog box. This is available when you right-click on a grouped value in the Query pane and click \textit{Edit Group}. For more information, see \textit{Dynamic Grouping} on page 111.
Using Multi Drill in Visualization Mode

Similar to the functionality that is available in Chart mode, you can create multiple drill down links on a measure field in a visualization. This enables you to define custom links to other reports or websites, making it easy to link content from internal and external sources. Once defined, these links display on the shortcut menu that displays when you hover over a riser, as shown in the following image.
You create multiple drill downs using the Drill Down dialog box, which you can access from the Links group on the Field tab. In the Query pane, click a measure to enable the Field tab. In the Links group, click Drill Down. The Drill Down dialog box displays, as shown in the following image.

![Drill Down Dialog Box](image)

**Note:** When creating a drill down in Visualization mode, the Auto Link Target option is not available.

For more information and instructional guidance, see Using Multi Drill on page 848.

### Creating Matrix Charts

Matrix charts are powerful, comparative tools. They provide enough detail to show a trend and they organize information in a categorical fashion.

Matrix charts display data in a grid, showing the comparative values on either axis. They provide you with a quick glance at trends over time, giving you a succinct synopsis of a situation (for example, sales or investment trends).

You can use various formats in your matrix chart (for example, pie or line chart).
In the following example, quarterly revenue data is reviewed by product category, for a range of years (2014 - 2016, specifically). Using a bar chart for the matrix, you can review how gross profit for each product category shifts over time.

![Bar chart example](image)

You can plot one value on the X axis and one value on the Y axis. For example, sales against region. You can also plot just one value for the rows or columns in the matrix chart.

**Procedure:** How to Create a Matrix Bar Chart

1. Launch InfoAssist in Chart or Visualization mode.
   - In Chart mode, on the Format tab, in the Chart Types group, click Bar chart.
   - In Visualization mode, on the Home tab, in the Visual group, click Change and click Bar chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart. The following Query field containers must be populated for this chart:
   - Vertical Axis - one or more data fields
Creating Matrix Charts

- Horizontal Axis - one data field
- Matrix Rows - one data field
- Matrix Columns - one data field

**Note:** You can also double-click a data field to add it to your Query field containers.

The matrix bar chart displays on the canvas. You can add additional fields for comparative purposes. In Visualization mode, you can also view underlying data by hovering over any particular point on the matrix bar chart.

**Procedure:**  **How to Create a Matrix Line Chart**

1. Launch InfoAssist in Chart or Visualization mode.
   - In Chart mode, on the Format tab, in the Chart Types group, click Line chart.
   - In Visualization mode, on the Home tab, in the Visual group, click Change and click Line chart.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart.

   The following Query field containers must be populated for this chart:
   - Vertical Axis - one or more data fields
   - Horizontal Axis - one data field
   - Matrix Rows - one data field
   - Matrix Columns - one data field

**Note:** You can also double-click a data field to add it to your Query field containers.

The matrix line chart displays on the canvas. You can add additional fields for comparative purposes. In visualizations mode, you can also view underlying data by hovering over any particular point on the matrix line chart.

**Procedure:**  **How to Create a Matrix Area Chart**

1. Launch InfoAssist in Chart or Visualization mode.
   - In Chart mode, on the Format tab, in the Chart Types group, click Area chart.
   - In Visualization mode, on the Home tab, in the Visual group, click Change and click Area chart.
2. Drag data fields to the canvas or to the Query field containers to add them to your visual. The following Query field containers must be populated for this visual:

- **Vertical Axis** - one or more data fields
- **Horizontal Axis** - one data field
- **Matrix Rows** - one data field
- **Matrix Columns** - one data field

**Note:** You can also double-click a data field to add it to your Query field containers.

A matrix area chart displays on the canvas. You can add additional data fields for comparative purposes. In Visualization mode, you can also view underlying data by hovering over any particular point on the matrix area chart.

**Procedure: How to Create a Matrix Pie Chart**

1. Launch InfoAssist in Chart or Visualization mode.
   - In Chart mode, on the **Format** tab, in the **Chart Types** group, click **Pie chart**.
   - In Visualization mode, on the **Home** tab, in the **Visual** group, click **Change** and click **Pie chart**.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart. The following Query field containers must be populated for this chart:

- **Measure** - one data field

  **Note:** Each unique measure field is represented by a separate pie chart.

- **Color** - one data field
- **Matrix Rows** - one data field
- **Matrix Columns** - one data field

  **Note:** You can also double-click a data field to add it to your Query field containers.

The matrix pie chart displays on the canvas. You can add additional data fields for comparative purposes, or to create another pie chart unique to the additional measure fields you select. In Visualization mode, you can also view underlying data by hovering over any particular point on the matrix pie chart.
Procedure: How to Create a Matrix Ring Pie Chart

1. Launch InfoAssist in Chart or Visualization mode.

   - In Chart mode, on the Format tab, in the Chart Types group, click Other. In the Select a chart dialog box, click Pie, then click Ring Pie.
     
     Click OK.

   - In Visualization mode, on the Home tab, in the Visual group, click Change and click Ring Pie.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart. The following Query field containers must be populated for this chart:

   - Measure - one data field

     Note: Each unique measure field is represented by a separate ring pie chart.

   - Color - one data field

   - Matrix Rows - one data field

   - Matrix Columns - one data field

     Note: You can also double-click a data field to add it to your Query field containers.

The matrix ring pie chart displays on the canvas. You can add additional fields for comparative purposes, or to create another pie chart unique to the additional measure fields you select. In Visualization mode, you can also view underlying data by hovering over any particular point on the matrix ring pie chart.

Procedure: How to Create a Matrix Circular Gauge

1. Launch InfoAssist in Chart or Visualization mode.

   - In Chart mode, on the Format tab, in the Chart Types group, click Other. In the Select a chart dialog box, click Special, then click Gauge.
     
     Click OK.

   - In Visualization mode, on the Home tab, in the Visual group, click Change and click Gauge.

2. Drag data fields to the canvas or to the Query field containers to add them to your chart. The following query field containers must be populated for this chart:

   - Measure - one data field. Data in this category is used to indicate the value of the selected measure, which displays within the gauge.
Note: Since the gauge relies on a constant (measure field), each intersection of the matrix chart is calculated using that measure along with the various matrix rows and columns in the matrix chart.

- Matrix Rows - one data field.
- Matrix Columns - one data field.
- Tooltip - one or more data fields. The fields that you add provide you with the ability to review additional related, underlying data for different measures. Tooltips are optional.

Note: You can also double-click a data field to add it to your Query field containers.

The matrix circular gauge displays on the canvas. You can select additional measure fields for which to include in the tooltip.

Using Active Technologies

This topic provides an overview of Active Technologies and discusses security and active cache processing. It includes additional information about the features of the product that will help you use it. It is intended for administrators and developers who are responsible for creating active reports, charts, and dashboards.

This topic also describes the features of an Active Technologies report, which is a report that is enabled to use the full capabilities of Active Technologies. An Active Technologies report is also called an active report.

Active Technologies Report Overview

An active report is a report that is designed for offline analysis. When using an active report, you can:

- Interact with the data, using analysis options similar to those found in an Excel® workbook, without any connection to a server. Analysis options include filtering, sorting, charting, and much more.

- Work offline without any additional plug-ins or programs. An active report is a self-contained report, meaning that it contains all the data and JavaScript® within the HTML output file. Packaging the data and the interactive functions in the HTML file also makes the output highly compressible for email and transparent to security systems.

- Save the report on a local machine with active report functionality. Since no connection to a server is required to view the data or use the analysis options, you can save and use the report anywhere.
Performance may vary across browsers due to browser-specific memory limitations. For very large reports, Internet Explorer® may produce an error. For more information, refer to the Microsoft® website.

When working with an active report, you can:

- Filter or highlight data.
- Sort data within any column in ascending or descending order.
- Apply calculations to columns and choose the location at which to display results.
- Control the display of data by hiding columns, freezing columns, limiting the number of rows per page, and using graphic visualization to compare column values.
- Create a variety of simple or advanced charts (pie, line, bar, or scatter) and Rollup Tables.
- Apply a global filter to multiple reports within the same HTML page.
- Export report data and chart data.
- Restore original report settings.
- Run active reports on your mobile device with the Opera browser (Version 8.60 U2 or higher) installed. See the Opera website for a list of supported devices.
- Run active reports on your iPhone® mobile device. For the best performance results, it is recommended that you set a maximum of 500 records for a mobile report.

Some active report functionality is drag and drop based, and thus not supported with iPhone.
The following image shows an HTML active report. The shortcut menu is open for the Sale Unit(s) column, with the Calculate Avg operator selected.

<table>
<thead>
<tr>
<th>Store Business Region</th>
<th>Store Business Sub Region</th>
<th>Revenue</th>
<th>Sale Unit(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>EMEA</td>
<td>Africa</td>
<td>$26,4</td>
<td>13</td>
</tr>
<tr>
<td></td>
<td>Asia</td>
<td>$396,2</td>
<td>78</td>
</tr>
<tr>
<td></td>
<td>Europe</td>
<td>$39,0</td>
<td>45</td>
</tr>
<tr>
<td>North America</td>
<td>Canada</td>
<td>$51,1</td>
<td>76</td>
</tr>
<tr>
<td></td>
<td>East</td>
<td>$12,9</td>
<td>72</td>
</tr>
<tr>
<td></td>
<td>Mexico</td>
<td>$90,9</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>Midwest</td>
<td>$77,4</td>
<td>38</td>
</tr>
<tr>
<td></td>
<td>Northeast</td>
<td>$4,4</td>
<td>32</td>
</tr>
<tr>
<td></td>
<td>Southeast</td>
<td>$382,3</td>
<td>78</td>
</tr>
<tr>
<td>Oceania</td>
<td>Australia-New Zealand</td>
<td>$1,2</td>
<td>58</td>
</tr>
<tr>
<td>South America</td>
<td>SA-Port</td>
<td>$25,9</td>
<td>38</td>
</tr>
<tr>
<td></td>
<td>SA-Span</td>
<td>$1,2</td>
<td>32</td>
</tr>
</tbody>
</table>

14 of 14 records, Page 1 of 1
The following image shows the options that are available at the cell level for a report in active report format. Included are the options that reflect Auto Drill, Multi Drill, and Auto Linking functionality. For more information, see Customizing Content on page 737.

Security Features

You can password protect an active report. This feature restricts users from viewing the report by requiring them to enter a password before opening the report. The data is encrypted using the 256-bit Advanced Encryption Standard (AES) specification. The password is used as the key for decrypting and encrypting the data. Therefore, the password is not stored in the report, and you do not need a connection to go back to the server for password verification.

The HTML page that you receive contains both the JavaScript and the data for the report so that you can interact with the data in a disconnected mode. Internet Explorer detects the JavaScript and issues a warning. If you look at the Internet Explorer warning, it mentions explicitly the detection of active content, which is the JavaScript. The same warning appears when pop-ups are blocked in the browser.
Handling a Large Amount of Data

Because all post-retrieval processing is performed in the memory of the web browser, an active report has a processing limit of approximately 5,000 records or 100 pages of output. The active cache option enables you to send only the first page of active report output to the browser and retrieve subsequent pages from a temporary cache on the WebFOCUS Reporting Server. The server also becomes the resource for performing all calculations, sorting, and filtering when active cache is enabled. Since active cache uses on-demand paging functionality, WebFOCUS Viewer is not supported.

The active report with active cache option in the clustered server environment, using Cluster Manager (CLM), will maintain the connection with the WebFOCUS Reporting Server on which the temporary cache is created. This enables the retrieval of subsequent pages from the browser, while the report is in the same browser session.

The active cache feature uses a POST instead of a GET in an HTTP request.

Distribution and Viewing Considerations

Active Technologies stores an active report as an HTML file. The HTML file created by Active Technologies contains both the report data and the JavaScript code that enables you to interact with the data in disconnected mode.

An active report is designed for distribution to users who need to perform offline analysis and interactive functions without connection to a server.

You can save an active report from your web browser to another location. You can also send an active report to another person by email, as an HTML attachment. However, when you distribute an active report, you must keep in mind how it will be viewed.

For example, when you send an active report as an HTML attachment to email, many client email programs on a mobile device can block the JavaScript in the attachment. A third-party tool, such as the Mobile Faves App for a mobile device, may be used to correctly view the attachment.

If you try to view an active report in a web browser, and JavaScript is blocked or disabled on your web browser, you will receive a message reminding you that JavaScript must be enabled on the browser. If you are using a mobile device, the message directs you to use the Mobile Faves App. If the Mobile Faves App is not installed, you can download it from the App Store® for iOS devices or from the Google Play™ store for Android™ devices. In the message, App Store and Google Play store are hyperlinks to the Mobile Faves App.
The message is displayed on the Desktop or on a supported mobile device when JavaScript is disabled in a web browser used to open an online or offline active report. It is also displayed on the Preview pane or window of an application used to preview the content of an offline active report.

The following image shows JavaScript disabled in Google Chrome™.
Usage Notes for Active Technologies

The following apply to browser support.

- ActiveX, a technology from Microsoft, is not supported in Microsoft Edge. Therefore, any Active Technologies feature that requires the use of ActiveX controls is not available in Microsoft Edge. These features include the following, which are accessible in other browsers at run time, using the column drop-down menu on an active report:
  - Send as E-mail (supported only in Internet Explorer)
  - Save Changes (supported only in Internet Explorer)
  - Export to XML (Excel) when active cache is disabled

- If you are using a Firefox browser and you export an AHTML report to Excel, the file extension that displays is incorrect (for example, .xls.xls). You can override this default value using the browser settings. Specifically, if you click the Always ask me where to save files radio button, located under Options, you will be prompted, upon download, to either open or save the file. You can then provide a name and extension for the file.

The following apply to Active Technologies reports.

- If multiple report components with different security passwords are included in an AHTML document, the password for the last report component is used.

- Active reports employ left and right cell padding, by default. This enables you to view the active report consistently, without the concatenation of any values or spacing issues related to the cell padding. In cases where these settings are not defined in the StyleSheet, the default settings for the left and right cell padding are used.

- By default, Active Technologies displays the name specified in the Master File to identify a column in an ACROSS group on a tabular active report. With the following WebFOCUS SET command, you can display the title specified in the Master File, instead of the name, to identify the column:

  \[
  \text{SET ACRSVRBTITL = ON}
  \]

  Active Technologies derives the title from the TITLE attribute in the Master File (for example, TITLE = 'Product ID'). It derives the name from the FIELDNAME or FIELD attribute (for example, FIELD = PCD).

InfoAssist does not allow you to create or modify your active report procedures with a text editor. In Business User Edition, you must issue the SET ACRSVRBTITL = ON command in a server profile (for example, edasprof.prf). When issued in edasprof.prf, the setting is applied globally. It affects all users and all procedures run in Business User Edition.
For more information on customizing the server profile in WebFOCUS Business User Edition, see *Managing the Server or Global Profile* on page 317.

- The Sort Ascending, Sort Descending, and Restore Original options are accessible on a column drop-down menu on an active report. When active cache is enabled on the active report, the Restore Original option does not return the report output to its original state after sorting the data. Instead, you receive the following message: Warning: Original sort could not be determined.

The following applies to filtering Active Technologies content.

- When using active content in Cache Mode, filtering may not work properly if the content contains a text field (for example, TX50). As a workaround, consider using an alphanumeric field (for example, A50).

The following apply to Active Technologies charts:

- When working with filters in an AHTML chart, certain filtering options do not display if you have only one column on which to filter and it has a decimal format which includes a decimal point. In this case, the Filter Chart and Exclude from Chart filtering options are not available in the chart tooltip at run time.

- As of Release 8.2 Version 02, the chart attribute syntax has been applied to the following chart types: Dual Bar and Line, Tag Cloud, Streamgraph, Mekko, Funnel, and Pyramid. This process adds additional relevant field containers for these chart types, which can be used to specify fields in a specific area of the chart. For example, Horizontal Axis, Color, and Tooltip are field containers that are part of the chart attribute syntax.

  In InfoAssist, specific field containers appear for each chart type.

- When you run an active chart, the output displays a chart toolbar with a number of options that you can select. These options are represented by icons. The active chart toolbar provides an Aggregation icon that allows you to select the aggregation method (that is, the type of calculation, such as Sum or Avg) that will be used on the selected data in the chart.

  If you run an active chart that does not have a measure field to which an aggregation method can be applied, the Aggregation icon:

  - Appears on the chart toolbar, but cannot be selected.

  - Displays None as the aggregation method. None is dimmed on the label. It indicates that there will be no aggregation performed on, or applied to, the selected data in the chart.
Once you run the active chart with data that applies to an aggregation method, the Aggregation icon is activated. Its label reflects the aggregation method currently in use (for example, Sum).

The following applies to Active Technologies tools.

- The comma inclusion edit option is not implemented in Rollup tables and Pivot tables when active cache is enabled.

The following apply when using the Export to Excel functionality.

- When using the Export to Excel option while creating and generating an active report with active cache enabled, the request will be generated in XLSX format, rather than EXL2K. This applies to the following browsers: Microsoft Edge, Internet Explorer, Firefox, and Chrome.

  The export behavior is controlled by the WebFOCUS Reporting Server, and an ActiveX plugin is not required for Internet Explorer. When the export is performed, an Office Open XML document is produced, which you can download and save in the required format (default is .xlsx).

- When using the Export to XML (Excel) option with active cache disabled, the export behavior is controlled by the active JavaScript layer.

  An ActiveX plugin is required for Internet Explorer. This is used to export the output directly into Microsoft Excel, enabling you to save the document in the required format (.xlsx or .xls depending on the Microsoft Excel version installed).

  In Firefox and Chrome, when the export is performed, an MS Office XML document is produced, which you can download and save in the required format (the default is .xls).

  In Microsoft Edge, the Export to XML (Excel) option is not supported. The option is available with active cache disabled, but when the export is performed, the output is displayed as text inside the browser window.

The following apply when using mobile devices.

- The Chrome browser Force enable zoom Accessibility setting on Android mobile devices overrides a website request to prevent zooming. If this setting is enabled when executing an AHTML report on an Android mobile device using Chrome, it interferes with active report functionality, such as FREEZE and manual resizing. The Accessibility setting needs to be disabled for active reports to be fully functional.
Creating an Active Technologies Report

An active report is a self-contained report that is designed for offline analysis.

Procedure: How to Create an Active Technologies Report

With InfoAssist in Report mode, you can perform this procedure in Query Design view or Live Preview.

1. On the Home tab, from the Format group, click Output File format and click active report.
2. Populate the report with your data in one of the following ways:
   - Drag the dimension fields and measure fields onto canvas.
   - Drag the dimension fields and measure fields into the appropriate field containers in the Query pane.

Active Technologies Report Menu Options

Menu options for an active report are described in the following table.

Note: The following options described in the table require the use of ActiveX controls. Since Microsoft Edge does not support ActiveX technology, these options are not available in that browser:

- Send as E-mail
- Save Changes
- Export to XML (Excel) when active cache is disabled

<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sort Ascending</td>
<td>Sorts the column in ascending order.</td>
</tr>
<tr>
<td>Sort Descending</td>
<td>Sorts the column in descending order.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>--------</td>
<td>------------</td>
</tr>
<tr>
<td>Filter</td>
<td>Filters the data. Options are:</td>
</tr>
<tr>
<td></td>
<td>☐ Equals</td>
</tr>
<tr>
<td></td>
<td>☐ Not equal</td>
</tr>
<tr>
<td></td>
<td>☐ Greater than</td>
</tr>
<tr>
<td></td>
<td>☐ Greater than or equal to</td>
</tr>
<tr>
<td></td>
<td>☐ Less than</td>
</tr>
<tr>
<td></td>
<td>☐ Less than or equal to</td>
</tr>
<tr>
<td></td>
<td>☐ Between</td>
</tr>
<tr>
<td></td>
<td>☐ Not Between</td>
</tr>
<tr>
<td></td>
<td>☐ Contains</td>
</tr>
<tr>
<td></td>
<td>☐ Contains (match case)</td>
</tr>
<tr>
<td></td>
<td>☐ Omits</td>
</tr>
<tr>
<td></td>
<td>☐ Omits (match case)</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Definition</strong></td>
</tr>
<tr>
<td>-------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Calculate</td>
<td>Calculation types that you can apply to the column:</td>
</tr>
<tr>
<td></td>
<td>- Clear</td>
</tr>
<tr>
<td></td>
<td>- Clear All</td>
</tr>
<tr>
<td></td>
<td>- Count</td>
</tr>
<tr>
<td></td>
<td>- Distinct, which counts the number of distinct values within a field.</td>
</tr>
<tr>
<td></td>
<td>For numeric fields, you can also apply:</td>
</tr>
<tr>
<td></td>
<td>- Sum</td>
</tr>
<tr>
<td></td>
<td>- Avg</td>
</tr>
<tr>
<td></td>
<td>- Min</td>
</tr>
<tr>
<td></td>
<td>- Max</td>
</tr>
<tr>
<td></td>
<td>- Count</td>
</tr>
<tr>
<td></td>
<td>- Distinct</td>
</tr>
<tr>
<td></td>
<td>- % of Total</td>
</tr>
<tr>
<td>Chart</td>
<td>Creates an active chart from the report. Options are Pie, Line, Column, and Scatter.</td>
</tr>
<tr>
<td>Rollup</td>
<td>Lists the fields available to create a table.</td>
</tr>
<tr>
<td>Pivot (Cross Tab)</td>
<td>Lists the fields available to create a Pivot table.</td>
</tr>
<tr>
<td>Visualize</td>
<td>Adds visualization bars to, or removes them from, the selected column. The Visualize option is available for numeric data columns.</td>
</tr>
<tr>
<td>Hide Column</td>
<td>Suppresses the display of the selected column in the report.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Show Columns</td>
<td>Lists the names of the columns that are hidden in the report, allowing you to individually restore a column. Select the name of a specific column in the hidden columns list to restore that column to the report.</td>
</tr>
<tr>
<td>Freeze Column</td>
<td>Freezes the report at a particular point so that columns to the left of the freeze point remain in view while the user scrolls through the other report columns.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If the report can be fully viewed in the browser window, freeze is not applied. The Freeze column option is not available for expandable report (Accordion) views.</td>
</tr>
<tr>
<td>Unfreeze All</td>
<td>Unfreezes the columns.</td>
</tr>
<tr>
<td>Grid Tool</td>
<td>Opens the Grid Tool, which you can use to change the column order, select multiple columns to sort ascending or descending, hide and show columns, add a calculation result to a column, and add subtotals to the active report.</td>
</tr>
<tr>
<td>Chart/Rollup Tool</td>
<td>Opens the Chart/Rollup Tool, which you can use to select multiple group fields to generate the chart or rollup table. The Chart/Rollup Tool contains a list of columns available in the active report to add to Group By and Measure fields. Drag the columns into the field that you want.</td>
</tr>
<tr>
<td>Pivot Tool</td>
<td>Opens the Pivot Tool, which you can use to select multiple group fields to generate the chart or pivot table. The Pivot Tool contains a list of columns available in the active report to add to Group By, Across, and Measure fields. Drag the columns into the field that you want.</td>
</tr>
<tr>
<td>Show Records</td>
<td>Opens the Show Records menu option to list the number of records available for display per page in the report. Select a number (for example, 10) to display, per page. Default displays the number of records (lines) per page that is specified in the WebFOCUS report procedure.</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Definition</strong></td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Comments</td>
<td>Options to display comments under cells or hide indicators for comments in the active report output.</td>
</tr>
<tr>
<td>Send as E-mail</td>
<td>Enables you to save the current state of the active report and send the report as email. &lt;br&gt;&lt;br&gt;<strong>Note:</strong> To use this feature, you must have ActiveX enabled in your browser security settings. &lt;br&gt;This feature is only supported in Internet Explorer.</td>
</tr>
<tr>
<td>Save Changes</td>
<td>Saves the current state of the active report. &lt;br&gt;&lt;br&gt;When you save an active report using the browser Save as option, the report is saved in its original default state. In the browser Save as dialog box, it is recommended that you select the <em>Webpage, HTML Only</em> save option to ensure that the page is saved properly. &lt;br&gt;&lt;br&gt;<strong>Note:</strong> To use this feature, you must have ActiveX enabled in your browser security settings. &lt;br&gt;This feature is only supported in Internet Explorer.</td>
</tr>
<tr>
<td>Export</td>
<td>When active cache is enabled, exports all records or filtered only records to HTML, CSV, Excel, or PDF. &lt;br&gt;&lt;br&gt;<strong>Note:</strong> active cache is enabled on an active report when you click <em>Pages On Demand</em> on the Format tab, in the Navigation group. &lt;br&gt;&lt;br&gt;When active cache is disabled, exports all records or filtered only records to HTML, CSV, or XML (Excel). To use this feature, you must enable ActiveX in your browser security settings.</td>
</tr>
<tr>
<td>Print</td>
<td>Prints all records or filtered only records.</td>
</tr>
<tr>
<td>Window</td>
<td>Displays reports in a cascade or separate tabs.</td>
</tr>
<tr>
<td>Restore Original</td>
<td>Restores the active report to the default state specified in the report procedure.</td>
</tr>
</tbody>
</table>

**Active Technologies Cell Menu Options**

When you are working in active report format, the following data cell options display.
<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>Drill down</td>
<td>Enables you to drill down one level in the hierarchy of your data source. This option displays for reports that have Auto Drill enabled.</td>
</tr>
<tr>
<td>Drill up</td>
<td>Enables you to drill up one level in the hierarchy of your data source. This option displays for reports that have Auto Drill enabled.</td>
</tr>
<tr>
<td>Restore Original</td>
<td>Restores the active report to the default state specified in the report procedure.</td>
</tr>
<tr>
<td>Auto Links</td>
<td>Displays a list of target reports that are linked to the Auto Link enabled report. This option displays for reports that have Auto Linking enabled.</td>
</tr>
<tr>
<td>Comments</td>
<td>Enables you to add comments about data in your report. The result is an annotation that displays when you hover over it at run time.</td>
</tr>
<tr>
<td>Highlight Value</td>
<td>Enables you to highlight a particular value in your report.</td>
</tr>
<tr>
<td>Highlight Row</td>
<td>Applies highlighting to the selected row in your report.</td>
</tr>
<tr>
<td>Unhighlight All</td>
<td>Removes any applied highlighting from values or rows in your report.</td>
</tr>
<tr>
<td>Filter Cell</td>
<td>Enables you to filter the output, showing only a selected row of data.</td>
</tr>
<tr>
<td>Remove Cell Filter</td>
<td>Removes any applied cell filters.</td>
</tr>
</tbody>
</table>

**Configuring Active Technologies Report Options**

You can configure active report options, including menu options, based on user role, through the active report options dialog box.

You can access the dialog box on the Format tab, in the Features group, by clicking the *active report options* button. The button is available when active report is selected as the output type.
The active report options dialog box contains the following tabs:

- General
- Menu Options
- Colors
- Advanced

**General Tab**

Use the General tab to set common properties specific to active reports.

The General tab contains the following options:

- **Display.** This area contains options to set the window to cascade or tabs, and options to freeze columns.
  - **Window.** Select the window setting. The options are Cascade and Tabs.
  - **Freeze Columns.** Select the columns you would like to freeze. You can also select None.

- **Page Options.** This area contains options to set the number of records per page, enable the display of page information, edit the alignment, and set the location of the page information.
  - **Records Per Page.** Select or type the number of records that you would like to display per page. The default value is 57.
  - **Display Page Information.** Select this option to display page navigation information. Clear this option to disable the display of page navigation information.
  - **Alignment.** Click the appropriate button to set the alignment of the page navigation information. Options are Left, Center, and Right.
  - **Location.** Select the location for the page navigation information. The options are Top Row and Bottom Row.

**Menu Options Tab**

Use the Menu Options tab to select a user type and which options to display in the menu.
The Menu Options tab contains the following options:

- **User Type.** The options are Power, Analyst, Basic, and Custom.
  - **Power.** This is the default user type. It enables all functionality.
  - **Analyst.** This user type has the following functionality: Show Records, Freeze, Hide/Unhide, Export, Sorting, Pivot, Filter, Calculations, Chart, Visualize, Restore Original, Save Changes, and Accordion.
  - **Basic.** This user type has the following functionality: Show Records, Freeze, Hide/Unhide, Sorting, Filter, Calculations, Visualize, and Restore Original.
  - **Custom.** If you select a combination of options that does not match one of the existing user types (Power, Analyst, Basic), the User level name that appears in the User Type field is Custom. This is not a default user type or a selectable user type. It indicates that options for this user do not match any of the existing user types.

The options available according to user type include the following:

- **Show Records.** Shows all records or specific numbers of records.
- **Freeze.** Freezes and unfreezes columns.
- **Hide/Unhide.** Hides and shows columns.
- **Export.** Exports data to HTML, CSV, Excel, or PDF if active cache is enabled, or to HTML, CSV, or XML (Excel) if active cache is disabled.
- **Sorting.** Sorts data in ascending or descending order.
- **Pivot.** Lists the fields available to create a Pivot table.
- **Window Type.** Shows windows as cascade or tabs.
- **Send as Email.** Enables you to save the current changes and send a report as email.
- **Print.** Prints all records or filtered-only records.
- **Advanced Tools.** Accesses the Chart/Rollup, Pivot, and Grid Tools.
- **Filter.** Opens the Filter Selection dialog box.
- **Calculations.** Performs the following calculations: Sum, Avg, Min, Max, Count, Distinct, % of Total.
- **Chart.** Converts a report to a pie, line, bar, or scatter chart.
- **Visualize.** Adds data visualization bars to a report.

- **Rollup.** Performs rollup on data.

- **Comments.** Adds comments.

- **Restore Original.** Restores the active report to the default state specified in the report procedure.

- **Save Changes.** Saves the current changes.

- **Accordion.** Produces accordion reports.

- **Grid Tool.** Opens the Grid Tool dialog box.

### Colors Tab

Use the Colors tab to select colors for various objects on the report.

The Colors tab contains the following options:

- **Page.** This area contains options to set the colors for the font and background of the page text.

  - **Font.** Opens the Color dialog box, where you can select the font color.

  - **Background.** Opens the Color dialog box, where you can select the background color for the page text.

- **Row Selection.** This area contains options to set the colors that appear when you point to or select a row on the report.

  - **Hover.** Opens the Color dialog box, where you can select the color that the row becomes when you hold the mouse over the row.

  - **Selected.** Opens the Color dialog box, where you can select the highlight color that the row becomes when you use the highlight option.

- **Visual.** This area contains options to set the colors for the data visualization bars.

  - **Positive.** Opens the Color dialog box, where you can select the color for a data visualization bar that represents a positive number.

  - **Negative.** Opens the Color dialog box, where you can select the color for a data visualization bar that represents a negative number.
Calculations. This area contains options to set the colors for values in a calculation.

- **Font.** Opens the Color dialog box, where you can select the font color for the calculation.
- **Background.** Opens the Color dialog box, where you can select the background color for the calculation.

Menu. This area contains options to change the color of the menu.

- **Normal**
  - **Font.** Opens the Color dialog box, where you can select the color for the text of the options on the column menus.
  - **Background.** Opens the Color dialog box, where you can select the background color for the column menus.
  - **Border.** Opens the Color dialog box, where you can select the color for the border of the column menus.

- **Hover**
  - **Font.** Opens the Color dialog box, where you can select the color for the text of the options on the column menus when you point to them.
  - **Background.** Opens the Color dialog box, where you can select the background color that appears behind options on the column menus when you point to them.

Advanced Tab

Use the Advanced tab to control the number of rows retrieved from active cache and to add security settings.

**Note:** Active cache is enabled when you select *active report* as the output type, and click *Pages On Demand* on the Format tab, in the Navigation group.

The Advanced tab contains the following options:

- **active cache.** Enables a report to cache the data in a binary file and return the data to the output window in pre-set increments.
- **Rows Retrieved.** Select the number of rows retrieved in the output. The default value is 100.
- **Security.** This area allows you to set a password to access the report and enable expiration by date or by days.
**Note:** When setting security options for active reports, be aware that security options can be set for each individual component on the canvas, but only one password can be set for the entire document.

**Creating an Active Technologies Chart**

An active chart is a chart that is designed for offline analysis. For more information, see *Active Technologies Report Overview* on page 507.

**Procedure: How to Create an Active Technologies Chart**

With InfoAssist in Chart mode, you can perform this procedure in Query Design view or Live Preview.

1. On the Home tab, from the Format group, click Output File format and click *active report*.
2. On the Format tab, in the Chart Types group, click the button of the chart that you want to create. Bar chart is the default.
   
   The chart appears on the canvas.

3. Populate the chart with your data in one of the following ways:

   - Drag the dimension fields and measure fields onto the chart.
   - Drag the dimension fields and measure fields into the appropriate field containers in the Query pane.

**Active Technologies Options for Charts**

Menu options for an active chart are described in the following table.

**Note:** For charts that employ the new attribute syntax, only the following four icons display: More Options, Advanced Chart, Original Chart, and Aggregation. If you have applied a filter, the Remove Filter icon displays.
<table>
<thead>
<tr>
<th>Option</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>More Options</td>
<td><strong>New.</strong> Creates a new instance of the chart. This option is available only when the chart is created from a column menu on a tabular report.</td>
</tr>
<tr>
<td></td>
<td><strong>Group By (X).</strong> Changes groups by the horizontal sort field.</td>
</tr>
<tr>
<td></td>
<td><strong>Add (Y).</strong> Adds a vertical sort field.</td>
</tr>
<tr>
<td></td>
<td><strong>X-Axis.</strong> Specifies a measure or dimension sort field. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Y-Axis.</strong> Specifies a measure. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Arrange By.</strong> Specifies the marker color. The marker color depends on the field assigned to the color attribute. If no field is assigned to this category, then all of the markers will be the same color. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Export to.</strong> Exports to Excel, Word, or PowerPoint.</td>
</tr>
<tr>
<td></td>
<td><strong>Stacked.</strong> Stacks the risers on top of each other, with the length of each riser representing the data value. Applies to column charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Top.</strong> Displays the top values. Options are Top 3, Top 5, Top 10, and Clear Top. Applies to pie charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Trend.</strong> Draws a trendline and equation label for an individual series. Applies to scatter charts.</td>
</tr>
<tr>
<td></td>
<td><strong>Chart/Rollup Tool.</strong> Opens the Chart/Rollup Tool, which you can use to select multiple group fields in the chart or rollup table generated. The Chart/Rollup Tool contains a list of columns available in the active report and Group By and Measure sort fields. Drag the columns into the desired sort field.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When working with the Chart/Rollup Tool for active charts (specifically those with the new chart attribute syntax), the Series tab is not supported. It is available with charts that are created with tabular reports or stand-alone charts that do not use the new chart attribute syntax.</td>
</tr>
<tr>
<td></td>
<td><strong>Restore Original.</strong> Restores the active report to the default state specified in the report procedure.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Column</td>
<td>Displays data as a column chart.</td>
</tr>
<tr>
<td>Pie</td>
<td>Displays data as a pie chart.</td>
</tr>
<tr>
<td>Line</td>
<td>Displays data as a line chart.</td>
</tr>
<tr>
<td>Scatter</td>
<td>Displays data as a scatter chart.</td>
</tr>
<tr>
<td>Rollup</td>
<td>Displays the chart as a rollup table.</td>
</tr>
<tr>
<td>Advanced Chart</td>
<td>Opens the Chart/Rollup Tool.</td>
</tr>
<tr>
<td>Original Chart</td>
<td>Restores the active chart to the chart type specified in the report procedure.</td>
</tr>
<tr>
<td>Lock/Unlock</td>
<td>Freezes the chart or rollup table. You can link or unlink a chart or rollup table to the filters that you have applied in your report using the Freeze Chart or Freeze Rollup icon. The icon indicates whether the report is linked to the filter (Freeze Chart or Freeze Rollup) or not (Unfreeze Chart or Unfreeze Rollup). This option is available only when the chart is created from a column menu on a tabular report.</td>
</tr>
<tr>
<td>Option</td>
<td>Definition</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Applies the following options to a Measure field: Sum, Avg, Min, Max, Count, and Distinct. The default value is Sum.</td>
</tr>
<tr>
<td>Remove Filter</td>
<td>Removes a filter from a chart. You can apply a filter by pointing to or lassoing an area of the chart and then clicking the Filter Chart or Exclude from Chart option from the chart tooltip.</td>
</tr>
</tbody>
</table>

**Creating an Active Technologies Dashboard**

You can create an active dashboard by inserting multiple content types, such as reports, charts, images, and text, into a document. An active dashboard will run any report or chart using the active output format, even if the report or chart itself is not in active output format.

You can also insert active dashboard prompts into a document to act as filters for the reports and charts on the dashboard. You can cascade (chain) prompts to populate them based on the selections from the previous prompts.

The output format of the active dashboard must be active report in order to add active dashboard prompts.

**Active Technologies Dashboard Prompts**

The Active Dashboard Prompts group contains buttons that insert active dashboard prompts into your dashboard. This group is only visible when the output format of the dashboard is set to active report. You can access the active dashboard prompts on the Insert tab, in the active dashboard prompts group.

The following are the types of active dashboard prompts that you can use to apply filters to an active dashboard:

- **Drop Down.** Inserts a drop down prompt placeholder in the upper-left corner of the canvas.
- **List.** Inserts a list prompt placeholder in the upper-left corner of the canvas.
- **Checkbox.** Inserts a check box prompt placeholder in the upper-left corner of the canvas.
- **Radio Button.** Inserts a radio button prompt placeholder in the upper-left corner of the canvas.
- **Text.** Inserts a text area prompt placeholder in the upper-left corner of the canvas.
**Note:** The display of values populated in active dashboard prompts is dependent on the data setting. For example, if sample data is turned on, then active dashboard prompts will show sample data, such as:

WF_RETAIL1  
WF_RETAIL2  
WF_RETAIL3

**Target Reports**

When you bind a field to an active dashboard prompt, the default target report is the report from which you dragged the field. You can add or remove target reports from an active dashboard prompt through the active dashboard properties dialog box. For more information on using the active dashboard properties dialog box, see *Using Multiple Reports as Targets and Sources* on page 531.

A report must meet one of the following requirements to be a target report:

- The report must contain a field with the same name as the source field (actual field name or AS name).

- The Master File of the report must contain a field with the same name as the source field.

If a report is eligible to be a target report because the field has the same user-supplied title and the title is changed, the report is automatically removed as a target.

**Procedure:** How to Add an Active Technologies Dashboard Prompt to a Dashboard

This procedure describes how to begin to create a dashboard by creating one report and binding a single prompt to one of the fields of the report.

With InfoAssist in Document mode:

1. On the Home tab, from the Format group, click Output File format and click *active report*.
2. On the Insert tab, in the Reports group, click *Report*.
   
   A placeholder appears on the canvas.
3. Drag fields onto the canvas, or into the Query pane, to create the report and start building the dashboard.
4. On the Insert tab, in the *active dashboard prompts* group, select a dashboard prompt to insert into the document.
   
   An active dashboard prompt appears in the upper-left corner of the canvas. If the report is located in the upper-left corner of the canvas, you will have to drag the prompt off of the report.
5. Select the report and bind one of its data source fields to the prompt in one of the following ways:

- **Query pane:** Select the report. From the Query pane, drag the field that you want to bind onto the prompt.

- **Report on the canvas:** Click the report on the canvas. You can now edit it. Highlight the column that contains the data that you want and drag it onto the prompt.

Once you have bound the field to the prompt, the values of the field appear in the prompt.

**Note:** Once an active dashboard prompt is added to the canvas, the document is locked in an active output format. You cannot change the active report format if there are prompts present on the canvas. To switch to a non-active output format, you must remove all prompts.

**Using Multiple Reports as Targets and Sources**

You can add multiple reports and charts to an active dashboard. Each report can have multiple prompts associated with it.

**Procedure:** How to Build a Dashboard With Multiple Reports as Targets and Sources

The following procedure describes how to set up active dashboard prompts for two reports on a dashboard. In the example that is used, the first report contains information about the categories of electronics products sold in various regions. The Product,Category field will be bound to a group of radio buttons. Each radio button will represent a particular product category of electronics. When you select a radio button for a product category, for example, Accessories, the report will be filtered by your selection.

The second report contains information about the gender and geographic location of electronics consumers. The Gender field will be bound to a drop-down list. The list will display the values, F (female) and M (male). When you select a gender from the drop-down list, the report will be filtered by your selection.

1. Open InfoAssist in Document mode using the wf_retail_lite Master File.

2. Create an active dashboard by adding two reports with the following components, respectively:

   **Report 1:**
   - Product,Category
   - Store,Business,Region
   - Discount
Gross Profit

**Report 2:**

- Gender
- Customer, Continent
- Product, Category

3. On the Insert tab, in the Active Dashboard Prompts group, add the following active dashboard prompts to the dashboard, positioning them relative to each respective report.

- **Radio Button:** This prompt will be used for Report1.
- **Drop Down:** This prompt will be used for Report2.

For more information on working with active dashboard prompts, see *How to Add an Active Technologies Dashboard Prompt to a Dashboard* on page 530.

4. Right-click the radio button active dashboard prompt for which you want to bind a field to and click *Properties*.

The active dashboard properties dialog box opens.

The Prompts list displays the two prompts (for example, radiobutton_1 and radiobutton_2) that were added to the dashboard in step 3.

5. From the Report drop-down menu, select the report that contains the field to which you want to bind an active dashboard prompt.

In this example, the radio button list (radiobutton_1) has been selected as the prompt for the region report (Report1), as shown in the following image.
The next step describes how to bind the Product,Category field from the region report to the radio button list to filter that report.

6. From the Field drop-down menu, select the field to which you want to bind the active dashboard prompt.

In this example, the Product,Category field has been selected for the radio buttons list (radiobutton_1), as shown in the following image.

![Image of Active Dashboard Properties]

**Note:** You can optionally specify an ascending or descending sort order for the current scenario.

7. Click **OK**.

The prompt is now bound to the field on the dashboard.
In the following image, the radio buttons list is bound to the Product,Category field. It displays all product categories by which a user can filter the report.

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Store Business Region</th>
<th>Discount</th>
<th>Gross Profit</th>
</tr>
</thead>
<tbody>
<tr>
<td>[All]</td>
<td>EMEA</td>
<td>$2,437,956.41</td>
<td>$15,898,776.98</td>
</tr>
<tr>
<td>Accessories</td>
<td>North America</td>
<td>$3,416,809.19</td>
<td>$22,879,859.37</td>
</tr>
<tr>
<td>Camcorder</td>
<td>South America</td>
<td>$153,257.58</td>
<td>$1,027,460.88</td>
</tr>
<tr>
<td>Computers</td>
<td>EMEA</td>
<td>$2,840,963.46</td>
<td>$19,928,603.81</td>
</tr>
<tr>
<td>Media Player</td>
<td>North America</td>
<td>$4,075,160.76</td>
<td>$28,304,171.49</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>South America</td>
<td>$185,793.84</td>
<td>$1,309,721.34</td>
</tr>
<tr>
<td></td>
<td>EMEA</td>
<td>$1,700,675.30</td>
<td>$12,147,362.23</td>
</tr>
<tr>
<td></td>
<td>North America</td>
<td>$2,999,148.76</td>
<td>$20,556,914.70</td>
</tr>
<tr>
<td></td>
<td>South America</td>
<td>$100,862.80</td>
<td>$753,505.60</td>
</tr>
<tr>
<td></td>
<td>EMEA</td>
<td>$4,678,461.09</td>
<td>$22,897,933.25</td>
</tr>
<tr>
<td></td>
<td>North America</td>
<td>$6,522,133.78</td>
<td>$31,364,927.54</td>
</tr>
<tr>
<td></td>
<td>South America</td>
<td>$304,665.09</td>
<td>$1,499,928.75</td>
</tr>
<tr>
<td></td>
<td>EMEA</td>
<td>$5,428,981.57</td>
<td>$34,639,882.85</td>
</tr>
<tr>
<td></td>
<td>North America</td>
<td>$7,744,502.52</td>
<td>$49,228,757.29</td>
</tr>
<tr>
<td></td>
<td>South America</td>
<td>$341,022.82</td>
<td>$2,214,130.64</td>
</tr>
<tr>
<td></td>
<td>EMEA</td>
<td>$1,518,099.74</td>
<td>$6,990,404.98</td>
</tr>
<tr>
<td></td>
<td>North America</td>
<td>$2,013,911.63</td>
<td>$9,358,461.12</td>
</tr>
<tr>
<td></td>
<td>South America</td>
<td>$102,362.82</td>
<td>$462,120.21</td>
</tr>
<tr>
<td></td>
<td>EMEA</td>
<td>$1,066,117.73</td>
<td>$7,195,930.82</td>
</tr>
<tr>
<td></td>
<td>North America</td>
<td>$1,552,040.11</td>
<td>$10,272,127.15</td>
</tr>
<tr>
<td></td>
<td>South America</td>
<td>$73,964.80</td>
<td>$460,856.91</td>
</tr>
</tbody>
</table>

The following steps describe how to bind the Gender field in the gender report (Report2) to the drop-down list prompt.

8. Right-click the Drop Down active dashboard prompt for which you want to bind a field and click Properties.

The active dashboard properties dialog box opens again.
Notice that combobox_2, the prompt selected on the dashboard, is selected in the Prompts list.

9. From the Report drop-down menu, select the report (Report2) that contains the field to which you want to bind an active dashboard prompt.

   The next step describes how to bind the Gender field from the gender report to the drop-down list to filter that report.

10. From the Field drop-down menu, select the field (Gender) to which you want to bind the active dashboard prompt.

   Once the Gender field has been selected, Report2 (gender report) appears in the Targets list and Report1 (region report) appears in the Candidate Reports list.

   **Note:** To move a report from the Candidate Reports list box to the Targets list box, select it and click the *Add to List* arrow. To remove a report from the Targets list box, select it and click the *Remove from List* arrow. You can select multiple reports by holding down the Ctrl key and clicking each one.

11. Click *OK*.
The prompt is now bound to the field on the dashboard. You can now filter the gender report by female or male, as shown in the following image.
The final active dashboard displays, as shown in the following image.

**Procedure:  How to Change the Field**

You can change the field to which the active prompt is bound.

1. Create an active dashboard in Document mode, or open an existing dashboard, and bind an active prompt to a field.
2. Right-click the active dashboard prompt that you want to configure, and click Properties. The active dashboard properties dialog box opens.
3. From the Field menu, select a different field.
   
   A warning message alerts you that changing the source field for the prompt will remove the existing prompt and any dependent (child) prompts from the cascades.

4. Click OK to close the warning.
5. Click OK to close the active dashboard properties dialog box.
The active dashboard prompt is updated with the new source field.

**Procedure: How to Change the Filter Condition**

1. Create an active dashboard in Document mode, or open an existing dashboard, and bind an active dashboard prompt to a field, as described in *How to Add an Active Technologies Dashboard Prompt to a Dashboard* on page 530.

2. Right-click the active dashboard prompt that you want to work with, and from the shortcut menu, select *Properties*.

   The active dashboard properties dialog box opens.

3. From the Condition drop-down menu, select the filter condition for the active dashboard prompt. The options are Equal to, Not equal to, Less than, Less than or equal to, Greater than, and Greater than or equal to.

4. Click *OK*.

   The filter condition is applied to the active dashboard prompt.

**Procedure: How to Add Multiple Prompts to a Dashboard**

1. Create an active dashboard in Document mode, or open an existing dashboard containing at least one report, and add at least two active dashboard prompts, as described in *How to Add an Active Technologies Dashboard Prompt to a Dashboard* on page 530.

2. Bind the fields to prompts that you have added, as described in *How to Add an Active Technologies Dashboard Prompt to a Dashboard* on page 530.

**Procedure: How to Cascade Prompts**

When you have more than one prompt on the canvas, you can cascade prompts to populate them based on the selections of the previous prompts. Cascading prompts have a parent-child relationship, in which the parent filters the available options of the child.

An active prompt can be the parent of more than one other prompt, but cannot be a child of more than one prompt.

1. Create an active dashboard in Document mode, or open an existing dashboard, and bind at least two active prompts to fields.

2. Right-click the active dashboard prompt that you want to configure, and click *Properties*.

   The active dashboard properties dialog box opens.

3. Click *Cascades*.
By default, a cascade named Cascade1 appears in the Cascades section of the active dashboard properties dialog box.

- You can click the Create a new cascade button to create a new cascade.
- You can click the Delete selected cascade button to delete the selected cascade.

4. Select the cascade to which you want to add prompts.

5. From the Available Prompts list box, select the prompt that you want to add.

6. Click the Add to List arrow to move the selected prompt to the Selected Prompts list box.

   **Note:** You can remove prompts from the Selected Prompts list box by selecting them and clicking the Remove from List arrow.

7. Add any additional prompts you want to be part of the cascade by repeating steps 5 and 6.

   By default, the hierarchy of the prompts is determined by the order in which they are added to the Selected Prompts list. The cascade of the prompts is from top to bottom. The prompts that come first in the Selected Prompts list are the parents of the lower prompts.

8. You can change the hierarchy of the prompts by selecting a prompt in the Selected Prompt list box and clicking the Move Up and Move Down arrows.

9. Click OK.

   The cascade is created.

10. Run the report.

    **Note:** If you set up more than one cascade, the cascade that you interact with last is the one that filters the report.

### Using Navigation Options for Reports

When working with reports, you can use the following options to customize output display and navigation.

- **Table.** Generates standard browser output. This is the default.

- **Table of Contents.** Generates output by displaying a table of contents icon in the upper-left corner where report output typically appears. Clicking Table of Contents opens a menu that enables you to select (view) individual values of the first Sort By (By) field, one value at a time.

You can also select options to view the entire report or remove the table of contents.
Creating Maps to Illustrate Trends

Using InfoAssist, you can create maps to identify patterns or trends in your data. By converting data into values that can be displayed on a map, you are able to visualize scenarios, illustrate hot spots, and identify potential problem areas. For example, a law enforcement agency may use mapping functionality to identify areas of higher crime within the locations they cover. You can also use maps to determine how places are related, understand where things are located, and identify the best actions to take. By illustrating trends on a map, a decision maker can identify patterns easily, and reach conclusions sooner.

**Creating Maps to Illustrate Trends**

- **Note:**
  - The Table of Contents option is activated only when HTML, active report, Excel, or PowerPoint output format is selected.
  - You cannot use the Table of Contents option with the Accordion feature.
  - **Freeze.** Generates output with column titles that freeze (remain in view) when you scroll through pages of the report output.
  - **Pages On Demand.** Provides access to two distinct features depending upon the output type that you have selected.
    - **HTML.** If you select this output type, and click *Pages on Demand*, then the report opens in the WebFOCUS Viewer.
    - **active report.** If you select this output type, and click *Pages on Demand*, then active cache is enabled. For more information on active cache, see *Using the Active Cache Option* on page 462.
  - **Auto Drill.** Provides access to Auto Drill functionality, which enables you to navigate the hierarchy of your data at run-time. For more information, see *Using Auto Drill* on page 839.
    - **Note:** Auto Drill functionality is only available for the HTML and active report output formats.
An early example of how maps can be used to illustrate trends is the case of Dr. John Snow, an epidemiologist who was one of the first to use data to map occurrences of cholera to find the cause of infection. By plotting the cholera data on a map of a town, Dr. Snow was able to visualize a trend that showed higher incidences of cholera closest to water pumps. This example is shown in the following image.

Maps also allow you to measure size, shape, and distribution to detect and quantify patterns, and even perform predictive analytics. An example of how maps can help detect and quantify patterns is the scenario in which a state agency used a WebFOCUS mapping application to solve a problem with their food stamp system. Using this application, odd food stamp redemptions, such as rounded numbers transactions, were discovered. By plotting those transactions on a map, the agency discovered that the redemptions appeared in the same geographic location. Upon further investigation, the agency identified that individuals were selling their food stamps at reduced prices, $50 worth of food stamps for $40 in cash, to others instead using them as intended. This map example is shown in the following image.
When working with maps, the concepts of location intelligence and business intelligence are important to understand. A Geographic Information System (GIS) captures, stores, analyzes, manages, and presents data linked to a location, while Business Intelligence (BI) relies on the conversion of raw data into meaningful information. Location intelligence is the process of analyzing data to make better business decisions. It combines GIS and BI/Analytics to allow the recognition of patterns in your data, including the visualization and discovery of geospatial outliers, which would not be easily discovered if you use the technology independently and separately.

More specifically, maps use non-intrusive GIS workflows with existing data. You can view symbol layers for data bound to a geo-location, such as state, country, and ZIP code, in an integrated map viewer. Using metrics from your data, you can also visualize geographic roles or dimensions. Geographic roles, or dimensions, can be built directly into your Metadata or assigned to a data field when you create a map.

**InfoAssist and Esri Integration**

Using WebFOCUS InfoAssist with the Esri integration, you can create maps that help you illustrate or identify trends, so that you can take action quickly. WebFOCUS architecture provides the framework in which this system operates. Using a Javascript map viewer, you can navigate the interface easily, as shown in the following image.
In addition, this integration utilizes the capabilities of Esri by leveraging the ArcGIS Javascript API and content. Specifically, you can integrate data into maps with published content in ArcGIS Online platform. For more information, see http://www.esri.com/software/arcgis/arcgisonline. Additionally, by using this integration, you can include information about demographics, spending habits, crime, and lifestyle to maps that contain your data. These maps include layers with extensive demographic or reference detail and topography and allow you to view information about people, businesses, climate, and much more.

You can create the following maps in InfoAssist:

- **Choropleth.** A common thematic map that uses geographical measures (for example, states and countries), representing the values aerially while employing a varying intensity of colors. It is useful for visualizing location-based data, trends, and distributions across a geographic area. The color hues for Choropleth maps are dictated by the legend, based on the selected measure, enabling you to determine data concentration across your map.

- **Proportional Symbol (Bubble).** A map that represents coordinates, such as an address or intersection, using symbols of different sizes to represent any measure. These maps focus on specific areas, for which data concentrations may vary. When the data concentration is larger, the bubble will be bigger.

Both maps can be created in Chart or Visualization mode. Built-in zooming capabilities allow you to drill down to a specific geographic area of focus easily. This allows you to get a closer look at regional or local data, draw inferences, and make recommendations, without changing the initial view of your data.

In Chart mode, you can also use the Auto Drill and Auto Linking features that are available when you create charts or reports in InfoAssist. In Visualization mode, you can also drill up and down within different levels in a data hierarchy in a map. Auto Drill allows you to navigate through the geographical hierarchy of your map data at run time. You can use this information to visualize the same measure at different geographical hierarchies, such as Countries to States and States to Cities. Auto Linking allows you to connect to related charts or reports in your environment that share similar data parameters.

Using the Esri integration in InfoAssist, you can also add the following layers to your map:

- **Backgrounds.** Display a layer that positions data as it is located, in context to other geographical features, such as streets, terrain, and imagery. Some standard Background options may combine road, aerial, and topographic data using a variety of symbols. Hosted on ArcGIS, you can change your background at any time, to review your data in a different context.
When you apply a Background to your map, its appearance changes. You can then adjust the view of your data, showing different terrain or geographical views. Backgrounds provide at least 17 levels of zoom. For more information, see https://developers.arcgis.com/javascript/jsapi/esri.basemaps-amd.html.

- **Reference Layers.** Display a layer of boundaries and locations that range from a continental scale to country, state, and even local neighborhood. For example, if you are viewing World data on electricity usage, you may want to add a Reference Layer that displays the borders and concentration of your data within each country.

- **Demographic Layers.** Display a layer of information about people and businesses in a specific demographic area. This includes the United States and 120 other countries. Demographic Layers are thematic maps that provide additional information about the location, such as spending habits, population, and lifestyles. You can add Demographic Layers to a map about sales data, to identify new locations for stores, based on the spending habits for a specific area.

Both mapextent and the Layers menu functionality are applied to your map when you select a Background, Reference Layer, or Demographic Layer. Mapextent is an automatic view of the map. Layers is a menu that appears on the map and provides access to options that allow you to adjust the information that is being displayed.

The map example in the following image shows the use of layers.

![Map example](image)

**Note:** Backgrounds, Demographic Layers, and Reference Layers can be accessed from the Format tab for maps in both Chart and Visualization mode. These layers are static, standard options that Esri provides for use with InfoAssist, and do not change based on the data source that you select.
Configuring an Esri On Premise Environment

The Esri On Premise functionality enables you to download and access mapping files through the use of a local Application Programming Interface (API). Once you download and configure the API, you do not need an internet connection to utilize the robust mapping features that Esri provides. For information on downloading and configuring the API that controls this feature, see *How to Download and Configure the ArcGIS JavaScript API* on page 545.

The Esri On Premise functionality provides you with local access to Esri mapping files. This is particularly useful if you are away from your office or without an Internet connection. You may also be using a mobile device, such as an iPad or smartphone with a large screen, without an Internet connection. The following mapping components are supported when using the Esri On Premise functionality:

- **Offline Basemaps.** Basemaps are an offering from ArcGIS. Standard basemaps are provided for your use offline. For example, there is an Oceans basemap and a Terrain with Labels basemap. In InfoAssist, these basemaps are also known as backgrounds. In an online setting, there are 10 basemaps available. In order to use offline basemaps, you need to use a tiled mapservice published in the ArcGIS Server.

- **Offline Geographic Roles.** Geographic Roles are used to visualize measures with commonly known dimensions (for example, Country, State, Cities, and so on). These provide the location information often in the form of (x/y) needed to plot on a map. Geographic roles are pre-defined for online users through ArcGIS Online. In InfoAssist, a geographic role defines the geographic component that you can select when creating a map (for example, State or Continent). For an offline user, the options that display can be customized in the geoservices.xml file. For more information, see *Customizing the List of Geographic Roles* on page 565.

  **Note:** Demographic Layers are not supported in an Esri On Premise environment.

**Procedure: How to Download and Configure the ArcGIS JavaScript API**

You can use this procedure to download and configure the API that controls the Esri On Premise environment.

1. In your browser, navigate to the following URL to download the API: [https://developers.arcgis.com/downloads](https://developers.arcgis.com/downloads)

2. Sign in to access the download options that are available to you.
3. Select Version 3.15 of the ArcGIS API for JavaScript, as shown in the following image.

![ArcGIS API for JavaScript](image)

4. Click API to download the API.

5. In drive:\ibi\config\web_resource, create a folder named arcgis_api.

6. Open the arcgis_js_v315_api.zip file downloaded in step 4 and navigate to arcgis_js_v315_api\arcgis_js_api\library\3.15\3.15.

7. Extract the files in that folder to the drive:\ibi\config\web_resource\arcgis_api folder.

8. Next, verify the path to the API in the WebFOCUS Administration Console, as shown in the following image.

   ![WebFOCUS Administration Console](image)

   **Note:** This is the path to which you extracted the API files.

   This field identifies the path to the internal ArcGIS Javascript API Source that develops ESRI-based maps. This setting is blank, by default, indicating that the use of the internal API source to develop ESRI maps is not activated. The API that is referenced is https://js.arcgis.com/3.15/, by default. To direct WebFOCUS to use the internal ArcGIS Javascript API to develop ESRI maps, enter the path to the local API files that you extracted into this setting.

   **Note:** This path should be a relative path that is accessible within the local WebFOCUS install.
9. Click **Save**.

10. Next, open the following two local API files:

   - `drive:\ibi\config\web_resource\arcgis_api\init.js`
   - `drive:\ibi\config\web_resource\arcgis_api\dojo\dojo.js`

   In both files, search for `HOSTNAME_AND_PATH_TO_JSAPI`. Replace `'//' +
   
   
   
   ```javascript
   "[HOSTNAME_AND_PATH_TO_JSAPI]dojo"
   ```

   with `'//' + `HOSTNAME_AND_PATH_TO_JSAPI +

   ```javascript
   "dojo"
   ```

11. In the WebFOCUS Administration Console, click **Clear Cache** to clear the browser cache. Your configuration is complete.

**Creating and Customizing Maps in InfoAssist**

The following procedures provide step-by-step instructions on how to create and customize maps.

As you create your maps, you can use the following built-in map viewer features:

- You can use the plus (+) and minus (-) symbols, , within the map to zoom in and out of different areas of the map. You can also click your left mouse button to zoom in to a specific location.

- Like all HTML5 visualizations, the highlighted markers and regions on a map support drill, multi-drill, auto-linking, and informational tooltip features.

- When working with maps in Chart mode, you can use the Pan / Selection button to alternate between the Pan and Selection controls. This option is in the upper-right corner of the map.

- When working with maps in Visualization mode, you can toggle the Pan or Selection button to make a selection. The Pan control allows you to click, hold, and move the map with your mouse. The Selection control allows you to lasso a specific area of the map and select data in the map.

**Procedure:** **How to Create an Esri Choropleth Map**

**Note:** The default option of creating a map utilizes the ArcGIS Javascript API that Esri provides.

1. Launch InfoAssist in Chart or Visualization mode.

   - In Chart mode, on the **Format** tab, in the **Chart Types** group, click **Choropleth**.
In Visualization mode, on the Home tab, in the Visual group, click Change and click Choropleth.

A blank map displays and the Layer field container is enabled, as shown in the following image.

2. Add a Geolocation field to the Layer field container.
This field, which already has a geographic role assigned, is denoted with a Layer icon, 🕯️, in the Data panel, as shown in the following image. You can also hover over a data field to view the geographic role assignment.

For more information, see Geographic Roles on page 562.

The canvas refreshes, and your map displays.

3. Before saving your map, to add insight, you can also do following:

- Click Run, to preview your map.
- Add a measure or dimension to the Color field container, to color your chart by that underlying data value. When you add a measure or dimension field to the Color field container, a legend displays for that data value. If you specify a dimension in the Color field container, the label changes to Color BY.
- Add a dimension or measure to the Tooltip field container, which will display tooltip information when you place your mouse over an area of the map.
- Add a Background, Demographic Layer, or Reference Layer.

4. Click Save to save your map.
Procedure: How to Create an Esri Proportional Symbol (Bubble) Map

1. Launch InfoAssist in Chart or Visualization mode.
   - In Chart mode, on the Format tab, in the Chart Types group, click Proportional Symbol.
   - In Visualization mode, on the Home tab, in the Visual group, click Change and select Proportional Symbol.

A blank map displays and the Layer field container is enabled.

2. Place a data field with a defined geographic role in the Layer field container.

This field, which already has a geographic role assigned, is denoted with a Layer icon, in the Data panel, as shown in the following image. You can also hover over a data field to view the geographic role assignment.

For more information, see Geographic Roles on page 562.
A basic bubble map displays, as shown in the following image.

3. Before saving your map, to add insight, you can also do the following:
   
   - Click Run, to preview your map.
   
   - Add a measure or dimension to the Color field container, to color your chart by that underlying data value.
   
   - Add a measure to the Size field container, to control the size of the bubbles on your map.
   
   - Add a measure to the Tooltip field container, to display tooltip information when you place your mouse over an area of the map at run time.
   
   - Add a Background, Demographic Layer, or Reference Layer.

4. Click Save to save your map.

**Procedure: How to Assign a Geographic Role to a Data Field**

1. Launch InfoAssist in Chart or Visualization mode.
   
   - In Chart mode, on the Format tab, in the Chart Types group, click Choropleth.
In Visualization mode, on the Home tab, in the Visual group, click Change and click Choropleth.

2. In the Data pane, select a data field without a geolocation assignment.

3. Perform one of the following tasks to open the Map dialog box and assign a geographic role:
   - Right-click the desired data field, click Map As and select a geographic role, as shown in the following image.

   ![Map As menu]

   - Drag the desired data field into the Layer field container.
The Map dialog box displays, as shown in the following image.

4. In the Map dialog box, select a geographic role. For example, State.

**Note:** When specifying a geographic role, you can use Name or an ISO-2 value for countries. The ISO-2 codes are recognized worldwide, as published in [http://www.iso.org/iso/country_codes](http://www.iso.org/iso/country_codes)

The Map dialog box refreshes and shows the Depends on section, as shown in the following image.
Note: If you used the Map As option, the Depends on section automatically displays, since a geographic role was selected at that time.

5. In the Depends on section, choose from the following options:

- **Field.** Identifies a specific field on which the geographic role depends. For example, you can select Country or Continent.

- **User Defined.** Enables the definition of a specific value from the data source. Selections can be as simple as a specific country. For example, you can select US.

The Geographic Role field automatically populates based on the hierarchy of your data source. For example, if your primary geographic role was State, and in your metadata hierarchy, State depends on Country, this option displays.

6. Click OK.

If you used the Map As option, you must place the data field with the defined geographic role in the Layer field container. If you placed a data field in the Layer field container and defined a geographic role, the field is automatically added to the Layer field container.

A basic map displays, as shown in the following image.
7. Before saving your map, to add insight, you can also do following:
   - Click Run, to preview your map.
   - Add a measure or dimension to the Color field container, to color your chart by that underlying data value.
   - Add a measure to the Size field container, to control the size of the bubbles on your map.
   - Add a measure to the Tooltip field container, to display tooltip information when you place your mouse over an area of the map at run time.
   - Add a Background, Demographic Layer, or Reference Layer.

8. Click Save to save your map.

Procedure: How to Change the Geographic Role of a Geolocation Field

You can change the geographic role assignment of any geolocation field using the following steps.

1. Launch InfoAssist in Chart or Visualization mode.
   - In Chart mode, on the Format tab, in the Chart Types group, click Choropleth.
   - In Visualization mode, on the Home tab, in the Visual group, click Change and click Choropleth.

2. From the Data pane, right-click a geolocation field and click Map As.

3. Select a geographic role.
   The Map dialog box displays using the selected Geographic Role.

4. In the Map dialog box, optionally select a geographic role from the drop-down list. For example, Country.
   **Note:** This changes the selection that you made on the Map As list.

5. Accept the default value for Stored As, or choose a new value from the drop-down list, for example, ISO code. Stored As indicates how the data values are represented in the table.

6. Click OK.
   The geographic role changes for the selected Geolocation field in the Data pane, and the map refreshes using the new geolocation that you specified.
Procedure: How to Change the Default Background of a Map

1. Create a new map or open an existing map in InfoAssist.
2. On the Format tab, expand the Map group and click Background, as shown in the following image.
3. Select one of the following options:
   - World Street Map
   - Terrain with Labels
Procedure: How to Add Demographic Layers to a Map

1. Create a new map or open an existing map in InfoAssist.
2. On the Format tab, expand the Map group and click Demographic Layers.
3. Select from various population and lifestyle groups, as shown in the following image.

![Demographic Layers Image]

**Note:** These are pre-defined demographic profiles, provided by ArcGIS. You can select multiple options in either category to gain additional insight into your data. Specifically, each Demographic Layer has its own profile and provides a layering option, when comparing values across different layers or profiles.

4. Click **OK**.
The Demographic Layers that you select are applied to your map. The map engine displays the different groups with unique hues and coloring. You can use the Table of Contents or Layers option, to toggle between the different layers that you have specified. The Layers option is shown in the following image.

![Layers Image]

**Note:** You can select and clear the check boxes to enable the display of one or more Demographic Layers to compare and contrast the different demographic scenarios.

**Procedure:** How to Add Reference Layers

1. Create a new map or open an existing map in InfoAssist.
2. On the **Format** tab, expand the Map group and click **Reference Layers**.
The Reference Layers dialog box displays, as shown in the following image.

3. Select one or more Reference Layers, such as World Countries, to add to your map, and then click OK.
Your map refreshes, and the definitions and borders of the References Layers display on the canvas. You can use the Table of Contents or Layers option, to toggle different Reference Layers in your map. These options are shown in the following image.

**Reference:**  Query Field Containers by Map Type

This section presents the Query field containers that display for both charts and visualizations, by map type.

<table>
<thead>
<tr>
<th>Query field container</th>
<th>Chart mode</th>
<th>Visualization mode</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Layer.</strong> One data field, specifically a field containing location data (for example, State).</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td><strong>Color.</strong> One data field.</td>
<td>✓</td>
<td>✓</td>
</tr>
</tbody>
</table>
Reference: Geographic Roles

This section contains information on the geographic roles that are supported for Esri maps in InfoAssist.

<table>
<thead>
<tr>
<th>Geographic Role</th>
<th>Description</th>
<th>Maps Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>CONTINENT</td>
<td>World Continents</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>COUNTRY</td>
<td>World Countries</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>STATE</td>
<td>World Admin Divisions</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>CITY</td>
<td>World Cities</td>
<td>Proportional Symbol</td>
</tr>
<tr>
<td>COUNTY</td>
<td>World Counties</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
<tr>
<td>POSTAL-CODE</td>
<td>Postal Code</td>
<td>Choropleth, Proportional Symbol</td>
</tr>
</tbody>
</table>

Note: This is a new, simplified list of geographic roles (dimensions) that you can utilize when creating a map chart. This unified list of roles provides worldwide mapping of administrative boundaries down to the postal code level. In InfoAssist, the new roles display, by default, when assigning a geographic role. They are also available for assignment from the Map As feature in the Data pane.

The following table summarizes additional geographic role information.
**Note:** All of the following roles are geographic roles, with the exception of Latitude and Longitude, which are coordinates.

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Role Format</th>
<th>Geographic Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Full</td>
<td>ADDRESS_FULL</td>
</tr>
<tr>
<td></td>
<td>Line</td>
<td>ADDRESS_LINE</td>
</tr>
<tr>
<td>City</td>
<td>Name</td>
<td>CITY</td>
</tr>
<tr>
<td>Continent</td>
<td>ISO-3166 code</td>
<td>CONTINENT_ISO2</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>CONTINENT</td>
</tr>
<tr>
<td>Country</td>
<td>FIPS code</td>
<td>COUNTRY_FIPS</td>
</tr>
<tr>
<td></td>
<td>ISO-3166-2 code</td>
<td>COUNTRY_ISO2</td>
</tr>
<tr>
<td></td>
<td>ISO-3166-3 code</td>
<td>COUNTRY_ISO3</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>COUNTRY</td>
</tr>
<tr>
<td>Country (NUTS level 0)</td>
<td>NUTS code</td>
<td>NUTS0_CC</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>NUTS0</td>
</tr>
<tr>
<td>District (NUTS level 3)</td>
<td>NUTS code</td>
<td>NUTS3_CC</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>NUTS3</td>
</tr>
<tr>
<td>Geometry area</td>
<td></td>
<td>GEOMETRYAREA</td>
</tr>
<tr>
<td>Geometry line</td>
<td></td>
<td>GEOMETRY_LINE</td>
</tr>
<tr>
<td>Geometry point</td>
<td></td>
<td>GEOMETRY_POINT</td>
</tr>
<tr>
<td>Latitude</td>
<td></td>
<td>LATITUDE</td>
</tr>
<tr>
<td>Longitude</td>
<td></td>
<td>LONGITUDE</td>
</tr>
<tr>
<td>Postal code</td>
<td></td>
<td>POSTAL-CODE</td>
</tr>
</tbody>
</table>
The following table illustrates the geographic roles and their dependencies. Level 1 indicates the highest level of hierarchy and level 5 is the lowest level of hierarchy.

<table>
<thead>
<tr>
<th>Role Name</th>
<th>Role Format</th>
<th>Geographic Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>Province (NUTS level 2)</td>
<td>NUTS code</td>
<td>NUTS2_CC</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>NUTS2</td>
</tr>
<tr>
<td>Region (NUTS level 1)</td>
<td>NUTS code</td>
<td>NUTS1_CC</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>NUTS1</td>
</tr>
<tr>
<td>State</td>
<td>FIPS code</td>
<td>STATE_FIPS</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>STATE</td>
</tr>
<tr>
<td>US County FIPS</td>
<td>FIPS code</td>
<td>USCOUNTY_FIPS</td>
</tr>
<tr>
<td>US city</td>
<td>FIPS code</td>
<td>USCITY_FIPS</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>USCITY</td>
</tr>
<tr>
<td>US county</td>
<td>Name</td>
<td>USCOUNTY</td>
</tr>
<tr>
<td>US Postal code</td>
<td>3 digits</td>
<td>ZIP3</td>
</tr>
<tr>
<td></td>
<td>5 digits</td>
<td>ZIP5</td>
</tr>
<tr>
<td>US state</td>
<td>Abbreviation</td>
<td>USSTATE_ABBR</td>
</tr>
<tr>
<td></td>
<td>FIPS code</td>
<td>USSTATE_FIPS</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>USSTATE</td>
</tr>
<tr>
<td></td>
<td>US ISO subdivision code</td>
<td>STATE_ISO_SUB</td>
</tr>
</tbody>
</table>
## Customizing the List of Geographic Roles

Customers with Enterprise Data often have map layers that represent their territories, events, or logistical information. These are published as Map Services to either a subscription based in the Esri Cloud (ArcGIS.com) or on an internal portal. This portal is available with ArcGIS Server 10.3 installations. More information can be found at [http://server.arcgis.com/en/portal/](http://server.arcgis.com/en/portal/).

InfoAssist comes with a configuration file (geo_services.xml) that contains elements that describe all of the geographic roles, geographic hierarchies, URLs to the map services, and base maps available to InfoAssist. This file is located in the catalog directory under the server home directory:

```
c:\ibi\srvnn\home\catalog
```

where:

```
nn
```

Is the release of your WebFOCUS Reporting Server. For example, 82 for version 8.2.

<table>
<thead>
<tr>
<th>Region</th>
<th>Hierarchy Level</th>
<th>Geographic Role</th>
</tr>
</thead>
<tbody>
<tr>
<td>United States</td>
<td>1</td>
<td>COUNTRY, COUNTRY_ISO_CC</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>USSTATE, USSTATE_ABBR, USSTATE_FIPS</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>USCOUNTY, USCOUNTY_FIPS</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>USCITY, USCITY_FIPS</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>ZIP3, ZIP5</td>
</tr>
<tr>
<td>World</td>
<td>1</td>
<td>CONTINENT, CONTINENT_ISO_CC</td>
</tr>
<tr>
<td></td>
<td>2</td>
<td>COUNTRY, COUNTRY_FIPS, COUNTRY_ISO_CC, COUNTRY_ISO2, COUNTRY_ISO3</td>
</tr>
<tr>
<td></td>
<td>3</td>
<td>STATE, STATE_ISO_SUB</td>
</tr>
<tr>
<td></td>
<td>4</td>
<td>CITY</td>
</tr>
<tr>
<td></td>
<td>5</td>
<td>POSTAL CODE</td>
</tr>
</tbody>
</table>
The geographic role selections that you can make in InfoAssist are built dynamically using this configuration file. Each role definition in the configuration file, when selected in InfoAssist, generates metadata and a request that is sent to Esri in order to download the appropriate map and place the markers or polygons on the map.

A geographic role can be part of a hierarchy. For example, the World geographic role is at the top of a hierarchy that contains continents, countries, states, and cities. These hierarchies are also described in the geo_services.xml file.

To add a custom geographic role, you must add the necessary parameters for the geography to this file.

You can also customize the geographic roles available by deleting geographic role definitions from the <GEO_ROLES> object. To configure Esri On Premise, you should remove any geographic role definition that references a URL that points to a location outside of your locally hosted Esri server.

Following standard XML syntax rules, each element is enclosed in element start and end tags (<elementname>, </elementname>), and attribute values are enclosed in double quotation marks (").

**Reference: Geographic Role Definitions**

A geographic role is stored as a geo_role element in the geo_roles object of the geo_services.xml file. A geographic role must be defined with:

- An ID that will identify the role in the configuration file.
- A format and length for the data to be returned.
- A role name.
- A display title for the role name (to appear as a selection in Map dialog box in InfoAssist).
- An optional role format (if the role can have multiple formats, such as a name and an abbreviation).
- A display title for the format.
- A role type (geography for polygons, geometry for geometry points, geometry areas, or geometry lines, or coordinate for longitude or latitude).
- An optional vocabulary rule element containing vocabulary elements for associating the role with a field in the metadata.
The syntax is

```xml
<geo_role id="id" value_size="size" unified="false" role_name="rname"
    role_name_title="rname_title" role_format="rformat"
    role_format_title="rformat_title" geo_type="gtype"
    type="datatype" >
    <vocabulary_rules>
        <vocabulary>vrule</vocabulary>
    </vocabulary_rules>
</geo_role>
```

where:

- **id="id"**
  - Is an alphanumeric uppercase value, up to 50 characters, used to identify the geographic role.

- **type="datatype"**
  - Is the data type for the ID. Can be one of the following.
    - **"alpha"** for alphanumeric data, formats An or In.
    - **"integer"** for integer numeric data, format In.
    - **"numeric"** for fractional numeric data, formats Pn.m, Dn.m, or Fn.m.
    - **"text"** for text data, format TXn.

- **value_size="size"**
  - Is the optional number of characters in USAGE format length (any, if not set).

- **role_name="rname"**
  - Is the name of the geographic role.

- **role_name_title="rname_title"**
  - Is the title of the geographic role, to be displayed in the Map dialog box for selection.

- **role_format="rformat"**
  - Is an optional format for the geographic role, useful when the role can be referenced using multiple formats, such as a name, an ISO code, and an abbreviation. Standard role titles include the following.
    - **NAME.** Specifies that the role defines the name of a geographic entity, such as Florida.
    - **ABBR.** Specifies that the role defines an abbreviation, such as FL.
- **ZIP3.** Specifies that the role defines a 3-digit zip code.
- **ZIP5.** Specifies that the role defines a 5-digit zip code.
- **FIPS.** Specifies that the role defines a FIPS (Federal Information Processing Standard) code.
- **ISO2.** Specifies that the role defines an ISO 3166-2 code published by the International Organization for Standardization (ISO).
- **ISO3.** Specifies that the role defines an ISO 3166-3 code published by the International Organization for Standardization (ISO).
- **LINE.** Specifies that the role defines one line of a role, just as an address line.
- **FULL.** Specifies that the role defines a full geographic role, such as a full address.

```xml
role_format_title="rformat_title"
```

Is an optional title for the format of the geographic role. It will be shown in parentheses along with the role title in the Map dialog box, for example, State (Abbreviation).

```xml
geo_type="gtype"
```

Is one of the following predefined role types.

- "geography" for geographic objects, such as country or state.
- "geometry" for geometry objects, such as geometry point, geometry line, and geometry area.
- "coordinate" for coordinates, such as latitude and longitude.

```xml
<vocabulary> vrule </vocabulary>
```

Is an element that consists of a group of vocabulary elements that explicitly describe column names for the geographic role. These rules will be used to select the best geographic data for the role.

Elements in a rule are connected by the Boolean logic operation OR (only one needs to be satisfied). Each vocabulary element contains words enclosed with special characters. Words in the rule element are connected by the Boolean logic operation AND (all need to be satisfied).

A word may be prefixed and/or suffixed with the percent character (%), which is a place holder for any sequence of characters. If an element contains more than one word, each word has to be prefixed by the character plus (+) or minus (-). Plus indicates that the word must be found in the column name. Minus indicates that the word must not be found in the column name.
Once you have added a geographic role definition, you can run the `geo_srv_roles` procedure on the Reporting Server to see that the parameters were added correctly.

**Example:**  **Sample Geographic Role Definitions**

The following defines the State Abbreviation geographic role. The role ID is `USSTATE_ABBR`. The role name is `USSTATE` with a role format of `ABBR`. The titles that show in the Map dialog box are US state (Abbreviation). The format is A2, and the vocabulary rules specify that the characters state must be present, but the characters `iso`, `capital`, and `population` must not be present. The `geo_type` is `geography`, indicating that the returned data will be a geographic area.

```xml
<geo_role
  id="USSTATE_ABBR"
  value_size="2"
  type="alpha"
  role_name="USSTATE"
  role_name_title="US state"
  role_format="ABBR"
  role_format_title="Abbreviation"
  geo_type="geography">
  <vocabulary_rules>
    <vocabulary>+%state%-%iso%-%capital%-%population%</vocabulary>
  </vocabulary_rules>
</geo_role>
```

The following is a role definition for latitude values. The role ID is `LATITUDE`. The role name is also `LATITUDE`. Its format is numeric. The title that displays in the Map dialog box is Latitude. The `geo_type` is `coordinate`, indicating that the returned data will be points. The vocabulary rules specify that the characters `latitude` must be present.

```xml
<geo_role
  id="LATITUDE"
  type="numeric"
  role_name="LATITUDE"
  role_name_title="Latitude"
  geo_type="coordinate">
  <vocabulary_rules>
    <vocabulary>%latitude%</vocabulary>
  </vocabulary_rules>
</geo_role>
```
The following is the definition for the city role. The ID is CITY. The role name is also CITY. Its format is NAME. The title that displays in the Map dialog box is City (Name). The definition has a set of vocabulary elements. Only one of the elements in the list must be true. Therefore, the characters city, or town, or country plus capital, or state plus capital must be present.

```xml
<geo_role
  id="CITY"
  type="alpha"
  role_name="CITY"
  role_name_title="City"
  role_format="NAME"
  role_format_title="Name"
  geo_type="geography">
  <vocabulary_rules>
    <vocabulary>+%city%-%population%</vocabulary>
    <vocabulary>+%town%-%population%</vocabulary>
    <vocabulary>+%country%+%capital%-%population%</vocabulary>
    <vocabulary>+%state%+%capital%-%population%</vocabulary>
  </vocabulary_rules>
</geo_role>
```

**Reference:** Geographic Role URI Definitions

After adding a geographic role, you must add its URI to the <URIS> object in the geo_services.xml file. The syntax is.

```xml
<uri description="description">
  <returned_geometry>type</returned_geometry>
  <returned_georole>role</returned_georole>
  <url type="esri" authorization="auth" synonym="">
    "url_to_georole"
  </url>
  <parameters>
    <parm order="number" parm_name="pname" parm_georole="parmrole"/>
  </parameters>
</uri>
```

where:

- **"description"**
  Is a description for the geographic role to which the URI is pointing.

- **type**
  Is any supported geometry type, such as GEOMETRY AREA.

- **role**
  Is the name of the returned geographic role.

- **"auth"**
  Is the type of authentication needed to access this geographic role. Valid values are:

  - **silent.** Authentication credentials are configured in the Adapter for Esri.
none. No authentication is needed.

dnamed. Credentials must be explicitly provided by the user on a login screen.

don premise. Authentication is configured by the locally hosted ArcGIS server.

$url_to_georole$
Is the URL for the geographic role.

parm order="number"
Is the number of a parameter needed to retrieve the correct geographic role.

parm_name="pname"
Is the name of the parameter associated with parm order.

parm_georole="parmrole"
Is the name of the geographic role associated with parm order.

Once you have added the URI, you can run the geo_srv_map_uris procedure on the Reporting Server to see that the parameters were added correctly.

Note: You must add the base URL to the list of proxy URLs in the esri_arcgis_rest.xml file. For example:

<ESRI_URL URL="//services7.arcgis.com/L95Wwv9OjRQtjAs/ArcGIS" DESCRIPTION="Custom Data" />

Reference: Adding the WebFOCUS Retail Regions Geographic Role

These steps describe how to add the WebFOCUS Retail Regions geographic role to the geo_services.xml file.

1. Open the geo_services.xml file. The default location is:

   C:\ibi\WebFOCUSnn\srv\home\catalog\geo_services.xml

   where:

   nn
   Is your release of WebFOCUS. For example, 82 for release 8.2.

2. Add the role to the end of the GEO_ROLES object:

   <geo_role id="REGION" value_size="50" unified="false"
   role_name="WF_Region" role_name_title="WF_R
   role_format="NAME" role_format_title="NAME"
   geo_type="geography" type="alpha" >
   <vocabulary_rules>
   <vocabulary>+%region%</vocabulary>
   </vocabulary>
   </geo_role>
The ID is REGION. The role name is WF.Region. Its format is NAME. The title that displays in the Map dialog box is WF.Region. The definition has a vocabulary rule. The characters region must be present.

Run the geo_srv_roles procedure on the Reporting Server to see that the role was added correctly. The output is shown in the following image.

### List of grouped GEO.Roles

<table>
<thead>
<tr>
<th>ROLE_NAME_TITLE</th>
<th>ROLE_FORMAT_TITLE</th>
<th>GEO_ROLE</th>
<th>GEO_TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Full</td>
<td>ADDRESS_FULL</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Line</td>
<td>ADDRESS_LINE</td>
<td>geography</td>
</tr>
<tr>
<td>City</td>
<td>Name</td>
<td>CITY</td>
<td>geography</td>
</tr>
<tr>
<td>Continent</td>
<td>ISO-3166 code</td>
<td>CONTINENT_ISO2</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>CONTINENT</td>
<td>geography</td>
</tr>
<tr>
<td>Country</td>
<td>FIPS code</td>
<td>COUNTRY_FIPS</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>ISO-3166-2 code</td>
<td>COUNTRY_ISO2</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>ISO-3166-3 code</td>
<td>COUNTRY_ISO3</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>COUNTRY</td>
<td>geography</td>
</tr>
<tr>
<td>County</td>
<td>Name</td>
<td>COUNTY</td>
<td>geography</td>
</tr>
<tr>
<td>Geometry area</td>
<td></td>
<td>GEOMETRY_AREA</td>
<td>geometry</td>
</tr>
<tr>
<td>Geometry line</td>
<td></td>
<td>GEOMETRY_LINE</td>
<td>geometry</td>
</tr>
<tr>
<td>Geometry point</td>
<td></td>
<td>GEOMETRY_POINT</td>
<td>geometry</td>
</tr>
<tr>
<td>Latitude</td>
<td></td>
<td>LATITUDE</td>
<td>coordinate</td>
</tr>
<tr>
<td>Longitude</td>
<td></td>
<td>LONGITUDE</td>
<td>coordinate</td>
</tr>
<tr>
<td>Postal code</td>
<td></td>
<td>POSTAL_CODE</td>
<td>geography</td>
</tr>
<tr>
<td>Seattle Onprem Neighborhoods</td>
<td>Seattle Neighborhoods</td>
<td>SEATON_NBRHDS</td>
<td>geography</td>
</tr>
<tr>
<td>State</td>
<td>FIPS code</td>
<td>STATE_FIPS</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>ISO subdivision code</td>
<td>STATE_ISO_SUB</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>STATE</td>
<td>geography</td>
</tr>
<tr>
<td>US city</td>
<td>FIPS code</td>
<td>USCITY_FIPS</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>USCITY</td>
<td>geography</td>
</tr>
<tr>
<td>US county</td>
<td>FIPS code</td>
<td>USCOUNTY_FIPS</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>USCOUNTY</td>
<td>geography</td>
</tr>
<tr>
<td>US postal code</td>
<td>3 digits</td>
<td>ZIP3</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>5 digits</td>
<td>ZIP5</td>
<td>geography</td>
</tr>
<tr>
<td>US state</td>
<td>Abbreviation</td>
<td>USSTATE_ABBR</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>FIPS code</td>
<td>USSTATE_FIPS</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>USSTATE</td>
<td>geography</td>
</tr>
<tr>
<td>WF.Region</td>
<td>NAME</td>
<td>REGION</td>
<td>geography</td>
</tr>
</tbody>
</table>
3. Add the URI to the map server layer for this role at the end of the URIS object:

```
<uri description="WFRetail Regions">
  <returned_geometry>GEOMETRY_AREA</returned_geometry>
  <returned_georole>REGION</returned_georole>
  <parameters_georoles>
    <parm position="1" parm_georole="REGION" />
  </parameters_georoles>
  <urls>
    <url type="esri" authorization="none" synonym="" value="/services7.arcgis.com/L95Wwv9OjRQ0tjAs/ArcGIS/rest/services/wfretail_sub_regions/FeatureServer/0" provider="Esri">
      <keys key="default" />
      <parameters_names>
        <parm position="1" parm_name="SUB_REGION" />
      </parameters_names>
    </url>
  </urls>
</uri>
```

**Note:** You must add the base URL to the list of proxy URLs in the esri_arcgis_rest.xml file. For example:

```
<ESRI_URL URL="/services7.arcgis.com/L95Wwv9OjRQ0tjAs/ArcGIS" DESCRIPTION="Custom Data" />
```

Optionally, on the Reporting Server, run the geo_srv_map_uris procedure to see if the parameters were added correctly. The output is shown in the following image.
You will now be able to select this role from the Map As menu the next time you start WebFOCUS, as shown in the following image.

**Example:** Using the WebFOCUS Retail Regions Role in a Map Layer

This example configures a map layer using the WF_Regions role.
In the Data pane, right-click a field that contains subregion data, for example. On the shortcut menu, select Map As and then select the WF_Region role, as previously illustrated. The output is shown in the following image:

![Map Image]

**Customizing the List of Basemap Definitions**

You can add custom basemaps for use with maps.

**Adding a Custom Basemap**

The list of basemaps available to InfoAssist is built dynamically on the server using the list of `<basemap>` objects in the `geo_services.xml` file, which is located in the catalog directory under the server home directory:

```
c:\ibi\srvnn\home\catalog
```

where:

```
nn
```

Is the release of your WebFOCUS Reporting Server. For example, 82 for version 8.2.
The following are some sample standard basemap definitions from this file that exist prior to customization.

```xml
<BASEMAPS>
  ...
  <basemap custom="false" default="false" name="streets"
    title="World Street Map" icon="qb/streets_map_108x72.png" />
  <basemap custom="false" default="false" name="satellite"
    title="World Imagery" icon="qb/imagery_map_108x72.png" />
  <basemap custom="false" default="false" name="terrain"
    title="Terrain with Labels" icon="qb/terrain_map_108x72.png" />
  <basemap custom="false" default="true" name="gray"
    title="Light Gray Canvas Map" icon="qb/gray_map_108x72.png" />
  ...
</BASEMAPS>
```

The properties defined for the standard basemaps are `custom` (which is `false` for the standard basemaps), `default`, `name`, `title`, and `icon`.

To define a custom basemap, you must define these properties for your custom basemap, and add a URL that points to the map service that has the basemap image.

**Note:** Any basemap you add must be a tiled map layer.

You can also customize the list of basemaps by deleting basemap definitions from the `<basemaps>` object. To configure Esri on Premise, you should remove any basemap definition that references a URL that points to a location outside of your locally hosted Esri server.

The syntax for a basemap definition is

```xml
<basemap custom="boolean" default="boolean" name="mapname"
    title="maptitle" icon="url_to_icon" url="url_to_basemap" />
```

where:

- `custom="boolean"`  
  - Specifies whether the basemap is standard or custom. Valid values are true and false. To add a custom basemap, specify `custom="true"`.

- `default="boolean"`  
  - Specifies whether this basemap should be the default basemap if the user does not select a basemap. Valid values are true and false.

- `name="mapname"`  
  - Is a name for the basemap.

- `title="maptitle"`  
  - Is a title that will display in the Basemap drop-down list in the list of basemaps in InfoAssist.
Is the location of a thumbnail image for the basemap.

Is the URL to the map service that provides the basemap.

After you add the basemap definition, you can run the geo_srv_basemaps procedure to see if the parameters were added correctly.

**Example:** Adding a Custom Basemap

The following `<basemap>` object defines the soil survey basemap.

```xml
```

Add this definition to the list of basemap objects in the geo_services.xml file. Note that the entire URL string must be on one line in the file, even if it breaks in this document because of the page size.

 Optionally, on the Reporting Server, run the geo_srv_basemaps procedure. The output is shown in the following image.

<table>
<thead>
<tr>
<th>NAME</th>
<th>TITLE</th>
<th>DEFAULT</th>
<th>CUSTOM</th>
<th>URL</th>
<th>ICON</th>
</tr>
</thead>
<tbody>
<tr>
<td>Details</td>
<td>General Support</td>
<td>false</td>
<td>true</td>
<td><a href="http://services.arcgis.com/ArcGIS/services/General_Support_Map/MapServer">http://services.arcgis.com/ArcGIS/services/General_Support_Map/MapServer</a></td>
<td><a href="https://services.arcgis.com/ArcGIS/services/General_Support_Map/MapServer/thumbnail.png">https://services.arcgis.com/ArcGIS/services/General_Support_Map/MapServer/thumbnail.png</a></td>
</tr>
<tr>
<td>dark_gray</td>
<td>Dark Gray Condo Map</td>
<td>false</td>
<td>false</td>
<td><a href="https://server.arcgisonline.com/ArcGIS/rest/services/Backup/World_Lakes/MapServer">https://server.arcgisonline.com/ArcGIS/rest/services/Backup/World_Lakes/MapServer</a></td>
<td></td>
</tr>
<tr>
<td>gris</td>
<td>Light Gray City Map</td>
<td>true</td>
<td>false</td>
<td><a href="https://server.arcgisonline.com/ArcGIS/rest/services/Backup/World_Lakes/MapServer">https://server.arcgisonline.com/ArcGIS/rest/services/Backup/World_Lakes/MapServer</a></td>
<td></td>
</tr>
<tr>
<td>hybrid</td>
<td>World Imagery with Lakes</td>
<td>false</td>
<td>false</td>
<td><a href="https://server.arcgisonline.com/ArcGIS/rest/services/Backup/World_Lakes/MapServer">https://server.arcgisonline.com/ArcGIS/rest/services/Backup/World_Lakes/MapServer</a></td>
<td></td>
</tr>
<tr>
<td>national-geographic</td>
<td>National Geographic World Map</td>
<td>false</td>
<td>false</td>
<td><a href="https://server.arcgisonline.com/ArcGIS/rest/services/Backup/World_Lakes/MapServer">https://server.arcgisonline.com/ArcGIS/rest/services/Backup/World_Lakes/MapServer</a></td>
<td></td>
</tr>
<tr>
<td>omn</td>
<td>Open Hybrid Map</td>
<td>false</td>
<td>false</td>
<td><a href="https://server.arcgisonline.com/ArcGIS/rest/services/Backup/World_Lakes/MapServer">https://server.arcgisonline.com/ArcGIS/rest/services/Backup/World_Lakes/MapServer</a></td>
<td></td>
</tr>
<tr>
<td>satellite</td>
<td>World Imagery</td>
<td>false</td>
<td>false</td>
<td><a href="https://server.arcgisonline.com/ArcGIS/rest/services/Backup/World_Lakes/MapServer">https://server.arcgisonline.com/ArcGIS/rest/services/Backup/World_Lakes/MapServer</a></td>
<td></td>
</tr>
<tr>
<td>soil_survey</td>
<td>Soil_Survey_Basemap</td>
<td>false</td>
<td>true</td>
<td><a href="https://server.arcgisonline.com/ArcGIS/rest/services/Backup/World_Lakes/MapServer">https://server.arcgisonline.com/ArcGIS/rest/services/Backup/World_Lakes/MapServer</a></td>
<td></td>
</tr>
</tbody>
</table>
When you create a map, your custom basemap appears in the Basemap drop-down list in InfoAssist, as shown in the following image.
The following image shows the map output using the soil survey basemap.

Customizing the List of Geographic Roles

Customers with Enterprise Data often have map layers that represent their territories, events, or logistical information. These are published as Map Services to either a subscription based in the Esri Cloud (ArcGIS.com) or on an internal portal. This portal is available with ArcGIS Server 10.3 installations. More information can be found at http://server.arcgis.com/en/portal/.

InfoAssist comes with a configuration file (geo_services.xml) that contains elements that describe all of the geographic roles, geographic hierarchies, URLs to the map services, and base maps available to InfoAssist. This file is located in the catalog directory under the server home directory:

c:\ibi\srvnn\home\catalog

where nn is the release of your WebFOCUS Reporting Server. For example, 82 for version 8.2.

The geographic role selections that you can make in InfoAssist are built dynamically using this configuration file. Each role definition in the configuration file, when selected in InfoAssist, generates metadata and a request that is sent to Esri in order to download the appropriate map and place the markers or polygons on the map.
A geographic role can be part of a hierarchy. For example, the World geographic role is at the top of a hierarchy that contains continents, countries, states, and cities. These hierarchies are also described in the geo_services.xml file.

To add a custom geographic role, you must add the necessary parameters for the geography to this file.

You can also customize the geographic roles available by deleting geographic role definitions from the <GEO_ROLES> object. To configure Esri On Premise, you should remove any geographic role definition that references a URL that points to a location outside of your locally hosted Esri server.

Following standard XML syntax rules, each element is enclosed in element start and end tags (<elementname>, </elementname>), and attribute values are enclosed in double quotation marks (").

Reference:   Geographic Role Definitions

A geographic role is stored as a geo_role element in the geo_roles object of the geo_services.xml file. A geographic role must be defined with:

- An ID that will identify the role in the configuration file.
- A format and length for the data to be returned.
- A role name.
- A display title for the role name (to appear as a selection in Map dialog box in InfoAssist).
- An optional role format (if the role can have multiple formats, such as a name and an abbreviation).
- A display title for the format.
- A role type (geography for polygons, geometry for geometry points, geometry areas, or geometry lines, or coordinate for longitude or latitude).
- An optional vocabulary rule element containing vocabulary elements for associating the role with a field in the metadata.
The syntax is

```xml
<geo_role id="id" value_size="size" unified="false" role_name="rname"
role_name_title="rname_title" role_format="rformat"
role_format_title="rformat_title" geo_type="gtype"
type="datatype" >
  <vocabulary_rules>
    <vocabulary>vrule</vocabulary>
  </vocabulary_rules>
</geo_role>
```

where:

- **id="id"**
  
  Is an alphanumeric uppercase value, up to 50 characters, used to identify the geographic role.

- **type="datatype"**
  
  Is the data type for the ID. Can be one of the following.
  
  - "alpha" for alphanumeric data, formats An or In.
  - "integer" for integer numeric data, format In.
  - "numeric" for fractional numeric data, formats Pn.m, Dn.m, or Fn.m.
  - "text" for text data, format TXn.

- **value_size="size"**
  
  Is the optional number of characters in USAGE format length (any, if not set).

- **role_name="rname"**
  
  Is the name of the geographic role.

- **role_name_title="rname_title"**
  
  Is the title of the geographic role, to be displayed in the Map dialog box for selection.

- **role_format="rformat"**
  
  Is an optional format for the geographic role, useful when the role can be referenced using multiple formats, such as a name, an ISO code, and an abbreviation. Standard role titles include the following.

  - **NAME.** Specifies that the role defines the name of a geographic entity, such as Florida.
  - **ABBR.** Specifies that the role defines an abbreviation, such as FL.
ZIP3. Specifies that the role defines a 3-digit zip code.

ZIP5. Specifies that the role defines a 5-digit zip code.

FIPS. Specifies that the role defines a FIPS (Federal Information Processing Standard) code.

ISO2. Specifies that the role defines an ISO 3166-2 code published by the International Organization for Standardization (ISO).


LINE. Specifies that the role defines one line of a role, just as an address line.

FULL. Specifies that the role defines a full geographic role, such as a full address.

role_format_title="rformat_title"

Is an optional title for the format of the geographic role. It will be shown in parentheses along with the role title in the Map dialog box, for example, State (Abbreviation).

geo_type="gtype"

Is one of the following predefined role types.

- "geography" for geographic objects, such as country or state.
- "geometry" for geometry objects, such as geometry point, geometry line, and geometry area.
- "coordinate" for coordinates, such as latitude and longitude.

<vocabulary> vrule </vocabulary>

Is an element that consists of a group of vocabulary elements that explicitly describe column names for the geographic role. These rules will be used to select the best geographic data for the role.

Elements in a rule are connected by the Boolean logic operation OR (only one needs to be satisfied). Each vocabulary element contains words enclosed with special characters. Words in the rule element are connected by the Boolean logic operation AND (all need to be satisfied).

A word may be prefixed and/or suffixed with the percent character (%), which is a place holder for any sequence of characters. If an element contains more than one word, each word has to be prefixed by the character plus (+) or minus (-). Plus indicates that the word must be found in the column name. Minus indicates that the word must not be found in the column name.
Once you have added a geographic role definition, you can run the geo_srv_roles procedure on the Reporting Server to see that the parameters were added correctly.

**Example:**  Sample Geographic Role Definitions

The following defines the State Abbreviation geographic role. The role ID is USSTATE_ABBR. The role name is USSTATE with a role format of ABBR. The titles that show in the Map dialog box are US state (Abbreviation). The format is A2, and the vocabulary rules specify that the characters *state* must be present, but the characters *iso*, *capital*, and *population* must not be present. The geo type is geography, indicating that the returned data will be a geographic area.

```xml
<geo_role id="USSTATE_ABBR"
  value_size="2"
  type="alpha"
  role_name="USSTATE"
  role_name_title="US state"
  role_format="ABBR"
  role_format_title="Abbreviation"
  geo_type="geography">
  <vocabulary_rules>
    <vocabulary>+%state%-%iso%-%capital%-%population%</vocabulary>
  </vocabulary_rules>
</geo_role>
```

The following is a role definition for latitude values. The role ID is LATITUDE. The role name is also LATITUDE. Its format is numeric. The title that displays in the Map dialog box is Latitude. The geo type is coordinate, indicating that the returned data will be points. The vocabulary rules specify that the characters *latitude* must be present.

```xml
<geo_role id="LATITUDE"
  type="numeric"
  role_name="LATITUDE"
  role_name_title="Latitude"
  geo_type="coordinate">
  <vocabulary_rules>
    <vocabulary>%latitude%</vocabulary>
  </vocabulary_rules>
</geo_role>
```
The following is the definition for the city role. The ID is CITY. The role name is also CITY. Its format is NAME. The title that displays in the Map dialog box is City (Name). The definition has a set of vocabulary elements. Only one of the elements in the list must be true. Therefore, the characters city, or town, or country plus capital, or state plus capital must be present.

```xml
<geo_role
  id="CITY"
  type="alpha"
  role_name="CITY"
  role_name_title="City"
  role_format="NAME"
  role_format_title="Name"
  geo_type="geography">
  <vocabulary_rules>
    <vocabulary>+%city%-%population%</vocabulary>
    <vocabulary>+%town%-%population%</vocabulary>
    <vocabulary>+%country%+%capital%-%population%</vocabulary>
    <vocabulary>+%state%+%capital%-%population%</vocabulary>
  </vocabulary_rules>
</geo_role>
```

**Reference:** Geographic Role URI Definitions

After adding a geographic role, you must add its URI to the <URIS> object in the geo_services.xml file. The syntax is.

```xml
<uri description="description">
  <returned_geometry>type</returned_geometry>
  <returned_georole>role</returned_georole>
  <url type="esri" authorization="auth" synonym="">
    "url_to_georole"
  </url>
  <parameters>
    <parm order="number" parm_name="pname" parm_georole="parmrole"/>
  </parameters>
</uri>
```

where:

- "description" is a description for the geographic role to which the URI is pointing.

- type is any supported geometry type, such as GEOMETRY AREA.

- role is the name of the returned geographic role.

- "auth" is the type of authentication needed to access this geographic role. Valid values are:
  - silent. Authentication credentials are configured in the Adapter for Esri.
none. No authentication is needed.

named. Credentials must be explicitly provided by the user on a login screen.

on premise. Authentication is configured by the locally hosted ArcGIS server.

$url_to_georole$

Is the URL for the geographic role.

parm order="number"

Is the number of a parameter needed to retrieve the correct geographic role.

parm_name="pname"

Is the name of the parameter associated with parm order.

parm_georole="parmrole"

Is the name of the geographic role associated with parm order.

Once you have added the URI, you can run the geo_srv_map_uris procedure on the Reporting Server to see that the parameters were added correctly.

**Note:** You must add the base URL to the list of proxy URLs in the esri_arcgis_rest.xml file. For example:

<ESRI_URL URL="//services7.arcgis.com/L95Wv9OjRQ0tjAs/ArcGIS" DESCRIPTION="Custom Data" />

**Reference:** Adding the WebFOCUS Retail Regions Geographic Role

These steps describe how to add the WebFOCUS Retail Regions geographic role to the geo_services.xml file.

1. Open the geo_services.xml file. The default location is:

   C:\ibi\WebFOCUSnn\srv\home\catalog\geo_services.xml

   where nn is your release of WebFOCUS. For example, 82 for release 8.2

2. Add the role to the end of the GEO_ROLES object:

   `<geo_role id="REGION" value_size="50" unified="false"
      role_name="WF_Region" role_name_title="WF_Region"
      role_format="NAME" role_format_title="NAME"
      geo_type="geography" type="alpha">
      <vocabulary_rules>
         <vocabulary>+\%region%</vocabulary>
      </vocabulary_rules>
      </geo_role>`
The ID is REGION. The role name is WF_Region. Its format is NAME. The title that displays in the Map dialog box is WF_Region. The definition has a vocabulary rule. The characters region must be present.

Run the `geo_srv_roles` procedure on the Reporting Server to see that the role was added correctly. The output is shown in the following image.

### List of grouped GEO_ROLES

<table>
<thead>
<tr>
<th>ROLE_NAME_TITLE</th>
<th>ROLE_FORMAT_TITLE</th>
<th>GEO_ROLE</th>
<th>GEO_TYPE</th>
</tr>
</thead>
<tbody>
<tr>
<td>Address</td>
<td>Full</td>
<td>ADDRESS_FULL</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Line</td>
<td>ADDRESS_LINE</td>
<td>geography</td>
</tr>
<tr>
<td>City</td>
<td>Name</td>
<td>CITY</td>
<td>geography</td>
</tr>
<tr>
<td>Continent</td>
<td>ISO-3166 code</td>
<td>CONTINENT_ISO2</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>CONTINENT</td>
<td>geography</td>
</tr>
<tr>
<td>Country</td>
<td>FIPS code</td>
<td>COUNTRY_FIPS</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>ISO-3166-2 code</td>
<td>COUNTRY_ISO2</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>ISO-3166-3 code</td>
<td>COUNTRY_ISO3</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>COUNTRY</td>
<td>geography</td>
</tr>
<tr>
<td>County</td>
<td>Name</td>
<td>COUNTY</td>
<td>geography</td>
</tr>
<tr>
<td>Geometry area</td>
<td>.</td>
<td>GEOMETRY_AREA</td>
<td>geometry</td>
</tr>
<tr>
<td>Geometry line</td>
<td>.</td>
<td>GEOMETRY_LINE</td>
<td>geometry</td>
</tr>
<tr>
<td>Geometry point</td>
<td>.</td>
<td>GEOMETRY_POINT</td>
<td>geometry</td>
</tr>
<tr>
<td>Latitude</td>
<td>.</td>
<td>LATITUDE</td>
<td>coordinate</td>
</tr>
<tr>
<td>Longitude</td>
<td>.</td>
<td>LONGITUDE</td>
<td>coordinate</td>
</tr>
<tr>
<td>Postal code</td>
<td>.</td>
<td>POSTAL-CODE</td>
<td>geography</td>
</tr>
<tr>
<td>Seattle Onprem Neighborhoods</td>
<td>Seattle Neighborhoods</td>
<td>SEATON_NBRHDS</td>
<td>geography</td>
</tr>
<tr>
<td>State</td>
<td>FIPS code</td>
<td>STATE_FIPS</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>ISO subdivision code</td>
<td>STATE_ISO_SUB</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>STATE</td>
<td>geography</td>
</tr>
<tr>
<td>US city</td>
<td>FIPS code</td>
<td>USCITY_FIPS</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>USCITY</td>
<td>geography</td>
</tr>
<tr>
<td>US county</td>
<td>FIPS code</td>
<td>USCOUNTY_FIPS</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>USCOUNTY</td>
<td>geography</td>
</tr>
<tr>
<td>US postal code</td>
<td>3 digits</td>
<td>ZIP3</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>5 digits</td>
<td>ZIP5</td>
<td>geography</td>
</tr>
<tr>
<td>US state</td>
<td>Abbreviation</td>
<td>USSTATE_ABBR</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>FIPS code</td>
<td>USSTATE_FIPS</td>
<td>geography</td>
</tr>
<tr>
<td></td>
<td>Name</td>
<td>USSTATE</td>
<td>geography</td>
</tr>
<tr>
<td>WF_Region</td>
<td>NAME</td>
<td>REGION</td>
<td>geography</td>
</tr>
</tbody>
</table>
3. Add the URI to the map server layer for this role at the end of the URIS object:

```xml
<uri description="WFRetail Regions">
  <returned_geometry>GEOMETRY_AREA</returned_geometry>
  <returned_georole>REGION</returned_georole>
  <parameters_georoles>
    <parm position="1" parm_georole="REGION" />
  </parameters_georoles>
  <urls>
    <url type="esri" authorization="none" synonym="">
      value="/services7.arcgis.com/L95Wwv9OjRQ0tjAs/ArcGIS/rest/services/wfretail_sub_regions/FeatureServer/0"
      provider="Esri">
        <keys key="default" />
        <parameters_names>
          <parm position="1" parm_name="SUB_REGION" />
        </parameters_names>
      </url>
    </urls>
  </uri>
```

**Note:** You must add the base URL to the list of proxy URLs in the `esri_arcgis_rest.xml` file. For example:

```xml
<ESRI_URL URL="/services7.arcgis.com/L95Wwv9OjRQ0tjAs/ArcGIS" DESCRIPTION="Custom Data" />
```

Optionally, on the Reporting Server, run the `geo_srv_map_uris` procedure to see if the parameters were added correctly. The output is shown in the following image.
You will now be able to select this role from the Map As menu the next time you start WebFOCUS, as shown in the following image.

**Example:** Using the WebFOCUS Retail Regions Role in a Map Layer

This example configures a map layer using the WF_Region role.
In the Data pane, right-click a field that contains subregion data, for example. On the shortcut menu, select Map As and then select the WF_Region role, as previously illustrated. The output is shown in the following image:

![Map with subregion data](image)

**Customizing the List of Basemap Definitions**

You can add custom basemaps for use with maps.

**Adding a Custom Basemap**

The list of basemaps available to InfoAssist is built dynamically on the server using the list of `<basemap>` objects in the `geo_services.xml` file, which is located in the catalog directory under the server home directory:

```
c:\ibi\srvnn\home\catalog
```

where `nn` is the release of your WebFOCUS Reporting Server. For example, 82 for version 8.2.
Following are some sample standard basemap definitions from this file that exist prior to customization.

```xml
<BASEMAPS>
  ...
  <basemap custom="false" default="false" name="streets"
    title="World Street Map" icon="qb/streets_map_108x72.png" />
  <basemap custom="false" default="false" name="satellite"
    title="World Imagery" icon="qb/imagery_map_108x72.png" />
  <basemap custom="false" default="false" name="terrain"
    title="Terrain with Labels" icon="qb/terrain_map_108x72.png" />
  <basemap custom="false" default="true" name="gray"
    title="Light Gray Canvas Map" icon="qb/gray_map_108x72.png" />
  ...
</BASEMAPS>
```

The properties defined for the standard basemaps are **custom** (which is **false** for the standard basemaps), **default**, **name**, **title**, and **icon**.

To define a custom basemap, you must define these properties for your custom basemap, and add a URL that points to the map service that has the basemap image.

**Note:** Any basemap you add must be a tiled map layer.

You can also customize the list of basemaps by deleting basemap definitions from the `<basemaps>` object. To configure Esri on Premise, you should remove any basemap definition that references a URL that points to a location outside of your locally hosted Esri server.

The syntax for a basemap definition is

```xml
<basemap custom="boolean" default="boolean" name="mapname"
  title="maptitle" icon="url_to_icon" url="url_to_basemap" />
```

where:

**custom="boolean"**
- Specifies whether the basemap is standard or custom. Valid values are true and false. To add a custom basemap, specify custom="true".

**default="boolean"**
- Specifies whether this basemap should be the default basemap if the user does not select a basemap. Valid values are true and false.

**name="mapname"**
- Is a name for the basemap.

**title="maptitle"**
- Is a title that will display in the Basemap drop-down list in the list of basemaps in InfoAssist.
Is the location of a thumbnail image for the basemap.

**url**="url_to_basemap"

Is the URL to the map service that provides the basemap.

After you add the basemap definition, you can run the `geo_srv_basemaps` procedure to see if the parameters were added correctly.

**Example:** Adding a Custom Basemap

The following `<basemap>` object defines the soil survey basemap.

```xml
<basemap name="soil_survey" custom="true" default="false" title="Soil_Survey_Basemap"
icon="https://server.arcgisonline.com/arcgis/rest/services/Specialty/Soil_Survey_Map/MapServer/info/thumbnail"
url="https://server.arcgisonline.com/ArcGIS/rest/services/Specialty/Soil_Survey_Map/MapServer" />
```

Add this definition to the list of basemap objects in the `geo_services.xml` file. Note that the entire URL string must be on one line in the file, even if it breaks in this document because of the page size.

Optionally, on the Reporting Server, run the `geo_srv_basemaps` procedure. The output is shown in the following image.

<table>
<thead>
<tr>
<th>NAME</th>
<th>TITLE</th>
<th>DEFAULT</th>
<th>CUSTOM</th>
<th>URL</th>
<th>ICON</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dark Gray</td>
<td>Dark Gray</td>
<td>false</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Gray</td>
<td>Light Gray</td>
<td>true</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Hybrid</td>
<td>World Imagery with Labels</td>
<td>false</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>National Geographic</td>
<td>National Geographic World Map</td>
<td>false</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open Street</td>
<td>Open Street Map</td>
<td>false</td>
<td>false</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Satellite</td>
<td>World Imagery</td>
<td>false</td>
<td>false</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
When you create a map, your custom basemap appears in the Basemap drop-down list in InfoAssist, as shown in the following image.
Building InfoMini Applications

InfoMini applications are built from an InfoAssist report and contain a subset of InfoAssist functionality available at run time.

You can build an InfoMini application and provide the run-time user with the option to interact with and edit the report.

Understanding InfoMini Applications

When you create a report in InfoAssist, you have the option to activate InfoMini. You can run a report with InfoMini activated, which creates an InfoMini application. An InfoMini application contains a subset of the functionality available in the full version of the report or chart. You can limit or expand the functionality that is available to the user at run time when you build the report in InfoAssist.

An InfoMini application opens in its own browser window when it is run from within InfoAssist to test. An InfoMini application does not open in its own browser window in the portal or in any other application that you build yourself.

An InfoMini application has many of the components an InfoAssist report has, with the following exceptions:

- The main menu is not accessible.
The New, Open, and View code buttons on the Quick Access Toolbar are not available.

Certain tabs and groups are unavailable or limited.

The status bar is not accessible.

The navigation taskbar is not accessible.

InfoMini does not support referencing existing procedures.

For more information on the available components and their functionality, see *InfoAssist Application Window* on page 77.

**Using the InfoMini Button**

The InfoMini button can be found on the Format tab, in the Destination group. You can click the *InfoMini* button to activate the InfoMini option. With the InfoMini button active, you can run a report to open the InfoMini application.

To deactivate the InfoMini option, click the *InfoMini* button again. There must be at least one option selected from the InfoMini button menu for InfoMini to be activated.

You can set the options available to the user at run time from the menu on the InfoMini button. If you select an option from the menu when the InfoMini button is inactive, the InfoMini option is activated. The options are:

- Format Tab
- Slicers Tab
- Run Immediately
- Run Deferred

When you select an option from the menu, a check mark appears next to the option. The check mark indicates the option is available for the user at run time within the InfoMini application. If you select a checked option to clear it, the check mark disappears, and the option is no longer available through the InfoMini application. If you clear all of the options from the menu, InfoMini is deactivated. All options are selected by default.

The Run Immediately option enables reports to run immediately when InfoMini first launches. You might want to clear this option so that the user can choose a format and pick slicers before running a report.
Understanding the InfoMini Layout

The Resources panel is not available in InfoMini. If no options are selected from the InfoMini button when the application runs, an error message displays, indicating that you must select at least one tab.

From the Format tab, you can access the Output Types group, with the following exceptions:

- The Destination and Features groups, which are on the Format tab in InfoAssist, are not available in an InfoMini application.
- The Other button, which is on the Format tab, in the Chart Types group in InfoAssist, is not available in an InfoMini application.
- The InfoMini button, which is on the Format tab, in the Destination group in InfoAssist, is not available in an InfoMini application.

The Output Types group contains commands to create output in any of the supported formats. For reports and charts, you also have access to the Auto Linking group. This group contains options for enabling the functions of Auto Linking, a feature that allows you to create a suite of referenceable reports and charts in your enterprise.

For more information on the functionality of the available groups on the Format tab, see Format Tab on page 86.

From the Slicers tab, you can access the Options, Record Limit, and Slicer Group groups, with the following exceptions:

- The New Group option, which is on the Slicers tab, in the Options group in InfoAssist, is not available in an InfoMini application.
- The Update Preview option, which is on Slicers tab, in the Options group in InfoAssist, is not available in an InfoMini application.
- The Preview list, which is on the Slicers tab, in the Record Limit group in InfoAssist, is not available in an InfoMini application.

For more information on the functionality of the available groups on the Slicers tab, see Working With Slicers on page 862.
Creating an InfoMini Application

To create an InfoMini application in InfoAssist, build a report as you normally would, then activate InfoMini and add the functionality you want the user to have available to them at run time. For more information on what functionality is available to InfoMini applications, see Understanding InfoMini Applications on page 593.

Procedure: How to Activate InfoMini

1. With a report or chart open, click the Format tab.
2. In the Destination group, click InfoMini.

   Note: At least one option from the InfoMini menu must be selected in order to activate InfoMini. By default, the Format tab and Slicers tab are selected on the menu when you activate InfoMini in a new report. For more information on enabling InfoMini options, see How to Enable and Disable InfoMini Application Options on page 596.

   The InfoMini button is highlighted and the InfoMini mode is activated. For more information about running an InfoMini application, see How to Test an InfoMini Application on page 596.

Procedure: How to Enable and Disable InfoMini Application Options

You can choose which options will be available at run time in an InfoMini application. By default, the Format tab and Slicers tab are selected on the menu when you activate InfoMini in a new report. For more information about the functionality of each option, see Understanding InfoMini Applications on page 593.

1. With a report or chart open, click the Format tab.
2. Click the arrow next to the InfoMini button. A menu of available tabs and options displays.

   InfoMini does not have to be active for you to access the menu. When you select an option from the menu, InfoMini is activated.
3. From the menu, select any options you want to display in your InfoMini application.

Procedure: How to Test an InfoMini Application

1. With an InfoAssist report open, activate InfoMini as described in How to Activate InfoMini on page 596.
2. Enable the options that you want, as described in How to Enable and Disable InfoMini Application Options on page 596.
3. Run the report.
An InfoMini application opens in a new window.

**Procedure: How to Interact With an InfoMini Application**

With an InfoMini application open, you can edit the application using the functionality that was enabled in InfoAssist. You have access to certain options, depending on which options were enabled.

You have the ability to alter the InfoMini application at run time. Changes to the application are not reflected on the canvas dynamically and you must run the report to see the updates.

1. Run a report with InfoMini activated, as described in *How to Test an InfoMini Application* on page 596.

   An InfoMini application opens in a new window.

2. By default, the ribbon is hidden in an InfoMini application. To display the ribbon, do one of the following:
   - Click one of the tabs (Format or Slicers).
   - Click the down arrow next to the Help icon.

   The available options on these tabs provide the same functionality as they do in InfoAssist. You can use this embedded functionality to change the report at run time.

3. After making your changes, click Run to see an updated version of the report.

**Viewing Data Behind Visuals**

You can use InfoAssist to analyze your data by creating or building interactive visualizations. As you develop these visualizations, you can create different views of the data, and find patterns or trends.

As you gain insight and spot patterns, you may want to share only the underlying data that comprises a specific visual with others in your enterprise. You can do this using the data options, as shown in the following image.

![Data Options](image)

The Show data option provides options for you to view and share this data. The Export data option enables you to export the data specific to your visualization in a summary or detailed format. You can also review related data by using the Show Data with Related Columns option.
The Show Data with Related Columns functionality allows you to review more specific underlying data based on the fields that you have selected. Specifically, it displays data related to other fields that are part of the dimension hierarchy that you select. For example, if you selected the Product,Category dimension field, the related column data would include data from the Product,Subcategory and Model dimension fields, because these data fields are part of that dimension hierarchy.

Similar to the Show data option, the Show Data with Related Columns option provides more detailed data based on the data fields that you select. You can sort and review the data columns, which display in a separate browser window. Depending on the size and breadth of your dimension hierarchy, a multiple page report may be produced.

**Note:** You can export data in .xls or .csv format.

When you select the option to show data or show data with related columns, a report is generated in a separate browser window. This report is an active report, which you can review, sort, and modify using the drop-down menus that are available.

When you point to the Export Data option, you can:

- Export data in summary format, which includes totals for categories based on the data fields that you selected for your visual.
- Export more granular data based on the data values that you selected in your visual.

**Note:**

- When exporting data using the Summary or Data Detail options, you can save the resulting data file, which is in Microsoft® Excel® format, to your local machine for further analysis and sharing.
- The maximum number of records that can be exported is 100,000.

**Procedure:** **How to Show the Data Behind Your Visual**

1. Create a visual, such as a chart, map, or grid.
2. In the upper-right corner of the visual cell, click the down arrow.
3. In the menu that appears, click *Show Data*.

   A new browser window opens. This window displays the data for your visual as a WebFOCUS active report. You can use this active report to create and share lightweight, browser-based data discovery analytics that are portable, and only require access to a browser.
Procedure: How to Show Data With Related Columns

1. Create a visual, such as a chart, map, or grid.
2. In the upper-right corner of the visual cell, click the down arrow.
3. In the menu that appears, click Show Data with Related Columns.

A new browser window opens. This window displays the data for your visual as a WebFOCUS active report. You can use this active report to sort and work with the underlying hierarchical data in your visual.

Procedure: How to Export the Data Behind Your Visual

1. Create a visual, such as a chart, map, or grid.
2. In the upper-right corner of the visual cell, click the down arrow.
3. In the menu that appears, point to Export Data, and then click one of the following:

- **Summary.** A prompt appears, asking you to open or save a Microsoft Excel file. This file is a summary of your data from a high level for a general analysis, as shown in the following image.


<table>
<thead>
<tr>
<th>A</th>
<th>B</th>
<th>C</th>
<th>D</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Product Category</td>
<td>Product Name</td>
<td>Revenue</td>
</tr>
<tr>
<td>2</td>
<td>Accessories</td>
<td>Cycle Energy Quick with Refresh Charger</td>
<td>$9,341,397.65</td>
</tr>
<tr>
<td>3</td>
<td>Denon AH-D5000 Over-Ear Headphones</td>
<td>$9,272,133.77</td>
<td>$2,477,303.77</td>
</tr>
<tr>
<td>5</td>
<td>Grado RS1i Reference Series Headphones</td>
<td>$9,452,243.25</td>
<td>$2,208,713.25</td>
</tr>
<tr>
<td>6</td>
<td>Universal Remote</td>
<td>$14,419,020.31</td>
<td>$4,401,161.31</td>
</tr>
<tr>
<td>7</td>
<td>Control</td>
<td>$9,301,960.89</td>
<td>$1,518,520.89</td>
</tr>
<tr>
<td>8</td>
<td>Anywhere Kit with Tabletop Sensor</td>
<td>$11,401,805.70</td>
<td>$2,616,237.70</td>
</tr>
<tr>
<td>9</td>
<td>Anywhere Kit for Home Theater</td>
<td>$14,276,128.75</td>
<td>$4,825,372.75</td>
</tr>
<tr>
<td>10</td>
<td>Headphones</td>
<td>$8,028,218.25</td>
<td>$4,049,178.25</td>
</tr>
<tr>
<td>11</td>
<td>Samsung OEM 2.0 Amp Travel Charger</td>
<td>$2,514,022.50</td>
<td>$1,303,511.50</td>
</tr>
</tbody>
</table>

- **Data Detail.** Generates a detailed report that provides specific data regarding your data analysis.

Creating Multi-Y Axis Comparative Visuals

When creating a chart with more than one measure (numeric) field, you can split the Y axis to create multiple charts, based on each unique measure field.

**Note:** Measure fields are selected from the Data pane and display under the Vertical Axis (Y) in the Query pane.
This functionality is useful when analyzing trends for multiple measure fields, as you can view data for each measure field separately within the same chart, as shown in the following image.

This functionality is available for Bar, Bar Stacked, Line, Area, and Area Stacked charts.

**Procedure: How to Create a Multi-Y Axis Comparative Visual**

1. Launch InfoAssist in visualization mode.
3. Select one of the following visual types: Bar, Bar Stacked, Line, Area, or Area Stacked.  
   **Note:** Bar Stacked is the default visual type.
4. Add multiple measure fields to the visual. For example, Gross Profit and Revenue.
5. Add at least one dimension field to the visual. For example, Product Category.
6. In the Query pane, right-click Vertical Axis.
7. Click Multi-Y split.

   The chart changes to display individual charts for each measure field.

   **Note:** You can revert your chart to an integrated display by right-clicking Vertical Axis and then clicking Multi-Y split.
Creating HOLD Files

A HOLD file is the output of a report request stored in a file that you can use as input to another WebFOCUS procedure.

You can then create new report requests that extract data from the HOLD file, resulting in multi-step report.

HOLD files can be created to use in a report, chart, document, or visualization.

Valuable Applications of HOLD Files

A HOLD file is valuable when you want to do the following:

- Extract fields from a large data source for faster and more efficient retrieval in subsequent requests.
- Store virtual field values or summary values calculated in one request for further processing in another request.

Storing HOLD Files

HOLD files can be created for immediate use and saved temporarily or they can be stored for future and repeated use.

Output Formats for Reports

You can save a HOLD file for a report in the following formats:

- Binary (*.ftm)
- FOCUS (*.foc). For more information, see FOCUS Format Index Fields on page 605.
- Comma Delimited with Titles (*.csv)
- Plain Text (*.ftm)
- Tab Delimited (*.tab)
- Tab Delimited with Titles (*.tab)
- Database Table (*.sql)

Note: The Database Table output is only available when working against an SQL database.

- SQL Script (*.sql)
- Hyperstage (*.bht)
Creating HOLD Files

This section contains examples of how you would use a HOLD file.

**Note:** Across fields are not allowed in HOLD files.

- Using the Change Title option in the Query pane, you can change the title of a field prior to creating a HOLD file. A blank space in the title will be replaced by an underscore. This functionality enables you to control the names used for the fields included in the HOLD file, and makes it easier to find the fields when creating report.

- When creating a HOLD file, the Temporary dialog box displays only those reporting server applications to which you have access.

- When a report contains a HOLD procedure, dots or periods (.) in the AS name of the Define field are automatically converted to an underscore (_).

- You can use Auto Linking when working with HOLD files. For more information, see *Using the Auto Linking Feature to Link Content* on page 841.

**Procedure:** How to Create a Tabular Report From a HOLD File

To create a tabular report from a HOLD file, begin by creating a report.

1. In the Open dialog box, select the wf_retail_lite Master File.
2. Add the following measure fields to the report:
   - Cost of Goods
   - Discount
   - Gross Profit
3. Add the following dimension fields to the report:

- Product Category
- Product,SubCategory
- Sale,Year


   The Temporary dialog box opens.

5. In the Temporary dialog box, name the HOLD file, keep the default file type, Binary (*.ftm), and click Save.

6. At the bottom of the canvas, click Create Report.

   The custom database structure displays in the Resources panel. The canvas is returned to a default blank state, enabling the development of a new report using the HOLD file.

7. From the HOLD file, drag Quantity,Sold to the canvas.

8. On the canvas, select the Quantity,Sold column heading.

9. On the Field tab, in the Display group, click Aggregation and then click First Value.

   **Note:** The heading changes to FST Quantity Sold.

10. Select the FST Quantity Sold heading.

11. On the Field tab, in the Display group, click Hide Field to hide Quantity,Sold, as it will be used in a subsequent calculation.

12. On the Data tab, in the Calculation group, click Summary (Compute).

13. In the Summary Field (COMPUTE) dialog box, do the following:

   - In the Format field, type D8.2%.
   - Double-click the Quantity,Sold field to add it to the formula box.
   - Add / 100 after the Quantity Sold field to calculate the percentage.

14. Click OK to close the dialog box.

15. Drag Product,Category to the By Query field container.

16. In the Query pane, select the Product,Category field.

17. On the Field tab, in the Break group, select Subtotal to create Subtotals on Product,Category.
18. Drag Product, Subcategory to the By Query field container.

19. Drag Sale, Year to Across.


The final report displays.

**Procedure:** How to Rearrange HOLD File Components

The following procedure describes how to rearrange file components in a HOLD file.

**Note:** This procedure creates a binary HOLD file and a subquery to illustrate how to rearrange HOLD files. It also shows the result of this rearrangement.

1. Create a new document, using the wf_retail_lite Master File for the data source.

2. On the Insert tab, in the Reports group, click Report. Populate the report with the following fields from the Data pane:
   - Gross Profit
   - Quantity, Sold
   - Revenue
   - Product, Category
   - Product, Subcategory

3. On the Home tab, in the Format group, click File to create a HOLD file.
   In the Temporary dialog box, enter a name for the file. For example, File1_binary.

4. Click Save.

5. Create a report using the HOLD file, specifying Product, Category, Product, Subcategory, and Quantity, Sold.

6. Next, using the following steps, add a subquery SQL script for use as a filter on the first report.
   a. On the Data tab, in the Data Source group, click Switch.
      Select the original master file (wf_retail_lite.mas).
   b. Locate and double-click the Product, Category dimension field.
      This creates a second report, which you can drag and resize as needed on the Document canvas.
   c. Create a filter on Product, Category, where the product category is equal to Televisions.
7. With the new component selected, click the Home tab and in the Format group, click File.
   In the File name field, enter File2_subquery and select the SQL Script (*.sql) format from
   the file types menu.

8. Click Save.

9. Rearrange the order of the HOLD files so that the File2_subquery is positioned above the
   File1_binary HOLD file using the following steps:
   a. Right-click Files in the Query pane and click Arrange Files, as shown in the following
      image.

      ![Arrange Files dialog box]

      The Arrange Files dialog box opens.

   b. Using the Arrange Files dialog box that displays, select File2_subquery and click Move
      Up to move the file above File1_binary.

   c. Click OK.

10. Edit the first report and create a filter using the subquery.

11. Click OK to exit the Create a filtering condition dialog box.

   Your report is refreshed to reflect the filtering you have applied.

**FOCUS Format Index Fields**

FOCUS is the only format that supports an index field. The maximum number of fields to index
is four. If the file format is FOCUS, then Index appears on the Query pane.

**Creating a Subquery Filter Using a HOLD File**

You can create a subquery using a HOLD file. A subquery is a nested query that is added to
the Where clause of an SQL statement. A subquery is valuable because it is highly reusable.
Procedure: How to Create a Subquery Filter Using a HOLD File

This procedure describes how to create a subquery filter using a HOLD file created in the previous procedure.

1. Build a report.
2. On the Data tab, in the Filter group, click Filter.
   The Filter dialog box opens.
3. In the Filter dialog box, from the Type drop-down menu, select Subquery as the filter type for the left-most part of the expression.
4. From the Subquery drop-down menu, select In list as the comparison operator.
5. From the list of subqueries, select the subquery that was created (in this example, File1) for the right-most part of the expression.
6. Click OK.
   The report is filtered by the subquery that you created.

Note: To view the SQL statements generated by the request, go to the Quick Access Toolbar, open the Run drop-down menu, and select SQL Trace.

Creating Shortcuts and URLs

The use of shortcuts and URLs can simplify workflow and provide additional context to your analytics. The following sections explain how to use shortcuts and URLs and describe how to create these content items in your repository.

Creating Shortcuts

You can create shortcuts to repository files and Master files. Once a shortcut to a Master file is created, you can use it to build visualizations and reports. Once a shortcut to a repository file is created, you can copy, delete, edit, and run this item. You can also publish and share your shortcuts to make them available for other users and groups.

Procedure: How to Create a Shortcut to a Repository File

1. Select the domain or folder where you want your new shortcut to reside.
2. On the actions bar, click Shortcut.
   The New Shortcut dialog box opens.
3. Click Browse.
   The Select dialog box opens.
4. Using the Breadcrumb Trail, navigate to the resource of your choice, such as folder, report, chart, or visualization, and then click Select.

The Title field populates with the name of the original item, and the word Shortcut. For example, if you create a shortcut to the item Chart1, the shortcut title will be Chart1 - Shortcut.

5. Optionally, you can edit the Title and populate the Summary field.

6. Click OK.

The new shortcut appears in the selected location.

**Procedure: How to Create a Shortcut To a Master File**

1. Select the domain or folder where you want your new shortcut to reside.

2. On the actions bar, click Shortcut.

The New Shortcut dialog box opens.

3. Click the Master File radio button, as shown in the following image.

4. Click Browse.

The Select dialog box opens.

5. Navigate to the Master file you to which you want to create a shortcut, and then click Select.

The Title field populates with the name of the original item.
6. Optionally, edit the Title and populate the Summary field.
7. Click OK.

The new shortcut appears in the selected directory.

Creating URLs
You can create URLs to webpages and store them within the repository. These URLs can further enhance analytics, by providing an additional interactive context to your data. You can run a URL from the Home page, use it in a portal, or add it to a personal page. If your URL is optimized for use in an iFrame, you can embed it within a container on a page. You can also publish and share a URL to make it available to other users and groups.

Procedure: How to Create a URL
1. Select the domain or folder where you want your new URL to reside.

2. On the actions bar, click URL.

   The New URL dialog box opens.

3. Type a Title for the URL, type the address of the URL, and then click OK.

   The URL now appears in your selected location.

Procedure: How to Embed an iFrame-Optimized URL in a Portal or Page
1. Copy an iFrame-optimized URL from the web, as shown in the following image.
2. Select the domain or folder where you want your new URL to reside.

3. On the actions bar, click **URL**.
   
The New URL dialog box opens.

4. Populate the Title field, and paste the copied URL in the URL field.

5. Remove any iFrame-related syntax that surrounds your URL. An example of these are shown in the following images.

6. Click **OK** to close the New URL dialog box.
   
   Your URL item is complete and ready to be displayed in a portal or page.

7. Using WebFOCUS Designer or the Portal Designer, add your new URL to a portal or page.
Creating Blogs

You can create blogs and include them in your collaborative portals. A blog is an interactive content item that operates as commonly seen blogs on the internet, and allows users to post and view comments. Blogs abide by the same security rules that apply to other items in the repository. You can publish, unpublish, hide, and move blogs between domains or folders. You can also share blogs with other users and groups.

Procedure:  How to Create a Blog

1. Select the domain or folder where you want your new blog to reside.

2. On the actions bar, click Blog .

   The New Blog dialog box opens.

3. Type the requested information in the dialog box, as follows.

   □ Title. Identifies the blog in the content area.

   □ Summary. Provides an optional explanation of the blog. It is displayed in the tool tip, when you hover over the blog.

4. Click OK.

   The new blog item appears in the selected location.
5. Right-click your new blog, and then click **Edit**.
   The Comments window opens.

6. Click the *Add comment* link to add a new comment.

7. Once you are done adding and editing comments, click **Post**, and close the Comments window.

8. You can optionally interact with comments using the following commands:

   - Click the *Refresh* icon to refresh comments.

   - Click the *Search* button, and type a key word or words in the search field, to search through comments. You can specify the search criteria by clicking the drop-down arrow and selecting search criteria, such as user name, content, or meta tags. Click the *Search* button again to close the search field.

   - Click the *Remove All* button to remove all comments from all users. Remove All is only available to users with the Manage Comments privilege.

You can now publish, share, and add your blog to a portal page or portal.

**Working With Portal Pages**

Portal pages are a vital part of the Business User Edition portal architecture. Depending on the type of a page, the Business User Edition portal allows different levels of versatility in the way you organize, share, and interact with it.

There are three types of pages in a portal. These include:

- **Base Portal Page.** Created in the Page Designer and added to the Business User Edition portal by a manager or developer. If a base portal page is created with the Lock Page property off, users can customize it at run time. If the user removes customizations, all changes made by the user are removed, and the base portal page reverts to its default state.

- **Personal Portal Page.** Added to the Business User Edition portal at run time by the user. Personal portal pages are stored in the repository but they are not visible in the Resources tree. Personal portal pages are only visible to the user that has created them.

- **Domain Portal Page.** Created with the Page Designer directly in a domain or folder. A domain page can be copied or added to a portal, in which case it becomes a base portal page. If a page is removed from a portal, it becomes a stand-alone domain portal page and can be edited, moved, unpublished, or hidden.
Note: To avoid unwanted behaviors, you should not edit base portal pages in the Page Designer, or move or hide base portal pages in the repository, while users are running these pages in the Business User Edition portal. If you need to edit a base portal page, remove it from the Business User Edition portal, and unpublish it before you begin editing.

Page Designer Overview

The Page Designer allows you to create domain portal pages inside domains and folders of your choice. This section explains how to use the Page Designer to create a domain portal page. It also describes the different components of the Page Designer interface.

Procedure: How to Use the Page Designer to Create a Domain Portal Page

1. On the Home page, in the Resources tree, select a domain or folder where you want to create the page, and then click Portal Page.

   The Page Designer opens, and the Add Page dialog box opens inside the Page Designer.

2. Select a page template and, optionally, edit the Title and Name fields.

3. Click Create.

   The page displays in the Page Designer.

4. Optionally add content to the page.

   If left blank, panels behave like Easy Selector containers at run time. To learn more about the Easy Selector, see Using the Easy Selector on page 873.

5. Optionally, unlock the page to allow run time edits. Clear the Lock Page check box in the Properties panel.

   Note: The Lock Page option is enabled, by default.

6. Save and close the Page Designer.

   A new domain portal page is created and now appears inside the selected domain or folder. It is ready to be added to the portal.

   For more information, see Working With the Business User Edition Portal on page 633.
Page Designer Interface

The following image shows the Page Designer, and the Add Page dialog box.

The Page Designer contains the following components, located from the top of the interface to the bottom:

- Page Templates
- Application menu
- Quick Access Toolbar
- Ribbon
- Canvas
- Properties panel
- Breadcrumb trail

The components are described in the following topics.

Page Templates

Page templates provide a quick way of creating page layouts. When you create a new domain page, the Add Page dialog box opens and displays layout presets that you can choose before adding any content.

Note: Page templates are only available for domain pages.
The Add Page window is shown in the following image.

![Add Page window with page templates]

The Add Page window contains the following options:

- **Page Templates.** Contains custom and default page templates. Each template is accompanied by a thumbnail, which allows you to preview the layout. The default templates are:
  - 1 Column
  - 2 Column
  - 3 Column
  - 4 Column
  - Fluid Canvas
  - Responsive 2-2
  - Responsive 3-2-2
  - Responsive 3-3
  - Responsive 3-3-3
  - Responsive 4-2
  - Responsive 4-2-2
Responsive 4-4-2

Single Area

New Page Information. Provides access to the following options:

- Title. Identifies the title of the portal page. The default title matches the name of the selected page template.

- Name. Identifies the name of the portal page. The default name matches the name of the selected page template.

- Location. Changes the location of the portal page in the repository. To change the location, click Change Location and navigate to a different domain or folder.

Copy Existing Page. Creates a copy of an existing page in the repository.

Application Menu

The Application button, represented by the BIP icon, opens the Application menu of options. From this menu, you can create a new portal page, open an existing portal page, save the page, or exit the Page Designer.

From the Application menu you can perform the following actions:


- Open Page. Open an existing portal page in the Page Designer.

- Save. Saves the current page.

- Save As. Saves the current page as under a different name or location.

- Exit. Closes the Page Designer.

Quick Access Toolbar

You can use the Quick Access Toolbar to save your changes to the current portal page.

Ribbon

In the Page Designer, you can use the ribbon to access commands to edit your portal pages and add content. You can also hide the ribbon to maximize space, or launch the online Help content.
The Page Designer ribbon contains the following three tabs:

- **Layout.** Specifies the theme and layout settings.
- **Insert.** Inserts content into the page.
- **Style.** Applies styles to common properties, such as background, border, and font.

### Layout Tab

The following image shows the Layout tab, which contains the Preview and Page groups. You can use the options in these groups to modify the theme of your portal page, or to change the layout of your canvas.

![Layout Tab Image]

#### Preview Group

The Preview group contains a single Theme option that launches a menu from which you can customize the theme of your portal page. This includes the following:

- **Portal Theme Files Browser.** Configures CSS files, by applying a predefined theme. You can also create a custom theme. The default theme is Neutral.
- **CSS Editor.** Edits specific components of the existing CSS theme.

#### Page Group

The Page group contains a single Layout option that launches a menu from which you can customize the layout of your canvas or portal page. For example, you can choose between a column-based layout or to a fluid layout. In a column-based layout, dragging a panel results in a drop indicator, showing where the panel goes. In a fluid layout, the content automatically fills the page area in equal proportions. You can manually rearrange and nest these elements on the page. The display area changes its size depending on your browser dimensions.

The Layout menu includes the following options:

- **Single Area.** Creates a free-flowing area, where there is no grid.
Fluid Canvas. Arranges content evenly, and redistributes space as more items are added.

One Column. Stretches content to fill the entire page area.

Two Columns. Divides the page evenly into two columns.

Three Columns. Divides the page evenly into three columns.

Four Columns. Divides the page evenly into four columns.

When you choose any option other than Single Area, any items that you add to the page automatically snap to place in the layout.

Insert Tab

You can use the Insert tab to add containers or content to your portal page. The Insert tab is shown in the following image.

The Insert tab contains the following two groups:

containers. Adds a panel, accordion, tabbed, responsive, or easy selector container to the page.

Content. Inserts content, for example visualizations, reports, charts, documents, dashboards, pages, and URLs. You can also add images and text.

Style Tab

You can use the Style tab to configure styling of objects, options for the background and borders, as well as fonts and colors of the text. This tab functions in the same way as does the Style tab in the Portal Designer.
The following image shows the Style tab.

![Style tab image](image)

**State**

From the State group, you can choose which of the available states you are styling for an object. The state options include the following:

- **Normal.** This is the default state of an object in which an event, such as a hover, is not occurring, or if styling for that event is not defined.

- **Active.** This is the state in which the object is currently in use. An example is the background color of the current page tab.

- **Hover.** This is the state in which the mouse cursor is resting on the object.

**Background**

You can use an image, a color, or a combination of options to style the background of an object.

**Image**

The Image button is a split button. When you click Image, the Open dialog box appears, and you can select an image from your repository. When you click the menu, the Background Image Options open. Here, you can change or remove the image.

Click **Change Image** to launch the Open dialog box. From this dialog box, select an existing image in the Repository to use as the background, and click **Open**.

**Repeat**

You can use the Select Background Repeat menu to choose whether or not to repeat the background. The options in this menu include the following:

- **None.** Displays the background image only once.

- **Everywhere.** Repeats the background image horizontally and vertically. This is the default value.
Horizontally. Repeats the background image horizontally.

Vertically. Repeats the background image vertically.

**Position**

You can select a background position using a visual menu if you do not choose to repeat the image on the page. For example, you can position the background image at the bottom of the window, on the right. This feature is similar to Menu Bar positioning.

The default background position is upper left.

**Background Color**

The Background Color icon launches the color selection dialog box, where you can set a page background color. The same icon is used in the Border and Font groups to set the border and font colors, respectively.

**Reset Background**

The Reset Background icon resets the background styling to the theme settings, for the currently selected state. The same icon is used in the Border and Font groups, to reset those groups.

**Border**

In addition to color and reset, the Border group contains style and width options.

**Style**

When you click the Style menu, the Select Border Style menu opens. From this menu, you can choose from nine border styles. This includes None, solid border, dotted border, dashed border, groove border, and more. As you hover over each option, the canvas refreshes with a preview to show the border style.

**Width**

You can use the Width controls to set the border thickness in pixels (px). If the style is set to none, which is the default for most objects, the Width control has no effect.
Color

The Border Color icon launches the color selection dialog box, where you can set the Border color.

Reset Border

The Reset Border icon, resets the border styling to the theme settings for the currently selected state.

Font

You can use the Font group to choose the Font family, modify the size of the font, and apply bold, italic, or underlined formatting.

In addition, the Font group contains the following options:

Color

The Font Color icon launches the color selection dialog box, where you can set the font color.

Reset Font

The Reset Font icon, resets the font styling to the theme settings for the currently selected state.
Canvas

The following image shows the canvas area of the Page Designer. Here, you design your portal pages.

Properties Panel

The Properties panel appears near the bottom of the window, below the canvas. It contains properties that apply specifically to the currently selected item.

Breadcrumb Trail

The breadcrumb trail appears at the bottom of the Page Designer window. It serves two purposes:

- It indicates the currently selected item.
- You can use it to change the currently selected item.

Click any portion of the breadcrumb trail to change the currently selected item on the page canvas. This feature is another way to select an item, in addition to selecting it through the canvas. It is especially useful when you are working with hidden or layered content.
**Page Components**

The page is made up of different components, such as columns, containers, and resources. This section describes the different components of a page and their properties.

**Portal Page Properties**

The portal page, while not a component itself, does have properties that you can set.

The following are the properties of a portal page.

- **Title.** Identifies the title or label shown in the navigation menu and any tree that lists pages in a portal.

- **Page Icon.**
  - This is an icon displayed to the left of the page name throughout the software. You can turn it on or off. It is disabled, by default.
  - The maximum display size of the icon is 16 x 16 pixels. Upload an image that is visible at that size.
  - Change the page icon by clicking the preview icon or the *Change Image* button.

- **Lock Page.** Turns off customization on the page. Customization includes moving content and adding content.
  
  **Note:** The Lock Page check box is selected by default. Clear it to grant permission to end users from moving and adding content.

- **Refresh on Click.** Refreshes the page when you click the page title. This feature is useful if another page changes the parameters used by the reports on this page. When you switch back, the reports rerun with the appropriate parameters.

- **Show in Navigation.** Hides the page from the navigation. You can use this property to create a Home page for a portal that displays the first time that a user runs the portal, but the user cannot navigate to it again.

- **Prevent Layout Change.** Restricts layout changes on unlocked pages at run time. This option is only active when the Lock Page option is cleared.

- **Relative Path.** References a specific path for the content that was added to a page and allows you to move the page in the repository without losing any content or resources.

- **Show Refresh.** Displays the Refresh option in the page menu at run time.

- **Margins.** Sets page margins in pixels or as a percentage. Use the Same for All option to set equal margins on all four edges of a page.
Comments. Controls the placement of the comments on a page. The options include: none, top, bottom, left, and right.

Container Defaults. Opens the Container Defaults dialog box, where you can set a default size, appearance, and list of behaviors for all containers on a page.

Columns
You can set the following properties for columns in a portal page.

- Column Number. Indicates the column that is selected on the page, using a label.
- Width. Sets the width of a column in pixels or as a percentage.
- Lock Width. Prevents a designated column width from being changed at run time. This option is disabled, by default.
- Container Padding. Sets the space between either container and the column edge (left and right of each container, the top of the first container, and the bottom of the last container) or each other (vertical space between each container). These work like page margins, but are set only in pixels.
- Freeze Column. Prevents users from adding content to the column or any of the containers inside this column at run time. It also prevents users from removing any content or containers from this column at run time. This option is not available when the Lock Page option is selected.
- Show Easy Selector. Activates the Easy Selector function at run time. When you enable this property, the Browse For Folder dialog box opens, and you can select a folder that is available from the Easy Selector option at run time.
- Select Folder. Opens the Browse For Folder dialog box, where you can select a folder that is available from the Easy Selector option at run time.

Containers
There are five types of containers that you can add to a portal page. These include:

- Panel. A simple container that can hold a single piece of content.
- Accordion. A compound container that can hold one or more pieces of content. It uses accordion panes to switch between the content.
- Tabbed. Similar to the accordion, but uses tabs to switch between the content.
Responsive. A compound container that responds to the layout changes based on the size of the browser or device.

Easy Selector. A simple container that a flexible way of adding content to a portal at run time without opening the Resources tree.

Panels

A panel container holds a single piece of content, as shown in the following image.

The panel consists of three sections:

- Overall panel
- Title bar
- Content Area
If you hover over a panel in Page Designer, the change panel type button appears, as shown in the following. This button opens a menu, where you can select a different type of panel.

![Change Panel Type Button](image)

**Note:** When adding pages created in the WebFOCUS Designer, the change panel type button opens over the Refresh and Filter option for the page. However, when you run the portal page, these options are accessible.

To change the title of the panel, right-click the title bar and click *Change Title*, as shown in the following image.

![Change Title Button](image)

When you select a panel or container on the canvas, the properties panel refreshes, and provides access to the properties that you can use to modify or customize the container.

You can use the Properties tab to modify the size of a panel, set responsive properties, adjust the behavior of a panel on the portal page, and control the appearance of the panel on the portal page. These properties include the following:

- **Size.** In a single area layout, this is both height and width in pixels. In column-based layouts, this is height only. You can set the height, in pixels, to Auto, Dynamic, or a numeric value. The Dynamic height option is only available when you use a responsive container.

- **Responsive Properties.** Opens the Responsive Panel Properties dialog box, where you can edit the layout of the responsive container.
Behaviors. Configures how the panel behaves. By default, all options are on. The options that require a menu click are available by hovering over the title bar and accessing the menu at the upper-right (in accordion and tabbed containers, each area has a menu as well). The options are as follows:

- **Move.** If selected, allows you to move a panel on a page at run time.
- **Resize.** If selected, allows you to resize a panel at run time.
- **Minimize.** Adds the Minimize option to the panel drop-down menu.
- **Maximize.** Adds the Maximize option to the panel drop-down menu.
- **Refresh.** Adds the Refresh option to the panel drop-down menu.
- **Hide.** Adds the Hide option to the panel drop-down menu.
- **Delete.** Adds the Delete option to the panel drop-down menu. When a user deletes a panel, they delete it only from their version.
- **Show Comments.** Displays comments on a panel, and adds the Show/Hide Comments option to the panel drop-down menu, if selected.

Appearance. You can control the following options:

- **Hide Panel.** When this option is selected, the panel is not initially visible. The user can add it by clicking *Hidden Content* in the page shortcut menu or the Menu Bar. You can use the Hidden Content feature to give the user a choice of widgets to view on their page.

- **Freeze Container.** Prevents users from adding content to and removing content from the container at run time. This option also restricts any interaction with the container at run time except minimizing, maximizing, and restoring the panel to its original size. This option is not available when the Lock Page option is selected.

Using the Title tab of the Properties panel, you can modify the title of the panel, create a panel icon, and control the appearance of the title or menu. These properties include the following:

- **Title.** Displays the text in the title bar. When you add content, it automatically changes to the current title of that content. You can edit this field to override the automatic change.

- **Panel Icons.** Works just like the page icon. It is disabled by default.

- **Change Image.** Allows you to select a different image for the icon.
- **Appearance.** Controls the following options:
  - **Hide Title Bar.** Hides the title bar to save space. This feature is useful when you have only a single piece of content on a page.
  - **Show Menu Icons.** Determines whether the icons that display with the options in a container shortcut menu are visible.

You can use the Content tab of the Properties panel to change the content area of the panel, enable automatic refreshes of the content within the panel, and apply the styling from the portal to all content items on the portal page. These properties include the following:

- **Content Area.** The properties for the Content Area differ based on the type of content. A blank panel has a blank properties panel.

- **Auto Refresh.** Refreshes the content automatically. This property is off by default. When it is enabled, the default time is 30 seconds.

- **Dynamic Report Styling.** Applies the style of the portal to all reports that run within the portal. This property is off by default.

When you select a tabbed or accordion container, you can modify properties on the Tabs or Areas tab. These properties include the following:

- **Tabs/Areas Tab.** Contains the properties that apply to tabs and areas. This tab is only visible in the properties panel of a tabbed or accordion container. Here you can style different areas of the container by selecting *Buttons or Bar*. You can also hide the new tab button from a tabbed container, or the new area button from an accordion container, to restrict adding more tabs and areas to this container at run time.
**Accordion Container**

The accordion container can hold more than one piece of content, as shown in the following image.

In the preceding image, notice how the chart fits perfectly in the container. InfoAssist has an option to AutoFit charts. When enabled, it accepts the sizing from the portal. This prevents the person who develops the chart and the person who uses it from having to coordinate sizing. Additionally, you can easily resize the container and see the entire chart.

The title bar and content area properties are the same. The overall properties have an additional section labeled Area.

In the Area section, you can use the icons in the order in which they appear to add, rename, delete, and reorder the areas. You can also create a new area using the new area bar in the container or delete containers using the menus. You must use the Properties panel to rename or reorder the areas.

**Note:** When you click the New Area bar multiple times to add new areas, you may need to resize the container to view the bar, as it could be covered by newly created areas.

There is also an additional Properties panel, the Pane Title Bars, which is accessible only through the breadcrumb trail. This feature lets you style the title bars of the areas. They are all styled together, but you can style the different states to distinguish the currently active one from the one on which the mouse pointer is resting.
Tabbed Container

The tabbed container can hold more than one piece of content, as shown in the following image.

The tabbed container has all the same properties as the accordion container. Instead of the Pane Title Bars properties, it has a property panel called Tab Bar. You can access this property panel by clicking it.

Unlike the Pane Title Bars, it is not blank. You can choose to style the buttons or the bar.
Responsive Container

The responsive container is designed to help you build a responsive portal that automatically adapts to different screen sizes and mobile devices, providing an optimal viewing experience for users everywhere. You can build your responsive portal on your desktop, and make it available to users on different platforms. The following image shows an example of a responsive portal displayed on a desktop, tablet, and smart phone.

The responsive container intuitively changes its layout when you change the size of your browser. The default width and height of the container, and the inserted items, are pre-configured to offer the best positioning of the elements on the screen. You can manually change the dimensions of the items in the Responsive Item Properties dialog box. You can also change the layout options in the Responsive Panel Properties dialog box.

Responsive Item Properties

The Responsive Item Properties dialog box provides options to change the dimensions of an individual item within the responsive container. You can access the Advanced Responsive Item Properties dialog box at design time by clicking the Responsive Properties button in the Properties panel.

The properties for a responsive item are:

- **Custom CSS Classes.** Enables custom CSS classes for the item.
- **Width.** Defines the width of the item.

- **Height.** Defines the height of the item.

- **Margin.** Defines the space between the adjacent items.

- **Shrink.** Defines the ability of the item to shrink if necessary.

- **Grow.** Defines the ability of the item to grow if necessary.

- **Basis.** Specifies the initial size of the item, before any available space is distributed according to the responsive factors.

- **Minimum Width.** Sets the minimum width of the specified element. This setting overrides the Width setting.

- **Maximum Width.** Sets the maximum width of the specified item. This setting overrides the Width setting.

- **Minimum Height.** Sets the minimum height of the specified item. This setting overrides the Height setting.

- **Maximum Height.** Sets the maximum height of the specified item. This setting overrides the Height setting.

- **Self Align.** Provides access to the following options:
  - **Auto.** Intuitively places the item in the best available space inside the responsive container.
  - **Start.** Aligns the item to the left side of the responsive container.
  - **End.** Aligns the item to the right side of the responsive container.
  - **Center.** Aligns the item to in the center of the responsive container.
  - **Stretch.** Stretches the item to fill the available space inside the responsive container, while respecting width and height constraints.
  - **Baseline (text).** Aligns the baseline of text inside the responsive container.

**Note:** In a responsive layout, setting fixed dimensions for items is not recommended, because the viewport width and height continually change from device to device. Responsive layouts need to adapt to this change, whereas fixed dimensions create too many constraints. For this reason, you must only set a range between minimum and maximum width and height, defining an amplitude with which the item can vary in size.
Easy Selector Container

The easy selector container provides a simple way to add content to a portal at run time, without opening the Resources tree. It also gives you the option to control which items users can access. When you insert an easy selector container into a page at design time, the Browse For Folders dialog box opens, as shown in the following image. Here you can select a folder that users can access at run time.

To change a target folder, click the Change Folder button in the Properties panel.

Content

You can add content to a page in a few ways. The first way is to use the ribbon. Navigate to the Insert tab and choose a type of content in the Content group. The second way is to insert a blank panel, area, or tab container, and use the WebFOCUS Resources panel to populate it. From this panel, you can drag content to the portal page.

Note: When you click, and drag one or multiple resources or folders from the WebFOCUS Resources panel to a blank page, a tabbed container is created, showing each resource as a separate tab.

The other three options (Image, Resource Tree, and Text) place their content in the content area that is selected, if applicable. Alternatively, they create a new panel with the content on the page.
WebFOCUS Resources

The WebFOCUS Resource option opens the Resources tree on the right-hand side of the window. The tree shows you the content stored in the Repository. You can access this content in the Domains section of the tree. Alternatively, you can find a resource that you marked as a Favorite.

The Resources tree is docked on the right. When it is docked, you can keep it open, close it, or unpin it so that it collapses to the side.

Text

The last type of content is text. The text area is simple to use. All styling is applied to all the text. You cannot style individual words or characters.

The text area has no properties other than the content type and the Area ID.

Working With the Business User Edition Portal

The first page that you see after signing in to the Business User Edition is the Home page. If you add a new personal portal page and sign out of the portal with the new portal page in focus, the new portal page opens, by default, the next time you sign in. You can create new portal pages to display the content that is available to you.

Procedure: How to Add a New Personal Portal Page

From the Home page, click the Add Page icon, as shown in the following image.
A blank page and the WebFOCUS Resources panel opens. You can drag content from the Resources tree to the portal page.

**Procedure:** How to Add a New Base Portal Page

1. In the Explorer, on the Home page, right-click a domain portal page, and then click Publish.
   
   For more information on how to create domain portal pages, see *How to Use the Page Designer to Create a Domain Portal Page* on page 612.

2. On the Menu bar, click Resources.

   The WebFOCUS Resources panel opens.

3. Right-click your published portal page, and then click Add to Portal.

   The confirmation message appears, indicating that the portal page is added to the portal.

4. Click OK to close the confirmation message.

   The portal refreshes, the new page appears in the new tab.

**Note:** The domain portal pages added to the Business User Edition portal behave as base portal pages. Base portal pages are locked, by default, at design time to prevent users from making run-time changes.

**Procedure:** How to Add Content to the Business User Edition Portal at Run Time

1. Navigate to the page that you want to populate with content.

2. On the Menu bar, click Resources.

   The WebFOCUS Resources panel opens.
3. Drag an item, such as report, chart, or page created in the WebFOCUS Designer, to the portal page. Use the shaded area to position the item on the portal page, as shown in the following image.

Note: When you drag one item on top of another and position your cursor in the center of the other item, you have a choice to either replace the existing item or add the new item as a new tab. If you choose the latter, a tabbed container is automatically created. If you multi-select several items and drag them to a portal page, they display as tabs within a single panel. You can refresh or delete each tab individually. You can rearrange content by moving it on the portal page with your pointer. Optionally, you can change the layout of the portal page by right-clicking the page title, and then clicking Page Layout. The default layout of the personal portal pages is Fluid Canvas.

4. After you finish adding content to the portal page, close the WebFOCUS Resources panel.
Accessing Page Shortcut Menu Options

Right-click the page title of a personal portal page or an unlocked base portal page to access a shortcut menu options. The shortcut menu opens, as shown in the following image.

### Change Title

Renames the selected portal page.

### Move Left

Moves the selected portal page to the left.

### Move Right

Moves the selected portal page to the right.

### Page Layout

Allows you to choose a portal page layout to align your content into the desired number of columns.

### Delete

Deletes the selected portal page.

**Note:** The Home page does not have shortcut menu options, since this is a static base page in the portal.

Using WebFOCUS Designer

These topics introduce WebFOCUS Designer, and how you can begin using it to create pages and InfoApps.
Introducing WebFOCUS Designer

WebFOCUS Designer is a web-based development tool that you can use to create interactive, responsive pages, using content that you or other members of your organization create. This content can be added to a page by utilizing drag-and-drop actions. With the interactive canvas, you can resize and rearrange resources with ease. Additionally, you can use the integrated filter control capability to create instant, compelling applications and InfoApps from your content.

WebFOCUS Designer is shown in the following image.

Navigating the WebFOCUS Designer

The WebFOCUS Designer features a modern user interface with intuitive navigation, streamlined content creation, and the flexibility to build filtered responsive pages that are instantly compatible with any browser or mobile device.
The WebFOCUS Designer Interface

The WebFOCUS Designer interface is shown in the following image.

The WebFOCUS Designer consists of the following components:

- Designer toolbar
- Resource selector
- Canvas
- Page toolbar
- Properties panel

Designer Toolbar

The Designer toolbar provides access to general properties and interface controls that you use to help develop content in the WebFOCUS Designer, as shown in the following image.

The following table lists and describes the controls that you can access from the Designer toolbar.
<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Application Menu" /></td>
<td><strong>Application Menu.</strong> Opens a menu that you can use to open an existing page, create a new page, save the current page, and close the WebFOCUS Designer.</td>
</tr>
<tr>
<td><img src="image" alt="Save" /></td>
<td><strong>Save.</strong> Opens the Save dialog box, where you can save the page to a specific location in your environment.</td>
</tr>
<tr>
<td><img src="image" alt="Preview" /></td>
<td><strong>Preview.</strong> Shows the page in preview mode, allowing you to view how the page will appear when run. To exit the preview mode of the Designer, click the back arrow.</td>
</tr>
<tr>
<td><img src="image" alt="Quick Filter" /></td>
<td><strong>Quick Filter.</strong> Configures filters that automatically appear when new unbound parameters are found in the content on the page. The badge icon shows the number of parameters available.</td>
</tr>
<tr>
<td><img src="image" alt="Page Filter Configuration" /></td>
<td><strong>Page Filter Configuration.</strong> Opens the Page Filter Configuration dialog box, where you can choose to display filters in a filter bar above your content or in a modal window.</td>
</tr>
<tr>
<td><img src="image" alt="Help" /></td>
<td><strong>Help.</strong> Launches the online Help content.</td>
</tr>
<tr>
<td><img src="image" alt="Resources" /></td>
<td><strong>Resources.</strong> Hides or shows the Resource selector.</td>
</tr>
<tr>
<td><img src="image" alt="Properties" /></td>
<td><strong>Properties.</strong> Hides or shows the Properties panel.</td>
</tr>
</tbody>
</table>

**Resource Selector**

You can use the Resource selector to access content, containers, and controls for your page. The Resource selector has the following tabs:

- Containers
- Content
- Controls
The Containers tab is shown in the following image.

Using this tab, you can select empty containers, which you can drag to the canvas, and populate with the content of your choice. The types of containers available to you include:

- Panel
- Tabbed
- Carousel
- Accordion
- Grid

The Content tab is shown in the following image.
This tab shows your Resources tree, where you can navigate to your content by expanding and collapsing folders, selecting content items, and dragging to the canvas.

The Controls tab is shown in the following image.

![Image of Controls tab](image)

Using this tab, you can add a text label or a Submit button to your page.

**Canvas**

The canvas is the design area. It provides a responsive grid for all your containers and content and resizes automatically to fit any browser or device. The canvas is shown in the following image.

![Image of canvas](image)

When you right-click the grid area, you access a shortcut menu of options that include the following:

- **Settings.** Opens Section Settings inside the Properties panel, which you can use to make the current section collapsible.

- **Style.** Opens the Style tab inside the Properties panel, which you can use to apply styles to the current section.
- **Delete section.** Deletes the current section.

- **Insert section above.** Inserts a section before the current section.

- **Insert section below.** Inserts a section after the current section.

The Page toolbar is located above the canvas. Here you can edit the page title by double-clicking the text and typing the new text. You can hide the page title by disabling *Title* in the Properties panel.

The Page toolbar also contains two options, described in the following table.

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td><strong>Refresh.</strong> Refreshes the content on the canvas.</td>
</tr>
<tr>
<td><img src="image" alt="Filter" /></td>
<td><strong>Filter.</strong> Toggles the page filter, which can be displayed as a filter bar or a filter modal window. This option is only visible when filters are added to the page.</td>
</tr>
</tbody>
</table>

You can hide the options by disabling *Toolbar* in the Properties panel. To hide the Page toolbar completely, disable both *Title* and *Toolbar* in the Properties panel.
Properties Panel

You can use the Properties panel to configure properties for the element that you selected on the page. An example of the Properties panel for a page is shown in the following image. Under the Settings tab, you can toggle the title and toolbar visibility. Under the Style tab, you can configure page style and page heading.

Creating and Editing Pages in WebFOCUS Designer

Using the responsive grid, drag-and-drop operations, and other features, arranging content on a page in WebFOCUS Designer is quick.

Creating Pages in WebFOCUS Designer

You can create pages in WebFOCUS Designer that you can add to a portal or portal page to share with other users in your organization. Additionally, pages that you create in Designer can be run as content items from the Home page or directly from a browser. You can share a Designer page as a stand-alone repository resource or a URL.
Procedure: How to Create a Page Using WebFOCUS Designer

1. To launch WebFOCUS Designer, from the Home page, in the Resources tree, select the domain or folder where you want to create the page, and then click Page.

   The New Page dialog box opens, as shown in the following image.

   ![New Page dialog box](image)

   - Choose a template for your page. The options include Blank, Grid 2-1, Grid 3-3-3, Grid 4-2-1, and InfoApp 1.

   Designer opens, and the canvas shows the template that you selected.

Editing Pages in WebFOCUS Designer

After creating a page in WebFOCUS Designer, you can edit it at any time, in one of the following ways:

- From the Home page, select the domain or folder where the page resides. Right-click the page, and click Edit.

- From the Home page, select the domain or folder where the page resides, and then click Page. In the New Page dialog box, click Copy an Existing Page. In the Open dialog box, click the name of the page, and then click Open.

- From WebFOCUS Designer, click the Application Menu button, and then click Open. In the Open dialog box, click the name of the page, and then click Open.

Note: You can only use WebFOCUS Designer to edit pages that were created in this tool.
Adding Content to a Page

In the WebFOCUS Designer, you can create interactive pages or InfoApps, using content that you create in InfoAssist as well as images and URLs to external content. You can also add content to these pages using content that was created by another user in your organization. You can access the content that is available to you from the Content tab in the Resource Selector.

Procedure: How to Add Content to a Page

1. From the Resources tree, in the WebFOCUS Designer, drag a content item of your choice to the canvas such as, a chart.

   As you drag the item to your canvas, a shaded placement area appears, as shown in the following image.

   ![Page Heading](image)

2. Repeat Step 1 to add more content to your page.

   After adding content to your page, you can resize or rearrange items, add a heading, or add filters. Before closing the page, be sure to save any changes.

Creating Multi-Content Containers

In the WebFOCUS Designer, you can create multi-content containers that show multiple content items at the same time. For example, you can create a carousel that rotates images or an accordion container that maximizes space on your page.

The multi-content container types include:

- Tab. Displays content items using tabs that you can click to view secondary content items.
- **Carousel.** Displays content as slides that rotate between other content items automatically.

- **Accordion.** Displays content items in an accordion-styled container that you can expand or collapse to view different content items.

**Procedure:** How to Create a Multi-Content Container

1. Add a content item to your page.

2. Drag a new content item to your page, and place it over the existing container.

   The Add Content dialog box opens, and presents the following options.

   - **Replace content.** Replaces the content item with the new one.
   - **Add content as new tab.** Creates a tabbed container.
   - **Add content as new slide.** Converts the container to a carousel, and adds content as slides.
   - **Add content as new accordion area.** Creates an accordion container.

   - **Cancel.** Closes the Add Content dialog box.

3. Select an option to modify the container.

   The item refreshes and shows the multi-content container. You can modify the container title and adjust the placement on your page.

   **Note:** Once you have selected a new tab, new slide, or new accordion area, the options in this menu only allow you to replace an item or add an item.
Resizing Content on a Page

You can resize content on a page at any time using the sizing handles and the shaded placement area that appear on the canvas. When you hover over an item on the canvas, a series of handles appear. Drag a handle in the direction that you want to resize the item, as shown in the following image.
**Previewing Pages**

As you create pages in the WebFOCUS Designer, you can preview how the page will appear when run by clicking the Preview button. This opens a preview mode of the Designer, which is shown in the following image.

In preview mode, you can interact with your content, view tooltips, as well as access menu options only available when the page is run. You can also explore the responsive capabilities of the page by adjusting the width of your browser. These functions are not available when you create the pages, as interactive features are disabled. The Maximize / Restore button behaves in the same way when you create a page or preview a page, by maximizing the item to fill the entire canvas. If you save the page while an item is maximized, it will appear maximized the next time that you open or run the page, by default.

To exit the preview mode of the Designer, click the arrow.

**Dividing Pages into Sections**

The WebFOCUS Designer canvas uses a responsive grid layout that you can divide into sections to organize your content, and achieve multiple, complex layouts. You can also collapse selected sections to allow users to maximize space on a page.
When you open a blank page, only one section displays inside the canvas. To add more sections, right-click the canvas and then click *Insert section above* or *Insert section below*.

When a section is selected, a red dotted line appears to indicate the border of the section, as shown in the following image.

![Section border](image)

To delete a section, right-click the section, and then click *Delete section*.

To make a section collapsible, enable the Collapsible setting in the Properties panel. Right-click the section, and click *Settings*, or click *Properties* on the toolbar to open the Properties panel. You must enable the Collapsible setting for each section that you want to make collapsible.

When the page is run, you can expand or collapse sections using the section indicator, which is shown in the following image.

![Section indicator](image)

When you save the page, the collapsed state of the section is saved and will appear collapsed the next time you open or run the page.
Editing Page and Contain Properties

The Properties panel displays the properties for the element that is selected. To access container properties, click a container or item with the Properties panel open. To access page properties, click the page header or the toolbar. If the page header and the toolbar are hidden, you can access page properties by clicking the canvas outside a grid section.

The following properties are available for pages.

Settings tab:

- **Title.** Toggles between hiding and showing the title in the header.

- **Toolbar.** Toggles between hiding and showing the page toolbar.

Style tab:

- **Theme.** Allows you to select a theme for the page. The options are Default, Light, and Midnight. Administrators can configure additional themes that will be available to users from this property.

- **Margin.** Controls the size of the margin between the border of the page and the content.

- **Max Width.** Controls the maximum width of the page.

- **Page Heading Style.** Provides a selection of typeface styles for the page heading.

The following properties are available for containers and items.

Settings tab:

- **Title.** Toggles between hiding and showing the title.

- **Toolbar.** Toggles between hiding and showing the container toolbar.

Style tab:

- **Container Style.** Allows you to choose a color style for the selected container or item.
Working With Filters in WebFOCUS Designer

Creating a page filter in WebFOCUS Designer is a quick and intuitive process. Whenever you add parameterized content item to the canvas, such as a report with parameters or chart with parameters, the Designer recognizes the parameters and creates filters for them automatically. The tool then notifies you of any available filters with a notification, and a badge count is overlaid on the Quick Filter button, as shown in the following image.

There are three ways to add filters to a page in WebFOCUS Designer:

- Automatically, by clicking the Quick Filter button.
- Manually, by creating an empty filter bar or filter modal window and populating it with select filters.
- Manually, inside a Grid container.

Procedure: How to Automatically Add Filters to a Page Using the Quick Filter Button

1. In the Resource selector, drag a parameterized item of your choice from the Resources tree to the canvas.
   
   The Quick Filter button appears on the toolbar with the badge icon showing the number of unbound filters.

2. Optionally, add more content with the same set of parameters.

3. Click the Quick Filter button.
   
   The filter bar with all available filters appears above your content.
4. Optionally, customize your filter bar as described below.

- Right-click a cell to access shortcut menu options, as shown in the following image.

![Image of filter bar customization options]

The available options are:

- **Add filter controls.** Opens the Add Filter Controls dialog box, where you can choose from the list of available controls and add them to the filter grid.

- **Insert row above.** Inserts an empty row above the current one in the filter grid.

- **Insert row below.** Inserts an empty row below the current one in the filter grid.

- **Style.** Opens the Properties panel, where you can customize grid style and cell alignment.

- **Delete cell.** Deletes the current cell.

- **Delete grid.** Deletes the entire filter bar.

- Right-click a control to access shortcut menu options, as shown in the following image.

![Image of control customization options]
The available options are:

- **Edit label.** Makes the label of the control an editable text.
  
  **Note:** Another way to edit a control label is to double-click the field, type the new text, and press *Enter*.

- **Convert.** Opens the Convert Control To dialog box, where you can choose between various control types.

- **Settings.** Opens the Properties panel, where you can customize label position, label alignment, and control object width.

- **Style.** Opens the Properties panel, where you can customize cell styling options.

- **Delete control.** Deletes the current control.

- Drag any filter cell to a new location in the grid.

- Multi-select two controls, right-click one of them, and then click *Combine* to combine the two controls into one. An example of two combined controls is shown in the following images.

![Combined Filters](image1.png)

- Drag a control into a cell with other controls. This action puts two separate controls into one cell. The drag marker is shown allowing you to position one control in front or behind another control. You can separate the controls again by dragging one control out of the cell.

5. Save your changes.

**Procedure:** How to Add Filters to a Page Manually

1. In the Resource selector, drag a parameterized item of your choice from the Resources tree to the canvas.

   The Quick Filter button appears on the toolbar with the badge icon showing the number of unbound filters.

2. Optionally, add more content with the same set of parameters.
3. Click the Page filter configuration button.

The Page Filter Configuration dialog box opens.

4. Click Create empty filter bar, as shown in the following image.

![Page Filter Configuration dialog box](image)

**Note:** If you prefer a floating modal window instead of a filter bar, click Create empty filter modal window.

5. Right-click inside any filter cell, and then click Add filter controls.

The Add Filter Controls dialog box opens, and lists all available controls selected by default, as shown in the following image.

![Add Filter Controls dialog box](image)

6. Clear the controls that you want to exclude.
7. Optionally, change the types of your controls where applicable by selecting a desired option in the Control column, as shown in the following image.

![Control Selection](image)

**Note:** When working with button sets, keep in mind that they look best when positioned in a single line.

8. Click **Add filter controls**.

The controls are added to the filter bar.

9. Save your changes.

**Procedure:** How to Add Filters to Page Using a Grid Container

1. In the Resource selector, drag a parameterized item of your choice from the Resources tree to the canvas.

   The Filter button appears on the toolbar with the badge icon showing the number of available filters.

2. Optionally, add more content with the same set of parameters.

3. In the Resource selector, click the Containers button.

4. Drag the Grid container onto the canvas.

5. Right-click inside the grid container, and then click **Add filter controls**.

   The Add Filter Controls dialog box opens, and lists all available controls selected by default.

6. Clear the controls that you want to exclude.

7. Click **Add filter controls**.

   The controls are added to the grid container.

   **Note:** You can also drag a control from the filter bar to a grid container directly, if the filter bar is open and populated with controls.

8. Optionally, move and resize your grid container and content to achieve the desired alignment.
An example of a simple layout featuring a grid container with filter controls is shown in the following image.

9. Save your changes.

**Configuring Filter Grid Properties**

You can configure the properties of the filter grid using the Properties panel, which is content-sensitive. For example, when you click a filter cell, the cell style properties open in the Properties panel. When you click a filter control, the general and style properties for this control open in the Properties panel.
The Properties panel for a cell is shown in the following image. When you configure these properties, you modify the alignment of content within a cell or change the style layout of the filter grid.

The properties for a grid cell are:

- **Cell Content Alignment.** Controls the alignment of the label and control inside the cell. The options include top, middle, bottom, left, center, and right.

- **Grid Style.** Controls the grid layout of the filter bar. The options include 1-Column, 2-Column, 3-Column, 4-Column, and 6-Column.
The Properties panel for a filter control is comprised of two tabs: general and style properties. The settings tab is displayed in the following image. Using these properties, you can define the type of filter control that shows on the page, add a tooltip or placeholder text, and set the default value.

The settings tab contains the following properties:

- **General Settings.** This section includes the following options:
  - **Type.** Displays the type of the control.
  - **Tooltip.** Displays a tooltip when you hover over the filter control.
  - **Global name.** Designates a global name to the control.

- **Control Settings.** This section includes the following options:
  - **Optional.** Toggles between optional and mandatory control.
  - **Placeholder Text.** Displays a placeholder text inside the control selection field.
  - **Search.** Adds a search field to the filter drop-down menu.

  **Note:** If the select list contains 50 or more values, the Search option is enabled automatically.
- **Selection controls.** Adds *Select All* and *Clear* buttons to the filter drop-down menu. This property is only available for multiple select lists.

  **Note:** The Selection controls and Show All options cannot be selected at the same time.

- **Data Settings.** This section includes the following options:
  - **Show All option.** Adds an All option to the control that the user can select. This option is hidden when the Selection controls option is enabled.

    **Note:** Choosing this option results in the parameter receiving a _FOC_NULL value. If this parameter is used in a WHERE condition, it results in the WHERE condition being removed from the request and all data values for this field displaying the page.

  - **Display text.** Allows you to specify a custom value for the Show All option in the control. The default text is *All*.

  - **Default value.** Displays the default value of the control. You can edit this field and override the control value.

  - **Parameters.** Shows the name of the parameters that were used for this control.
The style tab is displayed in the following image. Similar to the properties of a cell, you can modify the positions of labels in a control, define the alignment, and set the object width.

The style properties are:

- **Label Position.** Controls the position of the filter label in the relation to the control. The options are above, right, left, and no label.

- **Label Alignment.** Controls the alignment of the filter label. The options are left, right, and center.

- **Direction.** Controls the alignment of the elements inside the control. This property is available for radio button, checkbox and button set controls. The options are horizontal and vertical. The vertical option is enabled by default when the control has five or more values.
Label/Control Split. Controls the space ratio between the label and control inside the cell. This option is only available when the label position is set to right or left.

Control Object Width. Sets the width of the control in relation to the filter cell. The options are:

- **Auto.** Adjusts the width of the control automatically to accommodate the name of each value.
- **Max.** Fills the entire filter cell. This is the default value.
- **Percentages.** Set the control width to various percentages, as they relate to the filter cell.

Control Object Height. Sets the maximum height of the control. If the list of elements exceeds the maximum height of the control, a scrollbar is added to this control. This property is available for radio button, checkbox and button set controls when their Direction property is set to vertical. The default value is 150px. You can change this value as necessary.

Using Filters in WebFOCUS Designer

WebFOCUS Designer filter controls are versatile and allow you to facilitate multiple filtering scenarios. Depending on the needs of your enterprise and on the specifics of the data that you are using, you can configure filter controls to fit your unique needs. Examples below show you different types of controls and how to use them.

Choosing an Event Model for Your Page Filter

WebFOCUS Designer supports two event models for passing parameters to your page content:

- **On-selection Change.** Whenever you change a value of any filter control on the page, parameterized content refreshes to reflect your selection. This model is enabled, by default.

- **Submit Button.** After you make all desired changes to filter controls on the page and click the Submit button, parameterized content refreshes to reflect all your selections. This model can be enabled by dragging a Submit button control into the filter grid.

Procedure: How to Use One-selection Change Filters

1. Add filters to a page as described in How to Automatically Add Filters to a Page Using the Quick Filter Button on page 651.
2. Click the Preview button.
The preview mode is activated, allowing you to interact with content and filters.

3. Make filter selections.

Each time you make a selection, the content refreshes to reflect it.

**Note:** Notice that the filter controls are chained in such a way that each selection automatically reflects the available choices in other filters. In our example, we set Category to *Televisions*. Now, the Product Model filter only shows models of televisions, as shown in the following image. WebFOCUS Designer chains controls automatically, if the parameters are defined in the metadata layer with the WITHIN keyword to relate them.

4. Exit the preview mode and save your changes.

**Procedure:** **How to Use Filters With a Submit Button**

1. Add filters to a page, as described in *How to Automatically Add Filters to a Page Using the Quick Filter Button* on page 651.

2. From the Resource selector, click the **Controls** tab, and then drag the **Submit** button onto the filter grid.

   The Submit and Reset buttons display in the filter grid.
3. Optionally, customize the Submit and Reset buttons in any of the following ways:

- Align the Submit and Reset buttons by selecting the cell in which the buttons reside and customize the Cell Content Alignment option on the Style tab of the Properties panel. In this example, we selected *Align control bottom* and *Align control center*.

- Add a tooltip to the buttons by selecting each one and populating our the Tooltip field on the Settings tab of the Properties panel.

- Customize the width of the buttons in relation to the filter cell by selecting one of the options under the Control Object Width property. In this example we selected *50%*.

*Note:* You can delete one or both buttons by right-clicking them and clicking *Delete*.

4. Click the *Preview* button.

The preview mode is activated, allowing you to interact with content and filters.

5. Make filter selections and click *Submit*.

The content refreshes to reflect all your selections upon clicking the Submit button, as shown in the following image.

6. Click *Reset*.

The filters return to their default values.

7. Optionally, click *Submit* again to refresh the content with the default values.
**Note:** If you deleted the Reset button in the previous step, you must select default values manually, and then click Submit to return to the default state.

8. Exit the preview mode and save your changes.

**Working With Required Parameters**

When you have required parameters in your content, WebFOCUS Designer interprets them as required filter controls. Required controls are marked in red, prompting you to make a selection for the request to be processed. The image below shows an example of a required filters control.

![Required Parameter Example](image)

With a required parameter in place, your content does not refresh until you select filter values.

There are two ways to create a required filter control:

- By adding a required parameter to a chart or report in InfoAssist.
- By converting an optional control to a required one in WebFOCUS Designer.

**Procedure: How to Add a Parameter to a Content Item**

1. On the WebFOCUS Home Page, on the actions bar, click Report or Chart.
   The Open dialog box opens.
2. Select a data source in the Open dialog box and click Open.
   InfoAssist opens.
3. Create a report or chart.

To learn more about creating content in InfoAssist, see the *WebFOCUS InfoAssist User's Manual*.

4. On the Data tab, click *Filter*.

The Create a filleting condition dialog box opens.

5. Double-click the *Double-click or press F2 to edit* text, select a field, leave the condition at *Equal to*, and then click *Value*.

The drop-down dialog box opens.

6. Set the Type field to *Parameter* and select the *Dynamic* radio button.

7. Optionally, select the *Select multiple values at runtime* check box to create a multiple select filter control and *Optional* check box to create an optional filter control.

In our example, we are creating a multiple select required control. An example of a complete configuration is shown in the following image.

8. Save your changes and exit InfoAssist.

9. In WebFOCUS Designer, in the Resource selector, drag your new content item to the canvas.

The content item does not load. Instead, a blank container displays a message: *A required parameter is missing*. The Quick Filter button appears on the toolbar with the badge icon showing one available filter.
10. Click the *Quick Filter* button.

   The filter bar with one filter appears above the content item. The filter control is marked in red and the *Make a selection* text displays inside the control field.

11. Click the *Preview* button.

   The preview mode opens.

12. Select one or more values from the list.

   The filter control is no longer red. It displays your selections. The content refreshes to reflect the filter values, as shown in the following image.

   ![Image of filter control with selected values]

13. Exit the preview mode and save your changes.

**Procedure:** How to Convert an Optional Filter Control to a Required One

1. In WebFOCUS Designer, add filters to a page, as described in *How to Automatically Add Filters to a Page Using the Quick Filter Button* on page 651.

2. Click an optional filter control and then click the *Properties* button.

   The Properties panel opens.

3. In the Settings tab, disable the *Optional* setting and then disable the *Show All option* setting.

   The filter control is marked in red and the *Make a selection* text displays inside the control field.
4. Click the Preview button.
   The preview mode opens. The content does not refresh.

5. Select a value for the required filter control.
   The content refreshes to reflect your selection.

6. Exit the preview mode and save your changes.

**Working With Single and Multiple Select Lists**

There are two types of list controls in WebFOCUS Designer:

- **Single Select List.** Allows you to pick a single value at run time.

- **Multiple Select List.** Allows you to pick multiple values at run time.

An example of a single select list control is shown in the following image.

![Single Select List](image1)

Once you have made a selection in a single select list, your content instantly refreshes to reflect that selection.

An example of a multiple select list control is shown in the following image.

![Multiple Select List](image2)

Once you have made all your selections in the multiple select list, you must click outside of the control for the content to refresh.
You can customize your list controls with the search feature by enabling the *Search* setting in the Properties panel. Once enabled, it adds the search field to your list and allows you to quickly navigate to a specific value. Simply start typing any word or syllable and all values that contain it will display. When a list contains 50 or more values, the search feature is enabled automatically. You can disable it at any time by disabling the *Search* setting in the Properties panel.

If a list contains 200 or more values, the paging feature is added to the bottom of the control. When paging is active, 10 values display per page. An example of a long list with the paging feature enabled is shown in the following image.

![List control with search and paging](image)

You can further enhance a multiple select list by enabling the *Selection controls* option in the Properties panel. Once enabled, it adds the *Select all* and *Clear* buttons to the list. This feature is especially useful when you need to eliminate just a few values from your results. You can click *Select All*, clear the values that you need to eliminate, and click outside of the control to refresh your content.
If the Selection controls and Search features are enabled at the same time, you can use the Select all button to select all search results, as shown in the following image.

![Select all button image]

**Working With Slider Controls**

A slider control is a horizontal track with a marker that you can slide between a minimum and maximum value. This versatile control is often used to choose a value within a fixed range. An example of a slider control is shown in following image.

![Slider control image]

**Procedure:** **How to Create a Slider Control**

1. On the WebFOCUS Home Page, on the actions bar, click Report or Chart.
   The Open dialog box opens.

2. Select a data source in the Open dialog box and click Open.
   InfoAssist opens.

3. Create a report or chart.
   To learn more about creating content in InfoAssist, see the WebFOCUS InfoAssist User's Manual.

4. On the Data tab, click Filter.
   The Create a filleting condition dialog box opens.

5. Create two parameters representing minimum and maximum values and make them optional.
In this example we create the minimum and maximum parameters for the MPG field in the car report. An example of the completed filtering condition is shown in the following image.

6. Save your changes and exit InfoAssist.
7. One the Home Page, right-click your new content item, and then click *Edit with text editor*.
   The Text Editor window opens.
8. Edit the syntax by providing the data range values.
An example of the modified syntax is shown in the following image.

9. Save your changes and exit the Text Editor.

10. In WebFOCUS Designer, in the Resource selector, drag your new content item to the canvas.

   The Quick Filter button appears on the toolbar with the badge icon showing two available filters.

11. Click the **Quick Filter** button.
The slider controls display in the filter grid, as shown in the following image.

12. Optionally, combine two controls together. Multi-select both controls, right-click one of them, and then click **Combine**.

Your controls are combined. You can edit the label to reflect your new combined control. An example of the combined slider control is shown in the following image.

13. Save your changes.
Working With Date Controls

Parameters that contain date ranges are recognized by WebFOCUS Designer as date range controls. An example of the date range controls on the page is shown in the following image.

The calendar feature inside a date control allows you to select a specific date value. Once you pick a specific date, it is always spelled out, so that it can be supported by all internationalized applications.

Optionally, you can combine two date control into one date range control. To do so, multi-select two date controls and then click Combine. An example of a combined date range control is shown in the following image.
Using Global Name to Synchronize Filter Controls

The Global Name property is a powerful tool that allows you to quickly synchronize filter control values between different pages. The Global Name property is configured on the Settings tab of the Properties panel for a filter control. Once enabled, it allows you to match your filter selections across multiple pages at run time within the same browser session.

Procedure: How to Configure Global Name Filter Control Property

1. In WebFOCUS Designer, add filters to a page, as described in How to Automatically Add Filters to a Page Using the Quick Filter Button on page 651.

2. Click a filter control that you want to synchronize and then click the Properties button. The Properties panel opens.

3. In the Settings tab, populate the Global Name field, as shown in the following image.

Note: You can choose any text as a global name for your control. Combined controls, such as date ranges and slider controls, have a single global name property.

4. Optionally, repeat step 3 for all the filter controls that you want to synchronize.

5. Save the page.

6. Create a second page, populate it with parameterized content, and add the same set of filter controls as you did in step 1.

Note: To streamline this process, you can use the Save As option to create a new version of the existing page, leave the configured filters intact, and replace the content on the canvas. Make sure the Global Name values are identical between the filter controls on both pages.

7. Save the second page and exit WebFOCUS Designer.

8. Run one of your newly created pages.
9. Select filter control values.

An example of the filter control selections is shown in the following image.

![Image of filter control selections](http://example.com/image1.png)

10. Run the second page.

The page runs with the same filter control values as the ones you have selected on the previous page, as shown in the following image.

![Image of filter control selections on the second page](http://example.com/image2.png)

11. Optionally, change the filter control values on the second page and see how they synchronize with the ones on the first page.
Creating Report Queries With InfoAssist

You can create a new report query directly from Excel by accessing the WebFOCUS Quick Data Add-in. Specify connection attributes and the data source for your query, and then build your report using InfoAssist. You can place multiple queries in the same worksheet, or spread them out over multiple worksheets in a workbook.

There are limitations with queries that overlap. However, there are data layout options available in the Query properties of Excel that can assist with overlapping queries. This behavior is governed by Excel, not WebFOCUS Quick Data.

**Note:** Quick Data is a WebFOCUS Business User Edition option, which requires a separate license and installation. For more information about licensing Quick Data, contact your Information Builders representative.

**Procedure:** How to Create a New Report Query in InfoAssist

1. Open an Excel file.
2. Select a cell in which to place the query results.
3. With the Add-Ins tab selected, click the WebFOCUS option in the Excel menu, and then click Create Query.
   
   You can also right-click any cell and select Create WebFOCUS Query.
4. In the Web Server Connection dialog box, specify the desired Web Server URL and connection settings, and then click Next.
   
   **Note:** Do not end the URL with the / sign.
5. If prompted for sign-in credentials, sign in with your WebFOCUS Business User Edition username and password.
   
   The next screen opens, where you can select a folder to open a list of available data sources.
6. Select a folder and click Next.
7. In the Data Source Selection dialog box, select a Master File, as shown in the following image, and then click Finish.

InfoAssist opens, where you can build a query and run it to return the output data to Excel.

**Example: Creating a New Report Query in InfoAssist**

This example covers multiple aspects of creating a new report query using the WebFOCUS Quick Data tool from an Excel file.

1. Open an Excel file, select a cell in which to place the query results, select the Add-ins tab, click the WebFOCUS option in the Excel menu, and click Create Query.

   The Web Server Connection dialog box opens.

2. In the Web Server URL field, type the URL for a web server in your reporting environment, or select one from the drop-down list. An example of a Web Server URL is:

   \[\text{http://localhost:26000}\]

   **Note:** Do not end the URL with the / sign.

3. Click Next.

4. Select a folder to open a list of available data sources. In this example, we use the Retail Samples folder. Click Next.

5. In the Data Source Selection dialog box that opens, select \textit{WF\_RETAIL\_LITE} from the Data Source list, and click Finish.

   InfoAssist opens.

6. Drag fields from the Data pane to the Query Pane to create a report.
7. On the Home tab, in the Report group, select Column Totals. After you perform the steps up to this point, the InfoAssist window looks similar to the following.

8. Click the Save button.
The report query data is transferred to the Excel file, as shown in the following image.

9. Click the drop-down arrow to the right of the Name Box. You will see named ranges that are automatically added to the query, as shown in the following image.
Named ranges are added to the entire data table. The named range for the entire data table is QDATA1.

10. Select QDATA1 from the Name Box. The data in the table is automatically highlighted.

Ribbon Command Reference

The ribbon is contextual and changes depending on the type of file that you are developing. This topic describes each of the available ribbons and commands for each InfoAssist tool.

Ribbon Commands for Reports

When creating and customizing reports in Report mode, you can use the following ribbons and commands to customize report functionality.

Home Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Format Group</strong></td>
<td></td>
</tr>
<tr>
<td>Output File Format</td>
<td>Displays a drop-down menu of all supported output formats.</td>
</tr>
<tr>
<td>Chart</td>
<td>Switches to Chart mode. Converts a report to a chart using the fields specified in the report.</td>
</tr>
<tr>
<td>Report</td>
<td>Indicates that you are in Report mode.</td>
</tr>
<tr>
<td>File</td>
<td>Creates a data file from a report.</td>
</tr>
<tr>
<td><strong>Design Group</strong></td>
<td></td>
</tr>
<tr>
<td>Query (Design view)</td>
<td>Displays the Data, Query, and Filter panes across the entire canvas, eliminating Live Preview. This view provides a larger work area for creating the report.</td>
</tr>
<tr>
<td>Live Preview (Design view)</td>
<td>Displays the report on the canvas as you create the report. You can use the Live Preview to add, remove, and arrange fields, as well as style the report.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Document (Design view)</td>
<td>Converts a report into a document. Opens the document on canvas, which you can use to add text, images, lines, reports, and charts to create documents.</td>
</tr>
<tr>
<td>Data from Source</td>
<td>Uses the selected data source to display a live preview of the output on the canvas.</td>
</tr>
<tr>
<td>Use Sample Data</td>
<td>Displays sample data, which reduces processing time by eliminating the need to access the actual data source.</td>
</tr>
<tr>
<td>Records</td>
<td>Limits the number of rows retrieved from the data source when Live Preview is selected. This feature is useful in reducing response time if you are working with a large amount of data. Type the number of rows that you want directly in the Records field, or use the drop-down menu to select one of the preset record limits. The preset choices are All rows, 1, 10, 50, 100, 500, 1000, 2000, 5000, and 10000.</td>
</tr>
</tbody>
</table>

**Filter Group**

<table>
<thead>
<tr>
<th>Filter</th>
<th>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude</td>
<td>Turns off a filter.</td>
</tr>
<tr>
<td>Include</td>
<td>Turns on a filter.</td>
</tr>
</tbody>
</table>

**Report Group**

| Theme                | Opens a dialog box where you can select a theme to style your report or chart. You can use the default style sheet by clicking the Use Default Stylesheet button.  
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>You can also select a document styling theme or an application theme to style all reports created. Use the Environment and Styling section of the Options window, which is accessible by clicking Options in the Application main menu.</td>
</tr>
</tbody>
</table>
### Command Description

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Style</strong></td>
<td>Opens a Report Style dialog box for applying global styling to the entire report. For more information about styling reports, see <em>Styling Reports</em> on page 740.</td>
</tr>
<tr>
<td><strong>Banded</strong></td>
<td>Opens a Color dialog box for choosing a color that provides an alternating color scheme for the report. The report output displays alternating rows of data, using a white background for one row and a background of the selected color for the next row. This pattern continues throughout the report.</td>
</tr>
<tr>
<td><strong>Header &amp; Footer</strong></td>
<td>Opens the Header &amp; Footer dialog box, from which you can add and style headings and footings.</td>
</tr>
<tr>
<td><strong>Column Totals</strong></td>
<td>Adds a grand total row to the bottom of the report to sum numeric data in each column.</td>
</tr>
<tr>
<td><strong>Row Totals</strong></td>
<td>Adds a grand total column to the right side of the report to sum numeric data in each row.</td>
</tr>
</tbody>
</table>

### Format Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Destination Group</strong></td>
<td></td>
</tr>
<tr>
<td>InfoMini</td>
<td>Enables the creation of an InfoMini application. For more information on using InfoMini, see <em>Building InfoMini Applications</em> on page 593.</td>
</tr>
<tr>
<td>Chart</td>
<td>Switches to Chart mode. Converts a report to a chart using the fields specified in the report.</td>
</tr>
<tr>
<td>Report</td>
<td>Indicates that you are in Report mode.</td>
</tr>
<tr>
<td>File</td>
<td>Creates a data file from a report.</td>
</tr>
</tbody>
</table>

### Navigation Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Table</td>
<td>Generates standard browser output. This is the default.</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>Generates output by displaying a table of contents icon in the upper-left corner where report output typically appears. Clicking Table of Contents opens a menu that enables you to select (view) individual values of the first Sort By (By) field, one value at a time.</td>
</tr>
<tr>
<td></td>
<td>You can also select options to view the entire report or remove the table of contents.</td>
</tr>
<tr>
<td>Freeze</td>
<td>Generates output with column titles that freeze (remain in view) when you scroll through pages of the report output.</td>
</tr>
<tr>
<td>Pages On Demand</td>
<td>Provides access to two distinct features, depending upon the output type that you have selected.</td>
</tr>
</tbody>
</table>

### Features Group

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Popup</td>
<td>Displays pop-up titles when the mouse pointer hovers over a column title in the report output.</td>
</tr>
<tr>
<td>Accordion</td>
<td>Creates expandable views of data for each vertical sort field. This option displays data values only for the first vertical sort field when you first view the output. You can manually expand your view to expose the data values of lower-level sort fields.</td>
</tr>
<tr>
<td>Repeat Sort Value</td>
<td>Displays all repeated sort values instead of blanks in the output after the first instance of a new sort value, which is the default behavior.</td>
</tr>
<tr>
<td>Stack Measures</td>
<td>Displays all numeric measure field names in a column of the report output with the corresponding numeric data values.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>active report Options</td>
<td>Opens the active report options dialog box where you can configure your active report options such as menu items, graph engine, and colors. For more information, see <em>Using Active Technologies</em> on page 507.</td>
</tr>
<tr>
<td>Accessibility</td>
<td>Allows a title to be added to a report, chart, or document that is Section 508-compliant.</td>
</tr>
<tr>
<td>Run with Group</td>
<td></td>
</tr>
<tr>
<td>Auto Drill</td>
<td>Enables you to navigate through different levels within the dimension hierarchy of your data source. Click <em>Auto Drill</em> to enable the functionality. For more information, see <em>Using Auto Drill</em> on page 839.</td>
</tr>
<tr>
<td>Auto Linking Group</td>
<td></td>
</tr>
<tr>
<td>Enable Auto Linking</td>
<td>Enables auto linking. For more information, see <em>Using the Auto Linking Feature to Link Content</em> on page 841.</td>
</tr>
<tr>
<td>Auto Link Target</td>
<td>Sets procedure as an available target for auto linking.</td>
</tr>
<tr>
<td>Data Tab</td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>Calculation Group</td>
<td></td>
</tr>
<tr>
<td>Detail (Define)</td>
<td>Opens the Detail Field (DEFINE) dialog box, where you can create a defined field, type a name for the field, and enter a format. A Define field is an optional attribute used to create a virtual field for reporting. You can derive the virtual field value from information already in the data source (that is, from permanent fields).</td>
</tr>
<tr>
<td>Summary (Compute)</td>
<td>Opens the Summary Field (COMPUTE) dialog box, where you can create a computed field, type a name for the field, and enter a format.</td>
</tr>
</tbody>
</table>
### Join Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Join</td>
<td>Opens the Join dialog box, where you can create a new join, edit or delete existing joins, and add data sources to a join.</td>
</tr>
</tbody>
</table>

### Filter Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</td>
</tr>
</tbody>
</table>

### Display Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Missing Data</td>
<td>This option is disabled for reports.</td>
</tr>
</tbody>
</table>

### Data Source Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Opens the Open dialog box, where you can add additional data sources to a document, enabling you to insert reports from different data sources into the same document. This option is activated when you add a HOLD file. This option is unavailable, by default.</td>
</tr>
<tr>
<td>Switch</td>
<td>Opens a drop-down list of all the data sources that have been added. You can choose which data source is currently active and being used to create new reports. This option is activated when you add a HOLD file. This option is unavailable, by default.</td>
</tr>
</tbody>
</table>

### Slicers Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Group</td>
<td>Creates a new group of similar slicers.</td>
</tr>
<tr>
<td>Clear Slicers</td>
<td>Resets all slicers so that no filtering is done.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Update Preview</td>
<td>Applies slicers to preview.</td>
</tr>
<tr>
<td>Options</td>
<td>Opens the Edit Slicers dialog box to the General tab, where you can set general options for your slicers.</td>
</tr>
<tr>
<td>Record Limit Group</td>
<td></td>
</tr>
<tr>
<td>Preview</td>
<td>Sets the number of records retrieved from the data source for preview.</td>
</tr>
<tr>
<td>Run Time</td>
<td>Sets the number of records retrieved at run time.</td>
</tr>
<tr>
<td>Record Limit</td>
<td>Opens the Edit Slicers dialog box to the Record Limit tab, where you can set record limits for your slicers.</td>
</tr>
<tr>
<td>Group Number Group</td>
<td></td>
</tr>
<tr>
<td>Group (n)</td>
<td>Contains a group for each Slicer group that is added. Group 1 is the default slicer group to which you can drag fields to create slicers. To access slicer group options, click Group (n) to open the Edit Slicers dialog box where you can rename the slicer group and modify the order of the slicers in the group.</td>
</tr>
</tbody>
</table>

### Layout Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Setup Group</td>
<td></td>
</tr>
<tr>
<td>Margins</td>
<td>Enables you to set margin values by choosing Normal (1 inch all around), Narrow (.5 inch all around), Moderate (.5 inch left or right), Wide (1.5 inch left or right), or Custom. Choosing Custom opens the Margins dialog box, where you can set specific margins as needed.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Enables you to set the orientation of your report to portrait or landscape.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Size</td>
<td>Enables you to select the size of the paper for printing output. You can choose A3, A4, A5, Letter, Tabloid, Legal, PowerPoint, or Large Size (34 x 44 Inches).</td>
</tr>
<tr>
<td>Units</td>
<td>Enables you to select the unit of measurement used for customizing the dimension fields of your report. You can choose Inches, Centimeters, or Points.</td>
</tr>
<tr>
<td>Page Numbers</td>
<td>Enables you to select page numbering options. You can choose one of the following:</td>
</tr>
<tr>
<td></td>
<td>- No Lead (no space for headers)</td>
</tr>
<tr>
<td></td>
<td>- On (page numbers only in headers)</td>
</tr>
<tr>
<td></td>
<td>- Off (space for headers, but no page numbering)</td>
</tr>
<tr>
<td></td>
<td>The Page Numbers value is overridden by header and footer text options.</td>
</tr>
<tr>
<td>Report Group</td>
<td></td>
</tr>
<tr>
<td>Cell Padding</td>
<td>Opens the Cell Padding dialog box, where you can set specific values to control the amount of space inserted between rows and columns in a report. For more information, see How to Use Cell Padding in a Report on page 749.</td>
</tr>
<tr>
<td>AutoFit</td>
<td>Limits the width of columns in a report to be no wider than the largest value in each column. AutoFit Column is selected, by default.</td>
</tr>
</tbody>
</table>

View Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Group</td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Query (Design view)</td>
<td>Displays the Data, Query, and Filter panes across the entire canvas, eliminating Live Preview. This view provides a larger work area for creating the report.</td>
</tr>
<tr>
<td>Live Preview (Design view)</td>
<td>Displays the report on the canvas as you create the report. You can use the Live Preview to add, remove, and arrange fields, as well as style the report.</td>
</tr>
<tr>
<td>Document (Design view)</td>
<td>Converts a report into a document. Opens the document on canvas, which you can use to add text, images, lines, reports, and charts to create documents.</td>
</tr>
<tr>
<td><strong>Show/Hide Group</strong></td>
<td></td>
</tr>
<tr>
<td>Resources</td>
<td>Minimizes the Resources panel and expands the size of the canvas to also occupy the area where the Resources panel typically appears. The canvas can display a preview of a report, output of a report, or the Query Design pane.</td>
</tr>
<tr>
<td><strong>Data Panel Group</strong></td>
<td></td>
</tr>
<tr>
<td>Logical</td>
<td>Displays the data source fields by type. This is the default view. The Logical view options include Title, Description, Field, and Alias.</td>
</tr>
<tr>
<td>List</td>
<td>Displays the data source fields in a tabular list format. This list contains a header row. You can sort fields differently by clicking a column header. The List view options include Title, Description, Field, Alias, Format, Segment, Filename, and Reference.</td>
</tr>
<tr>
<td>Structured</td>
<td>Displays the hierarchical structure of the data source files. The Structured view options include Title, Description, Field, and Alias.</td>
</tr>
<tr>
<td><strong>Query Panel Group</strong></td>
<td></td>
</tr>
<tr>
<td>Areas 2x2</td>
<td>Displays data in a two column by two-row grid.</td>
</tr>
<tr>
<td>Areas 1x4</td>
<td>Displays data in a one column by four-row grid.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Tree</strong></td>
<td>Displays data in a tree. This is the default.</td>
</tr>
<tr>
<td><strong>Output Window Group</strong></td>
<td></td>
</tr>
<tr>
<td>Arrange</td>
<td>Opens a drop-down menu where you can choose how to display multiple output windows. The options are Cascade, Tile Horizontally, and Tile Vertically.</td>
</tr>
<tr>
<td>Output Location</td>
<td>Opens a drop-down menu where you can choose how to direct new output. The options are Single tab (default), New Tab, Single Window, and New Window.</td>
</tr>
<tr>
<td>Switch Output</td>
<td>Opens a drop-down menu for choosing to view any active output window.</td>
</tr>
<tr>
<td><strong>Report Group</strong></td>
<td></td>
</tr>
<tr>
<td>Switch Report</td>
<td>Lists any active reports, charts, documents, and visuals to which you can switch.</td>
</tr>
<tr>
<td><strong>Field Tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Filter Group</strong></td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</td>
</tr>
<tr>
<td>Exclude</td>
<td>Removes, but does not delete, the filter from the report.</td>
</tr>
<tr>
<td>Include</td>
<td>Restores a filter that was previously excluded from a report.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Prompt</td>
<td>Opens the Create a filtering condition dialog box for creating an auto prompting parameter that you can select when you run a report. The Create a filtering condition dialog box is used to create both filters and auto prompting parameters. The following prompt options are available when Parameter is selected from the Type drop-down menu:</td>
</tr>
<tr>
<td></td>
<td>- <strong>Simple.</strong> This is used for prompts using Text Input. This is the default value.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Static.</strong> This is used for prompts using Selection. This option allows you to select multiple values at run time.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Dynamic.</strong> This is used for prompts using Data Values. This option allows you to select multiple values at run time.</td>
</tr>
<tr>
<td></td>
<td>- <strong>Optional.</strong> This is used for prompts using Single or Multiselect parameters.</td>
</tr>
<tr>
<td>Sort Group</td>
<td></td>
</tr>
<tr>
<td>Up</td>
<td>Sorts the selected field in ascending order. This option is activated when you click on a measure or dimension.</td>
</tr>
<tr>
<td>Down</td>
<td>Sorts the selected field in descending order. This option is activated when you click on a measure or dimension.</td>
</tr>
<tr>
<td>Rank</td>
<td>Inserts a rank column immediately to the left of the report if a Sort By field is selected. It also adds a rank column to the left of the Sort By field if a Measure field is selected. Ranking a Measure field results in two copies of the field, the original Measure field, and the Sort By field that is created during ranking. This option is activated when you click on a measure or dimension.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Group</td>
<td>Opens the Create a Group dialog box where you can create a group to combine values together. This option is activated when you click on a dimension.</td>
</tr>
<tr>
<td>Limit</td>
<td>Opens a drop-down menu that allows you to specify the number of unique values to display for a sort group that has been added. This option is activated when you click on a measure or dimension.</td>
</tr>
</tbody>
</table>

**Break Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Break</td>
<td>Starts a new page when the primary sort field changes. Clicking the drop-down icon enables you to select Reset Page Numbers, which allows you to reset page numbers on a page break to start at 1. This option is activated when you click on a dimension.</td>
</tr>
<tr>
<td>Line Break</td>
<td>Inserts a line in the report output when the primary sort field changes. This option is activated when you click on a dimension.</td>
</tr>
<tr>
<td>Subtotal</td>
<td>Inserts a line, total text (TOTAL FIELD Value), and subtotals for all numeric fields when the primary sort field changes. This option is activated when you click on a dimension.</td>
</tr>
<tr>
<td>Sub Header</td>
<td>Opens a dialog box where you can type text to add a subheading just below the column titles in the report output when the primary sort field changes. This option is activated when you click on a dimension.</td>
</tr>
<tr>
<td>Sub Footer</td>
<td>Opens a dialog box where you can type text to add a subfooting at the end of the data on each page of the report output when the primary sort field changes. This option is activated when you click on a dimension.</td>
</tr>
</tbody>
</table>

**Style Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>Opens the Font list, which you can use to change the font.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Font Size</td>
<td>Opens the Font Size list, which you can use to change the numeric value for the font size.</td>
</tr>
<tr>
<td>Font Color</td>
<td>Opens the Color dialog box, where you can select the font color.</td>
</tr>
<tr>
<td>Style Reset</td>
<td>Resets all settings to the default settings from the template.</td>
</tr>
<tr>
<td>Bold</td>
<td>Applies bold font formatting to the selected text.</td>
</tr>
<tr>
<td>Italic</td>
<td>Applies italic font formatting to the selected text.</td>
</tr>
<tr>
<td>Underline</td>
<td>Underlines the selected text.</td>
</tr>
<tr>
<td>Justify Left</td>
<td>Aligns the text to the left of the report.</td>
</tr>
<tr>
<td>Justify Center</td>
<td>Aligns the text to the center of the report.</td>
</tr>
<tr>
<td>Justify Right</td>
<td>Aligns the text to the right of the report.</td>
</tr>
<tr>
<td>Background Color</td>
<td>Opens the Color dialog box, where you can select the background color for the report.</td>
</tr>
<tr>
<td>Data Style</td>
<td>Styles only the data for the selected data source field.</td>
</tr>
<tr>
<td>Title Style</td>
<td>Styles only the column title for the selected data source field.</td>
</tr>
<tr>
<td>Data + Title</td>
<td>Styles both the data and the column title for the selected data source field.</td>
</tr>
</tbody>
</table>

**Format Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal</td>
<td>The default value for the data format of the selected measure is Decimal. Use the drop-down menu to select Alphanumeric, Integer, or More options to open the Field Format Options dialog box.</td>
</tr>
<tr>
<td>Change currency options</td>
<td>Changes the currency options for the selected field. This option is activated when you click on a measure.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Percent</td>
<td>Specifies the value of the field as a percentage. This option is activated when you click on a measure.</td>
</tr>
<tr>
<td>Comma</td>
<td>Specifies the use of commas for the selected field. This option is activated when you click on a measure.</td>
</tr>
<tr>
<td>Increase Decimal Places</td>
<td>Increases the number of decimal places that display for the selected field. This option is activated when you click on a measure.</td>
</tr>
<tr>
<td>Decrease Decimal Places</td>
<td>Decreases the number of decimal places that display for the selected field. This option is activated when you click on a measure.</td>
</tr>
<tr>
<td>Display Group</td>
<td></td>
</tr>
<tr>
<td>Hide Field</td>
<td>Allows you to hide a selected field.</td>
</tr>
<tr>
<td>Hide Missing</td>
<td>Allows you to hide fields that have no value.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Enables you to apply an aggregation function to a field in a report. Opens a drop-down menu of the following options: None (default), Sum, Average, Count, Count Distinct, Percent of Count, First Value, Last Value, Maximum, Minimum, Total, Percent, Row Percent, Median, Average Square.</td>
</tr>
<tr>
<td>Traffic Lights</td>
<td>Opens the Traffic Light Condition dialog box. From this dialog box, you can add new conditional styling by applying traffic light (and other) colors to a selected field in the output when the field meets specified criteria, modify existing conditional styling, and enable conditional drill-down.</td>
</tr>
<tr>
<td>Data Bars</td>
<td>Adds a data visualization column to the right of a selected numeric field. The column displays values in each row using horizontal bars that extend from left to right in varying lengths, depending on the corresponding data values.</td>
</tr>
</tbody>
</table>
**Command** | **Description**
--- | ---
Within | Allows you to use specific aggregation tasks at different report levels. You can use the Within phrase to manipulate display field values as they are aggregated within a sort group rather than a report column.

Column(s) | This option is disabled for reports.

**Links Group**

Drill Down | Opens the Drill Down dialog box, where you can configure a hyperlink or a drill-down procedure for the selected field. Clicking that field in the report output, at run time, redirects you to the URL you specified or executes the indicated procedure.

**Ribbon Commands for Charts**

When creating and customizing charts in Chart mode, you can use the following ribbons and commands to customize chart functionality.

**Home Tab**

**Command** | **Description**
--- | ---
**Format Group** | 
Output File Format | Displays a drop-down menu of all supported output formats.
Chart | Indicates that you are in Chart mode.
Report | Switches to Report mode. Converts a chart to a report using the fields specified in the chart.
File | Creates an image file from a chart. This option is disabled by default and is only enabled for HTML format.

**Design Group**
## Command Description

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Query (Design view)</td>
<td>Displays the Data, Query, and Filter panes across the entire canvas, eliminating Live Preview. This view provides a larger work area for creating the chart.</td>
</tr>
<tr>
<td>Live Preview (Design view)</td>
<td>Displays the chart on the canvas as you create the chart. You can use the Live Preview to add, remove, and arrange fields, as well as style the chart.</td>
</tr>
<tr>
<td>Document (Design view)</td>
<td>Opens the document on canvas, which you can use to add text, images, lines, reports, and charts to create documents.</td>
</tr>
<tr>
<td>Data from Source</td>
<td>Uses the selected data source to display a live preview of the output on the canvas.</td>
</tr>
<tr>
<td>Use Sample Data</td>
<td>Displays sample data, which reduces processing time by eliminating the need to access the actual data source.</td>
</tr>
<tr>
<td>Records</td>
<td>Limits the number of rows retrieved from the data source when Live Preview is selected. This feature is useful in reducing response time if you are working with a large amount of data. Type the number of rows that you want directly in the Records field, or use the drop-down menu to select one of the preset record limits. The preset choices are All rows, 1, 10, 50, 100, 500, 1000, 2000, 5000, and 10000.</td>
</tr>
</tbody>
</table>

### Filter Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</td>
</tr>
<tr>
<td>Exclude</td>
<td>Turns off a filter.</td>
</tr>
<tr>
<td>Include</td>
<td>Turns on a filter.</td>
</tr>
</tbody>
</table>

### Report Group
### Ribbon Command Reference

#### Command

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Theme</strong></td>
<td>Opens a dialog box where you can select a theme to style your report or chart. You can use the default style sheet by clicking the <em>Use Default Stylesheet</em> button. You can also select a document styling theme or an application theme to style all reports created. Use the Environment and Styling section of the Options window, which is accessible by clicking Options in the Application main menu.</td>
</tr>
<tr>
<td><strong>Style</strong></td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td><strong>Banded</strong></td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td><strong>Header &amp; Footer</strong></td>
<td>Opens the Header &amp; Footer dialog box, from which you can add and style headings and footings.</td>
</tr>
<tr>
<td><strong>Column Totals</strong></td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td><strong>Row Totals</strong></td>
<td>This option is disabled for charts.</td>
</tr>
</tbody>
</table>

#### Format Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Destination Group</strong></td>
<td>Enables the creation of an InfoMini application. For more information on using InfoMini, see <em>Building InfoMini Applications</em> on page 593.</td>
</tr>
<tr>
<td><strong>Chart</strong></td>
<td>Indicates that you are in Chart mode.</td>
</tr>
<tr>
<td><strong>Report</strong></td>
<td>Switches to Report mode. Converts a chart to a report using the fields specified in the chart.</td>
</tr>
<tr>
<td><strong>File</strong></td>
<td>Creates an image file from a chart. This option is disabled by default and is only enabled for HTML format.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Chart Types Group</strong></td>
<td></td>
</tr>
<tr>
<td>Bar</td>
<td>Changes the chart type to a bar chart.</td>
</tr>
<tr>
<td>Pie</td>
<td>Changes the chart type to a pie chart.</td>
</tr>
<tr>
<td>Line</td>
<td>Changes the chart type to a line chart.</td>
</tr>
<tr>
<td>Area</td>
<td>Changes the chart type to an area chart.</td>
</tr>
<tr>
<td>Scatter</td>
<td>Changes the chart type to a scatter chart.</td>
</tr>
<tr>
<td>Choropleth</td>
<td>Changes the chart type to a choropleth map.</td>
</tr>
<tr>
<td>Proportional Symbol</td>
<td>Changes the chart type to a proportional symbol (bubble) map.</td>
</tr>
<tr>
<td>Other</td>
<td>Opens the Select a chart dialog box. The chart types, depicted by icons, display on the left side of the dialog box. The first chart type represents the bar chart category, which is selected by default. When a chart type is selected, the dialog box displays thumbnail images of bar chart variations that are supported.</td>
</tr>
<tr>
<td><strong>Map Group</strong></td>
<td></td>
</tr>
<tr>
<td>Background</td>
<td>Provides terrain options and various other geographical views. This option only displays when a map is selected as the chart type.</td>
</tr>
<tr>
<td>Demographic Layers</td>
<td>Allows you to apply one or more pre-defined demographic layers, which can narrow the scope of your data using these underlying layers of demographic categorization. This option only displays when a map is selected as the chart type.</td>
</tr>
<tr>
<td>Reference Layers</td>
<td>Enables you to define one or more reference layers, which creates borders based on your geographical selection. This option only displays when a map is selected as the chart type.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Features Group</strong></td>
<td></td>
</tr>
<tr>
<td>3D Effect</td>
<td>Sets the three-dimensional view to on or off. The 3D Effect feature is disabled for 3D, stock, gauge, gauge thermometer, Pareto, spectral map, and funnel chart types. This is the default. This option is not available for maps.</td>
</tr>
<tr>
<td>Rotate</td>
<td>Toggles between a vertical display or horizontal display of a chart. For more information, see <em>How to Rotate a Chart</em> on page 826. The Rotate feature is disabled for pie, scatter, 3D, stock, gauge, gauge thermometer, Pareto, spectral map, and funnel chart types. This option is not available for maps.</td>
</tr>
<tr>
<td>Reference</td>
<td>Opens a drop-down menu that provides the Add Reference Line to Y-Axis and Add Reference Line to X-Axis options. Selecting one of these options opens the appropriate Reference Line dialog box, where you can set the specific X-axis or Y-axis value, type the text that you want, and position the reference line on a chart. For more information, see <em>How to Display a Static Reference Line</em> on page 827. The Reference feature is disabled for pie, 3D, stock, gauge, gauge thermometer, Pareto, spectral map, and funnel chart types. This option is not available for maps.</td>
</tr>
<tr>
<td>Annotate</td>
<td>Opens a drop-down menu that provides the Add an annotation option. Selecting this option opens the Annotation dialog box, where you can type the text that you want and position the annotation on a chart. For more information, see <em>How to Display Annotations</em> on page 830. The annotation option is not available in HTML5. This option is not available for maps.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Grid</td>
<td>Opens a drop-down menu allowing you to expand options for Horizontal or Vertical Gridlines. Both selections allow you to enable or disable Major and Minor Gridlines. Clicking More Options opens the Format Grid Lines dialog box. This option is not available for maps. For more information, see Formatting Gridlines on page 786.</td>
</tr>
<tr>
<td>Frame &amp; Background</td>
<td>Opens the Frame &amp; Background dialog box where you can edit the background style and frames for charts. The dialog contains different options depending on the chart type selected. For more information, see Formatting a Frame and a Background on page 805.</td>
</tr>
<tr>
<td>Gauges</td>
<td>Opens the Gauge dialog box where you can edit your gauge chart. This button is only available when a gauge chart type is selected. This option is not available for maps. For more information, see How to Style a Gauge Needle on page 822.</td>
</tr>
<tr>
<td>active report Options</td>
<td>Opens the active report options dialog box where you can configure your active report options, such as menu items, graph engine, and colors. This button is available when the output type is set to active report. This option is not available for maps.</td>
</tr>
<tr>
<td>Accessibility</td>
<td>Allows a title to be added to a report, chart, or document that is Section 508 compliant. This option is only available for reports and charts when the output type is HTML, HTML5, or PDF. For documents, the output type must be set to PDF. The chart features are unavailable when designing a chart that will be output in active report format. This option is not available for maps.</td>
</tr>
</tbody>
</table>

**Labels Group**
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axes</td>
<td>Opens a drop-down menu, where you can enable and rotate horizontal and vertical axis labels, and stagger horizontal axis labels. You can also edit the axis labels by clicking <em>More Horizontal Axis Options</em> or <em>More Vertical Axis Options</em>. For more information, see <em>Formatting Axis Labels</em> on page 796. This option is not available for maps.</td>
</tr>
<tr>
<td>Legend</td>
<td>Opens a drop-down menu, where you can select the Show Legend option to display the legend on the chart, or clear your selection to hide the legend, change the default legend position, and change the default legend orientation. For more information, see <em>Format Legend Dialog Box</em> on page 781.</td>
</tr>
</tbody>
</table>

**Interactive Group**

| Interactive Options | Opens the Interactive Options dialog box, which enables you to specify animation and mouse over effects in your chart. This option is only available for HTML5 and active outputs. This option is not available for maps. |

**Run with Group**

<table>
<thead>
<tr>
<th>Auto Drill</th>
<th>Enables you to navigate through different levels within the dimension hierarchy of your data source. Click <em>Auto Drill</em> to enable the functionality.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Note:</strong></td>
<td>Auto Drill functionality requires the specification of at least one dimension sort field in the request. For more information, see <em>Using Auto Drill</em> on page 839.</td>
</tr>
</tbody>
</table>
**Command** | **Description**
--- | ---
Insight | Enables you to activate Insight, a powerful visualization tool that allows for the interactive selection of measures and dimensions. This allows you to create dynamic charts in real-time. This feature is available in HTML5 Chart mode only. Click Insight to enable the feature, and then click Run to launch it. For more information, see *Using Insight to Analyze Dynamic Charts* on page 391.

**Auto Linking Group**

| Command | Description |
--- | --- |
Enable Auto Linking | Enables auto linking. |
Auto Link Target | Sets procedure as an available target for auto linking. |

**Data Tab**

**Calculation Group**

| Command | Description |
--- | --- |
Detail (Define) | Opens the Detail Field (DEFINE) dialog box, where you can create a defined field, type a name for the field, and enter a format. A Define field is an optional attribute used to create a virtual field for reporting. You can derive the virtual field value from information already in the data source (that is, from permanent fields). |

| Command | Description |
--- | --- |
Summary (Compute) | Opens the Summary Field (COMPUTE) dialog box, where you can create a computed field, type a name for the field, and enter a format. |

**Join Group**

| Command | Description |
--- | --- |
Join | Opens the Join dialog box, where you can create a new join, edit or delete existing joins, and add data sources to a join. |

**Filter Group**
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box, enabling you to set filtering options. Filter options include Where, Where Total, the And conjunction, and the Or conjunctions in a single expression.</td>
</tr>
<tr>
<td>Display Group</td>
<td></td>
</tr>
<tr>
<td>Missing Data</td>
<td>Includes options for how to display missing values in charts.</td>
</tr>
<tr>
<td>Data Source Group</td>
<td></td>
</tr>
<tr>
<td>Add</td>
<td>Opens the Open dialog box, where you can add additional data sources to a document, enabling you to insert reports from different data sources into the same document. This option is only enabled if the chart was created from a HOLD file.</td>
</tr>
<tr>
<td>Switch</td>
<td>Opens a drop-down list of all the data sources that have been added. You can choose which data source is currently active and being used to create new reports. This option is only enabled if the chart was created from a HOLD file.</td>
</tr>
</tbody>
</table>

**Slicers Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Options Group</td>
<td></td>
</tr>
<tr>
<td>New Group</td>
<td>Creates a new group of similar slicers.</td>
</tr>
<tr>
<td>Clear Slicers</td>
<td>Resets all slicers so that no filtering is done.</td>
</tr>
<tr>
<td>Update Preview</td>
<td>Applies slicers to preview.</td>
</tr>
<tr>
<td>Options</td>
<td>Opens the Edit Slicers dialog box to the General tab, where you can set general options for your slicers.</td>
</tr>
</tbody>
</table>
### Command Description

#### Record Limit Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>Sets the number of records retrieved from the data source for preview.</td>
</tr>
<tr>
<td>Run Time</td>
<td>Sets the number of records retrieved at run time.</td>
</tr>
<tr>
<td>Record Limit</td>
<td>Opens the Edit Slicers dialog box to the Record Limit tab, where you can set record limits for your slicers.</td>
</tr>
</tbody>
</table>

#### Group Number Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Group n</td>
<td>Contains a group for each Slicer group that is added. Group 1 is the default slicer group to which you can drag fields to create slicers. To access slicer group options, click Group n to open the Edit Slicers dialog box where you can rename the slicer group and modify the order of the slicers in the group.</td>
</tr>
</tbody>
</table>

#### Layout Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Setup Group</td>
<td>Enables you to set margin values by choosing Normal (1 inch all around), Narrow (.5 inch all around), Moderate (.5 inch left or right), Wide (1.5 inch left or right), or Custom. Choosing Custom opens the Margins dialog box, where you can set specific margins as needed.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Enables you to set the orientation of your report to portrait or landscape.</td>
</tr>
<tr>
<td>Size</td>
<td>Enables you to select the size of the paper for printing output. You can choose A3, A4, A5, Letter, Tabloid, Legal, PowerPoint, or Large Size (34 x 44 Inches).</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Units</td>
<td>Enables you to select the unit of measurement used for customizing the dimension fields of your report or chart. You can choose Inches, Centimeters, or Points.</td>
</tr>
<tr>
<td>Page Numbers</td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td><strong>Size &amp; Arrange Group</strong></td>
<td></td>
</tr>
<tr>
<td>Height</td>
<td>Sets the height of the chart.</td>
</tr>
<tr>
<td>Width</td>
<td>Sets the width of the chart.</td>
</tr>
<tr>
<td>Auto Overflow</td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td>Aspect Ratio</td>
<td>Lock the height and width aspect ratio. With the aspect ratio locked, changing the width automatically changes the height to keep the component to scale, and changing the height automatically changes the width.</td>
</tr>
<tr>
<td>AutoFit</td>
<td>Expands the chart, at design time, when additional fields are added. At run time, the chart is resized dynamically to fit into the container in which it is placed. AutoFit is enabled, by default.</td>
</tr>
<tr>
<td>Align</td>
<td>This option is available in Document mode only.</td>
</tr>
<tr>
<td>Relative Position</td>
<td>This option is available in Document mode only.</td>
</tr>
</tbody>
</table>

**View Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Design Group</strong></td>
<td></td>
</tr>
<tr>
<td>Query (Design view)</td>
<td>Displays the Data, Query, and Filter panes across the entire canvas, eliminating Live Preview. This view provides a larger work area for creating the chart.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Live Preview (Design view)</td>
<td>Displays the chart on the canvas as you create the report. You can use the Live Preview to add, remove, and arrange fields, as well as style the chart.</td>
</tr>
<tr>
<td>Document (Design view)</td>
<td>Converts a chart into a document. Opens the document on canvas, which you can use to add text, images, lines, reports, and charts to create documents.</td>
</tr>
</tbody>
</table>

**Show/Hide Group**

| Resources                     | Minimizes the Resources panel and expands the size of the canvas to also occupy the area where the Resources panel typically appears. The canvas can display a preview of a report, output of a report, or the Query Design pane. |

**Data Panel Group**

| Logical                        | Displays the data source fields by type. This is the default view. The Logical view options include Title, Description, Field, and Alias. |
| List                           | Displays the data source fields in a tabular list format. This list contains a header row. You can sort fields differently by clicking a column header. The List view options include Title, Description, Field, Alias, Format, Segment, Filename, and Reference. |
| Structured                     | Displays the hierarchical structure of the data source files. The Structured view options include Title, Description, Field, and Alias. |

**Query Panel Group**

<p>| Areas 2x2                      | Displays data in a two column by two-row grid. This option is disabled for charts that use the new field container syntax. |
| Areas 1x4                      | Displays data in a one column by four-row grid. This option is disabled for charts that use the new field container syntax. |</p>
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tree</td>
<td>Displays data in a tree. This is the default.</td>
</tr>
</tbody>
</table>

**Output Window Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Arrange</td>
<td>Opens a drop-down menu where you can choose how to display multiple output windows. The options are Cascade, Tile Horizontally, and Tile Vertically.</td>
</tr>
<tr>
<td>Output Location</td>
<td>Opens a drop-down menu where you can choose how to direct new output. The options are Single tab (default), New Tab, Single Window, and New Window.</td>
</tr>
<tr>
<td>Switch Output</td>
<td>Opens a drop-down menu for choosing to view any active output window.</td>
</tr>
</tbody>
</table>

**Report Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch Report</td>
<td>Lists any active report or chart to which you can switch.</td>
</tr>
</tbody>
</table>

**Field Tab**

*Note:* The Format group is disabled in Chart mode.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</td>
</tr>
<tr>
<td>Exclude</td>
<td>Removes, but does not delete, the filter from the chart.</td>
</tr>
<tr>
<td>Include</td>
<td>Restores a filter that was previously excluded from a chart.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
<tr>
<td>Prompt</td>
<td>Opens the Create a filtering condition dialog box for creating an auto prompting parameter that you can select when you run a chart. The Create a filtering condition dialog box is used to create both filters and auto prompting parameters. The following prompt options are available when Parameter is selected from the Type drop-down menu:  &lt;ul&gt;&lt;li&gt;&lt;strong&gt;Simple&lt;/strong&gt;. This is used for prompts using Text Input. This is the default value.&lt;/li&gt;  &lt;li&gt;&lt;strong&gt;Static&lt;/strong&gt;. This is used for prompts using Selection. This option allows you to select multiple values at run time.&lt;/li&gt;  &lt;li&gt;&lt;strong&gt;Dynamic&lt;/strong&gt;. This is used for prompts using Data Values. This option allows you to select multiple values at run time.&lt;/li&gt;  &lt;li&gt;&lt;strong&gt;Optional&lt;/strong&gt;. This is used for prompts using Single or Multiselect parameters.&lt;/li&gt;&lt;/ul&gt;</td>
</tr>
<tr>
<td>Sort Group</td>
<td></td>
</tr>
<tr>
<td>Up</td>
<td>Sorts the selected field in ascending order.</td>
</tr>
<tr>
<td>Down</td>
<td>Sorts the selected field in descending order.</td>
</tr>
<tr>
<td>Rank</td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td>Group</td>
<td>Opens the Create a Group dialog box where you can create a group to combine values together. This option is enabled for dimension fields only.</td>
</tr>
<tr>
<td>Limit</td>
<td>Opens a drop-down menu that allows you to specify the number of unique values to display for a sort group that has been added.</td>
</tr>
</tbody>
</table>

**Note:** These options are disabled for charts.
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display Group</strong></td>
<td></td>
</tr>
<tr>
<td>Hide Field</td>
<td>Allows you to hide a selected field.</td>
</tr>
<tr>
<td>Hide Missing</td>
<td>Allows you to hide fields that have no value. This option is disabled for charts.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Opens a drop-down menu of the following options: None (default), Sum, Average, Count, Count Distinct, Percent of Count, First Value, Last Value, Maximum, Minimum, Total, Percent, Row Percent, Median, Average Square. This option is only available for measure fields or dimensions (alpha field only) that are in a numeric field container. Otherwise, aggregations will not display.</td>
</tr>
<tr>
<td>Traffic Lights</td>
<td>Opens the Traffic Light Condition dialog box. From this dialog box, you can add new conditional styling by applying traffic light (and other) colors to a selected field in the output when the field meets specified criteria, modify existing conditional styling, and enable conditional drill-down. This option is only available for measure fields.</td>
</tr>
<tr>
<td>Data Bars</td>
<td>This option is disabled for charts.</td>
</tr>
<tr>
<td>Within</td>
<td>Allows you to use specific aggregation tasks at different report levels. You can use the Within phrase to manipulate display field values as they are aggregated within a sort group rather than a report column. This option is disabled for charts.</td>
</tr>
<tr>
<td>Column(s)</td>
<td>Allows you to indicate the number of columns in which you wish to display multiple graphs. The value can be between 1 and 512. The default is 1. This option is also available from the Query Design pane shortcut menu for a Multi-graph component. This option is only enabled when the multi-graph field container is populated.</td>
</tr>
<tr>
<td><strong>Links Group</strong></td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Drill Down</td>
<td>Opens the Drill Down dialog box, where you can configure a hyperlink or a drill-down procedure for the selected field. Clicking that field in the report output, at run time, redirects you to the URL you specified or executes the indicated procedure. This option is available for measure fields only. If you are working in PDF format, this option is disabled.</td>
</tr>
</tbody>
</table>

**Series Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Group</td>
<td>Series drop-down list Lists the available series in the current chart.</td>
</tr>
</tbody>
</table>

**Style Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style</td>
<td>Opens the Format Series dialog box, where you can edit the styling options for the selected series. You can also open this dialog box by right-clicking a series, and then clicking More Style Options.</td>
</tr>
</tbody>
</table>

**Properties Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Labels</td>
<td>Adds data labels to the chart. The drop-down menu contains the following data position options for selecting where to display data values as labels on a chart: Above (default), On top edge, Below top edge, Center, and Base. If you are working with a Pie chart, the options are: On Slice, Outside Slice, and Outside with feeler lines. Clicking More Data Label Options opens the Format Labels dialog box, where you can further edit your data labels.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Type      | Opens a drop-down menu with the following options for selecting different chart types: None (default), Bar, Line, and Area.  
**Note:** When you make a change to the chart type using the Type button on the Series tab, changes to the chart type on the Format tab are overwritten. |
| Trendline | Opens a drop-down menu that provides options for adding a trendline to a chart.                                                               |
| Equation  | Displays the associated mathematical equation for the selected trendline on the chart. The equation is not available in HTML5.               |

**Line Group**

| Smooth Line | Draws the chart using smooth lines.                                                                                                           |
| Connect Lines | Controls the display of connecting lines between markers on a line or scatter chart. By default, lines are connected on a line chart and disconnected on a scatter chart. |
| Marker      | Opens a drop-down menu from which you can select options to change the display of the default data and legend markers on line and scatter chart types. For more information, see *How to Change the Appearance of a Marker* on page 768. |

**Pie Group**

**Note:** The following options are only enabled when you are working with a pie chart.

| Expand | Expands pie slices.                                                                 |
| Hide   | Hides pie slices.                                                                 |
Ribbon Commands for Documents

When creating and customizing documents in Document mode, you can use the following ribbons and commands to customize document functionality.

**Home Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Format Group</strong></td>
<td></td>
</tr>
<tr>
<td>Output File Format</td>
<td>Displays a drop-down menu of all supported output formats.</td>
</tr>
<tr>
<td>Chart</td>
<td>Determines whether chart-specific functionality is available in the InfoAssist tool. The default name Chart (data source) is given for each new chart created in a given InfoAssist session, where data source is the name of the underlying data source you are using. You can rename the chart by right-clicking Chart in the Query pane and clicking Rename.</td>
</tr>
<tr>
<td>Report</td>
<td>Determines whether report-specific functionality is available in the InfoAssist tool. The default name Report (data source) is given for each new report created in a given InfoAssist session, where data source is the name of the underlying data source you are using. You can rename the report by right-clicking Report in the Query pane and clicking Rename.</td>
</tr>
<tr>
<td>File</td>
<td>Creates a data file from a report component of a document.</td>
</tr>
<tr>
<td><strong>Design Group</strong></td>
<td></td>
</tr>
<tr>
<td>Query (Design view)</td>
<td>This option is disabled in Document mode.</td>
</tr>
<tr>
<td>Live Preview (Design view)</td>
<td>This option is disabled in Document mode.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Document (Design view)</td>
<td>Once you are in Document mode, it is selected by default in the Design group. The document displays on the canvas, to which you can add text, images, lines, reports, and charts.</td>
</tr>
<tr>
<td>Data from Source</td>
<td>Uses the selected data source to display a live preview of the output on the canvas.</td>
</tr>
<tr>
<td>Use Sample Data</td>
<td>Displays sample data, which reduces processing time by eliminating the need to access the actual data source.</td>
</tr>
<tr>
<td>Records</td>
<td>Limits the number of rows retrieved from the data source when Live Preview is selected. This feature is useful in reducing response time if you are working with a large amount of data. Type the number of rows that you want directly in the Records field, or use the drop-down menu to select one of the preset record limits. The preset choices are All rows, 1, 10, 50, 100, 500, 1000, 2000, 5000, and 10000.</td>
</tr>
</tbody>
</table>

**Filter Group**

<table>
<thead>
<tr>
<th>Filter</th>
<th>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude</td>
<td>Turns off a filter.</td>
</tr>
<tr>
<td>Include</td>
<td>Turns on a filter.</td>
</tr>
</tbody>
</table>

**Clipboard Group**

<table>
<thead>
<tr>
<th>Paste</th>
<th>Enables you to paste a text, report, or chart object that you have copied to or placed on the clipboard.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cut</td>
<td>Enables you to cut a text, report, or chart object from your document, placing it on the clipboard.</td>
</tr>
<tr>
<td>Copy</td>
<td>Enables you to copy a text, report, or chart object to the clipboard.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Enables you to duplicate a text, report, or chart object in your document, placing it on the clipboard.</td>
</tr>
<tr>
<td><strong>Report Group</strong></td>
<td></td>
</tr>
<tr>
<td>Theme</td>
<td>Opens a dialog box where you can select a theme to style your report or chart. You can use the default style sheet by clicking the <em>Use Default Stylesheet</em> button. You can also select a document styling theme or an application theme to style all reports created. Use the Environment and Styling section of the Options window, which is accessible by clicking <em>Options</em> in the Application main menu.</td>
</tr>
<tr>
<td>Style</td>
<td>Opens a Report Style dialog box for applying global styling to the entire report. This option is disabled for charts in Document mode. For more information about styling reports, see <em>Styling Reports</em> on page 740.</td>
</tr>
<tr>
<td>Banded</td>
<td>Opens a Color dialog box for choosing a color that provides an alternating color scheme for the report. The report output displays alternating rows of data, using a white background for one row and a background of the selected color for the next row. This pattern continues throughout the report. This option is disabled for charts in Document mode.</td>
</tr>
<tr>
<td>Header &amp; Footer</td>
<td>Opens the Header &amp; Footer dialog box, from which you can add and style headings and footings.</td>
</tr>
<tr>
<td>Column Totals</td>
<td>Adds a grand total row to the bottom of the report to sum numeric data in each column. This option is disabled for charts in Document mode.</td>
</tr>
<tr>
<td>Row Totals</td>
<td>Adds a grand total column to the right side of the report to sum numeric data in each row. This option is disabled for charts in Document mode.</td>
</tr>
</tbody>
</table>
**Insert Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Pages Group</strong></td>
<td></td>
</tr>
<tr>
<td>Page</td>
<td>Adds a new page to a document.</td>
</tr>
<tr>
<td><strong>Reports Group</strong></td>
<td></td>
</tr>
<tr>
<td>Report</td>
<td>Inserts a report placeholder on the canvas.</td>
</tr>
<tr>
<td>Chart</td>
<td>Inserts a chart placeholder on the canvas.</td>
</tr>
<tr>
<td>Existing Report</td>
<td>Opens the Open dialog box, where you can browse to the report that you want to insert in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td><strong>Objects Group</strong></td>
<td></td>
</tr>
<tr>
<td>Text Box</td>
<td>Inserts an inline text object in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td>Image</td>
<td>Opens the Open dialog box, where you can browse to the image that you want to insert in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td><strong>active dashboard Prompts group</strong></td>
<td></td>
</tr>
<tr>
<td>Drop Down</td>
<td>Inserts a drop-down control placeholder in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td>List</td>
<td>Inserts a list control placeholder in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td>Checkbox</td>
<td>Inserts a check box control placeholder in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td>Radio Button</td>
<td>Inserts a radio button control placeholder in the upper-left corner of the canvas.</td>
</tr>
<tr>
<td>Text</td>
<td>Inserts a text area control placeholder in the upper-left corner of the canvas.</td>
</tr>
</tbody>
</table>
## Format Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Destination Group</strong></td>
<td></td>
</tr>
<tr>
<td>InfoMini</td>
<td>Enables the creation of an InfoMini application. For more information on using InfoMini, see <em>Building InfoMini Applications</em> on page 593.</td>
</tr>
<tr>
<td>Report</td>
<td>Makes report-specific functionality available. In Document mode, if you select a report object, the Report option is enabled on the Home tab and the ribbon options change. For more information, see <em>Ribbon Commands for Reports</em> on page 680.</td>
</tr>
<tr>
<td>Chart</td>
<td>Makes chart-specific functionality available. In Document mode, if you select a chart object, the Chart option is enabled on the Home tab and the ribbon options change. For more information, see <em>Ribbon Commands for Charts</em> on page 694.</td>
</tr>
<tr>
<td>File</td>
<td>Creates a data file from a report component of a document.</td>
</tr>
<tr>
<td><strong>Navigation Group</strong></td>
<td></td>
</tr>
<tr>
<td>Table</td>
<td>Generates standard browser output. This is the default. This option is only available for reports in Document mode.</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>Generates output by displaying a table of contents icon in the upper-left corner where report output typically appears. Clicking <em>Table of Contents</em> opens a menu that enables you to select (view) individual values of the first Sort By (By) field, one value at a time. You can also select options to view the entire report or remove the table of contents. This option is unavailable for charts in Document mode, and is disabled for reports in Document mode.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Freeze</td>
<td>Generates output with column titles that freeze (remain in view) when you scroll through pages of the report output. This option is unavailable for charts in Document mode, and is disabled for reports in Document mode.</td>
</tr>
<tr>
<td>Pages On Demand</td>
<td>Provides access to two distinct features depending upon the output type that you have selected. This option is available for reports in Document mode.</td>
</tr>
<tr>
<td><strong>Features Group</strong></td>
<td></td>
</tr>
<tr>
<td>Title Popup</td>
<td>Displays pop-up titles when the mouse pointer hovers over a column title in the report output.</td>
</tr>
<tr>
<td>Accordion</td>
<td>Creates expandable views of data for each vertical sort field. This option displays data values only for the first vertical sort field when you first view the output. You can manually expand your view to expose the data values of lower-level sort fields.</td>
</tr>
<tr>
<td>Repeat Sort Value</td>
<td>Displays all repeated sort values instead of blanks in the output after the first instance of a new sort value, which is the default behavior.</td>
</tr>
<tr>
<td>Stack Measures</td>
<td>Displays all numeric measure field names in a column of the report output with the corresponding numeric data values.</td>
</tr>
<tr>
<td>active report Options</td>
<td>Opens the active report options dialog box where you can configure your active report options such as menu items, graph engine, and colors. For more information, see <em>Using Active Technologies</em> on page 507.</td>
</tr>
<tr>
<td>Accessibility</td>
<td>Allows a title to be added to a report, chart, or document that is Section 508-compliant.</td>
</tr>
<tr>
<td><strong>Run with Group</strong></td>
<td></td>
</tr>
<tr>
<td>Auto Drill</td>
<td>This option is disabled in Document mode.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Insight</td>
<td>This option is disabled in Document mode.</td>
</tr>
</tbody>
</table>

## Data Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Calculation Group</strong></td>
<td></td>
</tr>
<tr>
<td>Detail (Define)</td>
<td>Opens the Detail Field (DEFINE) dialog box, where you can create a defined field, type a name for the field, and enter a format. A Define field is an optional attribute used to create a virtual field for reporting. You can derive the virtual field value from information already in the data source (that is, from permanent fields).</td>
</tr>
<tr>
<td>Summary (Compute)</td>
<td>Opens the Summary Field (COMPUTE) dialog box, where you can create a computed field, type a name for the field, and enter a format.</td>
</tr>
<tr>
<td><strong>Join Group</strong></td>
<td></td>
</tr>
<tr>
<td>Join</td>
<td>Opens the Join dialog box, where you can create a new join, edit or delete existing joins, and add data sources to a join.</td>
</tr>
<tr>
<td><strong>Filter Group</strong></td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box, enabling you to set filtering options. Filter options include Where, Where Total, the And conjunction, and the Or conjunctions in a single expression.</td>
</tr>
<tr>
<td><strong>Display Group</strong></td>
<td></td>
</tr>
<tr>
<td>Missing Data</td>
<td>Includes options for how to display missing values in charts.</td>
</tr>
</tbody>
</table>

## Data Source Group
### Command

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Opens the Open dialog box, where you can add additional data sources to a document, enabling you to insert reports from different data sources into the same document.</td>
</tr>
<tr>
<td>Switch</td>
<td>Opens a drop-down list of all the data sources that have been added. You can choose which data source is currently active and being used to create new reports.</td>
</tr>
</tbody>
</table>

### Slicers Tab

#### Command

<table>
<thead>
<tr>
<th>Group</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Options Group</strong></td>
<td></td>
</tr>
<tr>
<td>New Group</td>
<td>Creates a new group of similar slicers.</td>
</tr>
<tr>
<td>Clear Slicers</td>
<td>Resets all slicers so that no filtering is done.</td>
</tr>
<tr>
<td>Update Preview</td>
<td>Applies slicers to preview.</td>
</tr>
<tr>
<td><strong>Record Limit Group</strong></td>
<td></td>
</tr>
<tr>
<td>Preview</td>
<td>Sets the number of records retrieved from the data source for preview.</td>
</tr>
<tr>
<td>Run Time</td>
<td>Sets the number of records retrieved at run time.</td>
</tr>
<tr>
<td><strong>Group Number Group</strong></td>
<td></td>
</tr>
<tr>
<td>Group $n$</td>
<td>Contains a group for each Slicer group that is added. Group 1 is the default slicer group to which you can drag fields to create slicers.</td>
</tr>
</tbody>
</table>
## Layout Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Page Setup Group</strong></td>
<td></td>
</tr>
<tr>
<td>Margins</td>
<td>This option is disabled in Document mode.</td>
</tr>
<tr>
<td>Orientation</td>
<td>Enables you to set the orientation of your report to portrait or landscape.</td>
</tr>
<tr>
<td>Size</td>
<td>Enables you to select the size of the paper for printing output. You can choose A3, A4, A5, Letter, Tabloid, Legal, PowerPoint, or Large Size (34 x 44 Inches).</td>
</tr>
<tr>
<td>Units</td>
<td>Enables you to select the unit of measurement used for customizing the dimension fields of your report or chart. You can choose Inches, Centimeters, or Points.</td>
</tr>
<tr>
<td>Page Numbers</td>
<td>Enables you to select page numbering options. You can choose one of the following:</td>
</tr>
<tr>
<td></td>
<td>- No Lead (no space for headers)</td>
</tr>
<tr>
<td></td>
<td>- On (page numbers only in headers)</td>
</tr>
<tr>
<td></td>
<td>- Off (space for headers, but no page numbering)</td>
</tr>
<tr>
<td></td>
<td>The Page Numbers value is overridden by header and footer text options.</td>
</tr>
<tr>
<td>Adaptive Dashboard</td>
<td>Available on for Active Documents, allows you to create responsive content within a fixed layout designed to make the dashboard easier to use while navigating on mobile devices.</td>
</tr>
<tr>
<td><strong>Size &amp; Arrange Group</strong></td>
<td></td>
</tr>
<tr>
<td>Height</td>
<td>Sets the height of the selected document component.</td>
</tr>
<tr>
<td>Width</td>
<td>Sets the width of the selected document component.</td>
</tr>
<tr>
<td>Auto Overflow</td>
<td>Automatically expands the query area to show all data.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Aspect Ratio</td>
<td>Lock the height and width aspect ratio.</td>
</tr>
<tr>
<td>AutoFit</td>
<td>In Document mode, this option is disabled.</td>
</tr>
<tr>
<td>Align</td>
<td>Opens a drop-down menu of available alignment options, when two or more document components are selected.</td>
</tr>
<tr>
<td>Relative Position</td>
<td>Positions the top-left corner of the lower component, to the bottom-left corner of the higher component, when two or more document components are selected.</td>
</tr>
<tr>
<td>Size and Arrange</td>
<td>Opens the Size and Position dialog box where you can set size and position options for the object in your document.</td>
</tr>
</tbody>
</table>

### Report Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cell Padding</td>
<td>Opens the Cell Padding dialog box, where you can set specific values to control the amount of space inserted between rows and columns in a report. For more information, see <em>How to Use Cell Padding in a Report</em> on page 749.</td>
</tr>
<tr>
<td>Autofit Column</td>
<td>When working with a report component, this option automatically compresses the columns in the report to the width of the widest data instance. Autofit Column is selected, by default.</td>
</tr>
</tbody>
</table>

### View Tab

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Design Group</td>
<td></td>
</tr>
<tr>
<td>Query (Design view)</td>
<td>This option is unavailable in Document mode.</td>
</tr>
<tr>
<td>Live Preview (Design view)</td>
<td>This option is unavailable in Document mode.</td>
</tr>
<tr>
<td>Document</td>
<td>Enables Document mode by default.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Show/Hide Group</strong></td>
<td></td>
</tr>
<tr>
<td>Resources</td>
<td>Minimizes the Resources panel and expands the size of the canvas to also occupy the area where the Resources panel typically appears. The canvas can display a preview of a report, output of a report, or the Query Design pane.</td>
</tr>
<tr>
<td>Ruler</td>
<td>Displays a ruler above the canvas and to the left of the canvas for a document.</td>
</tr>
<tr>
<td>Grid</td>
<td>Displays a grid as a visual aid for aligning objects in a document.</td>
</tr>
<tr>
<td>Relationships</td>
<td>Shows the relative positioning relationship among objects.</td>
</tr>
<tr>
<td><strong>Data Panel Group</strong></td>
<td></td>
</tr>
<tr>
<td>Logical</td>
<td>Displays the data source fields by type. This is the default view. The Logical view options include Title, Description, Field, and Alias.</td>
</tr>
<tr>
<td>List</td>
<td>Displays the data source fields in a tabular list format. This list contains a header row. You can sort fields differently by clicking a column header. The List view options include Title, Description, Field, Alias, Format, Segment, Filename, and Reference.</td>
</tr>
<tr>
<td>Structured</td>
<td>Displays the hierarchical structure of the data source files. The Structured view options include Title, Description, Field, and Alias.</td>
</tr>
<tr>
<td><strong>Query Panel Group</strong></td>
<td></td>
</tr>
<tr>
<td>Areas 2x2</td>
<td>Displays data in a two column by two-row grid. When working with the new field container syntax, this option is unavailable.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Areas 1x4</td>
<td>Displays data in a one column by four-row grid. When working with the new field container syntax, this option is unavailable.</td>
</tr>
<tr>
<td>Tree</td>
<td>Displays data in a tree. This is the default.</td>
</tr>
<tr>
<td><strong>Output Window Group</strong></td>
<td></td>
</tr>
<tr>
<td>Arrange</td>
<td>Opens a drop-down menu where you can choose how to display multiple output windows. The options are Cascade, Tile Horizontally, and Tile Vertically.</td>
</tr>
<tr>
<td>Output Location</td>
<td>Opens a drop-down menu where you can choose how to direct new output. The options are Single tab (default), New Tab, Single Window, and New Window.</td>
</tr>
<tr>
<td>Switch Output</td>
<td>Opens a drop-down menu for choosing to view any active output window.</td>
</tr>
<tr>
<td><strong>Report Group</strong></td>
<td></td>
</tr>
<tr>
<td>Switch Report</td>
<td>Lists any active report or chart to which you can switch.</td>
</tr>
<tr>
<td><strong>Field Tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Filter Group</strong></td>
<td></td>
</tr>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</td>
</tr>
<tr>
<td>Exclude</td>
<td>Removes, but does not delete, the filter from the report or chart.</td>
</tr>
<tr>
<td>Include</td>
<td>Restores a filter that was previously excluded from a report or chart.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>---------</td>
<td>-------------</td>
</tr>
</tbody>
</table>
| Prompt  | Opens the Create a filtering condition dialog box for creating an auto prompting parameter that you can select when you run a report. The Create a filtering condition dialog box is used to create both filters and auto prompting parameters. The following prompt options are available when Parameter is selected from the Type drop-down menu:  

- **Simple.** This is used for prompts using Text Input. This is the default value.  
- **Static.** This is used for prompts using Selection. This option allows you to select multiple values at run time.  
- **Dynamic.** This is used for prompts using Data Values. This option allows you to select multiple values at run time.  
- **Optional.** This is used for prompts using Single or Multiselect parameters. |

<table>
<thead>
<tr>
<th>Sort Group</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Up</td>
<td>Sorts the selected field in ascending order.</td>
</tr>
<tr>
<td>Down</td>
<td>Sorts the selected field in descending order.</td>
</tr>
<tr>
<td>Rank</td>
<td>Inserts a rank column immediately to the left of the report if a Sort By field is selected. It also adds a rank column to the left of the Sort By field if a Measure field is selected. Ranking a Measure field results in two copies of the field, the original Measure field, and the Sort By field that is created during ranking.</td>
</tr>
<tr>
<td>Group</td>
<td>Opens the Create a Group dialog box where you can create a group to combine values together.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-----------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Limit</td>
<td>Opens a drop-down menu that allows you to specify the number of unique values to display for a sort group that has been added.</td>
</tr>
</tbody>
</table>

**Break Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Page Break</td>
<td>Starts a new page when the primary sort field changes. Clicking the drop-down icon enables you to select Reset Page Numbers, which allows you to reset page numbers on a page break to start at 1.</td>
</tr>
<tr>
<td>Line Break</td>
<td>Inserts a line in the report output when the primary sort field changes.</td>
</tr>
<tr>
<td>Subtotal</td>
<td>Inserts a line, total text (TOTAL FIELD Value), and subtotals for all numeric fields when the primary sort field changes.</td>
</tr>
<tr>
<td>Sub Header</td>
<td>Opens a dialog box where you can type text to add a subheading just below the column titles in the report output when the primary sort field changes.</td>
</tr>
<tr>
<td>Sub Footer</td>
<td>Opens a dialog box where you can type text to add a subfooting at the end of the data on each page of the report output when the primary sort field changes.</td>
</tr>
</tbody>
</table>

**Style Group**

**Note:** The options in this group are only available for reports in Document mode.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Font</td>
<td>Opens the Font list, which you can use to change the font.</td>
</tr>
<tr>
<td>Font Size</td>
<td>Opens the Font Size list, which you can use to change the numeric value for the font size.</td>
</tr>
<tr>
<td>Font Color</td>
<td>Opens the Color dialog box, where you can select the font color.</td>
</tr>
<tr>
<td>Style Reset</td>
<td>Resets all settings to the default settings from the template.</td>
</tr>
<tr>
<td><strong>Command</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>------------------</td>
<td>---------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bold</td>
<td>Applies bold font formatting to the selected text.</td>
</tr>
<tr>
<td>Italic</td>
<td>Applies italic font formatting to the selected text.</td>
</tr>
<tr>
<td>Underline</td>
<td>Underlines the selected text.</td>
</tr>
<tr>
<td>Justify Left</td>
<td>Aligns the text to the left of the visual.</td>
</tr>
<tr>
<td>Justify Center</td>
<td>Aligns the text to the center of the visual.</td>
</tr>
<tr>
<td>Justify Right</td>
<td>Aligns the text to the right of the visual.</td>
</tr>
<tr>
<td>Background Color</td>
<td>Opens the Color dialog box, where you can select the background color for the visual.</td>
</tr>
<tr>
<td>Data Style</td>
<td>Styles only the data for the selected data source field.</td>
</tr>
<tr>
<td>Title Style</td>
<td>Styles only the column title for the selected data source field.</td>
</tr>
<tr>
<td>Data + Title</td>
<td>Styles both the data and the column title for the selected data source field.</td>
</tr>
</tbody>
</table>

**Format Group**

**Note:** The options in this group are only available for reports in Document mode.

<table>
<thead>
<tr>
<th><strong>Change currency options</strong></th>
<th>Changes the currency options for the selected field.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Percent</td>
<td>Specifies the value of the field as a percentage.</td>
</tr>
<tr>
<td>Comma</td>
<td>Specifies the use of commas for the selected field.</td>
</tr>
<tr>
<td>Increase Decimal Places</td>
<td>Increases the number of decimal places that display for the selected field.</td>
</tr>
<tr>
<td>Decrease Decimal Places</td>
<td>Decreases the number of decimal places that display for the selected field.</td>
</tr>
</tbody>
</table>

**Display Group**

<table>
<thead>
<tr>
<th><strong>Hide Field</strong></th>
<th>Allows you to hide a selected field.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Command</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Hide Missing</td>
<td>Allows you to hide fields that have no value.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Opens a drop-down menu of the following options: None (default), Sum, Average, Count, Count Distinct, Percent of Count, First Value, Last Value, Maximum, Minimum, Total, Percent, Row Percent, Median, Average Square.</td>
</tr>
<tr>
<td>Traffic Lights</td>
<td>Opens the Traffic Light Condition dialog box. From this dialog box, you can add new conditional styling by applying traffic light (and other) colors to a selected field in the output when the field meets specified criteria, modify existing conditional styling, and enable conditional drill-down.</td>
</tr>
<tr>
<td>Within</td>
<td>Allows you to use specific aggregation tasks at different report levels. You can use the Within phrase to manipulate display field values as they are aggregated within a sort group rather than a report column.</td>
</tr>
<tr>
<td>Data Bars</td>
<td>Adds a data visualization column to the right of a selected numeric field. The column displays values in each row using horizontal bars that extend from left to right in varying lengths, depending on the corresponding data values.</td>
</tr>
<tr>
<td>Column(s)</td>
<td>Allows you to indicate the number of columns in which you wish to display multiple graphs. The value can be between 1 and 512. The default is 1. This option is also available from the Query Design pane shortcut menu for a Multi-graph component.</td>
</tr>
</tbody>
</table>

**Links Group**
## Command | Description
--- | ---
Drill Down | Opens the Drill Down dialog box, where you can configure a hyperlink or a drill-down procedure for the selected field. Clicking that field in the report output, at run time, redirects you to the URL you specified or executes the indicated procedure. This option is disabled in Document mode.

### Series Tab
In Document mode, the Series tab is enabled for chart components.

## Command | Description
--- | ---
Select Group |  
Series drop-down list | Lists the available series in the current chart.

### Style Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style</td>
<td>Opens the Format Series dialog box, where you can edit the styling options for the selected series. You can also open this dialog box by right-clicking a series, and then clicking <strong>More Style Options</strong>.</td>
</tr>
</tbody>
</table>

### Properties Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Labels</td>
<td>Adds data labels to the chart. The drop-down menu contains the following data position options for selecting where to display data values as labels on a chart: Above (default), On top edge, Below top edge, Center, and Base. If you are working with a Pie chart, the options are: On Slice, Outside Slice, and Outside with feeler lines. Clicking <strong>More Data Label Options</strong> opens the Format Labels dialog box, where you can further edit your data labels.</td>
</tr>
<tr>
<td>Trendline</td>
<td>Opens a drop-down menu that provides options for adding a trendline to a chart.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Line Group</strong></td>
<td></td>
</tr>
<tr>
<td>Smooth Line</td>
<td>Draws the chart using smooth lines.</td>
</tr>
<tr>
<td>Connect Lines</td>
<td>Controls the display of connecting lines between markers on a line or scatter chart. By default, lines are connected on a line chart and disconnected on a scatter chart.</td>
</tr>
<tr>
<td>Marker</td>
<td>Opens a drop-down menu from which you can select options to change the display of the default data and legend markers on line and scatter chart types. For more information, see <em>How to Change the Appearance of a Marker</em> on page 768.</td>
</tr>
<tr>
<td><strong>Pie group</strong></td>
<td></td>
</tr>
<tr>
<td>Note: The following options are only enabled when you are working with a pie chart.</td>
<td></td>
</tr>
<tr>
<td>Expand</td>
<td>Expands pie slices.</td>
</tr>
<tr>
<td>Hide</td>
<td>Hides pie slices.</td>
</tr>
</tbody>
</table>

**Ribbon Commands for Visualizations**

When creating and customizing visualizations in Visualizations mode, you can use the following ribbons and commands to customize visualization functionality.

**Home Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Clipboard Group</strong></td>
<td></td>
</tr>
<tr>
<td>Paste</td>
<td>Enables you to paste a text, report, or chart object that you have copied to or placed on the clipboard.</td>
</tr>
<tr>
<td>Cut</td>
<td>Enables you to cut a text, report, or chart object from your document, placing it on the clipboard.</td>
</tr>
<tr>
<td>Command</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Copy</td>
<td>Enables you to copy a text, report, or chart object to the clipboard.</td>
</tr>
<tr>
<td>Duplicate</td>
<td>Enables you to duplicate a text, report, or chart object in your document, placing it on the clipboard.</td>
</tr>
<tr>
<td><strong>Data Group</strong></td>
<td></td>
</tr>
<tr>
<td>Calculation</td>
<td>Opens a menu from which you can choose to create Define or Compute fields.</td>
</tr>
<tr>
<td>Join</td>
<td>Opens the Join dialog box, where you can create a new join, edit or delete existing joins, and add data sources to a join. You can also create blends, which allow you to combine data from local or system resources into your current data source.</td>
</tr>
<tr>
<td><strong>Visual Group</strong></td>
<td></td>
</tr>
<tr>
<td>Insert</td>
<td>Inserts a new visual. The left side of the Insert button inserts the default visual, which is a stacked bar chart. Click the down arrow next to the Insert button to specify a visual type, such as a chart, grid, or text.</td>
</tr>
<tr>
<td>Change</td>
<td>Opens the Select a Visual menu, from which you can select the type of chart, map, or grid that you want to add to your visualization.</td>
</tr>
<tr>
<td><strong>Command</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------</td>
</tr>
</tbody>
</table>
| **Swap**    | Changes the vertical or horizontal orientation of data in a visual. When you add one or more fields to the canvas, Swap is enabled. When you have data fields in the vertical and horizontal field containers, clicking Swap switches the axis of these data fields to display on the opposite axis. When working with matrix charts, the rows and columns are similarly switched when you click Swap. Swap is available for bar, line, area, scatter, bubble, and matrix marker charts. It is also available for grids.  

**Note:**  
- Swap is disabled when the canvas is empty.  
- Swap is unavailable for maps. |
| **Clear**   | Clears the current visual. You can use the split button to select the option to clear a component, or the entire visualization, which clears all visuals on the canvas. If you have created a filter, you can also clear it. The Clear button is disabled until you begin developing a visual on the canvas. |
| **Storyboard Group** | |
| **Add**   | Takes a snapshot of the current visual or visualization, adding it to the storyboard. |
| **Show**  | Opens your storyboard as a PowerPoint presentation, where you can choose to view or save your storyboard. All storyboards display in Microsoft PowerPoint format. |
| **Format Tab** | |
| **Command** | **Description** |
| **Report Group** | |
### Command | Description
--- | ---
Theme | Opens the Templates dialog box, where you can select a theme to style your grid. You can use the default style sheet by clicking the *Use Default Stylesheet* button. You can also select a styling theme for your grid or an application theme to style all visualizations created.
Header & Footer | Opens the Header & Footer dialog box, from which you can add and style headings and footings.
Column Totals | Adds a grand total row to the bottom of the grid object to sum numeric data in each column.

**Features Group**

**Note:** These options do not display for grids or maps, with the exception of Frame & Background.

Reference | Opens the reference menu, where you can access the Add Reference Line to Y-Axis and Add Reference Line to X-Axis options. Selecting one of these options opens the Reference Line dialog box, where you can set the following: the X-axis or Y-axis value, the text that you want to appear, and the position of the reference line on a chart.
Grid | Opens the grid menu, where you can access the Horizontal or Vertical Gridlines options. Both selections allow you to enable or disable Major and Minor Gridlines. Clicking *More Grid Lines Options* opens the Format Grid Lines dialog box.
Frame & Background | Opens the Frame & Background dialog box, where you can edit the background style and frames for charts. This dialog box contains different options depending on the chart type that you have selected.

**Labels Group**
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axes</td>
<td>Opens the Axes menu, where you can enable and rotate horizontal and vertical axis labels, as well as stagger horizontal axis labels. You can also edit the axis labels by clicking More Vertical Axis Options or More Horizontal Axis Options. This option does not display for grids or maps.</td>
</tr>
<tr>
<td>Legend</td>
<td>Opens the Legend menu, where you can select the Show Legend option to display the legend on the chart. You can also clear your selection to hide the legend. In addition, you can change the default legend position and orientation. This option displays for maps but does not display for grids.</td>
</tr>
</tbody>
</table>

**Interactive Group**

**Note:** These options do not display for grids or maps.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Interactive Options</td>
<td>Opens the Interactive Options dialog box, which enables you to specify animation and mouse over effects in your chart.</td>
</tr>
</tbody>
</table>

**View Tab**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show/Hide Group</td>
<td></td>
</tr>
<tr>
<td>Resources</td>
<td>Minimizes the Resources panel, expanding the size of the canvas to occupy the area where the Resources panel typically appears. When you click the Resources button again, the Resources panel displays and the chart, map, or grid adjusts accordingly.</td>
</tr>
</tbody>
</table>

**Data Panel Group**
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logical</td>
<td>Displays the data source fields by type. This is the default view. The Logical view options include Title, Description, Field, and Alias.</td>
</tr>
<tr>
<td>List</td>
<td>Displays the data source fields in a tabular list format. This list contains a header row. You can sort fields differently by clicking a column header. The List view options include Title, Description, Field, Alias, Format, Segment, Filename, and Reference.</td>
</tr>
<tr>
<td>Structured</td>
<td>Displays the hierarchical structure of the data source files. The Structured view options include Title, Description, Field, and Alias.</td>
</tr>
</tbody>
</table>

**Report Group**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Switch Report</td>
<td>Lists any active report or chart to which you can switch.</td>
</tr>
</tbody>
</table>

**Field Tab**

### Filter Group

**Note:** Options on the Field tab are contingent on the visual type that you select.

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter</td>
<td>Opens the Filter dialog box for creating filters. Filters enable you to select only the data that you want and to exclude unwanted data.</td>
</tr>
<tr>
<td>Exclude</td>
<td>Select an existing filter in the Filter pane and choose <em>Exclude</em> to remove, but not delete, the filter from the visual.</td>
</tr>
<tr>
<td>Include</td>
<td>Select an existing filter in the Filter pane and choose <em>Include</em> to restore the filter, which was previously excluded from the visual.</td>
</tr>
<tr>
<td><strong>Command</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-------------</td>
<td>-----------------</td>
</tr>
<tr>
<td>Up</td>
<td>Displays the data source fields by type. This is the default view. The Logical view options include Title, Description, Field, and Alias.</td>
</tr>
<tr>
<td>Down</td>
<td>Displays the data source fields in a tabular list format. This list contains a header row. You can sort fields differently by clicking a column header. The List view options include Title, Description, Field, Alias, Format, Segment, Filename, and Reference.</td>
</tr>
<tr>
<td>Group</td>
<td>Opens the Create a Group dialog box where you can create a group to combine values together. For grids, this option is activated when you select a dimension.</td>
</tr>
<tr>
<td><strong>Display Group</strong></td>
<td></td>
</tr>
<tr>
<td>Hide Field</td>
<td>Hides a selected field.</td>
</tr>
<tr>
<td>Aggregation</td>
<td>Specifies an aggregation for a specific field. Commonly used options include: Sum, Average, Count, Minimum, and Maximum.</td>
</tr>
<tr>
<td>Traffic Lights</td>
<td>Specifies conditional styling to the selected field.</td>
</tr>
</tbody>
</table>

**Series Tab**

<table>
<thead>
<tr>
<th><strong>Command</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Select Group</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Note:</strong> This group is not available for grids. For maps, this group is disabled.</td>
<td></td>
</tr>
<tr>
<td>Series drop-down list</td>
<td>Lists the available series in the current visualization.</td>
</tr>
</tbody>
</table>

**Style Group**
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Style</td>
<td>Opens the Format Series dialog box, where you can edit the styling options for the selected series. You can also open this dialog box by right-clicking a series, and then clicking More Style Options.</td>
</tr>
<tr>
<td>Properties Group</td>
<td></td>
</tr>
<tr>
<td>Data Labels</td>
<td>Adds data labels to the chart. The drop-down menu contains the following data position options for selecting where to display data values as labels on a chart: Above (default), On top edge, Below top edge, Center, and Base. If you are working with a Pie chart, the options are: On Slice, Outside Slice, and Outside with feeler lines.</td>
</tr>
<tr>
<td>Trendline</td>
<td>Opens a drop-down menu that provides options for adding a trendline to a chart.</td>
</tr>
<tr>
<td>Line Group</td>
<td></td>
</tr>
<tr>
<td>Smooth Line</td>
<td>Draws the chart using smooth lines.</td>
</tr>
<tr>
<td>Connect Lines</td>
<td>Controls the display of connecting lines between markers on a line or scatter chart. By default, lines are connected on a line chart and disconnected on a scatter chart.</td>
</tr>
<tr>
<td>Marker</td>
<td>Opens a drop-down menu from which you can select options to change the display of the default data and legend markers on line and scatter chart types. For more information, see How to Change the Appearance of a Marker on page 768.</td>
</tr>
<tr>
<td>Pie Group</td>
<td></td>
</tr>
<tr>
<td>Note:</td>
<td>The following options are only enabled when you are working with a pie chart.</td>
</tr>
<tr>
<td>Expand</td>
<td>Expands pie slices.</td>
</tr>
<tr>
<td>Hide</td>
<td>Hides pie slices.</td>
</tr>
</tbody>
</table>
Chapter 5

Customizing Content

After you create your content, you can use the WebFOCUS Business User Edition's vast array of features and styling options to customize your content.

In this chapter:

- Customizing Reports
- Customizing Charts and Visualizations
- Creating Thumbnails for Use With the Home Page
- Using Storyboards
- Animating Visualizations
- Using Filters to Customize the Display of Data
- Using Auto Drill
- Using the Auto Linking Feature to Link Content
- Using Multi Drill
- Adding Parameters for Data Selection at Run Time
- Working With Slicers
- Changing a Field Format
- Dynamic Grouping
- Customizing Domain Portal Pages

Customizing Reports

You can customize reports using the various options on the Layout tab and Field tab.

- **Cell Padding.** Opens the Cell Padding dialog box, where you can set specific values to control the amount of space inserted between rows and columns in a report. For more information, see *How to Use Cell Padding in a Report* on page 749.

- **AutoFit.** Limits the width of columns in a report to be no wider than the largest value in each column. When additional fields are added, the report automatically grows at design time. AutoFit Column is selected, by default.

- **Page Break.** Starts a new page when the primary sort field changes. Clicking the drop-down icon enables you to select *Reset Page Numbers*, which allows you to reset page numbers on a page break to start at 1.

- **Line Break.** Inserts a line in the report output when the primary sort field changes.

- **Sub Header.** Opens a dialog box where you can type text to add a subheading just below the column titles in the report output when the primary sort field changes.
- **Sub Footer.** Opens a dialog box where you can type text to add a subfooting at the end of the data on each page of the report output when the primary sort field changes.

- **Subtotal.** Inserts a line, total text (TOTAL FIELD Value), and subtotals for all numeric fields when the primary sort field changes.

The drop-down menu on the *Field* tab, in the *Format* group provides three field-type options for the selected column, which are Alphanumeric, Integer, and Decimal. Selecting the fourth option, More options, opens the Field Format Options dialog box, which provides further formatting options for the selected field. For more information, see *Changing a Field Format* on page 865.

You can also apply floating and non-floating currency symbols, percent signs, and commas. You can increase and decrease decimal places by clicking the appropriate buttons under the drop-down menu.

The Currency button is a split button that turns the currency symbol on or off. Click the Currency button to turn on the default floating currency option. Click the Currency button a second time to turn off the floating currency option.

To turn on the non-floating currency option, open the drop-down menu and select *Non floating currency*. To turn off the non-floating currency option, click the Currency button.

The following options on the Field tab, in the Display group:

- **Hide Field.** Allows you to hide a selected field.

- **Hide Missing.** Allows you to hide fields that have no value.

- **Aggregation.** Opens a drop-down menu of the following options:
  - None (default)
  - Sum
  - Average
  - Count
  - Count Distinct
  - Percent of Count
  - Distinct Values
  - First Value
  - Last Value
- Maximum
- Minimum
- Total
- Percent
- Row Percent
- Median
- Average Square

Sum is the default aggregation type value for all numeric fields added to the Measure Query field container in the Query pane. Changing the Measure Query field container from Sum to Print, Count, or List overrides all assigned aggregation type values. For more information related to charts, see *How to Display Aggregations on Measure Data* on page 770.

- **Traffic Lights.** Opens the Traffic Light Condition dialog box. From this dialog box you can do the following:
  - Add new conditional styling by applying traffic light (and other) colors to a selected field in the output when the field meets specified criteria
  - Modify existing conditional styling
  - Enable conditional drilldowns

For more information related to reports, see *Styling Reports* on page 740. For more information related to charts, see *Traffic Light Condition Dialog Box* on page 760.

- **Data Bars.** (Reports only.) Adds a data visualization column to the right of a selected numeric field. The column displays values in each row using horizontal bars that extend from left to right in varying lengths, depending on the corresponding data values.

- **Within.** Allows you to use specific aggregation tasks at different report levels. You can use the Within phrase to manipulate display field values as they are aggregated within a sort group rather than a report column.

- **Column(s).** Allows you to indicate the number of columns in which you wish to display multiple graphs. The value can be between 1 and 512. The default is 1. This option is also available from the Query pane shortcut menu for a Multi-graph component.
Styling Reports

You can apply custom styling to specific areas of a report. When creating a report, you can perform the following styling customization.

- **Global styling for the entire report.**
- **Style data and column titles.**
- **Style headings and footings.** For more information, see *How to Style Headings and Footings in a Report* on page 745.
- **Style the rows of data with alternating colors.** For more information, see *How to Style Rows of Data With Alternating Colors in a Report* on page 746.
- **Apply traffic light conditional styling to data.** For more information, see *How to Apply Traffic Light Conditional Styling to a Report (By Constant)* on page 746 and *How to Apply Traffic Light Conditional Styling to a Report (By Field)* on page 748.
- **Increase or decrease the amount of space inserted between rows and columns.** For more information, see *How to Use Cell Padding in a Report* on page 749.

**Procedure:** How to Apply Styling to an Entire Report

1. Create a report, or open an existing report.
2. On the *Home* tab, in the *Report* group, click *Style*.
   
The Report Style dialog box opens.
3. Select any of the following styling options that are available in the Style group.

   - **Font.** Opens a drop-down list, which you can use to change the font.
   - **Font size.** Opens a drop-down list, which you can use to change the font size value.
   - **Bold.** Applies bold font formatting to the selected text.
   - **Italic.** Applies italic font formatting to the selected text.
   - **Underline.** Underlines the selected text.
   - **Justify Left.** Aligns the text to the left of the canvas.
   - **Justify Center.** Aligns the text to the center of the canvas.
   - **Justify Right.** Aligns the text to the right of the canvas.
   - **Font color.** Opens the Color dialog box, where you can select the font color.
Procedure: How to Perform Field-Level Styling in a Report

You can style data, column titles, or both, in the report output for the selected data source field.

1. Create a report.
2. In the Query pane, select a data source field.
   The Field tab appears on the ribbon.
3. In the Style group, click one of the following:
   - Data Style. Styles only the data for the selected data source field.
   - Title Style. Styles only the column title for the selected data source field.
   - Data + Title. Styles both the data and the column title for the selected data source field.
4. Select any of the following styling options that are available in the Style group.
   - Font. Opens a drop-down list, which you can use to change the font.
   - Font size. Opens a drop-down list, which you can use to change the font size value.
   - Font color. Opens the Color dialog box, where you can select the font color.
   - Reset to Quick Styles from Template. Resets all settings to the default settings from the template.
Note: Reset only works while the Report Style dialog box is open. Once you click OK, all changes are committed. To undo global styling after it has been committed, you must use the Undo command on the Quick Access Toolbar.

- **Bold.** Applies bold font formatting to the selected text.
- **Italic.** Applies italic font formatting to the selected text
- **Underline.** Underlines the selected text.
- **Justify Left.** Aligns the text to the left of the canvas.
- **Justify Center.** Aligns the text to the center of the canvas.
- **Justify Right.** Aligns the text to the right of the canvas.

- **Background color.** Click the button to open the Color dialog box, where you can select the background color for the report.

  **Note:** When working with font or background colors, you must click OK on the Color dialog box to return to the Report Style dialog box.

5. Click OK. The report is styled accordingly.

**Procedure:** How to Add Headings and Footings to a Report

You can make a report more meaningful by adding headings and footings. Headings and footings supply context and key information about a report, such as its purpose and audience. Headings and footings also provide structure, helping you navigate to the detail sought. They enhance visual appeal.

In this procedure, you will add and style a report heading and page heading. The procedure uses sample values, but you can supply values that apply to your own, reports.

Headings and Footings are available in Query Design view, Live Preview, and Document view.

1. Create a report.
2. On the Home tab, in the Report group, click the Header & Footer button.

   The Header & Footer dialog box opens.

3. Click the tab for the heading or footing element that you want to add.

   For a report, you can add a report heading, page heading, page footing, or report footing.

   By default, the Report Header tab is selected. In this procedure, accept the default.

4. Click inside the design area of the dialog box, and type the text for the heading.

   For example, the text for a sample report heading might be *Quantity Sold by Product.*
5. Using the styling ribbon, apply styling to the report heading text.

For example, click HELVETICA from the Font drop-down list. From the Font size drop-down list, click 12.

The sample report heading with the selected styling values is shown in the following image.

6. Click Apply to save the changes you have made so far, without closing the dialog box.

7. To add a page heading, click the Page Header tab.

   In this procedure, you are going to add one of the supplied quick text options.

8. Click the last icon (Insert preformatted text content for headers/footers) on the right of the styling ribbon, and click Confidential in the list.

9. Change the font and font size. For example, change the font to HELVETICA and the size to 10.
You can add your own text before or after the supplied text, for example, For Regional Managers Only.

10. Click OK to save the report heading and page heading and close the Header & Footer dialog box.

The report heading and page heading that you added and styled are shown in Live Preview in the following image.

11. To make changes to either the report or page heading, right-click the heading and click Edit. You can also double-click on the header to open the Header & Footer dialog box.
Procedure: How to Style Headings and Footings in a Report

You can style headings and footings in the report output for the selected heading or footing field.

1. Create a report.
2. With the report opened in Live Preview, select the heading or footing text that you want to style.
   The Header & Footer dialog box opens.
4. Select any of the following styling options that are available in the Style dialog box.
   - **Font.** Opens a drop-down list, which you can use to change the font.
   - **Font size.** Opens a drop-down list, which you can use to change the font size value.
   - **Bold.** Applies bold font formatting to the selected text.
   - **Italic.** Applies italic font formatting to the selected text.
   - **Underline.** Underlines the selected text.
   - **Justify Left.** Aligns the text to the left of the canvas.
   - **Justify Center.** Aligns the text to the center of the canvas.
   - **Justify Right.** Aligns the text to the right of the canvas.
   - **Font color.** Opens the Color dialog box, where you can select the font color.
   - **Background color.** Opens the Color dialog box, where you can select the background color for the report.
   - **Reset to Quick Styles from Template.** Resets all settings to the default settings from the template.

   **Note:** Reset only works while the Report Style dialog box is open. Once you click OK, all changes are committed. To undo global styling after it has been committed, you must use the Undo command on the Quick Access Toolbar.
5. Click OK. The report is styled accordingly.
Procedure: How to Style Rows of Data With Alternating Colors in a Report

You can style rows of data in a report with alternating colors.

1. Create a report.
2. Open the report in Live Preview.
   
   The Color dialog box opens.
4. Select a color.
5. Click OK.

The selected color provides an alternating color scheme for the report. The report output displays alternating rows of data, using a white background for one row and a background of the selected color for the next row. This pattern continues throughout the report, as shown in the following image of banded report output.

![Banded Report Output](image)

Procedure: How to Apply Traffic Light Conditional Styling to a Report (By Constant)

You can apply traffic light conditional styling to data for a selected measure field. By default the report displays the values that satisfy the first condition in green, and the values that satisfy the second condition in red.

1. Open a report in Live Preview.
2. Open the Traffic Light Condition dialog box in one of the following ways:
   
   - **Ribbon:** Select a field on the report, and then on the Field tab, in the Display group, click Traffic Lights.
   - **Shortcut Menu:** Right-click a field on the report, point to More, and then click Traffic Light Conditions.
The Traffic Light Condition dialog box opens.

3. From the Relational Operators drop-down menu below the field name, click a relational operator. For example, Equal to.

4. In the field to the right of the Relational Operators drop-down menu, click the down arrow for the Type drop-down menu.

   The Type menu opens.

5. In the Type drop-down list, click Constant.

6. Enter a value in the Value field.

   or

   a. From the Get Values drop-down menu, select one of the following values: All, First, Last, Minimum, Maximum, or From File. The value that you select appears in the Get Values field.

   b. Select the value in the Get Values field. The value that you selected appears in the Value field.

7. Click OK.

   The value that you selected appears in the field to the right of the Relational Operators drop-down menu.

8. Click the Style button.

   The Style menu opens.

9. From the Style menu, click the Font Color or Background Color button.

   The Color dialog box opens.

10. Select a color.

11. Click OK.

   The color appears in the Preview box.

12. Click Apply to apply the colors to the report.

13. Click the Drill Down button.

   The Drill Down dialog box opens.

14. In the Drill Down dialog box, use the radio buttons to specify the action you wish to perform. For example, drill down to a report or webpage, create an auto link target, or refresh a BI portal.

15. Click OK to close the dialog box.
16. In the Traffic Light Condition window, click the New button to set traffic light conditions for additional fields.

**Procedure:** How to Apply Traffic Light Conditional Styling to a Report (By Field)

You can apply traffic light conditional styling to data for a selected measure field. By default, the report displays the values that satisfy the first condition in green, and the values that satisfy the second condition in red.

1. Open a report in Live Preview.
2. Open the Traffic Light Condition dialog box in one of the following ways:
   - **Ribbon:** Select a field on the report, and then on the Field tab, in the Display group, click Traffic Lights.
   - **Shortcut Menu:** Right-click a field on the report, point to More, and then click Traffic Light Conditions.

   The Traffic Light Condition dialog box opens.

3. From the drop-down menu below the field name, select a relational operator. For example, Equal to.
4. In the field to the right of the Relational Operators drop-down menu, click the arrow for the Type drop-down menu.

   The Type dialog box opens.

5. In the Type drop-down list, select Field.

   The Type dialog box displays a list of the data fields that you can choose from.

6. Select a data field from the list.
7. Click OK.

   The field that you selected appears in the field to the right of the Relational Operators drop-down menu.

8. Click the Style button.

   The Style menu opens.

9. From the Style menu, click the Color button.

   The Color dialog box opens.

10. Select a color.

    The color appears in the Preview box.
11. Click OK.
12. Click the Drill Down button.
   The Drill Down dialog opens.
13. In the Drill Down dialog, specify each of the following:
   - Drill down to a report or a webpage
   - URL of the webpage
   - An alternate comment
   - Target (New Window, Same Window)
   - Parameters that you want to use (Name, Value)
14. Click OK.
15. Click the New button to set traffic light conditions for additional fields.

**Procedure:** **How to Use Cell Padding in a Report**

You can customize the amount of space inserted between rows and columns in a report.

1. Open a report in Live Preview.
2. On the Layout tab, in the Report group, click Cell Padding, and then click Custom.
   The Cell Padding dialog box opens.
3. Type the cell padding values that you want in the Top, Bottom, Left, and Right fields.
4. Click OK.
   The report reflects the cell padding that you set.
The following image shows a report with custom cell padding.

### Quantity Sold by Product

<table>
<thead>
<tr>
<th>Product Category</th>
<th>Quantity Sold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Accessories</td>
<td>511,667</td>
</tr>
<tr>
<td>Camcorder</td>
<td>455,244</td>
</tr>
<tr>
<td>Computers</td>
<td>351,777</td>
</tr>
<tr>
<td>Media Player</td>
<td>771,934</td>
</tr>
<tr>
<td>Stereo Systems</td>
<td>1,114,332</td>
</tr>
<tr>
<td>Televisions</td>
<td>105,188</td>
</tr>
<tr>
<td>Video Production</td>
<td>199,749</td>
</tr>
</tbody>
</table>

### Report Style Dialog Box

The Report Style dialog box provides options to style your report, as described below.

- **Font.** Use the drop-down menu to change the font.
- **Font size.** Use the drop-down menu to change the numeric value for the font size.
- **Font style.** Click the appropriate button (bold, italic, underline) to style the selected text.
- **Text alignment.** Click the appropriate button (left, center, right) to align the selected text.
- **Font color.** Click the button to open the Color dialog box, where you can select the font color. For more information, see *Color Dialog Box* on page 751.
Background. Click the button to open the Color dialog box, where you can select the background color for the report.

Currency Symbol. Click the button to access the following currency symbols US dollar, British pound, Japanese yen, euro, new Israeli shekel.

Note: The new Israeli shekel currency symbol can be displayed with the following settings only:

- Server codepage = 1255, 65001, 424, or 65002.
- Client codepage = 1255 or 65001.
- Application server encoding = Cp1255 or UTF8.
- Font name = Lucida Sans Unicode or Arial Unicode MS.

Reset to Quick Styles from Template. Click the button to reset all settings to the default settings from the template.

Note: Reset only works while the Report Style dialog box is open. Once you click OK, all changes are committed. To undo global styling after it has been committed, you must use the Undo command on the Quick Access Toolbar.

Color Dialog Box

The Color dialog box provides options for working with color in your report.

The Color dialog box options are:

- Standard Color Swatches. Provides a set of 48 predefined colors from which to choose on the left side of the dialog box. Your selection appears in the Selected Color field.

- Custom Color Palette. Provides a palette on the right side of the dialog box to define a custom color. Your selection appears in the Selected Color field.

- Luminosity bar. Drag the slider to change the luminosity (relative lightness or darkness) of a color. The corresponding numerical value appears in Lum.

- Hue. Indicates the hue value of your selected color. You can enter a value, or increase or decrease the hue value by using the up and down arrows, respectively.

- Sat. Indicates the saturation value of your selected color. You can enter a value, or increase or decrease the saturation value by using the up and down arrows, respectively.
- **Lum.** Indicates the luminosity (lightness or darkness) of your selected color. You can enter a value, or increase or decrease the luminosity value by using the up and down arrows, respectively.

- **Red.** Represents the numeric value of red (0 to 255).

- **Green.** Represents the numeric value of green (0 to 255).

- **Blue.** Represents the numeric value of blue (0 to 255).

- **Selected Color.** Displays the color that you selected.

- **Transparent.** Makes the color transparent. This is only available for background colors.

**Report Group**

The Report group on the Home tab contains commands to enhance a report.

- **Theme.** Opens a dialog box where you can select a theme to style your report. You can use the default StyleSheet by clicking the *Use Default Stylesheet* button.

  You can also select a document styling theme or an application theme to style all reports created. Use the Environment and Styling section of the Options window, which is accessible by clicking *Options* in the Application main menu.

  **Note:** If you switch themes when working in Report mode, all custom styling is removed from the procedure.

- **Style.** Opens a Report Style dialog box for applying global styling to the entire report. For more information about the Report Style dialog box, see *Report Style Dialog Box* on page 750. For more information about styling reports, see *Styling Reports* on page 740.

- **Banded.** Opens a Color dialog box for choosing a color that provides an alternating color scheme for the report. The report output displays alternating rows of data, using a white background for one row and a background of the selected color for the next row. This pattern continues throughout the report. For more information about the Color dialog box, see *Color Dialog Box* on page 751. For more information about banded styling, see *How to Style Rows of Data With Alternating Colors in a Report* on page 746.

- **Header & Footer.** Opens the Header & Footer dialog box, from which you can add and style headings and footings.

  For a report, you can add and style report headings, page headings, page footings, and report footings. In the dialog box, the tab for Report Header is active by default.
For a chart, you can add and style page headings and page footings. Page Header is active by default.

You can drag fields from the Data pane into the Header & Footer dialog box.

Another way to access the Header & Footer dialog box is to click the down arrow next to the Header & Footer button. It opens a drop-down menu from which you can select the heading or footing that you want to work with (Report Header, Page Header, Page Footer, Report Footer). After you make your selection, the Header & Footer dialog box opens, and the heading or footing that you selected is active.

From the Header & Footer dialog box, you can add and style the active heading or footing, or choose a different heading and footing to work with by selecting the applicable tab. You can switch among tabs, but InfoAssist does not save changes made on the tabs until you click Apply or OK. If you click Apply, the Header & Footer dialog box remains open. If you click OK, the dialog box closes.

You can style a selected heading or footing using the options on the styling toolbar. From left to right, you can customize the font type, font size, and font style (bold, italic, or underline). You can align text (left, center, or right), select the font color and background color, and restore styling settings to their default value from the template.

You can also add page footings to your reports or charts. From the Header & Footer dialog box, select Page Footer. When working with reports, you may use the Additional alignment options icon, to specify whether you want to align the footer relative to the data (default) or relative to the page. The Align Relative to Data option places the footer directly below the data, and the Align Relative to Page option positions the footer at the bottom of the page. When working with charts, only the default page footer alignment option is supported.

**Note:** The Align Relative to Page option works with reports that use positioned formats (for example, PDF, PS, DHTML, PPT, and PPTX).

You can also insert *quick text* into a heading or footing. Quick text is supplied for you. It includes information that is typically useful in identifying a report or chart. From the preformatted text drop-down menu, you can select:

- Draft
- Page X of Y
- Confidential
- Date (multiple formats)
Time (multiple formats)

Created by (followed by a name)

For charts, an icon on the far right of the styling ribbon is enabled. This icon provides two options for controlling the way in which the page heading and page footing are rendered. The default option, Create Header and Footer as text, renders the heading and footing as text elements that are separate from the chart image. The option, Embed Header and Footer in the chart, renders the heading and footing text as part of the chart image.

Once you have added a heading or footing to a report or chart, you can double-click it on the canvas in design mode to reopen the Header & Footer dialog box. You can also right-click an existing heading or footing in design mode and click Edit from the menu to open the dialog box.

For more information on adding and styling headings and footings, see How to Add Headings and Footings to a Report on page 742.

Column Totals. (Reports only) Adds a grand total row to the bottom of the report to sum numeric data in each column.

Row Totals. (Reports only) Adds a grand total column to the right side of the report to sum numeric data in each row.

Report Features

The options on the Format tab, in the Features group, while in Report mode, allow you to add pop-up titles to columns, stack measures, and more.

Title Popup. Displays pop-up titles when the mouse pointer hovers over a column title in the report output.

Accordion. Creates expandable views of data for each vertical sort field. This option displays data values only for the first vertical sort field when you first view the output. You can manually expand your view to expose the data values of lower-level sort fields.

Note: You cannot use the Table of Contents with the Accordion feature.

Repeat Sort Value. Displays all repeated sort values instead of blanks in the output after the first instance of a new sort value, which is the default behavior.

Stack Measures. Displays all numeric measure field names in a column of the report output with the corresponding numeric data values.
- **active report options.** Opens the active report options dialog box where you can configure your active report options such as menu items, graph engine, and colors.

- **Accessibility.** Allows a title to be added to a report, chart, or document that is Section 508-compliant.

The following table lists the output formats for which each feature is available. Yes means the output is available for the feature. No means that the output is not available for the feature.

<table>
<thead>
<tr>
<th>Feature</th>
<th>HTML</th>
<th>HTML5</th>
<th>active report</th>
<th>PDF</th>
<th>Excel</th>
<th>PowerPoint</th>
</tr>
</thead>
<tbody>
<tr>
<td>Title Popup</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Accordion</td>
<td>yes</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Repeat Sort Values</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Stack Measures</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>active report options</td>
<td>no</td>
<td>no</td>
<td>yes</td>
<td>no</td>
<td>no</td>
<td>no</td>
</tr>
</tbody>
</table>

**Customizing Charts and Visualizations**

Once you have created a visualization or chart, you can customize and style your content. For example, you can add axis titles or a header. The customization options vary depending on the type of chart or visual you are developing.

**Chart Features**

The options on the Format tab, in the Features group allow you to add effects and different functionality to your charts.

**Note:** When working with maps, all options in the Features group are disabled with the exception of Frame & Background and Accessibility.

- **3D Effect.** Sets the three-dimensional view to on or off. The 3D Effect feature is disabled for 3D, stock, gauge, gauge thermometer, Pareto, spectral map, and funnel chart types. By default, 3D effect is off for all chart types.

  **Note:** When working with charts in HTML5 format, the 3D Effect option is not supported.
- **Rotate.** Toggles between a vertical display or horizontal display of a chart. For more information, see *How to Rotate a Chart* on page 826. The Rotate feature is disabled for pie, scatter, 3D, stock, gauge, gauge thermometer, Pareto, spectral map, and funnel chart types.

- **Reference.** Opens a drop-down menu that provides the Add Reference Line to Y-Axis and Add Reference Line to X-Axis options. Selecting one of these options opens the appropriate Reference Line dialog box, where you can set the specific X-axis or Y-axis value, type the text that you want, and position the reference line on a chart. For more information, see *How to Display a Static Reference Line* on page 827. The Reference feature is disabled for pie, 3D, stock, gauge, gauge thermometer, Pareto, spectral map, and funnel chart types.

- **Annotate.** Opens a drop-down menu that provides the Add an annotation option. Selecting this option opens the Annotation dialog box, where you can type the text that you want and position the annotation on a chart.

- **Grid.** Opens a drop-down menu allowing you to expand options for Horizontal or Vertical Gridlines. Both selections allow you to enable or disable Major and Minor Gridlines. Clicking *More Options* opens the Format Grid Lines dialog box. For more information, see *Formatting Gridlines* on page 786.

- **Frame & Background.** Opens the Frame & Background dialog box where you can edit the background style and frames for charts. The dialog contains different options depending on the chart type selected. For more information, see *Formatting a Frame and a Background* on page 805.

- **Gauges.** Opens the Gauge dialog box where you can edit your gauge chart. This button is only available when a gauge chart type is selected. For more information, see *How to Style a Gauge Needle* on page 822.

- **active report Options.** Opens the active report options dialog box where you can configure your active report options, such as menu items, graph engine, and colors. This button is available when the output type is set to active report.

  **Note:** Annotate is not available in HTML5.

- **Accessibility.** Allows a title to be added to a report, chart, or document that is Section 508-compliant.

**Labeling Charts**

You can add labels to charts and visualizations using the Labels group on the Format tab.
Note: When working with maps, the Axes option is disabled.

- **Axes.** Opens a drop-down menu, where you can enable, stagger, and rotate horizontal and vertical axis labels. You can also edit the axis labels by clicking More Horizontal Axis Options or More Vertical Axis Options. For more information, see Formatting Axis Labels on page 796.

- **Legend.** Opens a drop-down menu, where you can select the Show Legend option to display the legend on the chart, or clear your selection to hide the legend, change the default legend position, and change the default legend orientation. For more information, see Format Legend Dialog Box on page 781.

Accessing Chart Formatting Tools

Your presentation of data on a chart or visualization is successful when it communicates to your audience the message that you intend. InfoAssist helps you meet the needs of your audience and convey your message by providing numerous chart features. For example, you can adjust the appearance of a chart, add layers of information, or customize the labels that identify the data on the chart.

Using Live Preview

In Live Preview, the canvas on the right of the window provides a preview of the content that you can interact with. The preview is context sensitive, meaning that depending on what portion you select different options become available.

In Live Preview, when you hover the mouse over a graph element (for example, legend, axis label, title), the bounding area is highlighted with a dotted line.

In Live Preview, when you select a graph element (for example, legend, axis label, title), the bounding area is highlighted with a solid line.

Once you select a chart element, you can access all available design options on the ribbon, or you can right-click an element to open a shortcut menu of frequently-used design options. Once you have selected your design option from the ribbon or the menu, InfoAssist instantly applies it to the chart element, so that you see the result immediately.

Shortcut menus are enabled for charts that are generated with either sample data, or live data from your data source.

The following sections describe the chart elements and the ribbon options that you can work with to design your charts in Live Preview.
**Related Information:**

- *Using Field Containers* on page 103

**Formatting a Series**

A series is a measure field that is included in a chart or visualization. You can format a series in a variety of ways. For example, you can change the color of a series, add a trendline to a series, or change the appearance of markers on a series.

You can access the full set of formatting options on the Series tab and Field tab. For more information, see *Series Tab* on page 90 and *Field Tab* on page 90.

You can also access a subset of frequently-used options by right-clicking a series element on a chart to open a menu of those options.

**Tip:** The options that you see on the menu depend on the type of chart that you are creating. For example, the Series Type option would not appear on the menu for a pie chart, but it would appear for a bar, line, and area chart.

**Associated Dialog Boxes**

Whether you access series options from the ribbon or the shortcut menu, you are presented with a dialog box of options. The following dialog boxes are commonly used for formatting a series:

- Format Series
- Edit Title
- Traffic Light Condition

For Instructions on how to open these dialog boxes, see the procedures in *Using Series Properties* on page 765.

**Format Series Dialog Box**

The Format Series dialog box contains options to format the fill and border of each series on a chart. To access this dialog box, on the Series tab, in the Style group, click Style.

The Format Series dialog box contains the following tabs:

- Fill
- Border
- Effect (for HTML5 charts only)

Use the Fill tab to modify the color of a chart series.
The Fill tab contains the following options:

- **No fill.** Select this option to remove the color from the series.
- **Solid fill.** Select this option to display the Color and Transparency options.
  - **Color.** Click this icon to open the Color dialog box, where you can select a color for the series.
  - **Transparency.** Move the slider to make the bands opaque (0%) or transparent (100%). The default is 0%.
- **Gradient fill.** Select this option to display the direction of the gradient, the color pattern of the gradient, and the degrees of transparency for the two colors that make up the gradient. A gradient is a smooth color transition or blending of one color to another. The number of colors to use in a gradient is defined by the stop or pin elements.
  - **Direction.** Select from this drop-down menu to set the direction of the gradient fill. For example, Gradient right or Gradient left.

Use the Border tab to specify a border for a chart series.

**Note:** When you create a bubble chart and attempt to apply a border using the Style options on the Series tab, the border does not display.

The Border tab contains the following options:

- **Show Border Color.** Select this option to show a border color around each series.
- **Border Color.** Click this icon to open the Color dialog box, where you can select a color for the border.

Use the Effect tab to specify styling and shadowing options for HTML5 charts.

**Note:** This tab only displays when working with HTML5 charts.

The Effect tab contains the following options:

- **Riser Style.** Use this drop-down menu to select a riser style. Options include: None, Bevel, Cylinder, Darken, Inverted Darken, Lighten, and Inverted Lighten.
- **Show Shadow.** Select this option to set a shadow.
**Edit Title Dialog Box**

To edit the title of a series, right-click a series on the canvas, and click *Change Title*. The Enter Title dialog box contains a text field in which you can type the title for a series on a chart. Click *OK* and the title appears on the chart.

**Traffic Light Condition Dialog Box**

The Traffic Light Condition dialog box contains fields for adding new conditional styling or modifying existing conditional styling by applying a traffic light color to the selected field.

The Traffic Light Condition dialog box contains the following fields:

- **Relational Operators.** Select from this drop-down menu to set the relational operator. For example, *Equal to*.

- **Type/Value.** Click this unlabeled field to open a dialog box that contains the following fields:
  - **Type.** Opens a drop-down menu containing the values Constant and Field. Select *Constant* to enter a constant value. Select *Field* to open a visual display of the fields in your data source.
  
  - **Value:** Enables you to specify a value based on the Type that you select.
    
  **Note:** If you are creating a Traffic Light condition on a full date field, the Value field will have a calendar icon adjacent to it. You can use this icon to select a date using a calendar control.

- **Get Values.** Select a value option from this drop-down list. For example, *All* or *First*.

The Traffic Light Condition dialog box contains the following buttons:

- **Selected Condition.** Click this icon to select a condition to work on.

- **New.** Creates a new rule.

- **Delete.** Deletes a rule.

- **Color.** Opens the Color dialog box.

- **Drill Down.** Opens the Drill Down dialog box, where you can drill down to a webpage or a URL. Specify the following:
  
  - **URL of the webpage or location of the report**
  
  - **A description**
Target (New Window, Same Window, a value that you enter)

Parameters that you want to use (Name, Value)

Formatting and Display Tools for Data in a Visual

When working with visualizations, you can use various filtering and editing tools to format the display of measure and dimension data in any given visual. For example, for measures, you can use the Edit Format option to set the display of decimals in the values of your selected measure. For measures and dimensions, you can add filters to limit the display of information. These options, which can be found on the right-click menu of a field, are defined and described in the following table.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Values</td>
<td>Creates a filter for the selected measure or dimension. You can select all values or only the one the data values that you want to display. In this way, you can exclude unwanted data. For visualizations, prompts are created, by default. However, you can clear this option when setting your filter options. This option displays for both measures and dimensions.</td>
</tr>
<tr>
<td>Sort</td>
<td>Enables you to set sorting options for the measure or dimension that you select. For example, you can sort your data values in ascending or descending order, or you can set limits for the display of information, the value for which is set to No Limit, by default. This option displays for both measures and dimensions.</td>
</tr>
<tr>
<td>Visibility</td>
<td>Controls the display of the selected measure or dimension in a visual. The default value is Show, but if you set the option to Hide, the values are hidden from the visual. This option displays for both measures and dimensions.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Change Title</td>
<td>Enables you to edit the title of the measure or dimension. In the Edit Title dialog box, type the new title in the Enter Title field, and click OK. Depending on the axis that you select, the new label will be applied accordingly. This option displays for both measures and dimensions.</td>
</tr>
<tr>
<td>Edit Format</td>
<td>Enables you to change the format of a field. This includes field type, display options, field length, and the specification of applicable decimal points. For more information, see Changing a Field Format on page 865. This option displays for measure fields only. Note: Any changes to the format of a field will be reflected in the tooltip for visualizations at design and run time.</td>
</tr>
<tr>
<td>Drill Down</td>
<td>Opens the Drill Down dialog box, where you can create multiple drill down links on a data field to external procedures or websites. This option is available for any measure field in a visualization.</td>
</tr>
<tr>
<td>More</td>
<td>Provides access to Aggregation functions, which enables you to apply Aggregation functions (for example, Sum, Average, and Count) to the numeric field that you select. This option is only available for measure fields. This option displays for both measures and dimensions.</td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected field. This option is available in every field container. Note: In the Query and Filter panes, you can select and delete multiple data fields at one time. Press the Ctrl key, select two or more data fields, right-click, and then click Delete.</td>
</tr>
</tbody>
</table>
Create Group

Allows you to create a group of elements based on the field data type that you select. Once you define a new group, a higher-level field is created that contains the selected elements. This option is available for dimension fields of non-numeric format or attribute. For more information, see Dynamic Grouping on page 111.

Series Elements Shortcut Menu

When you right-click a series, a menu of options opens. The menu contains options that are available on the Field and Series tabs.

The menu options are described in the following table. The table provides links to the sections of this document in which those options are also discussed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Filter Values</td>
<td>Enables you to create or modify a WHERE statement, using the Filter dialog box. With a WHERE statement, you select only the data that you want to display, and exclude unwanted data. For information on filtering your data, see Data Tab on page 87 and Field Tab on page 90.</td>
</tr>
<tr>
<td>Sort</td>
<td>Enables you to sort the series in either ascending or descending order.</td>
</tr>
<tr>
<td>Visibility</td>
<td>Controls the display of the selected series (field) on a chart. The value Hide suppresses the display of the series, and the default value Show displays the series. For instructions, see How to Hide a Field in a Series on page 770.</td>
</tr>
<tr>
<td>Change Title</td>
<td>Enables you to edit the title of the selected series. In the Edit Title dialog box, type the new title in the Enter Title field, and click OK.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Edit Format</td>
<td>Enables you to change the format of a field. This includes field type, display options, field length, and the specification of applicable decimal points. For more information, see Changing a Field Format on page 865.</td>
</tr>
<tr>
<td><strong>Note:</strong> Any changes to the format of a field will be reflected in the tooltip for charts at run time, as well as for visualizations at design and run time.</td>
<td></td>
</tr>
<tr>
<td>Series Type</td>
<td>Changes the chart type of the selected series to bar, line, or area. The option None (default) returns the series to the chart type that was in effect before you changed it. This option applies to bar, line, and area chart types only.</td>
</tr>
<tr>
<td>Series Color</td>
<td>Enables you to specify the color of the selected series, using the Color dialog box. For more information, see Color Dialog Box on page 751.</td>
</tr>
<tr>
<td>More Style Options</td>
<td>Opens the Format Series dialog box. For more information, see Format Series Dialog Box on page 758.</td>
</tr>
<tr>
<td>Data Labels</td>
<td>Controls the display of data labels (values) on the selected series. The default value Hide suppresses the display of labels, and the value Show displays labels. This option does not apply to the gauge chart type. For instructions, see How to Show and Hide Data Labels on page 780.</td>
</tr>
<tr>
<td>Color Mode</td>
<td>Controls how color is applied to a series (measure field) on a chart. The possible settings are By Series (default) and By Group. For example, assume that there is only one series on a sample bar chart. The By Series setting applies the same color to all the bars in the series. The By Group setting applies a different color to each bar. For instructions, see How to Control the Color Mode on page 774.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Add Trendline</td>
<td>Draws a line on a chart to indicate a statistical trend. This option does not apply to the pie, funnel, 3D, gauge, or stock chart type. For an example of a chart with a trendline, see How to Add a Trendline on page 767.</td>
</tr>
<tr>
<td>Drill Down</td>
<td>Opens the Drill Down dialog box, where you can configure a hyperlink or a drill-down procedure for the selected field. Clicking that field in the report output, at run-time, redirects you to the URL you specified or executes the indicated procedure.</td>
</tr>
<tr>
<td>More</td>
<td>Contains the Aggregation Functions, Traffic Light Conditions, and Missing options. Aggregation Functions assign an aggregation value to a numeric measure field in a report. For instructions, see How to Display Aggregations on Measure Data on page 770. Traffic Light Conditions enables you to specify the color of numeric measure fields in the output, depending on conditions that you set. You can use the Traffic Light Condition dialog box to specify the conditions and colors. For instructions, see How to Apply Traffic Light Conditions With Drill-Down to a Numeric Measure Field (By Constant) on page 771 and How to Apply Traffic Light Conditions With Drilldown to a Numeric Measure Field (By Field) on page 773. The Missing option allows you to show or hide fields with no value.</td>
</tr>
<tr>
<td>Delete</td>
<td>Removes the selected series from the report and updates the Live Preview accordingly.</td>
</tr>
</tbody>
</table>

**Using Series Properties**

The following sections contain procedures for customizing a series.
Procedure: How to Select a Series

1. Create a chart or visualization.
2. On the Series tab, in the Select group drop-down menu, select the Series that you want to customize.

   The Series appears in the drop-down menu field.

Procedure: How to Format the Fill and Border of a Series

1. Create a chart or visualization.
2. Open the Format Series dialog box in one of the following ways:
   - **Ribbon:** On the Series tab, in the Style group, click Style.
   - **Shortcut Menu:** Right-click a series on the chart, and click More Style Options.

   The Format Series dialog box opens.
3. Use the fill and border options to format the series.

   For more information, see Format Series Dialog Box on page 758.
4. Click OK to close the dialog box.

   The Format Series dialog box closes. The series fill and border are formatted accordingly.
5. Click Run to generate the report.

Enhancing Series Using the Series Tab

The Properties group contains commands for enhancing charts, such as changing the type or adding a trendline, for the selected series.

Procedure: How to Change the Type of a Series

1. Create a bar, line, or area chart.
2. Access the list of series types in one of the following ways:
   - **Ribbon:** On the Series tab, in the Properties group, open the Type drop-down menu.
   - **Shortcut Menu:** Right-click a series on the chart, and point to Series Type.

3. Select the type that you want the series to become.

   The chart contains the new series type.
**Procedure:** How to Add a Trendline

A trendline is a line that is drawn over the plot area of a chart or visual to show the pattern of data points. The pattern reveals a statistical trend. In particular, the slope of the trendline, which is calculated by subtracting and dividing two different x, y coordinate values, is a value that indicates the rate at which the y value of a line rises or falls as the x value increases. Once the slope of your chart or visual is determined, you can further extrapolate your results and gain further insight into your data.

**Note:** The mathematical equation for the selected trendline option is only available in chart mode. It is not available in visualization mode.

1. Create a chart or visualization.
2. Access the menu of trendline types in one of the following ways:
   - **Ribbon:** On the Series tab, in the Properties group, open the Trendline drop-down menu.
   - **Shortcut Menu:** Right-click a series on the chart or visual, and point to Add Trendline.
3. Select the type of trendline that you want to display.
   
   The trendline appears on the canvas.
4. Optionally, to display the mathematical equation for the selected trendline option, on the Series tab, in the Properties group, click Equation.

**Formatting Charts Using the Series Tab**

The Series tab contains options for formatting charts.

**Procedure:** How to Apply Smooth Line Effect to a Line Chart

1. Create a line chart.
2. Select a series on the line chart.

   The Smooth Line effect is applied to the series.

**Procedure:** How to Hide a Series Line Between Markers

Lines appear between markers by default.

To hide a series line between a marker:

1. Create a line chart.
2. Select a series on the line chart.
3. On the Series tab, in the Series group drop-down menu, select the series that you want to hide.

4. In the Line Group, click Connect Lines.
   
The series line between the markers disappears.
   
   To make the series line reappear, click Connect Lines again.

**Procedure:** How to Change the Appearance of a Marker

Markers are used to display points of data on a line chart. They are also used in the legend to identify the data that is on the chart. The different marker shapes distinguish one series from another.

1. Create a line chart.
2. Select a series on the line chart.
3. On the Series tab, in the Line group, click Marker to open a drop-down menu of options.
4. From the Marker drop-down menu, select the marker shape. For example, Diamond or Hourglass.
   
The markers are formatted.
   
The following image shows a triangle marker for gross profit data and a star marker for revenue data.
Procedure: How to Expand Pie Slices

1. Create a pie chart.
2. On the Series tab, in the Select group, from the drop-down menu, select one of the following:
   - All Series expands all slices out from the center of the pie.
   - A specific series expands that particular slice out from the center of the pie.
3. In the Pie group, click Expand.
   The pie expands accordingly.

Procedure: How to Hide a Pie Slice

1. Create a pie chart.
2. On the Series tab, in the Select group, from the drop-down menu, select the series that you want to hide. Then, in the Pie group, click Hide.
   The slice is hidden.

Procedure: How to Filter Values in a Series

1. Create a chart.
2. Select a series on the chart.
3. Open the Filter dialog box in one of the following ways:
   - Ribbon: On the Field tab, in the Filter group, click Filter.
   - Shortcut Menu: Right-click a series, and click Filter Values.
   The Filter dialog box opens.
4. Select values for values and prompts.
5. Click OK to close the dialog box.
   The series values are filtered.

Procedure: How to Sort the Fields in a Series

1. Create a chart.
2. Select a series.
3. Sort the series in one of the following ways:

- **Ribbon:** On the *Field* tab, in the *Sort* group, click *Up* to sort the series values from smallest to largest, or click *Down* to sort the series values from largest to smallest.

- **Shortcut Menu:** Right click a series on the chart, and point to *Sort*, and then *Sort* again. Click *Ascending* to sort the series values from smallest to largest, or click *Descending* to sort the series values from largest to smallest. Select *Limit* to open a list of values to display for a sort group.

The chart appears with the series sorted accordingly.

**Procedure:** How to Hide a Field in a Series

1. Create a chart or visualization.
2. Hide a field in a series in one of the following ways:

   - Select the field in the Query pane.
   - Right-click the field in the chart.
   - **Ribbon:** Select the field in the Query pane or by right-clicking it in the chart. On the *Field* tab, in the *Display* group, click *Hide Field*. Click *Hide Field* again to make the series reappear.

   - **Shortcut Menu:** Right-click a series in the Query pane, or in the chart, point to *Visibility*, and then click *Hide*. Right-click the same series, point to *Visibility*, and then click *Show* to make the series reappear.

The field is hidden.

**Procedure:** How to Display Aggregations on Measure Data

You can display numeric measure data using a variety of aggregation values.

1. Create a chart or visualization.
2. Open the list of Aggregation options in one of the following ways:

   - **Ribbon:** On the *Field* tab, in the *Display* group, click *Aggregation*.

   - **Shortcut Menu:** Right-click a series, point to *More*, and then *Aggregation Functions*.

3. Select an aggregation function.

The aggregation function is applied to the series.
**Note:** If you change the Measure (Sum) Query field container in the Query pane from Sum to Print, Count, or List, the change overrides all assigned aggregation values.

**Procedure:** How to Display Aggregations on Dimension (Non-Numeric) Data

You can use various aggregations when working with dimension (non-numeric) fields in a chart, including Count, Count Distinct, and Percent of Count. The Count aggregation counts the number of occurrences of a field. Count Distinct counts the number of distinct values within a field. Percent of Count computes a field percentage, based on the number of instances found. When a dimension (non-numeric) field is placed in the Vertical Axis field container, it is converted to a Count field. You can subsequently change the aggregation to Count Distinct or Percent of Count.

1. Create a chart.
2. Convert a dimension (non-numeric) field into a Count field by placing it in the Vertical Axis field container.
3. Select the series on which to perform an aggregation.
4. Open the list of Aggregation options in one of the following ways:
   - **Ribbon:** On the Field tab, in the Display group, click Aggregation.
   - **Shortcut Menu:** Right-click a series, point to More, and then click Aggregation Functions.
5. Select an aggregation function.
   
   The aggregation is applied to the series.

**Procedure:** How to Apply Traffic Light Conditions With Drill-Down to a Numeric Measure Field (By Constant)

1. Create a chart or visualization.
2. Open the Traffic Light Condition dialog box in one of the following ways:
   - **Ribbon:** In the Query pane, select a field, and then on the Field tab, in the Display group, click Traffic Lights.
   - **Shortcut Menu:** Right-click a series on the chart, point to More, and then click Traffic Light Conditions.

   The Traffic Light Condition dialog box opens. For more information, see Traffic Light Condition Dialog Box on page 760.
3. From the Relational Operators drop-down menu below the field name, select a relational operator. For example, Equal to.
4. In the field to the right of the Relational Operators drop-down menu, click the down arrow for the Type drop-down menu.

   The Type dialog box opens.

5. In the Type dialog box, select Constant.

6. Enter a value in the Value field, or
   a. From the Get Values drop-down menu, select one of the following values All, First, Last, Minimum, Maximum, From File. The value that you select appears in the Get Values field.
   b. Select the value in the Get Values field. The value that you selected appears in the Value field.

7. Click OK.

   The value that you selected appears in the field to the right of the operator drop-down menu.

8. Click the Color button.

   The Color dialog box opens.

9. Select a color.

10. Click OK.

    The color appears in the Preview box.

11. Click OK.

12. Click the Drill Down button.

    The Drill Down dialog box opens.

13. In the Drill Down dialog box, specify each of the following:
    
       - Drill down to a report or a webpage
       - URL of the webpage or location of the report
       - An alternate comment
       - Target (New Window, Same Window)
       - Parameters that you want to use (Name, Value)

14. Click OK to close the dialog box.

15. Click the New button to set traffic light conditions for additional fields.
Procedure: How to Apply Traffic Light Conditions With Drilldown to a Numeric Measure Field (By Field)

1. Create a chart or visualization.

2. Open the Traffic Light Condition dialog box in one of the following ways:
   - **Ribbon:** In the Query pane, select a field, and then on the Field tab, in the Display group, click Traffic Lights.
   - **Shortcut Menu:** Right-click a series on your chart, point to More, and then click Traffic Light Conditions.

   The Traffic Light Condition dialog box opens. For more information, see Traffic Light Condition Dialog Box on page 760.

3. From the Relational Operators drop-down menu below the field name, select a relational operator. For example, Greater than.

4. In the field to the right of the operator drop-down menu, click the arrow for the Type drop-down menu.

   The Type dialog box opens.

5. In the Type dialog box, select Field.

   The Type dialog box displays the Dimensions, and Measures and Properties of your data. You can display the data in the following ways:

   - **View fields in business order.** Select from the following options: Title, Description, Name, or Alias.
   - **View fields in a sortable grid.** Select from the following options: Name, Title, Alias, Format, Segment, Filename, Description, or Reference.
   - **View the hierarchical structure of the data.** Select from the following options: Title, Description, Name, or Alias.

6. Select a field.

7. Click OK.

   The field that you selected appears in the field to the right of the operator drop-down menu.

8. Click the Color button.

   The Color dialog box opens.

9. Select a color.

   The color appears in the Preview box.
10. Click OK.

11. Click the Drill Down button.

   The Drill Down dialog box opens.

12. In the Drill Down dialog box, specify each of the following:

   - Drill down to a report or a webpage
   - URL of the webpage or location of the report
   - An alternate comment
   - Target (New Window, Same Window)
   - Parameters that you want to use (Name, Value)

13. Click OK to close the dialog box.

14. Click the New button to set traffic light conditions for additional fields.

Procedure: How to Change the Title of a Series

1. Create a chart or visualization.

2. Open the Edit Title dialog box in one of the following ways:
   
   - **Shortcut Menu**: Right-click a series on the chart, and click *Change Title*.
   
   - **Query Pane**: Right-click a series, and click *Change Title*.

   The Edit Title dialog box opens.

3. In the Enter Title field, type the new name for the series.

4. Click OK to close the dialog box.

   The series has a new title.

Procedure: How to Control the Color Mode

When you create a single-series chart, all series groups appear in the same color. To use a different color for each group, set the color mode to *By Group*.

1. Create a chart or visualization.

2. Right-click a series on the chart, point to *Color Mode*, and then click *By Group*.

   A different color is applied to each group in the series. To return to the default display of the series in one color, right-click the series, point to *Color Mode*, and then click *By Series*. 
3. Click Run to generate the report.

Procedure: How to Delete a Series

1. Create a chart or visualization.
2. Right-click a series on the chart, and click Delete.

The series is deleted.

Formatting Data Labels

Data labels highlight important data points on a chart. They identify exact numbers. You can customize data labels in a variety of ways to make them stand out more clearly on the chart. For example, you can change the position, angle, color, or size of data labels.

Associated Dialog Boxes

Whether you access data label options from the ribbon or the shortcut menu, you are presented with a dialog box of options. The following dialog boxes are commonly used for formatting data labels:

- Format Labels
- Style
- Line Style

For instructions on how to open these dialog boxes, see the procedures in Using Data Labels Properties on page 780.

Format Labels Dialog Box

The Format Labels dialog box contains options for editing data labels. The Format Labels dialog box offers different options depending on the chart type that you are using. Bar, line, and area charts share the same tabs.

The Format Labels dialog box contains the following tabs:

- General Options
- Advanced
- Pie Title (for pie charts only)
- Pie Labels (for pie charts only)
- Funnel Labels (for funnel and pyramid charts)
General Options Tab

Use the General Options tab to add data labels to a chart and set their position, angle, and radius.

The General Options tab contains the following options:

- **Show Data Labels.** Select this option to show data labels on a chart. Clear this option to suppress data labels.

- **Position.** Select an option from this drop-down menu to determine where the data label will be positioned. The options are:
  - Above
  - Below top edge
  - Center
  - Base
  - Center back

- **Format Labels.** Select from this drop-down menu of preset formats that can be applied to the labels. Some of the options include Use Pattern, Currency General, and Date Full.

- **Custom Format.** Enter a standard number format pattern for the data label. This option is only available when you select the Use Pattern option from the Format Labels drop-down menu.

The following table describes the characters that you can use in a custom format.

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>Is a digit.</td>
</tr>
<tr>
<td>0 (zero)</td>
<td>Shows as absent.</td>
</tr>
<tr>
<td>. (period)</td>
<td>Is a placeholder for decimal separator.</td>
</tr>
<tr>
<td>, (comma)</td>
<td>Is a placeholder for grouping separator.</td>
</tr>
<tr>
<td>; (semicolon)</td>
<td>Separates formats.</td>
</tr>
<tr>
<td>- (dash)</td>
<td>Is the default negative prefix.</td>
</tr>
<tr>
<td>Character</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>% (percent)</td>
<td>Divides by 100 and shows as a percentage.</td>
</tr>
<tr>
<td>x</td>
<td>Determines that any other characters can be used in the prefix or suffix.</td>
</tr>
<tr>
<td>‘ (apostrophe)</td>
<td>Is used to quote special characters in a prefix or suffix.</td>
</tr>
</tbody>
</table>

- **Style Labels.** Click this icon to open the Style dialog box, where you can style text. For more information, see *Style Dialog Box* on page 779.

- **Show Cumulative Sums.** Select this option to have the data text labels show cumulative sums. Clear this option to have data text labels show individual sums. This option is available for stacked charts.

- **Show Stacked Total.** Select this option to display stacked totals. Data position should be set to *Center* to display a stacked total. This option is available for stacked charts.

**Advanced Tab**

Use the Advanced tab to modify additional data labels properties.

The Advanced tab contains the following options:

- **Show Zero Labels.** Select this option to display zero values in a chart. Clear this option to display all data values except zero.

- **Apply color to negative data labels.** Select this option to style negative data labels separately from positive data labels.

- **Color.** Click this icon to open the Color dialog box, where you can select a color for the negative number.

**Pie Title Tab**

Use the Pie Title tab to create and style a pie title.

The Pie Title tab contains the following options:

- **Show Pie Title.** Clear this option to suppress a pie title. Select this option to display a pie title. This is the default option.

- **Style Title.** Click this icon to open the Style dialog box, where you can style pie title text.
Use the Pie Labels tab to customize your pie data labels.

The Pie Labels tab contains the following options:

- **Label Position.** Select from this drop-down menu an option to control the display of feeler lines and labels on a pie chart.

- **Label Display.** Select from this drop-down menu an option to control the format of labels displayed next to feelers on a pie chart.

- **Format Labels.** Select from this drop-down menu of preset formats that can be applied to labels.

- **Custom Format.** Select this option to use a custom format from a list of preset formats. See the following table for a list and description of the characters that you can use in a custom format.

- **Style Labels.** Click this button to open the Style dialog box, where you can style text.

**Ring Label**

- **Show Ring Label.** Select this option to control the display of the total label on a pie ring chart.

- **Format Labels.** Select from this drop-down menu of preset formats that can be applied to labels.

- **Custom Format.** Enter a standard number format pattern for the data label. This option is only available when you select the *Use Pattern* option from the Format Labels drop-down menu.

- **Style Labels.** Click this button to open the Style dialog box, where you can style text.

**Feeler Line**

- **Line Style.** Click this button to open the Line Style dialog box, where you can edit the color, weight, and style of the feeler line.

**Funnel Labels Tab**

Use the Funnel Labels tab to customize the labels on a funnel or a pyramid chart.

The Funnel Labels tab contains the following options:

- **Label Position.** Select an option from this drop-down menu to control the display of feeler lines and labels on a funnel chart.

- **Format Labels.** Select from this drop-down menu of preset formats that can be applied to labels.
Custom Format. Select this option to use a custom format. See the table in the previous section for a list and description of the characters that you can use in a custom format.

Style Labels. Click this button to open the Style dialog box, where you can style text.

Style Value. Opens the Style dialog box, where you can style the value.

Feeler Line

Show Feeler Lines. (Default) Clear this option to suppress feeler lines. Select this option to display feeler lines.

Line Style. Click this button to open the Line Style dialog box, where you can edit the color, weight, and style of the feeler line.

Note: While some style options, such as Show Pie Title and Show Feeler Lines, are enabled by default, a StyleSheet applied to the chart may contain different settings that will override these default settings.

Style Dialog Box

The Style dialog box contains options to style the data labels.

The Style dialog box contains the following options:

Font. Use the drop-down menu to change the font.

Font size. Use the drop-down menu to change the numeric value for the font size.

Font style. Click the appropriate button (bold, italic, underline) to style the selected text.

Text alignment. Click the appropriate button (left, center, right) to align the selected text.

Font color. Click the button to open the Color dialog box, where you can select the font color.

Reset to Quick Styles from Template. Click the button to reset all settings to the default settings from the template.

Note: Reset only works while the Style dialog box is open. Once you click OK, all changes are committed. To undo global styling after it has been committed, you must use the Undo command on the Quick Access Toolbar.

Line Style Dialog Box

The Line Style dialog box contains options to style lines on a chart.
The Line Style dialog box contains the following options:

- **Color.** Click this button to open the Color dialog box, where you can select the color for the line.

- **Weight.** Click this button to open a drop-down menu of line weight options.

- **Style.** Click this button to open a drop-down menu of line style options.

- **Reset.** Click this button to reset the line to the default options.

**Data Labels Elements Shortcut Menu**

When you right-click a data label on a bar, line, or area chart, a menu of the following options opens:

- **Data Labels.** Point to this option to toggle between Show and Hide.

- **More Label Options.** Click this option to open the Format Labels dialog box.

The shortcut menu contains options that are available on the Series tab.

**Using Data Labels Properties**

The following sections contain procedures for customizing data labels.

**Procedure:** **How to Show and Hide Data Labels**

1. Create a chart or visualization.

2. You can access the option to show data labels in one of the following ways:

   - **Ribbon:** On the Series tab, in the Properties group, click Data Labels, and from the drop-down menu, click More Data Label Options. The Format Labels dialog box opens. On the General Options tab, select the Show Data Labels check box, and click OK to close the dialog box. You can use this dialog box to format and style the data labels. For more information, see *Format Labels Dialog Box* on page 775. To hide data labels, clear this option.

   - **Shortcut Menu:** Right-click a series on the chart, point to Data Labels, and then click Show. To hide data labels, right-click a series on the chart, point to Data Labels, and then click Hide.

   The data labels appear, and are formatted and styled accordingly.
Procedure: How to Change the Position of Data Labels

2. On the menu, select the position for the data labels.

The data labels are positioned accordingly.

Formatting a Legend

A legend contains information that is necessary to accurately interpret the data on a chart. By default, a chart displays either a vertical axis title if there is a single measure field, or a legend if there are multiple measure fields.

Format Legend Dialog Box

Whether you access legend options from the ribbon or the shortcut menu, you are presented with the Format Legend dialog box of options. For instructions on how to open this dialog box, see Using Legend Properties on page 784.
The Format Legend dialog box contains options for formatting a legend on a chart or visualization. It contains the following tabs:

- Legend Options
- Markers & Labels
- Fill
- Border Styles

For instructions on how to open this dialog box, see the procedures in Using Legend Properties on page 784.

Use the Legend Options tab to customize the appearance of a legend on a chart or visualization.

The Legend Options tab is shown in the following image.

The Legend Options tab contains the following options.

- **Show Legend.** When selected, a legend displays on a chart or visualization. Clear this option to suppress a legend on a chart or visualization.
- **Legend Position.** Opens a drop-down menu of options to position the legend. For example, top or left.

- **Reverse Legend Order.** Specifies that the legend be drawn in reverse order. Clear this option to specify that the legend be drawn in normal order.

- **Docking State.** This option dictates how the legend is docked. It is set to Expanded by default, but you can set it to Collapsed, which will show that the legend is available (using the grey arrow). This option saves real estate in your chart by collapsing the categorical text labels in the legend while preserving the legend label colors. This is particularly useful when items in your legend have long labels and you wish to truncate them for the purposes of display. If you set this option to None, the ability to expand or collapse the legend is removed and the grey arrow no longer displays.

- **Enable Scrolling.** Select this check box to enable scrolling in your legend. This is particularly useful when you have numerous entries in your legend. This check box is selected, by default. To disable scrolling in your legend, clear the Enable Scrolling check box. All legend options display in columns, and a scroll bar does not display.

- **Show Title.** Select this check box to display the legend title.

Use the Markers & Labels tab to customize the appearance of markers and labels on legends.

The Markers & Labels tab contains the following options:

- **Style Labels.** Opens the Style dialog box, where you can style text.

- **Marker Position.** Opens a drop-down menu of options to set the position of text relative to the legend marker. For example, Left of Text or Above Text.

Use the Fill tab to modify the color of the legend area. For more information, see *Format Series Dialog Box* on page 758.

Use the Border Styles tab to place a border around a legend. For more information, see *Format Series Dialog Box* on page 758.

The Border Styles tab contains the following options:

- **Show Border.** Select this option to place a border around a legend.

- **Color.** With the Show Border option selected, you can click this button to open the Color dialog box, where you can select a color for the border.

**Legend Elements Shortcut Menu**

When you right-click a legend on a chart, a menu of options opens. The menu contains options that are available on the Format tab.
The shortcut menu options are described in the following table. The table provides links to the sections of this document in which those options are also discussed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show legend</td>
<td>Controls the display of the legend. InfoAssist displays the legend by default. When you clear this option, InfoAssist suppresses the legend. For instructions, see <em>Using Legend Properties</em> on page 784. The background shortcut menu has an option to restore the legend after it has been suppressed.</td>
</tr>
<tr>
<td>Legend Position</td>
<td>Controls the placement of the legend on the chart. For instructions see, <em>Using Legend Properties</em> on page 784.</td>
</tr>
<tr>
<td>Legend Area Color</td>
<td>Enables you to specify the color of the legend background area using the Color dialog box. This option is available only when you right-click the area around the legend. For instructions see, <em>Using Legend Properties</em> on page 784.</td>
</tr>
<tr>
<td>Legend Border Color</td>
<td>Enables you to specify the color of the border around the legend background area using the Color dialog box. This option is available only when you right-click the area around the legend. For instructions see, <em>Using Legend Properties</em> on page 784.</td>
</tr>
<tr>
<td>More Legend Options</td>
<td>Opens the Format Legend dialog box.</td>
</tr>
</tbody>
</table>

**Using Legend Properties**

The following sections contain procedures for customizing the legend. The procedures are organized by the tab and group in which their associated options appear on the ribbon.

**Procedure:** How to Hide a Legend

1. Create a chart or visualization with multiple measure fields.
2. Clear the *Show legend* option in one of the following ways:

- **Ribbon:** On the *Format* tab, in the *Labels* group, click *Legend*, then click *Show legend* to clear the option.

- **Shortcut Menu:** Right-click the legend, and clear the *Show legend* option.

  The legend is hidden.

**Procedure:** How to Position a Legend

1. Create a chart or visualization with multiple measure fields.
2. Open the menu of label position options in one of the following ways:

   - **Ribbon:** On the *Format* tab, in the *Labels* group, click *Legend*, then point to *Legend Position*.

   - **Shortcut Menu:** Right-click the legend, and point to *Legend Position*.
3. Select a position for the legend. For example, Auto or Right.

**Procedure:** How to Specify the Color of a Legend Border

1. Create a chart or visualization with multiple measure fields.
2. Open the Format Legends dialog box in one of the following ways:

   - **Ribbon:** On the *Format* tab, in the *Labels* group, click *Legend*, then click *More Legend Options*.

   - **Shortcut Menu:** Right-click the legend, and click *More Legend Options*.

   The Format Legends dialog box opens. For more information, see *Format Legend Dialog Box* on page 781.
3. On the Border Styles tab, select the option to *Show Border*.
4. Click the *Color* icon to open the Color dialog box, where you can specify the color of the legend border.
5. Click *OK* to close the Color dialog box.
6. Click *OK* to close the Format Legend dialog box.

   The legend border is formatted accordingly.
The following image is an example of a bar chart with a styled legend.

![Bar Chart Example](image)

**Formatting Gridlines**

Gridlines are used on a chart as a reference to help you understand the quantities and values of your data and decode information on the axis. There are four types of gridlines that you can display and edit on your chart. They are:

- Horizontal major gridlines
- Horizontal minor gridlines
- Vertical major gridlines
- Vertical minor gridlines

Major gridlines enhance the display of values, while minor gridlines supplement major gridlines. If a plot point falls in between major gridlines, you can use minor gridlines for more precise interpretation of the data.

- Vertical gridlines in a vertical chart run on the X axis.
- Horizontal gridlines in a vertical chart run on the Y axis.
- Horizontal major gridlines enhance the display of values, compared to the Y-axis scale alone. They are enabled by default on many charts. They do not apply to the pie, 3D, gauge, spectral map, or funnel chart type.
Horizontal minor gridlines are disabled by default. They do not apply to the pie, 3D, gauge, spectral map, or funnel chart type.

Vertical major gridlines enhance the display of values, compared to the X-axis scale alone. They are enabled by default. They do not apply to the pie, 3D, gauge, spectral map, or funnel chart type.

Vertical minor gridlines are disabled by default. They do not apply to the pie, 3D, gauge, spectral map, or funnel chart type.

**Note:** The orientation of a chart determines the available gridline options.

### Format Grid Lines Dialog Box

You can format horizontal and vertical gridlines, color bands, and frames on a chart using the options in the Format Grid Lines dialog box. For instructions on how to open this dialog box, see the procedures in *Using Gridline Properties* on page 790.

Color bands come in a pair, with each band uniquely colored. They appear in a continually repeating pattern behind a series on a chart. The contrast of colors is designed to make the chart easier to read.

Alternate formatting can be used to apply different colors to sections, called regions, of an axis.

The Format Grid Lines dialog box contains the following tabs:

- Major Grid Lines
- Minor Grid Lines
- Color Bands
- Frames

Use the Major Grid Lines tab to format the major gridlines on the chart.

The Major Grid Lines tab contains the following options:

- **Show Grid Lines.** Select this option to display major gridlines on a chart if minor gridlines are the default for the chart.

- **Line Style.** Click this icon to open the Line Style dialog box, where you can edit the color, weight, and style of the gridlines.

- **Show Ticks.** Select this check box to enable or disable the tick mark functionality.
Customizing Charts and Visualizations

- **Tick Style.** Select from this drop-down menu of tick styles (Inside, Outside, Spanning).

- **Line Style.** Click this icon to open the Line Style dialog box, where you can edit the color, weight, and style of the gridlines.

Use the Minor Grid Lines tab to format the minor gridlines on your chart.

The Minor Grid Lines tab contains the following options:

- **Show Grid Lines.** Select this option to display minor gridlines on a chart. By default, this option is enabled.

- **Line Style.** Click this icon to open the Line Style dialog box, where you can edit the color, weight, and style of the gridlines.

- **Grid count.** Set the number of minor gridlines that will appear between major gridlines.

- **Show Ticks.** Select this check box to enable or disable the tick mark functionality.

- **Tick Style.** Select from this drop-down menu of tick styles (Inside, Outside, Spanning).

- **Line Style.** Click this icon to open the Line Style dialog box, where you can edit the color, weight, and style of the gridlines.

Use the Color Bands tab to format the color bands on your chart.

The Color Bands tab contains the following options:

- **Band 1.** Select this option to add Band 1 to a chart.

  - **Color.** Click this icon to open the Color dialog box, where you can edit the color of Band 1.

  - **Transparency.** Move the slider to make Band 1 opaque (0%) or transparent (100%). The default is 0%.

  - %. Enter or select the percentage of the transparency of Band 1.

- **Band 2.** Select this option to add Band 2 to a chart.

  - **Color.** Click this icon to open the Color dialog box, where you can edit the color of Band 2.

  - **Transparency.** Move the slider to make the Band 2 opaque (0%) or transparent (100%). The default is 0%.

  - %. Enter or select the percentage of the transparency of Band 2.
Use the Frames tab to enable or disable frame regions, and to set the location and style of the frame text.

The Frames tab contains the following options:

- **Show Frame Regions.** Select this option to show a frame region. Clear this option to suppress a frame region.
  - **Region.** Select from this drop-down list, the region that you want to format.
  - **Add.** Click this button to add a region.
  - **Remove.** Click this button to remove a region.

- **Location.** Enter the location of the region.

- **Color.** Click this icon to open the Color dialog box, where you can edit the color of the frame.

- **Border Color.** Click this icon to open the Color dialog box, where you can edit the color of the frame border.

- **Text.** Enter the text that you want to appear on the frame.

- **Style Text.** Click this icon to style the frame text.

For instructions on how to open this dialog box, see the procedures in *Using Gridline Properties* on page 790.

**Gridline Elements Shortcut Menu**

When you right-click a gridline on a chart, a menu of options opens. The options for the gridline elements are described in the following table.
Using Gridline Properties

The following sections contain procedures for customizing gridlines.

Procedure: How to Display Horizontal Major Gridlines

If your chart does not display gridlines by default, use this procedure to generate gridlines.

1. Create a chart or visualization.
2. On the Format tab, in the Features group, open the Grid drop-down menu, point to Horizontal Gridlines, and then click Major Gridlines.

   Horizontal major gridlines are added to the chart.

Procedure: How to Display Horizontal Minor Gridlines

1. Create a chart or visualization.
2. Access the option to show gridlines in one of the following ways:

   - **Ribbon:** On the Format tab, in the Features group, open the Grid drop-down menu. On the Grid drop-down menu, point to Horizontal Gridlines, and then click Minor Gridlines.

   - **Shortcut Menu:** Right-click the gridlines on the chart, and click More Grid Lines Options. The Format Horizontal Grid Lines dialog box opens. On the Minor Grid Lines tab, select Show Grid Lines.

   Horizontal minor gridlines are added to the chart.
**Procedure: How to Display Vertical Major Gridlines**

1. Create a chart or visualization.
2. Access the option to show gridlines in one of the following ways:
   - **Ribbon:** On the *Format* tab, in the *Features* group, open the *Grid* drop-down menu. On the Grid drop-down menu, point to *Vertical Gridlines*, and then click *Major Gridlines*.
   - **Shortcut Menu:** Right-click the gridlines on the chart, and click *More Grid Lines Options*. The Format Vertical Grid Lines dialog box opens. On the Major Grid Lines tab, select *Show Major Grid Lines*.

Vertical major gridlines are added to the chart.

**Procedure: How to Display Vertical Minor Gridlines**

1. Create a chart or visualization.
2. Access the option to show gridlines in one of the following ways:
   - **Ribbon:** On the *Format* tab, in the *Features* group, open the *Grid* drop-down menu. On the Grid drop-down menu, point to *Vertical Gridlines*, and then click *Minor Gridlines*.
   - **Shortcut Menu:** Right-click the gridlines on the chart, and click *More Grid Lines Options*. The Format Vertical Grid Lines dialog box opens. On the Minor Grid Lines tab, select *Show Minor Grid Lines*.

Vertical minor gridlines are added to the chart.

**Procedure: How to Set the Color, Weight, and Style of a Gridline**

1. Open the Format Grid Lines dialog box in one of the following ways:
   - **Ribbon:** On the *Format* tab, in the *Features* group, open the Grid drop-down menu, point to the gridline type that you want to format, and click *More Grid Lines Options*.
   - **Shortcut Menu:** Right-click a gridline, and click *More Grid Lines Options*.

The Format Grid Lines dialog box opens.

2. Click the Line Style icon.
   - The Line Style dialog box opens.

3. Set the color, weight, and style of the gridlines.
4. Click *OK* to close the Line Style dialog box.
5. Click *OK* again to close the Format Grid Lines dialog box.
The gridlines are formatted accordingly.

The following image shows a line chart with styling applied to the gridlines.

**Procedure:** How to Set Ticks

Ticks are short lines which are perpendicular to a gridline. They are used to tick off specific increments along the gridline.

1. Create a chart or visualization with gridlines.
2. Open the Format Grid Lines dialog box in one of the following ways:
   - **Ribbon:** On the *Format* tab, in the *Features* group, open the Grid drop-down menu, point to the gridline type that you want to format, and click *More Grid Lines Options*.
   - **Shortcut Menu:** Right-click a gridline, and click *More Grid Lines Options*.

   The Format Grid Lines dialog box opens.
3. From the Tick Style drop-down menu select a tick style option. The options are:
   - Inside
   - Outside
   - Spanning
4. Click the Line Style icon to open the Line Style dialog box, where you can edit the color, weight, and style of the gridline.

5. Click OK to close the Line Style dialog box.

6. Click OK again to close the Format Grid Lines dialog box.

The tick marks are formatted accordingly.

The following image shows a chart with tick marks spanning both the vertical axis and horizontal axis.

---

**Procedure:** How to Set Color Bands

1. Create a chart or visualization with gridlines.

2. Open the Format Grid Lines dialog box in one of the following ways:

   - **Ribbon:** On the Format tab, in the Features group, open the Grid drop-down menu, point to the gridlines that you want to format, and click More Grid Lines Options.

   - **Shortcut Menu:** Right-click a gridline, and click More Grid Lines Options.

   The Format Grid Lines dialog box opens.

3. On the Color Bands tab, click the Color icon to open the Color dialog box, where you can set the color of the color bands.
4. Use the transparency slider, or the percentage box, to type or select the percentage of the transparency that you want to apply to the color.

5. Click OK to close the Color dialog box.

6. Click OK again to close the Format Grid Lines dialog box.

The following image shows a chart with color bands along the horizontal gridline.

![Chart with Color Bands](chart.png)

**Procedure:** How to Delete a Gridline

1. Create a chart or visualization with gridlines.

2. Select a gridline.

3. Delete the gridline in one of the following ways:

- **Ribbon:** On the Format tab, in the Features group, open the Grid drop-down menu. From the menu, point to the gridline that you want to format, and click More Grid Lines to open the Format Grid Lines dialog box. On the tab for the gridline that you want to delete, clear the Show Grid Lines option, and click OK.

- **Shortcut Menu:** Right-click the gridline, and from the menu, select Delete.

The gridline is deleted from the chart.
**Procedure:** How to Add Frames to Regions on a Chart

1. Create a chart or visualization.
2. On the **Format** tab, in the **Features** group, click **Grid**.
3. On the drop-down menu, point to either Horizontal Gridlines or Vertical Gridlines, and then click **More Grid Lines Options**.
   
The Format Grid Lines dialog box opens.
4. On the **Frames** tab, select the **Show Frame Regions** check box.
5. Click **Apply**.

Colored frames are added to the chart, using the default styling options. Optionally, you may use the color and border color options to change these.

The following image shows a bar chart with colored frames around each region.
**Formatting Axis Labels**

Vertical and horizontal axes are based on the orientation of the graph. For example, in a vertical graph, the horizontal axis refers to the X axis and the vertical axis refers to the Y axis. In a horizontal graph, the horizontal axis refers to the Y axis and the vertical axis refers to the X axis. This is important to consider, since options could change depending on the orientation of the graph.

A chart can contain the following types of axis labels:

- **Horizontal axis labels** represent the X axis. They do not apply to pie, funnel, or gauge charts.

- **Vertical axis labels** represent the Y1 axis in a single axis chart. They represent a numeric scale, usually located on the left side of a vertical chart.

- **Secondary horizontal and vertical labels** can only be used when dual axes charts are selected.

**Format Axis Dialog Box**

Whether you access axis options from the ribbon, or the shortcut menu, you are presented with the Format Axis dialog box of options for formatting for both vertical and horizontal axes. The Format Axis dialog box contains the following tabs:

- **Scale**
- **Title**
- **Labels**
- **Advanced**

**Reference: Format Vertical Axis Dialog Box**

You use the Format Vertical Axis dialog box to specify formatting options for the vertical axis in your chart.

Use the Scale tab to modify scale properties.
The Scale tab contains the following options:

- **Automatic Minimum.** Supplies the minimum value on the Y-axis scale automatically. To use manual scaling, clear this option. You can then set the minimum value by entering a number into the Value text box.
  - **Value.** Type the minimum value in this text box if you have not selected Automatic Minimum.

- **Automatic Maximum.** Supplies the maximum value on the Y-axis scale automatically. To use manual scaling, clear this option. You can then set the maximum value by entering a number into the Value text box.
  - **Value.** Type the maximum value in this text box if you have not selected Automatic Maximum.

- **Automatic Grid Step.** Calculates the number of major grid steps automatically. To use manual scaling, clear this option. You can then set the value by typing the number into the Value text box.
  - **Value.** Type the value in this text box if you have not selected Automatic Grid Step.

- **Logarithmic Scale.** Controls whether or not the Y-axis scale progresses logarithmically instead of linearly. This option is disabled by default. When selected, the logarithmic base is set to 10.0, but can be changed by entering another value.

- **Include zero on scale.** Controls whether or not a zero (0) value appears on the scale. This option is enabled by default.

Use the Title tab to show or hide the axis title, and create and style the title for the axis.

The Title tab contains the following options:

- **Show title.** Select this check box to show the axis title (default) or clear the check box to hide the axis title.

- **Text.** Type a title for the axis in the Text field.

- **Style text.** Opens the Style dialog box, where you can style the text.

Use the Labels tab to format the layout of the axis labels.
The Labels tab contains the following options:

- **Show Labels.** Displays labels next to the axis. This is enabled by default. Clear this option to suppress labels.

- **Axis side.** Contains a list of position options for the labels on the axis. The options are Left (default), Right, or Both.

- **Style labels.** Opens the Style dialog box, where you can style text.

- **Format Labels.** Contains a list of preset formats that can be applied to the labels.

- **Custom Format.** Allows you to use a custom format. This option is activated when Use Pattern /100 or Use Pattern are selected as the label format.

The Format Labels drop-down menu provides a list of preset formats that you can apply to labels. When you select a custom format, it must be defined using a custom format pattern. See the following table for a list and description of the characters that you can use in a custom format.

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>#</td>
<td>Is a digit.</td>
</tr>
<tr>
<td>0 (zero)</td>
<td>Shows as absent.</td>
</tr>
<tr>
<td>. (period)</td>
<td>Is a placeholder for a decimal separator.</td>
</tr>
<tr>
<td>, (comma)</td>
<td>Is a placeholder for a grouping separator.</td>
</tr>
<tr>
<td>; (semicolon)</td>
<td>Separates formats.</td>
</tr>
<tr>
<td>- (dash)</td>
<td>Is the default negative prefix.</td>
</tr>
<tr>
<td>% (percent)</td>
<td>Divides by 100 and shows as a percentage.</td>
</tr>
<tr>
<td>x</td>
<td>Determines that any other characters can be used in the prefix or suffix.</td>
</tr>
<tr>
<td>' (apostrophe)</td>
<td>Is used to quote special characters in a prefix or suffix.</td>
</tr>
</tbody>
</table>

Use the Advanced tab to modify additional axis properties.
The Advanced tab contains the following options:

- **Exclude Minimum Label.** Excludes the label with the lowest axis value from the chart.
- **Exclude Maximum Label.** Excludes the label with the highest axis value from the chart.
- **Descending Axis.** Draws the axis in descending order.
- **Show axis line.** Controls the display of the axis baseline.
  - **Line Style.** Opens the Line Style dialog box, where you can edit the color, weight, and style of the axis line.
- **Show zero line.** Controls the display of the zero line.
  - **Line Style.** Opens the Line Style dialog box, where you can edit the color, weight, and style of the zero line.
- **Custom Baseline.** Controls the display of the custom baseline.
  - **Value.** Type a value for the custom baseline.
  - **Line Style.** Opens the Line Style dialog box, where you can edit the color, weight, and style of the custom baseline.

For instructions on how to open this dialog box, see the procedures in *Using Axis Properties* on page 803.

**Reference:** Format Horizontal Axis Dialog Box

You use the Format Horizontal Axis dialog box to specify formatting options for the horizontal axis in your chart.

Use the Scale tab to modify scale properties.

The Scale tab contains the following options:

- **Automatic Minimum.** Supplies the minimum value on the Y-axis scale automatically. To use manual scaling, clear this option. You can then set the minimum value by entering a number into the Value text box.
  - **Value.** Type the minimum value in this text box if you have not selected Automatic Minimum.
Automatic Maximum. Supplies the maximum value on the Y-axis scale automatically. To use manual scaling, clear this option. You can then set the maximum value by entering a number into the Value text box.

Value. Type the maximum value in this text box if you have not selected Automatic Maximum.

Automatic Grid Step. Calculates the number of major grid steps automatically. To use manual scaling, clear this option. You can then set the value by typing the number into the Value text box.

Value. Type the value in this text box if you have not selected Automatic Grid Step.

Logarithmic Scale. Controls whether or not the Y-axis scale progresses logarithmically instead of linearly. This option is disabled by default. When selected, the logarithmic base is set to 10.0, but can be changed by entering another value.

Include zero on scale. Controls whether or not a zero (0) value appears on the scale. This option is enabled by default.

Use the Title tab to create and style the title for the axis.

The Title tab contains the following options:

Show title. Select this check box to show the axis title (default) or clear the check box to hide the axis title.

Text. Type a title for the axis in the Text field.

Style. Opens the Style dialog box, where you can style the text.

Use the Labels tab to format the layout of the axis labels.

The Labels tab contains the following options:

Show Labels. Displays labels next to the axis. This is enabled by default. Clear this option to suppress labels.

Axis side. Contains a list of position options for the labels on the axis. The options are Left (default), Right, or Both.

Style labels. Opens the Style dialog box, where you can style text.

Stagger Labels. Sets the labels to appear staggered.

Concatenate Labels. Concatenates the labels in your chart. This is enabled by default.
Format Labels. Contains a list of preset formats that can be applied to the labels.

Custom Format. Allows you to use a custom format. This option is activated when Use Pattern /100 and Use Pattern are selected as the format labels.

Use the Advanced tab to modify additional axis properties.

The Advanced tab contains the following options:

- Exclude Minimum Label. Excludes the label with the lowest axis value from the chart.
- Exclude Maximum Label. Excludes the label with the highest axis value from the chart.
- Descending Axis. Draws the axis in descending order.
- Show zero line. Controls the display of the zero line.

  - Line Style. Opens the Line Style dialog box, where you can edit the color, weight, and style of the zero line.

For instructions on how to open this dialog box, see the procedures in Using Axis Properties on page 803.

Secondary Axes Options

Formatting options are available for secondary axes in dual-axis charts. For example, in a vertical dual-axis chart, the secondary vertical axis refers to the Y2 axis.

The Format Secondary Axis dialog box contains the following tabs for both vertical and horizontal axes:

- General. For more information, see the Scale tab options in Format Axis Dialog Box on page 796.
- Title. For more information, see the equivalent tab in Format Axis Dialog Box on page 796.
- Labels. For more information, see the equivalent tab in Format Axis Dialog Box on page 796.
- Advanced. For more information, see the equivalent tab in Format Axis Dialog Box on page 796.

Axis Elements Shortcut Menu

When you right-click an axis label or title in a chart in Live Preview, a menu of options opens. The options for the right-click axis label elements are described in the following table.
<table>
<thead>
<tr>
<th>Element</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Axis Title</td>
<td>Delete</td>
<td>Deletes the axis title from the chart and updates the Live Preview accordingly.</td>
</tr>
<tr>
<td></td>
<td>Change Title</td>
<td>Enables you to change the axis title.</td>
</tr>
<tr>
<td></td>
<td>Style Title</td>
<td>Enables you to apply styling to the axis title, using the Style dialog box. For more information, see <em>Style Dialog Box</em> on page 779.</td>
</tr>
<tr>
<td>Horizontal Labels</td>
<td>Delete</td>
<td>Deletes labels from the chart and updates the Live Preview accordingly.</td>
</tr>
<tr>
<td></td>
<td>Stagger</td>
<td>Controls the positioning of the labels. The On value positions the labels in a zigzag pattern. The Off default value positions the labels in a straight row.</td>
</tr>
<tr>
<td></td>
<td>Rotate</td>
<td>Rotates the labels a specified number of degrees.</td>
</tr>
<tr>
<td></td>
<td>Style Labels</td>
<td>Enables you to apply styling to the labels, using the Style dialog box. For more information, see <em>Style Dialog Box</em> on page 779.</td>
</tr>
<tr>
<td></td>
<td>More Axis Options</td>
<td>Opens the Format Axis dialog box. For more information, see <em>Formatting Axis Labels</em> on page 796.</td>
</tr>
<tr>
<td>Vertical Labels</td>
<td>Delete</td>
<td>Deletes labels from the chart and updates the Live Preview accordingly.</td>
</tr>
<tr>
<td></td>
<td>Rotate</td>
<td>Rotates the labels a specified number of degrees.</td>
</tr>
<tr>
<td></td>
<td>Format Labels</td>
<td>Formats the labels according to the value that you specify.</td>
</tr>
<tr>
<td></td>
<td>Style Labels</td>
<td>Enables you to apply styling to the labels, using the Style dialog box. For more information, see <em>Style Dialog Box</em> on page 779.</td>
</tr>
<tr>
<td></td>
<td>More Axis Options</td>
<td>Opens the Format Axis dialog box. For more information, see <em>Formatting Axis Labels</em> on page 796.</td>
</tr>
</tbody>
</table>
Using Axis Properties

The following sections contain procedures for customizing an axis. The procedures are organized by the tab and group in which their associated options appear on the ribbon.

Axis labels appear by default.

Procedure: How to Delete Axis Labels

1. Create a chart or visualization.
2. You can delete axis labels in one of the following ways:

- **Ribbon:** On the *Format* tab, in the *Labels* group, open the *Axes* drop-down menu, point to the axis that you are working with, and clear the *Show Labels* option.

- **Shortcut Menu:** Right-click an axis label on the chart, and click *Delete*.

The axis labels are deleted from the chart.

Procedure: How to Stagger Axis Labels

**Note:** You can only apply a staggered effect to horizontal axis labels.

1. Create a chart or visualization with at least one axis label on display.
2. Access the Stagger option in one of the following ways:

- **Ribbon:** On the *Format* tab, in the *Labels* group, open the *Axes* drop-down menu, point to the axis that you are working with, and click *Stagger Labels*.

- **Shortcut Menu:** Right-click an axis label on the chart, point to *Stagger* and select *On*.

The axis labels are staggered.

Procedure: How to Rotate Axis Labels

1. Create a chart or visualization with axis labels.
2. Access the Rotate option in one of the following ways:

- **Ribbon:** On the *Format* tab, in the *Labels* group, open the *Axes* drop-down menu, point to the axis that you are working with, point to *Rotate Labels*, and then click the degree to which you want to rotate the axis labels.

- **Shortcut Menu:** Right-click an axis label on the chart, point to *Rotate*, and then click the degree to which you want to rotate the axis labels.

The axis labels are rotated.
**Procedure:** How to Format Axis Labels

1. Create a chart or visualization with an axis label.
2. Access the list of axis label options in one of the following ways:
   - **Ribbon:** On the *Format* tab, in the *Labels* group, open the Axes drop-down menu, point to the axis that you are working with, and click *More Axis Options* to open the Format Axis dialog box. Open the Labels tab, and from the Labels option drop-down menu, select the formatting option that you want.
   - **Shortcut Menu:** Right-click an axis label, point to Format Labels, and click the formatting option that you want.

   The axis labels are formatted accordingly.

**Procedure:** How to Manually Set the Scale of an Axis

1. Create a chart or visualization.
2. Open the Format Axis dialog box in one of the following ways:
   - **Ribbon:** On the *Format* tab, in the *Labels* group, open the Axes drop-down menu, point to the axis that you are working with, and click *More Axis Options*.
   - **Shortcut Menu:** Right-click an axis value on the chart, and click *More Axis Options*.

   The Format Axis dialog box opens.
3. On the scale tab, clear the *Automatic Minimum* option and enter your own minimum value in the *Value* text box.
4. Clear the *Automatic Maximum* option, and enter your own maximum value in the *Value* text box.
5. Clear the *Automatic Grid Step* option, and enter your own grid step value in the *Value* text box.
6. Optionally, you can select the *Logarithmic Scale* option and enter the log scale base in the text field of that name. You can also clear the *Include zero on scale* option if you do not want zero to appear on the axis.
7. Click *OK* to close the dialog box.

   The axis scale is set accordingly.

**Procedure:** How to Add an Axis Title

1. Create a chart or visualization with an axis label.
2. Open the Format Axis dialog box in one of the following ways:

   - **Ribbon:** On the *Format* tab, in the *Labels* group, open the Axes drop-down menu, point to the axis that you are working with, and click *More Axis Options*.

   - **Shortcut Menu:** Right-click an axis label, and click *More Axis Options*.

   The Format Axis dialog box opens.

3. On the *Title* tab, type the axis title in the *Text* field.

4. Click the *Style* text icon to open the Style dialog box, where you can style the text.

   The axis title is styled accordingly.

   **Note:** Right-click the axis title to delete, change, or style the axis title.

**Procedure:** How to Set Advanced Axis Properties

1. Create a chart or visualization with an axis label.

2. Open the Format Axis dialog box in one of the following ways:

   - **Ribbon:** On the *Format* tab, in the *Labels* group, open the Axes drop-down menu, point to the axis that you are working with, and click *More Axis Options*.

   - **Shortcut Menu:** Right-click an axis label, and click *More Axis Options*.

   The Format Axis dialog box opens.

3. On the *Advanced* tab, set the following options:

   - Exclude Minimum Label
   - Exclude Maximum Label
   - Descending Axis
   - Show zero line

   You can edit the color, weight, and style of all the lines that you set in the Line Style dialog box.

4. Click *OK*.

   The axis advanced options are set accordingly.

**Formatting a Frame and a Background**

The frame of a chart is the area that contains the plot points. It is also the area in which horizontal and vertical gridlines are drawn.
The background of a chart is the area around the frame.

You can adjust the appearance of the frame and background to achieve different visual effects for your charts. For example, you can change the appearance of the chart frame line, or you can change the color of the background of your chart, as shown in the following image.

![Chart with different background colors](chart.jpg)

**Frame & Background Dialog Box**

Whether you access frame and background options from the ribbon, or the shortcut menu, you are presented with the Frame & Background dialog box of options for formatting the frame and background of a chart. The Frame & Background dialog contains the following tabs:

- Frame
- Frame Edge
- Background

The Frame & Background dialog box and pertinent tabs are discussed in this section for the following types of charts:

- 2D Charts and 2D Charts with 3D Effects (Frame and Frame Edge tabs)
- Pie Charts (Frame and Frame Edge tabs)
3D Charts (Left Wall, Right Wall, Floor, and Advanced tabs)

Note: The options in the Frame tab vary based on the chart type selected.

Use the Frame tab for 2D charts and 2D charts with 3D effects to set a frame depth angle and depth radius, select a fill for a frame, and set a shadow for a frame for these types of charts.

The Frame tab for 2D charts and 2D charts with 3D effects contains the following options:

- **Depth Angle.** Enter the angle from the front of the chart to the back where the chart risers and frames are drawn. You can set the depth angle from zero to 180 degrees, but it must be used along with Depth Radius.

- **Depth Radius.** Enter how far out the extruded frame will be extended. Small values, such as zero, produce very narrow charts. Large values, the maximum being 100, produce thicker charts.

**Fill**

- **No fill.** (Default). Select this option to keep the legend colorless.

- **Solid fill.** Select this option to display the Color and Transparency options.
  - **Color.** Click this icon to open the Color dialog box, where you can select a color for a frame.
  - **Transparency.** Move the slider to make the frame opaque (0%) or transparent (100%). The default is 0%.

- **Gradient fill.** Select this option to display the direction of the gradient, the color pattern of the gradient, and the degrees of transparency for the two colors that make up the gradient. A gradient is a smooth color transition or blending of one color to another. The number of colors to use in a gradient is defined by the stop or pin elements.
  - **Direction.** Select from this drop-down menu to set the direction of the gradient fill. For example, Gradient right or Gradient left.

**Gradient style**

- **Color Pattern.** Select the color pattern for the data series. The color pattern option on the left is an AB wash that uses two colors in the pattern color1 - color2, for example, red-green. The color pattern option on the right is an ABA wash that uses two colors in the pattern color1 - color2 - color1, for example, red-green-red.

- **First Color.** Click this icon to open the Color dialog box, where you can select a color for the first color.
- **Second Color.** Click this icon to open the Color dialog box, where you can select a color for the second color.

**Shadow**

- **Show Shadow.** Select this option to set a shadow.

Use the Frame Edge tab for 2D charts and 2D charts with 3D effects to set a frame depth angle and depth radius, select a fill for a frame, and set a shadow for a frame for these types of charts.

The Frame tab for 2D charts and 2D charts with 3D effects contains the following options:

- **Automatically Shade Frame Edge.** Select this option to automatically shade the frame edge. Clear this option to enable the Side Frame and Bottom Frame options.

**Side Frame**

- **Show Color.** Select this option to show the color of the side frame.

- **Color.** Click this icon to open the Color dialog box, where you can select a color for the side frame.

- **Show Border Color.** Select this option to show the color of the border of the side frame.

- **Border Color.** Click this icon to open the Color dialog box, where you can select a color for the border of the side frame.

**Bottom Frame**

- **Show Color.** Select this option to show the color of the bottom frame.

- **Color.** Click this icon to open the Color dialog box, where you can select a color for the bottom frame.

- **Show Border Color.** Select this option to show the color of the bottom frame.

- **Border Color.** Click this icon to open the Color dialog box, where you can select a color for the border of the bottom frame.

Use the Frame tab for pie charts to set pie depth and tilt, select a fill and color for a pie frame, and set a shadow for the frame.

The Frame tab for pie charts contains the following options:

- **Pie Depth.** Set the depth of the edge of a pie chart. You can select a value from zero to 100 to set the thickness of an edge.
Pie Tilt. Set the tilt of the pie chart. The smaller the value you add, the flatter the pie chart appears. The larger the value you add, more of the pie edge appears.

Fill

- **No fill.** (Default). Results in no color added to the edge of the pie.
- **Solid fill.** Select this option to display the Color and Transparency options.
  - **Color.** Click this icon to open the Color dialog box, where you can select a color for the frame.
  - **Transparency.** Move the slider to make the fill opaque (0%) or transparent (100%). The default is 0%.

- **Gradient fill.** Select this option to display the direction of the gradient, the color pattern of the gradient, and the degrees of transparency for the two colors that make up the gradient. A gradient is a smooth color transition or blending of one color to another. The number of colors to use in a gradient is defined by the stop or pin elements.
  - **Direction.** Select from this drop-down menu to set the direction of the gradient fill. For example, Gradient right or Gradient left.

Gradient Style

- **Color Pattern.** Select the color pattern for the data series. The color pattern option on the left is an AB wash that uses two colors in the pattern color1 - color2, for example, red-green. The color pattern option on the right is an ABA wash that uses two colors in the pattern color1 - color2 - color1, for example, red-green-red.
  - **First Color.** Click this icon to open the Color dialog box, where you can select a color for the first color.
  - **Second Color.** Click this icon to open the Color dialog box, where you can select a color for the second color.

Shadow

- **Show Shadow.** Select this option to set a shadow around the frame.

Use the Frame Edge tab for pie charts to set the edge of a pie frame.
The Frame Edge tab for pie charts contains the following options:

- **Automatically Shade Frame Edge.** Select this option to automatically shade the frame edge. Clear this option to enable the Side Frame and Bottom Frame options.

- **Show Color.** Select this option to show the color of the side frame.

- **Color.** Click this icon to open the Color dialog box, where you can select a color for side frame.

- **Show Border Color.** Select this option to show the color of the border of the side frame.

- **Border Color.** Click this icon to open the Color dialog box, where you can select a color for the border of the side frame.

**Bottom Frame**

- **Show Color.** Select this option to show the color of the bottom frame.

- **Color.** Click this icon to open the Color dialog box, where you can select a color for the bottom frame.

- **Show Border Color.** Select this option to show the color of the bottom frame.

- **Border Color.** Click this icon to open the Color dialog box, where you can select a color for the border of the bottom frame.

Use Wall and Floor tabs to set the walls and floor of a 3D chart.

These Wall and Floor tabs contain the following options:

- **Show Wall** or **Show Floor.** Select this option to show the wall or floor (depending on the tab) of the 3D chart.

- **Wall Thickness.** Specify the thickness of the wall or floor.

- **Cube Size.** Specify the cube size of the wall or floor.

- **Color.** Click this icon to open the Color dialog box, where you can select a color for the wall or floor.

- **Border Color.** Click this icon to open the Color dialog box, where you can select a color for the border of the wall or floor.

- **Show Wall (Left Wall).** Select this option to show the left wall.

- **Show Wall (Right Wall).** Select this option to show the right wall.
Show Floor. Select this option to show the floor.

Use the Advanced tab for 3D charts to modify additional properties for 3D frames.

The Advanced tab contains the following options:

- Viewing Angles. Select from a drop-down menu of viewing angles for three-dimensional charts. For example, Standard or Group View.

- Isometric Projection. Select this option to ignore perspective distortion in a project graph cube from an isometric view.

- Proportional Cube. Select this option to define the axis size proportional to the number of series or groups.

- Automatic shading of walls. Select this option to shade chart walls.

- Automatically Shade Frame Edge. Select this option to automatically shade the frame edge.

- 3D Zoom Factor. Enter a value in the text box to set the global scaling factor for zooming in and out in a 3D chart. Smaller values zoom out and produce a smaller display of the chart within a frame. Larger values zoom in and produce a larger display of the chart within a frame.

- Pan Horizontally. Enter a value in the text box to pan a 3D chart in the horizontal direction. Smaller values move the frame of the chart to the left. Larger values move the frame of the chart to the right.

- Pan Vertically. Enter a value in the text box to pan a 3D chart in the vertical direction. Smaller values move the frame of the chart upward. Larger values move the frame of the chart downward.

Use the Background tab to set and customize a border for a chart.

The Background tab contains the following options:

- Show Border Color. Select this option to show the color of the border.

- Border Color. Click this icon to open the Color dialog box, where you can select a color for the border.

- Solid fill. Select this option to display the Color and Transparency options.

- Color. Click this icon to open the Color dialog box, where you can select a color for the frame.
- **Transparency.** Move the slider to make the background opaque (0%) or transparent (100%). The default is 0%.

- **Gradient fill.** Select this option to display the direction of the gradient, the color pattern of the gradient, and the degrees of transparency for the two colors that make up the gradient. A gradient is a smooth color transition or blending of one color to another. The number of colors to use in a gradient is defined by the stop or pin elements.

- **Direction.** Select from this drop-down menu to set the direction of the gradient fill. For example, Gradient right or Radial.

**Gradient Style**

- **Color Pattern.** Select the color pattern for the data series. The color pattern option on the left is an AB wash that uses two colors in the pattern color1 - color2, for example, red-green. The color pattern option on the right is an ABA wash that uses two colors in the pattern color1 - color2 - color1, for example, red-green-red.

- **First Color.** Click this icon to open the Color dialog box, where you can select a color for the first color.

- **Second Color.** Click this icon to open the Color dialog box, where you can select a color for the second color.

For instructions on how to open this dialog box, see the procedures in *Using Frame and Background Properties* on page 813.

**Frame and Background Shortcut Menu**

When you right-click a chart background, a menu of options opens. The options for the background and frame elements are described in the following table.
### Using Frame and Background Properties

The following sections contain procedures for customizing frame and background properties. The options for the following procedures are found in the Features group of the Format tab.

**Procedure:** How to Change the Color of the Frame

The default color of the frame in a chart is determined by the Document Theme selected on the Options dialog box. For more information, see *Changing InfoAssist User Preferences* on page 284.

<table>
<thead>
<tr>
<th>Element</th>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Background</td>
<td>Background Color</td>
<td>Enables you to specify the color of the background, using the Color dialog box. For instructions, <em>How to Change the Color of the Background</em> on page 814.</td>
</tr>
<tr>
<td></td>
<td>Show legend</td>
<td>Controls the display of the legend on the background. When selected, it displays the legend. When cleared, it suppresses the display of the legend.</td>
</tr>
<tr>
<td></td>
<td>More Frame and</td>
<td>Opens the Frame &amp; Background dialog box. For more information, see <em>Frame &amp; Background Dialog Box</em> on page 806.</td>
</tr>
<tr>
<td></td>
<td>Background Options</td>
<td></td>
</tr>
<tr>
<td>Frame</td>
<td>Frame Color</td>
<td>Enables you to specify the color of the frame, using the Color dialog box. For more information, see <em>Color Dialog Box</em> on page 751.</td>
</tr>
<tr>
<td></td>
<td>Show 3D</td>
<td>Controls the depth of the frame. The value <strong>On</strong> renders the frame in 3D depth. The value <strong>Off</strong> renders the frame in one dimension.</td>
</tr>
<tr>
<td></td>
<td>More Frame and</td>
<td>Opens the Frame &amp; Background dialog box. For more information, see <em>Frame &amp; Background Dialog Box</em> on page 806.</td>
</tr>
<tr>
<td></td>
<td>Background Options</td>
<td></td>
</tr>
</tbody>
</table>
This procedure describes how to change the color of the frame.

1. Create a chart or visualization.

2. Access the Frame & Background dialog box in one of the following ways:
   - **Ribbon:** On the *Format* tab, in the *Features* group, click *Frame & Background*.
   - **Shortcut Menu:** Right-click the chart, and click *More Frame & Background Options*.

   The Frame & Background dialog box opens.

3. On the Frame tab, in the Fill area, click the *Color* icon.

   **Note:** Solid fill must be selected for the Color icon to appear.

   The Color dialog box opens. Select a new color for the frame. For more information on the Color dialog box, see *Color Dialog Box* on page 751. You can also set the depth angle and depth radius for the frame, as well as set a shadow for the frame.

4. Click *OK*.

   The chart displays the new frame color.

**Procedure:**  **How to Change the Color of the Background**

The default color of the background of a chart is determined by the Document Theme selected on the Options dialog box. For more information, see *Changing InfoAssist User Preferences* on page 284.

1. Create a chart or visualization.

2. Open the Frame & Background dialog box in one of the following ways:
   - **Ribbon:** On the *Format* tab, in the *Features* group, click *Frame & Background*.
   - **Shortcut Menu:** Right-click the background of the chart, and click *Background Color*.

   The Frame & Background dialog box opens.

3. On the Background tab, in the Background Fill area, click the *Color* icon.

   The Color dialog box opens. Select a new color for the background. For more information on the Color dialog box, see *Color Dialog Box* on page 751.

4. Click *OK*.

   The chart displays the new background color.
Formatting a Gauge Chart

A gauge chart is a circular chart that indicates the current position of a single data value within a given spectrum.

You can change the appearance of a gauge chart by using the gauge chart options found on the Format Gauge dialog box. To access the Format Gauge dialog box, on the Format tab, in the Features group, click Gauges.

Format Gauge Dialog Box

Whether you access gauge options from the ribbon, or the shortcut menu, you are presented with the Format Gauge dialog box of options for formatting a gauge chart. Such options include setting and styling a title for the gauge chart, setting tick marks, enabling and styling color bands, as well as setting advanced options, such as the gauge start and stop angle.

The Format Gauge dialog box contains the following tabs:

- General Options
- Axis Scale & Labels
- Tick Marks
- Bands
- Advanced

Use the General Options tab to set general gauge options.

The General Options tab contains the following options:

- **Gauges per row.** Enter or select how many gauges appear on each row. The default setting displays two gauge charts. A maximum of 32 gauge charts can appear on each row.

  **Note:** The number of charts displayed per row can differ, based on the output format selected. For example, HTML format will display two charts per row, and HTML5 will display three.

**Gauge Title**

- **Show title.** (Default) Displays a gauge title appear for each gauge. Clear this option to suppress the title.

- **Position.** Select a position for the gauge title. Above is the default value.

- **Style.** Click this icon to open the Style dialog box, where you can style text.
Gauge value

- **Show value.** (Default) Clear this option to suppress the gauge value.
- **Style.** Click this icon to open the Style dialog box, where you can style text.
- **Format Value.** Contains a list of preset formats that can be applied.
- **Custom Format.** Allows you to use a custom format. This option is activated when *Use Pattern /100* or *Use Pattern* are selected as the label format.

Use the Axis Scale & Labels tab to set the axis scale and label properties for the gauge needle.

The Axis Scale & Labels tab contains the following options:

**Scale**

- **Automatic Minimum.** (Default) Sets the engine to automatically supply the minimum value on the scale. Clear this option to manually set the minimum value by entering a number into the Value text box.

- **Value.** Enter the minimum value in this text box if you have not selected Automatic Minimum.

- **Automatic Maximum.** (Default) Sets the engine to automatically supply the maximum value on the scale. Clear this option to manually set the maximum value by entering a number into the Value text box.

- **Value.** Enter the maximum value in this text box if you have not selected Automatic Maximum.

**Labels**

- **Show Labels.** (Default) Displays labels next to the axis. Clear this option to suppress labels.

- **Style Labels.** Click this icon to opens the Style dialog box, where you can style text.

- **Format Labels.** Select from a drop-down menu of present formats that can be applied to the labels. When a custom format is selected, the format must be defined using a custom format pattern. For a list and description of the characters that you can use in a custom format, see the table in *Formatting Data Labels* on page 775.

- **Custom Format.** Text field to enter the custom format that you want to use.

The Tick Marks tab contains options to format tick marks on a gauge chart.
The Tick Marks tab contains the following options for both major and minor ticks:

- **Automatic Grid Step.** (Default) Automatically calculates the number of major grid steps in a gauge chart. Clear this option to manually set the value by entering a number in the Value text box.

- **Value.** Enter the value in this text box if you have not selected Automatic Grid Step.

- **Tick Color.** Click this icon to open the Color dialog box, where you can select a color for the tick marks.

- **Tick Mark Length.** Enter a value for the relative length of major tick marks in a gauge chart. The valid range is from 0.0 to 0.5. If you set the smallest value, major tick marks do not appear.

The Bands tab contains options to format the color of the scale background on a gauge chart.

The Bands tab contains the following options:

- **Band 1.** Opens a drop-down menu of available bands.
  - **Add.** Adds the band selected from the drop-down menu of bands to the gauge chart. You can create up to five bands for a gauge chart.
  - **Remove.** Removes the band selected from the drop-down menu of bands to the gauge chart.

- **Minimum Value.** Enter a minimum value to a quality band in the gauge chart.

- **Maximum Value.** Enter a maximum value to a quality band in the gauge chart.

- **Border Color.** Opens the Color dialog box, where you can edit the color of the gauge band border.

**Fill**

- **No fill.** Removes fill from the quality band.

- **Solid fill.** (Default) Applies a solid color to the quality band.

- **Color.** Click this option to open the Color dialog box, where you can select the color for the quality band.

- **Transparency.** Move the slider to make the band opaque (0%) or transparent (100%). The default is 0%.

The Advanced tab contains options to set additional properties for the gauge needle.
The Advanced tab contains the following options:

- **Descending Axis.** Select this option to draw the gauge scale in descending order. When this option is cleared (default), the gauge scale is drawn in ascending order.

- **Show Zero Label.** Displays the zero label on the axis scale. Clear this option to start the gauge at another value. This option is selected by default.

- **Gauge Start Angle.** Enter a value to rotate the gauge start angle to a specified number of degrees. Values can range from 0 to 359 degrees. The default is 220 degrees.

- **Gauge Stop Angle.** Enter a value to rotate the gauge stop angle to a specified number of degrees. Values can range from 0 to 359 degrees. The default is 320 degrees. Setting a start angle to 0, and a stop angle to 180, creates a semi-circle.

- **Relative Inner Radius.** Enter a value to define the inner radius of the gauge bands and labels relative to the outer background of the gauge. Smaller values, such as 0.0, place the inner radius closer to the center of the gauge. A maximum value of 1.0, places the inner radius close to the gauge outline.

- **Relative Thickness.** Enter a value to define the relative thickness of the gauge bands. Values can range from 0.0 to 1.0.

**Gauge Elements Shortcut Menu**

When you right-click a gauge chart, a menu containing the More Gauge Options becomes available. Select this option to open the Format Gauge dialog box. This is only available when using the HTML output format.

**Using Gauge Properties**

The following sections contain procedures for gauge properties. The Gauges option can be found on the Format tab, in the Features group.

**Note:** This option is only available when you are working with a gauge chart.

**Procedure: How to Set the Number of Gauges Per Row**

If you have multiple gauges on a chart, you might want to specify how many gauges appear on each row.

1. Create a gauge chart that has multiple values.
2. Open the Format Gauge dialog box in one of the following ways:
   - **Ribbon:** On the Format tab, in the Features group, click Gauges.
Shortcut Menu: Right-click the gauge chart and select More Gauge Options.

The Format Gauge dialog box opens.

3. On the General options tab, in the Gauges per row field, enter or select the number of gauges that you want to appear on one row.

4. Click OK.

After changing the setting from the default of 2 gauges per row to the number of values in the chart, all the gauges now appear on one row.

Procedure: How to Set the Minimum and Maximum Axis Scale Values

1. Create a gauge chart.

2. Open the Format Gauge dialog box in one of the following ways:

   ❑ Ribbon: On the Format tab, in the Features group, click Gauges.

   ❑ Shortcut Menu: Right-click the gauge chart, and click More Gauge Options.

   The Format Gauge dialog box opens.

3. On the Axis Scale & Labels tab, in the Scale area, either accept the minimum and maximum values for the scale automatically supplied by the chart engine, or enter your own in the Value fields.

4. Click Apply.

   The gauge scale reflects the selections that you have made.

Procedure: How to Style Axis Labels

1. Create a gauge chart.

2. Open the Style dialog box in one of the following ways:

   ❑ Ribbon: On the Format tab, in the Features group, click Gauges to open the Format Gauge dialog box. In the Format Gauge dialog box, open the Axis Scale & Labels tab. In the Labels area, click the Style Labels icon.

   ❑ Shortcut Menu: Right-click an axis label, and click Style.

   The Style dialog box opens.

3. Select your styling options.

4. Click OK.

   The scale labels reflect the style selections that you have made.
Procedure: How to Format Axis Labels
1. Create a gauge chart.
2. Access the menu of available format options for axis labels in one of the following ways:
   - **Ribbon:** On the *Format* tab, in the *Features* group, click *Gauges* to open the Format Gauge dialog box. In the Format Gauge dialog box, open the Axis Scale & Labels tab. In the Labels area, open the *Format Labels* drop-down menu.
   - **Shortcut Menu:** Right-click an axis label, and point to *Format*. The menu of available format options opens.
3. Select your format option.
   - **Note:** If you select a custom format (for example, User Pattern, or Use Pattern /100), from the Format Labels menu on the Format Gauge dialog box, the Custom Format menu becomes available. When you select a custom format, it must be defined using a custom format pattern. For a list and description of the characters that you can use in a custom format, see the table in *Formatting Data Labels* on page 775.
4. Click OK.
   - The scale labels reflect the format selection that you have made.

Procedure: How to Rotate Axis Labels
1. Create a gauge chart.
2. Right-click an axis label.
3. On the shortcut menu, point to *Rotate*, then select the degree to which you want the labels rotated.

Procedure: How to Set Gauge Tick Marks
This procedure describes how to set the grid step, tick color, and tick length for the major and minor tick marks.
1. Create a gauge chart.
2. Open the Format Gauge dialog box in one of the following ways:
   - **Ribbon:** On the *Format* tab, in the *Features* group, click *Gauges*.
   - **Shortcut Menu:** Right-click the gauge chart and select *More Gauge Options*.
   - The Format Gauge dialog box opens.
3. On the Tick Marks tab, for the *Automatic Grid Step*, either accept the value automatically supplied by the chart engine, or enter your own, in the Value fields.

4. Click the *Tick Color* icon, to open the Color dialog box, where you can select a color for the tick mark.

5. For the *Tick Mark Length*, either accept the value automatically supplied by the chart engine, or enter your own, in the Value fields.

**Procedure: How to Set Gauge Color Bands**

1. Create a gauge chart.

2. Open the Format Gauge dialog box in one of the following ways:
   - **Ribbon:** On the *Format* tab, in the *Features* group, click *Gauges*.
   - **Shortcut Menu:** Right-click the gauge chart, and click *More Gauge Options*.

   The Format Gauge dialog box opens.

3. Set the minimum and maximum value for each band that you want to appear on the gauge chart.

4. Set the color of the fill and border for each color band.
   - **Note:** The gradient fill option is not available for color bands.

5. Click *OK* to close the Format Gauge dialog box.

   The bands are formatted accordingly.

**Procedure: How to Match Needle Center Color to Band Color (Gauge Center by Quality)**

This option matches the needle center color to the color of the band that the needle is pointing to.

1. Create a gauge chart.

2. On the *Format* tab, in the *Features* group, click *Gauges*.

   The Format Gauge dialog box opens.

3. On the Bands tab, set the minimum and maximum value for each band that you want to appear on the gauge chart.

4. Set the color of the fill and border for each color band.
   - **Note:** The gradient fill and transparency options are not available for gauge needles.

5. On the Advanced tab, select *Gauge Center by Quality*.
   - **Note:** This option displays in HTML, but not in HTML5.
6. Click OK to close the Format Gauge dialog box.

   The color of the center of the gauge needle now matches the color of the band.

**Procedure: How to Style a Gauge Needle**

This procedure explains how to change the gauge needle from the Normal style to the Pencil style.

1. Create a gauge chart.
2. Open the Format Gauge dialog box in one of the following ways:
   - **Ribbon:** On the Format tab, in the Features group, click Gauges.
   - **Shortcut Menu:** Right-click the gauge chart, and click More Gauge Options.
3. The Format Gauges dialog box opens.
4. In the General Options tab, in the Gauge Needle section, from the Style drop-down menu, select Pencil.
5. Click OK.

   The gauge needle changes to a pencil.

**Procedure: How to Set Gauge Needle Colors in a Multi Series Gauge Chart**

You cannot change the fill color and border color of the needles in a multi-series gauge chart through the General Options tab of the Format Gauge dialog box. You can do so through the Format Series dialog box. However, you can still use the General Options tab to change the style of the needle.

1. Create a gauge chart with more than one measure field.
2. On the Series tab, from the Series drop-down menu, select the series that you want to style.
3. In the Properties group, click Style.

   The Format Series dialog box opens.
4. On the Fill tab, select the fill and color options for the gauge needle for the selected series.
5. On the Border tab, select the Show Border Color option, if you want the gauge needle to have a border. You can select the color for the border, as well.
6. Click Apply.
7. Repeat steps 2 through 5 for each series gauge needle that you want to style.
8. When you are finished, click OK to close the Format Series dialog box.
   The color of the gauge needles and their borders changes accordingly.

**Formatting Page Headings and Page Footings**

Page headings and page footings supply context and key information about a chart, such as its purpose, audience, and author. Page headings and page footings also enhance visual appeal.

**Procedure: How to Add a Page Heading and Page Footing to a Chart**

The procedure uses sample values, but you can supply values that apply to your own charts.

This feature is available in Query Design view, Live Preview, and Document view.

1. Create a chart or visualization.
2. On the **Home** tab, in the **Report** group, click **Header & Footer**.
   
   The Header & Footer dialog box opens.

   **Tip:** Another way to access the Heading & Footing dialog box is to click the arrow next to the Header & Footer button. Doing so opens a drop-down menu from which you can select the heading or footing that you want to work with. After you make your selection, the Header & Footer dialog box opens, and the heading or footing that you selected is active.

3. Click the tab for the page heading or page footing, depending on which you want to add.
   
   By default, the Page Heading tab is selected. In this procedure, accept the default to add a page heading first.

4. Click inside the design area of the dialog box, and type the text for the page heading.
   
   For example, the text for a sample page heading might be Customers By Occupation.

5. Using the styling options, apply styling to the page heading text.
   
   For example, 14 pt. bold Helvetica with center alignment.

6. Click **Apply** to save the changes that you have made, without closing the dialog box.

7. To add a page footing, click the **Page Footer** tab.
   
   For this procedure, you are going to add one of the supplied quick text options, followed by some text of your own.

8. Click the down arrow next to the preformatted text button, and click **Created by** from the drop-down list.

9. Complete the text by typing the applicable value within the supplied text, for example, **Sales Manager**.
10. Change the styling as you want.

11. Click OK to save the page heading and page footing and close the Header & Footer dialog box.

The chart contains the page heading and page footing that you added and styled.

The following image shows a chart with a styled header and footer.

12. To make changes to either the page heading or page footing, return to Design view. Right-click the header or footer, and click Edit from the drop-down menu.

**Procedure:** How to Control the Rendering of a Page Heading and Page Footing

You can control the way in which a page heading and page footing are rendered on a chart at run time.

1. Create a chart or visualization.

2. Open the Header & Footer dialog box, as described in *How to Add a Page Heading and Page Footing to a Chart* on page 823.

3. Click the Text options for chart button .

   A drop-down menu, with two options for rendering the page heading and page footing, opens.
Tip: Your selection for a page heading also applies to a page footing, and vice versa.

- Create Header and Footer as text renders the heading and footing as text elements that are separate from the chart image.
- Embed Header and Footer in the chart renders the heading and footing text as part of the chart image. This is the default value.

4. Click OK to save your selection and close the Heading & Footing dialog box.

Using Additional Formatting Features

This section describes additional formatting features that are available for charts.

**Procedure:** How to Set 3D Depth on a Bar Chart

You can apply a 3D-effect to a 2D-chart.

**Note:** If you find that the depth of the 3D effect makes it difficult to distinguish the values on the Y-axis scale, then you can turn this option off. This procedure explains how to set the 3D effect for a default vertical bar chart.

The following image shows a bar chart before the 3D effect is applied.

1. Create a 2D chart.
2. In Live Preview, apply the 3D effect in one of the following ways:

- **Ribbon:** On the *Format* tab, in the *Features* group, click *3D Effect*.

- **Shortcut Menu:** Right-click the frame of the chart, point to *Show 3D*, and click *On*.

The 3D effect is applied to the chart, as shown in the following image.

![3D Chart Image](image-url)

*Procedure: How to Rotate a Chart*

You can rotate bar, line, and area charts to change the orientation of the data.

1. Create a chart or visualization.

2. On the *Format* tab, in the *Features* group, click *Rotate*.

   The chart is rotated 90 degrees clockwise.

*Procedure: How to Sort a Chart by Total Value*

Once you create a bar, line, or area chart, you can sort the results in ascending or descending order. While this feature was implemented specifically for Stacked Bar charts, it also applies to other chart types, as previously mentioned. This feature enables you to view your data in numerical order, allowing you to identify trends and determine what data points are priorities.
Note: This feature is available in Chart and Visualization mode.

1. Create a bar, line, or area chart with at least one measure and one dimension.
2. In the Query pane, right-click on the Horizontal Axis and point to Sort by Total Value.
3. From the cascading menu, select Ascending to sort the chart from the lowest value to the highest value, as shown in the following image.

![Chart with ascending sort]

4. Select Descending to sort the chart from the largest value to the lowest value.

Procedure: How to Display a Static Reference Line

Reference lines draw attention to specific data locations on a chart. You can add up to three horizontal (X axis) and three vertical (Y axis) reference lines to a chart.

Reference lines can be created using either a constant or a computed field.

Field values allow a property to be dynamic, so that the reference line can change position dynamically on the chart depending on the value of the field that is assigned to it.

Note: A reference line value should be a single value, such as 10K, for example. In the Reference Line dialog box, if you select a field with multiple values, (Quantity Sold, for example), then InfoAssist plots the last value on the chart.

1. Create a chart or visualization.
2. On the Format tab, in the Features group, click Reference.

3. In the drop-down menu that opens, select one of the following:
   - Add Reference Line to Y-Axis
   - Add Reference Line to X-Axis

   The Reference Line dialog box opens.

4. Create the reference line with a static value that you set.
   a. Select the Value option.
   b. In the Value text field, type the value that you want to distinguish with the reference line.

5. In the Text field, type the text for the reference line.

6. In the Position drop-down menu, select the position for the reference line on the chart. For example, Above Center.

7. Click the Style button to set the style for the reference line. For example, Solid.

8. Click the Color button to open the Color dialog box, where you can select a color for the reference line and the text.

9. Click the Weight button to select the weight of the reference line. For example, 1px - Light.

10. Click OK to save the options that you have selected, and close the Reference Line dialog box.

   The reference line is added to the chart.

**Procedure:** How to Display a Dynamic Reference Line

Reference lines can be created using either a constant or a computed field.

Field values allows a property to be dynamic, so that the reference line can change position dynamically on the chart depending on the value of the field that is assigned to it.

**Note:** A reference line value should be a single value, such as 10K, for example. In the Reference Line dialog box, if you select a field with multiple values, (Quantity Sold, for example), then InfoAssist plots the last value on the chart.
The following procedure provides an example of how to create a dynamic reference line, where the value changes based on the date. In this example, you can track the number of estimated delivery days per shipping company, where the number of days estimated for delivery are based on whether or not the sale date is a holiday. This example uses the wf_retail_lite sample data.

1. **Create a COMPUTE field to calculate the Reference Line.**
   a. On the **Data** tab, in the **Calculation** group, click **Summary (Compute)**.  
      The Summary Field (COMPUTE) dialog box opens.
   b. In the **Field** text box, enter **Reference**.
   c. Set the format to **D12.2**.
   d. Enter `IF WF_RETAIL_LITE.WF_RETAIL_TIME_SALES.TIME_HOL EQ 'Y' THEN 5 ELSE 2` into the expression.
   e. Click **OK** to close the dialog box.

2. **Hide the Reference field from the chart.**

3. **Add a dynamic reference line.**
   a. On the **Format** tab, in the **Features** group, click **Reference**.  
      The Reference Line dialog box opens.
   b. From the drop-down menu, select **Add Reference Line to Y-Axis**.
   c. Select the **Field** option.
   d. From the Field drop-down menu, select **Reference**.
   e. In the **Text** field, enter **Acceptable**.
   f. From the Weight drop-down menu, select **2px - Medium**.
   g. From the Position drop-down menu, select **Above Left**.
   h. Optionally, you can change the color and style of the Reference line.
   i. Click **OK** to close the Reference Line dialog box.

4. **Run the chart.**
   Auto Prompt appears.
   a. Select **20100101** (January 1, 2010) and click **Run** to see that five days are acceptable since the date is a holiday.
   b. Select **20100202** (January 2, 2010) and click **Run** again to see that two days are acceptable since the date is not a holiday.

5. **Click Save.**
Procedure: How to Display Annotations

Annotations are explanatory notes or comments. You can add up to eight annotations on a chart.

1. Create a chart or visualization.
2. On the Format tab, in the Features group, click Annotate.
3. In the drop-down menu that opens, click Add an annotation.
   The Annotation dialog box opens.
4. In the text input field, type the text for the annotation.
5. In the Position drop-down menu, select the position for the annotation on the chart. For example, Top Left.
6. Click OK to save the options that you selected, and close the Annotation dialog box.
   The annotation is added to the chart.
7. Click Run to generate the report.

Collation in Charts

Charts that have the new attribute syntax respect collation, which provides alphabetical sorting. Collation is also used in other areas, such as filtering.

Collation is set to CODEPAGE by the WebFOCUS Business User Edition installation, by default. This can be changed in the Custom Settings section of the Administration Console. For more information, see How to Configure Collation Sequence Settings on page 128.

Creating Thumbnails for Use With the Home Page

In InfoAssist, you can create and store thumbnail images for use in the Home page. Thumbnail images allow you to see a snapshot of a report or chart without opening the file. In InfoAssist, you can create a thumbnail image by clicking on the Create Thumbnail icon, which is located on the Quick Access toolbar.
You can create thumbnail images when working in Report and Chart mode in InfoAssist. These images are smaller renditions (220x160px) of your actual report or chart as it displays in Live Preview. Once you create the thumbnail and save the report or chart, you can access the thumbnail image from the file list on the Home page, as shown in the following image.

**Note:** Thumbnail images are stored as part of the procedure when it is saved in the repository.

**Procedure:** How to Create a Thumbnail Image of a Report or Chart

1. Open InfoAssist in Report or Chart mode.
2. Create a report or chart.
3. On the Quick Access Toolbar, click Create Thumbnail, as shown outlined in blue in the following image.
The Create Thumbnail dialog box displays, as shown in the following image.

4. On the Create Thumbnail dialog box, click OK.
5. On the Message dialog box, a message displays stating that theThumbnail has been created. Click OK.
6. On the Quick Access Toolbar, click Save to save the chart or report along with the thumbnail. The thumbnail is stored with the procedure.

**Procedure:** How to View the Properties of a Thumbnail from the Home Page
1. Create a report or chart that contains a thumbnail.
2. Save the procedure.
3. In the content view on the Home page, locate the procedure.
   The image that displays is the thumbnail that was saved with the procedure.
4. Right-click the procedure and select Properties to view additional thumbnail options.
5. Click the Advanced tab.
The thumbnail displays in the Explorer/Portal Properties section of the panel, as shown in the following image.

Using Storyboards

The Storyboard feature allows you to capture and preserve snapshots of your visualizations as you create them.
Each time you add something to the storyboard, it is placed onto a unique PowerPoint slide. When you click Show, you can open and review your slides in PowerPoint.

Since storyboards give you the ability to turn your visualizations into a PowerPoint presentation, you can modify your storyboard to create a customized demo. For example, you can rearrange or delete slides, or add titles and text.

You can also make your visualization portable by saving the PowerPoint files that you create and sharing the slides through email or other electronic distribution.

**Procedure:** **How to Create a Storyboard**

1. Create a visual, for example, a bar chart or a grid.
2. On the Home tab, in the Storyboard group, click Add.
   
   **Note:** When you receive the Added to Storyboard message, click OK.
   
   **Note:** You can also click the down-arrow on the Insert button to insert a chart, grid, or text.
   Repeat steps 2 through 4 until you complete your data analysis.
5. On the Home tab, in the Storyboard group, click Show.

A new browser window opens, and you are prompted to open or save the PowerPoint file that contains your storyboard.

- If you click Open, the storyboard opens in PowerPoint. You can save the file as a PowerPoint presentation on your machine.

- If you click Save, the storyboard will be saved to a PowerPoint (.pptx) file and placed in the Downloads folder on your machine. Click the down arrow on the right side of the Save button to perform a Save as. This allows you to specify the drive and directory to which the file will be saved.
In PowerPoint, each storyboard frame displays as a PowerPoint slide, as shown in the following image.

### Animating Visualizations

You can animate visuals in a visualization. Each individual visual can have different animation settings. The animations for each visual execute when you run the visualization.

**Procedure:** **How to Add Animation to a Visual**

1. Create a visualization with one or more visuals.
2. Select the visual that you want to animate.
3. On the **Format** tab, in the **Interactive** group, click **Interactive Options**.
4. On the Interactive Options dialog box, select the **Show Animation** check box. This animates the visual.
5. Set the duration for the animation, which determines the speed at which the animation occurs. The default value is 1400ms. Increase the value to make the animation slower, and decrease the value to make it faster.
6. Optionally, clear the **Enable Hover Over Effect** check box.
   
   This option lightens or adds a border to the segment of the visual that you move your mouse over.
7. Click **OK**.
Using Filters to Customize the Display of Data

Filters enable you to customize the display of data in your report, chart, document, or visualization. This gives you the advantage of viewing only the data that you want to see and use.

When creating a report, you refer to fields in several parts of the request. For example, in display commands (PRINT, SUM), in sort phrases (BY, ACROSS), and in selection criteria (WHERE, WHERE TOTAL, IF).

**Note:** When using ESSBASE hierarchical data sources, creating a filter on a sort field is not supported.

The WHERE phrase selects records from the data source to be included in a report. The data is evaluated according to the selection criteria before it is retrieved from the data source. You can use as many WHERE phrases as necessary to define your selection criteria.

In WHERE TOTAL tests, however, data is selected after all the data has been retrieved and processed.

You can group conditions and expressions within filter criteria. In addition, you can apply functions and calculations within criteria. For more information on filtering options, see *Field Tab* on page 90.

You can create Where and Where Total filters in the Filter dialog box by clicking *WHERE*.

Double-clicking the *Double-click or press F2 to edit!* text opens drop-down menus for Fields and Subqueries, Operators, and Values.

You can retrieve fields and values from the Master File and data source and Subqueries from a HOLD file.

The Field drop-down menu provides a field list from the Master File. The Field list can be viewed as follows:

- In business order (default)
- In a sortable grid
In a hierarchical structure of the data

- If you select Subquery, then the Operator drop-down menu is replaced by a menu with the options of *In list* and *Not in list*.

  - **In list.** Activates a drop-down menu in the right-most part of the expression. The drop-down menu contains a list of all subqueries that you have created from the Master file in use, and an EXISTING option.
    
    Click *EXISTING* to open the Open dialog box, where you can select a subquery from a different Master file.

  - **Not in list.** Opens the Open dialog box, where you can select a subquery from a different Master file.

The Operator (default) drop-down menu provides various operators for your filter. For example, Equal to.

The Value drop-down menu opens a dialog box with multiple options.

**Note:** If you are creating a filter on a full date field, the Value field will have a calendar icon adjacent to it. You can use this icon to select a date using a calendar control.

The Type drop-down menu contains the following options:

- **Constant.** Enables the entry of a literal value. This value can be a positive number, a negative number, or any character string.

- **Parameter.** Enables you to specify a parameter by entering a name and description in the provided text input areas, as well as selecting the type of parameter (Simple, Static, Dynamic, or Optional).

- **Field.** Enables the specification of a field name to compare against.

The value area generally contains a text input box that you can use to manually insert values. However, if you are working with a date field, the Value field is set to Today. You can optionally select Beginning of Month, End of Month, Beginning of Quarter, End of Quarter, Beginning of Year, End of Year, or you can specify a Custom date using the calendar that displays when you make that selection.

**Note:** The default date of Today applies to Report, Chart, and Document modes only.

The value area also contains a Get Values drop-down menu, which supplies the following options:

- **All.** Retrieves all the values from the selected field.
First. Retrieves the first value from the selected field.

Last. Retrieves the last value from the selected field.

Minimum. Retrieves the minimum value from the selected field.

Maximum. Retrieves the maximum value from the selected field.

From File. Retrieves a value that you specify. Selecting this option opens the Select From File dialog box, where you can browse to a local file and specify a file format, such as a flat file (CSV) or an Excel spreadsheet (XLS or XLSX).

Note: The Get Values drop-down menu is only accessible if you have already selected a field.

After selecting the values that you want, you can move them into and out of the Multiple Values area with the left and right arrows. You can also change the value order and delete values with the up and down arrows and the Delete icon.

After creating a condition, you can insert additional conditions before and after the selected condition by using the Insert Before and Insert After buttons at the top of the Filter dialog box. You can use either the And or the Or conjunction to link conditions and the Group and Ungroup buttons to nest and organize conditions.

You can create additional filters by clicking the New Filter button at the top of the Filter dialog box.

After creating the filters that you want, click OK to save and apply the filters. You can access them from the Filter pane of the Resources panel.

Note: Dates shown in the live preview reflect the format specified in the data source. However, when Filters are applied to a date formatted field, the format of dates shown in the Filter interface is derived from the locale. When the report, chart or visualization is executed, the output as well as any prompt will reflect the format specified in the data source.

Including or Excluding a Filter

Once you have created a filter, you can make decisions about when and where you want to include it in your report. For example, you might want to include one filter and exclude another. Using the Include and Exclude options in the Filter group on the Home or Field tabs, you can set filters accordingly.

You can use the following information to make decisions about your filters:

Exclude. Removes, but does not delete, the filter from the report.

Include. Restores a filter that was previously excluded from a report.
Sorting the Values in an Autoprompt Parameter

Using the prompt functionality, you can create an auto prompting parameter that displays sorted values at run time. This feature is located in the Filter Group on the Field tab.

To create an auto prompting parameter:

1. Select a field for which you want to create a parameter in your report.
2. On the Field tab, in the Filter group, click Prompt.
   The Create a filtering condition dialog box displays.
3. Double-click the Value field.
   
   **Note:** Parameter is selected, by default, when you are defining a prompt.

   The following options display, from which you can make a selection:

   - **Simple.** This is used for prompts using Text Input. This is the default value.
   - **Static.** This is used for prompts using Selection. This option allows you to select multiple values at run time.
   - **Dynamic.** This is used for prompts using Data Values. This option allows you to select multiple values at run time.
   - **Optional.** This is used for prompts using Single or Multiselect parameters.
   - **Sort Prompt Values.** This is used to determine how the values are sorted. Ascending is the default.
4. Click OK, and click OK again to close the Create a filtering dialog box.

When you run your report, you will be prompted for information based on the parameters you created.

Using Auto Drill

Auto Drill enables you to navigate through different levels within the dimension hierarchy of your data source. This allows you to review underlying data for a particular area, and move through the structure of your data source based on your informational needs.

In order to use Auto Drill, you must enable it by clicking the Auto Drill button on the Format tab, in the Run with group.

Once you have enabled Auto Drill, you can develop your report or chart and run it to activate the hyperlinks that Auto Drill creates. This enables you to navigate up or down through the related hierarchy of your data source by clicking the links that display.
When you click a hyperlink, the option to drill up or drill down displays, depending on where you are in the hierarchy of your data. You can then select one of these options to begin navigating your data. For example, if you have Product Category in your hierarchy, you would be able to drill down to Product Subcategory. When you drill down, you can subsequently drill back up to the originating dimension sort field. If you have selected a data source that has multiple levels and your report or chart uses a component in the middle of the hierarchy, both the Drill up and Drill down options will display. Once you have started navigating your data using the Drill up and Drill down options, the Restore Original option displays, enabling you to start your data analysis over by re-executing the original Auto Drill request.

At run-time, the Auto Drill functionality displays a breadcrumb header. This defines your current location in the hierarchy of your data source and enables you to navigate back and forth between different levels in your data.

**Important:**

- The Auto Drill functionality is only available for data sources that have a dimension hierarchy.

- If you have Auto Drill enabled and you attempt to run your report or chart in deferred mode, the hyperlinks will not display. This is also true for Auto Drill enabled reports that are distributed through ReportCaster.

- With the exception of Visualization mode, Auto Drill is available at run-time, but not in Live Preview.

- Auto Drill is supported for HTML and active report output format reports.

- Auto Drill is automatically enabled in Visualization mode for data sources that have a dimension hierarchy.

- Auto Drill functionality is not available in reports distributed by ReportCaster, because Auto Drill uses live data, in an interactive session, for data drilling. Data values and totals may not be the same if the data has changed since the last distribution. Mixing past data with current data could impact data analysis.

- Auto Drill is not supported for HTML5 output format charts that do not support the new chart attributes syntax.

- Auto Drill is not supported on Across fields in active reports.

- You must use dimension fields as a sorting field, either BY or ACROSS.
Procedure: How to Use Auto Drill to Navigate the Hierarchy of Your Data Source

1. Select a data source that has a dimension hierarchy. For example, wf_retail_lite.mas.
2. Create a report or chart with one or more hierarchical fields (for example, Product, Category).
3. On the Format tab, in the Run with group, click Auto Drill.
4. Click Run.
   The report or chart displays.
5. For reports, click a hyperlinked field within your report. For charts, hover over a chart aspect (for example, a bar).
   A menu appears.
6. Select a hierarchical value to which to drill down.
   Once you have drilled down on a field, you can subsequently drill up.
7. To return to the default state of the report or chart, click a hyperlink or hover over a chart aspect, and then click Restore Original.

Using the Auto Linking Feature to Link Content

Auto Linking makes it easy to connect reports and charts in your development environment, expanding the reporting capabilities of your organization. Using Auto Linking, you can dynamically link HTML reports, active reports, and HTML5 charts with a single report or chart of any format, based on their common sort (BY) fields and parameters referenced in any filters. It is this commonality that dynamically links content in your WebFOCUS repository, allowing you to discover new possibilities in your data, and explore new relationships within your reporting enterprise. In addition, Auto Linking saves development time and effort, because drilldowns do not need to be manually created and maintained.

To use Auto Linking, you must use the Enable Auto Linking option in InfoAssist to set the reports or charts that can be auto-linked. In addition, you must also set reports or charts to be Auto Link targets. The options to enable and disable Auto Linking and Auto Link Target functionality are available on the Format tab, in the Auto Linking group, in InfoAssist.

Note:
- The Auto Link Enabled option is activated only when the HTML, HTML5, and active report output format is selected.
- You can open an existing report or chart and enable Auto Linking or set the item as an Auto Link target.
When Auto Link functionality is activated, your reports or charts display a link for each sort (BY) field with qualifying target reports or charts at run time. In Auto Link enabled reports, you must add sort (BY) fields in the BY field container. In Auto Link enabled charts, you can add sort (BY) fields to the Horizontal Axis, Vertical Axis, or Color field containers.

To qualify a report or chart as an Auto Link target, you must include filters that contain the parameters that you selected as the sort field or fields in the enabled report or chart. The parameter names defined in these filters must be the same as the sort (BY) field names in the Auto Link enabled report. When you select a report or chart as the Auto Link Target, it specifies that the parameter information should be catalogued, and will be evaluated when an Auto Link enabled report or chart is run.

For an Auto Link enabled report at run time, the qualifying target reports and charts are those that have filters with parameters for the selected sort field and the sort fields that precede it, which appear to the left. For an Auto Link enabled chart at run time, the target reports and charts are those that have filters with parameters for all sort fields. For run time for both reports and charts, the linked sort field values in the Auto Link enabled report or chart are passed to the Auto Link target report so that it can be filtered by the sort (BY) field values.

For example, you may have an Auto Link enabled report that contains sort (BY) fields Product Category and Model, with a measure (Sum) field, Revenue. To qualify as an Auto Link target, other reports or charts in your repository can contain a single filter with a parameter for Product Category, or two filters with parameters for both Product Category and Model. When you run the Auto Link enabled report, the Product Category field will link to target reports or charts that have a filter with a parameter for Product Category and the Model field will link to target reports or charts that have filters for both Product Category and Model.

If you use the same example for an Auto Link enabled chart instead of a report, you can access the target reports or charts from a tooltip option that displays when you point your mouse over an area of the chart, such as a bar that represents Revenue by Product Category and by Model.
Using Optional Parameters with Auto Linking to Enhance Drilldown Results

In addition to the basic Auto Linking functionality that is available in InfoAssist, you can also add optional parameters to your Auto Link reports and charts, extending the capability of this feature. An Auto Link Enabled report can link to any target content that you are authorized to access that satisfies the sort (BY) field to the Auto Link Target report filter parameter requirement. Auto Link Target reports that satisfy this requirement and also have optional filter parameters for other fields are included in the Auto Link target report evaluation, so that all possible combinations of run-time parameters are evaluated and available as links as you run the request. This may produce additional reports or charts in your list of available Auto Link targets, offering you access to an expanded network of related content.

Setting a parameter to optional is not required because the Auto Link Enabled report will pass the value for the fields being filtered to the Auto Link Target report. When a sort (BY) field value in an Auto Link Enabled report is selected, that value and the value of its parent sort fields are passed to the Auto Link Target. When a measure value in a chart is selected, all sort (BY) field values for that measure are passed to the Auto Link Target. If you select the Optional option, the Auto Link Target report can run on its own (from the Resources Tree or within InfoAssist) without being prompted by Autoprompt for a value for the parameter. This is because optional parameters are assigned a default value.

With Auto Linking, you can link as many reports and charts as you want, and Auto Link Enabled reports can also be an Auto Link Target which contributes to the development of a cascading linkage of reports. For more information, see Using Filters to Customize the Display of Data.

Note:

- The linked reports displayed are limited to those that you are authorized to run or run deferred.
- If you are drilling down through a list of Auto Link target reports, a previously selected Auto Link target report will be excluded so that the available Auto Link targets are reports that the user has not yet viewed.
- When running an HTML report with On-demand Paging enabled, the qualifying Auto Link targets appear on the menu in the order that they are specified in the request. This is also true for a chart request that is a legacy graph format (PFJ-based formats, such as PNG and non-bucket HTML5). In reports, horizontal lines appear in the menu to separate user specified drilldowns and Auto Link navigation options.
- Consideration should be given to how many reports or charts are indicated as Auto Link targets, as the run time Multi-drill menu for the qualifying target reports may become long in length. In these cases, some browsers may display a script processing warning message.
The Auto Link Enabled and an Auto Link Target options can be set individually or both can be set on the same report or chart if that item meets the Auto Linking requirements.

When creating a request from a HOLD file, you can enable Auto Linking.

**Procedure:** How to Set an Existing Report or Chart as Auto Link Enabled

1. On the Home page, right-click a report or chart and click *Edit*.
   
   InfoAssist opens in the relevant mode.
2. Verify that there is a sort (BY) field in the report or chart.
   
   - For reports, sort fields are added to the BY field container.
   - For charts, sort fields are added to the Horizontal, Vertical, or Color field containers.
3. On the *Format* tab, in the Auto Linking group, click *Enable Auto Linking*.
4. Save the report or chart.
   
   Your existing report or chart is now Auto Link enabled.

**Procedure:** How to Set an Existing Report or Chart as an Auto Link Target

1. On the Home page, right-click a report or chart and click *Edit*.
   
   InfoAssist opens in the relevant mode.
2. On the *Format* tab, in the Auto Linking group, click *Auto Link Target*.
   
   **Note:** Selecting Auto Link Target specifies that the parameter information for this report or chart will be stored, adding it to the repository of reports and charts that will be evaluated when an Auto Link enabled report is run.
3. Add a filter with a simple or optional parameter to the target report or chart. Qualifying target reports are those that have filters with parameters for the sort (BY) fields in Auto Link enabled reports or charts.
   
   a. From the Data pane, drag a sort (BY) field into the Filter pane.
b. Using the Create a filtering condition dialog box, add the selected parameter as simple, as shown in the following image.

![Create a filtering condition dialog box](image)

c. Click OK, and then click OK again to exit the Create a filtering condition dialog box.

4. Save the report or chart.

Your existing report or chart is now set as an Auto Link target.

**Procedure:** How to Create a New Auto Link Enabled Report or Chart

1. Open InfoAssist in report or chart mode.
2. From the Open dialog box, select a data source.
4. Add fields to the report or chart, ensuring that one is a sort (BY) field.

   - For reports, sort fields are added to the By field container.
For charts, sort fields are added to the Horizontal, Vertical, or Color field containers.

5. Save the report or chart.

Your report or chart is now set as Auto Link Enabled.

**Procedure: How to Create a New Auto Link Target Report or Chart**

1. Open InfoAssist in report or chart mode.
2. From the Open dialog box, select a data source.
3. On the **Format** tab, in the Auto Linking group, click **Auto Link Target**.
   
   **Note:** Selecting Auto Link Target specifies that the parameter information for this report or chart will be stored, adding it to the repository of reports that will be evaluated when an Auto Link enabled report is run.

4. Add fields to the report or chart.
5. Add a filter with a simple or optional parameter to the target report or chart.
   a. From the Data pane, drag a sort (BY) field into the Filter pane.
   b. Using the Create a filtering condition dialog box, add the selected parameter as simple or optional.

   **Note:** When creating a parameter for a field, the parameter name defaults to the fieldname that you select. In the previous image, the creation of a filter with parameter Product Category is shown. To ensure that the name of the parameter is the same as the sort (BY) field in the Auto Link enabled report or chart, do not change the name of the parameter that is generated by your field selection.
c. Click OK, and then click OK again to exit the Create a filtering dialog box.

6. Save the report or chart.

Your report or chart is stored as an Auto Link target.

**Procedure: How to Run an Auto Link Enabled Report or Chart**

You can run an Auto Link enabled report or chart from within InfoAssist or from the Home page.

1. Open and run an Auto Link enabled report or chart in one of the following ways:
   - In InfoAssist, open or create an Auto Link enabled report and on the Quick Access Toolbar, click Run.
   - From the Home page, right-click a report or chart that is Auto Link enabled and click Run.

2. Use the hyperlinks to link to other reports and charts, based on the following information:

   - **Reports.** Displays with hyperlinks on the sort (BY) fields that have qualifying target reports. Click a hyperlink to display the menu with the Auto Links option, which cascades to list the qualified Auto Link target reports and charts, as shown in the following image.
Charts. Displays with aspects over which you can hover (for example, a bar) in the chart. A tooltip displays with the Auto Link target reports and charts, as shown in the following image.

Using Multi Drill

The Multi Drill functionality enables you to create multiple drill down links on a data field in a report or chart. This is useful when you want to define custom links to other reports or websites.

Using the Multi Drill functionality, you can define conditions for drilling down or through the data element that you select. Once drill down information is saved and you run the report or chart, the drill down options display when you click or hover over the defined area of a report or chart, respectively.
You can create drill down links by selecting a field in the Query pane. On the Field tab, in the Links group, click Drill Down to open the Drill Down dialog box. You can also right-click a field in the Query pane, and click Drill Down. The Drill Down dialog box is shown in the following image.

When you access the Drill Down dialog box, the name of the field that you selected displays in the title bar. This enables you to identify the current field and is useful when working with Drill Down parameters.

In the Drill Down dialog box, you can configure a hyperlink or drill-down procedure. When you run the report, you can click the link that is created, which would take you to the specified URL or execute the specified procedure.

You can also create multiple drilldowns for a selected field. The drill down links that you define display as separate entries in the drill down list, also known as the drill menu, at run-time. The display of these entries is based on the naming conventions that you applied when creating the multi-drill scenario.
Once your drilldown options are defined, you must run your report in order to access the drill down links that you have created. For reports, the links display when you click on a hyperlink for the data field that you selected. For charts, they display when you hover over an area of the chart for which the drill down has been defined (that is, the field that you selected when you defined the drill down).

These links enable you to drill directly through to an external procedure or URL.

For example, you can create one drill down link for an existing procedure, and another for a webpage. Both drill downs are stored for the underlying field that you selected. Once you define the first drill down, additional options display on the toolbar, as shown in the following image.

![Drill Down - Product,Category](image.png)

**Note:** You can rename a drill down using the Description field in the right pane of the Drill Down dialog box.
The following icons are available on the Drill Down dialog box toolbar:

- **Create a new drill down.** This option is enabled when all required information is provided for the first drill down. When you click *Create a new drill down*, a new drill down item is created. This switches the drill down functionality from a regular drill down to multi-drill. By default, the name of the drilldown is Drill Down n, where n is a consecutive integer, such as Drill Down 1, Drill Down 2, etc. This option is initially disabled, but is enabled after you have created at least one drill down link.

- **Duplicate the selected drill down.** When an existing drill down item is selected, clicking this option duplicates the item. A (Copy n) is appended to the name of the drill down, where n is the consecutive number assigned to the duplicated drill down. Once assigned, the name can subsequently be changed in the Description field. Consecutive copies can also be rearranged by dragging the drill down items into the desired order.

  **Note:** The Duplicate button is only active when sufficient information is available for the selected drill down item.

- **Rename the selected drill down.** This option enables you to rename an existing drilldown and is active by default. When this option is selected, the Description field is selected, allowing you to provide a new name for the drill down link. You can enter a description up to 100 characters long. If you remove the description, the drilldown is renamed to the default name.

- **Remove the selected drill down.** If you have a drill down item selected, the Remove the selected drill down option is active. When you select this option, the current drilldown is deleted. If a drill down item is removed, the next drill down item is automatically selected. If you remove the last drill down item, the Drill Down dialog box resets to its initial state, restoring Drill Down 1 as the default value.

- **Options.** The Options functionality enables you to change the order of your drill down items. This allows you to control the order in which the items are presented in the drill menu when you run your report and click on a hyperlink. You can change the order by selecting a defined drill down in the list that is presented under Edit Order and then clicking the Move Up or Move Down button. You can also remove one or more drill down items from the list by selecting the desired items and then clicking the Remove from List button. If you multi-select your drill down items using the CTRL key, the Move Up and Move Down buttons are disabled.

  **Note:** Move Up, Move Down, and Delete are also available as context menu options when you right-click a drill down item in the Edit Order list.

The Drill Down dialog box contains the following options for specifying drill down information for the selected field:
Note: When specifying parameters for your drill down, click Add Parameter to add them to your parameters list.

- **Report.** Select this option to choose a report for the current drill down. This option is selected by default.

- **Report.** Enables you to browse to a stored report.

- **Description.** Provides a field in which to describe the report. If you selected a report by browsing, this field is automatically populated with the title of the procedure or the name where procedure titles are not accessible. This field is also used to rename a specified drill down.

- **Target.** Allows you to specify a target for the drill down. Options include: New Window, Same Window, or a value that you specify. The default value for report is New Window.

- **Parameters.** Displays the parameters that you have indicated for the current drill down.

- **Refresh BI Portal.** Select this option to refresh the components of the BI Portal and pass parameters to them.

- **Refresh.** Provides options by which to refresh the page. Options include Current Page and All Pages.

- **Description.** Provides a field in which to describe the refresh process. This field is also used to rename a specified drill down.

- **Target.** Reflects the target for the drill down. The only applicable value for Refresh BI Portal is Same Window.

- **Parameters.** Displays the parameters that you have indicated for the current drill down.

- **Auto Link Target.** Select this option to create an explicit list of Auto Link targets. Upon selection, these will be available in the drill down menu at run time.

  Note: When working with reports, the Auto Link Target drill down option is only available for a selected dimension (BY) field. For more information, see Using the Auto Linking Feature to Link Content on page 841.

- **Auto Link Target.** Enables you to browse to a stored target report.

- **Description.** Provides a field in which to describe the target report. If you originally selected a report by browsing, this field is automatically populated with the report title or the name where titles are not accessible. This field is also used to rename a specified drill down.
- **Target.** Enables you to specify a target for the drill down. Options include: New Window, Same Window, or a value that you specify. The default value for Auto Link Target is New Window.

- **Parameters.** Displays the parameters that meet the column-to-parameter requirement for the selected target report.

  For more information, see *Using the Auto Linking Feature to Link Content* on page 841.

- **Web Page.** Select this option to indicate that you want to drill through to a webpage. Enter a value in the URL field.

  - **URL.** Enables you to specify the URL for the webpage to which to drill down. This option is available only when Web Page is selected.

  - **Description.** Enables you to enter additional comments related to the drill down. This field is also used to rename a specified drill down.

  - **Target.** Enables you to specify a target for the drill down. Options include: New Window, Same Window, or a value that you specify. The default value is New Window.

  - **Parameters.** Displays the parameters that you have indicated for the current drill down.
If you are working with a report that has parameters, the parameter names are automatically retrieved and made available from the Name control in the Parameters section of the Drill Down dialog box, as shown in the following image.

By default, the field is labeled with a value of Name. If there are multiple parameters to choose from, you can use the drop down list to make a selection. You can also manually enter a name to create a new parameter. The parameters that display are populated from the underlying report procedure (.fex) that you selected for your drill down.

The Type field enables you to specify a field or constant value. The options in the Value list are based on the fields that you selected for your report. The item that you select determines the value for the parameter (for example, Discount or Revenue).

**Note:** If you switch the Type field from Field to Constant or from Constant to Field, the Value field is reset, enabling you to specify a unique value.
**Procedure:** How to Create a Single Drill Down Link

You can create a single drill down link on a measure field.

1. Create a report or chart with at least one measure field.
2. In the Query pane, do one of the following:
   - Right-click the measure field and click *Drill Down*.
   - Click the measure field and on the *Field* tab, in the *Links* group, click *Drill Down*.

The Drill Down Dialog box displays, as shown in the following image.
3. Select one of the following Drill Down options:
   - Report
   - Refresh BI Portal
   - Auto Link Target
   - Web Page

4. Populate the fields based on the drill down option you selected.
   **Note:** Descriptions for these fields are provided earlier in this topic.

5. Optionally, rename the Drill Down using the Description field. This dictates how the Drill Down will appear in the left pane of the Drill Down dialog box.

6. Click OK.
   The drill down link displays when you hover over the defined area of a report or chart, at run time.

**Procedure:** How to Create Multi Drill Links

You can create a multiple drill down links on a single dimension field.

1. Create a report or chart with at least one dimension field.

2. In the Query pane, do one of the following:
   - Right-click the dimension field and click *Drill Down*.
   - Click the dimension field and on the *Field* tab, in the *Links group*, click *Drill Down*. 
3. Select one of the following Drill Down options:
   - Report
   - Refresh BI Portal
   - Auto Link Target
   - Web Page

4. Populate the fields based on the drill down option you selected.
   **Note:** Descriptions for these fields are provided earlier in this topic.

5. Optionally, rename the Drill Down using the Description field. This dictates how the Drill Down will appear in the left pane of the Drill Down dialog box.

6. Repeat steps 3-5 until you have added all of the drill down links required.
   **Note:** The following image defines three unique drill down links for the selected dimension field.
7. Click OK.

The links display when you hover over the defined area of a report or chart, at run time, as shown in the following image.
Adding Parameters for Data Selection at Run Time

You can add new parameters to your report or chart to create parameter options for selection at run time. This enables you to dynamically select and review different scenarios with your data, offering you on-demand, dynamic report or chart creation at run time.

When you add a parameter, it becomes a field container into which you can add one or more measures and dimensions. You create a new parameter by right-clicking on a field container in the Query pane and clicking New Parameter. This creates a numbered parameter (for example, Parameter 1). In cases where you have multiple parameters defined, the numbering is applied sequentially.

Once you add a parameter, you can rename the variable by right-clicking the Parameter-n field container and clicking Parameter Prompt, where n is the number of the parameter that was added. Once you rename a parameter field container, the new title displays in the Query pane and at run-time. This allows you to easily identify the parameters while categorizing the data fields that you want each to contain. For example, if you add a number of Sales-related fields to a parameter, you can rename the parameter with a title of Sales to encapsulate the data fields that you selected. Parameters should be renamed before you run the report or chart so that they are easy to identify.

In order to populate parameters in your report or chart, data fields must be placed in the parameter field container. You can do this by selecting fields from the Data pane and dragging them into the relevant parameter field containers that you create.

**Note:** Double-clicking the data fields in the Data pane places the data field in the default field containers in the Query pane, not the parameter field container. For example, in a report, if you double-click Discount, the data field is placed in the Sum container (outside of the parameter field container that you created). You can always drag a data field into a parameter container from another field container in the Query pane if you wish to consider it a parameter.

You can also reorder the data fields that you have placed in a given parameter field container by dragging them into the order that you wish to display them at run time. Parameters can be specified in any field container, with the exception of Multi-graph. Once you have defined your parameters and selected the relevant data fields, run the report or chart. Using the drop-down lists for each parameter, you can select different options from the parameter lists to view the data in your report or chart dynamically. To load different scenarios, select the values and then click Run.
The following image shows the Query pane with a number of parameters and data fields specified.

**Procedure:**  **How to Add a Parameter**

1. Create a new report or chart or open an existing one.

2. Add a new parameter by right-clicking a field container and clicking *New Parameter*, as shown in the following image.

A new parameter field container is added.
3. Add the data fields that you would like to display in a parameter list at run time to the new parameter field container.

4. Optionally, rename the parameter by right-clicking the parameter and clicking *Parameter Prompt*.

   This is not required, but it does help in differentiating the various numbered parameters that display, depending on how many you define.

5. Optionally, add one or more additional parameters, and relevant data fields, into the field containers for which you would like to select data values at run time.

6. On the Quick Access toolbar, click *Run*.

   You can use the Parameter drop-down lists that display at run-time to create different views of your data, as shown in the following image.

![Parameter drop-down lists](image)

**Note:** You can optionally run your report or chart using the default parameters without making a selection. Click the down arrow on the Run button in the Quick Access toolbar and select Run with Default Parameter Values.

The following navigational icons display at run time:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Close Filter Panel" /></td>
<td><strong>Close Filter Panel.</strong> Click this option to collapse the filter panel, displaying more of the report or chart in the right pane.</td>
</tr>
<tr>
<td><img src="image" alt="Reset filter values" /></td>
<td><strong>Reset filter values.</strong> Click this option to reset the filter values to their default values, as indicated when the parameter was initially set up.</td>
</tr>
</tbody>
</table>
Slicers provide a quick and easy way to add dynamic user controls to a chart or report, giving you the ability to filter the data in use as you create or view content. Slicers are dynamic filters that can be changed by making a selection from a menu of fields. You can use them to filter your content by modifying a slicer in the Slicers tab and running the chart or report, or you can use them at run time when running a report in InfoMini with the Slicers tab selected.

Creating Slicers

You can create slicers by dragging fields to the Slicers tab or through the context menu of a field. When you create a slicer group, it appears on the Slicers tab.

You can use slicers to dynamically filter reports at design time.

You can dynamically filter reports at run time when they are included in an InfoMini application. For more information on InfoMini, see *Building InfoMini Applications* on page 593.

**Procedure:**  How to Create a Slicer

1. Click the Slicers tab.
2. Create a new slicer by using one of the following methods:
   - Click the New Group button to create a new slicer group.
     
     Select a field from the Data pane and drag it onto the Drag Fields Here to Create Slicers text on the Slicers tab.

     **Note:** You cannot drag parent-child hierarchies onto the Slicers tab.

     The field is added to the new group.

   or

   - Right-click a field in the Data pane, point to Slicers, and then click New Group.

     The field is added to the new group.
If you are creating a slicer on a full date field, a calendar icon displays adjacent to the field. You can use this icon to select a date using a calendar control.

**Procedure: How to Add a Field to an Existing Slicer Group**

1. Click the Slicers tab.
2. Add a field to an existing slicer group using one of the following methods:
   - Select a field from the Data pane and drag it onto an existing slicer group.
   - or
   - Right-click a field in the Data pane, point to Slicers, and then click Existing Group.
     Select an existing group from the menu, and then click OK.
     The field is added to the existing group.

**Procedure: How to Add a Hierarchy as a Slicer Group**

Note: You cannot drag parent-child hierarchies onto the Slicers tab.

1. Click the Slicers tab.
2. Add a hierarchy as a slicer group using one of the following methods:
   - Select a hierarchy from the Data pane and drag it onto an existing slicer group.
     The hierarchy is added as a new group, not as a slicer in the existing group. The new group is given the same name as the hierarchy.
   - or
   - Click the New Group button to create a new slicer group.
     Select a hierarchy from the Data pane and drag it onto the Drag Fields Here to Create Slicers text of the Slicers tab.
     The hierarchy is added to the new group. The name of the new group changes to the name of the hierarchy automatically.

Note: Hierarchies cannot be added to existing slicer groups. If a hierarchy is dragged onto an existing slicer group, a new group is created automatically.

There is no right-click context menu for hierarchies. To add a hierarchy as a slicer group, you must drag it into a new slicer group.
Filtering With Slicers

Once you add slicers to an InfoAssist report, you can use them to filter the report. You can select values from the slicers menus, change the number of records that appear, create new slicer groups, clear existing slicer groups, and update the report preview.

Slicers that are not selected have their values filtered by the selected slicers. Only values that meet the criteria for previously selected slicers will appear in the menu for the next slicer. Slicers are not filtered in the order they appear in the slicer group, but by the order they are selected. Cascading of slicers is only valid for hierarchies.

**Procedure: How to Change the Relationship Operator in a Slicer**

1. With at least one slicer added to the report, click the Slicers tab.
2. Click the operators button on the slicer for the operation you want to change.
   
   A list of operators (numeric) appears in the menu.
   
   **Note:** Alpha fields just flip between equal and not equal.
3. Select the operator that you want from the menu. You can rest the mouse on an operator to display a tooltip describing the operation.

**How Slicers Cascade Together**

Slicers cascade within a hierarchy (cube or dimension builder-based), rather than in the order of user interaction, eliminating potential performance issues.

**Procedure: How to Cascade Slicers**

Controls with fields from the same hierarchy are cascaded together.

1. Create a report.
2. Create multiple slicer groups, as described in *How to Create a Slicer* on page 862.
   
   **Note:** You can select multiple values by holding down the CTRL key while selecting items in the drop-down list box. In cases where multiple items are selected, the label for the drop-down list is set to Multiple. You can click the drop-down list to review the selections.
   
   Once you click OK, the new control appears in the drop-down menu.
   
   The 1 prior to the decimal point indicates that this is the first cascade you have interacted with. The 1 after the decimal point indicates that it is the first control in that cascade.
3. Filter the report using the controls in the slicer groups that you created.
Note: The order of a cascade is dynamic. For example, if you selected Camcorder from Product Subcategory first, then the Product Category control would have a value of Video Production.

Changing a Field Format

You can change the format of any field except a Sort field. You can change the format of measure fields, as well as any calculated fields.

You can access the Field Format Options dialog box from the following locations:

- Define and Compute dialog boxes.
- Edit Format option when you right-click a measure in the Query pane (all modes), right-click a column in a chart, or a measure column in a report.
- Format group on the Field tab.

The following image shows the Field Format Options dialog box.

The Field Format options dialog box enables you to choose from a variety of Field types. Display options are enabled based on the Field type you select. For example, the default Field type selection is Decimal. The first Display option, Currency Symbol, provides the following list of currency symbol options:

- None
- Floating Currency
- Non-floating Currency
- Fixed Euro symbol
The default value for Currency Symbol is set to None, unless the Field Format dialog box was invoked when changing the format of a field that already contains a currency symbol from the Master File. Accordingly, the currency symbol will default to that which is defined in the Master File.

Charts work with floating currency symbols to allow the placement of the currency symbol to work within the different elements of the chart. In a chart, any fixed currency designations will automatically be presented with a floating currency symbol. Floating and fixed currency formats are supported for Reports only.

When working with charts, the axis label formats are defined separately from the field format. To set the format of the axis label, use the option in the Labels group on the Format tab. Click Axes point to Vertical Axis, and click More Vertical Axis Options. In the Format Vertical Axis dialog box, click Labels, open the Format Labels drop-down menu, and select a currency format.

The following procedures show how to change a field format from the Field Format Options dialog box. For more information on how to use the Format group options, see Field Tab on page 90.

Procedure: How to Assign an Alphanumeric Format

1. With a report open in Live Preview, right-click a virtual field or column measure field, and select Edit Format.

   The Field Format Options dialog box opens.
2. From the Field type list, select Alphanumeric.
3. To assign a different length, specify a number between 1 and 4095 in the Total length field. The default value is 20.
4. Click OK to close the Field Format Options dialog box and return to the canvas.
   The new format appears in the previously selected column.

**Procedure: How to Assign a Numeric Format**

1. With a report open in Live Preview, right-click a virtual or column measure field, and click Edit Format.
   The Field Format Options dialog box opens.
2. From the Field type list, click one of the following options:
   - Floating Point (default length 7.2)
   - Integer (default length 5)
   - Decimal (default length 12.2)
   - Packed (default length 12.2)
   If the selected field matches the selected format type, its current length appears in the Field Length field. Otherwise, the default length appears in the Field Length field. The Decimals field shows the numbers of decimal places for Floating Point, Decimal, and Packed.
   - To assign a different length, specify it in the Field Length field for format types as follows: 1-9 for Floating Point, 1-11 for Integer, 1-20 for Decimal, and 1-33 for Packed.
   - To assign a different number of decimal places for Floating Point, Decimal, or Packed, specify the number in the Decimals field.
3. Click OK to close the Field Format Options dialog box and return to the canvas.
   The new format appears in the previously selected column.

**Procedure: How to Assign a Date Format**

1. With a report open in Live Preview, right-click a virtual or column measure field, and select Edit Format.
   The Field Format Options dialog box opens.
2. From the Field type list, click Date, as shown in the following image.

3. To assign a different date display format, select a date format from the Display options list.

   The default date display format is MDY.

4. Optionally, select a separator for the date format.

   The default is /, but you can select . (period), - (hyphen), (space) or None.

   **Note:** If a date has only one component (for example, Year), a separator will not be used.

5. Click OK to close the Field Format Options dialog box and return to the canvas.

   The new format appears in the previously selected column.

**Procedure:** How to Assign a Date-Time Format

1. With a report open in Live Preview, right-click a virtual or column measure field, and select Edit Format.

   The Field Format Options dialog box opens.
2. From the Field type list, click Date-Time, as shown in the following image.

3. To assign a different date-time format, select the date format you want to use from the Date Format list. Expand Year First, Month First, or Day First to see the available options.

4. Select a time format (if applicable) from the Time Format list.
   
   If you select the Time Only check box then you can only set a time format. Expand Hour First, Minute First, or Seconds First to see the available options.
   
   **Note:** These expansion options are only visible when you select Time Only.

5. Optionally select a separator for the date format.
   
   The default is /, but you can select . (period), - (hyphen), (space) or None.
   
   **Note:** If a date has only one component (for example, Year), a separator will not be used.

6. Click the Use AM/PM check box if you are indicating a time format.
   
   The format of the time selection displays in the text box at the bottom of the dialog box. A preview displays in the Sample text box in the left pane, showing you the exact format of your time-based selection.

7. Click OK to close the Field Format Options dialog box and return to the canvas.
   
   The new format appears in the previously selected column.
**Procedure:** How to Add a Percent Sign to a Numeric Field

You can add a percent sign to the end of a numeric value (Decimal, Integer, and Floating Point formats). This numeric display option includes a percent sign along with the numeric data, but does not calculate the percent.

1. With a report open in Live Preview, right-click a virtual or column measure field, and select *Edit Format*.
   
   The Field Format Options dialog box opens.

2. From the Field type list, click a numeric value format (Floating point, Integer, Decimal, or Packed), and then select the *Percent (%)* check box.

3. Click *OK* to close the Field Format Options dialog box and return to the canvas.

   The new format appears in the previously selected column.

**Dynamic Grouping**

Dynamic grouping allows you to create groups of elements based on the field data type that you select. For example, in the wf_retail_lite database, there are a number of brands of televisions. Using the dynamic grouping functionality, you can create groups based on the popularity of a particular brand. The first group might include top sellers such as LG and Sony. The second group might contain the remaining brands (Panasonic, GPX, Supersonic, Tivax, and Audiovox). This would allow you to group top sellers into one group, and the remaining brands into another group.

**Note:** The Create Group option is only available for dimension fields of non-numeric format or attribute.

You can also specify multiple, unique groupings in the same session. For example, you might want to group the data to indicate groups of products, or specific regions.

**Note:** If you want to exclude a specific data element from your analysis, you can use the filter functionality.

The grouping that you specify is applied and this new group then replaces the original field that you selected in the Query pane. The name that you specify when creating the group is reflected in the Query pane.

**Note:** You can edit the group once it has been created by right-clicking on the group field and clicking *Edit Group*.

**Procedure:** How to Create a Dynamic Group

1. From the Data pane, add one or more data fields to your report or chart.
2. In the Query pane, right-click the data field for which you want to apply dynamic grouping.  
   **Note:** The Create Group option is also available in the Data pane shortcut menu.

3. Click *Create Group*.  
   The Create a Group dialog box displays.

4. In the Field text box, optionally type a name for the new group field.

5. Select the data values that you want to group. Use Ctrl + click to select more than one value, as shown in the following image.

6. Click *Group* .  
   **Note:** To ungroup values, click a group and then click *Ungroup*.  

7. Optionally, create additional groups, as shown in the following image.

8. Optionally, rename a group by selecting a group and then clicking Rename.

9. Click OK.
Your grouped data will display in the Data pane when your report, chart, or visualization refreshes, as shown in the following image.

---

**Customizing Domain Portal Pages**

This section describes page customization features, such as configuring responsive behavior, using the Easy Selector, working with comments, and removing customizations.

**Using the Easy Selector**

The Easy Selector provides a simple way to add content to a page at run time, without opening the Resources tree. It also allows you to control which items users can access.

You can enable the Easy Selector feature on a container or a column level.

**Procedure: How to Use the Easy Selector Container**

1. Sign in to the portal as a developer or a manager.
2. On the Home page, select a domain, and then click *Folder*. 
3. Populate this folder with the content that you intend to make available through the Easy Selector at run time, such as reports, charts or pages.

   **Note:** Ensure that the folder only includes file content and no subfolders.

4. Publish the folder.

5. On the Home page, and click *Portal Page*.

   The Page Designer opens.

6. Select a columnar template from the Add Page dialog box, and click *Create*.

7. On the *Insert* tab, in the *Containers* group, click *Easy Selector*.

   The Easy Selector container is inserted into the page, and the Browse For Folder dialog box opens, where you can select a target folder.

8. Optionally, navigate to the folder that you that want to display inside the Easy Selector at run time, and then click *OK*. If no target folder is selected, the entire repository is displayed at run time, allowing the user to explore all available domains and folders.

   **Note:** You can also change the folder location by clicking *Select Folder* in the Properties panel, and navigating to a different folder. It is not recommended to change the folder location after the end users have begun using the Easy Selector.

9. Repeat steps 7 and 8 to create more Easy Selector containers, if needed.

   **Note:** You can multiselect the containers by holding the Ctrl key.

10. Click *Save* and close the Page Designer.

    **Note:** You must publish your portal page and add it to the portal before adding content using the Easy Selector.

11. On the portal page you created, click the *Add content* button.

    The Select Item dialog box opens.
12. Navigate to an item that you want to show on the portal page and click Add, as shown in the following image.

![Easy Selector container](image)

The item opens inside the Easy Selector container.

**Procedure:**  How to Use Easy Selector in a Column

1. Sign in to the portal as a developer or a manager.
2. On the Home page, select a domain, and then click *Folder*.
3. Populate this folder with the content that you intend to make available through the Easy Selector at run time.
   
   **Note:** Ensure that the folder only includes file content and no subfolders.
4. Publish the folder.
5. On the Home page, click *Portal Page*.
   
   The Page Designer opens.
6. Select a columnar template from the Add Page dialog box, and click *Create*.
7. With the page canvas selected, in the Properties panel, clear the *Lock Page* check box and select the *Prevent Layout Change* check box.
Note: This configuration allows users to add new content to a page at run time, while preventing them from changing the column layout, which is important for the Easy Selector.

8. In the Properties panel, click Container Defaults.

The Container Defaults dialog box opens. Here, you can customize the drop-down menu for the items that are displayed on the page at run time. Click OK to close the Container Defaults dialog box.

9. Select a column.

10. In the Properties panel, select the Show Easy Selector check box.

The Browse For Folder dialog box opens, where you can select a target folder.

11. Click the folder you want to display inside the Easy Selector at run time, and then click OK.

Note: You can change the folder location by clicking the Select Folder button and navigating to a different folder. It is not recommended to change the folder location after the end users have begun using the Easy Selector.

12. Repeat steps 9-11 for each column.

Note: You can multiselect the columns by holding the Ctrl key.

13. Click Save and close the Page Designer.

Note: You must publish your portal page and add it to the portal before adding content using the Easy Selector.

14. On the portal page you created, click the Add content button.

The Select Item dialog box opens.

15. Select an item from the list and click Add.
The selected item opens and a new Add content button displays in the next column, automatically, as shown in the following image. This allows you to add the remaining items that are available to you. You can also multiselect items inside the Select Item dialog box.

Additionally, you can replace an item on the page with any item from the Select Item dialog box. You can access the Replace menu option by clicking the arrow in the upper-right corner of the container panel.

**Note:** The Add content button disappears and the Replace option becomes inactive after the last item in the Select Item dialog box is added to the page.

### Building a Responsive Layout

A responsive layout resizes dynamically to any width based on screen size, device, and orientation, thus eliminating the need to design for a specific device preference. This approach takes your content beyond the desktop and delivers a quality experience to users, on any display. The Page Designer offers you a series of versatile presets, that make the task of creating a responsive portal a quick and straightforward process.

A user must have the privileges of a developer or manager to be able to build a responsive layout.
**Procedure:** How to Build a Responsive Layout

1. Sign in to the portal as a developer or a manager.
2. On the Home page, and click *Portal Page*.
   The Page Designer opens.
3. Select the *1 Column* template from the Add Page dialog box, and click *Create*.
   All responsive layouts are created using a one column page layout.
4. Click inside the column that you just created. On the Properties panel, set the *Container Padding* to 5px and select the *Same for All* check box, if it is not already enabled.
5. On the *Insert* tab, in the *Containers* group, click *Responsive*.
   The Responsive container is inserted, taking up the full width of the page.
6. On the *Insert* tab, in the *Content* group, click *WebFOCUS Resources*.
7. Populate the responsive container with content from the folder of your choice, by dragging them to the container.
   When you drag items sequentially, you can choose the order in which they display, using the shaded placement indicator as a guide. When you drag items simultaneously, using the multiselect option (Ctrl key), they display in the order in which they are selected.
8. Multi-select the panels to which you want to assign the Custom CSS Classes by holding the Ctrl key and clicking a title bar of each panel.
   For example, if you were going to create a responsive portal that contained four items in the first row, and two items in the second row, you would select the first four panels.
   **Note:** You can only multi-select panels by clicking its title bars. If the title bars are hidden, you cannot multi-select these panels.
9. On the Properties tab of the Properties panel, click the *Responsive Properties* button.
   The Advanced Responsive Item Properties dialog box opens.
10. In the *Custom CSS Classes* field, type `bip-responsive-n`.
    where:
    
    `n`
    
    Is the responsive folding behavior that you want to apply the content on your page.
For example, `bip-responsive-4-2-1` means that the content will display four items across on wide screens, two items across on medium screens, and one item across on narrow screens. If you use `bip-responsive-3-2-1`, the content will display three items across, then two items across, then one item across. If you use `bip-responsive-2-1`, content will display two items across, then one item across. If you choose `bip-responsive-1`, the item will fill the entire row.

**Note:** When one of the built-in responsive classes is used in the Custom CSS Classes field, it sets the width of the panel as a percentage of the page width, based on media queries. The percentage width setting made in these built-in responsive classes overrides any width settings defined on the panel.

11. Click **OK** to close the Advanced Responsive Properties dialog box.

The first row of panels are now stretched evenly across the Responsive container.

12. Multiselect the remaining panels by holding the Ctrl key and clicking each panel.

13. On the Properties panel, click the **Responsive Properties** button.

The Advanced Responsive Item Properties dialog box opens.

14. In the **Custom CSS Classes** field, type `bip-responsive-2-1`. This will enable the remaining two panels to go from two across to one across on a smaller screen.

15. Set Minimum Height to **440px**.

16. Click **OK** to save the properties.

The remaining panels now stretch across the Responsive container, in the second row.

**Note:** You can create multiple layouts using this principle and varying the CSS classes to reflect the desired percentage.

17. With the Responsive container selected, make the following changes:

- On the Properties tab of the Properties panel, set Height to **Dynamic**.
- On the Title tab of the Properties panel, select the **Hide Title Bar** check box.
- On the Style tab of the Ribbon, in the Border group, click **Style**, and then select **None**.

**Note:** These changes render the Responsive container invisible on the page at runtime, and in the Page Designer. To edit the content in your Responsive container or access its properties, you can use the breadcrumb trail below the Property sheet to select it.

18. Click the **Save** button and close the Page Designer.

19. Publish your page, and add it to the portal.

20. Change the size of your browser window to observe the responsive behavior.
All items rearrange perfectly to fill the page.

Working With Comments

In domain portal pages, you can use comments to interact with your peers in a multi-user environment. Developers and managers can enable comments in the Page Designer. You can enable comments on portal pages, containers, and individual content items.

Procedure: How to Enable Comments on a Domain Portal Page

1. Sign in to the portal as a developer or manager.
   The Page Designer opens.
3. In the Add Page dialog box, choose a page template and, optionally, add new page information.
4. Click Create.
5. In the Properties panel, click the Comments drop-down menu and update the style of your comments to reflect any standards.
6. Save the portal page and close the Page Designer.

Procedure: How to Enable Comments on a Container

1. Sign in to the portal as a developer or manager.
   The Page Designer opens.
3. In the Add Page dialog box, choose a page template and, optionally, add new page information.
4. Click Create.
5. On the Insert tab, in the Containers group, click any container button.
   The container is placed on the page canvas.
6. In the Properties panel, select the Show Comments check box.
   When enabled, this option allows you to show and hide comments on a container or item at run time.
7. Save the portal page and close the Page Designer.
Using Comments at Run Time

When enabled, comments display at run time, as shown in the following image.

![WebFOCUS dashboard with comments](image-url)
Additionally, you can use the following controls to interact with comments:

- Click the **Minimize button** in the upper-right corner of the comment area, to minimize comments, as shown in the following image.

![30 Day Sales Trend](image)

Click the **Restore button** in the lower-right corner of the container, to restore the comments area.
Customize the height of the comments area by dragging the height indicator to achieve a desirable size, as shown in the following image.

![Chart Image]

- Click the **Refresh** button to refresh comments.
- Click the **Search** button in the comments menu, and type a key word or words in the search field, to search through comments. You can specify the search criteria by clicking the arrow next to the Search button and selecting search criteria, such as user name, content, or meta tags.
- Click the **Remove All** button to remove all comments from all users. The Remove All option is only available to managers, developers, and group administrators.

### Removing Customizations

If the domain portal page is unlocked and added to the portal, users are able to customize it and remove their customizations at run time.
Procedure: How to Remove Customizations From a Base Portal Page at Run Time

1. Inside the portal, right-click a page tab of a base portal page.
2. Click Remove My Customizations, as shown in the following image.

![Image of WebFOCUS interface with Remove My Customizations option highlighted]

The page refreshes. The customizations are removed from the modified portal page.

**Note:** This option is not available when the Lock Page option is selected.
Chapter 6

Using Content

After you have created and customized your content, learn how to distribute the content and create schedules.

**In this chapter:**

- Creating Distribution Lists
- Maintaining Distribution Lists
- Creating Schedules
- Using Amper Variables as Parameter Values
- Maintaining Schedules
- Tracking Schedules
- Using Favorites
- Publishing Content
- Sharing Content
- Using Visualizations at Run Time
- Using the Deferred Report Status Interface

**Creating Distribution Lists**

A Distribution List is an easy way to distribute content to multiple recipients by specifying the name of a list stored in the Repository that contains the individual recipients rather than entering each recipient separately into a schedule. A Distribution List can be made available to other users by sharing it or changing its ownership to be managed or published.
Creating a Distribution List

You can create a Distribution List to distribute content to multiple recipients at one time. If you have an LDAP data source, you can access Email information that is stored in it by configuring the LDAP Email Setting in the ReportCaster Console Configuration tool. Once configured, you can select email addresses from within the email address book of your company, eliminating the need to type them in manually. For more information on the configuration of this functionality, see LDAP Setting on page 205.

For more information on using this feature, see How to Retrieve Email Addresses from an LDAP Data Source on page 888.

Before creating a Distribution List, understand what groups or individual users require access to it to determine the folder in which to create it.

Procedure: How to Create a Distribution List

1. In the Resources tree, right-click a domain or folder.
2. In the shortcut menu, point to New and click Distribution List.
   
   The Distribution List window opens, as shown in the following image.

3. In the Title box, type a descriptive name for the Distribution List.
4. From the Method drop-down list, select the distribution method for the Distribution List. Email is the default distribution method.
   
   If you select Email, you must provide a list of email addresses and can optionally burst values associated with an address. For details on entering burst values, see Bursting a Report on page 894.
On the ribbon, in the Members group, select the Add New button to specify the email addresses of the recipients (for example, chuck_hill@ibi.com for an individual user or #sales@ibi.com for a email server list that contains multiple email addresses). Be careful typing this information because there is no edit checking. The maximum number of email addresses you can specify in a Distribution List is 9999. You can specify a maximum of 800 characters within a single address line.

You can specify multiple email addresses within a single address field. For more information, see Specifying Multiple Email Addresses on page 898.

**Note:** In the Allowed Email Addresses and Domains dialog box in the ReportCaster Console, if the Restrict user input with this list check box has been selected, user input of email addresses is restricted to a list of allowed email domains and addresses.

-if you select Print, you must specify the printers that will receive the distribution and, optionally, burst values associated with the printer. For details on entering burst values, see Bursting a Report on page 894.

On the ribbon, in the Members group, select the Add New button to specify the printer using the following format:

```
queue@printserver
```

where:

- **queue**
  
  Is the name of the printer queue.

- **printserver**
  
  Is the host name or IP address of the printer.

Although ReportCaster supports specifying only the print server (host name or IP address), we recommend that you specify both the print queue and print server. (ReportCaster differentiates between the printer queue and the printer server by detecting the presence of the '@' separator.)

5. If you are finished creating a Distribution List, click Save & Close.

**Note:**

- The maximum length of a title value for a file is 256 characters.

- If the title of your file has the same name of an existing file in the folder, you will receive a message asking if you wish to replace the file.
Procedure: How to Retrieve Email Addresses from an LDAP Data Source

Note: In order to use this procedure, LDAP must be configured. For more information, see Using the ReportCaster Console on page 162.

1. From the Distribution List toolbar, click Add New.

The Add New Member dialog box displays, as shown in the following image.

2. Click the Search button adjacent to the email address field.
The Find dialog box displays, as shown in the following image.

3. Select the criteria (Last Name, First Name, or Email) and the operator (Equals, Starts with, Ends with, or Contains). Enter the search string (for example, M* to locate all records beginning with M).

4. Click Search.

ReportCaster retrieves and displays the specified names from the LDAP data source.

**Note:** You can select one record at a time or use the Ctrl key to select multiple records simultaneously.

5. Click the To button to add the selected email address or addresses to your selection.

6. Click OK to save them in the Distribution List.

7. On the Add New Member dialog box, click OK.

The email recipients are then listed in the Email column on the Distribution List dialog box.
Maintaining Distribution Lists

A Distribution List is an easy way to distribute content to multiple recipients by specifying the name of a list stored in the Repository that contains the individual recipients rather than entering each recipient separately into a schedule. A Distribution List can be made available to other users by sharing it or changing its ownership to be managed or published.

Editing and Deleting a Distribution List

If you are authorized to access the Distribution List tool, you can view and edit the Distribution Lists of which you are the owner. If the Distribution List is owned by a group or is published, you have to be authorized to edit it.

Procedure: How to Edit a Distribution List

1. From the Resources tree, select a domain or folder that contains a Distribution List.
2. Right-click the Distribution List and click Edit. Optionally, you can double-click the distribution list to open it.

A window opens displaying the properties of the selected Distribution List, as shown in the following image.

3. From this window, you can perform the following:
   - Change the name of the Distribution List by typing a new name in the Title field.
   - Change the distribution method.
Click Add New or double-click within the area below the Burst Value column to add a New Member to the Distribution List below Burst Value and Email. The Add New Member dialog box appears, as shown in the following image.

Delete a Distribution List entry by selecting the item to be deleted and then clicking Delete.

Note: In the Allowed Email Addresses and Domains dialog box in the ReportCaster Console, if the Restrict user input with this list check box has been selected, user input of email addresses is restricted to a list of allowed email domains and addresses.

4. When you have completed your changes, click Save & Close.

Note: If the title of your file has the same name of an existing file in the folder, you will receive a message asking if you wish to replace the file.

To exit the editing window without making changes, click Close.

Accessing Distribution Lists

Sharing a private Distribution List allows you to permit groups and users to see its content and use it in schedules while you retain ownership. Authorized users can share their private Distribution Lists with groups and users with whom they are permitted to share. The Distribution List can be accessed by users authorized to access the folder in which the shared Distribution Lists are located.
Authorized users can publish and unpublish Distribution Lists to make them available to users authorized to access the folder in which they are located. Publishing requires the folder the item is located in to be published in order to publish an item within the folder. If the folder is subsequently unpublished, all items in that folder are unpublished.

Procedure: How to Share a Distribution List

From the Resources tree, if you are authorized to share your private content, you can share a Distribution List with users authorized to access the folder in which the Distribution List is located by right-clicking the folder or Distribution List in the Resources tree and selecting Share.

Note: In order to share a Distribution List, it must reside in the My Content folder. If you have created the Distribution List in a different folder, simply drag the Distribution List into the My Content folder to enable the sharing options that are available to you.

If you are authorized for advanced sharing, you can share your private content with specific groups and users with whom you are authorized to share by performing the following steps.

1. From the Resources tree, select a domain or folder that contains a Distribution List.
2. Right-click the Distribution List and select Share with.
The Share dialog box displays, as shown in the following image.

3. Use the left and right arrow buttons to select which groups will have access to the Distribution List.

4. Use the left and right arrow buttons to select which users will have access to the Distribution List.

5. Click OK.

Procedure: **How to Publish Distribution Lists**

The following steps allow you to publish a Distribution List or folder.

**Note:** A folder must be published in order to publish items within it. Published items or folders display in color. Those that are unpublished display in black and white.

1. From the Resources tree, select a domain or folder that contains a Distribution List.

2. Right-click the folder or Distribution List and select *Publish.*
**Procedure:** How to Unpublish Distribution Lists

From the Resources tree, you can unpublish a Distribution List or folder.

1. From the Resources tree, select a domain or folder that contains a Distribution List.
2. Right-click the published folder or item that you want to unpublish and select *Unpublish*.

**Bursting a Report**

Instead of distributing an entire report from a scheduled report procedure (FEX), you can use the ReportCaster burst feature to break the report into sections to be distributed separately to the same or different destinations. Bursting enables you to target relevant sections of a report to individual users. Each report section is saved to a separate file.

If you are distributing a burst tabular report, the burst value is determined by the first BY field. If you are distributing a burst graph report, the burst value is determined by the second BY field. The burst value is automatically determined by the internal matrix, which is a memory area that stores each database field value and calculates values referenced by the TABLE or GRAPH request.

You can send several report sections to one recipient by specifying the destination of that recipient (email addresses and files or printers) for each section you want to send. You can also send several report sections to one destination. The burst values you specify in the Distribution List must exist in the data source you are reporting against.

**Note:**

- If you want to burst a report, you must enable the bursting option within the Task for a schedule. The burst values specified in the Burst Value column in the Distribution List are ignored unless the Task specifies to burst the report.
- Report names containing more than 60 National Language Support (NLS) characters are truncated to 60 characters prior to distribution. This prevents a report name from becoming corrupted when the report is emailed.
Example: Specifying Burst Values in a Distribution List

You can specify sort field burst values and destinations (email addresses or printers) when creating or editing a Distribution List. The following image shows burst values and the destination email addresses specified in the Distribution List window.

Using the primary sort field values (Northeast Sales, South Sales, and Midwest Sales), the email address of each representative is associated with the relevant sales report data. Since Chuck Hill needs only the data for the Northeast branch, the sort value Northeast is listed in the Burst Value column and is associated with his email address in the E-mail column.

However, Tom Gregory works in both the Midwest and South regions. Since he requires data for both regions, his email address is listed in the E-mail column twice, next to a Burst Value column entry for each region.

**Note:** You can click on a column heading to sort the data in that column.

**Tip:** You can specify multiple email addresses on a single Address line. For details, see *Specifying Multiple Email Addresses* on page 898.

**Bursting Guidelines and Limitations**

This section provides detailed information to assist you in defining burst values.
When a schedule task specifies to burst a report procedure (FEX), all data values generated for each burst section are returned to the Distribution Server.

- For the Repository distribution method, each burst section is distributed to the repository. The owner of the schedule must have write access to the repository folder specified in the schedule when the scheduled job runs for the report output to be successfully distributed. Access to the report sections is controlled by the repository security rules that are created when the report is distributed.

- For the email and printer distribution methods, specific burst sections are distributed based on the burst values specified when creating the Distribution List or single address used by the schedule.

The following are guidelines and limitations that apply to the burst feature:

- **Case.** Burst values are case-sensitive.

- **Keywords.** Burst values can contain the following keywords:
  
  - **Wildcard Characters.** Use an asterisk (*) and a question mark (?) as wildcards to represent characters at the beginning, end, or middle of the burst values. The asterisk represents one or more characters, while the question mark represents any single character. Precede each instance of a burst value using a wildcard with the wildcard keyword enclosed in brackets followed by a colon, [wildcard]:, as shown in the following examples.
    
    - [wildcard]:abc* = all values that start with 'abc'.
    - [wildcard]:a?c = all three-character values that start with 'a' and end with 'c'.
    - [wildcard]:a?c* = all values that start with 'a' and have a 'c' as the third character.

  - **Java Regular Expressions.** Use to identify strings of text. Precede each instance of a burst value using a Java regular expression with the regular expression keyword enclosed in brackets followed by a colon, [regexp]:, as shown in the following examples.
    
    - [regexp]:[bcr]at = values that are bat, cat, or rat.
    - [regexp]:[^bcr]at = any value that is not bat, cat, or rat.

- **Default Distribution.** You can provide a default destination for burst values that are not specified in the Distribution List. To do this, enter the following in the burst value column of the Distribution List.
[ellesend] = reports for burst values not contained in the Distribution List will be sent to the named recipient.

- **'%BURST' Syntax.** You can include a burst value in the name of a distributed file by using the '%BURST' syntax in the name. The use of '%BURST' is not supported in a zip file name when the Packet email setting is Yes.

The following are example entries in an email Distribution List that illustrate the use of the wildcard and default distribution keywords in burst values.

<table>
<thead>
<tr>
<th>Burst Value</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>[wildcard]:<em>an</em></td>
<td><a href="mailto:sml@company.com">sml@company.com</a></td>
</tr>
<tr>
<td>England</td>
<td><a href="mailto:ray@company.com">ray@company.com</a></td>
</tr>
<tr>
<td>[ellesend]:</td>
<td><a href="mailto:jt@company.com">jt@company.com</a></td>
</tr>
</tbody>
</table>

Using a scenario where the report output from a scheduled report procedure (FEX) is burst on the Country field that contains values of Germany, USA, France, Canada, Italy, Chile, England, and Japan, then:

- Report information for Germany, France, Canada, England, and Japan will be delivered to sml@company.com.
- Report information for England will be delivered to ray@company.com.
- Report information for USA, Italy, and Chile will be delivered to jt@company.com.

- **Formats.** All formats support bursting except XML and EXCEL. Each burst section of the report output from a scheduled report procedure (FEX) will be named `burstvalue_filename.format` (for example, Northeast_Sales.pdf).

- **ACROSS command.** This command is not evaluated as a primary sort field. To burst report output from a scheduled report procedure (FEX), you must also include a BY field. Bursting occurs on the BY field.

- **TABLEF.** No internal sort processing is performed. The specification of a BY field requires that the data already be sorted in the data source.
ON TABLE SUBHEAD/ON TABLE SUBFOOT. Creates a SUBHEAD for only the first page of the report output from a scheduled report procedure (FEX), and a SUBFOOT for only the last page of the report output from a scheduled report procedure (FEX). When bursting report output from a scheduled report procedure (FEX), the SUBHEAD and SUBFOOT should occur for each sort break. Therefore, specify the primary sort field in place of TABLE in the ON command. For example:

ON primarysortfield SUBHEAD

AnV field types. Bursting is not supported on a field with the AnV (where n is an integer value) field type.

Specifying Multiple Email Addresses

When creating a schedule or Distribution List, you can specify multiple email addresses within a single field, row, or record.

When creating a schedule or Distribution List, you can separate each email address with a comma (,) or a semicolon (;).

The multiple email addresses will appear in the To line of a single email when the scheduled output is distributed.

Note:

- To distribute separate emails for each address, specify the email addresses on separate lines within the Distribution List.
- If the Email Delivery, Restrict Email Domains option is set to yes in the Server Configuration tool, then only those email domains (the portion of the email address following the at (@) symbol) listed in Allowed Email Domains (also in the Server Configuration tool) are valid email recipients.

Example: Specifying Multiple Burst Email Addresses

If you are using the default configuration (Packet Email = YES), one email is distributed for multiple burst values specified for the same email address. The email address values specified on each row are treated as a string that is a key. If there are multiple rows with the same address value (key), one email is distributed with all the burst values. For example, consider the following Distribution List:

<table>
<thead>
<tr>
<th>Burst Value Address</th>
<th><a href="mailto:user1@abcd.com">user1@abcd.com</a>;<a href="mailto:user2@abcd.com">user2@abcd.com</a></th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td><a href="mailto:user1@abcd.com">user1@abcd.com</a></td>
</tr>
<tr>
<td>B</td>
<td><a href="mailto:user1@abcd.com">user1@abcd.com</a></td>
</tr>
<tr>
<td>C</td>
<td><a href="mailto:user1@abcd.com">user1@abcd.com</a></td>
</tr>
</tbody>
</table>
In this example, user1@abcd.com receives two emails when the scheduled output is distributed. In the first email, user1@abcd.com; user2@abcd.com appears in the email To line and one attachment is distributed for burst value A. In the second email, user1@abcd.com appears in the To line and two attachments are distributed, one for burst value B and one for burst value C.

If you are using the configuration that specifies to distribute a single email for each row (Packet Email = NO), then the following behavior occurs for our example. Three separate emails are distributed. In the first email, user1@abcd.com; user2@abcd.com appears on the To line and one attachment is distributed for burst value A. The second email is sent to user1@abcd.com with one attachment for burst value B. The third email is sent to user1@abcd.com with one attachment for burst value C.

If a schedule has Packet Email = BURST, then for each burst value the output for each task is combined and distributed. In our example, three separate emails are distributed. In the first email, user1@abcd.com; user2@abcd.com appears on the To line and all output from the tasks for burst value A are distributed. The second email is sent to user1@abcd.com with all output from all tasks for burst value B. The third email is sent to user1@abcd.com with all output from all tasks for burst value C.

Another consideration is when using the default configuration (Packet Email = YES) and the same burst value is specified multiple times for the same Address (key) value. For example, consider the following Distribution List:

**Burst Value Address**

<table>
<thead>
<tr>
<th>Burst Value</th>
<th>Address</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td><a href="mailto:user1@abcd.com">user1@abcd.com</a>;<a href="mailto:user2@abcd.com">user2@abcd.com</a></td>
</tr>
<tr>
<td>B</td>
<td><a href="mailto:user1@abcd.com">user1@abcd.com</a></td>
</tr>
<tr>
<td>B</td>
<td><a href="mailto:user1@abcd.com">user1@abcd.com</a></td>
</tr>
</tbody>
</table>

In this Distribution List, only two emails are distributed for user1@abcd.com. In the first email, user1@abcd.com; user2@abcd.com appears in the To line and the attachment is for burst value A. In the second email, user1@abcd.com appears in the To line and the attachment is for burst value B. The third row in the Distribution List is ignored since it contains the same key and the same burst value, B, as the second row.

As a best practice, be sure to review your distribution information to make sure you have not duplicated the same burst and address value pairs.
**Example:** Specifying Multiple Non-Burst Email Addresses

Consider the following sample Distribution List, which does not contain burst values:

**Address**

user1@abcd.com;user2@abcd.com

user1@abcd.com

user2@abcd.com

user3@abcd.com

user1@abcd.com;user2@abcd.com;user3@abcd.com

In this Distribution List, an email is distributed for each address line regardless of whether Packet Email is set to YES or NO. This is because each address value is unique. For the first email, user1@abcd.com; user2@abcd.com appears in the To line and the attachment is for the full report output from a scheduled report procedure (FEX). The second email is distributed to user1@abcd.com, and so on.

If one of the address lines is repeated in the Distribution List (for example, if user3@abcd.com is added as the sixth line in the example Distribution List), the behavior would work as follows. If Packet Email = YES, only one email is distributed for user3@abcd.com. However, if Packet Email = NO, two separate emails are distributed to user3@abcd.com.

**Creating Schedules**

A schedule allows you to specify when to run a report, the format in which to create the output, and how it will be distributed.

**About the Basic Scheduling Tool**

The Basic Scheduling tool provides the ability to create a schedule for a procedure (FEX) when right-clicking a report procedure (FEX) from the portal. The WebFOCUS Client security authorization model controls whether users are authorized to access the application content stored in the Repository and the Scheduling tools.

To create a new schedule for a report procedure (FEX), navigate to the Resources tree and expand a domain to display your folders and report procedures (FEX). Right-click the report procedure (FEX) you want to schedule, point to Schedule, and then select the method to distribute the report procedure (FEX). You can distribute the report procedure (FEX) by Email, Printer, or Repository.
Basic Scheduling Tool Quick Access Toolbar

The Quick Access Toolbar, located at the top of the Basic Scheduling tool, is always visible no matter which options are selected. It provides access to the most commonly used functions. From the Quick Access Toolbar, you can select the ReportCaster button to access the New Distribution List, Save, Save As, Delete, and Close options. You can also access the Save, Run, and Help options from the toolbar.

Run options are available for selection from the Run drop-down list.

**Note:** The schedule must be saved for Run options to be available or enabled.
The Run options you can select include: Run with default traces, Run with no traces, Run with Schedule traces, and Run with Schedule and Report traces, as shown in the following image.

Note:

- If you have the Session Traces privilege, you will have the Run with Traces options in the schedule tools. If you are not authorized to run with traces, these options will not display.

- Online help is available by clicking the online help icon.

Basic Scheduling Tool Ribbon

The Basic Scheduling tool ribbon partitions the scheduling options into the following categories:

- **Actions**

  The Actions portion of the ribbon is shown in the following image.

  - **Save & Close.** Saves and closes the schedule.
  - **Delete.** Deletes the schedule and closes the Scheduling tool.
The Show portion of the ribbon is shown in the following image.

Properties. Provides a Title, Path where the schedule will be created or was opened from, Summary, Job Priority Level, No Report to Distribute, and other settings for the schedule. The **Delete this schedule if it is not scheduled to run again** check box specifies to delete the schedule if, after it is run, it is not scheduled to run again. The **Enabled (Scheduled job runs at specified time)** check box specifies to run the schedule as specified by the Recurrence settings within the schedule. The **No Report to Distribute** drop-down list box specifies whether to process a No Report to Distribute result as an Error or a Warning.

Recurrence. Provides run-time intervals for distribution and repeat options.

Distribution. Provides options to specify the recipients or location to which the report will be distributed.

Task. Provides information on the report procedure (FEX) that is being scheduled.

Notification. Provides the options to set up notification of the schedule status.

Log Reports. Shows the Number of Jobs and the Log Report for individual jobs.

Options

The Options portion of the ribbon is shown in the following image.

Parameters. Specifies values for parameters that are required at run time by the report procedure (FEX) being scheduled.
Creating Schedules

- **Advanced Task Settings.** Allows you to input the report language and additional FOC Errors to be processed as warnings.

## Creating a Schedule in the Basic Scheduling Tool

This section provides the overall procedure to create a new schedule for a report procedure (FEX). Some steps in the procedure contain details on the associated options, while other steps direct you to a separate section that contains detailed descriptions of the options and additional information, such as tips in making a selection.

To save a schedule, the required information in the Properties, Recurrence, Distribution, and Notification tabs must be provided. If required schedule information is missing when you save the schedule, a message will display informing you of the schedule information that needs to be entered.

### Procedure: How to Create a Schedule

1. Open the Basic Scheduling tool, as described earlier in this section. The Basic Schedule Distribution tab appears. For more information, see *About the Basic Scheduling Tool* on page 900.

   In the Distribution tab, you can adjust your distribution preferences for your schedule. The options available will change depending on whether you have selected Email, Printer, or Repository distribution. For more information, see *Distribution Options in the Basic Scheduling Tool* on page 931.

2. In the Properties tab, you can edit the name for the schedule in the **Title** box.

   This is a required field and a default name is provided.

3. Type a descriptive summary in the **Summary** box.

   **Note:** This is an optional field.

4. Select a Job Priority Level.

   Normal - 3 Job Priority Level is the default.

5. Check the **Delete this schedule if it is not scheduled to run again** check box if you do not want this schedule to be stored in the Repository if it will not run again as specified in the Schedule recurrence settings.

6. Leave the **Enabled (Scheduled job runs at specified time)** check box checked if you want scheduled jobs to run as specified in the recurrence settings.

7. Select the Recurrence tab and make the following selections.

   a. From the Settings radio button list, select a time interval that the schedule will use to run the report procedure (FEX).
You can set the interval to Run Once, Minutes, Hourly, Daily, Weekly, Monthly, Yearly, or at Custom intervals.

b. From the Start Schedule options, select the date (from the drop-down calendar) and time you want the schedule to begin running.

   **Note:** To change the time setting, select either the hour or minutes and use the arrows to increase or decrease the value.

c. If applicable to the Run Interval selection, from the End Schedule options, select the date and time you want the schedule to stop running.

d. If applicable to the Run Interval selection, from the Advanced settings, click the *Repeat schedule every:* check box to enable custom intervals.

   **Note:** This option is disabled for the Run Once, Minutes, and Hourly settings options.

8. Select the *Task* tab. The Path, Procedure, Server Name, and Save Report As fields are populated according to the report procedure (FEX) you selected to schedule. For a description of the Task tab, see *About Tasks in the Basic Scheduling Tool* on page 906.

9. Select the *Notification* tab and specify whether or not you want to send a notification when the schedule runs and under what conditions to send it. The notification options are:

   - **Never.** ReportCaster will not send a notification of the schedule status under any circumstances. This is the default value.
   - **Always.** Send a notification each time the schedule runs.
   - **On Error.** Only send a notification when there is an error running the schedule.

   For more information, see *Notification Options in the Basic Scheduling Tool* on page 942.

10. In the Log Reports tab, you can view logs and manage log reports for the schedule.

11. To save the schedule, click *Save & Close* on the ribbon.

   **Note:** You can optionally click Save on the toolbar to remain in the Scheduling tool. The Save dialog box appears.

12. Select the folder that will contain the schedule.

   **Note:**

   - You must be authorized to create content in this folder.
   - The default location for saving a schedule is dependent upon your privileges. If you can create content in the folder where the Scheduling tool is launched, the Save dialog will be positioned in that folder. If you are not allowed to create content in that folder, the Save dialog will be positioned in the My Content folder located under that folder. If a My Content folder is not available, the Save dialog will be positioned in the first writable folder found.
Creating Schedules

13. Enter a name for the schedule and click Save.

Note:

- The maximum length of a title value for a file is 256 characters.
- If the title of your file has the same name as an existing file in the folder, you will receive a message asking if you wish to replace the file.

About Tasks in the Basic Scheduling Tool

When you access the Basic Scheduling tool, the information for the Task tab options is predefined with the selected report procedure (FEX) information. You can complete the available task options, such as specifying parameter values, as well as select whether or not to burst the report.

Note: You can use parameters (amper variables) when specifying a value in the Save Report As field of a schedule. These parameters can be system variables, such as &YYMD or any amper variable for which a value is returned by the Reporting Server when the scheduled procedure is executed. To use the dot file extension separator after a variable, terminate the variable with the '|' character, for example, &YYMD|.htm. Similarly, to use the ampersand character itself, follow the ampersand with the '|' character (for example, Smith&|Jones). If a value for a parameter specified in a schedule is not returned by the Reporting Server when the procedure executes, the schedule will fail with a "No report to distribute" error. If the scheduled task is burst, you can also use the '%BURST' symbol to include the burst value in the Save Report As field.

Task Options in the Basic Scheduling Tool

The options available when you select the Task tab are:

- **Path.** Shows the report path in the Repository or on the Reporting Server.

- **Procedure.** The name of the procedure you are scheduling.

- **Server Name.** The Reporting Server to which the report procedure (FEX) will be submitted.

- **Execution ID.** The user ID running the report procedure (FEX) on the Reporting Server.

- **Alert.** Specifies how to reactivate the alert or to deactivate the alert condition when it is triggered. Click Alert to specify the alert options.
Select one of the following options from the Alert Options dialog box.

- **Automatically Reset.** After the alert is triggered, reactivate the alert when the condition is no longer true. The system will keep checking the condition after the alert has been triggered. As soon as the condition is no longer true, it will reactivate the alert. This is the default value.

- **Continue After Alert.** After the alert is triggered, reactivate the alert immediately.

- **Deactivate Schedule After Alert.** Deactivate the schedule after the alert is triggered.

- **Delay.** Restart the alert after a specified period. You can specify to restart the alert after a maximum of 99 hour(s), day(s), week(s), month(s), or year(s).

  **Caution:** Be sure that you set the schedule interval to a time period greater than the time it takes to run the scheduled procedure. When the schedule interval is less than the time it takes to run the procedure and the Delay option is selected, an alert schedule will distribute (based on the Distribution that you selected) more frequently than expected. For email distribution, this can result in unnecessary distribution of emails which can impact the business or operational goals of the alert report distribution.

**Report Properties**

- **Burst Report.** If you want to burst the report, select the Burst Report check box. The burst feature enables you to instruct the Reporting Server to create the report in sections so that they can be distributed separately.

- **Override the Format Specified in the Procedure.** Select this check box to display the list of report formats and indicate a format other than the one specified in the procedure.

  **Note:** When editing an existing schedule, if the Override the Format Specified in the Procedure check box was selected, the list of formats will display. If you now clear the Override the Format Specified in the Procedure check box, the list of formats does not display. Conversely, if the Override the Format Specified in the Procedure check box was not selected, the list of formats will not display. If you now select the Override the Format Specified in the Procedure check box, the list of formats displays.

- **Save Report As.** Allows you to specify a different name for the report, which defaults to the name of the report that you selected to schedule.
Specifying Parameter Values

You can customize a report and control its execution with parameters. When scheduling a report procedure (FEX), the schedule task Parameters section allows you to supply a value for parameters referenced in the report procedure or add a parameter to the schedule by creating a new parameter and specifying the parameter name and value.

Procedure: How to Specify Parameter Values

If the scheduled procedure contains parameters for which values must be supplied at run time, these parameters are displayed in the parameters section of the scheduling tool.

In the Basic Scheduling tool, click the Parameters tab to open the Task Parameters dialog box, shown in the following image.

![Task Parameters dialog box](image-url)
Parameters may have default values and may have values that can be selected from a static or dynamic list. For more information about selecting parameters in the Scheduling Task Parameters dialog box, see the examples provided in this chapter.

**Reference:** Considerations When Specifying Parameter Values

The following are considerations when specifying parameter values for a procedure:

- The maximum number of characters for each individual parameter value is 3200. You can store multiple values for a single parameter. Multiple values for a parameter are stored as one entry, which must not exceed the 3200 maximum character limit.

- ReportCaster displays the description for the parameter when it is specified in the procedure. Otherwise, ReportCaster displays the parameter name.

- ReportCaster displays default variable values, as well as static or dynamic single-select and multiselect lists.

**Note:**

- The No Selection option is displayed for dynamic multi-select lists. When selected, this option does not perform any data selection test on that field.

- ReportCaster does not support using the -HTMLFORM command to create a dynamic selectable list of parameter values.

- ReportCaster displays global variables that are used in FILTERS defined in Master Files and referenced by a procedure. For example, if a Master File contains

```plaintext
FILENAME=CAR,SUFFIX=FOC
VARIABLE NAME=&&COUNTRY1, USAGE=A10, DEFAULT=ENGLAND,$
FILTER FILTER1=COUNTRY EQ '&&COUNTRY1'; $
```

and the procedure being scheduled contains

```plaintext
WHERE FILTER1
```

then ReportCaster displays COUNTRY1 in the Parameters window.

- ReportCaster does not prompt for the value of its internal variables that are set by the Distribution Server at schedule execution time. For example, &DSTOWNER is the user ID of the schedule owner. If this parameter is referenced in a scheduled procedure, the value will be available because the Distribution Server sets the value to the owner of the schedule at schedule execution time. However, the scheduling tool will not prompt for this value in the Task Parameters dialog box.
Once a parameter is stored for a schedule, ReportCaster will continue to display that parameter in the Parameter list and submit the parameter to the Reporting Server when the schedule is run even if the parameter is removed from the underlying report. To remove the parameter from the schedule information, edit the schedule and delete the parameter. For information on how to delete a parameter from a schedule, see Deleting a Parameter on page 928.

A parameter value that contains special characters should not be used in a schedule setting that refers to an output file name, since file names cannot contain special characters. Examples of affected schedule settings include the Save Report As value, the Report Name value for single-file FTP distribution, and the Zip File Name.

A FEX can be coded to set the Display Value for any value. For example, if a value is named ENGLAND, the Display Value can be set to display as England.

**Example: Adding a Static Single-Select List of Parameter Values**

The following image shows an example of a static parameter list for the CATEGORY parameter created in WebFOCUS InfoAssist.
The following image shows the Task Parameters dialog box displaying the CATEGORY parameter. The CATEGORY parameter has been encoded to only use the values Coffee, Food, or Gifts. InfoAssist, the content developer tool in WebFOCUS Business User Edition, does not allow you to set default values. Therefore, the Use Default column will always be blank.

To supply a value for a single-select parameter, select the Value field drop-down list box and choose a value. Your selected value will be shown in the value column. You can select only one value for a static single-select parameter.
**Example:** Adding a Dynamic Single-Select List of Parameter Values

The following image shows an example of a dynamic single-select parameter list for the Product parameter. This filter is created in InfoAssist.
The following image shows the Task Parameters dialog box displaying the PRODUCT parameter. To change a parameter value, click the PRODUCT parameter in the table and change the parameter value using the Value field drop-down list in the Parameter Properties section.
Example: Adding a Dynamic Multiselect List of Parameter Values

The following image shows an example of a dynamic multiselect parameter list for the PRODUCT parameter. This filter is created in InfoAssist.
The following image shows the PRODUCT parameter selected in the Task Parameters table.
In the Parameter Properties section, click the Value button to display the Parameter Value for Amper Variable dialog box, as shown in the following image.

The All Values check box is selected by default. If the All Values check box is cleared, you can select a single value, or you can select multiple values by holding down the Ctrl key.

**Using Parameter Values to Burst Active Dashboards and Compound Reports**

In addition to the ability to distribute sections of a single report to individual users using standard bursting, you can distribute sections of reports by using a filter with a static or dynamic multi-select parameter.

Active dashboards, which are compound reports that contain active reports, and reports that use an Excel format output, can be burst by using the parameter values saved in these reports. You can also burst Excel reports that contain a table of contents. You can burst these reports using a field other than the first BY field.
The Repeat Task for Each Selected Value check box must be selected in order to burst each parameter separately. In the Basic Scheduling tool, the Repeat Task for Each Selected Value check box is found in the Parameter Value for Amper Variable dialog box, as shown in the following image.

![Parameter Value for Amper Variable](image)

**Note:**

- This check box is cleared by default.
- The Repeat Task for Each Selected Value check box only displays for static or dynamic multiselect parameters.
- At least one parameter value must be selected.
- If the All Values check box is selected, the term _FOC_NULL appears in the Value field of the Task Parameters dialog box. The server then performs a WFDescribe at run time to generate the list of values for the parameter.
- The Repeat Task for Selected Parameter Value feature can only be applied to one parameter at a time.
- If the Burst Report check box within the Task tab of the Basic Scheduling tool is selected first, then the Repeat Task for Each Selected Value check box will be disabled and cannot be selected. The two bursting methods cannot be combined in one schedule.
If the Repeat Task for Each Selected Value check box is selected on the Parameter Value dialog box, then the Burst Report check box within the Task tab of the Basic Scheduling tool becomes the Burst Report by Parameterized Report Filter check box. This check box will now be automatically selected and cannot be cleared unless the Repeat Task for Each Selected Value check box is cleared.

The values you choose are shown in the Task Parameters dialog box and placed between square brackets in the Value column to indicate their selection, as shown in the following image.
Once the schedule is run, the Distribution Server repeats the execution of the task for each parameter selected. For example, since the parameter values Japan, Italy, and France are selected, and the Repeat Task for Each Selected Parameter check box is selected, the schedule bursts the report information into three separate reports. Each report shows information related to one of the three selected parameters, as shown in the following image.

![Example reports for Japan, Italy, and France](image)

### Running Pre and Post-Processing Procedures for Each Parameter Value

Selecting the **Repeat Task for Each Selected Value** check box allows you to select the **Run Pre/Post-RPC Every Time** check box, as shown in the following image.

![Parameter value selection window](image)

The **Run Pre/Post-RPC Every Time** check box enables the Distribution Server to run pre-processing and post-processing procedures with each task repetition.
For example, if three parameter values are selected, and the Run Pre/Post-RPC Every Time check box is selected, pre-processing procedures run before each selected value, and post-processing procedures run after each selected value.

If you do not select this check box, pre-processing procedures execute only once before the first task is executed, and post-processing procedures execute only once after the last task is executed. This check box is cleared by default.

**Note:** The Run Pre/Post-RPC Every Time check box cannot be selected unless the Repeat Task for Each Selected Value check box is selected first.

**Procedure:** How to Burst a Filtered Active Dashboard or Excel Compound Report Using the Basic Scheduling Tool

1. Create an active dashboard or Excel compound report that contains at least one static or dynamic multiselect parameter. For more information, see Creating Reports on page 371.

2. Right-click the report, point to Schedule, and select a distribution method to begin a new basic schedule.

3. In the Options group, click Parameters.

   The Task Parameters dialog box opens.

4. Choose the parameter you wish to edit.

   Once the parameter is chosen, the Parameter Properties section is populated with information about the selected parameter.

5. In the Parameters Properties section, click the Value button.

   **Note:** For the Value button to be able to be selected, the chosen parameter must be a multiselect parameter.

   The Parameter Value for Amper Variable dialog box opens.

6. Choose the values that you want the schedule to burst. While holding the Ctrl key, use your mouse to select more than one value. To choose all values, select the All Values check box.

7. Select the Repeat Task for Each Selected Value check box.

8. Optionally, select the Run Pre/Post-RPC Every Time check box. For more information, see Running Pre and Post-Processing Procedures for Each Parameter Value on page 919.

9. Click OK.
The selected parameter values now appear in square brackets in the Task Parameters dialog box in the Value column, as shown in the following image.

10. Click OK.

11. Input all other necessary options and settings for your schedule, then save the schedule. For more information, see Creating a Schedule in the Basic Scheduling Tool on page 904.

12. Run the schedule.

When the schedule is run, it distributes a report for every burst parameter that you selected, as shown in the following image.
Bursting an Active Dashboard or Excel Compound Report That Contains Filtered and Unfiltered Reports

When you create an active dashboard or Excel compound report that contain filtered and unfiltered reports, only the filtered reports can be configured for bursting.

The following image shows two reports created in InfoAssist on one dashboard. The report showing MODEL, CAR, COUNTRY, and DEALER COST data has a COUNTRY filter applied, which allows the user to filter report results by country. The report showing MODEL and RETAIL_COST data does not have a filter.
When you access Task Parameters for this compound report through the scheduling tool, any edits you make to the parameter will only apply to the filtered report. Meaning, you will only be able to assign values to a parameter in the filtered report. An example of this is shown in the following image, where you can see the values that were assigned to the COUNTRY parameter.

When you schedule a compound report to be burst, and the Repeat Task for Each Selected Value check box is selected, the reports that contain filters will burst based on the parameter values selected. In the following image, the compound report is distributed into three separate burst reports, which show filtered data about W GERMANY, FRANCE, and JAPAN, respectively.

For each burst report, the first chart shows data for the selected COUNTRY value.
The following image shows the W GERMANY burst compound report.

Because no filters have been applied to the second report, the results of the second report are the same for each burst compound report. Only the report that uses the COUNTRY filter changes.

### Bursting an Active Dashboard or Excel Compound Report That Contains Only Filtered Reports

If you attempt to burst an active dashboard or Excel compound report that contains only filtered reports, all reports will be compatible with bursting.
The following images show two reports created in InfoAssist on one dashboard. Both reports use the same filter for the MODEL data.

When Task Parameters are accessed through the Scheduling tool for this compound report, you can specify the MODEL values for both reports.
As shown in the following image, the MODEL parameter has the filter values 3.0 SI 4 DOOR, 100 LS 2 DOOR AUTO, XJ12L AUTO, B210 2 DOOR AUTO, and 2000 SPIDER VELOCE selected.

<table>
<thead>
<tr>
<th>Parameter Value for Amper Variable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Please select value(s) for the Amper Variable:</td>
</tr>
<tr>
<td>□ All Values</td>
</tr>
<tr>
<td>□ 100 LS 2 DOOR AUTO</td>
</tr>
<tr>
<td>□ 2000 4 DOOR BERLINA</td>
</tr>
<tr>
<td>□ 2000 GT VELOCE</td>
</tr>
<tr>
<td>□ 2000 SPIDER VELOCE</td>
</tr>
<tr>
<td>□ 2002 2 DOOR</td>
</tr>
<tr>
<td>□ 2002 2 DOOR AUTO</td>
</tr>
<tr>
<td>□ 3.0 SI 4 DOOR</td>
</tr>
<tr>
<td>□ 3.0 SI 4 DOOR AUTO</td>
</tr>
<tr>
<td>□ 504 4 DOOR</td>
</tr>
<tr>
<td>□ 530I 4 DOOR</td>
</tr>
<tr>
<td>□ 530I 4 DOOR AUTO</td>
</tr>
<tr>
<td>□ B210 2 DOOR AUTO</td>
</tr>
<tr>
<td>□ COROLLA 4 DOOR DX AUTO</td>
</tr>
<tr>
<td>□ CORTINA 2 DOOR</td>
</tr>
<tr>
<td>□ INTERCEPTOR III</td>
</tr>
<tr>
<td>□ TR7</td>
</tr>
<tr>
<td>□ V12XRIE AUTO</td>
</tr>
<tr>
<td>□ XJ12L AUTO</td>
</tr>
</tbody>
</table>

☑ Repeat Task for Each Selected Value
☐ Run Pre/Post-RPC Every Time

[OK]  [Cancel]
The selected values appear in brackets in the Task Parameters dialog box, as shown in the following image.

When you schedule a compound report to be burst, and the Repeat Task for Each Selected Value check box is selected, burst reports are created based on the parameter values selected. In the following image, the compound report is distributed and burst into five separate compound reports, which show filtered data about each selected car model.
For each burst compound report, both reports show data for the selected car model. In the following image, the burst compound report showing information about the 3.0 SI 4 DOOR car model is selected. Both reports in the burst compound report only show information about the selected model.

<table>
<thead>
<tr>
<th>MODEL</th>
<th>CAR</th>
<th>COUNTRY</th>
<th>DEALER_COST</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.0 SI 4 DOOR</td>
<td>BMW</td>
<td>W GERMANY</td>
<td>10,000</td>
</tr>
</tbody>
</table>

Deleting a Parameter

It is important to verify that the parameters you delete when scheduling a report procedure (FEX) will be handled, as follows, so that the scheduled job will run successfully:

- A default value is specified in the report procedure (FEX) being scheduled.

- A value will be dynamically assigned to the parameter by the report procedure (FEX) processing when the scheduled job runs on the Reporting Server.

- The parameter will not be referenced when the report procedure (FEX) is processed by the Reporting Server.

To delete a parameter so that it is not stored with the schedule information, highlight the parameter in the parameter table you want to delete, and click the Delete button.

Creating a New Parameter

If you need to have the schedule job send a parameter and value that is not defined in the report procedure being scheduled, you can create a new parameter in the Task Parameters dialog box. Parameters referenced during processing by the Reporting Server must be assigned a value for the scheduled job to run successfully. The schedule job log report will contain information when required parameter values were not provided.
**Procedure:** How to Create a New Parameter

You can create parameters for a task as follows:

1. On the ribbon, click **Parameters** to open the Task Parameters dialog box. The Task Parameters dialog box is shown in the following image.

![Task Parameters Dialog Box](image)

2. Click the **New** button located above the Parameter Properties section.
The Task Parameter dialog box displays, as shown in the following image.

3. Enter a value in the Name and Value boxes.

4. Click OK.

The Name and Value boxes are populated in the Task Parameters dialog box Parameters table.

5. If you would like to change the parameter value, select the parameter in the Parameters table and specify the values in the Description and Value fields located in the Parameter Properties section.

6. Click OK when you have completed entering parameter settings for the task.

**Advanced Task Settings**

The Advanced Task Settings option in the Options group provides access to the Additional FOC Errors to be Processed as Warnings dialog box, where you can specify one or more FOCUS error message numbers, separated by a comma. If one of these FOCUS error numbers is encountered during schedule execution, ReportCaster will process it as a warning rather than an error. For example, if a FOC1517 error is generated by the procedure, add 1517 to the text box to convert this error to a warning. This means that if a report is produced, it will be distributed in spite of the FOCUS error number. It also means that this FOCUS error number will not trigger error notification if the schedule is configured to notify on error.

**Note:** When an accordion report is distributed through ReportCaster, an error may be generated. To prevent this, the error FOC 3330 (EXPANDBYROW: Not Supported with BORDER) can be added to the list of FOC Errors to be Processed as Warnings.
The following image shows the error FOC 3330 saved in the Additional FOC Errors to be Processed as Warnings dialog box.

![Error FOC 3330](image)

**Distribution Options in the Basic Scheduling Tool**

The Distribution tab in the Basic Scheduling tool provides the options available for distributing the report output for the scheduled report procedure (FEX). You can distribute a report output using one of the following methods.

- **Email**
- **Printer**
- **Repository**

**Note:**

- Distribution methods can be limited globally (for all users) in ReportCaster configuration and for groups or individual users by security operations.
- Maps can be distributed to the Repository only. Maps distributed by email do not open correctly.

**Using the Email Distribution Option in the Basic Scheduling Tool**

When you distribute a report through email, you can include the report in the body of the email (known as an inline email message) or send it as an attachment. Only the HTML, DHTML, WP, and DOC formats can be distributed as an inline email message.

**Note:** You must be authorized to distribute by email in order to create a schedule that uses Email distribution.

Distributing a report as an inline email message is particularly useful when the report is distributed to mobile devices or through email systems that do not support attachments.
You can also distribute a report to a fax machine, as explained later in this section. The following image shows the email distribution options in the Distribution tab of the Basic Scheduling tool when the email method is selected.

**Note:**

- The availability of the inline message option when you create a schedule depends on the Inline Report Distribution setting in the ReportCaster Configuration tool accessible from the ReportCaster Console.

- The display of a report that is distributed as an inline email message can be affected by settings and restrictions of your email server or email client.

- When distributing HTML reports by email, the scheduled report (.fex) must set a fully qualified FOCEXURL and FOCHTMLURL for the report styling options defined below. These reference the JavaScript components located on the web or application server where the Client is configured. The Distribution Server will set a fully qualified FOCEXURL and FOCHTMLURL for email distribution using the host name and port provided at installation time. This can be overridden by setting these values in the scheduled procedure. For example:
SET FOCEXURL='hostname:port/ibi_apps/'

SET FOCHTMLURL='hostname:port/ibi_apps/ibi_html'

Styling options include:

- Accordion reports
- Table of Contents (TOC) reports
- Peer Graphics/Data Visualization graphical reporting
- Multi-drill reports
- HFREEZE options

- In the Allowed Email Addresses and Domains dialog box in the ReportCaster Console, if the Restrict user input with this list check box has been selected, user input of email addresses is restricted to a list of allowed email domains and addresses.

**Reference:** Considerations When Sending a Report to Multiple Email Addresses

When you create a schedule that uses email distribution, you can type email addresses in the To field, as shown in the following image.

If you type multiple email addresses in the To field, you can use a semi-colon or comma symbol between each email address, to designate how the Distribution Server delivers information.

**Example:** Using a Comma to Separate Email Addresses in the To Field

If you use the comma symbol to separate email addresses, all email addresses are visible to every email recipient.
The following image shows the email addresses EmailA@ibi.com and EmailB@ibi.com separated by a comma.

The schedule will distribute a report named Sales_Metrics_YTD.htm to these email addresses. When you run the schedule, the log report states that one report named Sales_Metrics_YTD.htm has been distributed to both email addresses through a single email, as shown in the following image.

**Example:** Using a Semi-Colon to Separate Email Addresses in the To Field

If you use the semi-colon symbol to separate email addresses, each recipient only sees their own email address.

The following image shows the email addresses EmailA@ibi.com and EmailB@ibi.com separated by a semi-colon.

The schedule will distribute a report named Sales_Metrics_YTD.htm to these email addresses. When you run the schedule, the log report states that two reports named Sales_Metrics_YTD.htm have been distributed to EmailA@ibi.com and EmailB@ibi.com through separate emails, as shown in the following image.
Procedure: How to Use the Email Distribution Option

Note: You can use parameters (amper variables) when specifying values in the Email settings of a schedule. These parameters can be system variables, such as &YYMD, or any amper variable for which a value is returned by the Reporting Server when the scheduled procedure is executed. To use the dot file extension separator after a variable, terminate the variable with the '|' character (for example, &YYMD|.htm). Similarly, to use the ampersand character itself, follow the ampersand with the '|' character (for example, Smith&|Jones). If a value for a parameter specified in a schedule is not returned by the Reporting Server when the procedure executes, the schedule will fail with a "No report to distribute" error. If the scheduled task is burst, you can also use the '%BURST' symbol to include the burst value. If the Packet Email setting is Yes, the burst value will not be substituted in the Zip filename.

1. Right-click a report procedure (FEX), point to Schedule, and then select Email.

   The Basic Scheduling tool appears.

2. Select the Distribution tab.

3. From the Type drop-down list, select the method you will use to provide the email addresses that will receive the distribution. The options are Distribution List and Email Address(s). These options all show where the report procedure (FEX) distributes To and From, the Reply Address, and the Subject. Additionally, in the Email Information section, select whether you would like to send all reports as attachments or send a report as an inline message.

   Distribution List. The report will be sent to all email addresses in the selected email Distribution List.

   Email Address(s). This is the default method for supplying email addresses in the scheduling tools. The default value of this field is the email address of the user that is creating the schedule. You can specify multiple email addresses in the Email Address(s) field. Separate each email address with a comma (,) or a semicolon (;). The email addresses will appear in the To line of a single email when the scheduled output is distributed. Each individual email address can be a maximum of 130 characters, according to the SMTP specification. The total maximum length of this field is 800 characters.
Additionally, you can use group mail lists (defined on your mail server) with the Email Address(es) option. You can use group mail lists to distribute a report or notification to multiple recipients without having to maintain multiple email addresses in the Repository. The format of the group mail list depends on the mail server being used. For example, if you are using a Microsoft Exchange Server and your group mail list is defined as #group1, you would enter group1@listdomain in the Email Address(es) field. If the group mail list contains a space within its name, enclose the space with double quotation marks (" "). For more information, see your mail server administrator.

4. In the To box, type the email address of the recipient.

5. Optionally, click the To button to open the Enter Email Addresses dialog box and type an email address in the To, Cc, Bcc, and Reply fields.

   **Note:**
   - You can create a schedule that bursts sections of a report to different email recipients. However, if you type an email address in the Cc or Bcc field, every section of a burst report will distribute to the same Cc or Bcc email address.
   - If you type multiple email addresses in the Cc and Bcc fields, Cc and Bcc emails are always sent to each email address individually, regardless of whether a comma or semi-colon is used to separate addresses.

6. In the From box, type any value (for example, the name of the person creating the schedule). ReportCaster does not require a value for this field, but your email system may require one.

7. In the Reply Address box, type a valid email address. If recipients reply to the email, their messages will be sent to this address. If your email system is unable to deliver the content, the undeliverable output message is also returned to this address. ReportCaster requires this field.

   **Note:** If a default Mail Reply Address was not provided in the ReportCaster Configuration tool, the default Reply Address used for this field is the email address of the user that is signed to WebFOCUS. ReportCaster obtains the email address of the user from the WebFOCUS security system.

8. In the Subject box, type the text that you want to appear in the email subject line. ReportCaster may not require this information, but it may be needed by your email system. The value you entered in the schedule Title field is the default Subject value.

9. Specify whether you want to send the report as an email attachment, or within the body of the email inline by selecting or clearing the Send all reports as attachments option. For more information, see *Using the Email Distribution Option in the Basic Scheduling Tool* on page 931.

10. Optionally, you can type a message to appear in the email body to replace the default message, *Please see attachment(s).*
Note: You can also provide a custom default distribution message using the Email Distribution and Notification settings in the ReportCaster Configuration tool in the ReportCaster Console. This allows you to override the default message, Please see attachment(s), by enabling you to create a custom message specific to your organization. The message displays when creating a schedule using Email distribution. For more information, see ReportCaster Configuration on page 171.

11. Optionally, specify a value for the Packet Email or accept the default value. The Packet Email option is set to the default value configured by the Manager. For a schedule that has a task that is burst, you can decide how many emails to send to each recipient. Options include:

- **No.** Sends each attachment in a separate email.
- **Yes.** Sends one email that contains all attachments.
- **By Burst Values.** Sends one email with multiple attachments for each burst value.

12. Specify whether to send the report as a compressed (.zip) file by selecting or clearing the Add Report to Zip File check box.

You have the option of converting your distributed report into a password-protected compressed file. By default, the Add Report to Zip File check box is not selected and the report will not be compressed.

13. If the Add Report to Zip File check box is selected, enter the name of the Zip file in the Zip File Name box.

Note: Support of Unicode characters in a Zip file name and content within a Zip file on Windows 7 and Windows 2008 Server R2 requires the following hotfix from Microsoft: http://support.microsoft.com/kb/2704299/en-us. Without this hotfix, file names are corrupted after you decompress a .zip file in Windows 7 or in Windows Server 2008 R2.

14. Additionally, you can specify the minimum size (in KBs) a file must exceed before it is automatically added to a Zip file. The Zip minimum size is set to the default value configured by the administrator. To automatically zip an attachment that exceeds a certain size, set this value to the desired size.

15. Select the Notification tab to specify whether to send an email notification of the schedule job status. If you select Always or On Error, then you have to specify the Reply Address, Subject, Brief Message To, and Full Message To.

16. Next, select the Properties tab to specify the Title, Priority, whether a warning or error will display if there is no report to distribute, whether to delete the schedule if it will not run again, and whether the schedule is enabled to run. For more information, see About Properties in the Basic Scheduling Tool on page 944.
17. Select the **Recurrence** tab to specify how often to run the schedule. If you want the schedule to run on the current day, set the Start Date and Start Time to values later than the current time. For more information, see *About Recurrence in the Basic Scheduling Tool* on page 946.

18. Click **Save & Close** to save the schedule.

**Using the Printer Distribution Option in the Basic Scheduling Tool**

The report formats that support printing are DOC, PDF (when you configure ReportCaster to enable PDF to print and the printer has the appropriate driver), PS, and WP.

**Note:**

- You must be authorized to distribute to a printer in order to create a schedule that uses Printer distribution.
- Problems may occur in printed output if the distributed reports contain UTF-8 characters.
- Since a Printer schedule will not work unless the report output format is a valid print format, ReportCaster always sets the format of a schedule with distribution to a printer to a valid format. If the default configuration of PDF as a valid print format is in place, the override format is set to PDF. Otherwise, the override format is set to DOC. You can change this format on the Task tab.

**Procedure: How to Use the Printer Distribution Option**

**Note:** You can use parameters (amper variables) when specifying a value for the Printer Name field of a schedule. These parameters can be system variables, such as &YYMD, or any amper variable for which a value is returned by the Reporting Server when the scheduled procedure is executed. To use the dot file extension separator after a variable, terminate the variable with the '|' character (for example, &YYMD|.htm). Similarly, to use the ampersand character itself, follow the ampersand with the '|' character (for example, Smith&|Jones). If a value for a parameter specified in a schedule is not returned by the Reporting Server when the procedure executes, the schedule will fail with a "No report to distribute" error. If the scheduled task is burst, you can also use the '%BURST' symbol to include the burst value.

1. Right-click a report procedure (FEX), point to **Schedule**, and then select **Printer**.

   The Basic Scheduling tool appears.

2. Click the **Distribution** tab.
3. From the Type drop-down menu, select the method in which you will provide the file names to distribute to the printer. The options are:

- **Distribution List.** The report will be sent to all printers in the selected Distribution List. To select a Distribution List, click the icon next to the Distribution List field.

- **Printer.** Specify the printer using the following format.

  \[\text{queue}@\text{printserver}\]

  where:

  \[\text{queue}\]

  Is the name of the printer queue.

  \[\text{printserver}\]

  Is the host name or IP address of the printer.

  ReportCaster can differentiate between the printer queue and the printer host name or IP address due to the presence of the '@' separator. Although ReportCaster supports specifying only the host name or IP address of the printer, we recommend that you specify both the printer queue and host name or IP address when distributing ReportCaster output to a printer. The maximum length of this field is 800 characters.

4. If you select *Distribution List*, click the *Name* button, which will display the Open dialog box to allow you to select a Distribution List. If you select *Printer*, specify the printer name in the Name field.

5. Select the *Notification* tab to specify whether to send an email notification of the schedule job status. If you select *Always* or *On Error*, then you must specify the Reply Address, Subject, Brief Message To, and Full Message To.

6. Select the *Properties* tab to specify the Title, Priority, whether a warning or error will display if there is no report to distribute, whether to delete the schedule if it will not run again, and whether the schedule is enabled to run. For more information, see *About Properties in the Basic Scheduling Tool* on page 944.

7. Select the *Recurrence* tab to specify how often to run the schedule. If you want the schedule to run on the current day, set the Start Date and Start Time to values later than the current time. For more information, see *About Recurrence in the Basic Scheduling Tool* on page 946.

8. Select *Save & Close* to save your changes.

**Using the Repository Distribution Option in the Basic Scheduling Tool**

When distributing scheduled output to Repository in the Basic Scheduling tool, specify the Repository folder location to which to distribute the report output.
Note: You must be authorized to distribute to repository in order to create a schedule that uses Repository distribution.

The best practice for recurring and burst schedules is to create and specify a different folder location for each report being distributed for the same report procedure (FEX). This is important so the security access can be defined and managed at the folder level and when opting to burst the distributed report output because the burst value is assigned as the title value to each report section that is distributed. The title value is the value that displays in the Resources tree.

When the report output is distributed using the Repository distribution option, the Day, Date, and Time information is prepended to the Save Report As value specified in the schedule task information. For example, the Schedule for the Product Packaging & Price report is assigned the default Save Report As value 'Product_Packaging_Price.htm' (blanks and special characters are replaced with an underscore character).

The report output distributed to the Repository on Monday December 19, 2011 at 1:35pm EST is assigned the description: Mon, 19 Dec 2011 01:35 PM EST Product Packaging Price.

Procedure: How to Use the Repository Distribution Option

1. Right-click a report procedure (FEX), point to Schedule, and then select Repository.
   The Basic Scheduling tool displays in a new window.

2. Enter or verify task information.

3. Click the Distribution tab.
   The Distribution Server adds Day, Date, and Time to the beginning of the Save Report As value specified in the Task tab.
Verify that the folder location is the folder to which you want to distribute the report output. The folder location defaults to the same folder as the report procedure (FEX) being scheduled. Users can select a different folder to distribute the report output to by clicking the Folder Location button, which will display a dialog box of the Resources tree from which a folder location can be selected, as shown in the following image.

4. Optionally, select the Do not add a timestamp to the filename check box if you want the report output to be overwritten with each distribution.

5. Select the Notification tab to specify whether to send an email notification of the schedule job status. If you select Always or On Error, then you must specify the Reply Address, Subject, Brief Message To, and Full Message To.

6. Select the Properties tab to specify the Title, Priority, summary, whether a warning or error will display if there is no report to distribute, whether to delete the schedule if it will not run again, and whether the schedule is enabled to run.

7. Select the Recurrence tab to specify how often to run the schedule. If you want the schedule to run on the current day, set the Start Date and Start Time to values later than the current time.
8. Select Save & Close to save your changes.

Notification Options in the Basic Scheduling Tool

The Notification tab in the Basic Scheduling tool, shown in the following image, provides the options to send a notification of the schedule status to specific email recipients.

**Note:**

- Notification will not work unless a mail server is configured. If a mail server is not configured, notification will fail and an error message will be recorded in the schedule job log.

- You can use parameters (amper variables) when specifying values for the Notification fields of a schedule. These parameters can be system variables, such as &YYMD, or any amper variable for which a value is returned by the Reporting Server when the scheduled procedure is executed. To use the dot file extension separator after a variable, terminate the variable with the '|' character (for example, &YYMD|.htm). Similarly, to use the ampersand character itself, follow the ampersand with the '|' character (for example, Smith&|Jones). If a value for a parameter specified in a schedule is not returned by the Reporting Server when the procedure executes, the schedule will fail with a "No report to distribute" error.

**Note:** In the Allowed Email Addresses and Domains dialog box in the ReportCaster Console, if the Restrict user input with this list check box has been selected, user input of email addresses is restricted to a list of allowed email domains and addresses.

The notification options are:

- **Never.** ReportCaster will not send a notification of the schedule status under any circumstances. This is the default value.
Always. The specified users are always notified when the schedule runs.

On Error. The specified users are notified when errors are encountered while running the schedule. Information Builders recommends the use of the On Error notification option.

Setting On Error and Always Notification in the Basic Scheduling Tool

When you select the On Error or Always notification option, additional options become available.

The On Error and Always notification options are:

- Reply Address. Type the email address of the sender. If report recipients reply to the report sender, then their messages are sent to this address. If your email system is unable to deliver a report, then the undeliverable report message is also returned to this address.

  Note:

  - If you are authenticating to the mail server with your user ID and password, then the reply address will be the email address associated with that user ID.

  - If the mail server is configured with authentication and the Reply Address is configured in the ReportCaster Configuration tool, then the Reply Address field in the scheduling tools will be disabled. If a Reply Address is not configured, then the field is enabled to allow a Reply Address to be sent to the email server, however the actual Reply Address of the delivered email will be that of the authenticating account.

- Subject. Type the text you want to display in the subject line of the email notification. There is a limit of 255 alphanumeric characters. By default, this field contains the report name and date and time stamp.
Brief Message To. Type the email address where you want a full notification sent. There is no syntax error checking for this field.

Tip: Use the Brief Message To option when you are sending notification to devices that have limited memory, such as pagers and cell phones. If you want to notify multiple recipients, you can use group mail lists defined on your mail server provided that you append an at sign (@) followed by a valid domain.

Full Message To. Type the email address to which you want a full notification sent. There is no syntax error checking for this field.

About Properties in the Basic Scheduling Tool

When you access the Basic Scheduling tool, the Title and Path Properties options are predefined for the selected report procedure (FEX). The following image displays the Properties tab in the Basic Scheduling tool.

The options within the Properties tab are:

Title. This allows you to provide a brief description of the purpose of the schedule. It is pre-populated with the title of the report procedure being scheduled when creating schedules with the Basic Scheduling tool. You can edit the title while creating the schedule or after saving the schedule from within the Schedule tools. You can also edit the title from the Properties option from the Resources tree after saving the schedule.
The title of the schedule is the default name assigned when saving the schedule. If the name value already exists in the selected tree folder, a message is displayed informing you that the name already exists. You can change the Title field in the Save dialog box, which when saved, will also update the Title field within the schedule information.

- **Path.** This is the Repository path of the report procedure (FEX) you selected to schedule.

- **Summary.** This allows you to insert a detailed description for the schedule. This is an optional field.

- **Job Priority Level.** This specifies the priority the scheduled job will be given when processed by the Distribution Server. The default Job Priority Level is set to Normal - 3. However, you can use the drop-down list to set the priority level, as shown in the following image.

  ![Job Priority Level Drop-Down List](image)

- **No Report to Distribute.** This option is set to the default value configured by the Manager. To trigger error notification if no report is generated, set this value to *Error*. If you do not want to trigger notification when no report is generated, set this value to *Warning*.

- **Delete this schedule if it is not scheduled to run again.** This check box allows you to specify that the schedule should be deleted after the scheduled job processing is completed if the schedule is not scheduled to run again. Selecting this option for schedules you will not utilize again is recommended as it will improve overall performance within the Resources tree listing folder contents and within the ReportCaster Explorer tool when listing schedules.

- **Enabled (Scheduled job runs at specified time).** This check box is selected by default to specify that the schedule should be evaluated by the Distribution Server when polling for scheduled jobs to run. If you do not want to distribute the schedule based on its NEXTRUNTIME value, clear this check box.
About Recurrence in the Basic Scheduling Tool

When you access the Basic Scheduling tool, the Recurrence tab options allow you to define how often to run the schedule. The following image displays the Recurrence tab in the Basic Scheduling tool.

Options that users must determine include frequency of distribution, start and end times, and Advanced interval settings. Select one of the following frequency of distribution settings:

- Run Once
- Minutes
- Hourly
- Daily
- Weekly
- Monthly
- Yearly
- Custom
You can assign start and end times by using the drop-down lists. When you click on the down arrow, a calendar will display that enables an authorized user to set the date for schedule distribution. Use the up and down arrows to set a specific time for schedule distribution. Alternatively, you can enter the time manually.

If the user has the privilege to set Advanced settings, check the *Repeat schedule every* check box to enable Advanced interval setting options. Set how often you want to repeat schedule distribution, when you want to stop distributing the schedule (Until Time), and the duration to distribute the schedule (Last For). Enter this information manually or use the up and down arrows to set parameters.

**The Run Once Interval**

The Run Once option sets the job to execute immediately. This is the default value. You can modify the date or time if you do not want the schedule to run immediately. You can specify the date and time you want the schedule to run using the Start Schedule options, as shown in the following image.

To select a date, choose a date from the drop-down date calendar. To select a time, select either the hour or minutes, and use the up and down arrows to increase or decrease the value. Alternatively, you can enter the time manually.
The Minutes Interval

The Minute(s) option sets the schedule to run every \( n \) minutes.

In the Every minute(s) field, type or select the minutes interval (1 to 59), check the days of the week on which you want to run the schedule, and select the Start and End date and time to define the time period in which the schedule will run. For example, the following image shows a schedule that will run every 30 minutes on Mondays beginning at noon May 16, 2012 and ending 6:00 PM October 30, 2012.

Tip: Selecting this option may affect system performance if you choose to run the schedule every 5 minutes or less. We recommend specifying a minimum of 30 minutes. The minute interval option is primarily for alert schedules.
The Hourly Interval

The Hourly option sets the schedule to run every $n$ hours.

In the Every hour(s) field, type or select the hours interval (1 to 24), check the days of the week on which you want to run the schedule, and select the Start and End date and time to define the time period in which the schedule will run. For example, the schedule shown in the following image will run every three hours on Mondays and Fridays beginning at noon May 16, 2012 and ending 6:00 PM October 30, 2012.
The Daily Interval

The Daily option in the Settings list sets the schedule to run every \( n \) days. In the Every day(s) field, type or select the days interval to run the schedule and select Start and End date and time to define the period in which the schedule will run. For example, the schedule shown in the following image will run every five days beginning at noon May 16, 2012 and ending 6:00 PM October 30, 2012.

You can also set a secondary run interval. For information about this setting, see Advanced Settings on page 956.
The Weekly Interval

The Weekly option in the Settings list sets the schedule to run every \( n \) weeks.

In the Every week(s) field, type or select the weekly interval to run the schedule, check the days of the week on which you want to run the schedule, and select the Start and End date and time to define the time period in which the schedule will run. The following image shows a schedule that will run every two weeks on both Monday and Friday beginning at noon May 16, 2012 and ending at 6:00pm on October 30, 2012.

Note: When selecting the Weekly interval, set the Start to the date of the first day (current or future) of the week you want the schedule to run. If you select the current date, then you must make sure that the Start time is later than the current time when you save the schedule. If the Start time is less than or equal to the current time, the calculation for the next run time results in the schedule not running on the current date.

You can also set a secondary run interval. For more information about this settings, see Advanced Settings on page 956.
The Monthly Interval

The Monthly option sets the schedule to run every $n$ months. You can then refine the monthly interval with one of the following options. Note that these options are mutually exclusive.

- Every first, second, third, fourth, or last $n$ day of the week (where $n$ is Monday, Tuesday, Wednesday, Thursday, Friday, Saturday, or Sunday) every $n$ months.

- Specific days every $n$ months.

Additionally, select the Start and End date and time to define the time period in which the schedule will run. The following image shows a schedule set to run on the first Monday of every month beginning at noon May 16, 2012 and ending 6:00 PM October 30, 2012.
The following image shows a schedule set to run on the 2nd, 9th, 16th, 23rd, and 30th of every month, regardless of the day of the week on which those dates fall.

You can also select the Last Day of the Month option at the end of the calendar to run the schedule on the last day of the month.

**Note:** When selecting the Month(s) interval, set the Start date to the date of the first day (current or future) of the month you want the schedule to run. If you select the current date, then you must make sure that the Start time is later than the current time when you save the schedule. If the Start time is less than or equal to the current time, the calculation for the next run time results in the schedule not running on the current date.

You can also set a secondary run interval. For information about this setting, see Advanced Settings on page 956.
The Yearly Interval

The Yearly option sets the schedule to run every \( n \) years during a specific time period. The following image shows a schedule set to run every two years beginning at noon May 16, 2012 and ending 6:00 PM October 30, 2022.

You can also set a secondary run interval. For information about this setting, see Advanced Settings on page 956.

The Custom Interval

The Custom option allows you to select a set of dates that do not follow a specific pattern. For example, if you want to run a quarterly report on a different day of each quarter, then you can use the Custom run interval to set the schedule to run on dates, such as March 3 (Saturday), June 4 (Monday), September 7 (Friday), and December 2 (Sunday).
The following image shows the Custom Run Interval options, which includes Start (initially set to the current date and time) and the End date and time options, the Custom calendar, and the Custom Date List node that appears in the right panel.
Define the time period in which the schedule will run by selecting the Start date and time and the End date and time. Select the specific days on which to run the schedule by clicking the day in the calendar. (Use the forward and back buttons at the top of the calendar to move through the months and years.) As you select a date, it appears in the Custom Date List. If it does not already exist, a folder for the year and month of the date you select is automatically created under the Custom Date List node. The following image shows an example of a selection of Custom dates in the calendar and the Custom Date List.

To remove a date from the list, click the date in the calendar. The date is no longer highlighted in the calendar and will not appear in the Custom Date List. You can optionally use the left single arrow to remove a date from the list. The double arrow button removes all defined lists.

You can also set secondary run interval. For information about this setting, see Advanced Settings on page 956.

**Advanced Settings**

The Advanced settings option enables you to create a secondary run interval within the day the schedule runs. You can apply the secondary run interval every \( n \) minutes or hours for a specified number of hours and minutes or until a specified time. This option is available for schedules that run every day(s), week(s), month(s), or year(s).

**Note:** When a schedule is saved, the hours setting is converted to minutes. When a schedule is edited, this value appears as minutes.
The secondary run interval will not be validated when the schedule is created. Instead, validation is performed every time the next run time of the schedule is calculated when running within the secondary run interval. The secondary run interval cannot exceed the next run time for the primary run interval. For example, a daily schedule cannot have a secondary run interval greater than Every 1 day(s). If you schedule a secondary run interval to run after the next primary run interval of the schedule, the secondary run interval is stopped and an error message appears. This error message is also written to the log file.

The Advanced settings section allows you to specify repeat options, as well as time intervals. The following image shows an example of set secondary run interval options.

The Apply secondary run interval options are:

- **Repeat schedule every.** Applies the secondary run interval every \( n \) minutes or hours (in this example, every 10 minutes) within the day the schedule runs.

- **Until Time.** The time up until which the secondary run interval will be applied. In this example, the schedule will rerun every 10 minutes until 4:10 PM when the Until Time option is selected.

- **Last For.** The duration, specified in hours and minutes, during which the secondary run interval will be applied. This option and the Until Time option are mutually exclusive.

**Note:** When a schedule is updated, the next run time is recalculated based only on the primary run interval. This means that if a schedule that includes a secondary run interval is updated before the secondary schedule is able to run, then the secondary run interval is ignored and the NEXTRUNTIME is calculated based on the primary interval.

For example, a schedule exists that is set to run daily at 2:00 PM with a secondary run interval of every 10 minutes from 2:00 PM to 3:00 PM. When the schedule runs at 2:00 PM, the NEXTRUNTIME resets to run at 2:10, which honors the secondary run interval. If this schedule is updated at 2:03 PM, the NEXTRUNTIME is recalculated to be 2:00 PM the next day, rather than 2:10 PM on the current day.
Using Amper Variables as Parameter Values

When a parameterized report is scheduled, you can set the value of a parameter to a variable, rather than a literal value. This ability reduces the need for a schedule to be updated before it is run. For example, instead of editing a schedule daily in order to display up-to-date information, a report can be scheduled to always display the date of the day that it is running. This is done by setting the value of the parameter as &YYMD. In the Task Parameters dialog box, there is a check box labeled *The value contains a system variable*, as shown in the following image.

This check box is cleared by default. When this check box is selected, a string beginning with the ampersand character is processed as a variable. When this check box is cleared, the ampersand character is then processed as a literal value. This feature works with both system variables, and global variables that have been set in the Reporting Server global profile edasprof.prf.

To use the &YYMD variable as a parameter value, create or locate a FEX file that contains a date parameter. This date parameter can then be used with the &YYMD variable. The following image shows a Task Parameters dialog box that displays a date parameter named Sale_Date.
The following image is an example of a distributed report that uses the &YYMD amper variable as a parameter value. The Widgets&More company report distributed on March 27th, 2018 shows the number of items sold on March 27th, 2018, 2017, and 2016.

![Report Example](image)

**Maintaining Schedules**

Maintaining a schedule allows you to edit schedule properties or delete the schedule when it is no longer needed. If a schedule contains properties that you want to use in a new schedule, the duplicate or copy option creates a template with those properties for the new schedule.

You can also check the status of a schedule and run a log report to obtain detailed information about the schedule.

**About Maintaining a Schedule in the Basic Scheduling Tool**

As a user with the ability to access the Basic Scheduling tool, you can perform various maintenance functions on the schedules you are authorized to access.

If you right-click a schedule, the following options are available.

- **Edit**
  - Allows you to open and edit an existing schedule.

- **Run**
  - Runs the schedule.

- **View Log**
  - Allows you to view a log report for one or more selected schedules.

- **Enable and Disable**
  - You can enable or disable schedules from the Home page. This option is also found in the Properties tab of the Basic Scheduling tool.
Duplicate

Creates a new schedule with the same properties in the same folder. The new schedule is disabled automatically, because it is a duplicate of an existing schedule.

Cut

Allows you to move the schedule from the original folder to a target folder using the Paste operation.

Copy

Allows you to create a new schedule by copying an existing schedule.

Create Shortcut

Allows you to create a shortcut to the schedule.

Delete

Deletes the existing schedule.

Change Title

Allows you to rename the schedule.

Publish and Unpublish

An owner of a schedule can make a schedule available to other members of the top-level folder in which the schedule resides. The schedule owner remains the execution ID. The following table describes the shortcut menu options for published schedules permitted to the different groups associated with a top-level folder.

Note: The default setting is Unpublish.

Hide and Show

Once an owner publishes a schedule, they can elect to Hide the schedule from groups not authorized to create content in the folder. To hide or show a schedule, right-click on a schedule and select the Hide or Show option.

Note: The default setting is Show.

Share

Allows you to share the selected schedule. You can subsequently Unshare the schedule via the same menu.

Share with

Allows you to specify the groups and users with whom you want to share the selected schedule.
**Unshare**

Allows you to remove sharing on a shared schedule. This option only displays if you have previously shared the schedule.

**Security**

Allows you to view and modify the ownership of the schedule. Options include: Rules, Rules on this Resource, and Effective Policy.

**Properties**

Allows you to view properties of the schedule, as well as modify title and summary information. You can also change the name of a schedule using the Properties dialog box. In addition, you can access Security features, including Owner and Sharing.

<table>
<thead>
<tr>
<th></th>
<th>Basic</th>
<th>Advanced</th>
<th>Developer</th>
<th>Group Administrator</th>
<th>Manager</th>
</tr>
</thead>
<tbody>
<tr>
<td>Run</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>View Log</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Edit</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Enable/Disable</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Publish/Unpublish</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Security</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Hide/Show</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Copy/Duplicate</td>
<td>✗</td>
<td>✓</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Properties</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
<td>✓</td>
</tr>
<tr>
<td>Change Title</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
</tr>
<tr>
<td>Delete</td>
<td>✗</td>
<td>✗</td>
<td>✓</td>
<td>✗</td>
<td>✓</td>
</tr>
</tbody>
</table>
Editing a Schedule in the Basic Scheduling Tool

From the Home page, you can edit the schedules you are authorized to access.

Procedure: How to Edit a Schedule in the Basic Scheduling Tool

1. Right-click the schedule you want to edit and select Edit.
2. Make the required changes to the schedule. For details on the Basic Scheduling tool options, see Creating a Schedule in the Basic Scheduling Tool on page 904.
3. Click Save & Close.

Reference: Considerations When Editing a Schedule in the Basic Scheduling Tool

- When you open a schedule that uses unavailable options, such as a distribution method, information is displayed that describes the change or changes that you must make for the schedule to use available options. Changes to the schedule cannot be saved until the schedule uses available options.
- If you selected Run once for the run interval, the schedule runs immediately unless you change the Start Time to a time later than the current time. All other run intervals run at the next primary run-time interval of the schedule.
- You must save your changes in order to be able to run from within the scheduling tool.
- If you want your selected schedule or schedules to run immediately, click Run.
- When editing an existing schedule, if the Override the Format Specified in the Procedure check box was selected, the list of formats will display. If you now clear the Override the Format Specified in the Procedure check box, the list of formats does not display. Conversely, if the Override the Format Specified in the Procedure check box was not selected, the list of formats will not display. If you now select the Override the Format Specified in the Procedure check box, the list of formats displays.

Enabling or Disabling Schedules Using The Right-Click Menu Option

Disabling a schedule will prevent it from executing immediate and scheduled tasks. You can enable and disable schedules from the Home page. The Enable setting can also be accessed in the Properties tab of the Basic Scheduling tool.

Note: The enable and disable options display when you are authorized to use these options.

From the Home page, in the content area, right-click an enabled schedule and select Disable. If the schedule is already disabled, the menu option appears as Enabled.
Copying a Schedule in the Basic Scheduling Tool

For your convenience, you can copy an existing schedule for use as a template to create a new schedule. The copied schedule is created disabled because it is a duplicate schedule.

**Procedure:** How to Copy a Schedule in the Basic Scheduling Tool

**Note:** The cut, copy, and paste options display when you are authorized to use these options.

1. From the Resources tree, choose a domain or folder that contains a schedule.
2. In the content area, right-click the schedule you want to copy and select *Copy*.
3. Right-click the folder you wish to copy the schedule into and select *Paste*.

Deleting a Schedule in the Basic Scheduling Tool

From the Home page, you can delete schedules using the following procedure.

**Procedure:** How to Delete a Schedule in the Basic Scheduling Tool

Note that the Delete option displays when you are authorized to delete the selected schedule.

1. In the content area, right-click the schedule you want to delete and select *Delete*.
   **Note:** To select multiple schedules, use the Shift key and Ctrl key as in a standard Windows interface. A message appears asking to confirm if you want to delete the selected schedules.
2. Click *OK* to delete the schedule or schedules.

Sharing Schedules

The owner of a schedule that is located in a My Content folder can share that schedule with other users.

**Procedure:** How to Share Schedules

You can share one or more schedules by performing the following steps.

1. In the Resources tree, choose a domain or folder that contains a schedule.
2. Select one or more schedules that you want to share.
3. Right-click the selected schedule or schedules and select *Share*.
   If you are a group administrator or user with the share schedule privilege, the schedule or schedules are shared. The Schedule icon changes to denote that it is shared.
**Procedure:**  **How to Share Schedules With Specific Groups or Users**

From the Home page, you can specify the groups or users with whom you want to share the selected schedule or schedules.

1. On the Home page, in the content area, select one or more schedules that you want to share.
2. Right-click the selected schedule or schedules and select *Share with*.

The Share dialog box displays, as shown in the following image.

3. Use the left and right arrow buttons to select which Groups will have access to Schedules.
4. Use the left and right arrow buttons to select which Users will have access to Schedules.
5. Click OK.

**Publishing Schedules**

A published schedule is visible to all users with access to the folder in which it resides. The shortcut menu options that appear on the schedule depend upon the privileges of the user that is signed in. For example, a user with the Run privilege is able to run the published schedule. When a published schedule runs, it runs as the creator of the schedule and not as the signed in user that initiated the run.
Note: A published schedule runs as the creator of the schedule. A user that is allowed to edit a published schedule may make a change to the schedule that the creator of the schedule is not permitted to make. In this case, the schedule will fail at run time. For example, a user may change the Distribution List used in the schedule to a private Distribution List that is not available to the creator of the schedule. When the changed schedule runs, it will fail due to inability of the creator to retrieve the Distribution List from the Repository.

Procedure: How to Publish a Schedule

From the Home page, you can publish a schedule by performing the following steps.

1. On the Home page, in the content area, select a schedule that you want to publish.
2. Right-click the selected schedule and select Publish.

The schedule is published.

Tracking Schedules

Information about a schedule, such as date, time, execution status, and recipients of a distributed job, can be accessed by running a log report and checking the job status in the ReportCaster Console Job Status tool.

Log Reports

Log reports are stylized HTML format and appear in a separate browser window. You can search, print, or save the log report. The log report displays information according to your specifications in a separate browser window. One log record is produced for each scheduled job run in the specified time frame.

Tracking Schedules in the Console

Information about a schedule, such as date, time, execution status, and recipients of a distributed job, can be accessed by running a log report and checking the job status. For more information, see Using the ReportCaster Console on page 162.

Using Schedule Logs

Log reports enable you to view information about a distributed job, such as whether or not the job executed successfully, when the scheduled output was distributed, in what format the distributed output was sent, and the method of distribution. Log reports are stylized HTML format and display in a separate browser window. You can search, print, or save the log report. Log reports can be accessed within the scheduling tool when editing a schedule or by right-clicking a schedule from the Home page.
The log file accumulates information. You should periodically purge log records to manage the number of log reports stored in the Repository, as well as the performance of log report information that is displayed.

The list in the right panel provides basic information about the job execution, including the job ID, the time the job started running, the amount of time it took to complete the execution of the job, and the general status of the job. To view a full log report for a job, double-click the job in the job list.

**Checking the Job Status**

Another resource for tracking schedules is the schedule job status. The schedule status provides a list of scheduled jobs that are in the Distribution Server queue. Status information includes the schedule ID, the time it started running, and the status of the job.

To access the schedule job status information, see the Job Status tab in the ReportCaster Console. For more information, see *Using the ReportCaster Console* on page 162.

**Procedure: How to View a Log Report From the Home Page**

1. Right-click the schedule from the content area and select *View Log*. 
The Schedule Log Options dialog box appears, as shown in the following image.

2. Specify which log report you would like to view by selecting Last Executed, All, or Date.

If you select Date, you will have the option to specify your search using start date and time and end date and time parameters.

3. Click OK.
The log reports that match your search criteria appear, as shown in the following image.

The log report first lists the job description for the record, which is the unique description identifier that you specified when you created the schedule. Underneath the Job Description, the left column of the log report includes the following information:

- **User.** ReportCaster user ID, indicating the owner of the schedule.
- **Procedure.** Unique key generated by ReportCaster that identifies a specific execution of a scheduled job.
- **Schedule ID.** Unique key generated by ReportCaster that was assigned to the job when it was scheduled.
- **Start Time.** Date and time the job started running.
- **End Time.** Date and time the job finished running.

In the second column, the log report specifies messages consisting of the following:

- **General information,** such as the method of distribution for a particular job (for example, email distribution).
- **Processing information,** indicating that the request started, distribution was successful, and the request was completed. Processing information also includes reasons why a request failed, such as the unavailability of a data source.

**Procedure:** How to View a Log Report in the Scheduling Tool

1. From the Resources tree, choose a domain or folder that contains a schedule.
2. Right-click the schedule for which you want to see the logs, and click *Edit.*
The Basic Scheduling tool opens.

3. From the Basic Scheduling tool, click the Log Reports tab.

The Log Reports panel appears, as shown in the following image.

4. Observe the Number of Jobs that have run.

5. Click the Job Number to view the log report information for that job in the panel below the job listing.

**Reference:** Considerations When Viewing a Log Report

When viewing a log report, be aware of the following considerations.

**Task and Report Names**

The ReportCaster Log references WebFOCUS folders and procedures (FEXs) by their path and file names and not their descriptions.
**Email Addresses**

ReportCaster cannot validate email addresses since email validation is performed by the mail server. The log report will include any email addresses validated by the mail server and returned to ReportCaster.

**Burst Reports**

- If a valid burst value is omitted in a Distribution List, ReportCaster treats the blank value as if it is a valid burst value and no entries indicating a blank burst value appear in the log file. This will significantly reduce the size of the log file, particularly when the database contains many values for the primary field and only a small subset of those values are burst.

- If a burst value is specified in a Distribution List, and it is not found in the database, the following message appears in the log file:

  Burst Value: value is not in the database.

- When a report procedure (FEX) is successfully burst, the log file will include the following message for each burst value:

  FILE filename SUCCESSFULLY DISTRIBUTED TO destination FOR burst value.

**Unavailable Options**

- When schedules with unavailable task types or distribution methods are not permitted to run, an error notification is triggered. The error is shown in red text within the job process log report. The log report, as well as the full and brief notifications, contains information on the unavailable options that the owner of the schedule must change.

- When schedules with unavailable task types or distribution methods are permitted to run, normal job execution occurs and a message appears in the log report indicating that existing schedules using the unavailable task types or distribution methods are able to run. For more information on configuring available task types and distribution methods, see Configuration Tab Folders on page 173.

**Using Favorites**

You can customize the view of content on your Home page using the Favorites feature. When you save content as a favorite, it automatically appears in the Favorites view of the sidebar. Here, you can interact with your content and view its properties.

**Procedure: How to Add Content to Favorites**

1. On the Home page, right-click a report, chart, document, visualization, shortcut, or URL, and then click Add to Favorites.
2. On the sidebar, click *Favorites*.

The item now appears in the Favorites view, as shown in the following image.

![Image of Favorites view](image)

If you right-click the item, a shortcut menu of options opens. Here, you can do the following:

- Click *Run* or select a different way to run the item by clicking *Run*....
- Point to *Schedule*, and choose a scheduling option for the item.
- Click *Edit* to edit the item in the appropriate tool.
- Click *Remove favorite* to remove the item from the Favorites view.
- Click *Properties* to open the Properties panel, and edit the properties of the item.

**Procedure:** How to Remove a Favorite

1. In the Favorites view, right-click an item.
2. Click *Remove favorite*.

The item is removed from the Favorites view.

**Publishing Content**

When you create a new folder, report, or chart, it is private. Only you can see it, run it, edit it, and so on. A private item is illustrated with a gray icon.

When you are ready to allow others to access the item, you can publish it. This turns on any rules set on the item itself or inherited from a higher level. The icon of the item appears in full color to indicate the item is live.
Managers and developers have the ability to publish items. Once the item is published, it becomes visible to all users.

Sharing Content

Each domain in the repository comes with the private My Content folder. Whenever you create content inside the My Content folder, this content remains private and only visible to you, unless you share it with other users and groups. You can share content in one of two ways:

- **Share with all users.** This method makes the content available to all users that have access to the domain.

- **Share with specific users and groups.** This method allows you to choose which users and groups get access to your private content.

In both scenarios, you can easily revoke access to your content by unsharing it.

**Procedure: How to Share Content with All Users**

1. In the Resources tree, navigate to a domain of your choice and open the My Content folder.

2. In the My Content folder, right-click the item that you want to share, and then click Share.

   The Share icon now displays next the default icon, as shown in the following image.

   ![Share icon](image)

   The item is now shared with all users that have access to this domain.

3. To unshare the item, right-click it, and then click Unshare.

**Procedure: How to Share Content with Specific Users and Groups**

1. In the Resources tree, navigate to a domain of your choice and open the My Content folder.
2. In the My Content folder, right-click the item that you want to share, and then click Share with.

The Share with other dialog box opens.

3. In the Search field type the name of the user or group with which you want to share this item.

4. Click the correct entity from the drop down list, as shown in the following image.

The name now displays below the Search field. The item is shared.

5. Optionally, add more users or groups.

You can narrow your search by clicking an arrow and selecting Users or Groups, as shown in the following image.
6. Once you are happy with your choices, click OK.

The icon now indicates that the item is shared. You can unshare it at any time or go back to the Share with others dialog box and edit your choices.

**Using Visualizations at Run Time**

In InfoAssist, you can run visualizations that are either saved or run dynamically. In this case, the visualization opens in a separate browser window, as shown in the following image.
In the Business User Edition portal, all users can run stored visualizations that are available to them. In this case, the visualization opens in a new page, as shown in the following image.

![Visualization Image]

**Working With Filters at Run Time**

If you have added a filter to your visualization, you can use the Prompts panel to control the display of information. When you run your visualization, the Prompts panel appears. This enables you to select additional values by which to filter the visualization.

**Note:** The filters that you apply at run time can be removed using the Remove Filter option in the Run-Time toolbar. This does not apply to filters that were added prior to running the visualization.
The following image shows an example of a visualization with an open Prompts panel.

Note: If you select (or lasso) components of your visualization, the Prompts panel does not automatically update to reflect your selections.

Procedure: How to Filter Data With Tooltips at Run Time
1. Run a visualization from one of the following locations:
   - From the Application Main Menu or Quick Access Toolbar in InfoAssist.
2. Click, point to, or lasso data in your visualization.
A tooltip opens, as shown in the following image.

The tooltip includes the following options:

- **Filter Chart.** Filters the visualization by the data values that you have selected.
- **Exclude from Chart.** Excludes the selected data values from the visualization.
- **Remove Filter.** Removes the filter and returns the visualization to its original state.

**Note:** The same run-time options are available when you run your visualization on a mobile device.

**Viewing Data at Run Time**

When viewing data at run time, you can access the data behind each visual in your visualization. Using the Show Data option, which is available from the Run-Time toolbar, you can view your data in summary format. This grid display includes totals for the categories in your visual, based on the data fields that you selected. All InfoAssist users can use this option with the visualizations that are available to them.
Procedure: How to View Data at Run Time

1. Run a visual or visualization from one of the following locations:
   - From the Application Main Menu or Quick Access Toolbar in InfoAssist.

2. In the bottom-right corner of the visual cell, click the arrow.
   The Run-Time toolbar opens.

3. Click the Show Data button.
   The visual changes to the grid view, displaying the underlying data for the selected visual.
   Click the Show Data button again to return to your visual.

   Note: The same run-time options are available when you run your visualization on a mobile device.

Using the Run-Time Toolbar Options

You can access the Run-Time toolbar by clicking the arrow button, which is located in the bottom-right corner of each visual cell at run time. The Run-Time toolbar is shown in the following image.

The Run-Time toolbar options are described in the following table:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Show Data icon]</td>
<td>Show Data</td>
<td>Alternates between the visual and the grid view, which shows the underlying data. To return to the visual view, click the Show Data button again.</td>
</tr>
<tr>
<td>![Reset to Default icon]</td>
<td>Reset to Default</td>
<td>Resets all changes and returns the visualization to its original state.</td>
</tr>
<tr>
<td>![Remove Filter icon]</td>
<td>Remove Filter</td>
<td>Removes the filter and returns the visualization to its original state. This option is only available if a filter is applied at run time.</td>
</tr>
</tbody>
</table>
Using the Deferred Report Status Interface

The following topics provide an overview of the Deferred Report Status Interface including a detailed description of its appearance and functions. Specific procedures guide you through viewing, saving and deleting reports, deleting deferred reports that are being processed but are not yet complete, and reviewing parameters for reports containing amper variables.

The Deferred Report Status Interface enables you to obtain information about deferred reports. From this Interface, you can perform the following actions on a deferred report:

- Sort deferred report output by date, description, domain, and server ID.
- View deferred report output.
- Delete a deferred report from the Reporting Server.
- Save the report output as private content.
- Review or change parameters associated with a deferred report.
- View the number of days remaining prior to expiration (deletion) on the server.
- Terminate a deferred request that is in the deferred report queue.
- Terminate a deferred report that is running.
- Delete all expired, unknown, completed, running, and queued tickets.

You can access the Deferred Status Report Interface from the portal by clicking Tools, in the Menu bar, and then clicking Deferred Status.

Running a Report as Deferred

When you run a report as deferred, the report title is assigned as the deferred report description by default. If the Custom Deferred Report Description feature is enabled, you are prompted to edit a report description. This feature allows you to distinguish between the outputs of the same report that you ran at different times.

You can view information about a deferred report in the Deferred Report Status Interface window. The window indicates the time the report was submitted and whether the report was completed, and also provides Delete, View, Save, as well as Run or Parameters options.
Procedure: How to Run a Report as Deferred

1. From the Resources tree, choose a Domain or folder that contains a schedule.

2. Right-click a report that you want to run as deferred, point to Run and then click Run deferred.

   If the Custom Deferred Report Description feature is enabled, the Deferred Report Description dialog box opens, as shown in the following image. If you run a parameterized report as deferred, the Deferred Report Description field is displayed in the Parameters prompt window.

   ![Deferred Report Description](image)

   **Note:** The Custom Deferred Report Description feature is disabled by default. To enable this feature, in the Administration Console, click Configuration. Under Application Settings, click Deferred Reporting, and then set the IBI_Deferred_Custom_Description setting to True.

3. Optionally, type a new or updated description and click OK.

   The Deferred Report Notification dialog box appears, reflecting the updated description, as shown in the following image.

   ![Deferred Report Notification](image)

4. To open the Deferred Report Status window directly from the dialog box, click the Deferred Report Status link.

5. To review the deferred report later, close the dialog box. On the menu bar, click Tools, then click Deferred Status.
Deferred Report
Status Interface Features

The Deferred Report Status Interface includes:

- A banner at the top of the window that lists the date and time of the request.
- A gray toolbar below the banner that contains Refresh and Help options, a Sort By drop-down list to select sort values, a sort order button to toggle between ascending and descending order, and a Delete drop-down list. The Delete drop-down list has options to delete All, All Completed, All Running, All Queued, All Expired, or All Unknown reports, depending on which report status types exist in the Interface.
- The status of each report within the Interface.

Sort Controls for the Deferred Report Status Interface

The sorting feature pertains to the entire report. When the default sort value (Date/Time Submitted) is changed, the new primary sort becomes your choice, but the secondary sort is always fixed as Date/Time Submitted. To re-sort the list, select the Sort by option:

- Date (default)
- Description
- Domain

You can optionally change the sort order (ascending or descending) by clicking the Reverse Sort Order button, which toggles between A to Z and Z to A.

**Note:** When the sort value is Date, the sort order option A to Z means from new to old and not alphabetical from A to Z.

To see the results of the new sort options, click Refresh.

Deferred Report Status

The status of deferred requests are organized under the following sections within the Interface:

- **Completed.** Indicates that the Deferred Receipt request has finished processing.
- **Running.** Indicates that the Deferred Receipt request is processing.
- **Queued.** Indicates that the Deferred Receipt request is queued for processing.
Unknown. Indicates that the Deferred Receipt request cannot be identified. This can occur when the file containing the deferred report results cannot be found. For more information, see Deferred Report Expiration Setting on page 984.

The following image shows a sample Deferred Report Status window with completed reports.

<table>
<thead>
<tr>
<th>Date/Time Submitted</th>
<th>Domains</th>
<th>Description</th>
<th>Expires In</th>
<th>Delete</th>
<th>View</th>
<th>Save</th>
<th>Run</th>
</tr>
</thead>
<tbody>
<tr>
<td>4/11/2016, 6:22:56 PM</td>
<td>Retail Samples</td>
<td>Margin by Product Category</td>
<td>29 days</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4/11/2016, 6:22:38 PM</td>
<td>Retail Samples</td>
<td>Regional Analysis</td>
<td>29 days</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4/11/2016, 6:22:21 PM</td>
<td>Retail Samples</td>
<td>Choropleth Map - Sales by State</td>
<td>29 days</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4/11/2016, 6:21:57 PM</td>
<td>Retail Samples</td>
<td>Bar - Highest Margin Products</td>
<td>29 days</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Column headings provide information about the published content including the date and time the published content was submitted, the domain of origin, a description of the report (the report name), an expiration indicator, and an Options heading for options within the Deferred Report Status Interface.

When you select the Deferred Status option, the status for all the deferred requests submitted by your Managed Reporting user ID is retrieved. Depending on how Managed Reporting is configured, deferred status may be coming from multiple WebFOCUS Reporting Servers on various platforms. If credentials are required for the connections, you are prompted by the WebFOCUS Dynamic Server System Signon feature. You can view the status of all the deferred requests submitted by your Managed Reporting user ID, but can only delete, view, save, stop, or review parameters for deferred requests submitted with an identical WebFOCUS Reporting Server user ID.

The options available in the Deferred Report Status Interface are based upon the status of the report request and security validation. You can perform various functions by clicking the buttons under the following options.

Delete. Available for all report status types. The Delete option deletes the deferred request according to the report status, as follows:

- Queued. When a deferred request is listed in the Queued tab, the Delete option removes the deferred report from the Reporting Server and deletes the deferred request ticket from the WebFOCUS Repository.

- Unknown. When a deferred request is listed in the Unknown tab, the Delete option deletes the deferred request ticket from the WebFOCUS Repository.
- **Completed.** When a deferred request is listed in the Completed tab, the Delete option removes the report from the window, deletes the deferred report results from the Reporting Server, and deletes the deferred request ticket from the WebFOCUS Repository.

- **Running.** When a deferred request is listed in the Running tab, the Delete option deletes the deferred request ticket from the WebFOCUS Repository and cancels the job on the Reporting Server.

  **Note:** The Delete drop-down list in the toolbar at the top of the Interface provides options to delete All, All Completed, All Running, All Queued, All Expired, or All Unknown reports, depending on which report status types exist in the Interface.

- **View.** Available when the report status is Completed.

  The View option displays the completed report in a new browser session, or the report format may result in the opening of a Windows dialog box that prompts you to save the report to disk or open the report within an application (such as Microsoft® Excel®, Microsoft® Word, or Adobe® Acrobat®).

  **Note:** Auto Drill functionality is not available for reports that are run deferred because Auto Drill uses live data, in an interactive session, for data drilling. Data values and totals may not be the same if the data has changed since the last deferred execution. Mixing past data with current data could impact the data analysis.

- **Save.** Available when the report status is Completed.

  The Save option allows you to save Deferred Receipt reports to the WebFOCUS Repository, if you are authorized to save deferred reports and to create private content. You can save the report output to your My Content folder or a folder you are authorized to create content in and write to. When your deferred report is saved to the WebFOCUS Repository, it is removed from the Deferred Report Status Interface.

  **Note:** This option appears for users authorized to save deferred reports.

- **Run.** Available for reports without parameters when the report status is completed or queued. The Run option runs the report deferred again.

  **Note:** Auto Drill functionality is not available for reports that are run deferred because Auto Drill uses live data, in an interactive session, for data drilling. Data values and totals may not be the same if the data has changed since the last deferred execution. Mixing past data with current data could impact the data analysis.
Parameters. Available for reports with parameters when the report status is completed or queued. The Parameters option allows you to review or change report variables. Changing report variables generates a new report that does not overwrite the original request.

Note: Deferred reports run from within any report development tool do not have an option to view or change ampersand variable parameter values in the Deferred Status Interface window.

Under certain circumstances, WebFOCUS Business User Edition is unable to submit the request to run in deferred mode. This can occur, for example, when the Reporting Server is unavailable. When WebFOCUS Business User Edition is unable to submit a deferred request, a Deferred Receipt Notification window opens, notifying you of the failure.

Deferred Report Expiration Setting

The number of days until expiration appears next to each report. On the last day, the value Today appears.

The following image shows the results of a deferred status request, run on the afternoon of Tuesday, March 15. (The current date appears in the status bar at the top of the page.) Each report is listed with the time remaining before it is deleted from the WebFOCUS Reporting Server. The time remaining is based on 24-hour intervals (rather than whole days), beginning with the time that the report was submitted. For example, the last report shown on the list will be deleted shortly after 3:51 pm on March 14, not at midnight on March 13.

If a deferred report is not saved or deleted prior to its expiration, the output is automatically deleted from the Reporting Server dfm_dir directory and the deferred report is moved to the Unknown status tab in the Deferred Report Status Interface. From here, you can only delete the orphaned report.

If deferred output expiration is not configured on your Reporting Server, then the value never appears next to each report under the Expires In column.

Note: This setting does not affect deferred output saved to your private content area.
Saved Deferred Output Subject to Temporary Expiration

Saved Deferred Reports that utilize features that create temporary files, such as OLAP, On-demand paging, and redirected formats, are subject to expiration as defined by the WebFOCUS Client parameter, EXPIRE_REPORTS (located in cgivars.wfs).

Setting the Automatic Refresh Interval

You can set the automatic refresh interval to any value. The default is 5 seconds and there is no maximum value.

Procedure: How to Set the Automatic Refresh Interval

1. Enter a time interval (in seconds) in the input box below the gray toolbar.
   The default value is 5 seconds. There is no maximum value.
2. Check the box to enable automatic refresh.

Viewing Deferred Reports

You must access the Deferred Report Status Interface to view deferred reports.

Procedure: How to View a Deferred Status Report

1. Open the Deferred Report Status Interface.
2. To view the output of a deferred report:
   a. Locate the report description under the Completed tab.
   b. Click View, under the Options column, to view the report.
      The output appears in a new window.
3. The Deferred Report Status Interface remains open until closed.
   a. To return to the Deferred Report Status Interface, close or minimize the report output window.
   b. To return to your reporting environment, close or minimize the report output window, then close the Deferred Report Status Interface.
4. Click Refresh to obtain the most current status of deferred requests.
**Reviewing Deferred Report Parameters**

The Deferred Report Status Interface enables you to retrieve parameters submitted with a deferred request. You access parameters by opening the Deferred Report Status Interface and clicking the parameters button for the report of your choice. The parameters button is not available when the deferred request is submitted from within a report development tool, such as InfoAssist.

You can also change the parameters associated with a report and submit the report to run deferred with the new parameters you specified. WebFOCUS generates your report again using the new parameters and does not overwrite your original report request.

**Procedure: How to Retrieve Deferred Request Parameters**

1. Open the Deferred Report Status Interface.
2. In the Completed or Unknown tabs, identify the report containing the parameters to review.
3. Click Parameters under the Options column heading.
   - An intermediate window (HTML form) opens.
   - To review and accept the original parameters, close the browser window.
   - To change the parameters, enter a new value in the input box.
   - The original request runs in addition to the newly submitted request.
4. Click Submit.
   - The Deferred Report Notification window opens.

**Saving Deferred Reports**

You can save Deferred Receipt reports to the WebFOCUS Repository, if you are authorized to save deferred reports. You can save the report output to your My Content folder or a folder you are authorized to create content in and write to. When your deferred report is saved to the WebFOCUS Repository, it is removed from the Deferred Report Status Interface.

**Procedure: How to Save a Deferred Report**

1. Open the Deferred Report Status Interface.
2. Under the Completed tab, locate the report you want to save.
3. Under the Options column, click Save, which is located to the right of the deferred report description.
   - The Save File Content dialog box opens.
4. Navigate to your My Content folder or another folder you are permitted to create content in and write to.

5. Click Save to save the deferred report results.

   **Note:**
   - The maximum length of a title value for a file is 256 characters.
   - If the title of your file has the same name of an existing file in the folder, you will receive a message asking if you wish to replace the file.

To return to your reporting environment, close the Deferred Report Status Interface.

**Deleting Tickets for all Report Status Types**

From the Deferred Status Interface, you can delete tickets for all report status types using the Delete drop-down list located in the toolbar at the top of the Interface. The drop-down list provides options to delete All, All Completed, All Running, All Queued, All Expired, and All Unknown reports, but only when one or more reports exist for that status type in the Deferred Status Interface. If a report status type is not displayed in the Interface, the corresponding status option does not appear in the Delete drop-down list.

You can also delete individual tickets using the Delete button, located in the Options column next to each report.

The following image shows the Deferred Status Interface with the Delete drop-down list expanded showing the available options.

For Unknown tickets, the status column shows:

- **Expired** if the report has expired and is no longer stored on the Server.
- **Unknown** for cases where the status cannot be determined, including situations where the server is not running so a connection could not be made to determine the status.
Note: For Unknown reports, the Options column displays the Server ID that submitted the report along with the Current ID.

Procedure: How to Delete Tickets for All Report Status Types

1. Open the Deferred Status Interface.
2. Click the down-arrow next to Delete and select one of the following from the drop-down list that opens:
   - All
   - All Completed
   - All Running
   - All Queued
   - All Expired
   - All Unknown
   You are prompted to confirm the deletion.
3. Click OK to delete all tickets for the selected status type or click Cancel to cancel the request.

Deferred Status Delete Confirmation Messages

The Deferred Status Interface presents the user with a delete confirmation message before deleting a deferred report that is in Completed, Running, or Queued states. (A confirmation message is already displayed for deferred reports in Unknown status.)

When you click the delete button from the Deferred Report Status page, you are prompted to confirm the delete before the deferred report is actually deleted. A similar confirmation message is used for all deferred reports, but the message varies depending on the conditions.

The following are the confirmation messages and the associated conditions:

- If the report is expired or was deleted from the server, the message recommends deletion and indicates that there is no report output on the specific Reporting Server.

- If the Reporting Server is unavailable, the message indicates there is an error attaching to the specific Reporting Server.

- If there is no entry for the server in the WebFOCUS client configuration, the message recommends deletion and indicates that the specific Reporting Server is not defined in the WebFOCUS client configuration file.
Each of the deletion confirmation messages also displays the date and time the deferred report was submitted, and the description that is displayed in the Deferred Status Interface.
Troubleshooting

Learn how to troubleshoot all areas of WebFOCUS Business User Edition.

In this chapter:

- Troubleshooting WebFOCUS Business User Edition
- Monitoring Sessions
- Exporting the Session Monitor Log
- Viewing Sessions
- Working With Log Files
- Understanding Warning Messages in InfoAssist

Troubleshooting WebFOCUS Business User Edition

This topic describes how to troubleshoot the WebFOCUS Business User Edition installation.

Starting the Reporting Server Service

If you receive a message during the installation process related to failure to start the Reporting Server service, perform either of the following steps after the installation completes:

- Start the WebFOCUS BUE 82 Reporting Server service from the Windows Services.
  
  or

- Use the Start WebFOCUS_BUE Services program shortcut.

Starting WebFOCUS Business User Edition

If you are unable to launch WebFOCUS Business User Edition, ensure that all services are running. If they are not, do the following:

- Stop all services.

- Restart the services, and launch WebFOCUS Business User Edition.
If this does not work, stop the services again. Before you restart the services, ensure that the Hyperstage processes, `ibengine.exe` and `postgres.exe`, are also stopped. Restart your machine if you are still unable to restart the services.

**Port Assignment**

By default, ports in the range of 26000 to 26040 are checked for availability. If the installation program detects that no ports in that range are available, it then increases the range by 10 and checks again for availability. For example, if ports 26000 to 26040 are unavailable, ports 26010 to 26050 are then checked.

**Default Port Assignment.**

- Ports 26000 to 26003 are used by the application server.
- Port 26010 is used by the repository server.
- Ports 26020 to 26023 and port 26040 are used by the Reporting Server.
- Port 26030 is used by the Distribution Server.

**WebFOCUS Business User Edition Log Files**

WebFOCUS Business User Edition creates a log file in the following location for Windows:

```plaintext
drive:\Users\user_id\WebFOCUS_BUE82_Install_date_time.log
```

```plaintext
drive:\Users\user_id\WebFOCUS_BUE82_Debug_date_time.log
```

where:

- `user_id` is your Windows user ID.
- `date_time` is the date and time the log file was created.

These log files provide information about the WebFOCUS Business User Edition installation. If you contact Customer Support Services with an installation problem, have these files available.

**Troubleshooting the Uninstall Process**

If you choose to uninstall WebFOCUS Business User Edition, and the uninstall process fails, you can follow one of the procedures in this section to clean up your machine before reinstalling the product.
Before performing one of the following procedures, ensure that you have uninstalled WebFOCUS Business User Edition.

**Procedure:** How to Manually Uninstall WebFOCUS Business User Edition Components Using the Cleanup Utility

If the WebFOCUS Business User Edition uninstall process fails, you can run the idis_cleanup.bat file to clean a damaged installation on your machine.

1. Navigate to the following location on your machine:
   
   \drive:\ibi\WebFOCUS_BUE82\WebFOCUS\utilities\install\

2. Copy the *idis_cleanup.bat* file from the install directory to a different directory (for example, \drive:\ibi\).

3. Right-click *idis_cleanup.bat*, and then click Run as administrator.

4. When prompted, type the location of the install directory to proceed.
   
   **Note:** By default, the utility will back up the Reporting Server applications, data, and the Derby database.

**Procedure:** How to Manually Uninstall WebFOCUS Business User Edition Components

If the WebFOCUS Business User Edition uninstall process fails, you can do the following to manually cleanup the remaining WebFOCUS Business User Edition components on your machine.

2. Remove any remaining services from your machine.
   a. Locate the existing WebFOCUS Business User Edition services. To get the service name, right-click the service in the Windows Services program and click Properties. The Properties dialog box opens, where you can right-click the service name and click Copy, as shown in the following image.

   ![WebFOCUS BUE 82 Application Server Properties](image)

   b. To remove a service, open the Command Prompt as an Administrator and issue the following command:

   ```
   sc delete "service name"
   ```

   where:

   ```
   service name
   ```

   Is the name of the service you are manually deleting. For example:
C:\sc delete "WfBUE82AppSrv"

**Note:** The service name must be enclosed in double quotation marks.
Repeat this for the remaining services.

3. Open Task Manager and ensure that the process `ibengine.exe` is not running.

4. Remove files from disk, except for the Reporting Server application folders.
   For example, if WebFOCUS Business User Edition is installed on the C:\ drive, remove all folders under C:\ibi\WebFOCUS_BUE82\ except for the C:\ibi\WebFOCUS_BUE82\data\ folder.

5. Click **Start**, point to **All Programs**, and expand the **Information Builders** folder.

6. Right-click the **WebFOCUS Business User Edition 82** folder and click **Delete**.

7. Launch the Windows Registry Editor, and remove the following registry keys.

   - HKEY_LOCAL_MACHINE\SOFTWARE\WebFOCUS_BUE82
   - HKEY_LOCAL_MACHINE\SOFTWARE\Information Builders\Derby\WfBUE82DbSrv
   - HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Apache Software Foundation \Procrun 2.0\WfBUE82AppSrv
   - HKEY_LOCAL_MACHINE\SOFTWARE\Information Builders\WebFOCUS BUE 82 Reporting Server
   - HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Information Builders \ReportCaster\WfBUE82DistSrv

**Monitoring Sessions**

The Session Monitor enables Managers to track all client sessions, as well as connections and activity on the Reporting Server. The Session Monitor displays information about connected users, report requests, and Reporting Server nodes, as shown in the following image.
To refresh the information displayed, click the Refresh icon. To set an automatic refresh operation, select the Refresh Interval check box and accept the default setting of ten second intervals, or type the number of seconds you wish to use instead. If you change the value in this field, it will remain valid only while the Session Monitor page is open. If you close this page and return to it later, the default value will be reestablished.

Managers can enable or disable logging for all current sessions by clicking All/None/Selective next to URL Logging Level is currently set to. To enable or disable logging for individual sessions, click Selective, and then ON or OFF under the URL Logging column for the individual sessions. By default, all log information is located in the /logs directory.

To prevent inactive sessions from continuing indefinitely, accept the value of five minutes in the Long Running Threshold field, or type a different value to extend or curtail this period. If you change the value in this field, it will remain valid only while the Session Monitor page is open. If you close this page and return to it later, the default value will be reestablished.

For each session, the following information is available:

**IP Address**

The numeric label assigned to the computer or other device that initiated the session.

Using this address, you can identify the user assigned to the computer or other device that initiated the session.

**Mode**

Identifies the product component that started the session and provides information about all active requests. The product component values are as follows:

**WEB**

Specifies the Client.
WSRV
Specifies the Reporting Server.

Client User
Specifies the user ID that started the client session. A value of null indicates that it is a request from a self-service application.

URL Logging
Enables or disables logging for an individual session or a current user.

Trace Control
Enables or disables tracing for a specific IP Address, that is, user.

Trace FEX
Enables or disables WFServlet, Client Connector, and Reporting Server traces for each session. If tracing is enabled, click the View Trace icon to see the trace.

Active URLs
Specifies the number of URLs that are actively in use during the session. This value is relevant only to sessions that are currently open and active. Each URL represents the workstation from which a request was launched to the application server through the browser.

URL
Specifies the number, average duration, and maximum duration of dynamic URLs sent in HTTP requests. Duration is measured in seconds, calculated to the millisecond. Not all URLs in HTTP requests are forwarded to the server, and not all requests forwarded to the server are then forwarded to the DBMS.

Server
Specifies the number, average duration, and maximum duration of dynamic URLs that run reports on the Reporting Server. Duration is measured in seconds, calculated to the millisecond. Not all URLs in HTTP requests are forwarded to the server, and not all requests forwarded to the server are then forwarded to the DBMS.

W/DBMS
Specifies the number, average duration, and maximum duration of dynamic URLs that run reports against an external database. Duration is measured in seconds, calculated to the millisecond. Not all URLs in HTTP requests are forwarded to the server, and not all requests forwarded to the server are then forwarded to the DBMS.
Exporting the Session Monitor Log

You may need to export a session monitor log for troubleshooting.

1. In the Administration Console, click the Diagnostics tab, and then click Session Monitor.
   Current sessions appear in the right pane.
2. Set the Trace Control option for the chosen session to Details.
   Information icons now appear in the Trace FEX column.
3. If necessary, run a request for logging, then return to the Administration Console.
4. Click the View Trace icon.
   The Session Viewer appears, as shown in the following image.

5. Click on one of the Zip Session Traces links and save the zip file.
6. Close the Session Viewer and return to the Session Monitor pane.
7. Set Trace Control to its previous value. Typically, this is OFF.

   WebFOCUS Business User Edition confirms that tracing has been changed or stopped in a message above the Session Monitor table.

Viewing Sessions

The Session Viewer enables you to review traces of system events that took place during recent work sessions and export them to system administrators or customer support staff. Traces of system events and error messages captured by the Session Viewer provide a clear picture of system operations, and enable you to investigate the causes of system disruptions or performance issues.
The Session Viewer complements the Session Monitor page by extending the range of sessions under review, from those that are currently active, to those that occurred in the past. The parameter Days Until Traces Are Deleted (IBI_TRACE_RETAIN_DAYS) defines the number of days that the Session Viewer retains information about sessions. It also focuses your review by limiting the range of available sessions to those created by you and by those users whose session activities you have permission to review.

The Session Viewer is only available to Managers. To open the Session Viewer, sign in as a Manager, and in the Portal Menu bar, click Tools, and then click Session Viewer. If you are signed in as a Manager, you can also open the Session Viewer from the View Trace icons in the Session Monitor page.

You can view sessions you started and sessions started by other users.

Reviewing the Session Viewer Main Page

The main page of the Session Viewer displays information about your current work session. It also lists entries for all recently completed sessions that you have permission to review, as shown in the following image.

![Session Viewer Main Page](image)

To open the main page of the Session Viewer, sign in as a Manager, and in the Portal Menu bar, click Tools, and then click Session Viewer. When the main page opens, your sign-in information and the ID of the session you are viewing appear at the top of the screen. The session ID follows the format username_HHMMSS (YYMMDD). It contains the date, time, and username of the session on display. For each session, the following information is available:

**User Name**

The name of the user that signed in to this work session.
Tracing Level

The level of traces captured by the current session. The default value for this field is Off, but you can choose another value from the drop-down list. The Session Viewer saves this selection when you close the viewer, and uses it as the default setting for your next session.

The four tracing levels are cumulative, meaning each higher level includes the traces of all of the levels below it. These levels include:

- **Basic.** Generates a trace for each URL, which includes IBFS traces and procedure traces.

- **Outputs.** Includes Basic level traces and output from URLs that run requests on the Reporting Server. This level of tracing affects the amount of disk space required to capture output traces, but does not affect system performance.

- **Debug.** Includes Outputs level traces and log4j debug level written to the Session Viewer output.

- **Details.** Includes Debug level traces and legacy WFServlet traces. This level of tracing affects session performance.

- **Server.** Includes Details level traces and generates traces for the Reporting Server activity for the current work session.

Fex Echo Setting

The level of echo traces captured from the execution of FEX file commands. In a FEX file, the $ECHO variable displays command lines as they execute in order to test and debug procedures. These levels include:

- **Off.** Suppresses the display of both stacked commands and Dialogue Manager commands in its traces. This value is the default.

- **On.** Displays WebFOCUS Business User Edition commands that are expanded and stacked for execution in its traces.

- **All.** Displays Dialogue Manager commands and WebFOCUS Business User Edition commands that are expanded and stacked for execution in its traces.

SQL Tracing

The level of traces captured from SQL events. These levels include:

- **Off.** Suppresses the display of traces of SQL request and response events.
On. Displays traces of all SQL request and response events. Even if you select this setting, however, the Session Viewer will not display SQL event traces if there are no requests issued to an SQL database.

**Viewing File**

The name of the Viewing File. File names are identified by their start time and end time in HH.MM format. If an asterisk (*) is displayed as the end time, current traces are being routed to that file.

You can click *New File* to capture a new set of traces, which allows users to capture a set of URLs to be reviewed. When you click this link, the Session Viewer automatically creates a new file and assigns all subsequent traces to it. You can review prior traces by clicking a file containing completed traces in the Viewing File list.

**Session Started**

The time that your active session started, in HH:MM:SS format.

**Last Activity**

The start time of the most recent activity in your active session, in HH:MM:SS format.

**URL Count**

The total number of URLs issued for the session that you are viewing.

**Average Response**

The average response time for all URLs issued for the session that you are viewing.

**Server Requests**

The number of requests made to your Reporting Server during your active session.

**Average Server Time**

The average time (in seconds) that it takes the Reporting Server to respond to a request.

**Average DBMS Time**

The average time (in seconds) that it takes the Reporting Server to respond to a request directed to a non-WebFOCUS Business User Edition or RDBMS database.

If no current session file is available, the section below the status bar displays the following text:

*Session file does not exist.*

If a current session file is available, the section below the status bar lists traces for that file.
You can also view a table containing links representing recently completed sessions. If multiple viewable sessions occurred on a specific date, they are listed from left to right in that table in the order in which they occurred, earliest to latest.

Information from completed sessions remains available for the period defined in the setting, Days Until Traces Are Deleted (IBI_TRACE_RETAIN_DAYS).

To view a different session, click a session link on the main page or the session details page. A new page displaying traces for your selected session opens.

**Note:** The session information links connect to completed sessions only. To view a current session, open the Session Monitor page from the Administration Console, and click an Information icon, if one appears.

### Reviewing the Session Details Page

To open the session details page, click a session link in the Existing session traces column of the main page. The session details page opens, as shown in the following image:

![Session Details Page Image](image)

This page displays a group of features that enables you to review relevant details about your selected session, review summary versions of the traces it created, and move on to other sessions.

When the review of your selected session is complete, close the session details page to return to the main page.

When you open the session details page, your sign-in information and the ID of your selected session appear at the top of the screen.
A table underneath the Session ID lists additional details identifying the session under review.
The User Name entry identifies the name of the user who initiated the session on display.

The Inactive Session entry identifies the session as being inactive or active. If this entry is blank, the session on display is inactive. If a value appears in this entry, the session on display is currently open.

The Viewing File entry identifies the range of trace entries on display, as defined by start time. By default, this value displays the entire range of trace entries from the start time to an undefined end time. If a drop-down button appears, you can select a different time range from the drop-down menu.

You can use the following options to change the display of trace information that you want to view.

- **Refresh.** Adds any traces to the list that were generated after you opened an active session. This option is not available to previously completed sessions.

- **Previous.** Moves the display back to view an earlier set of traces.

- **Next.** Moves the display forward to view a later set of traces.

- **Last.** Moves the display to view the final set of traces captured right before the end of the session.

- **View.** Limits the list of traces by type.
  - **All URLs.** Displays URLs that return static content, such as .css files, .html files, .js files, and dynamic URLs that perform a Client action, as well as URLs that perform an action on the Reporting Server.
  
  - **Work URLs.** Limits the display to dynamic URLs, as well as Reporting Server requests. This is the default setting.
  
  - **Server Requests.** Limits the display to URLs that access the Reporting Server.

- **In groups of.** Determines the number of trace entries that appear on a single page. You can select 1, 5, 10, 25, 50, 100, or 200. Your selection in this field impacts the use of the Previous, Next, and Last options. The larger the value you select, the fewer times you will be required to move to the previous or next page.

- **HighLight.** Assigns a yellow highlight to the start time field of all trace entries that contain the search term that you type in this field.

  For example, if you type the term *short*, a highlight appears in the Start Time field for any trace entry that contains this term, such as:
**Note:** After your search results produce a match, the highlights from that match will not clear until you close the session details window. Therefore, to prevent false matches to any subsequent search, you must close and reopen the session details window.

**ZIP Session Traces.** Saves all of the traces from the session to a single.zip file. When you click this link, you are prompted to open or save the file. Click Save As, browse to a storage location for the.zip file, and then click Save.

The default name for this .zip file is `sessionmonitor`, followed by the number of trace and log files it contains.

These options also appear below the trace information table.

The trace information table enables you to review individual session traces in more detail. It displays one summary entry for each trace captured during the session. You can expand these entries to review the detailed event messages captured by the trace.

The table located below the trace information table and options identify the User Agent and Build that started the session. Details identifying the User Agent include the browser, operating systems, and supporting applications. Details identifying the Build include the version number, build number, and generation date of the version of WebFOCUS Business User Edition to which this session was connected.

A list of recently completed sessions appears at the bottom of the page. This list is a duplicate of the session list on the main page and appears here to enable you to move on to another session without having to leave the session details page.

**Reviewing Trace Entries**

Each entry in the list of traces on the session details page represents the record for a single system activity, as shown in the following image.

One activity can include multiple events, and these events become visible when you expand the icon next to a trace to view its full detail.

For each trace, the following information is available:

**Start**

The time, in hours, minutes, and seconds, that an event in the trace began. Hours are expressed in twenty-four hour time notation.
End

The time, in hours, minutes, and seconds, that an event in the trace ended. Hours are expressed in twenty-four hour time notation.

Number of Seconds Max

The number in the header of this column represents the maximum number of seconds that were required to complete the longest trace in the list.

Entries in this column contain a (time) bar that represents the relative duration of the events in the trace, as shown in the following image.

- The darkest blue section of the bar represents the number of Web CPU seconds that were required to process the events in this trace. It also identifies the trace as containing a Work URL component.
- The lightest blue section of the bar represents the number of Web wait seconds that were required to retrieve a response from a database. It also identifies the trace as containing a Work URL component.
- The brown section of the bar represents the number of Reporting Server seconds that were required to process the events represented in this trace. It also identifies the trace as containing a Server Request component.

You can view tooltips that identify the exact number of seconds that each section of a bar represents by pointing to that section with your mouse. If you are reviewing an active trace in a current session, the bar appears green and occupies the entire column entry.

Details

The ID of the trace. This is the URL of the destination of the request message that launched the trace events. The first term in the URL identifies the servlet or other application that launched the request. Each trace ID is unique.

When the URL ID number is highlighted in orange, events in the trace associated with it include one or more error messages. Within the detail trace display, events that contain error messages are also highlighted in orange to help you identify when the errors occurred.
Reviewing Expanded URL Details

When you expand an individual Trace Details list entry, a nested list of system-generated messages opens. These messages identify the events captured by that trace and the time, in milliseconds, at which those events took place. Events include request and response messages exchanged between the Client and the Reporting Server or between the Reporting Server and the application server. They also include error messages, informational messages, and system status messages generated by application programs as they execute commands. Entries representing repetitive or subordinate events are nested to help you identify them more quickly, as shown in the following image.

A trace entry begins with the event start time and the number of milliseconds after the trace start time at which the event took place. This value helps you distinguish between individual events, and places them in sequence within an individual trace.

The IBFS status code for the trace event follows the event start time.

This column contains one of the following symbols:

<table>
<thead>
<tr>
<th>Symbol</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBFS+</td>
<td>The starting event of a program or exchange of data between programs or applications.</td>
</tr>
<tr>
<td>IBFS-</td>
<td>The ending or final event of a program or exchange of data between programs or applications.</td>
</tr>
<tr>
<td>IBFX*</td>
<td>An error message.</td>
</tr>
<tr>
<td>IBFSX</td>
<td>An administrative or informational message.</td>
</tr>
</tbody>
</table>
The text of the message generated by the application or program that describes the event appears next. The type of text displayed in this section varies with the type of trace you have selected from the View drop-down list.

- If you select All URLs or Work URLs, an expanded URL entry displays the status and error messages that were generated as the program ran.

  **Note:** If your entry includes a Server Request message, the underlined Request ID term of the trace entry links you to full details of the Reporting Server Request trace, and the underlined Response ID entry links you to full details of the Reporting Server Response trace.

- If you select Server Request, an expanded URL entry displays the Reporting Server Request procedure, followed by a list of status or error messages generated during that procedure. (This is the same display that appears when you open a Server Request link from a Session Monitor Information icon.)

### Reviewing Reporting Server Request Details

Traces captured from a Reporting Server Request identify the details of the query or other request operation sent from the Client to the Reporting Server during the session, as shown in the following image.
This information identifies the variables and commands sent during the request operation. These requests are usually TABLE requests or -HTMLFORM BEGIN/END requests that are sent from the Client to the Reporting Server.

The ID term in the first line above the procedure links it to the URL trace from which it was generated. For example, the ID URL85, links the procedure to the server request event line within the activity captured in trace URL 85.

At the end of the list of variables and commands, the procedure displays a list of status messages describing the results of the query or other operation, as shown in the following image.

```
--------End-------- RequestID=URL85Req2 UrlID=URL85 ReqInfo="Run:Domain=Setting Started.
--------Server---Times-------- RequestID=URL85Req2 UrlID=URL85 ReqInfo="Run:Domain=Setting Started.
```

**Reviewing Reporting Server Response Details**

Traces captured from a Reporting Server response identify the information returned in response to a query or other request operation sent during a work session from the Reporting Server to the Client during a work session.

To view output traces, click on the link from an underlined URL request response entry in a URL Trace entry, such as:

**URL103Req4Resp**

The first part of this display identifies the format variables returned to the Client during the response operation, as shown in the following image.
The second part of the display identifies the data returned to the Client during the response operation, as shown in the following image.

The Session Viewer can display Reporting Server response traces in XML, HTML, or a standard report format. Reporting Server responses usually contain data or status messages returned in response to SQL-based queries, updates, or other database-related operations.

**Working With Log Files**

The Log Files page displays links to all log files. The main grid lists log files in alphabetical order by name.

Next to each log file entry is a list of Logger Names, that is, those pages or events that contribute entries to that log. For example, the audit.log file captures events from com.ibi.uoa, com.ibi.config, com.ibi.uoa.caster_config, com.ibi.content, and others. The Log Level field, next to each Logger, identifies the level of events captured by that contributor.

Event levels are cumulative. Events captured by a higher level are included when you select a lower level. For example, if you set the level to **Warn**, you capture Fatal level and Error level events as well as events that generate a warning.

The levels are defined below:

- **Off**. Capture no events.
- **Fatal**. Capture only events that disrupt system operations.
- **Error**. Capture events that generate error messages in addition to fatal events.
- **Warn**. Capture events that generate warning messages in addition to fatal and error events.
- **Info**. Capture events that generate informational messages in addition to warning, error, and fatal events.
- **Debug**. Capture events that generate debug messages in addition to informational, warning, error, and fatal events.
**Trace.** Capture events that generate trace messages in addition to debug, informational, warning, error, and fatal events.

The log levels assigned to the audit log files are preset, and are not available for updates. You can adjust the log level assigned to any of the other log files. However, when you recycle the application server, all log levels revert to their default value.

The Zip All button saves copies of the current version of all log files into a single zip file. You can use this button to capture records of system events whenever necessary. The log files you capture include records of events from the start of the current day until the time you create the zip file. Event records captured in the log files support troubleshooting and analysis.

**Note:** The Log Files page does not display Web Services traces or client traces. To view these traces, open the Session Viewer or the Session Monitor.

**Working With Log Pages**

Log pages list detailed records of system events that were captured in a log file in order of the time of their occurrence, from the earliest event on the day of the log to the most recent.

To open a log file for review, click a link from the Log Name column on the Log Files page. The page for your selected log file opens in a separate window.

The name of the log file appears at the top of the page. A list of earlier versions of that log file also appears at the top of the page. This list contains all previous versions of that log file that are currently available in the `drive:\ibi\WebFOCUS_BUE82\WebFOCUS\logs` directory.

The New Trace Lines link appears beneath the file name. Click this link to refresh the log page with entries for system events that occur after you open it. New records are posted to a log file automatically. To protect the integrity of this information, no one can use a log page to update or change log file records.

The Bottom link takes you directly to the last entry in the file. This link is useful when you must review a file with a large number of entries and you want to move directly to the most recent event. Similarly, the Top link, which appears below the last entry, returns you to the first entry in the log file and the features that appear on the top of the page.

The list of individual event entries begins below the Bottom link. Individual entries start with the date and time, in hours, minutes, seconds, and milliseconds, that an event took place. A code name identifying the category of event and the specific event itself follows the date and time. A full description of the event comes next. This description includes any messages generated by the system in response to the event.
You can use the log page to review and search for records of specific events in response to a query from a customer service support team member. The Find command in your browser can help you search for an event by a unique message, event name, or timestamp. You can also scroll through records to locate an event.

When your review is complete, close the log page window. You can use the Save or Print command in your browser to save or print a copy of the log page, or you can capture a zipped copy of it using the Zip All button from the Log Files page.

Tracking ReportCaster Configuration Events

You can now track when ReportCaster Configuration settings are changed. This feature enables you to keep continuous records of how and when ReportCaster Configuration settings are changed, and to comply with any regulatory auditing requirements of your organization. To access the audit log file, launch the Administration Console, click the Diagnostics tab, and then click Log Files. In the Log Name column, click the audit link.

When you change ReportCaster Configuration settings, a record of the event, labeled as caster_config, is created in the audit.log file. Before changes to the ReportCaster Configuration settings are saved, the previous settings of the ReportCaster Configuration tool are recorded in a timestamped dserver.xml file. This file is saved in the following directory:

drive:\ibi\WebFOCUS_BUEnn\WebFOCUS\logs

where nn is the WebFOCUS BUE release number.

Downloading ReportCaster Job Trace Files

After you run a schedule, or use the Purge Job Logs utility, you can select the corresponding job log stored in the ReportCaster Console to download the trace files that were created by the job.

Procedure: How to Download ReportCaster Job Trace Files

1. Run a schedule, or use the Purge Job Logs utility.
   
   **Note:** To receive trace files for a ReportCaster job, traces must be enabled for the job.

2. Navigate to the ReportCaster Console. On the ribbon, in the Show group, click the Job Log button.

3. In the Job Logs panel, choose the folder that contains the job log you wish to select.
   
   The job logs appear in the right panel.

4. Click a job log.

5. On the ribbon, in the Manage Job Logs group, click the down arrow on the View Trace button.
The Download Trace Files menu option appears.

6. Click the Download Trace Files option.

The Windows Save dialog box displays, from which you can save the trace files to your machine. The Job Id of the log becomes the name of the zip file to be opened or saved.

**Using the ReportCaster Performance Log to Track Schedule Performance**

You can use the performance log to analyze the resource utilization of schedules in WebFOCUS Business User Edition. This log records the processing duration of individual schedules and schedule components.

To access the performance log, navigate to the ReportCaster Console. On the ribbon, in the Manage group, click the Server Log drop-down arrow to view the Server Log menu, where you can click the performance.log option.

**Note:** If the Manage Server Group is not visible, click the Server Status button in the Show group.

The performance log feature is turned off by default. To activate performance log recordings, click Turn On Server Performance Trace.

The performance.log records the following information in each record:

- Job ID
- Schedule ID
- Schedule Name
- User ID
- Time
- Type - (Begin, End)
- Event - (QUEUED, JOB, WF_REPORTING_SERVER, DESTINATION_MAPPING, COMPRESSION, EMAIL, FTP, LIBRARY, REPOSITORY, PRINT)
- Source - (Schedule ID, Task ID, Distribution ID)
- Server Name - (EDASERVE, IBIMAIL, FTP Server Name, Print Name…)
- Server User - (Execution ID)
- Object - Scheduled fex
### Understanding Warning Messages in InfoAssist

This topic describes InfoAssist warning messages.

#### InfoAssist Warning Messages

<table>
<thead>
<tr>
<th>Message</th>
<th>Description</th>
<th>OK</th>
<th>Cancel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Are you sure you want to switch data source? Doing so will delete your current report.</td>
<td>This warning message displays when a report is first saved in a different format and one or more additional reports are created and saved, and the user clicks <strong>Switch</strong> on the Data tab and selects a different report from the shortcut menu.</td>
<td>Deletes the current report.</td>
<td>Preserves the current report.</td>
</tr>
<tr>
<td>Are you sure you want to add a data source? Doing so will delete your current report.</td>
<td>This warning message displays when a report is first saved in a different format and an additional report is created and saved, and <strong>Add</strong> on the Data tab is selected.</td>
<td>Deletes the current report.</td>
<td>Preserves the current report.</td>
</tr>
<tr>
<td>User Selection in this request is not allowed with your configuration. Your report will be converted to default output.</td>
<td>This warning message displays when the user selection option is not available on restore, or when you are restoring a user selection option when it is disabled at global preference.</td>
<td>Converts the report to use the default output type.</td>
<td>No changes are made to the original procedure and it is closed.</td>
</tr>
</tbody>
</table>
Unsupported Syntax and Objects

This section describes the syntax and objects that are not supported.

- **SUB-TOTAL** syntax is not supported. If you try to open an existing procedure in InfoAssist from a legacy tool that contains **SUB-TOTAL** syntax, an unsupported syntax warning message displays. If you choose to continue, InfoAssist will convert the syntax to **SUBTOTAL** and add the converted syntax to all higher level sort breaks.

- **SUMMARIZE** syntax is not supported. If you try to open an existing procedure in InfoAssist from a legacy tool that contains **SUMMARIZE** syntax, an unsupported syntax warning message displays. If you choose to continue, InfoAssist will convert the syntax to **RECOMPUTE**.

- **HTML** FULL, FIXED, and PAGED syntax is not supported. If you try to open an existing procedure in InfoAssist from a legacy tool that contains any of these three options, an unsupported syntax warning message displays. If you choose to continue, InfoAssist will convert the procedure to regular HTML output.

- **COLUMN-TOTAL** syntax is not supported. If you try to open an existing procedure in InfoAssist from a legacy tool that contains this syntax, an unsupported syntax warning message displays. If you choose to continue, InfoAssist will convert it to use **RECOMPUTE** syntax.

- Line objects in a compound document imported from a legacy tool are not supported. If you try to open an existing procedure that includes line objects, an unsupported syntax warning message displays. If you choose to continue, InfoAssist will remove these line objects.
Index

3D chart types 424
3D charts 423
3D depth
  removing from a bar chart 825

A

active cache 462, 511
  enabling 463
  enabling by component 463
  rows retrieved 463
active report 598
active report Options dialog box 521
  Advanced tab 525
  Colors tab 524
  General tab 522
  Menu Options tab 522
Active Technologies
  for charts 526
adding a Reporting Server 215
Address Book access types
  configuring 181
Administration Console
  accessing 115
  Client Verification 75
  Diagnostics 75
  navigating 70
  verification tools 75
aggregation values 770
  dimension 771
annotations
  displaying 830
API for extensions 429
application button 77
application main menu 78
application window 77
area chart types 420
area charts 419, 474
attribute categories
  for an extension 438
authentication
  by Active Directory 268
  by LDAP 268
  external 268
automatic refresh 985
axis labels
  custom format characters 798
  deleting 803
  formatting 796, 804
  horizontal axis labels 796
  rotating 803
  secondary axis labels 796
  staggering 803
  vertical axis labels 796
axis titles
  adding 804
axis
  manually setting 804
  setting advanced properties 805
  shortcut menu 801
  using properties 803

B
bar chart types 415
bar charts 413, 470
basemaps
   custom 575, 589
Basic Scheduling Tool
   advanced settings 957
   creating a schedule 904
   delete parameters 928
   Distribution Options 931
   Email Distribution Option 931
   Managed Reporting Distribution Option 940
   notifications 942
   Parameter Values 908
   Printer Distribution Option 938
   Quick Access Toolbar 901
   Tasks 906
Binning 383
Blackout Dates 216
   defining 220
   extracting 240
   importing 234
blend 349
blending data 349
browser requirements 27
bubble charts 423, 480
bubble maps 540
burst reports 970
burst values 898
bursting 894
bursting reports 898
   guidelines and limitations 895
business views 320

C
Cache Cleaner 165
cache clearing 122
callback functions
   for rendering extensions 430
   initCallback 430
   preRenderCallback 430
   properties 433
   renderCallback 430
canvas 77, 91
cell padding in reports 749
change 465
Change Management 277
Change Management settings 143
   IBI_CM_Export_WFRS_File_Extensions 143
   IBI_CM_Retain_Handles 143
   IBI_CM_Zip 143
   IBI_CM_Zip_File_Format 144
   IBI_CM_Zip_File_Verify_Signature 144
chart frame and background
  formatting 805
chart types
  custom 428
chart
  pyramid 426
  adding a page heading and a page footing 823
  controlling the rendering of a page heading and page footing 824
  frame and background 806
  rotating 826
Sort By Total Value 111, 826
charts
  3D 423
  area 419
  bar 413
  bubble 423
  funnel 426
  gauge 426
  gauge thermometer 426
  horizontal bar charts 415
  horizontal box plot 426
  line charts 417
  multi-axis 422
  pareto 426
  pie 415
  polar 423
  selecting 413
  special 426
charts
  spectral map 427
  stock 425
  vertical bar charts 414
  vertical box plot 426
  XY plot 422
chart elements
  chart formatting tools 757
  chart outputs 383
  creating a basic chart 380
  creating a combination chart 381
  creating a dual-axis chart 382
  creating a multi-axis chart 382
  creating an advanced chart 381
  custom 428
  displaying annotations 830
  dynamic reference lines 828
  extensions 428
  HTML5 427
  library of advanced charts 380
  Live Preview 757
  plug-ins 428
  removing 3D depth 825
  shortcut menu 757
  static reference lines 827
  using Active Technologies 526
choropleth maps 540
  circular gauges 484
  cleanup utility 42, 993
  Clear Cache 122
Client Verification 75
Client
	license management 118
clusters
	creating 342
color bands
	setting 793
Color dialog box 751
color mode
	by group 774
	By Group setting 764
	by series 774
	By Series setting 764
color-banded rows of data in reports 746
COMPUTE fields 351
cfg object for extensions 434
configuration 171
	change default user IDs 175
Data Server Settings 208
Distribution Server settings 175
Email Settings 187, 198
General Preferences 181
LDAP Setting 205
Log Settings 204
Other Schedule Defaults 203
ZIP Settings 201
configuring
	InfoAssist for MR 118
	Magnify license 118
	Mobile Favorites 118
configuring
	Quick Data 118
connections
	adding 333
	changing 334
	configuring 333
containers 623
Creating Distribution Lists 885
creating report queries
	in InfoAssist 676
custom charts 427
custom interval 955
custom reports 986
d

daily interval 950
data 349
	appending 325
	connecting to 331
	editing 341
	merging 325
	uploading 325
DataGrids 427
Deferred Report Status interface 979, 981, 985, 988
	enpiration setting 984
	parameters 979, 984, 986
	refreshing 981
Deferred Reporting settings
	IBI_Deferred_Custom_Description 144
Deferred Reporting settings

IBI_Deferred_Notify_Submitted 144
IBI_Deferred_Ticket_Delete_Confirm 144

defered reports 979, 988
  deleting 982, 984
  options 981
  parameters 979, 984, 986
  running 983, 988
  saving 979, 983, 986
  sorting 979, 981
  status 981
  viewing 979, 981, 985

DEFINE fields 351

delete confirmation message 988
delete option 988
deletion confirmation message 988

Detail (DEFINE) dialog box 352

Diagnostics Tab 74
  Client Verification 75

Dimension View 345

Distribution Lists 885
  creating 886
  deleting 890
  editing 890
  multiple email addresses 898
  publishing 893
  sharing 892
  unpublish 894

Distribution Server 164
  configuring 175

Distribution Server 164
  start 168
  status 165
  stop 168

documents
  aligning components 455
  building 448
  cascading prompts 538
  changing the filter condition 537
  creating from a single report 451
  deleting a component 460
  editing component 453
  editing text 458
  inserting a chart 450
  inserting a report 449
  inserting an existing report 451
  inserting an existing report into a document with the Insert tab 451
  inserting an image 452
  inserting reports from multiple data sources 448
  inserting text 452
  inserting text and images 451
  inserting two reports from two different data sources 448
  moving a component 454
  resizing a component 453
  setting target reports 530
  styling and customizing a chart 458
  styling and customizing a report 457
domain templates 246
DV roles 345
dynamic reference lines 828

E

Edit Title dialog box 760
editing a schedule with unavailable options 962
Enable(d) check box 137
Enterprise domain template 246
Esri HTML5 Viewer
  geographic roles, custom 565, 579
Excel output for reports 373
expiration settings for deferred reports 984
Export Data 599
extensions 428
  buckets 438
  build cycle 429
  building 435
  callback functions 430
  config object 434
  configuring 434, 436
  creating 428, 429
  data for 438
  installing 444
  null data 443
  partial data 443
  registering 435
  reinstalling 445
  structure 429
  using 446
external authentication 268
External Security settings 127

F

field formats
  changing in reports 865
date 867
date-time 868
  alphanumeric 866
  changing in reports 865
currency 865
numeric 867
percent sign 870
field images 96
Field tab 90
  Filter group 836
Filter group 836
Filter pane 97
filtering with slicers 864
FOCUS format index files 605
folders 249, 345
  changing title 254
  creating 251
  deleting 254
  duplicating 253
  publishing 252, 253
  viewing properties 249
Format Axis dialog box 796
  Advanced tab 798, 801
  Labels tab 797, 800
Format Axis dialog box 796
  Scale tab 796
  Title tab 797, 800
Format Gauge dialog box 815
  Advanced tab 817
  Axis Scale & Labels tab 816
  Bands tab 817
  General Options tab 815
  Tick Marks tab 816
Format Grid Lines dialog box 787
  Color Bands tab 788
  Frames tab 789
  Major Grid Lines tab 787
  Minor Grid Lines tab 788
Format Labels dialog box 775
  Advanced tab 777
  Funnel Labels tab 778
  General Options tab 776
  Pie Labels tab 778
  Pie Title tab 777
Format Legend dialog box 781
  Legend Options tab 782
  Markers & Labels tab 783
Format Series dialog box 758
  Border tab 759
  Fill tab 758
Format tab 86
Frame & Background dialog box 806
  Frame Edge tab for 2D charts and 2D charts with 3D effects 808
  Frame Edge tab for pie charts 809
  Frame tab for 2D charts and 2D charts with 3D effect 807
  Frame tab for pie charts 808
  shortcut menu 812
  Wall and Floor tabs 810
  frame and background
    using properties 813
funnel charts 426

G

gauge chart
  shortcut menu 818
gauge charts 426
  Format Gauge dialog box 815
gauge thermometer 426
gauge
  using properties 818
g geographic roles
    custom 565, 579
Get More Extensions 138
Global Updates
  Data Server 244
  Email Address 243
  Email From 243
  Mail Server 243
  Notification Brief Message To 245
Global Updates
  Notification Full Message To 245
  Notification Reply Address 244
  Notification Subject 244
  Notification Type 244
  Printer 243
  gridlines 786
    deleting 794
    displaying horizontal minor 790
    displaying vertical major 791
    displaying vertical minor 791
  formatting 786
    major 786
    minor 786
    setting the color, weight, and style 791
  shortcut menu 789
  using properties 790
  grids 468
  Group Membership Report 263
    Creating 265
  groups
    adding users 267
    deleting users 267

H
  hardware requirements 27
  headings and footings
    adding to reports 742
    styling in a report 745
  Help 77

HFREEZE 933
  Home tab 86
    Report group 752
  horizontal box plot charts 426
  horizontal major gridlines
    displaying 790
  horizontal menu 508
  hourly interval 949
  HTML5 Chart Extensions 136
  HTML5 Chart Extensions Entries 137
  HTTP request headers 76
  HTTP Request Info setting 76

I
  IBI_CM_Export_WFRS_File_Extensions 143
  IBI_CM_Retain_Handles 143
  IBI_CM_Zip 143
  IBI_CM_Zip_File_Format 144
  IBI_CM_Zip_File_Verify_Signature 144
  IBI_Deferred_Custom_Description 144
  IBI_Deferred_Notify_Submitted 144
  IBI_Deferred_Ticket_Delete_Confirm 144
  IBI_DESCRIBE_TEMPLATES 146
  IBI_TEXT_GENERATION_SERVER_URL 147
  IBI_WFDescribe_Default 146
  IBIF_Describe_Null 147
  IBIMR_Prompting 145
  IBIMR_PromptingUnset 146
  InfoAssist interface
    application button 77
InfoAssist interface
  application window 77
  canvas 77
  Help 77
  main components 77
  Navigation taskbar 78
  Quick Access Toolbar 77
  Resources panel 77
  ribbon 77
  status bar 78
InfoAssist
  creating report queries 676
  license configuration 118
  report queries 676
InfoDiscovery
  troubleshooting 991
  troubleshooting 991
initCallback 430
insert 488
Insert tab 86
inserting a chart
  450
Insight 391
  adding filters 405
  changing summary operators 399
  charts 394
  filtering 401
  Options toolbar 406
  Phone mode 411
  removing filters 406
installation 26
installation steps
  Linux 46
installing an extension 444
interactive reports 508
  horizontal menu 508
  vertical menu 508
J
Java environment 76
Java Regular Expressions 896
Job Logs 170
Job Status 169
Join dialog box 347
JVM Property Info 76
L
Layout tab 89
LDAP 205
  configuration 205
  email settings 205
  settings 205
legend
  shortcut menu 783
legends
  formatting 781
  hiding 784
  positioning 785
  specifying border color 785
  using properties 784
license code configuration 118
Lightweight Mapping 380
line chart types 418
line charts 417, 472
    applying a smooth effect 767
Line Style dialog box 779
List view 99
log files 968
log reports 965, 968
    considerations 969
    viewing 965, 969
Logical view 99

M
Magnify license 118
Maintaining Distribution Lists 885
major gridlines 786
Manage Private Resources 268
Managed Reporting 979
Managed Reporting Repository 982, 986
maps
    bubble 540
    choropleth 540
marker
    changing the appearance of 768
markers
    connecting or hiding a series line 767
mathematical equations 767
matrix charts 502
matrix marker charts 482
maximize visualization 492
    492
Menu Bar 57
metadata
    editing 341
    importing 334
mime.wfs configuration file 133
    redirection settings 133
minor gridlines 786
minutes interval 948
Mobile Favorites license 118
mode 996
monthly interval 952
multi-axis charts 422
multi-page dashboard
    creating 461
multi-page document
    creating 460
multi-page documents 460
multi-page
    dashboards 460
Multi-Y 600
Multi-Y Axis 599
multipage documents and dashboards
    Page menu 462

N
Navigation taskbar 78, 94
null data for an extension 443
Options window 284
Output window 92
  cascade 93
  output format options 94
  output target options 93
  output view options 93
  switch output 94
  tile horizontally 93
  tile vertically 94

Packet Email 937
  page footing
    adding to a chart 823
  page heading
    adding to a chart 823
  page headings and page footings
    formatting 823
Page Options dialog box 462
pages 636
Paper-clipping 494
Parameter Prompting settings
  IBI_Describe_Templates 146
  IBI_WFDescribe_Default 146
  IBIF_describe_null 147
  IBIMR_Prompting 145
  IBIMR_PromptingUnset 146
pareto charts 426
partial data for an extension 443
pie chart types 416
pie charts 415, 475
pie slices
  expanding 769
  hiding 769
pivoting
  columns 343
plug-ins 428
  API 429
  buckets 438
  build cycle 429
  building 435
  callback functions 430
  config object 434
  configuring 434, 436
  creating 428
  data for 438
  installing 444
  null data 443
  partial data 443
  registering 435
  reinstalling 445
  structure 429
  using 446
polar charts 423
Portal
  adding pages 636
  pages 636
  preRenderCallback 430
Procedure Settings 374
Properties panel 249
properties.json file for an extension 436
published content 982
publishing 971
pyramid charts 426

Q
Query pane 92
right-click options 107
Quick Access Toolbar 77, 81
Quick Data license 118

R
Redirection Settings 133
Reference Line dialog box 828
reference lines
   COMPUTE field 829
dynamic 828
static 827
refresh options 981, 985
registering an extension 435
renderCallback 430
Report group 752
report queries
   InfoAssist 676
Report Style dialog box 750
report types
   custom 986
defferred 979
Standard 982
ReportCaster configuration folders 173
ReportCaster Tab 73
ReportCaster
   tracking schedules 965
   unavailable options 970
Reporting Server settings 214
Reporting Servers
   adding servers 215
reports
   Excel output 373
   bursting 894, 895
cell padding 749
color-banded rows of data 746
defferred 981
deleting 979
distributing 894
headings and footings 742
Live Preview 757
report-level styling 740
Style group 741
styling 740
styling column titles 741
styling data 741
styling headings and footings 745
styling rows with alternate colors 746
tracking 965
traffic light conditional styling by constant 746
traffic light conditional styling by field 748
viewing deferred output 981
resource templates 246
Resources panel 77, 95
  field images 96
    using Query pane in 101
reviewing parameters 986
ribbon 77
ring pie charts 477
run once interval 947

S
SaaS Tenant domain template 246
sAMAAccountName 256
scatter charts 423, 479
schedule blackout dates 216
Schedule Distribution Method Settings 185
Schedule Format settings 182, 183
schedule formats
  configuring 181
schedule logs 965
Schedule Method setting 185
schedule methods
  configuring 181
schedule status
  checking 966
Schedule
  multiple email addresses 898
schedules
  publishing 964
  sharing 963
se‌condary axes options
  Format Secondary Axis dialog box 801
Security Tab 73
Series tab 91
series
  changing the title 774
  changing the type 766
  color mode 774
  deleting 775
  dialog boxes 758
  filtering values in 769
  formatting 758
  formatting the fill and border 766
  hiding fields 770
  shortcut menu 763
  sorting fields 769
  using properties 765
Session Monitor 995
Show data 598
  597
Size and Position dialog box 454
Slicers tab 88
slicers
  filtering with 864
software requirements 27
sorting deferred reports 979, 981
special charts 426
spectral map charts 427
spreadsheets
    appending new data 326
    merging new data 327
SQL 334, 335
static reference lines 827
status bar 78, 95
stock chart types 426
stock charts 425
storyboard 833, 834
    create 835
    creating 833
Structured view 99
Style dialog box 779
subquery filter 605
Summary Field (COMPUTE) dialog box 353
synonyms
    editing 332, 341
    importing 334
system requirements 27

T

Text Generation Server Settings
    IBI_TEXT_GENERATION_SERVER_URL 147
text
    adding 489
    inserting 488
Thumbnails 830
ticks
    setting 792
tracking schedules 965
Traffic Light Condition dialog box 760
traffic light conditional styling by constant in reports 746
traffic light conditional styling by field in reports 748
traffic light conditions
    applying with drill-down to numeric measure field (by constant) 771
    applying with drill-down to numeric measure field (by field) 773
treemap charts 483
trendlines
    adding 767
troubleshooting 41, 991

U

unavailable options
    in ReportCaster 962
    log information 970
    notification 970
uninstalling
    on Linux 53
    on Windows 39, 42, 992
Upload and Install Extensions Page 138
user preferences
    changing 284
    environment and styling 285
    format 285
    layout 285
user preferences
  view 284
users 255
  adding to groups 267
deleting 262
  editing details 262
removing from groups 267

V
verification tools 75
vertical box plots charts 426
vertical menu 508
View tab 89
  Data Panel group 98
viewing deferred reports 979, 985
visualization 486, 489
  Multi Drill 501
  creating 489
  inserting 488
  renaming 493
visuals
  area charts 474
  bar charts 470
  bubble charts 480
  bubble maps 540
  changing 465
  choropleth maps 540
  circular gauges 484
gauges 484
  grids 468
  horizontal bar charts 471
  inserting 488
  line charts 472
  maps 540
  matrix marker charts 482
  pie charts 475
  ring pie charts 477
  scatter charts 479
  selecting 465
  stacked area charts 474
  stacked bar charts 470
treemaps 483
  vertical bar charts 470

W
web browsers 26
web servers 26
WebFOCUS 76
  Diagnostics menu 76
weekly interval 951
WF.Designer 636
Wildcard characters 896
Within 739

X
XY plot chart types 423
XY plot charts 422
Index

Y

yearly interval 954

Z

Zip distribution
  configuring 201
Feedback

Customer success is our top priority. Connect with us today!

Information Builders Technical Content Management team is comprised of many talented individuals who work together to design and deliver quality technical documentation products. Your feedback supports our ongoing efforts!

You can also preview new innovations to get an early look at new content products and services. Your participation helps us create great experiences for every customer.

To send us feedback or make a connection, contact Sarah Buccellato, Technical Editor, Technical Content Management at Sarah_Buccellato@ibi.com.

To request permission to repurpose copyrighted material, please contact Frances Gambino, Vice President, Technical Content Management at Frances_Gambino@ibi.com.